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To Our Valued Readers:

Thank you for looking to Sybex for your MOS: Excel exam prep needs. The Sybex team is 
proud of its reputation for providing certification candidates with the practical knowledge 
and skills needed to succeed in the highly competitive workplace. Just as Microsoft Learning 
is committed to establishing measurable standards for certifying individuals who work with 
Excel on a regular basis, Sybex is committed to providing those individuals with the skills 
needed to meet those standards. 
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candidate, succeed in your endeavors.

As always, your feedback is important to us. If you believe you’ve identified an error in the 
book, please visit the Customer Support section of the Wiley web site. And if you have general 
comments or suggestions, feel free to drop me a line directly at nedde@wiley.com. At Sybex 
we’re continually striving to meet the needs of individuals preparing for certification exams.

Good luck in pursuit of your MOS certification!

Neil Edde
Vice President & Publisher
Sybex, an Imprint of John Wiley & Sons
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Introduction

 

Microsoft’s Office Specialist (MOS) certifications for Excel 2003, both the Specialist and 
Expert levels, are becoming the industry standard for job placement in many different types of 
offices, from accounting firms, to medical offices, to construction companies, to churches. 
Gone are the days when companies had to spend the time and money to prepare, administer, 
and score Excel tests of their own when considering job applicants. Today, more and more 
employers are simply requiring MOS certification before you can even get your foot in the per-
sonnel department’s door.

Microsoft proclaims the benefits of MOS certification for individuals, businesses, academic 
institutions, staffing agencies, information technology (IT) training centers, and government 
organizations. Though this book was developed mainly for the individual who has a general 
understanding of Excel and Windows and is now ready to get MOS certified to increase their 
job eligibility potential, the bottom line is that anyone wanting to learn more about Excel or 
MOS certification will find this book helpful.

 

Microsoft Office Excel 2003 Specialist and 

Expert Certifications

 

Microsoft has developed the Microsoft Office Specialist (MOS) Exams to provide employers, 
schools, and potential employees with standardized tests to determine proficiency in all of the 
Office programs. Though there are MOS certification exams for all of the versions of the various 
Microsoft Office programs, this study guide prepares you for the Microsoft Office Excel 2003 
MOS Specialist and Expert certifications.

 

Microsoft Office Excel 2003 Specialist Certification

 

Microsoft Office Excel 2003 Specialist 
certification is intended for students and employees whose responsibilities include the use of 
Microsoft Excel to create, modify, and manage workbooks.

 

Microsoft Office Excel 2003 Expert Certification

 

Microsoft Office Excel 2003 Expert cer-
tification is intended for students and employees whose responsibilities include the use of 
Microsoft Excel to create, modify, share, and revise workbooks using templates, automated 
procedures, and the Web, and to retrieve, analyze, and summarize data.

 

How Do You Become MOS Certified?

 

To attain your MOS certification, you must successfully pass the MOS Exam. In order to do 
this, you must be proficient in all of the MOS objectives.

Microsoft Office Specialist certification exams are not written exams. There are no questions 
and answers to memorize. The MOS Excel 2003 exams are performance-based, which means 
each is conducted within Excel itself. Using the actual program, you will be presented with 
scenarios and asked to perform a series of tasks to demonstrate your skills.
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Requirements for MOS Excel 2003 Specialist Certification

 

You must pass the Microsoft 
Office Excel 2003 Exam at an approved testing center, within the given time limit.

 

Requirements for MOS Excel 2003 Expert Certification

 

You must pass the Microsoft 
Office Excel 2003 Expert Exam at an approved testing center, within the given time limit.

 

Taking the Exam

 

Once you’re finally ready to take the MOS Specialist or Expert Exam, there are a few things you 
need to know. For instance, each MOS Excel exam contains skill standards and scenarios to help 
determine the depth of your Excel knowledge. Let me tell you about these exam components as 
well as how to register for the exams. I’ll also give you some tips for taking the exams.

 

Standard Skill Sets

 

You must be proficient in Microsoft’s “standard skill sets” pertaining to the exam you’re 
taking. To see the full list of objectives in each skill standard set, see the objectives mapping 
tear-out card within this book.

 

The Specialist Exam

 

The Specialist Exam requires that you be proficient in the following standard skill sets:
�

 

Creating data and content
�

 

Analyzing data

 

Specialist vs. Expert Certification

 

Depending on your level of expertise in Excel, Microsoft has provided two levels of certifica-
tion you may choose from. You do not have to be certified as a Specialist in order to take the 
Expert exam. If you are seeking employment that does not require the Expert skills, most of 
what you need is covered in the first five chapters of this book. However, if you consider your-
self Expert material, by all means read this whole book and go for the full Expert certification.

 

Requirements for Master MOS Certification

 

Microsoft also offers a Master MOS certification, which requires that you successfully com-
plete three required expert exams and one elective exam. Microsoft Excel 2003 is one of the 
required exams, along with Microsoft Word 2003 and Microsoft PowerPoint 2003. The elec-
tive exams include Microsoft Access 2003 and Microsoft Outlook 2003.
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�

 

Formatting data and content
�

 

Collaborating
�

 

Managing workbooks

 

The Expert Exam

 

The Expert Exam requires that you be proficient in the following standard skill sets:
�

 

Organizing and analyzing data
�

 

Formatting data and content
�

 

Collaborating
�

 

Managing data and workbooks
�

 

Customizing Excel

 

Microsoft provides exam objectives to give you a general overview of possi-
ble areas of coverage on the MOS exams. Keep in mind, however, that exam 
objectives are subject to change at any time without prior notice and at 
Microsoft’s sole discretion. Please visit Microsoft’s MOS Learning website 
located at 

 

www.microsoft.com

 

 for the most current listing of exam objec-
tives. From Microsoft’s home page, click the Learning Tools link, then click 

 

Microsoft Certifications �

 

 Microsoft Office Specialist (MOS).

 

Exam Scenarios

 

The MOS exams include various scenarios. Some simply ask you to perform one task and oth-
ers include multiple tasks. You are presented with scenarios in a box at the bottom of your 
screen while you are inside Excel. The scenarios include no particular instruction, but simply 
tell you what the end result must be. For example, you would not be told to go to the Edit 
menu and select the Copy command. Instead, you would simply be requested to copy some 
particular data.

You are not graded on any scenario until you click the button indicating you have com-
pleted that scenario. So, how you do something is not important; you are not graded on how 
you did it, but only graded on the result you achieved. The exam is timed, and you must finish 
all of the scenarios within that time limit; you will get no credit for incomplete scenarios. The 
exam time runs about one hour. Once you have indicated that a scenario is complete, you can-
not go back to it later and make changes. You click the button to indicate you have finished 
and you are presented with the next scenario.

If you make mistakes, you can start the scenario over, as long as you haven’t clicked the 
button indicating you are done. You can also use the Undo button; however, you will not be 
allowed to access Excel’s Help menu.
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Once You’ve Completed the Exam

 

When you have finished the exam, your score appears onscreen so you know immediately 
whether you have passed. If you fail, you must wait seven days before you can take the exam 
again. There is no limit to the number of times you may take the exam; however, you must pay 
the full fee every time you take it. If you pass, in a few weeks you will receive a certificate in the 
mail from Microsoft.

 

Exam Registration

 

Microsoft Office Specialist exams are offered at Certiport iQcenters authorized Office Spe-
cialist exam testing centers. To find the location nearest you, go to Microsoft’s MOS Learning 
site, enter your country and city or zip code, and you will receive a list. Generally there will 
be a testing site convenient to your location. MOS exams are often offered at colleges, tech 
schools, and even some retail computer stores. When you use Microsoft’s MOS site search 
utility, you will be given an address and phone number you can use to contact the testing cen-
ter to register. Some of the sites listed even include clickable links to their websites, and you 
can register online if you prefer.

Each testing site has its own rules concerning how far in advance you must register; you will 
have to contact the site to get that information. The cost is governed by Microsoft, so all testing 
centers must charge Microsoft’s current rate, so don’t concern yourself with bargain hunting.

 

For complete, up-to-date information on the MOS exams, visit Microsoft’s 
MOS Learning site at 

 

www.microsoft.com

 

, where you can find answers to fre-
quently asked questions, see a free sample exam scenario, locate authorized 

 

testing centers in your area, and see the latest updates to the MOS program.

 

Tips for Taking the Microsoft Office Excel 2003 Specialist 

and Expert Exams

 

Here are some general tips for achieving success on your certification exam:
�

 

Be sure you know the location of the exam. If you’re not sure, take a test drive there a few 
days before the actual exam.

�

 

Get a good night’s sleep the night before the exam. Don’t stay up late cramming. If you’ve 
successfully completed the chapters in this book related to the objectives covered in the 
exam you are taking, you will be fine.

�

 

Arrive early at the exam center so that you can relax and review your study materials. If 
the testing center allows you to log into the testing machine ahead of time, do so. Get com-
fortable with that computer and its keyboard and mouse. Make adjustments to anything 
you can (mouse speed, chair height, etc.) so the experience is more comfortable for you.

�

 

Before the test begins, ask the person monitoring the test as many questions as you need 
to feel comfortable with the test rules.

�

 

Read the scenarios carefully. Don’t be tempted to jump to an early conclusion. Make sure 
you know exactly what the task entails. When you have finished a scenario, take a quick 
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look at your results for accuracy before you move to the next scenario. Remember that 
this exam is graded by a machine, so a properly executed procedure could be marked as 
incorrect because of a silly spelling error.

�

 

Try to complete every scenario. Scenarios that include more than one step are not pass/
fail deals. If a scenario includes three steps and you only do two of them, you will get 
credit for the part you completed. Always at least try to do part of any scenario. Never 
completely skip one.

�

 

Don’t do more or less than what is required. Don’t change settings just to make something 
look better if it’s not part of the task. Leave the default settings if the instructions do not 
request or imply that you change them.

�

 

Make sure you are completely finished with a scenario before you click the button to save 
it and move on. Remember that you will not be allowed to go back to it, even if you have 
time available at the end.

�

 

Watch the clock. At the beginning of the exam, you will be shown how many scenarios 
you have to complete within how much time. If you find you are spending too much time 
on one scenario because you really don’t know how to complete it, it might be best to 
leave it unfinished and move on to the next one.

�

 

If you get onscreen errors or the computer freezes up on you, notify the person moderating 
the test immediately. They will provide you with another machine and reset the test timer 
for any time lost in the transition. Don’t try to troubleshoot computer errors, because that 
time will not be given back to you.

 

What’s in the Book?

 

This book is part of a complete series of Study Guides, published by Sybex Inc., an imprint of 
John Wiley & Sons Publishing, that together cover the operating system requirements as well 
as the design requirements needed to complete your MOS Exam.

 

Please visit the Sybex website at 

 

www.sybex.com

 

 or the Wiley website at

 

 

 

www.wiley.com

 

 for complete program and product details.

 

In writing this book, I took into account not only what you need to know to pass the exam, 
but what you need to know to take what you’ve learned and apply it in the real world. Each 
book contains the following:

 

Objective-by-objective coverage of important topics

 

Each chapter lists the objectives cov-
ered in that chapter. The chapters not only teach you how to master the objectives, but when 
and why you would use the features.

 

The topics covered in this Study Guide map directly to Microsoft’s official 

 

MOS Exam objectives. Each exam objective is covered completely.
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Hands-on exercises

 

In each chapter, you’ll find exercises designed to give you the important 
hands-on experience that is critical for your exam preparation. The exercises support the topics 
of the chapter, and they walk you through the steps necessary to perform a particular function. 
You can download the files you need to complete the exercises from the website for this book 
at 

 

www.sybex.com.

 

 (Check out the “This Book’s Companion Website” section of this Intro-
duction to find out how to access the book’s web page). I’ve organized the files chapter by 
chapter in zipped format, and you must extract them to a temporary folder on your computer 
in order to use them for the exercises. The zipped files also include copies of the completed 
exercise workbooks so you can compare them with yours to check your results. In each exercise, 
I’ll let you know the filenames you’ll be using, and in some cases instructing you to save the 
changes you’ve made for use in future exercises.

 

To do the exercises in this book, you must have some version of Microsoft 
Excel installed on your computer. Most of the exercises and information can 
be applied to any version of Excel, but the book assumes you have Excel 2003 
installed. If you are using an earlier version of Excel, some of the instructions 
and images in this book may be slightly different but you should still be able 
to understand most of what is covered. Because Microsoft Office 2003 requires 
Windows XP, all references to Windows assume you have Windows XP as 

 

your operating system.

 

Exam Essentials

 

To highlight what you learn, you’ll find a list of Exam Essentials at the end 
of each chapter. The Exam Essentials section briefly highlights the topics that need your par-
ticular attention as you prepare for the exam.

 

Sample MOS Exam Scenarios with Suggested Solutions

 

Each chapter includes sample sce-
narios at the end, similar to the ones you will encounter in the exam. The zipped files for each 
chapter include the workbooks you will need to use to complete the scenarios, along with copies 
of the completed scenario workbooks for you to check your results. I have also provided step-
by-step suggested solutions, which you can find in this book’s Appendix. Because there are var-
ious ways to accomplish tasks in Excel, your steps do not have to match mine exactly, as long 
as you reach the correct result. My steps only demonstrate one way to complete the scenario.

 

Glossary

 

Throughout each chapter, you will be introduced to important terms and concepts 
that you will need to know in order to understand the tasks presented to you in the exam sce-
narios. These terms appear in italic within the chapters, and at the end of the book, a detailed 
glossary gives definitions for these terms, as well as other general terms you should know.

 

Real World Scenarios

 

Because reading a book isn’t enough for you to learn how to apply 
these topics in your everyday duties, I have provided Real World Scenarios in special sidebars. 
In these scenarios, I will share real-life situations that explain when and why a particular solu-
tion would make sense in a working environment you’d actually encounter.

 

Tips, Notes, and Warnings

 

Watch for these special items. They will give you helpful infor-
mation to let you best understand what I’m teaching you.
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This study guide has undergone the Certiport (

 

www.certiport.com

 

) approval 
process to achieve its designation as Microsoft Official Courseware. Every 
element in this book has been reviewed by the Certiport professionals to 

 

ensure it expertly prepares users for both levels of MOS Excel certification.

 

This Book’s Companion Website

 

In order to download the sample files I’ve created for the exercises in this book, you’ll need to 
access the companion website for this book at:

 

www.sybex.com/go/mosexcel2003

 

I’ve zipped the files and organized them chapter by chapter for you to work with when 
you’re doing the book’s exercises. You’ll need to extract them to a temporary folder on your 
computer. Within each zipped file, I’ve included copies of the completed exercise workbooks 
so you can compare them with yours to check your results.

 

How Do You Use This Book?

 

This book provides a solid foundation for the serious effort of preparing for the exam. To best 
benefit from this book, you may wish to use the following study method:

 

1.

 

Read the chapters in the order in which they are presented. The instructions in each chap-
ter build upon what you learned in the previous chapters. Procedures that were explained 
step by step in one chapter will not necessarily be explained in that much detail when you 
use them again in a later chapter. At least review the Exam Essentials and Sample Scenarios 
at the end of a chapter before you move onto the next one. If you don’t understand some-
thing in a chapter, refer to the index to find the earlier chapter where that was explained, 
so you can go back to that section.

 

Software Requirements

 

Though you can do most of the exercises in this book using an earlier version of Excel, it is 
recommended you use Excel 2003 so you are familiar with its unique interface and features. 
If you use a different version while studying for the exam, I highly recommend you find a com-
puter with Excel 2003 installed and do the end-of-chapter scenarios on that machine at least 
once before you take the exam.

Because Excel 2003 requires Windows XP as the operating system, it is assumed you have 
Windows XP installed. The files you need to use for the chapter exercises are included on the 
website for this book in a zipped format, which can be extracted for use automatically by Win-
dows XP’s unzipping utility. However, if you are using a different version of Windows, you 
will need some type of unzipping software to access the files.
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Introduction

 

2.

 

Study each chapter carefully. Do your best to fully understand the information. Always 
have Microsoft Excel running on your computer as you read, so you can refer to your 
screen when you don’t understand something.

 

3.

 

Complete all the hands-on exercises in the chapters, referring back to the text as necessary 
so that you understand each step you take.

 

4.

 

Read over the Real World Scenarios to improve your understanding of how to use what 
you learn in the book.

 

5.

 

Study the Exam Essentials to make sure you are familiar with the areas you need to focus on.

 

6.

 

Try all of the end-of-chapter Sample MOS Scenarios. The only way to be sure you under-
stand the concepts is to put them into action. Try not to look at the completed scenario 
files or the suggested steps in the Appendix until you’ve tried to do the scenarios alone.

 

7.

 

Take note of the scenarios you could not complete, and then study the corresponding 
sections of the book again.

 

8.

 

Go back over the Exam Essentials at the end of each chapter.

To learn all the material covered in this book, you will need to study regularly and with dis-
cipline. Try to set aside the same time every day to study, and select a comfortable and quiet 
place in which to do it. If you work hard, you will be surprised at how quickly you learn this 
material. Good luck!

 

Knowledge Requirements

 

Because you have obtained this book in preparation for taking the MOS Exam, it is assumed 
you are not a novice computer user and have a basic knowledge of personal computers and the 
Windows operating system. You should know how to locate files on your computer and use 
your Windows desktop, for example. Any knowledge of Excel itself is not needed previous to 
reading this book.
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Chapter

 

1

 

Navigating in Excel 
and Understanding 
the Interface

 

MOS SPECIALIST OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Enter and edit cell content

�

 

Navigate to specific cell content

�

 

Modify row and column formats

�

 

Insert, delete, and move cells

�

 

Organize worksheets

�

 

Organize workbooks using file folders

�

 

Save data in appropriate formats for different uses
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You know you’re really old if you remember the paper spread-
sheets that companies used to use to do their number crunching. 
The look of Microsoft Excel resembles those abacuses of papy-

rus, but the advantages to using Excel are numerous, not to mention obvious. You don’t have 
to be a mathematician or have an accountant’s brain to use it. Excel does most of the hard stuff 
for you. I always tell my students that I don’t know that much about math, but I do know how 
to use Excel. The reason I learned Excel in the first place was because I needed a program that 
could do what I was always paying accountants to do.

In this chapter you will learn the fundamentals of how to get around in an Excel workbook, 
add data in the correct places, and make simple changes to the data, as well as how to identify 
and modify the layout components and understand the basic workbook structure. To help you 
master the MOS objectives relating to cell and workbook navigation and organization, I’ve 
provided files on the website for this book that you will need for each exercise in this chapter. 
Download the file named exl2003ch01.zip and extract the files before you begin. 

Throughout these lessons, you will create, and edit, and save workbooks. To keep the lessons 
well organized, I recommend that you create folders and subfolders to hold all the files you 
save. Though you can do this from within My Computer in Windows, one of the MOS objec-
tives requires that you know how to do it from within Excel. That is explained in a later sec-
tion in this chapter (“Saving and Managing Workbooks”), so if you need to save any files you 
work on in this chapter before you get to that section, simply save them as you always have 
in Windows or take a peek at that section before you proceed.

To get started, let’s take a look at the most fundamental component of Excel’s uniqueness: 
its interface.

 

Understanding Excel’s Interface

 

If you are like me, when you opened Excel for the first time, you were mystified by all the 
boxes, columns, and rows. Excel looks quite different from word processing programs or 
email, so it’s important to understand Excel’s unique file setup and navigation. However, 
before you can see how Excel simplifies these processes for you, it’s important that you under-
stand the names and purposes of everything you see on your screen so you can follow my 
instructions. Let’s get the program up and running and take a look at some of these interface 
features.

Open Excel by selecting Start �

 

 All Programs �

 

 Microsoft Office �

 

 Microsoft Office 
Excel 2003. When Excel opens, you will see a blank worksheet, and the title bar at the top of 
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your screen will say Microsoft Excel – Book1. 

 

Book1

 

 is the name temporarily assigned to a 
new workbook before you save it. Before you learn the names and purposes of all the boxes 
and columns, let’s first look at the different bars at the top of the Excel screen.

 

Investigating the Default Bars at the Top of Your Screen

 

Like virtually all computer programs, all the actions you perform in Excel are executed from 
the commands in the menus or the buttons on the toolbars. To see all of the toolbar buttons 
and menu commands in Excel, click Tools �

 

 Customize. In the Customize dialog box, click 
the Options tab and select the two checkboxes at the top: Show Standard And Formatting 
Toolbars On Two Rows and Always Show Full Menus. Then, click the Close button. By 
default, Microsoft has these set up to show only the most recently used commands, but, for 
clarity purposes, the change you just made lets you see all of them and will make it much easier 
for you to find the commands I refer to throughout this book.

If at any time you don’t see any toolbars I refer to, click View �

 

 Toolbars and check the sub-
menu, which shows most of them. The ones that are present on your screen are checked. 
Simply click the toolbar you want displayed to put a check there. Alternatively, if there’s any 
toolbar you don’t want displayed, simply remove the checkmark by clicking it. If the toolbar 
you are looking for is not in the list, click the Customize command at the bottom of the sub-
menu to see a more complete list of choices. 

 

Toolbar Functions

 

You can choose from a number of toolbars in Excel, and I will cover all of them in the chapters 
of this book. In this chapter, we investigate the bars that are on your screen by default when 
you first open Excel. Check out Figure 1.1, which illustrates a typical view of Excel when you 
open it for the first time. At the top of the screen

 

,

 

 you see the five bars listed here:

 

Title bar

 

The 

 

title bar

 

 tells you the name of the program and the filename.

 

Menu bar

 

The 

 

menu bar

 

 displays menus that list 

 

commands

 

 relative to each menu’s function.

 

Standard toolbar 

 

The 

 

Standard toolbar

 

 includes buttons for the most commonly used file 
management and editing commands.

 

Formatting toolbar

 

You can find the most commonly used formatting commands on the 

 

Formatting toolbar

 

.

 

Formula bar

 

The 

 

Formula bar

 

 shows you which cell is active and the content of that cell.

All of these bars (with the exception of the Formula bar) basically work the same way in 
Excel as they do in Windows or any Windows program.  

Using the buttons on the toolbars saves you time, which is important in the MOS Exam 
because of the exam’s time limit. Instead of having to root through the menus to find a com-
mand, most of the ones you will need during the exam are available on the toolbars. Famil-
iarize yourself with these buttons because you will be using many of them in this chapter, as 
well as throughout this book. 
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Navigating in Excel and Understanding the Interface

 

F I G U R E 1 . 1

 

The Five Bars at the Top of the Screen

 

The toolbars include 

 

tooltips,

 

 which display when you rest your mouse pointer on any but-
ton. These tips tell you what the button does. 

 

If you don’t see tooltips displayed, choose Tools �

 

 Options. In the Options 
dialog box, select the General tab and click the Function Tooltips option. 
Then, choose Tools�

 

 Customize, and select the Options tab, and click the 

 

checkbox for Show ScreenTips On Toolbars.

 

Before I teach you how to use the toolbars, here are a few tips on managing them.

 

Managing the Toolbars

 

Toolbars can be rearranged, moved to different locations, and detached and left floating on 
the worksheet, depending on your preference. Excel allows you full control of your toolbars. 
Let’s try some moving and resizing to get your feet wet by doing Exercise 1.1.

Title Bar

Standard Toolbar

Menu Bar

Formatting Toolbar Formula Bar
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You can drag toolbars to the sides and bottom of your screen as well. If a tool-
bar is docked on the side of the screen, you will have to move your mouse to 

 

the top of the toolbar instead of the left end to find the four-headed arrow. 

 

Task Pane

 

New to Excel, starting with Office XP, is the task pane. Microsoft added this feature to give 
you a larger, more obvious, area to find some commonly used tasks. Though the task pane in 
some of the other Office programs greatly improves the usability of the program (Power-
Point’s Animation task pane and Word’s Styles task pane, for example), in Excel it doesn’t add 
much new, but it’s worth mentioning. By default, the task pane should appear on the right side 
of your screen when you first open Excel. If it is not there, choose View �

 

 Task Pane.

 

E X E R C I S E  1 . 1

 

Moving and Resizing Toolbars

 

1.

 

From the View menu, choose Toolbars �

 

 Formula Auditing. The Formula Auditing tool-
bar is displayed as a floating toolbar.

 

2.

 

Move your mouse pointer to the top edge of the toolbar, until you see a double-headed 
black arrow. Click and hold this arrow and drag the edge of the toolbar up to make it taller. 
Then drag it down to restore it to its original shape.

 

3.

 

Click your mouse pointer anywhere on the toolbar’s title bar and you will see a four-
headed arrow. Click and hold this arrow to move the toolbar to a different location on 
your screen.

 

4.

 

Drag the toolbar to the top of your screen until it docks itself with your other toolbars.

 

5.

 

Move your mouse pointer to the left end of the docked toolbar until you see your mouse 
pointer turn into the four-headed arrow. Then click and hold to drag the toolbar back to 
a floating position on your worksheet.

 

6.

 

Double-click the toolbar’s title bar. It will redock itself wherever it was last docked.

 

7.

 

Using the four-headed arrow on the left end of the toolbar, drag the Formula Auditing 
toolbar so it is above the Formatting toolbar and below the Standard toolbar.

 

8.

 

Move your mouse pointer to the toolbar’s left end again and, with the four-headed arrow, 
drag it back to the middle of the worksheet.

 

9.

 

Click the X on the right end of the toolbar’s title bar to close it.

 

4002book.fm  Page 5  Friday, March 24, 2006  11:36 PM



 

6

 

Chapter 1 �

 

Navigating in Excel and Understanding the Interface

 

At the top of the task pane is a title bar that shows the name of the task pane you are seeing, 
and it has a black downward-pointing arrow to the right of it. Click that arrow to see the var-
ious choices, such as the New Workbook task pane and the Clip Art task pane.

Table 1.1 briefly explains the purpose of each task pane. You will learn how to use each of 
them in future chapters when they are utilized.

 

T A B L E 1 . 1

 

Elements of the Task Pane 

 

Task Pane Purpose

 

Getting Started/ 
Help/Search Results/
Template Help

These four task panes help you find what you need to know about 
Excel.

Clip Art This pane gives you access to Microsoft’s Clip Art Gallery to search 
for pictures, sounds, and movie files to include in your workbook. 
There’s also a Clip Organizer that lets you include your own files in 
the gallery.

Research Use this task pane to get more information from dictionaries, a the-
saurus, an encyclopedia, and more.

Task Pane Choices
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When you are not using the task pane, you can click the X in the upper-right corner to close 
it and have more room on your screen. If you want it back, just choose View �

 

 Task Pane. 
Also, some commands (like Insert �

 

 Picture �

 

 Clip Art and File �

 

 New) will bring the task 
pane back automatically when you need it. After you’ve explored the various task panes, click 
the X in the task panes upper-right corner to close it.

 

Workbook Components

 

In Excel, you do data entry, formatting, and computing within what is called a 

 

worksheet 

 

(commonly referred to as a

 

 sheet)

 

. One or more worksheets within a single Excel file create a 

 

workbook

 

, which is what an Excel file is called. Think of the workbook as the manila folder 
in your file cabinet and the worksheets as the invoices, inventory lists, customer information 
sheets, and so forth that are included in the manila folder. Look at the bottom of your Excel 
screen; see the tabs that say Sheet1, Sheet2, and Sheet3? By default, Excel includes three sheets 
in a new workbook (see Figure 1.2), but you can create more, as I’ll explain later in the section 
“Organizing Worksheets.”

You can use these sheets to organize data that belongs in one workbook but has differing 
types of information and, therefore, should not be included in one worksheet. An example is 
a workbook you make for one particular company, including individual worksheets for inven-
tory lists, sales records, and customer information. You can also use worksheets to organize 
similar information—creating a separate sheet for each month of the year in a yearly sales 
workbook, for example. 

In Figure 1.2 notice that there are 

 

tab scrolling buttons

 

 to the left of the sheet tabs. You can 
click these buttons to move through the sheets when you have so many tabs that you can’t view 
them all at one time.

 

Clipboard This pane allows you to see up to 24 items stored in your Clipboard 
when you copy or cut data.

New Workbook You use this pane when you create a new blank workbook or want to 
start a new workbook based on a template.

Shared Workspace/ 
Document Updates

Use these panes when you want to create a workspace for multiple 
users.

XML Source This pane is for viewing Extensible Markup Language (XML) maps.

 

T A B L E 1 . 1

 

Elements of the Task Pane

 

(continued)

 

Task Pane Purpose
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F I G U R E 1 . 2

 

Sheet tabs allow you to quickly move from sheet to sheet.

 

When you have a large number of sheets, a quick way to move from one to 
another is to right-click the tab scrolling buttons and pick the sheet you want 

 

from the list that pops up.

 

Workbooks also include both vertical and horizontal scrollbars so you can get to all parts 
of the sheet when it is too large to be displayed completely on your screen.

Worksheet Components

Excel worksheets are organized in columns and rows. The columns are vertical and are labeled 
at the top with letters. The rows run horizontally across the sheet and are labeled on the left 
end with numbers. The individual boxes on the sheet are called cells, and they are named with 
a cell address, according to the column and row intersection where they appear. For example, 
if you move across to column C, then move down to row 6, that cell address would be C6, sim-
ilar to the way towns are listed in the key on a road map. To see the address of any cell, click 
that cell with your mouse pointer, then look at the Name box next to the Formula bar and see 
it displayed there (see Figure 1.3). 

Tab Scrolling Buttons Horizontal Scrollbar Vertical ScrollbarSheet Tabs
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F I G U R E 1 . 3 The Name box displays the cell address of the active cell.

The lines you see defining the cells are called gridlines. They do not print by default, but are 
intended more for clarity when you view the data onscreen.

When you click any cell, you see it is outlined in black, as shown in Figure 1.3. Clicking a 
cell selects it and makes it the active cell, meaning this is the cell that will be affected by what-
ever you type or do.

Now that you’ve read about the basic elements of the Excel interface, it’s time to under-
stand how to navigate around Excel. It’s not as easy as some programs, so it definitely war-
rants a discussion.

Navigating in Excel
Your next goal is to learn how to move around to the various locations in the workbook and 
various places on the worksheets. This section includes exercises that teach you the different 
ways to move around in Excel.

Moving Around in Workbooks

To see all the data in your workbook and edit the data, you must know how to effectively nav-
igate to different worksheets within the workbook. Exercise 1.2 teaches you how to do this.

E X E R C I S E  1 . 2  

Navigating in a Workbook

1. Open Excel and select File � Open.

2. Find the file named Exercise 1-1.xls that you extracted from the zipped file for this chapter.

3. On Sheet1, you can see the January sales for five stores. Click the Sheet2 sheet tab at the 
bottom of the worksheet. This is the March sales sheet.
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Moving Around in Worksheets

 Moving from sheet to sheet is fairly straightforward; however, moving around within a work-
sheet is more complex because sheets can be very large and you can waste a lot of time scroll-
ing to find something. Once you’ve navigated to the sheet you want to work on, you can find 
the particular cell that needs your attention in various ways, as demonstrated in Exercise 1.3.

4. Click Sheet3’s tab to see the February sales sheet.

5. Hold down the Ctrl key on your keyboard and tap the Page Up key. This is the keyboard 
shortcut to move to the previous sheet, so this moves you back to Sheet2.

6. Press Ctrl+Page Down to move back to Sheet3.

7. When you have more sheets than can be displayed at the bottom of the workbook, you 
use the tab scrolling buttons (First, Previous, Next, and Last) shown in Figure 1.2 to dis-
play the unseen sheets. 

8. Leave this workbook open for the next exercise.

E X E R C I S E  1 . 3  

Navigating in a Worksheet

1. Still inside the workbook named Exercise 1-1.xls, click the Sheet1 tab to get back to the 
January sales sheet.

2. Use the vertical scrollbar on the right side of your screen to move the view of the sheet 
up and down.

3. Use the horizontal scrollbar at the bottom of the screen to move the view left and right.

Scrollbars are necessary only when the data on your worksheet will not fit on one screen. 
Since the data in this file does fit on one screen, using the scrollbars has a less obvious 
effect.

4. Press Ctrl+Home to move to cell A1 on this sheet. This is the keyboard shortcut to move 
to the first cell that contains data.

5. Press Ctrl+End to move to cell E8 on this sheet. This is the keyboard shortcut to move to 
the last cell that contains data.

E X E R C I S E  1 . 2 ( c o n t i n u e d )
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It is important to note that if you click into a cell beyond the data area and just put one 
space in that cell, or enter data in that cell and then delete it, Excel will see this as the last 
cell that contains data, so Ctrl+End is not always reliable.

6. Click your mouse pointer in cell A3 to make that the active cell. Press Ctrl+→ to move to 
cell E3, which is the last cell in that row containing data.

7. Click in the Name box at the top of your screen, below your Formatting toolbar. Type a4 in 
this box and press Enter. This capitalizes the A in the Name box and moves you to cell A4.

Note that when you type a cell address in the Name box or in a formula, you don’t have 
to capitalize the column identifier. Excel will recognize it as a cell reference and capitalize 
the letter(s) for you.

8. Press the End key on your keyboard. Look at the Status bar at the bottom of your screen; 
note the word “END” in the lower-right corner. Now press Enter and you will move to the 
last cell on that row that contains data. Press End again to remove the word “END” from 
your Status bar, if it doesn’t automatically disappear.

9. Press the  ↑ , ↓ , ← , and → keys to move from cell to cell.

10. Press the F5 key on your keyboard to bring up the Go To dialog box. Type h77 in the Ref-
erence box and click OK. This takes you to cell H77.

11. Choose Go To from the Edit menu, and it shows you other cells you have recently 
selected. Click one of them and click OK to return to that cell.

12. Press Ctrl+Home to return to cell A1. From the Edit menu, choose Find.

13. In the Find What box, type french, and then click the Find Next button. This takes you to 
cell A6, where the word “French” is located. 

14. Click the Close button to close the Find and Replace dialog box.

15. Press Ctrl+F to open the Find box again. Type 2 in the Find What box. (Note that the word 
french is highlighted in black. Typing 2 will replace what is highlighted.) Click Find Next 
and you will move to cell C7, which is the next cell that contains the number 2.

16. Click the Find All button and the list displayed at the bottom of the Find box shows you 
all the cells on this sheet that contain the number 2. The Value column shows all the val-
ues that include the number 2. Click the one that shows Week 2 and you move to cell C3. 
To find all occurrences in the workbook, click the other sheet tabs and click Find All again.

17. Close the Find and Replace dialog box and close the file. Do not save any changes. 

E X E R C I S E  1 . 3 ( c o n t i n u e d )

4002book.fm  Page 11  Friday, March 24, 2006  11:36 PM



12 Chapter 1 � Navigating in Excel and Understanding the Interface

Excel has many keyboard shortcuts, and it is not possible to show you all of 
them.  However, they are all included in Excel’s Help files. From the Help menu, 
choose Microsoft Excel Help and the Excel Help task pane will appear. In the 
Search For box, type keyboard shortcuts and click the green arrow button. Then 
click the Keyboard Shortcuts links. Also note that when you choose commands 
from the menus, many of the commands show keyboard shortcuts beside them.

Now that you know the fundamentals of how to move around your worksheets and work-
book, let’s look at managing your data and cells.

By default, when moving from cell to cell, pressing Enter moves you to the 
cell below the one you are currently in, and pressing Tab moves you to the cell 
to the right. Pressing these keys is usually the quickest way to move from 
cell to cell when you’re entering data.

Adding and Editing Data in a Workbook
Adding to or editing information in an Excel workbook is referred to as data management. 
Data is the term used to refer to what’s inside the cells. You can also manage the actual cells, 
rows, and columns without actually changing the data within them. This section shows you 
the difference between data management, cell management, and row and column manage-
ment, and the basics of doing each.

Managing Data in Cells

There are basically two types of data in Excel: labels and values.

Label Refers to text typed at the top of a column or to the left of a row to identify the infor-
mation contained in the column or row.

Value Is the actual information listed in the rows and columns, below, or to the right of the 
labels. 

Figure 1.4 shows you a typical worksheet layout, using labels and values. The title at the 
top, the store names, and the numbered weeks are examples of labels. The values in dollars 
and the word closed are examples of values. Notice that labels and values can consist of text 
and/or numbers.

Between cell formatting and manual editing of cell contents, you can make Excel display 
your data in many different ways. Most of the cell formatting options will be discussed in 
Chapter 2, “Formats, Graphics, and Excel’s Templates,” but the following exercises will show 
you how to add new data to and edit existing data in a worksheet. Exercise 1.4 teaches you 
how to add new data to an existing worksheet.
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F I G U R E 1 . 4 Cells can contain labels or values.

E X E R C I S E  1 . 4  

Adding Data to a Worksheet

1. Open the file Exercise 1-1.xls.

2. Move to Sheet2 and click cell A9. On the Status bar at the bottom of your screen, on the 
left end you see the word Ready. This means the cell is now the active cell and ready for 
your input.

3. Type the word Florence. As soon as you start typing, the word on the Status bar changes 
to Enter. This means you are now entering data in this cell. (Also notice that what you 
type in the cell appears in the Formula bar above.)

4. Press Enter and you move to the cell immediately below this. Your Status bar shows 
“Ready” again.

5. Press ↑ to return to cell A9. Press either → or Tab to move to cell B9.

ValuesLabels Label Labels
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Once data is in a worksheet, there are various ways to modify that data at a later time, if 
you need to update it. 

An important thing to note is that anything typed within a cell is not committed until you 
press the Enter key. When in Edit or Enter mode, if you start to change or replace the content 
of any cell but change your mind, pressing the Esc key on your keyboard will revert the con-
tent to what it was originally, as long as you have not yet pressed Enter and left the cell. If 
you have already left the cell, use the Undo button on your Standard toolbar to undo the last 
action. 

6. In cells B9 through E9 enter the numbers shown here, pressing your Tab key after you 
type each one:

In B9, type 450, and then press Tab to move to C9.

Type 550.5, and then press Tab to move to D9.

Type 675.95, and then press Tab to move to E9.

Type 1000. 

7. After you type 1000 in E9, press Enter to move down to E10, then press Home to move 
to the beginning of row 10.

8. In rows 10 and 11, add the data shown here, using the method described earlier:

In A10, Flora; in B10, 300; in C10, 899.5; in D10, 1600; in E10, 1297

In A11, Fauna; in B11, 1499; in C11, 1076; in D11, 1187.99; in E11, closed

9. You have now added three new stores to your worksheet, and it should look like the 
worksheet shown here: 

10. Leave this workbook open for the next exercise.

E X E R C I S E  1 . 4 ( c o n t i n u e d )
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To the right of the Undo button is a small downward-pointing dropdown 
arrow. Click this arrow to open a list of all you’ve done recently, so you can 
undo more than one action if necessary.

Exercise 1.5 illustrates ways to edit all or part of the content of a cell.

E X E R C I S E  1 . 5

Editing Data in a Worksheet

1. Still inside Exercise 1-1.xls, select cell A9 by clicking it one time. Notice your Status bar 
shows “Ready.” When you want to totally change the content of a cell, you do not need 
to delete what is in the cell first. Simply type what you want and press Enter, and the con-
tent will be replaced. Type Rosewood and press Enter. Notice that the content has been 
changed.

2. Select cell D4. In this case, we don’t want to change the entire contents. Instead, we only 
want to change one digit in this number. We want to change 10000.5 to 11000.5. To do this, 
we need to move from Ready mode to Edit mode; this can be done in one of three ways:

� Double-click any cell and your Status bar shows “Edit.”

� Click any cell, then press F2 and your Status bar shows “Edit.”

� Click any cell; then click in the Formula bar where you see the cell content below the 
Formatting toolbar. Your Status bar shows “Edit.”

3. Once you use one of these three methods to get into Edit mode, in cell D4 you will see an 
I beam. This I beam designates the insertion point, which shows where your typing will 
be entered within the cell. Use your ← and → keys to move to the right of the number 1, 
press the Delete key on your keyboard one time to remove one of the zeroes, and then 
type 1. 

4. Press Enter and the content of the cell now shows 11000.5.

5. Using the methods described earlier, change the contents of the following cells to these 
new values:

� Change B6 to 1275.75.

� Change A4 to Burberry.

� Add 50 to cell D8.

6. Leave this workbook open for the next exercise.
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16 Chapter 1 � Navigating in Excel and Understanding the Interface

Managing Cells

Because all cells in a column must be the same width and all cells in a row must be the same 
height, cell size management doesn’t include too many options. Most cell size management is 
governed by the specifications set on the row or column that contains the cell. You can work 
around some of this by merging cells, a process that is covered in Chapter 2.

Cells can be deleted and cleared individually, but deleting a cell is different from clearing 
or deleting the content of a cell. Clearing a cell just removes the content, whereas deleting a 
cell removes the entire cell and shifts the cells around it to fill the area where that cell was orig-
inally. As Figure 1.5 shows, you can shift the cells up or to the left when deleting a cell. 

F I G U R E 1 . 5 When you delete a cell, you have choices for how you want the space filled.

Exercise 1.6 walks you through deleting content and deleting whole cells.

E X E R C I S E  1 . 6  

Deleting Cells and Clearing Cell Components

1. Still inside Exercise 1-1, move to Sheet1 and select cell D6.

2. Press Delete and then press Enter. Notice that the content in cell D6 has been removed. 

3. Click the Undo button to restore the value of 500 into cell D6.

With cell D6 still selected, go to the Edit menu and rest your mouse pointer on the Clear 
command. As you can see, you have four choices: All, Formats, Contents (Del), and 
Comments. Pressing the Delete key removes the contents of the cell but leaves any for-
matting that has been applied to the cell. To remove all of this, use the Edit� Clear � 
All command.

4. Select cell C6.

5. Go to the Edit menu and choose Delete.

6. Verify that Shift Cells Up is selected and click OK. 
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Managing Rows and Columns

Managing rows and columns involves everything from changing their size to accommodate 
the data you want to display to adding and deleting rows and columns. We’ll discuss these 
issues in further detail and, of course, practice these maneuvers as well.

Changing the Size of Rows and Columns

Rows and columns that are not large enough can cause data to be displayed and printed incor-
rectly. And, based on certain variables, Excel will treat data that is too wide for a column dif-
ferently. Look at Sheet1 in the file Exercise 1-1.xls and you’ll notice that the text in cell D7 is 
cut off because it is wider than what the column allows. However, notice that the text in E7 
is not cut off but instead spills out of the column and appears to continue into column F. Look 
at Sheet2 and click cell C5 (the cell that is displaying multiple # signs). Observe in the Formula 
bar that this cell actually has a number in it, but because the number is too wide for the col-
umn, Excel replaces that number with the # signs. These dissimilarities are the result of the way 
Excel adapts to data that is too wide for a column, based on two criteria:
� Is there anything in the cell immediately to the right of the data?
� Does the cell contain text or numbers?

If text is too wide for a column, Excel will allow the text to spill out over the next column 
if the cell to the right is empty. However, if there is something in that cell to the right, the data 
that is too wide for the column will be cut off.

The illustration here shows that the value 21000 that was in C7 has now moved up into 
C6, and that 12000.75 has moved up into C7. When you delete a cell, the gap must be 
filled. When you simply clear the contents of a cell, the cell still remains but is empty.

7. Click the Undo button so that 21000 is back in cell C7, as shown in the “Before” part in 
the illustration.

8. Leave this file open for the next discussion and exercise.

E X E R C I S E  1 . 6 ( c o n t i n u e d )
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18 Chapter 1 � Navigating in Excel and Understanding the Interface

If numbers are too wide for a column, Excel will replace the digits with # signs if the cell 
to the right of it has something in it. However, if the cell to the right is empty, Excel will cut 
off the digits that exceed the width of the column, rounding the number off if necessary.

It is important for you to know that what you see in a cell is not always what Excel sees in 
that cell. For example, when Excel rounds off a number to fit it in a column, Excel still sees 
the full number. To always know exactly what Excel is seeing in a cell, look at what is in the 
Formula bar at the top of the screen. That is the only place you will always see exactly what 
Excel sees. For example, 1.5 rounded off to fit in a narrow column will show as 2 in the cell, 
but Excel will still show it as 1.5 in the Formula bar; therefore, when you use a formula to add 
two cells together that seem to have 2 in them, you will get a result of 3, because Excel is actu-
ally adding 1.5 and 1.5. (I’ll cover more on using formulas in Chapter 5, “Formulas and Func-
tions in Excel.”) 

The following exercises will teach you how to adjust column widths, as well as row heights, 
using the mouse or the menu commands. First, in Exercise 1.7, let’s try it with the mouse.

E X E R C I S E  1 . 7  

Resizing Rows and Columns Using the Mouse

1. Go to Sheet1 in Exercise 1-1.xls.

2. Move your mouse pointer up to the column headers section—the gray area at the top of 
the worksheet that displays the column letters A, B, C, etc.

3. Move your mouse pointer over the gridline between the letters D and E until you see the 
resizing pointer, as shown here:

4. With this pointer you can:

� Hold down the left mouse button and drag the right edge of the column until the col-
umn is wide enough.

� Double-click to automatically fit the column to the widest entry in it.

4002book.fm  Page 18  Friday, March 24, 2006  11:36 PM



Adding and Editing Data in a Workbook 19

In Exercise 1.8, we’ll explore an alternative method for resizing the columns and rows pre-
cisely, using the menus.

5. Drag the right edge of the column until all of the text in cell D7 is visible. Then drag the 
edge back to the left until the # signs reappear. 

When you drag the column headers with the resizing pointer, you see a tooltip that tells 
you the exact column width. The first number you see is the size in characters; the second 
number, in parentheses, is the size in pixels. 

6. Now, try double-clicking to let Excel automatically adjust it to the length of the value in D7.

7. Move to Sheet2 and double-click between the column headers for C and D to display the 
full number in C5.

8. Change the number in cell E5 to 9501.977 and press Enter. Notice that the full number is 
still displayed because it fits within the column.

9. Edit the number in E5 by adding a 9 at the end so that it now shows 9501.9779, and press 
Enter. See that the number is shortened by one digit so that it fits within the column, and 
is rounded to 9501.978.

10. Double-click between column headers E and F to adjust the column so the full number in 
E5 is displayed.

11. Adjusting row height is similar to adjusting column width. Move your mouse pointer 
over the gridline between the row headers on the left of your screen that say 3 and 4 until 
you see the resizing pointer; then drag down to increase the height of row 3. The tooltip 
that appears when you drag to adjust row heights shows the size in points first (1 point 
equals 1/72 of an inch), followed by the size in pixels, in parentheses.

12. Double-click with the resizing pointer to make row 3 automatically adjust to the height of 
the text in that row. 

13. Leave the file open for the next exercise.

E X E R C I S E  1 . 8  

Resizing Rows and Columns Using the Menus

1. Move to Sheet2 in Exercise 1-1.xls.

2. Change the column heading labels in cells B3 through E3 so the week numbers are 
spelled out, making them Week One, Week Two, Week Three, and Week Four.

E X E R C I S E  1 . 7 ( c o n t i n u e d )
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Adding and Deleting Rows and Columns

Sometimes you just need a little more information: another row or column to finish off your 
report, or wrap up that expense worksheet. When this is the case, you can add new rows or 
columns within your data area. When you insert a column or row, by default it takes on the 
formatting from the column to the left or the row above, if the cell to the left or the cell above 
has data in it. You can click the option button that appears on the lower-right corner of the 
active cell to change the formatting to match the column to the right or the row below, or 
choose to have no formatting attached to the new column or row (see Figure 1.6).

F I G U R E 1 . 6 Option buttons give you easy choices to change default formatting.

3. Notice that Week Three is now cut off. Click any cell in column D.

4. From the Format menu, move down to Column and choose Autofit Selection. The col-
umn width adjusts to fit the widest item in that column. This is the same as double-click-
ing the gridline to the right of any column header, as we did in Exercise 1.7.

5. Click any cell in column A and select Format � Column � Width. Type 10 in the Column 
Width box and click OK. Notice the column widens to 10 characters.

6. Click in any cell in the worksheet and select Format � Column � Standard Width. Type 12.5 
in the Standard column width box and click OK. Notice that any column in the worksheet 
that was set at Excel’s default width of 8.43 is now 12.5 characters wide, whereas columns 
that had been changed from the standard width are not altered. Obviously, all empty col-
umns have been adjusted to 12.5 because they are still set to standard width.

7. Row heights have the same adjustment options, except you cannot change the standard 
height setting. Select Format � Row and you’ll see options for Height and Autofit. Click 
anywhere in row 3, and select Format � Row � Height. Change the height to 3 points, and 
then click OK. Notice that the row height is too small and the data is cut off.

8. Still in row 3, go back to Format � Row and choose Autofit, and the row adjusts to fit the 
height of the text in that row, which is the same as double-clicking the gridline below the 
row header, explained in Exercise 1.7. 

9. Leave the file open for the next exercise.

E X E R C I S E  1 . 8 ( c o n t i n u e d )
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As I’m sure you’re aware, if you want to delete all the data in a column or row but leave 
the empty column or row in the worksheet, you just select the cells that have the data in them 
and press the Delete key, or use the Edit � Clear command, or use the right-click shortcut 
menu. But if you want to remove unnecessary rows and columns completely and, in the pro-
cess, automatically adjust the column and row headers, you have a little more of a process to 
follow, which I will address in Exercise 1.9. 

Hiding Rows and Columns

Assume you have a large worksheet and want to edit data in only a few columns or rows, or 
you want to print a special printout that shows only specific columns or rows. In this case, you 
wouldn’t want to permanently delete the unneeded rows or columns, but instead just hide 
them temporarily. Exercise 1.10 shows you how to do this.

E X E R C I S E  1 . 9

Adding and Removing Rows and Columns

1. Still inside Exercise 1-1.xls, move to Sheet3. Click anywhere in column C.

2. Go to the Insert menu and choose Columns, and a new empty column is added to the left 
of column C. The new column is now column C and the original column C data is moved 
to column D.

3. Right-click in the newly created column C and choose Insert from the shortcut menu. 
When the Insert box comes up, choose Entire Column and click OK. This adds a new col-
umn to the left, and again, the column headers are adjusted. (Notice that right-clicking a 
cell also allows you to choose Shift Cells Right or Shift Cells Down if you only want to 
insert a single cell instead of an entire column or row.) 

4. Right-click again and choose Insert � Entire Row and click OK. This adds a new empty 
row above the row you are in. This option is also available when you choose Insert � Rows.

5. Click any cell in one of your new empty columns and choose Delete from the Edit menu, 
then choose Entire Column and click OK.

6. Right-click the other empty column you inserted and choose Delete � Entire Column, 
then click OK. Be sure to delete all of the empty columns you inserted.

7. Using either the Edit or right-click menu, delete the empty row(s) you have inserted by 
choosing Delete � Entire Row and clicking OK.

8. Leave the file open for the next exercise.
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If you accidentally drag to select multiple cells using the wrong mouse 
pointer, cells may move or copy themselves. This is not what you want 
to do, so use your Undo button if the incorrect action occurs.

Organizing Worksheets

You may have noticed that the worksheets in Exercise 1-1.xls are not in the correct order and 
that the sheet tab names are not relevant to the data included in the sheets. The first sheet 
shows sales for January, the second sheet shows the March data, and the third shows Febru-
ary’s information. The exercises in this section will show you how to perform all sorts of 
worksheet tasks. You’ll learn to rename the sheets with names that reveal what is on the sheet. 
You’ll also learn how to color-code sheet tabs, as well as how to move, copy, delete, insert, and 
hide/unhide sheets.

E X E R C I S E  1 . 1 0

Hiding and Unhiding Rows and Columns

1. Move to Sheet1 in Exercise 1-1.xls and click any cell in column D.

2. From the Format menu, choose Column � Hide. Notice column D is now hidden and the 
column headers show A, B, C, E.

3. If you immediately go back to the Format menu and choose Column � Unhide, the column 
you just hid would return to view. But, instead of doing that, click any cell in column F and 
choose Format � Column � Unhide. As you’ll see, nothing happens.

4. Click any cell in column C and, holding your mouse button down, drag to select the cell 
to the right of it in column D so that both cells are selected. Be sure your mouse pointer 
is a white plus sign while dragging, and not a black four-headed arrow or black plus sign 
(these other pointers will be explained later).

5. With the two cells selected, choose Format � Column � Unhide, and column D will return 
to view. To unhide a column, you must select cells on both sides of the hidden column 
beforehand.

6. Once you have unhidden column D, click in any cell and hide that row by choosing For-
mat � Row � Hide. Notice the row is removed from view and the row header numbers 
omit that number.

7. Select a cell in the row above the hidden row, and drag with the white plus sign to select 
a cell in the row below the hidden row. Choose Format � Row � Unhide to bring the row 
back into view.

8. Leave the file open for the next exercise.
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Be aware that many of the actions performed in the exercises in this section 
cannot be undone by simply clicking the Undo button. If you move a sheet to 
the wrong location, delete the wrong sheet, rename a sheet incorrectly, and 
similar mistakes, and then try to backtrack using the Undo button, you will 
notice that it does nothing. In these cases, you will have to manually correct 
the action.

Making Sheet Tabs Make Sense

In order for your sheets to make sense and be well organized, you can name them and color-
code them for clarity. It’s much easier to find something in a workbook if the sheet tabs are 
obvious. Exercise 1.11 explains how to accomplish this.

E X E R C I S E  1 . 1 1

Renaming and Color-Coding Worksheets

1. Move to Sheet1 in Exercise 1-1.xls. Double-click the Sheet1 sheet tab; the name is high-
lighted in black.

2. Type January Sales and press Enter.

3. Right-click the Sheet2 tab and choose Rename. Type March Sales and press Enter.

4. Choose the method you prefer and either double-click Sheet3’s tab or right-click Sheet3’s 
tab and choose Rename. Type February Sales and press Enter.

5. Right-click the sheet tab that now reads January Sales and choose Tab Color. When the 
Format Tab Color box comes up, click any color you like, then click OK. Notice January 
Sales is now underlined in that color.

6. Click the March Sales tab to select that sheet. The January Sales tab is now fully colored 
in the tab color you chose for it.

7. With the March Sales sheet displayed, go to the Format menu and choose Sheet � Tab 
Color. Again, choose a color and click OK. Now the March Sales sheet tab is underlined 
in that color.

8. Move to the February Sales sheet and either right-click it or use the Format menu to 
change the color of that tab.

9. Notice that the active sheet shows a white tab with its name underlined in the chosen 
color, whereas the inactive sheets show the tabs in their full colors. Also, you can see that 
the active sheet tab has bold text.

10. Leave the file open for the next exercise.
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Once the worksheets have self-explanatory names and are categorized by color, the next 
important step is to put them in some logical order. For example, sheets that include data from 
different time periods should be in chronological order, or sheets that have no real logical 
order based on their contents should be in alphabetical order. The important thing is that the 
order makes sense to you and any others using this workbook, similar to the way a filing sys-
tem should be intuitive to the people using it.

Arranging Worksheets in a Logical Order

Don’t forget that workbooks can become quite large and the number of worksheets increases 
as you add new data. Think of the sheets as chapter names in a book and how important it is 
to have those chapters in a sequence that makes sense. Use the instructions in Exercise 1.12 to 
put the sheets in the correct order and add new sheets.

Using Tab Colors

Applying different tab colors not only makes it easier to see which sheet is active, but color 
coding also works well for categorizing the worksheets. I once helped a company that used a 
workbook to keep records of sales for different stores in a chain. There were 20 stores and 
each store was part of either the Eastern region or the Western region categories. A separate 
worksheet was made for each store, with the tab showing the name of that store, and that 
worked well for them. However, they wanted a quick way to identify which store was in which 
region. So, we color-coded the sheet tabs so that all stores in the Eastern region had red tabs, 
while all stores in the Western region had blue tabs. This was very helpful to the company.

E X E R C I S E  1 . 1 2  

Inserting, Moving, and Copying Worksheets

If you want to move a worksheet to a different location, you can simply drag it with your 
mouse and drop it where you want it. 

1. Click the March Sales sheet tab in Exercise 1-1.xls.

2. Holding your mouse button down on the tab shows a white sheet of paper attached to the 
mouse pointer. Continue to hold the mouse button down and move the pointer until it is 
positioned to the right of the February Sales tab. The small black arrow pointing down-
ward indicates where the sheet will be placed when you release the mouse button. When 
you see the black arrow to the right of the February Sales tab, release the mouse button.
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3. Your sheets should now be in order, beginning with January and ending with March.

4. Click the February Sales tab to make that sheet active. Right-click the tab and choose 
Insert.

5. When the Insert dialog box comes up, make sure Worksheet is selected and click OK.

6. You now have a new blank worksheet named Sheet1 inserted to the left of the February 
Sales sheet. New worksheets are always added to the left (before) the active sheet.

7. Rename Sheet1 to Yearly Totals and color the tab any color you choose.

8. Right-click the Yearly Totals tab and choose Move Or Copy. When the Move Or Copy dia-
log box appears, click the text that reads “(move to end)” in the list of choices under 
Before Sheet. Click OK. Now the Yearly Totals sheet is the last one.

9. With the Yearly Totals sheet active, select Insert � Worksheet. A new Sheet2 is now 
added to the left of the Yearly Totals sheet.

10. Rename the new sheet 1st Qtr Sales.

11. Inside the 1st Qtr Sales sheet, select Edit � Move Or Copy Sheet. 

12. From the Before Sheet list, choose Yearly Totals and select the Create A Copy option. 
Click OK. This places a sheet named “1st Qtr Sales (2)” between the 1st Qtr Sales and 
Yearly Sales sheets.

13. Use the methods from steps 8, 11, and 12 to make two more copies of the 1st Qtr Sales 
sheet, so you have 1st Qtr Sales (3) and 1st Qtr Sales (4) also inserted before Yearly Sales.

14. Rename the new sheets 2nd Qtr Sales, 3rd Qtr Sales, and 4th Qtr Sales.

15. Using the previous techniques, either create nine new blank sheets or copy any of the 
empty quarterly sheets until you have sheets for each month. Then rename the sheets to 
reflect the month for which they are intended.

16. Either by dragging or right-clicking and moving, rearrange all your sheets until they are 
in this order: 

January Sales

February Sales

March Sales

1st Qtr Sales

April Sales

May Sales

E X E R C I S E  1 . 1 2 ( c o n t i n u e d )
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Deleting and Hiding Worksheets

As with rows and columns, sometimes you want to remove sheets, either permanently or tem-
porarily. Deleting an entire worksheet is an action that cannot be undone by using the Undo 
button, so instead of having you actually delete sheets, I will simply tell you how to do this. 
If you choose to do it, you will have to re-create the sheets manually so you have all of them 
for future exercises.

To delete a worksheet, you can do one of the following:
� Right-click a sheet tab and choose Delete.
� Select Edit � Delete Sheet.

June Sales

2nd Qtr Sales

July Sales

August Sales

September Sales

3rd Qtr Sales

October Sales

November Sales

December Sales

4th Qtr Sales

Yearly Totals

You may need to use the tab scrolling buttons to the left of your sheet tabs to see all of 
your tabs (see Figure 1.2).

17. Once your sheets are renamed and in the correct order, recolor the tabs so the first month 
of every quarter is the same color, the second month of every quarter is the same color, the 
third month of every quarter is the same color, the quarterly tabs are the same color, and 
the Totals sheet tab is a unique color.

18. Leave the file open for the next exercise.

E X E R C I S E  1 . 1 2 ( c o n t i n u e d )

4002book.fm  Page 26  Friday, March 24, 2006  11:36 PM



Adding and Editing Data in a Workbook 27

Alternatively, sometimes you don’t want to permanently delete the sheet but instead just 
want it out of view temporarily. Exercise 1.13 shows you how to hide worksheets and then 
how to unhide them again.

Saving and Managing Workbooks

When you create a new workbook from scratch, you see in the title bar that Excel temporarily 
names it Book1, Book2, and so forth. When you save this new workbook for the first time, 
either by clicking the Save button on the Standard toolbar or by choosing Save from the File 
menu, the dialog box that appears is named Save As. You can use this box to do three things:

1. Name the file.

2. Choose the location where you want to save it.

3. Choose the file type you want for this file.

However, in that same workbook, if you make more changes and then click the Save but-
ton, or choose File � Save, you will not see the Save As dialog box again. Instead, the file will 
just be saved with the same name you first chose, in the same location and with the same file 
type. The original file will be completely overwritten by the one you save the second time. The 
original file will no longer be available; only the newer version with the changes will exist.

If instead you want to save the new version with a different name, or in a different location, 
or as a different type, you must use File � Save As.

Though you can create folders in the Windows Explorer or My Computer windows, Exer-
cise 1.14 will show you how to use Excel to manage your files and folders in an orderly fash-
ion, which is one of the MOS objectives you could be tested on. The exercise also introduces 

E X E R C I S E  1 . 1 3

Hiding and Unhiding Sheets

1. Click the 1st Qtr Sales sheet tab in Exercise 1-1.xls.

2. From the Format menu choose Sheet � Hide. The sheet tab no longer appears.

3. Repeat step 2 to hide the 2nd Qtr Sales, 3rd Qtr Sales, and 4th Qtr Sales sheets.

4. To unhide sheets, select Format � Sheet � Unhide.

5. A list appears that shows all your hidden sheets. Choose one and click OK to bring that 
sheet back into view.

6. Repeat steps 4 and 5 until all sheets are unhidden.

7. Leave the workbook open for the next exercise.
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you to the dropdown box where you can choose different file format types when saving. Be 
sure to look through the type choices and understand them.

E X E R C I S E  1 . 1 4  

Using Save and Save As 

1. Inside the current workbook that you have been editing, select File � Save As.

2. You will see this dialog box:

3. The file location shown will most likely be the place where the original file was located. 
Click the icon on the left that reads “My Documents.” At the top, in the Save In box you 
now see My Documents.

4. Click the yellow starred folder icon to the right of the Save In box to create a new folder 
inside your My Documents folder.

5. When the New Folder box appears, type Excel 2003 MOS Projects as the name of your 
new folder and click OK.

6. You are now inside your new folder. Click the New Folder icon again.

7. This time, type Chapter One and click OK.

Change the File Type

Choose a Location

Name the File

Create a New Folder
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An even quicker way to close your file and close Excel is to click the X on the 
far-right end of your menu bar to close the file; then click the X above that on 
your title bar to close Excel. 

Moving and Copying Data
Often you have repetitive data that you want placed in more than one location in your work-
book, or you simply want to move your data from one place to another. Excel offers various 
ways to do this. First, let’s look at simple copying and pasting.

Copy and Paste

There are various methods of copying and pasting that are specific to Excel. Something you 
will notice when you copy data in Excel is a moving marquee around the copied data. This is 
the way Excel shows you that something is on your Clipboard. To clear the data from the Clip-
board, you simply press the Esc key on your keyboard and the marquee disappears. 

Exercise 1.15 explores the different ways to copy and paste in Excel.

8. You are now inside the Chapter One folder, which is inside the Excel 2003 MOS Projects 
folder.

9. Now, it is time to name the file. In the File Name box near the bottom of the Save As box, 
type Exercise 1-14 to replace what is already there.

10. As you can see, the Save As Type box contains Microsoft Office Excel Workbook (*.xls). 
Click the dropdown arrow at the right end of that box. This is where you can choose a dif-
ferent format if you will be sharing this file with someone who does not have Excel 2003. 
However, for this exercise you will be choosing the default, so scroll to the top of the 
choices and click Microsoft Office Excel Workbook (*.xls) again.

11. Confirm that you are saving the file inside your Chapter One folder, that you have named 
the file correctly, and that you have the default file type selected; then click Save.

12. Close the file by choosing File � Close; then exit Excel by selecting File � Exit.

E X E R C I S E  1 . 1 4 ( c o n t i n u e d )
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E X E R C I S E  1 . 1 5  

Methods of Copying and Pasting

1. Open Excel and select File � Open. Browse to find the file you saved at the end of the last 
exercise, named Exercise 1-14.xls, and open it. (If you did not do the last exercise or think 
you may have omitted some steps up to this point, extract Exercise 1-14.xls from the 
zipped file for this chapter.)

2. Go to the January Sales sheet.

3. Select cell A7, which contains the store name Riley, and copy it, using one of these methods:

� Click the Copy button on the Standard toolbar.

� Choose Copy from the Edit menu.

� Use the keyboard shortcut Ctrl+C to copy it.

� Right-click the cell and choose Copy.

4. Notice the moving marquee once you have copied the cell.

5. Now move to the February Sales sheet. Click cell A8 and paste, using one of these methods:

Click the Paste button on the Standard toolbar.

Choose Paste from the Edit menu.

Use the keyboard shortcut Ctrl+V.

Right-click the cell and choose Paste.

6. Move to the March Sales sheet and use one of the Paste methods to paste it again, this 
time into cell A12. Whatever is copied remains on the Clipboard for you to paste over and 
over, until you copy or cut something else to overwrite it or you remove it from the Clipboard.

7. Go back to the January Sales sheet and you’ll notice that the moving marquee is still 
present on cell A7. Press the Esc key on your keyboard and the marquee disappears. 
Notice that the Paste button on the Standard toolbar is now grayed out. If you right-click, 
you will see Paste is also grayed out, and if you go to the Edit menu, Paste is grayed out 
there as well. Removing the marquee from the cell removes the data from the Clipboard.

8. Using the copy and paste techniques above, copy cell D7 on the January Sales sheet and 
paste it into cells B8, C8, D8, and E8 in the February Sales sheet. Remember to widen your 
columns if the text is cut off.

9. Go to the March Sales sheet and continue to paste into cells B12, C12, D12, and E12, and 
again, widen your columns if necessary.

10. Return to the January Sales sheet and copy cell A4. (If you are simply going to select a 
new cell to copy, you don’t need to remove the marquee from the original selection; 
Excel will do that automatically.)
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Cut and Paste

Excel also offers different ways to cut and paste both single cells and ranges of cells. When you 
select multiple cells, the first cell in the selection does not appear to be highlighted. However, 
if you look at the Name box to the left of the Formula bar, you will see the name of that cell 
in that box. This assures you that that cell is indeed included in the selection.

It is important to note that if you use the right-click method to copy or cut cells and you 
right-click outside the cell or cells you want to copy or cut, you will copy or cut the wrong 
data, or no data at all. Be sure you right-click in the correct place.

Exercise 1.16 teaches you how to cut and paste, and also shows you how to apply the com-
mands to a range of cells instead of just a single cell.

11. Move to the March Sales sheet and select cell A4 and paste. Note when you paste data 
into a cell that already contains data, the new data overwrites the old.

12. Follow the instructions in Exercise 1.14 to save the file (using the Save As command) into 
your Chapter One folder, but this time, name the file Exercise 1-16.xls. Leave the file open 
for the next exercise.

E X E R C I S E  1 . 1 6  

Methods of Cutting and Pasting

1. Still inside the file you worked on in Exercise 1.15, go to the February Sales sheet.

2. Click cell A8, and holding your mouse button down, drag to select cells A8, B8, C8, D8, 
and E8. Be sure you are using the white plus sign. You will know you did it correctly if all 
five cells are highlighted.

3. With all five cells selected, cut the cells using one of these methods:

� Click the Cut button on the Standard toolbar.

� Choose Cut from the Edit menu.

� Use the keyboard shortcut Ctrl+X to cut it.

� Right-click within the selected cell’s area and choose Cut.

4. Right-click cell A7 and choose Paste. The pasted information overwrites what was origi-
nally in row 7. In this case, that is not what we want, so click the Undo button.

5. Click any cell in row 7 and select Insert � Row. This adds a blank row above the Madison 
information.

6. Now highlight all the data again (note that it is now in row 9 because you inserted a 
new row). 

E X E R C I S E  1 . 1 5 ( c o n t i n u e d )
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Selecting Contiguous and Noncontiguous Ranges

Now that you know how to cut, copy, and paste data, as well as how to delete data, cells, and 
whole rows and columns, it is time to learn how to select multiple cells at one time so you can 
perform these actions on contiguous or noncontiguous blocks of cells, rows, or columns. 
Again, before you begin, you must understand what certain terms mean:

Range The term applied to any block of cells. In Excel, a range is designated or named by 
showing the first cell in the range, then a colon (:), then the last cell in the range. For example, 
the range of cells that starts at cell A1 and continues down and to the right to cell E5 would 
be called A1:E5 (see Figure 1.7).

F I G U R E 1 . 7 The selected range, A1:E5, includes contiguous cells.

Contiguous Refers to cells that are adjacent to each other. The range in Figure 1.7 is a range 
of contiguous cells.

Noncontiguous Refers to cells or ranges that are not adjacent to one another. If I selected 
cells A3, B5, and the range C6:E8, I would be making a noncontiguous selection (see 
Figure 1.8).

When you paste a range, you do not need to select the range where it will be pasted. Simply 
click the first cell of the targeted range area, and paste there. Excel will determine how many 
cells are needed and fill the cells appropriately. Another quirk about pasting in Excel is when 
you paste cells, the column width settings are not automatically pasted along with the data and 

7. Cut the data, and then click cell A7 and paste.

8. Move to the March Sales sheet, and then highlight the data in cells A12 through E12 and cut it.

9. Right-click cell A7 and choose Insert Cut Cells. This pastes the cells in a new row above 
the cell you were in when you chose the Insert command. (If you would prefer to use the 
menu instead of right-clicking, click cell A7 and choose Insert � Cut Cells.)

10. Save the file by clicking the Save button on the Standard toolbar or by choosing File �  
Save. This will overwrite the file with the newer version. Close the file. 

E X E R C I S E  1 . 1 6 ( c o n t i n u e d )
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other formatting attached to the cells. Column widths must be pasted separately. After you 
have pasted the data, you will have to leave the range selected and choose Edit � Paste Special, 
then select Column Widths in the Paste Special dialog box that opens.

F I G U R E 1 . 8 This is an example of a noncontiguous selection of cells and ranges.

Exercise 1.17 will show you how to select contiguous ranges and move, copy, paste, and 
delete them.

E X E R C I S E  1 . 1 7  

Selecting Contiguous Ranges

1. Open the file Exercise 1-16.xls that you saved at the end of the last exercise. (If you did 
not save this file, extract it from the zipped file for this chapter.)

2. Move to the March Sales sheet.

3. Click cell A3. Be sure your mouse pointer is the white cross, and hold your mouse button 
down and drag to select the range A3:A12.

4. Using one of the copy methods described in Exercise 1.15, copy the range.

5. Move to the 1st Qtr Sales sheet. Click cell A3 and use one of the paste methods described 
in Exercise 1.15 to paste the data.

6. Move back to the March Sales sheet. You’ll notice the marquee moving around the range 
you copied. Do not bother to press Esc to remove the marquee. Simply highlight the 
range B3:E3 and copy that.

7. Move to the 1st Qtr Sales sheet; click cell B3 and paste.

8. With the pasted range still selected, choose Edit � Paste Special and select Column 
Widths. Then click OK. Now your columns adjust to the same widths as the columns that 
held the data you copied.

9. Move back to the March Sales sheet, highlight the range A12:E12, and cut it.

10. Move to the April Sales sheet, click cell A12, and paste.
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Selecting contiguous ranges is fairly straightforward. However, to select noncontiguous 
ranges, you must use some keyboard combinations. Excel will not let you cut or copy non-
contiguous cells; however, you can delete them or format them all at one time, so there are still 
many uses for noncontiguous selections. Exercise 1.18 shows you what happens when you try 
to cut or copy noncontiguous selections.

11. Move back to the March Sales sheet and you’ll see that the data you cut is gone.

12. Go to the 1st Qtr Sales sheet and select (highlight) the range B3:E3 (which may already 
be selected because pasting it there was the last action you did on that sheet). With that 
range selected, press the Delete key on your keyboard to remove it.

13. Select the range A3:A12 using an alternative keyboard technique: Click cell A3 to select 
it, then release your mouse button; then hold down your Shift key and press the ↓ key one 
time to add cell A4 to the selection. Continue holding Shift and tapping ↓ to select cells 
A5:A12. Then delete this range as well. The 1st Qtr Sales sheet should now be empty.

Yet another way to select a range is to click the first cell, then Shift+click the last cell. Try 
it. Undo the last deletion you did, then click cell A3; hold down Shift and click cell A12. 
You’ll see that this selects the whole range. Delete the range again.

14. Use the Save As command to save this file in your Chapter One folder, and name it Exer-

cise 1-17.xls. Leave the file open for the next exercise.

E X E R C I S E  1 . 1 8  

Selecting Noncontiguous Ranges

1. In the March Sales sheet, select the range A3:A11. (Remember that you cut the data from 
row 12 in Exercise 1.17, so that row should be empty.)

2. With A3:A11 selected, hold down your Ctrl key, click cell B3, and drag the white plus sign 
over to cell E3 to add that to your selection. Note that B3 does not appear to be high-
lighted but B3 shows in the Name box, so that assures you that it is included in the selection.

E X E R C I S E  1 . 1 7 ( c o n t i n u e d )
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3. Now try to copy that selection. You see this error message:

4. Click OK to clear the message. 

5. You cannot copy noncontiguous selections. Try to cut it instead. You see this similar 
message:

6. Click OK to clear the message.

7. With the noncontiguous range selected, press Delete on your keyboard and the cells will 
be cleared.

8. Click the Undo button to bring the deleted data back.

9. Try another noncontiguous selection:

a. Select the range A3:E4.

b. Holding down your Ctrl key, click cell B6.

c. Still holding the Ctrl key, select the range C7:D11.

Here’s how your selection should look:

E X E R C I S E  1 . 1 8 ( c o n t i n u e d )
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Using the Office Clipboard

The Windows Clipboard is rather limited; it holds only the last item you cut or copied. As soon 
as you cut or copy something new, the previous item is overwritten. However, Excel allows 
you to use the Office Clipboard, which can hold up to 24 blocks of data at one time. This lets you 
make multiple cuts and copies before you paste any of them, and then you can choose what 
you want to paste, and where you want to paste it. This is the way to override Excel’s behavior 
of not allowing you to cut or copy noncontiguous selections. Exercise 1.19 shows you how.

10. To deselect the selection, simply click in any cell that is not part of the selection.

11. Close the file and click Yes when Excel asks if you want to save it. This will overwrite the 
previous copy.

E X E R C I S E  1 . 1 9  

Pasting Multiple Cut and Copied Blocks of Data

1. Open the file Exercise 1-18.xls that you saved in the last exercise. (If you did not save it, 
extract it from the zipped file for this chapter.)

2. Select Edit � Office Clipboard.

3. The Office Clipboard task pane appears. It should be empty, as shown here. If it is not 
empty, click the Clear All button near the top.

E X E R C I S E  1 . 1 8 ( c o n t i n u e d )
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4. Move to the January Sales sheet. Use one of the methods you learned earlier to get into 
Edit mode in cell A1 and change the content of the cell to read January Monthly Sales 
Report.

Reminder: To get into Edit mode in a cell, do one of the following:

� Double-click the cell.

� Click the cell and press F2.

� Click the cell; then click in the Formula bar.

5. Still in Edit mode, using the I beam, drag across the text “Monthly Sales Report” to select 
all the text except the word January. Copy it and it will appear on your Office Clipboard.

6. Move to the March Sales sheet, select the range A3:A11, and copy it. It also appears on 
the task pane.

7. Next, select B3:E3 and copy that range.

8. Now, select B11:E11 and cut that range. Then select A11 and press Delete. 

9. You now have four different blocks of data on your Office Clipboard. Move to the Febru-
ary Sales sheet.

10. Get into Edit mode in cell A1 and select just the word Sales, not the word February.

11. With the word Sales selected, click the task-pane text that reads “Monthly Sales Report.” 
Notice that the text is pasted over what you had selected, so cell A1 now says “February 
Monthly Sales Report.”

12. Go to the March Sales sheet and repeat step 11 to change cell A1 to “March Monthly 
Sales Report.”

13. Go to the April Sales sheet and type the word April in cell A1; press your spacebar one 
time; then click the text “Monthly Sales Report” in the task pane. Cell A1 now shows 
“April Monthly Sales Report.”

14. Follow the previous procedure to put the appropriate month, followed by a space, fol-
lowed by the text “Monthly Sales Report” into the May through December Sales sheets 
(not in the Qtr Sales sheets nor the Yearly Totals sheet).

E X E R C I S E  1 . 1 9 ( c o n t i n u e d )
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Using the Mouse to Drag and Drop or Fill Data

Up to this point, you have used three different mouse pointers (the white plus sign, the row/
column resizing pointer, and the I beam), but Excel has more and you must understand them 
in order to use them correctly to perform the action you intend. The ones we will use for this 
exercise are pictured in Figure 1.9.
� The white plus sign is used only for selecting cells and ranges.
� The black four-headed arrow is used to drag and drop cells and ranges.
� The black plus sign is seen only if your mouse hovers over the fill handle on a cell. The fill 

handle is the small black box you see in the lower-right corner of any selected cell or 
range, as shown here. This pointer is used to copy data or fill a series.

15. Once you have completed all of the monthly sales sheets, move your mouse over the task-
pane text that reads “Monthly Sales Report.” You will see a dropdown arrow to the right of 
the text. Click this arrow and choose Delete to remove this item from the Office Clipboard.

16. Move to the 1st Qtr Sales sheet and click cell A3. Click the list of store names in the task 
pane to paste them into cells A3:A11.

17. Click the April Sales sheet. Click cell A3 and paste the store names.

18. Click cell B3 and paste the week titles (Week 1, Week 2, etc.).

When using the Office Clipboard, your column widths do not come through; choosing Paste 
Special gives you different choices, and you cannot choose to paste the column widths. You 
will have to use one of the other methods you learned to adjust the column widths.

19. Click cell B11 and paste the numbers for the Flora store.

20. Click the Clear All button at the top of the task pane to remove all of the items from the 
Office Clipboard.

21. Use the Save As command to save the file in your Chapter One folder and name it Exer-

cise 1-19.xls. Close the file and close Excel.

E X E R C I S E  1 . 1 9 ( c o n t i n u e d )
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F I G U R E 1 . 9 Mouse pointers can make a big difference in Excel.

It’s definitely easier to understand these pointers in action, so you’ll get a chance to practice 
using them in Exercise 1.20. 

E X E R C I S E  1 . 2 0  

Using the Different Mouse Pointers to Select, Move, and Copy Data

1. Open Excel with a new blank workbook showing.

2. In cell A1, enter the number 100 and press Enter.

3. Click cell A1 and copy it.

4. Select the range A2:B10, using the white plus sign pointer, and paste. Note that you can 
paste the same data into multiple cells if you select the range before you paste.

5. Use the Ctrl key with the white plus sign to select cells C1, C3, and C10, and paste again. 
Note that you can paste into noncontiguous cells as well. Notice the marquee remains 
around cell A1 because the content of A1 is still on the Clipboard and you can continue 
to paste it as many times as you want until it is cleared from the Clipboard.

6. Press your Esc key to remove the marquee and clear the Clipboard.

7. Select cell A1 and type 200, then press Enter.

Black Plus Sign

White Plus Sign

Black Four-Headed Arrow
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8. Select cell A1 again and, without holding the mouse button down, move your pointer 
over cell Al’s edge until you see the black four-headed arrow. Click with this pointer and 
drag the cell over to cell F7. As you drag, the pointer changes to a white diagonal arrow 
and a tooltip shows the cell name you are over. When the tooltip shows F7 (see the fol-
lowing graphic), release your mouse button. The number 200 has been moved from A1 
to F7.

9. Using the black four-headed arrow again, drag cell F7 until it is over cell F2, but this time 
hold the Ctrl key down while you drag. Notice the small plus sign attached to the white 
arrow. The plus sign tells you that you are copying the cell instead of moving it.

10. Select the range A2:B4, use the black four-headed arrow to drag it to the range D6:E8, and 
drop it. Note that the tooltip shows the range that will be filled instead of just one cell 
name. 

11. Select the range D6:E8 and Ctrl+drag it to the range A2:B4 and drop a copy of it there.

12. Edit cell A2 so the value is 300 and press Enter. Select A2 again and hover your mouse 
pointer over the fill handle of that cell, in the lower-right corner, until you see the black 
plus sign.

13. Click with the black plus sign and drag the number 300 down to cell A10. Notice that it 
copies 300 to every cell you pass over on your way to A10.

14. You’ll notice the Options button that appears to the lower right of cell A10. Click it to see the 
Auto Fill options, such as Copy Cells, Fill Without Formatting, and so forth, as shown here:

15. The default option, when you drag using the fill handle, is to simply copy the cells. 
Choose Fill Series, and the numbers will progress in a series from 300 to 308.

E X E R C I S E  1 . 2 0 ( c o n t i n u e d )
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There are many ways to use Auto Fill, and more of them are explained in 
Chapter 4, “Editing Tools, Comments, and Hyperlinks.”

Summary
Understanding how to easily move around a workbook and quickly move to any given section 
is imperative for the most effective use of the program. Knowing which menu houses which 
command will also speed up your process, with less trial-and-error guesswork. Commands 
can be executed in Excel by choosing a command from a menu, choosing a command from the 
task pane, right-clicking and selecting a command from a shortcut menu, using the various 
toolbar buttons, or using keyboard shortcuts.

An Excel file is called a workbook; workbooks can include many worksheets. You can nav-
igate through a workbook, from sheet to sheet, and navigate through a worksheet, from cell 
to cell. Or you can use methods to move to specific content from anywhere in the workbook.

You can add data and edit data, add new worksheets and edit sheet names, and add and 
remove cells, columns, and rows. You can also manage the size of your rows and columns.

Excel helps you manage your files and folders by using the Save As dialog box to name files, 
create new folders, choose the location where you want the file saved, and specify the file type.

After data is entered in a worksheet, you can move it or copy it to another location on the 
sheet, or to another sheet. Moving and copying can be done by using the cut, copy, and paste 
commands or by using the mouse to drag and drop or fill.

You can select parts of the content of any cell, or the entire cell, or entire ranges, either 
contiguous or noncontiguous. Once selected, the selection can be moved, copied, or deleted 
in one step.

16. Select cells A9 and A10, which now contain 307 and 308. Now use the black plus sign on 
the fill handle on A10 to drag both cells down to A15. When you select multiple cells, 
Excel recognizes the series and fills the series by default.

17. Click the Options button and choose Copy Cells. Now instead of filling the series, Excel 
just copies 307 and 308 over and over.

18. Continue to explore different ways to use the different mouse pointers to move, copy, 
and fill data. When you are done, close the file and close Excel. You do not need to save 
this one.

E X E R C I S E  1 . 2 0 ( c o n t i n u e d )
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Exam Essentials
Know the terminology. Get familiar with the terms used in Excel so the MOS scenarios 
make sense to you. Remember to use tooltips to identify the names of everything onscreen.

Learn the quickest way to do everything. Try all the methods for moving around the work-
sheets and find the ones that work best for you. Get familiar with where everything is located. 
The MOS Exam is a timed exam, so know how to use the shortcuts like Go To and Find.

Be sure you understand the difference between deleting content and deleting cells. Under-
stand how to delete content, as well as cells, rows, columns, ranges, and sheets. Also, know 
how to insert rows, columns, and cut cells.

Be able to move and copy data, cells, ranges, and sheets. Know the difference between 
move (cut and paste) and copy (copy and paste), and understand all the ways to select contig-
uous and noncontiguous data and use the Office Clipboard.

Understand the cell modes and mouse pointers. Be aware of what mode (Ready, Enter, and 
Edit) you are in when working in cells, and be sure you know which mouse pointer does what.

Be able to modify row and column formats. Know how to resize rows and columns, using 
both the mouse pointer and the Format menu.

Know how use the Save As dialog box. Understand how to create folders in the correct 
locations, how to save files into the correct folders, and how to choose the correct file type.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter; then check the solutions to see how you did. To complete these exercises, you will 
need to extract the file MOS Scenarios Ch 1.xls from the zipped file for this chapter. Open the 
file in Excel before you begin the scenario exercises.

 

MOS Scenario 1: Enter and Edit Cell Content and Manage Columns and Rows

Change the store names in column A, beginning with A4, to Bayberry Shops; Wilson Appli-

ances; The French Corner; Riley & Sons, Inc.; Madison Avenue; The O’Leary Bros.; and Rose-

wood Plaza. Change the dollar amounts for the Madison Avenue row so that they are all 
exactly 100 dollars higher. Add a row above The O’Leary Bros. row and enter the shop name 
Smithfield Clothiers, with sales for each week that are the same as the sales for Wilson Appli-
ances. Adjust all columns so they fit the longest data in the column.
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MOS Scenario 2: Add Worksheets and Find Data

Rename the worksheet to March 2005, then add two more sheets and name them March 2004 
and March 2003. Rearrange the sheets so they are in chronological order and make each tab 
a different color. Copy all of the data from the March 2005 sheet and paste it into both of the 
other sheets. Find all occurrences of The French Corner and change them to The French Riviera 
on all three sheets. Make sure all column widths are adjusted appropriately.

 

MOS Scenario 3: Insert, Move, and Delete Cells and Save Files

On the March 2005 sheet, delete row 2 and change the height of the new row 2 to 20 points. On 
the March 2004 sheet, insert a cell above C9 so that the value in C9 moves down to C10. Cut the 
value in C12 and paste it into C11. Save the file into the My Documents folder inside a new 
folder you create called MOS Scenarios. Name the file ChapterOneScenarios.xls. Move to the 
March 2005 sheet and save the file as a text (tab-delimited) file in the same location with the 
name ChapterOneScenarios.txt. 

4002book.fm  Page 43  Friday, March 24, 2006  11:36 PM



4002book.fm  Page 44  Friday, March 24, 2006  11:36 PM



 

Chapter

 

2

 

Formats, Graphics, 
and Excel’s Templates

 

MOS SPECIALIST OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Insert, position, and size graphics

�

 

Create, modify, and position diagrams and charts based on 

worksheet data

�

 

Apply and modify cell formats

�

 

Apply and modify cell styles

�

 

Format worksheets

�

 

Create new workbooks from templates

 

MOS EXPERT OBJECTIVES COVERED IN 
THIS CHAPTER:

�

 

Format and resize graphics

�

 

Format charts and diagrams
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Contrary to popular belief, spreadsheets do not have to be plain 
and boring. You can apply formatting that not only makes a 
workbook more appealing to the eye, but also highlights impor-

tant data so it won’t be overlooked. And, you can add graphics that clarify the data, such as 
charts and diagrams. Remember the old saying: “A picture is worth a thousand words;” in 
Excel, this is definitely true. What better way to show the relationship between five depart-
ments’ sales than in a chart? What’s clearer to you: a long list of numbers or a diagram with 
arrows pointing out selected highs and lows? If you submit a budget proposal to your boss, 
how long can they stare at a boring black-and-white directory of endless data, all in 10-pt. 
Times New Roman font, before falling asleep?

In this chapter, I’ll show you how to add color and graphics to your workbooks, as well as 
how to keep formatting consistent from cell to cell, sheet to sheet, and even workbook to 
workbook. I’ll also discuss the many features that automate the formatting process such as 
styles and templates, as well as charts and diagrams that you can produce, based on your data. 

I’ve provided the files you will need for this chapter to help you become proficient in all of 
the MOS objectives related to formatting and graphics, on both the Specialist and Expert lev-
els. Download the file exl2003ch02.zip and extract the contents before you begin this chapter. 

 

Because all of the exercises in this chapter will make your worksheet look very 
different, I suggest you use the extracted files to view my versions of the 
changes after you complete each exercise. Also, if there are any instructions 
you don’t understand, view my completed files to see what I did. For most of 

 

this, seeing what I did will be more helpful than just reading it.

 

First, let’s get acquainted with the two features you will use to format individual cells or cell 
ranges: the Formatting toolbar and the Format Cells dialog box.

 

Using the Format Cells Dialog Box and 
the Formatting Toolbar

 

In Excel, formatting relates to anything that controls how the data is displayed—whether it’s 
changing colors or controlling how many decimals are displayed in a number. You can use the 
buttons on the Formatting toolbar for most of the common cell-formatting commands (rest 
your mouse pointer on any button that is unfamiliar to you to see the tooltip that displays its 
name, then refer to Table 2.1 for an explanation of what it does). Or, you can access the more 
extensive choices available through the Format menu, specifically Format �

 

 Cells.
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Immediately to the right of some buttons you can see a small downward-pointing arrow. 
Clicking that gives you various choices: the Font Color dropdown lets you choose a color, the 
Font Size button lets you choose a font size, and so on. If you click the down arrow beside 
the Font Color button and then run your mouse over the colored boxes, you’ll see tooltips that 
display the color names (see Figure 2.1). 

 

F I G U R E 2 . 1

 

Submenus for buttons display more choices and can be moved to become 

 

floating toolbars while you use them.

 

T A B L E 2 . 1

 

Buttons on the Formatting Toolbar and What They Do

 

Button Name Description

 

Font Choose the font type.

Font Size Choose the font size.

Bold, Italic, Underline Choose a 

 

font attribute

 

: bold, italic, and/or underline.

Align Left, Center, Right Align data within a cell: left, center, or right.

Merge and Center Merge the data into one cell and center it within the selected range.

Currency Style Add the currency style to a cell, including a dollar sign and two 
decimal places.

Percent Style Add the percentage style to a cell.

Comma Style Add comma separators to numbers over three digits.

Increase/Decrease Decimal Increase or decrease the number of decimal places displayed.

Increase/Decrease Indent Increase or decrease the indentation of data in a cell.

Borders Add borders to cells or ranges.

Fill Color Fill the background color of cells or ranges.

Font Color Choose a font color for cells, ranges, or individual content 
within a cell.
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If you click the actual Font Color button, it will change the font color to whatever color 
underlines the A (the default is red, but the default will change to the last color you chose). To 
choose a different color, you must click the dropdown arrow to the right and not on the actual 
button.

If you are going to be making a lot of changes using certain submenus, you can grab the sub-
menu by its title bar, which shows a series of dots (see Figure 2.1); then drag it off the toolbar 
so it is freestanding. Move your mouse pointer over its title bar and see the four-headed arrow; 
click and drag it to a location on your worksheet. When you are done with it, click the X in 
its upper-right corner to close it. Not all submenus have this option, but on the Formatting 
toolbar, the Font Color, Fill Color, and Borders buttons do. Whenever you see that series of 
dots at the top of any submenu, you will know you can drag it off and make it freestanding.

Before we jazz up these dull spreadsheets, let’s look at the most basic formatting choices 
first: the fonts.

 

Font Formatting

 

Before I teach you how to assign font formats, let’s take a moment to familiarize you with the 
terminology related to fonts. 

 

Font formatting

 

 includes various components: font type, font 
size, font color, font style, and font effects.
�

 

Font type

 

 refers to the name of the font. Fonts are either serif or sans serif. Serif is the small 
decorative line added to a character as an embellishment. 

�

 

Times New Roman is a serif font and has extra decorative lines added to characters.
�

 

Arial is a sans serif font (sans meaning “without”) and no extra lines are added to 
characters. 

�

 

Fonts are also either 

 

true type

 

 or 

 

bitmap

 

.
�

 

True type fonts are WYSIWYG (“What you see is what you get”) and appear the same 
in print as they appear on your screen. In Excel 2003, with rare exceptions, the only 
fonts you will have in your choices are true type fonts.

�

 

Bitmap fonts are graphic fonts, which are fixed-size fonts.
�

 

Font size

 

 is determined in points. There are 72 points per inch; therefore a one-inch font 
is 72 points.

�

 

Excel displays 40 default 

 

font color

 

 choices. 

 

The default font color choices can be modified, but that won’t be covered until 

 

Chapter 12, “Customizing Excel and Setting Defaults.”

�

 

Font style

 

 includes the attributes of bold, italic, and underlined.
�

 

Font effects

 

 include strikethrough, subscript, and superscript.
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Font formatting can be applied to individual selected parts of a cell, or the entire cell, or a 
full selected range of cells. You can apply it to data already in the workbook by selecting the 
data first, or you can apply it to any cell or range before adding the data.

Most font formatting can be applied easily using the Formatting toolbar. The font choices 
used in this chapter are based on the default fonts that come with Windows XP and Office 2003. 
If for some reason you do not have the font choice requested in the following exercises, choose 
an alternative.

Exercise 2.1 teaches you how to apply basic font settings using the Formatting toolbar. 

 

E X E R C I S E  2 . 1  

 

Using the Formatting Toolbar to Change Font Formats

 

1.

 

Open the file Exercise 2-1.xls.

 

2.

 

Click the January Sales sheet tab and select cell D7.

 

3.

 

On the Formatting toolbar, the Font dropdown box on the left end displays all of your 
available font types and currently displays your default font (which is probably Arial). 
From that dropdown, choose Times New Roman. (Instead of scrolling through all of the 
choices in the font type dropdown, click in the dropdown box and type 

 

ti

 

. Times New 
Roman will appear—Simply press Enter and it will be applied to the cell.)

 

4.

 

Notice that all of the text in cell D7 (“out of business”) is changed to Times New Roman.

 

5.

 

Double-click cell E7 to get into Edit mode.

 

6.

 

Once in Edit mode, double-click the word “business” to select just that word.

 

7.

 

Choose Times New Roman from the dropdown list to apply that font type to the selected 
word only.

 

8.

 

Select empty cell C6 and choose Comic Sans MS from the Font Type dropdown list. Then 
type 

 

430.1

 

 into that cell. See the font is applied.

 

9.

 

Using the methods for selecting noncontiguous cells that you learned in Chapter 1, select 
both ranges A3:E3 and A4:A8.

 

10.

 

From the Font Size dropdown choose 14. Then click the B button to make the font bold. 
Resize column widths and row heights, if necessary, to display the full data. Notice, if you 
double-click the right edge of the column A header, the column resizes to fit what is in A1. 
You can drag the column header back to the left so it fits the data below that instead, because 
A1 has no data to the right of it and, therefore, can spill over into the cells to the right.

 

11.

 

Select cell A1 and use the toolbar buttons and dropdowns to format it as Verdana, 18 pt., 
bold. Then use the down-pointing arrow to the right of the Font Color button to choose 
Indigo (see Figure 2.1).
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Though you can do a lot with fonts using the Formatting toolbar, even more options are 
available to you using the Format Cells dialog box. One of the main advantages to formatting 
your fonts from this dialog box is that it shows you a preview of how your selection will look. 
Exercise 2.2 will familiarize you with the choices available in this dialog box:

 

12.

 

Double-click cell A1 to get into Edit mode; then double-click the word 

 

January

 

 to select 
it. Click the I (italic) and U (underline) buttons to add those attributes to the already 
bolded (B) text.

 

13.

 

Save the file, using the Save As command described in Chapter 1; this time create a 
new folder named 

 

Chapter Two

 

. Save this file in the Chapter Two folder and name it 

 

Exercise 2-2.xls

 

. Do not close the file.

 

E X E R C I S E  2 . 2  

 

Formatting Fonts Using the Format Cells Dialog Box

 

1.

 

Move to the February Sales sheet in Exercise 2-2.xls and select the ranges A3:E3 and 
A4:A8.

 

2.

 

From the Format menu, choose Cells.

 

3.

 

Inside the Format Cells dialog box, click the Font tab at the top.

 

4.

 

From the Font list, choose Verdana.

 

5.

 

In the Font Style list, click Bold Italic.

 

6.

 

In the Font Size list, choose 14.

 

7.

 

From the Color dropdown box, choose Red and see how the preview changes.

 

8.

 

Click OK to apply your changes and close the dialog box.

 

9.

 

With the cells still selected, select Format �

 

 Cells. Click the Font tab and select the Normal 
Font checkbox. In the Preview box, your fonts will be returned to the defaults. Click Can-
cel to reject this change and close the dialog box.

 

10.

 

Adjust your column widths and row heights, if necessary.

 

11.

 

Select cell B4. Choose Format �

 

 Cells and click the Font tab. Select the Superscript check-
box and click OK.

 

12.

 

Note that the number is raised and smaller. This is the Superscript font effect.

 

13.

 

Return to the Format Cells dialog box, deselect Superscript—select Strikethrough, and 
click OK. You can now see the Strikethrough effect.

 

E X E R C I S E  2 . 1

 

( c o n t i n u e d )
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Using the Different Cell Formats

 

The Format Cells dialog box contains other tabs in addition to the Font tab. This is because 

 

cell formatting

 

 includes more than just font formatting. Actually, in Excel, font formatting is 
only a small part of cell formatting. The other tabs in that dialog box allow you to specify how 
you want your values displayed, how the data should be aligned within a cell, how you want 
the cell borders customized around a cell or range, and how you want the cells filled with back-
ground colors and patterns. Some of the simpler format options are also available from the 
Formatting toolbar (see Table 2.1), so let’s explore them first.

 

14.

 

Return to the dialog box and deselect Strikethrough. Then click OK.

 

15.

 

Save the file to update it with these changes. Close the file.

 

E X E R C I S E  2 . 3  

 

Applying Cell Formatting Changes Using the Formatting Toolbar

 

1.

 

Open the file Exercise 2-2.xls that you saved in the previous exercise. If you did not save 
it, you can extract it from the zipped file for this chapter.

 

2.

 

On the January Sales sheet, using the Ctrl+drag technique, select all the cells that have 
numbers in them (B4:E5, C6:E6, B7:C7, and B8:E8) and click the $ on the Formatting tool-
bar. This adds a dollar sign in front of each number and displays each number with two 
decimal places showing and a comma separator whenever a number is over three digits.

 

3.

 

With the cells still selected, click the Increase Decimal button one time. Note that all 
selected numbers now show three decimal places.

4. Click the Decrease Decimal button one time to return to two decimal places displayed.

5. Select the range A3:E3 and click the Center Alignment button. Then, click the Undo but-
ton on your Standard toolbar.

6. With A3:E3 still selected, click the Increase Indent button three times. Then, click the 
Decrease Indent button one time.

7. Click the dropdown arrow to the right of the Borders button and choose Thick Box Bor-
der, as shown here:

E X E R C I S E  2 . 2 ( c o n t i n u e d )
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The Merge & Center button used in the previous exercise can be problematic. 
Though it appears to be helpful, when you try to perform certain actions 
down the road, such as sorting and filtering, including merged cells in a selec-
tion, Excel will present an error message telling you the action cannot be per-
formed on merged cells. Because of this, I do not recommend you use this 
feature-and will show you later (in Exercise 2.5) what I recommend as an 
alternative to Merge & Center.

As stated previously, the Formatting toolbar allows only minimal cell formatting. To find 
more cell-formatting options, you need to use the Format Cells dialog box. See Table 2.2 for 
explanations of the choices from the Format Cells dialog box.

8. Click the Fill Color dropdown arrow and choose Light Green.

9. Click any cell outside of the selected range to see the border and background color 
applied.

10. Select cell A1. Notice that the text appears to run across multiple cells, but if you look 
in the Formula bar, you will see all of that text is in A1. If you click cells B1, C1, etc., you 
will see they are empty cells. Select the range A1:E1 and click the Merge & Center button. 
Now try to click the individual cells and you will notice that, no matter where you click in 
cells A1:E1, the Name box always displays A1. Only if you click into F1 will the cell address 
change in the Name box. In essence, cells B1:E1 no longer exist. Those cells have been 
merged into cell A1, with the data center-aligned within.

11. Save the file into your Chapter Two folder and name it Exercise 2-4.xls. Do not close 
the file.

T A B L E 2 . 2 The Different Cell Formats Explained 

Format Description

General Data that requires no specific format.

Number General numbers that will be used in calculations.

Currency General monetary values.

E X E R C I S E  2 . 3 ( c o n t i n u e d )
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Exercise 2.4 will guide you through the use of some of these formats. 

Accounting Currency with decimal places and dollar signs lined up as accoun-
tants prefer them.

Date Dates that Excel will assign serial numbers so they can be correctly 
calculated (I’ll explain this in Chapter 5, “Formulas and Functions in 
Excel”).

Time Times of day that Excel will assign serial numbers (explained in 
Chapter 5).

Percentage Numbers will be multiplied by 100 and a % symbol will be added.

Fraction Converts everything after a decimal point to a fraction.

Scientific Applies the scientific format, as seen in a scientific calculator.

Text Data will show exactly as entered. Numbers assigned a text format 
cannot be used in calculations.

Special Zip codes, Social Security numbers, etc.

Custom Used to define a new format, when none of the other formats meet 
your needs (I’ll cover this in Chapter 7, “Advanced Data Organization 
and Display”).

E X E R C I S E  2 . 4  

Controlling Data Formats Using the Numbers Tab

1. Move to the February Sales worksheet in Exercise 2-4.xls and select cells B4:E4.

2. From the Format menu, choose Cells; then click the Number tab.

3. Notice the numbers are formatted as General; the Sample box shows how they will be 
displayed.

4. Click Number in the category list and the options are displayed on the right, below the 
Sample box.

T A B L E 2 . 2 The Different Cell Formats Explained (continued)

Format Description
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5. Choose 2 in the Decimal Places scroll box; select the Use 1000 Separator checkbox, and 
choose the Negative format at the bottom that is red and in parentheses, as shown here:

6. Click OK and note how the data is now displayed in B4:E4. Select cell B4, type -1010.7, and 
press Enter. Because you typed a minus sign at the beginning of the number, Excel rec-
ognized it as a negative number and used the negative formatting choice you made. Also, 
the comma was added after the first 1 and a zero was added at the end to make it two dec-
imal places.

7. Select cells B5:C5 and right-click within the selected area; choose Format Cells. Note that 
this brings you to the Format Cells dialog box also.

8. On the Number tab, choose Currency. On the right, choose 2 decimal places; select the 
dollar sign ($) as your symbol, and choose the same negative format you chose previ-
ously (red, in parentheses). Click OK and notice the formatting applied.

9. Select cells D5:E5 and repeat the previous steps, but this time choose the Accounting cat-
egory, using the same two-decimal format with a dollar sign as the symbol. (You have no 
choice for the negative format because the default format used by accountants will be 
applied automatically.) Click OK.

10. Select cell B6 and return to the Numbers tab in the Format Cells dialog box.

11. Click the Percentage category and note that the sample shows the number formatted as 
a percentage.

12. Click the Fractions category and note that the numbers after the decimal place are con-
verted to fractions.

E X E R C I S E  2 . 4 ( c o n t i n u e d )
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Cell Alignment

In Exercise 2.3 you used the alignment buttons on the Formatting toolbar, and you learned 
how to increase and decrease the indentation and use the Merge & Center button. However, 
cell alignment in Excel allows you more options, including vertical alignment and text wrap-
ping, which are available only via the Format Cells dialog box. I also mentioned earlier that 
I would show you an alternative method of centering text across multiple cells, because I do 
not like the Merge & Center option.

Exercise 2.5 will teach you how to fine-tune cell alignment using the Alignment tab in the 
Format Cells dialog box.   

13. Click the Scientific category and you’ll see the numbers displayed in a scientific format.

14. Check out the Text and Special formats as well.

15. After previewing the different formats in the category list, click the Cancel button at the 
bottom of the box so none of your choices are applied.

16. Save the file to update it. Then close the file.

The Sad Story of Merge & Center

As I mentioned previously, Excel includes the Merge & Center feature and it appears, at first 
glance, to be useful. However, whenever you try to perform certain actions (sorting, filtering, 
and even some copying and pasting) that require selecting merged cells as part of a range, 
Excel will tell you the action is not possible because the range you selected includes merged 
cells, and then Excel will tell you to remove the merged cells before you perform your selected 
action. When I worked on a help desk, I can’t tell you how many problems people reported to 
me that required removing the merged cells. For this reason, I always recommend you use 
the Center Across Selection feature instead. Because this action only makes your cells appear 
to be merged but actually they remain separate cells, it will not cause the same errors. 

However, if you choose not to heed this warning and do use the Merge & Center command, 
notice the Merge Cells checkbox on the Alignment tab in the Format Cells dialog box. You 
would need to deselect this checkbox when you receive this error. Then you would also have 
to remove the center horizontal alignment to see the full contents of the cells you unmerged. 
And finally, you would need to follow the directions in Exercise 2.5 to center the data across 
the selected range again.

E X E R C I S E  2 . 4 ( c o n t i n u e d )
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E X E R C I S E  2 . 5  

Controlling Cell Alignment Using the Format Cells Dialog Box

1. Open the file Exercise 2-4.xls that you saved in the previous exercise. If you did not save 
it, extract it from the zipped file for this chapter.

2. Move to the February Sales sheet and select the range A1:E1. Open the Format Cells dia-
log box and click the Alignment tab.

3. At the top of this dialog box are choices for both Horizontal and Vertical Text alignment. 
From the Horizontal Alignment box, choose Center Across Selection and from the Verti-
cal Alignment box, choose Center. Click OK.

4. Click cell A1 and note that in the Formula bar the text is still in A1, even though it appears 
to be in cells B1:D1. Clicking cells B1, C1, D1, and E1 shows they are empty but still iden-
tified as individual cells in the Name box.

5. Be sure cells A1:E1 are still selected and change the font to Verdana, 18 pt., Indigo. Now, 
drag the bottom edge of the Row 1 row header (the gray box at the left end of the row that 
shows the number 1) until the tooltip shows it is 50 pixels tall. Note that, because you 
center-aligned the cell vertically, the content is midway between the top and bottom of 
the row.

6. Select A3:E3, right-click within the selection, and choose Format Cells. 

7. Click the Alignment tab and, in the Orientation section on the right, either drag the little 
red diamond in the diagram or use the Degrees box to change the orientation to 45 
degrees, as shown here:

8. Click OK. Your headings are now at a 45° angle.

9. Edit cell A4 to read Bayberry Department Store; change cell A8 to read Madison Elec-

tronics. Note the text is cut off because the column is too narrow.
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Applying Cell Borders and Patterns

In addition to the simple borders and fill colors you added to cells in Exercise 2.3, there are 
more options on the Border and Patterns tabs in the Format Cells dialog box.

The Patterns tab allows you to add preset background patterns to cells.
On the Border tab, you have choices for which sides of the cells you want bordered, what 

style you want for the border, and what color you wish the border to be. You must choose the 
color and style first, before you make any choices, in order for that color and style to be 
applied to the border. Another thing you must understand about borders is that cells share 
borders; in other words, the bottom border of one cell is the top border of the cell below it.

10. Select cells A4:A8 and return to the Format Cells dialog box. On the Alignment tab, select 
the Wrap Text checkbox and click OK.

11. Notice the text is no longer on one line, but instead is wrapping to fit the column width. 
Using the column-resizing double arrow, drag the right edge of column A’s column 
header to the right until no words are incorrectly split. It should look something like this:

12. Save the file in your Chapter Two folder and name it Exercise 2-5.xls. Close the file.

E X E R C I S E  2 . 5 ( c o n t i n u e d )
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Remember that the lines you see on your worksheet are gridlines and do not print by 
default. If you want the defining edges of cells to be apparent when printing, you need to apply 
borders. Exercise 2.6 shows you how.

E X E R C I S E  2 . 6

Creating Custom Borders Around Cells and Ranges

1. Open the file Exercise 2-5.xls that you saved previously. If you didn’t save it, extract it 
from the zipped file for this chapter.

2. Move to the March Sales tab and select cell A1. Edit the font to be Times New Roman, 
16 pt., Plum. Select just the word March and change its font color to Black.

3. Select cells A1:A3 and open the Format Cells dialog box, select the Alignment tab, and 
use the Horizontal dropdown to specify Center Across Selection. Do not click OK or close 
the dialog box. 

4. Click the Border tab.

5. Choose Dark Blue as the color and choose the heavy, solid line style that is on the right 
side, second from the bottom. Click the Outline button on the left. Click OK.

6. Click any cell outside the selection to view the border around the selection. Then, select 
cells A3:E3 and return to the Format Cells dialog box. 

7. Choose the same color and line style, but this time click the Outline button, then also click 
the Inside button. Note the preview below that. Click OK. Deselect the cells and note that 
the border is also around the individual cells within the selection.

8. Select cells A4:A10. Return to the Format Cells dialog box, choose Plum as the line color 
and select the thin double lines below the line style you chose previously. Click the Out-
side button. Click OK.

Notice that the plum double line at the top of cell A4 has replaced the heavy dark-blue 
border that was at the bottom of cell A3 because this border is shared.

9. Select cell A4 and return to the Format Cells dialog box. Notice that the preview shows 
the border on the top, left, and right of the cell. Click the top edge that you see in the pre-
view and it is removed. Note the small buttons around the outside of this preview box 
also let you add and remove border edges. Click OK.

10. Note that the plum double line at the top of A4 has been removed, but that the dark-blue 
heavy line isn’t there either. Click cell A3 and return to the dialog box.

11. The preview shows the dark-blue border on the sides and top of the cell, but not the bot-
tom. Click the preview’s bottom edge to add it there. Click OK.

12. Save the file as Exercise 2-7.xls, but do not close it.
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The Patterns tab in the Format Cells dialog box offers you a few more background colors 
and some background patterns, as shown in Exercise 2.7.

Use patterns sparingly. They can often make data unreadable. Always choose 
a pattern color that is complementary to your font color, and use patterns 
only when the font is bold and fairly large.

Formatting Shortcuts
Once you know how to format cells, it’s important that you know how to add those formats 
to other cells quickly. Certainly, you can apply the formatting manually over and over, or you 
can use some of Excel’s shortcuts. Many of the formatting choices have keyboard shortcuts 
(for example, Ctrl+B for bold, Ctrl+I for italic, and Ctrl+U for underline), but those are not the 
types of shortcuts you will learn here. These shortcuts allow you to repeat formatting you have 
used before, in a new location, by using styles and the Format Painter.

When you take your MOS Exam, remember that you are not graded on how 
you do things. You are working under a strict time limit, so it is important to 
learn the shortcuts that will speed up the process.

E X E R C I S E  2 . 7

Adding Background Colors and Patterns Using the Format Cells Dialog Box

1. Still on the March Sales sheet in Exercise 2-7.xls, select the ranges A1:C1 and A3:E3. 
Select Format � Cells and click the Patterns tab.

2. The same 40 color choices you had when using the Fill Color paint bucket on the Format-
ting toolbar are available here, plus an additional 16 colors below that. Note that running 
your mouse pointer over them does not show the tooltips identifying the colors.

3. Click the Patterns dropdown box at the bottom to display the tooltips, as well as some 
pattern choices.

4. Click the Plum color box and the box choices disappear; nothing shows in the Sample 
window to the right.

5. Click the Patterns dropdown again and choose the pattern at the top with the tooltip 
“12.5% Gray.” Notice the pattern showing in the Sample window. Click OK.

6. Click any cell outside the selection to see how the pattern looks.

7. Close the file and click Yes when Excel asks if you want to save it. 

4002book.fm  Page 59  Friday, March 24, 2006  11:36 PM



60 Chapter 2 � Formats, Graphics, and Excel’s Templates

Creating and Modifying Styles

Styles are collections of choices made in the Format Cells dialog box that are named and saved 
so they can be used again. If you set up a particular format in one cell that includes various 
choices from the Format Cells dialog box, and you know you will want to repeat all of 
these choices in other cells, worksheets, or workbooks, you can save it as a style so you don’t 
have to completely remake it every time you want to use it. Exercise 2.8 shows you how to cre-
ate and modify these styles.

E X E R C I S E  2 . 8  

Create a Style and Use It

1. Open the file Exercise 2-7.xls, which you saved in the last exercise. If you did not save it, 
extract it from the zipped file for this chapter.

2. Go to the April Sales worksheet and select cell A1.

3. From the Format menu, choose Style to see this dialog box:

4. In the Style Name box at the top, type Monthly Title, then click the Add button.

5. Notice, below the name, what is currently included in this style. You can deselect any 
component if you don’t want it to be part of this style when you apply it at any time.

6. Click the Modify button.

7. Since this style will be for our sheet title labels, we can leave the Number format as General.

8. Click the Alignment tab. Choose Center Across Selection for the Horizontal alignment, 
then choose Center for the Vertical alignment.

9. Click the Font tab. Choose Book Antiqua, Bold, 14 pt., Violet.

10. Click the Border tab. Choose Black, the double line at the lower right, and click the Outline 
button.

11. Click the Patterns tab. Choose Light Turquoise. (You may have to click the Patterns drop-
down to see which one that is. But don’t choose it from that dropdown; choose it from the 
main boxes. We don’t want a pattern; we want a fill.)
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The Format Painter

Another way to copy formatting quickly from one cell to another is to use the Format Painter, 
which is the yellow paintbrush button to the right of the Paste button on the Standard toolbar:

To use the Format Painter correctly, follow these steps:
� Click the cell that has the formatting you want to copy.
� Click the Format Painter button one time.
� Click the cell where you want to paste the formatting.

Exercise 2.9 gives you hands-on experience with this tool.

12. Click OK and note all the new changes in your Style Includes list. Click OK to apply the 
style to cell A1.

13. Notice, because we used the Center Across Selection alignment, the data is cut off on the 
left end. Select cells A1:E1 and choose Format � Style.

14. From the Style Name dropdown list, choose Monthly Title; then click OK. The style is 
applied to the range of cells.

15. Move to the January Sales sheet and select cell A1, which is a merged cell. Got to Format � 
Style; choose Monthly Title; then click OK.

16. Move to the February Sales sheet and select the range A1:E1. Select Format � Style; 
choose Monthly Title; then click OK. Repeat this on the March Sales sheet.

17. Save the workbook in your Chapter Two folder as Exercise 2-9.xls. Leave the file open for 
the next exercise.

E X E R C I S E  2 . 9  

Using the Format Painter

1. Still inside the workbook you saved in the last exercise, move to the January Sales sheet 
and select cell A3; then click once on the Format Painter and release your mouse button. 
Without touching the mouse button, move your pointer over the sheet and note the 
paintbrush attached to the pointer. Also, notice the marquee around cell A3.

2. Click the February Sales sheet tab; then click cell A3 on that sheet. Notice that the format-
ting from cell A3 on the January Sales sheet is pasted into this cell.

E X E R C I S E  2 . 8 ( c o n t i n u e d )
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Formatting Worksheets
Up to this point, you’ve been learning how to format cells and cell content only. Excel also has 
some formatting choices that can be applied to entire worksheets in one step, like AutoFor-
mats and sheet backgrounds. AutoFormats can also be applied to selected parts of a sheet; 
however, backgrounds can only be applied to full sheets.

Using AutoFormats

AutoFormats are premade formats included in Excel that can be applied to a full worksheet 
or a selected part of a worksheet. To apply an AutoFormat to a full worksheet, you must select 
the range or ranges that have data in them.

3. Return to the January Sales sheet. Notice that the mouse pointer has returned to normal 
and the marquee is gone. However, cell A3 is still selected, so click the Format Painter 
button one more time.

4. Move back to the February Sales sheet. Click cell B3 and hold your mouse button down 
to select cell C3 also, then release the mouse button and the format is pasted to the range 
you selected.

5. One more time, return to the January Sales sheet where A3 is still selected, but this time 
double-click the Format Painter button.

6. Back in the February Sales sheet, select the range D3:E3 to apply the format. Notice that 
the paintbrush is still attached to your mouse pointer. Double-clicking the Format Painter 
leaves it turned on until you turn it off.

7. Select the range A4:A8 and release your mouse button. Note that the format is pasted 
there also, and the paintbrush is still attached to your pointer.

8. Click once on the Format Painter button to turn it off.

9. On the February Sales sheet, select cell B8 and open the Format Cells dialog box. Click the 
Number tab and note that cell has a General format. Click the Cancel button to close the 
dialog box.

10. Select cell B5 and note that its format is Currency.

11. Use the Format Painter to copy the Currency format from cell B5 and paste the format 
into all of the other cells on this sheet that contain numbers. The Format Painter copies 
all formatting, not just colors and fonts.

12. Adjust column widths and row heights if necessary; then save the file to update it, and 
close it.

E X E R C I S E  2 . 9 ( c o n t i n u e d )
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If you want to apply the AutoFormat to everything on the worksheet, do not 
select all 255 columns and 65,000+ rows! Doing this will add the format to 
every row and column that will ever possibly have data in them. A 5-page 
worksheet will end up being over 50,000 pages because Excel sees cells with 
AutoFormats applied as cells that are part of the workbook and assumes they 
should be printed.

You can apply the complete AutoFormat to any selection, or just the parts of the AutoFor-
mat options that you want. The advantage of autoformatting is that it is easy to apply quickly 
and it assures you that all parts of a workbook that use the same AutoFormat are formatted 
exactly alike. However, sometimes you need to adjust which parts of the AutoFormat are 
being applied where, and Exercise 2.10 demonstrates this.

E X E R C I S E  2 . 1 0  

Applying AutoFormats

1. Open the file Exercise 2-10.xls that you saved in the last exercise. If you did not save it, 
extract it from the zipped file for this chapter.

2. Move to the March Sales sheet.

3. Before you apply an AutoFormat, you must select the area you want formatted. In this 
instance, we want to apply the format to the entire sheet, so select the range A1:E10.

4. From the Format menu, choose AutoFormat. Scroll through the various formats to view them.

5. Click the one titled Colorful 1, then click OK.

6. Click outside the selected area to see how the format looks.

7. Move to the April Sales sheet. Select cells A3:E12.

8. Apply the Colorful 1 AutoFormat to this range. See that it is applied only to the selection, 
which did not include rows 1 and 2.

9. Click the Undo button. Select cells A4:E12 and apply the same AutoFormat again. Note 
that this doesn’t work well because the AutoFormat assumes the top row in the selection 
includes headings, so it centers the word Bayberry at the top. Click Undo.

10. With A4:E12 still selected, return to the AutoFormat dialog box, click the Colorful 1 for-
mat, then click the Options button.

11. Deselect the Alignment checkbox at the bottom; also deselect the Patterns checkbox. 
Click OK.

Looks like you lost all your data! But, actually, what has happened is the AutoFormat 
applied the white text color and the background of the cells is also white, so the data does 
not appear. 
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Formatting Backgrounds

Excel also allows you to apply background pictures to entire sheets. Backgrounds appear only 
onscreen and do not print. Therefore, you should use only backgrounds on files that will 
appear on websites or be shared via email or across a network. Using backgrounds on a file 
that will be printed is unnecessary and causes the file to increase in size. However, because 
background pictures don’t print, they do not cause the number of pages to increase as they do 
when you apply an AutoFormat to all rows and columns in a sheet. 

Exercise 2.11 shows you how to add background images to a worksheet.

12. With the range still selected, change the font color to black.

13. Click outside the selection to see it. Everything looks okay but Bayberry is bold and italic 
because AutoFormat assumes you want the top row of text to be displayed differently. 
Use the Format Painter to copy the format from cell A4 and paste it to cells A5:A12.

14. Note that cell A12 now has no bottom border. This is because A4 had only a top border 
and a left border. Select cell A12 and use the Border tab in the Format Cells dialog box 
to add a bottom border. Then click OK.

15. Adjust column widths and row heights if necessary and save the file in your Chapter Two 
folder. Name it Exercise 2-10.xls. Do not close the file.

E X E R C I S E  2 . 1 1  

Adding a Background Picture to a Worksheet

1. Move to the January Sales sheet and go to Format � Sheet � Background.

2. Browse to locate any picture file on your computer. If you don’t have any, you can extract 
Saturn_background.jpg from the zipped file for this chapter.

3. Select the picture in the Sheet Background window and click the Insert button at the bot-
tom. Your sheet now has a picture behind the data.

4. If you chose a picture that is dark and your fonts are also dark, the font color may need 
to be adjusted, so do that if necessary.

5. Use the horizontal scroll bar at the bottom of your screen to move to the right and see the 
background picture is repeated over and over on every page.

6. Click the Print Preview button. Note that the picture does not appear, because background 
pictures do not print. Also notice that the Status bar shows that the file is still only one 
page long.

E X E R C I S E  2 . 1 0 ( c o n t i n u e d )
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Excel and Graphics
Workbooks are not just about numbers. Excel has many features for adding and modifying 
drawings, clip art, pictures, diagrams, and charts. Adding graphics to a worksheet can have 
decorative value but, more importantly, can enhance and clarify the data presentation. You 
can emphasize areas of the worksheet that show data that should not be missed by using 
graphics such as arrows pointing to data or circles surrounding data.

Understanding the Drawing Toolbar

The Drawing toolbar is the most convenient utility for accessing and modifying graphics. It 
includes all of the tools you need for enhancing your worksheets with different illustrative 
material. Your Drawing toolbar should appear at the bottom of your screen. If it’s not there, 
choose View � Toolbars � Drawing. Run your mouse pointer over its buttons to learn their 
names; Table 2.3 provides explanations of what each button does.

7. Return to Format � Sheet and note that Background has been replaced with Delete Back-
ground. Click that to remove the background picture.

8. Close the file; you do not need to save it.

T A B L E 2 . 3 The Drawing Toolbar Buttons and What They Do 

Button Description

Draw This pop-up menu includes choices for ordering and 
arranging objects.

AutoShapes This pop-up menu includes many premade shapes.

Line, Arrow, Rectangle, Oval These buttons let you add lines, arrows, rectangles, 
and ovals.

Textbox Use this to add a text box.

Insert WordArt Use this to add graphical text, known as WordArt.

Insert Diagram or Organization Chart This lets you add diagrams of different varieties.

Insert Clip Art Use this to add clip art from the Clip Art Gallery.

E X E R C I S E  2 . 1 1 ( c o n t i n u e d )
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First, let’s learn how to create the basic shapes from the toolbar. Exercise 2.12 will show 
you how. 

Insert Picture from File This lets you add pictures stored on your computer.

Fill Color This lets you choose a color to fill a selected object 
(you can use the Fill Color button on the Formatting 
toolbar to do the same thing).

Line Color This lets you choose a color for a line or the border 
around a selected object.

Font Color This lets you choose a color for selected text within an 
object (you can use the Font Color button on the For-
matting toolbar to do the same thing).

Line Style This lets you choose a style for a line or the border 
around a selected object.

Dash Style Use this to change a line or the border around a 
selected object to a dashed line.

Arrow Style Use this to add an arrow to a line or adjust the arrow 
already on a line.

Shadow and 3D Styles These buttons let you add Shadow and 3D effects to 
objects.

E X E R C I S E  2 . 1 2  

Creating Shapes with the Drawing Tools

1. Open the file named Exercise 2-10.xls that you saved in a previous exercise. If you did not 
save it, extract it from the zipped file for this chapter.

2. Move to the February Sales sheet. Note that the sales figure for Madison Electronics, 
Week 4, is the highest sales amount for that month. You can use graphics to highlight 
this fact.

3. Click the Oval tool and release your mouse button. Move your pointer so it is above and 
to the left of the number in cell E8. Notice the mouse pointer appears as a thin crosshair. 
Hold the mouse button down and drag to the right and down until the entire number is 
inside the oval.

T A B L E 2 . 3 The Drawing Toolbar Buttons and What They Do (continued)

Button Description
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4. Release your mouse button and you’ll see a white oval that is blocking out the number 
completely.

5. Click the dropdown arrow to the right of the Line Color button and choose Red.

6. Click the button for Line Style. Choose the 3 pt. style.

7. Click the dropdown arrow to the right of the Fill Color button and choose No Fill. You now 
have a red circle around the number.

8. Click the Textbox tool and release your mouse. Your pointer is now an inverted cross. 
Click the pointer to the left of the word February at the top of the sheet. Type UPDATED 
but do not press Enter.

9. Note the diagonal-lined border around the text box. This is the border you see when you 
are in Edit mode in a text box. (Note your Status bar reads Edit.) Press your Enter key. 
Move your mouse pointer over this diagonal-lined border until you see the four-headed 
arrow and click once. Note that the diagonal lines have been replaced with dots and that 
your Status bar reads Ready. Use the four-headed arrow to drag the text box so it is lined 
up with the text in the row.

10. With the dotted pattern around the text box, click the Font Color dropdown arrow and 
choose Violet. Then click the Fill Color and choose Yellow. Then, click outside the text box 
to deselect it. Notice that your changes were applied to the entire text box.

11. Click the AutoShapes button. Go to the Flowcharts submenu and choose the shape with 
the tooltip “Flowchart: Punched Tape.” Click below cell A8 and drag to the right and 
downward to draw a shape about 1˝ wide by 1˝ tall. Release your mouse button.

12. Use the Line Style and Line Color tools to change the outside edge to 3 pt., Plum. Then 
use the Fill Color tool to fill it with Light Turquoise.

13. Right-click the shape and choose Add Text. Type Sell this store. Click the diagonal-lined 
border to change it to the dot pattern; then use the Font Color button to change the text 
to Plum. Click the Bold button on the Formatting toolbar to make it bold; then click the 
Center Alignment button to center the text inside the shape. Use the double-headed 
resizing arrow pointers on any of the white circles around the shape to make it larger or 
smaller, if necessary.

14. Click the Arrow tool and click and drag to draw an arrow from the top-left corner of the 
flowchart shape to the word Riley in cell A7. Use the resizing arrow pointer on the white 
circles on either end of the line to make the line shorter or longer or change its angle.

15. With the arrow still selected, use the Line Style tool to make it 3 pt. and use the Line Color 
tool to make it Plum.

E X E R C I S E  2 . 1 2 ( c o n t i n u e d )
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Be aware that when you rotate a shape with text in it, the text does not rotate 
with the shape, so you may have to resize the shape so the text is still com-
pletely inside it. If you want to resize or rotate one part of a grouped shape, 
select the grouped shape and then return to the Draw button and choose 
Ungroup, make your adjustments, and then select both shapes again, return 
to the Draw button, and choose Regroup.

Spend some time experimenting with the different shapes. Once you are comfortable add-
ing various shapes to a worksheet, close the file but do not save it again. You will need it to 
look like it did at the end of Exercise 2.12 before you move on to Exercise 2.13, which teaches 
you different ways to modify shapes.

16. While the arrow is still selected, hold down your Ctrl key and click the flowchart shape. 
This selects both shapes. Click the Draw button on the left end of the Drawing toolbar and 
choose Group. See that two shapes have been grouped into one shape.

17. Using the four-headed arrow to move the new grouped shape, the two-headed arrow to 
resize it, and the green circle at the top to rotate it, move the shape so it is below Madison 
Electronics but the arrow passes between the words Madison and Electronics to point 
to Riley. 

18. Save the file into your Chapter Two folder and name it Exercise 2-12.xls.

E X E R C I S E  2 . 1 3  

Modifying Shapes Using the Drawing Toolbar and Format Menu

1. Open the file Exercise 2-12.xls; you can either use the one you saved in the last exercise, 
or extract it from the zipped file for this chapter.

2. Click the arrow part of the grouped shape so it is selected. Do not click the text, because 
that may put you into Edit mode for the text. Be sure it is the shape you have selected and 
not the text.

3. Click the Draw button on the Drawing toolbar and choose Change AutoShape; then move 
to Basic Shapes, find the shape with the tooltip “Change Shape to Plaque,” and click that. 
Note that the flowchart is now a plaque shape.

4. With the shape selected, go to the Format menu and choose Object. On the Colors And 
Lines tab, change the Fill Color to Yellow; use the slider to change the Transparency to 
50%; change the Line Color to Violet; choose the Dash style from the Dashed dropdown 
box; and choose the Diamond Arrow from the Arrow End Style dropdown. Click OK.

E X E R C I S E  2 . 1 2 ( c o n t i n u e d )
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Adding and Editing Graphics in a Worksheet

The Drawing toolbar not only provides a way to draw and modify shapes, but also has buttons 
for adding Microsoft’s clip art and your own preexisting pictures from your computer. Exer-
cise 2.14 teaches you how to find clip art that matches your needs and add it to a worksheet.

When you use clip art for the first time, a message box appears asking if you want to orga-
nize your clip art. If you click Yes, the clip art organizer will search your hard drive for all pic-
ture, sound, and video files on your computer and add them to your Media Gallery so they can 

5. Double-click the red circle around the number and you’ll see this also brings you to the For-
mat dialog box. Change the Line Color to Dark Blue. Click OK and your circle is now blue.

6. Right-click the edge of the text box that reads UPDATED and choose Format Textbox. On 
the Colors And Lines tab, change the Fill Color to Lavender. On the Font tab, change the 
Font Color to Dark Blue. Click OK.

7. Click the Oval button on the Drawing toolbar, then click somewhere below cells B8:C8 
and note that a white circle is added. Repeat this to add another circle, but this time place 
the circle below cells D8:E8.

8. Click one circle, then Ctrl+click the second one to select both of them.

9. From the Draw button, choose Align Or Distribute � Align Top. This lines the objects up 
by their top edges.

10. Click outside the shapes to deselect them; then add a third circle in between those two. 
Don’t worry if they are not lined up properly, or even if they overlap. Ctrl+click all of them 
to select all three.

11. From the Draw button, choose Align Or Distribute � Align Middle; then choose Draw � 
Align Or Distribute � Distribute Horizontally. The objects are all lined up, with equal 
amounts of space between them. 

12. With the three circles still selected, go back to the Draw button and choose Group. Then 
return to the Draw button and choose Rotate Or Flip � Rotate Left 90°.

13. Return to the Draw button and rotate them back to the right 90°.

14. Click the Rectangle button on the Drawing toolbar, then drag to draw a rectangle on the 
sheet, which is on top of the circles. Be sure part of the box overlaps one of the circles. 
Fill it with Light Orange.

15. With the rectangle selected, go to the Draw button and choose Order � Send To Back. 
This puts the rectangle behind the circles. 

16. Save the file in your Chapter Two folder and name it Exercise 2-13.xls.

E X E R C I S E  2 . 1 3 ( c o n t i n u e d )

4002book.fm  Page 69  Friday, March 24, 2006  11:36 PM



70 Chapter 2 � Formats, Graphics, and Excel’s Templates

be found when searching your clip art. If you chose No but would now like that done, click 
the Organize Clips link at the bottom of the task pane; when the box comes up, select File � 
Add Clips To Organizer � Automatically.

The amount of clip art available to you depends on how Microsoft Office was installed, and 
whether you added any of your own graphics to the gallery. If you have a minimal installation 
of Office, you might be prompted to insert the Office CD to access the clip art.

Notice the link at the bottom of the task pane that reads Clip Art On Office Online. If you 
are connected to the Internet, you can click that link to Microsoft’s website, where you can 
download free clip art to add to your collections.

Though Microsoft offers lots of clip art, sometimes you want to use pictures of your own. 
If you added them to your Clip Art Gallery using the Organizer, they will be included in your 

E X E R C I S E  2 . 1 4

Adding Clip Art to a Worksheet

1. Open the file Exercise 2-13.xls that you saved in the previous exercise. If you did not save 
it, extract it from the zipped file for this chapter.

2. Move to the January Sales sheet and increase the height of row 1 to 72 points (96 pixels).

3. Display the Clip Art task pane, either by clicking the Insert Clip Art button on the Drawing 
toolbar, or choosing Insert � Picture � Clip Art.

4. In the Search For box at the top of the Clip Art task pane, type money; make sure the 
Search In box reads All Collections and use the Results Should Be dropdown list to dese-
lect everything except Clip Art. Then click the Go button.

5. Below that, you will see the clip art displayed that has the word money as one of its key-
words. Scroll to find one you like and click it one time to insert it on your worksheet.

6. It will appear, floating on your worksheet, along with the Picture toolbar. Use the four-
headed arrow to move the picture to the left of the text in row 1; then use the two-headed 
arrows on the white circles to resize it so it doesn’t cover up any text or data. If you don’t 
see the Picture toolbar, choose View � Toolbars � Picture.

7. Click outside of the picture to deselect it, and notice the Picture toolbar disappears. Click 
the picture again to bring the toolbar back, then click the X on the right end of the tool-
bar’s title bar to close it. Select View � Toolbars � Picture to bring it back.

8. Click outside of the picture again to deselect it. Close the Clip Art task pane by clicking on 
the X in its upper-right corner.

9. Save the file into your Chapter Two folder and name it Exercise 2-15.xls, but do not close 
the file.
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Clip Art task pane, but may be difficult to find. You can click the dropdown arrow beside any 
picture in the Clip Art task pane and choose Edit Keywords to add keywords to your pictures 
so they will appear in the task pane when you do a search using those words. Or, you can simply 
insert the picture from the Drawing toolbar using the Insert Picture From File button. You’ll 
learn how to do that in Exercise 2.15.

Once you have added clip art or pictures to a worksheet, you can use the Picture toolbar 
or the Format Picture dialog box to edit the picture. To see the Picture toolbar, simply click 
any picture on the worksheet and it will be displayed (if not, choose View � Toolbars � Pic-
ture). Run your mouse over the buttons on the toolbar to see the tooltips revealing their 
names. Table 2.4 explains what each button does.

E X E R C I S E  2 . 1 5

Adding Your Own Pictures to a Worksheet

1. Still inside the file you saved in the previous exercise, move to the March Sales sheet.

2. To add a picture from your hard drive, CD-ROM, floppy disk, and so forth, you can either 
click the Insert Picture From File button on the Drawing toolbar or choose Insert � Picture � 
From File.

3. When the Insert Picture dialog box comes up, browse to find a picture on your computer. 
If you don’t have one, extract Saturn_background.jpg from the zipped file for this chapter.

4. Once you’ve located a picture, either click it one time and then click the Insert button, or 
simply double-click the picture file to insert it. You will see the picture floating on the 
worksheet, along with the Picture toolbar.

5. Again, using the four-headed arrow to move the picture and the two-headed arrows to 
resize the picture, place it below the last line of data on the sheet and resize it so it is no 
wider than the data.

6. Click outside of the picture to deselect it; then save the file to update it. Close the file.

T A B L E 2 . 4 The Picture Toolbar Buttons and What They Do 

Button Description

Insert Picture From File Inserts a new picture

Color, More Contrast, Less Contrast, 
More Brightness, and Less Brightness

Adjust color, brightness, and contrast

Crop Removes parts of the picture
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In my opinion, using Excel’s compression tool on your pictures is like trying 
to cut a steak with a butter knife. I believe in using the right tools for the job. 
If you are concerned about the size of a file that includes a lot of graphics, use 
a graphics program to optimize your graphics correctly before you insert 
them into Excel. A graphic-design program will give you many more options 
to find the best size-to-quality trade-offs. Excel may be many things, but it is 
not a graphic-design program.

In Exercise 2.16, you will learn how to use all of the buttons on the Picture toolbar. If you 
did not use the Saturn_background.jpg picture in the previous exercise, extract the file Exer-
cise 2-15.xls from the zipped file for this chapter and use that one, because the instructions in 
this exercise pertain to that picture.

Rotate Left 90° Rotates the picture 90 degrees

Line Style Adds and modifies a line border around the picture 
(you can use this button on the Drawing toolbar to do 
the same thing)

Compress Pictures Adjusts the file size of the picture based on your 
needs

Format Picture Opens the Format Picture dialog box

Set Transparent Color Makes one color transparent

Reset Picture Resets the picture back to its original settings

E X E R C I S E  2 . 1 6  

Editing Pictures with the Picture Toolbar

1. Open the file Exercise 2-15.xls that you saved in the previous exercise. 

2. On the March Sales sheet, click the Saturn picture so it is selected and you see the Picture 
toolbar. 

T A B L E 2 . 4 The Picture Toolbar Buttons and What They Do (continued)

Button Description
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3. Click the Color button on the Picture toolbar and choose Grayscale to change the color 
settings to shades of gray. Click the Undo button on the Standard toolbar. Click the Color 
button again and choose Black & White. Notice this picture does not lend itself well to 
black-and-white settings. Click Undo again.

4. Click the More Contrast button two times. Click the Less Contract button three times.

5. Click the More Brightness button two times. Click the Less Brightness button five times. 
Now, choose Color � Black & White and note that the darker picture does lend itself bet-
ter to the black-and-white setting. Click Color � Automatic to revert to the original color.

6. Click the Crop button and move your mouse pointer over the black bracket markers you 
see on the edge of the picture. Click and drag inward to remove the entire ring around 
Saturn and just leave the round planet. Note that cropping is different than resizing; crop-
ping actually removes part of the picture.

7. Click the Undo button as many times as needed to bring the full picture back. Or, instead 
of clicking the Undo button multiple times, click the dropdown arrow to the right of the 
Undo button; then move your mouse down to the lowest Crop Picture on the list and click 
that. That will undo all of the cropping.

8. Click the Crop button to turn it off. Now, click the Rotate Left 90° button four times, until 
you’ve rotated the picture back to its original orientation.

9. Click the Line Style button and choose 41⁄2 pt. to add a line border around the picture. 
Then, use the Line Color button on the Drawing toolbar to change the color of the line 
to Plum.

10. Click the Compress Pictures button and you’ll see the box shown here, which allows you 
to choose a compression that will adjust this picture (or all of the pictures in the work-
book) for print quality or web quality. Click Cancel to avoid making changes.

E X E R C I S E  2 . 1 6 ( c o n t i n u e d )
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In addition to the buttons on the Picture toolbar, the Format Picture dialog box offers 
even more choices, which give you more precise control. When dealing with pictures, you 
may need to have exact sizes, so you can use the Format Picture dialog box to enter specific 
numbers. You can also choose to lock aspect ratios, which will keep your picture in pro-
portion when you resize it, to avoid distortion. Exercise 2.17 walks you through these 
options.

11. Ignore the next button (Format Picture) for now, and click the Set Transparent Color but-
ton. This button allows you to remove one color from the picture and lets the worksheet 
show through. Using the transparent pointer, click the blue/gray background color on the 
picture. Note that it is now transparent.

12. Click the Reset Picture button. The picture is reset to the state it was in when you first 
inserted it. Click the Undo button to take the picture back to its transparent state.

13. Move and resize the picture so the top border is in the area of row 9 that has no data and 
the planet and border are not covering any data.

14. Save the file in the Chapter Two folder and name it Exercise 2-17.xls. Do not close the file.

E X E R C I S E  2 . 1 7

Editing Pictures Using the Format Picture Dialog Box

1. Move to the January Sales sheet in Exercise 2-17.xls and click the clip art you inserted 
there to select it.

2. Go to the Format Picture dialog box, either by clicking the Format Picture button on the 
Picture toolbar, selecting Format � Picture, double-clicking the clip art, or right-clicking 
the clip art and choosing Format Picture.

3. Click the Colors And Lines tab and choose Plum as the Fill color, set to 50% transparent. 
Choose Dark Teal as the Line Color and make it 3 pt. Click OK to see how it looks.

4. Return to the Format Picture dialog box and click the Size tab. In the Scale section, dese-
lect the Lock Aspect Ratio option. In the Size and Rotate area, change the height and 
width to .8˝ each. Click OK and you’ll see that the picture is now square.

5. Return to the Format Picture dialog box and click the Picture tab. Use the Color dropdown 
under Image Control and choose Washout. Click OK.

6. Click outside of the picture to deselect it. Save the file to update it. Close the file.

E X E R C I S E  2 . 1 6 ( c o n t i n u e d )
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Adding and Editing Diagrams and Organization 

Charts in a Worksheet

A good way to show the relationships between various data in your worksheet is to use dia-
grams. Excel’s Diagram Gallery includes six different diagram choices, shown in Figure 2.2. 
Clicking any of the pictures displays a description of when this type of diagram is appropriate 
for your data.

F I G U R E 2 . 2 The Diagram Gallery lets you choose from six different diagram types.

In the following two exercises, you will create a radial diagram, then an organization chart, 
since these are the two most commonly used and relate to the type of data included in this par-
ticular workbook. When you finish these exercises, feel free to create the other types of dia-
grams if you have other workbooks that include the types of data that would be appropriate 
for them. Exercise 2.18 teaches you how to use radial diagrams.

E X E R C I S E  2 . 1 8  

The Radial Diagram

1. Open the file Exercise 2-17.xls that you saved in the previous exercise. If you did not save 
it, extract it from the zipped file for this chapter.

2. Move to the January Sales sheet and click the Insert Diagram Or Organization Chart but-
ton on the Drawing toolbar.

3. Click each of the six pictures in the Diagram Gallery to display a description below. Then 
click the radial diagram and click OK.

4. You can see the diagram floating on your worksheet, and the Diagram toolbar is 
displayed.
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The most commonly used diagram is the organization chart. It lets you present family trees 
and company hierarchies, and I’ve even seen it used to show navigational structure for a 

5. Click the Insert Shape button one time so that you now have four circles around the 
center circle.

6. Click the center circle where it reads “Click to add text” and type Madison.

7. Click the circle to the left and type Week 1; then press Enter and type $7,800.

8. Move around to each circle, in a clockwise fashion, and type Week 2 $12,001, Week 3 

$15,678, and Week 4 $14,990, remembering to press Enter each time to put the dollar 
amount below the week number, as seen here:

9. Click the dotted pattern surrounding the whole diagram so the entire diagram is selected; 
then click the AutoFormat button on the Diagram toolbar and choose 3D Color. Click OK.

10. With the entire diagram still selected, use the Fill Color button on the Drawing toolbar 
and choose Plum to fill the background of the diagram with that color.

11. Using the four-headed arrow and the two-headed arrows, move your diagram below 
the data in row 8 and size the diagram to be approximately three columns wide and 20 
rows tall.

12. Click outside the diagram to deselect it. Save the file in your Chapter Two folder and 
name it Exercise 2-19.xls. Do not close the file.

E X E R C I S E  2 . 1 8 ( c o n t i n u e d )
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website. Of all the diagrams, it is definitely the most flexible and familiar. Exercise 2.19 shows 
you how to create a simple one.

E X E R C I S E  2 . 1 9  

The Organization Chart

1. Move to the 1st Qtr Sales sheet in Exercise 2-19.xls and select Insert � Diagram.

2. Choose the organization chart and click OK. The organization chart appears, along with 
the Organization Chart toolbar.

3. Click the top-level box and type Stores.

4. Click the first box on the second level; then click the diagonal-lined border to see gray cir-
cles around this box. Press the Delete key to remove this box.

5. In the two boxes remaining on the second level, type Eastern Division in one and West-

ern Division in the other.

6. Click the Eastern Division box, then use the small dropdown arrow to the right of the 
Insert Shape button on the Organization Chart toolbar to select Subordinate. This adds a 
box below Eastern Division. 

7. Repeat step 6 three more times so the Eastern Division has four subordinates. Type the 
first four store names that you see in cells A4:A7 into these boxes.

8. Repeat steps 6 and 7 to add the last four store names in cells A8:A11 as subordinates of 
the Western Division. (Type carefully, as the font may be very small and unreadable. If 
necessary, click outside of the box so it is no longer selected, then use the Zoom box on 
your Standard toolbar to increase the Zoom percentage while typing.)

9. Click the diagonal-lined border on the outside edge of the chart to change it to a dotted 
border, then select Format � Organization Chart. 

10. Click the Fonts tab and choose Arial, Bold, 10 pt., Dark Teal. Click OK.

11. Notice that some words are split and appearing on two lines. This is where some major 
tweaking is necessary to get everything displayed correctly. Use the two-headed arrow 
on the left and right edges of the chart to gradually make it wider. Drag a bit; then release 
the mouse button to see how it looks. Repeat this process until you get what you want. 
Making the chart wider will also make the boxes wider.

12. When you have most of the boxes displaying correctly, click any box that still needs 
adjustment; then click the diagonal edge to see the gray circles that mean the entire box 
is selected. Then, decrease the font size for that box only, using the Formatting toolbar.
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Creating and Modifying Charts
Up to this point, we’ve been making diagrams and shapes and manually adding text to them. 
While diagrams and drawing objects require that you manually add the data, charts in Excel 
are created based on data you already have in a worksheet. 

Of all the graphics you can add to an Excel workbook, charts are by far the most often used 
and, therefore, have many more features than the others. Excel’s Chart Wizard helps you set 
up the basic chart; then you can modify it, using the Chart menu and Chart toolbar.

Using the Chart Wizard

Oftentimes, you have data in a worksheet that can be more clearly displayed if plotted in a 
chart. Excel’s Chart Wizard allows you to customize the chart to fit the data display you seek. 
The wizard lets you choose from many different chart types, but not all data displays properly 
in all chart types. For example, charting a list of sales for five departments in one company 
would work well in a pie chart, because a pie chart shows only percentages of a whole (this 
department was responsible for 40 percent of the company’s sales; that department 30 per-
cent; etc.).However, if you wanted to show multiple product sales for each department in the 
same chart, a pie chart would not allow for this. Pie charts don’t have multiple axes, so instead 
you would want to use a chart that allows for this, such as a column chart, a bar chart, or a 
line chart. The next few exercises will teach you how to use the wizard to produce some dif-
ferent chart types. For the first chart exercise, Exercise 2.20, you will need to use the file named 
Exercise 2-20 Charts.xls, which you can extract from the zipped file for this chapter.

 In Exercise 2-20 Charts.xls, there are two sheets. The first sheet is named 
Store Sales and contains the sales for five different stores, grouped by weeks. 
The second sheet is named Store Comparisons and is empty at this point. 

13. Continue to change the size of the chart and the font in the individual boxes until all text 
is readable and words are not split onto two lines.

14. Click the outside edge of the chart to get the dotted pattern, then click the AutoFormat 
button on the Organization Chart toolbar. Choose Bookend Fills and click OK.

15. Use the four-headed arrow to move the organization chart so its top-left corner is in cell 
B1 and the chart is to the right of the data listed in cells A3:A11.

16. Click outside the chart to deselect it and save the file to update it. Close the file.

E X E R C I S E  2 . 1 9 ( c o n t i n u e d )
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As long as your data is contiguous on the sheet (meaning there are no empty 
rows or columns within the data area) and you want to use all of the data from 
the sheet to create a chart (as opposed to using only part of the data in one area 
of the worksheet), you simply need to click your mouse pointer on any one cell 
within the data area and the wizard will include all the data in the chart. 

E X E R C I S E  2 . 2 0  

Using the Chart Wizard to Create a Column Chart 

1. Click cell B3 on the Store Sales sheet in Exercise 2-20 Charts.xls; then click the Chart Wiz-
ard button on the Standard toolbar. It’s near the right end of the toolbar and, when you 
pause your mouse pointer over it, the tooltip reads “Chart Wizard.”

2. The first step of the wizard lets you choose your chart type:

3. If you click any chart type in the list on the left, you see thumbnail views of the different 
subtypes on the right. Click through the list to see all that is available. When you click any 
subtype thumbnail, a description is displayed below that, and if you click and hold your 
mouse button down on the Press And Hold To View Sample button, you’ll see how your 
data would look using that chart type. Also note the Custom Types tab at the top, which 
provides even more varieties.

4. After you’ve explored and previewed some of the possibilities, make sure you are back 
on the Standard Types tab, and select Column from the Chart Type list on the left and 
Clustered Column from the subtypes on the right (the one selected in the picture in step 2 
above). Then click the Next button at the bottom to move to Step 2 of the wizard.
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5. Step 2 shows you the data range that is being included in this chart—in this case, the 
Store Sales sheet and the absolute ($) range, A1:E6. The dollar signs indicate that the 
range will remain the same, no matter where you move the chart. (You’ll learn more 
about absolute ranges in Chapter 6, “Advanced Functions, Table Arrays, and Database 
Features”; for now, just ignore the dollar signs, but leave them there.)

Step 2 of the wizard has two tabs at the top:

The Data Range tab shows you the range and also whether your series is in columns 
or rows. Columns is selected and you see the store names are referenced on the X axis 
at the bottom of the chart (also known as the category axis). When Columns is chosen 
as your series type, the legend in the chart shows a different color for each column of 
data in the worksheet (Wk. 1, Wk. 2, Wk. 3, and Wk. 4). If you choose Rows instead of 
Columns, the legend will show a different color for each store, because the data for 
each store is in a separate row in the worksheet; also, the category axis now shows the 
week numbers, instead of the store names. 

The Series tab, when Columns is selected as your series type, shows a different series 
for each week. If you choose Rows on the Data Range tab, the Series tab will show a 
different series for each store.

E X E R C I S E  2 . 2 0 ( c o n t i n u e d )
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6. Make sure Columns is selected as your series type, and click the Next button.

7. Step 3 of the wizard has various tabs at the top, but at this time, the only settings you will 
make changes to are the titles. Click the Titles tab and enter the following information: 
Chart title: Weekly Store Comparisons; Category (X) axis title: Stores; and Value (Y) axis 
title: Sales. Then, click the Next button.

8. The last step of the wizard is where you tell Excel where you want your chart located in 
the workbook. You can choose to create a new sheet, or to add the chart to an existing 
sheet. Make sure As Object In is selected, and use the dropdown box to select the Store 
Comparisons sheet, as shown here. Then click the Finish button.

9. When the chart appears on the Store Comparisons sheet, use the double-headed arrow 
on the black resizing handles to make the chart approximately 20 rows tall.

10. Save the file in your Chapter Two folder and name it Exercise 2-20.xls. Do not close 
the file.

E X E R C I S E  2 . 2 0 ( c o n t i n u e d )
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As I stated previously, if you want to include all of the data in a contiguous range in a chart, 
you simply have to click your mouse pointer anywhere within that range before you start the 
Chart Wizard. However, if you want to create a chart using only a portion of the data, you 
must first select that data before you start the wizard. As mentioned earlier, pie charts are the 
perfect way to display different percentages of a whole (the whole being 100 percent). This is 
really all pie charts can do, since they do not use axes and can therefore display only one series 
of data. If the worksheet you are using has more than one series of data but you want to create 
a pie chart to plot the data from a single series, the wizard allows you to do that if you select 
the data first. Exercise 2.21 shows you how.

E X E R C I S E  2 . 2 1  

Using the Chart Wizard to Create a Pie Chart

1. With Exercise 2-20.xls still open from the last exercise (if you did not save it, extract it 
from the zipped file for this chapter), move to the Store Sales sheet. Using the Ctrl key in 
conjunction with your mouse, select the noncontiguous ranges A1:A6 and E1:E6, then 
click the Chart Wizard button on the Standard toolbar.

2. In the first step of the wizard, choose Pie as your chart type; then choose Pie With 3D 
Visual Effect as your chart subtype (the second thumbnail on the top row). Click Next.

3. In Step 2 of the wizard, make sure your series is set to Columns and, you’ll see a different 
pie-slice color for each store. Click Next.

4. Note Step 3 of a pie chart shows fewer options than you saw in Step 3 of the column 
chart. This is because pie charts do not have as many options (for example, axes are non-
existent). On the Titles tab, title the chart Week Four Sales.

5. Click the Legend tab and deselect the Show Legend checkbox.

6. Click the Data Labels tab and select the checkboxes Category Name and Percentage (as 
shown here). Click Next.
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Using the Chart Toolbar

Once you have used the wizard to create your chart, you can modify it by using the Chart tool-
bar. When a chart is selected, four obvious things happen: 
� The chart has black resizing handles around it.
� The Data menu on the menu bar is replaced with a Chart menu.
� The Name box now shows the name of the chart object that is selected, instead of a cell 

address.
� The Chart toolbar appears. (If the toolbar doesn’t appear, choose View � Toolbars � 

Chart.)

Running your mouse over the buttons on the toolbar shows tooltips that tell you the but-
ton’s name. Table 2.5 tells you what each button does.

7. In Step 4, choose the As New Sheet option and type in the sheet name, Wk 4 Pie. Click 
Finish.

8. Notice that you now have three sheet tabs and Wk 4 Pie is the first one. Move that sheet 
to the end, so it is the last sheet.

9. Save the file into your Chapter Two folder and name it Exercise 2-21.xls. Close the file.

T A B L E 2 . 5 The Chart Toolbar Buttons and What They Do 

Button Description

Chart Objects Provides a dropdown list that allows you to 
select any object in the chart

Format Lets you access the Format dialog box for any 
object selected

Chart Type Allows you to change the chart type

Legend Lets you add or remove the legend

Data Table Lets you add or remove the data table

By Row, By Column Two buttons that switch the chart display from 
rows to columns, and vice versa

Angle Clockwise, Angle Counterclockwise Two buttons that angle the text, either clock-
wise or counterclockwise

E X E R C I S E  2 . 2 1 ( c o n t i n u e d )
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In Exercise 2.22, let’s use the Chart toolbar to tweak some settings on that column chart 
we made.

A Note about Fill Effects

When you are formatting various shapes on a worksheet or objects in your chart, you can 
use fill effects. Excel offers four different types, and each type has various settings. This 
briefly explains each. I will give you more information within the exercises when you actu-
ally use them.

� Gradient is the term that designates two shades that gradually blend from one to 
another. There are choices for one- or two-color custom blends, or preset blends cre-
ated by Excel; there are also choices for different gradient styles, and variants of those 
styles.

� The Texture tab lets you choose from a variety of textures within the program, or use a 
texture of your own from your computer.

� The Pattern tab includes many preset patterns, and you can choose the background and 
foreground colors for the pattern.

� On the Picture tab, you can choose a picture from your computer and either stretch it to 
fill the object, or stack multiple copies of the picture on top of each other within the 
object.

E X E R C I S E  2 . 2 2  

Modifying the Chart Using the Chart Toolbar

1. Open the file Exercise 2-21.xls that you saved in the previous exercise. If you didn’t save 
it, extract it from the zipped file for this chapter.

2. Move to the Store Comparisons sheet and click one time on the white background area 
of the chart to select it. 

3. Since you clicked on the white background area of the chart, both the Object dropdown 
box on the left end of the Chart toolbar and the Name box next to the Formula bar show 
the words Chart Area, which is what the white background of this chart is called.

4. Click once on the legend, and the name changes to Legend in both boxes.

5. Click the dropdown arrow to the right of the Objects box on the Chart toolbar and choose 
Plot Area. Note that a different part of your chart is selected.
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6. Use the ← and → keys on your keyboard to move through all of the different objects on 
the chart.

7. Using any of the methods described in the previous steps, select the category axis, which 
is the X axis at the bottom of the chart, which shows the store names.

8. With this axis selected, click the Format button to the right of the Objects box on the Chart 
toolbar to display the Format Axis dialog box. Select the Font tab.

9. Change the Font to Verdana, 12 pt., Plum. Click OK. If increasing font sizes causes text to 
be cut off in your chart, or one of the five stores no longer shows, click the Chart Area to 
see the black resizing handles around the chart, then use the double-headed arrow on the 
resizing handles to make the chart wider.

10. Select the Chart Area and click the Format button to open the Format Chart Area dialog 
box. Click the Patterns tab; then choose one of the pale turquoise colors from the Area 
section on the right. Click OK.

11. Select the Value Axis and go to its Format box. Click the Number tab. Choose Currency, 
zero decimal places, and a dollar sign. Then move to the Font tab and choose Verdana, 
10 pt., Plum. Click OK to see the change in your numbers.

12. Select the legend and open its Format box. Click the Placement tab and choose Bottom. 
Then, click the Patterns tab and click the Fill Effects button under the color choices. 

13. From the Gradient tab, choose Two Colors, then use the dropdowns to the right to select 
white for the first color and a pale turquoise for the second; then choose Vertical as the 
style and click the first variant on the top left. Click OK. Then click OK again to return to 
the chart.

14. Click the Legend button on the Chart toolbar. Note that the legend is removed. Click the 
button again to bring it back. You can also move the legend anywhere on the chart simply 
by clicking on it, and then using the white diagonal arrow to drag it to any location within 
the chart area.

15. Click the Data Table button next to display a table showing your data below the chart. Click 
the button again to remove the table.

16. Click the By Row button to change the data display from columns to rows. Click the By 
Column button to reverse this.

17. Finally, select the category axis again and click the Angle Clockwise button to change the 
angle of the text. Click Angle Counterclockwise to reverse it.

18. Save the file into your Chapter Two folder and name it Exercise 2-22.xls. Close the file.

E X E R C I S E  2 . 2 2 ( c o n t i n u e d )

4002book.fm  Page 85  Friday, March 24, 2006  11:36 PM



86 Chapter 2 � Formats, Graphics, and Excel’s Templates

Customizing Charts 

The important thing to understand, when it comes to chart customization, is that you can use 
various methods to modify all of the objects within the chart, but if you want to actually 
change the data plotted in the chart (that is, the store names or dollar amounts), you must 
modify the data in the worksheet. Using the Chart toolbar, the Chart menu, and the Drawing 
toolbar, you can change just about everything in the display, except the data it is actually 
displaying. 

Notice the two charts we created in the last exercises have some differences. The chart we 
created and chose to place on a new sheet instead of an existing sheet (in Step 4 of the wizard) 
has no cell gridlines, because chart sheets are special sheets that include nothing but the chart 
itself. On the Store Comparison sheet, you can add data outside of the chart; on this sheet this 
is not possible, unless you use a text box. Also, remember that on the Store Comparison sheet 
if the chart is not selected, you have a Data menu, but if the chart is selected, the Data menu 
is replaced with a Chart menu. On this sheet, regardless of whether the chart is selected, you 
will never have a Data menu.

Let’s look at some more ways to modify these charts in Exercise 2.23.

E X E R C I S E  2 . 2 3  

Chart Customization

1. Open Exercise 2-22.xls; you can use the one you saved in the previous exercise or extract 
it from the zipped file for this chapter. Move to the Wk 4 Pie sheet.

2. Click any one of the pie slices, and small boxes appear on the edges of all of the slices and 
the Chart Toolbar Objects box displays Series Wk. 4. Double-click one of the slices, and 
the Format Data Series dialog box pops up. Click the Options tab.

3. Deselect the Vary Colors By Slice option. The preview now shows all slices the same 
color. Click OK.

4. With all slices still selected, click one time on the slice for Wesley and note that now it 
is the only slice selected. Also note that the Objects box says “Series ‘Wk. 4’ Point 
‘Wesley’.” Use the → key to select the next pie slice, then continue to use that key to 
move around the pie, selecting each slice in turn. Use the ← key to move back to the 
Wesley slice.

5. With the Wesley slice selected, click the Fill Color bucket on the Drawing toolbar and fill 
that slice with Bright Green. With that one slice still selected, let’s draw attention to it by 
using the diagonal white arrow to drag the slice away from the pie so it’s more obvious.

6. Use the → key to move to the Merion slice and choose Format � Selected Data Point. 
Click the Patterns tab and use the Fill Effects button to apply the Preset Gradient called 
Desert. Select the Diagonal Down style at the bottom and use the bottom-right variant. 
Click OK twice to return to the chart.
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7. Use the → key to move to the Hempstead slice. Click the Fill Color bucket on the Drawing 
toolbar and choose Fill Effects. Click the Textures tab and click the individual texture 
thumbnails to see their names displayed below. Select the one called Green Marble and 
click OK.

8. Select the Orion slice and use one of the methods above to return to the Fill Effects dialog 
box. Click the Pattern tab. Choose Black for the Foreground color and Rose for the Back-
ground color; then choose the third pattern on the second row at the top. Click OK.

9. Select the Waterbury slice and choose the Picture tab in the Fill Effects dialog box. Click 
the Select Picture button and browse to find Saturn_background.jpg (which you 
extracted from the zipped file for this chapter) or any other picture on your hard drive. 
Select the picture, click the Insert button, and click OK.

Obviously, you would not use these dramatically different fill effects on one chart, but 
this is just to show you how they all work, and the various ways you can get to the Fill 
Effects dialog box.

10. Click outside the chart so nothing is selected; then go to the Chart menu and choose Chart 
Options.

11. Click the Data Labels tab and deselect the Percentages option. Select the Values option; 
then use the Separator dropdown box to choose a semicolon. Click OK.

Notice that the Chart Options choice takes you to the same information you saw in Step 3 
of the Chart Wizard. You can always return to any step of the wizard to change the infor-
mation there.

12. Click the Chart Wizard button. When the wizard appears and shows Step 1, click the Next 
button twice to move to Step 3; then click the Back button to move back to Step 2. Click 
the Cancel button to close the wizard without making any changes.

13. Move to the Store Comparisons sheet and click the chart to select it; you’ll now see a Chart 
menu on your menu bar instead of a Data menu. Click the Chart menu and choose Chart 
Type.

14. Choose Line as the type; then choose Line With Markers Displayed At Each Data Value as 
the subtype. Click OK.

15. Select the Value axis and click the Format button on the Chart toolbar to open the Format 
Axis dialog box. Click the Patterns tab and choose a line color of Sea Green. On the right, 
choose None in the Major Tick Mark Type section. Then click the Scale tab and change 
the value for Major Unit to 500. And finally, move to the Alignment tab and change the 
orientation degrees to –45. Click OK to see how this affects your chart.

E X E R C I S E  2 . 2 3 ( c o n t i n u e d )
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Editing the Data Used to Produce Charts

Recall that the chart formatting tools do not allow you to change the values and categories dis-
played in your chart, because this is controlled by the data itself. To change any data plotted 
in the chart or add or remove series in a chart, you must edit the data in the worksheet. The 
next two exercises show you how to do this. First, in Exercise 2.24 we will edit data already 
in the chart.

16. Select the plot area and use the double-headed arrows on the resizing handles to make 
the plot area larger to better display the data. Also, click the Store category axis title box, 
and use the white diagonal arrow to drag it so it is centered at the bottom of the chart 
area. Then drag the legend so it is centered below the word Store.

17. Save the file in your Chapter Two folder and name it Exercise 2-23.xls. Close the file.

E X E R C I S E  2 . 2 4  

Editing Data in a Chart

1. Open the file Exercise 2-23.xls—either the one you saved in the last exercise or the one 
you extract from the zipped file for this chapter. Move to the Store Sales sheet.

2. Click anywhere within the data range and click the Chart Wizard button.

3. Click Finish to add the default chart type with no customizations to this worksheet. Notice 
the chart is selected and there are colored outlines around the data in the worksheet: the 
values (dollar amounts) are outlined in blue, the categories (store names) in purple, and 
the legend entries (week numbers) in green.

4. Use the diagonal-white-arrow mouse pointer to move the chart below the data, with the 
top edge in row 10.

5. Click the By Row button on the Chart toolbar; notice the category labels and legend 
entrees are now reversed, the purple outline on the data is around the week numbers, 
and the green outline is around the store names. If the change isn’t obvious to you, click 
the Undo button, and then click the Redo button to see the change. When you are done, 
be sure that the legend displays the store names, and the week numbers are displayed 
along the category (X) axis.

6. Notice that the light turquoise column for Orion’s Wk. 1 sales is below the 500 marker. 
Select cell B5 on the worksheet and change the value there to 950; then press Enter. The 
chart automatically reflects the change and the column gets taller.

E X E R C I S E  2 . 2 3 ( c o n t i n u e d )
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Because you edited data that is already included in the charts, the changes are automatically 
reflected in the chart. However, if you add data to a part of the worksheet that was not 
included when you originally produced the chart, you need to manually add that to the Source 
Data range. Exercise 2.25 shows you how to add data to the range and also how to remove 
data from a chart.

7. Select cell A5 and change Orion’s name to Hunter. Press Enter, and the name changes in 
the chart’s legend. 

8. Move to the Store Comparisons and Wk 4 Pie sheets, and note that both of these charts 
also reflect the changes you made. This is because all three of these charts were pro-
duced using this same data.

9. Save the file into your Chapter Two folder and name it Exercise 2-25.xls, but do not close 
the file.

E X E R C I S E  2 . 2 5  

Adding and Removing Chart Data

1. Move to the Store Sales tab in Exercise 2-25.xls and add this data to row 7:

Harleyville 700 1300 200 550

Notice the new store is not included in the chart. There are three ways you can manually 
include it:

� Use the double-headed arrow to drag the colored outlines around the worksheet data 
to include the new row.

� Go to the Chart menu and choose Source Data. Manually change what is in the Data 
Range box to reflect the new range including row 7.

� Go to the Chart menu and choose Source Data. Notice the marquee moving around 
the existing range. With the Source Data box open, you can drag to select the new 
range on the worksheet data.

2. Click the chart to select it. Using the double-headed diagonal arrow mouse pointer, click 
the blue/green selection handles where the lower edges of cells A6 and B6 join. Drag the 
double-headed arrow down one row to include row 7 in the data range. The chart now 
includes the new store. Click the Undo button.

E X E R C I S E  2 . 2 4 ( c o n t i n u e d )

4002book.fm  Page 89  Friday, March 24, 2006  11:36 PM



90 Chapter 2 � Formats, Graphics, and Excel’s Templates

3. Click the chart to select it. Go to the Chart menu and choose Source Data. In the Data 
Range box, change the 6 at the end of the range to a 7. Click OK to see the new store 
included in the chart. Click the Undo button.

4. Repeat these steps to return to the Source Data box, but this time, instead of manually 
typing in the Data Range box, notice that the data on the worksheet has a marquee 
around it, showing you the range that is included. Also notice that the range in the Data 
Range box is selected. While that range is highlighted, use your mouse pointer to drag 
and select the new range on the worksheet (A1:E7). Notice that as soon as you start to 
drag, the Source Data box minimizes to get out of your way. When you release your 
mouse button, the box returns and shows your new range. Click OK to see the new range 
reflected on the chart.

5. Highlight the range A4:E4 and press your Delete key. Notice the data is removed from the 
chart, but there’s a gap between the columns where it used to be. Also note that the leg-
end still shows a box color for this series, even though the series does not appear to be 
there.

Remember that pressing the Delete key only clears the data from the cells. It does not 
remove the actual cells or row and, therefore, Excel assumes this row is still part of the 
source data. To remove the series from the chart completely, you must delete the entire 
row, not just clear the data.

6. Click the Undo button to return the columns to the chart. Then click in any cell in row 4, 
and select Edit � Delete � Entire Row. Click OK.

If you get an error message: In most cases, the row will be deleted and the column will 
be removed from the chart. However, because you used various methods to experiment 
with adding new data to this chart and because your data range is reflected in three dif-
ferent charts, you may see the error message here:

If you do see this error message, click OK. The row is removed from the data, but the chart 
shows a gap where the column was and the legend shows #REF on that legend button. 
This is because the legend is trying to reference something that it cannot find. Click your 
chart to select it and note that there are no colored outlines around your cell range. To fix 
this, go to the Chart menu and select Source Data. The Data Range box is empty. Click 
your mouse pointer inside that box; then drag across your range on the worksheet to 
select it again. Click OK, and your chart should now reflect the change correctly.

E X E R C I S E  2 . 2 5 ( c o n t i n u e d )
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Combination Charts

One more thing you should know about charts and how they reflect data is that sometimes 
your data may be representative of more than one series type and does not plot well on a 
standard chart. In this case, you would want a combination chart with a secondary axis. 
Exercise 2.26 shows you how this works.

There is another option in charting, which you may have heard of, called Trendlines. I’ll 
discuss the Trendlines option when we get into forecasting future data in Chapter 8, “Data 
Analysis and Sharing Workbooks.” Now, let’s discuss the templates you can use in Excel.

7. Click the other tabs and note that the store has been removed from all of the charts.

8. Save the file to update it. Close the file.

E X E R C I S E  2 . 2 6

Adding a Secondary Chart Type and a Secondary Axis

1. Open the file named Exercise 2-26 Combo Chart.xls.

Note that the data shows two columns of numbers. One column shows the sales 
amounts for the stores and the other shows the temperature on that day. Notice that the 
chart does not display the temperature numbers well because they are so much smaller 
than the dollar amounts. Also, this is really not what we want to show on this chart. What 
we want to show is the comparison between the sales on that day and the weather. So, 
we need to put the temperature in a different chart type and on a separate axis.

2. Use the Objects dropdown box on the Chart toolbar and select Series “Temperature (Degrees 
Fahrenheit).” This selects all the columns on the chart that refer to the temperatures.

3. Click the Chart Type dropdown button on the toolbar and select Line (the fourth one down 
on the left) as the type. This changes this series to a line chart, but we still can’t really see it.

4. With the temperature series still selected, go to the Chart menu, choose Chart Options, 
and click the Axis tab.

5. In the lower-left corner, choose Value (Y) Axis under the Secondary Axis heading. Note 
that the preview shows the temperature line plotted over the Sales columns. Click OK.

This makes the comparison between the temperature and the amount of sales much 
clearer.

6. Save the file into your Chapter Two folder and name it Exercise 2-26.xls. Close the file.

E X E R C I S E  2 . 2 5 ( c o n t i n u e d )
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Using Excel’s Templates
Since this chapter is about formatting, we need to take a brief look at using templates. Tem-
plates include formatting and formulas already created and saved, so you don’t have to rein-
vent the wheel every time you create a new worksheet and want to use the same formatting and 
formulas. In Chapter 9, “Advanced Template Design and Workbook Security,” you will learn 
how to edit templates and make new ones; in this section, however, you will simply learn how 
to use existing templates created by Microsoft for Excel.

Understanding Templates

Templates are simply files that contain elements already included in them. You use templates 
that meet specific needs and include designs and customizations applicable to the type of file 
you want to create. When you click the New icon on the Standard toolbar to open a new blank 
workbook, you are actually opening a template that includes your default font settings, col-
umn widths, and so forth. To access additional templates, you select File � New, and the New 
Workbook task pane appears to give you template choices other than the simple blank work-
book. The exercises in this section show you how to choose and use a template. Let’s start with 
Exercise 2.27 and select a template.

E X E R C I S E  2 . 2 7  

Choosing a Template

When you first open Excel, a new blank workbook template is automatically loaded for you to 
use. If you see this blank workbook on your screen at this time, close it so Excel is open with 
no workbook showing.

1. Choose File � New to open the New Workbook task pane. Clicking the Blank Workbook 
link at the top will open the same blank workbook you automatically see when you open 
Excel, or the blank workbook you get when you click the New icon on the Standard tool-
bar. However, below that you see the Templates section. Click the link that says On My 
Computer. 

2. The New Workbook dialog box appears. There are two tabs at the top. The General tab 
displays your blank workbook template and would also include any other templates cre-
ated by you or anyone else using your computer. The second tab, Spreadsheet Solutions, 
displays the templates created by Microsoft. Click the Spreadsheet Solutions tab.

3. The templates included with Excel are based on the most commonly created forms in 
Excel: balance sheets, invoices, timecards, and so forth. Click each to display a preview 
picture to the right.
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Adding Data Using Templates

Notice, in Exercise 2.27, that you did not use Save As to save this file, even though it appeared 
to be a file that already includes data. This is because it’s a template. When you access a tem-
plate by choosing File � New, it is different than accessing a file using File � Open. When 
using File � New, you are creating a new workbook based on this template and the original 
template remains untouched. You can also open templates using File � Open when you actu-
ally want to change the template itself. Editing existing templates is covered in Chapter 9; 
however, in this chapter, I will teach you how to create new workbooks using templates. 

A template can include locked areas, which are protected so they can’t be changed. If you 
try to click locked cells, you will see that they cannot be selected. There are examples of locked 
cells in the timecard template we’ll use in Exercise 2.28, and they include labels, such as Name 
and Position, as well as all of the cells in the Total Hours column. I’ll explain cell protection 
in more detail in Chapter 9.

4. Click the Timecard template; then click OK.

5. As you can see, this is a premade worksheet that allows you to keep a record of hours 
worked by employees. Click the Save button on the Standard toolbar and save the file 
into your Chapter Two folder and name it Exercise 2-27.xls. Leave the file open for the 
next exercise.

E X E R C I S E  2 . 2 8  

Using a Template

1. Try to click the text Name to select it; you’ll see that you can’t. However, click the cell to 
the right of that, which shows a dotted underline, and type the name John Doe. 

2. Press Enter; then type the position Sales Rep.

3. Click into row 19, below the text Account Description, and type Hempstead Account.

4. Press Tab or the → key to move to the Account Code column and type H67.

5. Enter these hours in the Monday through Friday columns, pressing Tab after each:

8 6.5 7 7 7

Notice the total is generated automatically in the Total Hours column. This is because this 
template includes a formula there.

6. Click the Save button to update the file; then close the file.

E X E R C I S E  2 . 2 7 ( c o n t i n u e d )
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Summary
Since Excel workbooks can be so data-intensive and crammed with information, formatting 
and graphics help to make important data more visible and more easily understood, not to 
mention more attractive.

Cell formatting not only lets you set up font styles and background colors, but it also keeps 
formatting of numbers, dates, currency, and so forth more uniform throughout the workbook. 
Cell formats also help Excel determine how to calculate the data within a cell and how to prop-
erly sort data (both of which will become more obvious in later chapters). 

Using Excel’s automated formatting tools allows you to change multiple cell formats 
quickly. This is important when you take the MOS Exam because of the time limits, as well 
as in the workplace when you are under deadline pressure.

Graphics, such as pictures, AutoShapes, and clip art, can be used to highlight important 
data so it isn’t overlooked. They also work well to separate one section of data from another. 

When you need to illustrate comparisons in your data, diagrams and charts help tremen-
dously. Diagrams can be manually constructed to show relationships and hierarchies. Charts, 
on the other hand, are created automatically using a wizard and are based on data already in 
the worksheets.

All of the formatting and graphic options in Excel come together nicely when creating tem-
plates. Templates can include many formatting presets so users can simply enter their data and 
not have to worry about formatting.

Exam Essentials
Know how to format cells and worksheets and use the automated formatting tools. Be 
able to apply every cell formatting option in the Format Cells dialog box, then repeat those 
formats through the use of AutoFormats, styles, and the Format Painter. Be sure you know 
how to format entire worksheets and selected ranges.

Understand all of the steps to insert, position, edit, and resize graphics of all types. Make 
sure you know how to use every button on the Drawing and Picture toolbars. Be proficient in 
the use of all of the Format dialog boxes for each type of graphic, including clip art, pictures, 
and AutoShapes.

7. Choose File � New, select the Timecard template again, and click OK. Note that the tem-
plate does not include the data you added. Close the template.

8. Choose File� Open, and open the file Exercise 2-27.xls that you created using the Time-
card template. Note that this file does include the data you added.

9. Close the file and close Excel.

E X E R C I S E  2 . 2 8 ( c o n t i n u e d )
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Be able to choose the right type of chart or diagram to match the data. Know the differ-
ence between the different types of charts and diagrams and why one is best suited for a par-
ticular type of data. Know when a combination chart or secondary axis is needed.

Know how to create and edit every part of a chart or diagram. Make sure you understand 
what every button on the Chart and Diagram toolbars does. Know the names of all of the dif-
ferent parts of the charts and diagrams and how to recolor, resize, relocate, and modify every 
one of them.

Understand the steps needed to update charts and diagrams to reflect new data. Remem-
ber that not all data added is automatically reflected in a chart, so you must know how to man-
ually update the chart when necessary. Also, know how to add elements to a diagram.

Be proficient in using templates other than the blank document template. Understand the 
difference between using a template and creating one. Be able to use every one of the Spread-
sheet Solutions templates to create new workbooks.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this chap-
ter but also include skills learned in the previous chapter; then check the solutions to see how you 
did. To complete these exercises, you will need to extract the files MOS Scenarios Ch 2.xls and 
Blue hills.jpg from the zipped file for this chapter. Open MOS Scenarios Ch 2.xls before you 
begin these scenarios.

 

MOS Scenario 4: Format Cells and Worksheets

Change the font settings for the runners’ names and the column headings to match the style 
in the title, without the italics. Format all cells containing numbers to show two decimal places 
and change the background color for the number cells to Light Turquoise. Add the back-
ground picture Blue hills.jpg to the worksheet. 

 

MOS Scenario 5: Add and Modify Graphics and Diagrams

Circle the lowest average running time in red and add a transparent rectangular callout that 
points to this number with 14 pt. bold red text that says The Winner on one line. Add clip art 
that shows a runner below the callout. Resize the picture to be 2˝ × 2˝. Add a Target diagram 
below the data that uses the Square Shadows format to show an inward progression from 
Desire to Practice to Peak Performance.
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MOS Scenario 6: Create and Modify Charts

Add a column chart on Sheet 2 that shows the runners’ times for this race, with their ages plot-
ted on a secondary line axis. Title the chart How Age Relates to Running Times and name the 
axes Age and Time, respectively; then name the sheet Age Comparison.
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Organizing Data, 
Changing Views, 
and Printing

 

MOS SPECIALIST OBJECTIVES COVERED 

IN THIS CHAPTER:

�

 

Filter lists using AutoFilter

�

 

Sort lists

�

 

Preview data in other views

�

 

Customize Window layout

�

 

Set up pages for printing 

�

 

Print data
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One thing I don’t like about some computer programs is I often 
feel locked into viewing the interface in the way the programmer 
wanted it viewed and not in the way that works best for me. 

Excel, on the other hand, offers many different ways to view data onscreen, and provides 
many different options for printing. You can rearrange the data display; you can hide data 
temporarily; you can print partial areas of data; and you can save these settings to be quickly 
reapplied at a later time, when needed. Often when you are working with large workbooks 
there is just too much on the screen at one time, so Excel gives you various ways to narrow 
down what you are seeing. That way, you can focus on what’s relevant to your task. And, con-
versely, sometimes you need to see multiple sections of data at the same time for comparison 
purposes, and, again, Excel fills this need.

When you have large workbooks full of various types of data, you need to organize the data 
so you can find what you want. Excel’s AutoFilters and sorting capabilities give you lots of 
control over the display of the data so you aren’t scrolling all over the place trying to find stuff 
that’s out of order or lost in a sea of other data.

Another helpful feature of Excel is that you can use it to quickly print parts of workbooks 
for a particular report. There’s no need to create a whole new worksheet. Through the use of 
Excel’s versatile views and printing choices, you can produce many different printouts, show-
ing various data from the same workbook, in seconds.

This chapter teaches you how to control the layout of your data by organizing it using 
AutoFilters and sorting. It then moves on to show you how you can save these different layouts 
using custom views, and finally, how you can print different layouts and sections of data. 

I’ve included files at the website for you to download and use for the exercises in this chap-
ter, which will guide you through all of the skills you will need for the MOS Exam scenarios 
pertaining to data organization both onscreen and in print. Download the file 
exl2003ch03.zip and extract the Excel files so you can start learning how to organize your 
mounds of data.

 

Organizing Data

 

I’m a big fan of program features that make my life easier and allow me to see what I want, 
when I want it, without having to wade through tons of nonessential stuff. I don’t usually have 
an abundance of free time to spend wallowing in a mire of mixed-up data. I need to find spe-
cific data fast. Some worksheets I have are huge and include various types of information. If 
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I try to manually look through all of them to find one particular item or a unique set of items, 
it takes hours, so I’ve learned how to use the sorting and filtering utilities in Excel to bring 
what I’m looking for to the foreground. Whether I want to rearrange data in a specific order 
or show only data that meets certain criteria, Excel gives me the means to do so quickly.

The features covered in this section show you how to change the order in which your data 
is listed and how to exclude certain data from view, so the cream floats to the top.

 

It’s always best to keep data listed in columns with headings at the top since 
most of Excel’s automated features rely on this type of layout. Data that is 
organized with row headings on the left and information listed to the right, 
across the columns, will not allow you to take advantage of some of Excel’s 

 

automated utilities.

 

Because you can use both sorting and filtering in combination with one another, let’s start 
with the horse first, then we’ll add the cart—and the horse, in this case, is basic sorting of data.

 

Sorting Data, Based on Single and Multiple Columns

 

Generally, all worksheets look better and are more functional when the data is sorted, whether 
it’s arranged alphabetically by people’s last names or numerically by invoice numbers. How-
ever, it’s totally unreasonable to think you have to insert a new row between Jansen and Jones 
to add Jenkins. Usually, you enter new data into a workbook in the first empty row at the bot-
tom, rather than inserting new rows to add data 

 

within

 

 the data. It is simply easier and faster 
to do it that way. And, there’s really no reason to insert the data where you eventually want 
it to be, because you can simply 

 

sort 

 

the data after the new data is added at the end. Data can 
be sorted in ascending or descending order, ascending being from A to Z or 1 to 1,000 and 
descending being Z to A or 1,000 to 1.

 

Many of Excel’s features will automatically select all data in a contiguous 
range. Therefore, you should avoid blank rows and columns within any sec-
tion you want Excel to recognize as contiguous. When Excel automatically 
selects data (as you saw when you created charts in Chapter 2), as soon as it 
sees a blank row or column, it considers data past that as being outside of the 
selection. Another example where this is obvious is if you use Excel data in a 
Word Mail Merge. When pulling the data from Excel, the Mail Merge feature 
sees a blank row and halts, thinking it has reached the end of the data. It’s 
always best to increase the height of a row or width of a column to give the 

 

illusion of space, without using blank rows or columns.

 

Exercise 3.1 shows you how to sort data, based on the information in one column.
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E X E R C I S E  3 . 1

 

Sorting Data by One Column

 

1.

 

Open the file named Exercise 3-1.xls, which you extracted from the zipped file for this 
chapter. This file contains a list of information about employees in a company and the 
data is in no particular order.

 

2.

 

Click any cell in column A and click the Sort Ascending button on the Standard toolbar 
(use the tooltips to find it). The list is now sorted in alphabetical order by last name. Also 
notice that Excel did not include the Last Name heading within the sort because, when 
you use the sort buttons on the toolbar, the default sorts assume the top row of data 
includes heading labels and not actual data values.

 

3.

 

Click the Sort Descending button to reverse the sort so that the end of the alphabet now 
appears at the top.

 

4.

 

Click anywhere in column D and click Sort Ascending. Note that the data is now re-sorted, 
with the newest employees at the top. Notice the last names are no longer in alphabetical 
order. When you sort by one column, the data for each employee is included, so the 
whole row is sorted and the correct data for each employee stays with that employee.

 

5.

 

Click Sort Descending so that those who have been employed the longest are moved to 
the top.

 

6.

 

Click any cell in column E and click Sort Ascending. The lowest salaries are now on top.

 

7.

 

Select the range E3:E31 and click the Sort Descending button. You get this warning:

If you specify a range before you click a sort button, only that range will be sorted and the 
salaries will now be assigned to the wrong employees.

 

8.

 

Choose the Continue With The Current Selection option; then click the Sort button. Now 
you see poor Carla Wilson, who has been an administrator for 22 years, is making only 
$18,000. But if you scroll to the bottom of the list, there’s lucky Martha Resnick, who’s 
been in Customer Service for only 1 year and she’s making $96,000!

 

9.

 

Click the Undo button so everyone is getting the proper salary again. With the range still 
selected, click the Sort Descending button again, but this time leave the default choice at 
Expand The Selection. The full range is now sorted properly.

 

10.

 

Use the Save As dialog box to create a new folder named 

 

Chapter Three

 

 and save this file 
in that folder; name it 

 

Exercise 3-2.xls

 

 but do not close it.
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Notice that when you sorted by last name, employees with the same last name were sorted 
incorrectly. There are three employees with the same last name, Franklin, and their first names 
were in this order: Deborah, Anna, and then Linda. Ideally, the first names should also be in 
alphabetical order. (Imagine a customer list with 50 Smiths. Wouldn’t it be easier to find Joe 
Smith in this list if the Smiths were sorted alphabetically by first name so Joe appears after Her-
man and before Karla?) To do this, you would need to add a 

 

secondary sort

 

. A secondary sort 
only comes into play when there are duplicates in your 

 

primary sort

 

. 
Exercise 3.2 shows you how to sort by up to three columns, using the Sort dialog box. 

When you use this method, choosing Data �

 

 Sort shows you four things (see Figure 3.1): 
�

 

The data behind the dialog box has been selected for you. When you have any blank rows 
or columns, anything outside of those blanks is not included in the selection. As you can 
see in Figure 3.1, row 1 is not included, because row 2 is empty.

�

 

The column headings in row 3 are not included in the sort because, as you can see in the 
Sort box, it says “My data range has ‘

 

Header row’

 

” (a header row is simply the data in 
the cell at the top of a column).

�

 

Whatever column you are in when you open this dialog box is the column Excel assumes 
you want as your primary sort. Excel has chosen Last Name as the primary sort column 
because a cell in column A was selected before you opened the dialog box shown in Figure 3.1.

�

 

The default choice, as shown in the right side of the dialog box, is to sort in Ascending 
order (A to Z or 1 to 1,000).

 

F I G U R E 3 . 1

 

The Sort dialog box

 

If you click the Options button, you can see the default sort order is from top to bottom. 
If your data was set up with headings going down column A and the values listed to the right 
across columns, you would have to change this option to sort from left to right. However, this 
is another reason not to set your data up in this fashion, because all default sorts are always 
from top to bottom and the defaults are what are applied when you simply click the Sort 
Ascending or Sort Descending button.

Let’s try sorting by more than one column by practicing with Exercise 3.2.
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Using AutoFilters

 

Sorting obviously helps in data organization and makes it easier to find data in a large work-
sheet. But sometimes you want to take it a step further. You not only want to find specific 
data, but you want only that data displayed. In this case, you need to use filters. 

 

Filters

 

 remove 
irrelevant data from your view so that you see just what you want to see. Filtering is a 

 

database

 

 
feature, so Excel considers each row a separate record in this database when filtering.

 

E X E R C I S E  3 . 2

 

Sorting Data by Multiple Columns

 

1.

 

Still using Exercise 3-2.xls, click anywhere within the data in column A and choose 
Data �

 

 Sort.

 

2.

 

The Sort dialog box appears (as shown in Figure 3.1).

 

3.

 

In the Sort dialog box, click the No Header Row button and you will see two things change:

�

 

The selection behind the box expands to include row 3, which means the text Last 
Name would be sorted and appear between Kellerman and Lewis.

�

 

The Sort dialog box shows your primary sort as column A instead of Last Name 
because Excel is no longer distinguishing what’s in row 3 as a label instead of a value.

 

4.

 

Click the Header Row button again so you see Last Name in the top box.

 

 

 

Then use the sec-
ond dropdown, Then By, to choose First Name. Click OK. 

 

5.

 

Scroll through the data. You’ll see that every last name that appears more than once now 
shows the first names in alphabetical order as well.

 

6.

 

Save the file to update it, and then close the file.

 

Sorting by More than Three Columns 

 

Excel’s Sort utility allows you to sort only by up to three columns at one time. This is generally 
not a problem because secondary sorts come into play only when there are duplicates in the 
previous sort. So, a fourth sort would be needed only if the data in the first three columns were 
exactly the same in some rows. However, I have come across a few situations where a fourth 
sort was definitely needed. The workaround is to sort first by the fourth sort only, then sort a 
second time by the first three. This will give the desired result, because sorting a second time 
applies your sorts to the already sorted data, having a cumulative effect. In one case, I was 
working with a company that had data that required six sort levels, and I was able to accom-
plish it by sorting first by columns 4, 5, and 6, and then sorting again by columns 1, 2, and 3.
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This section shows you how to use Excel’s 

 

AutoFilters

 

, which will handle most of your fil-
tering needs. AutoFilters are cumulative; meaning that you can apply one AutoFilter, and then 
apply a second one that will be applied to the results of the first.

 There are also advanced filters (which are covered in Chapter 7, “Advanced Data Orga-
nization and Display”), but most filtering needs can be fulfilled with the AutoFilters explained 
here. First, in Exercise 3.3 let’s look at the basic AutoFilters.

 

E X E R C I S E  3 . 3  

 

Using Basic AutoFilters

 

1.

 

Open the file named Exercise 3-2.xls that you saved in the previous exercise. If you didn’t 
save it, extract it from the zipped file for this chapter.

 

2.

 

Click any cell in row 3 and choose Data �

 

 Filter �

 

 AutoFilter. Notice this puts dropdown 
arrows in every heading in row 3. These allow you to choose any value in the columns.

 

3.

 

Click the dropdown arrow in column C and choose Customer Service. This filters your 
data to show only the rows for the employees in the Customer Service department.

Notice that the dropdown arrow on this column is now blue. The blue arrow tells you a 
filter has been applied, based on the information in this column. Also, notice your Status 
bar at the bottom of your screen shows “8 of 28 records found.” 

 

4.

 

Click the blue dropdown arrow and choose (All) to display all the rows (records) again.

 

5.

 

Click the AutoFilter dropdown arrow on column E. Note that every salary is listed. Rarely 
would you want to choose just one salary, but you might want to see only, perhaps, the 
five highest-paid employees. Click (Top 10…) and the Top 10 AutoFilter dialog box appears. 
Adjust the number in the center box to show the top five items, as shown here:

 

6.

 

Click OK and the top five largest numbers are displayed. The Status bar now reads “5 of 
28 records found.”

 

7.

 

Use the blue dropdown arrow and choose (All) to bring all records back into view.

 

8.

 

Click the dropdown in column E and apply a Top 10 filter again, but this time, use the 
dropdowns to change the criteria in the Top 10 AutoFilter box to Bottom, 20, and Percent. 
Click OK. 

This shows you the five employees whose salaries fall within the bottom 20 percent of 
the company’s salary range. But let’s say we want to see all of the employees working in 
our Customer Service department who are in the bottom 20 percent of our salary range.
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The basic AutoFilters allow you to choose specific data that is repeated in a column, as well 
as top and bottom amounts and percentages, but you can use 

 

custom AutoFilters

 

 to do a lot 
more than that. You can use custom AutoFilters to find values greater than or less than a spe-
cific number, for example. Custom AutoFilters can also be applied to text: If you think about 
how Excel sorts text, “greater than” refers to letters that come later in the alphabet and “less 
than” means previous letters in the alphabet.

Exercise 3.4 will show you the different custom options available.

 

9.

 

With the salary filter already applied, click the dropdown in column C and choose Cus-
tomer Service. You’ll see that there are four employees in the Customer Service depart-
ment who are in this salary range.

 

10.

 

Select Data �

 

 Filter �

 

 Show All to remove the filters from all columns. You can now see 
all your records again.

 

11.

 

Save the file in your Chapter Three folder and name it 

 

Exercise 3-4.xls

 

, but leave the file 
open for the next exercise.

 

E X E R C I S E  3 . 4  

 

Using Custom AutoFilters

 

1.

 

Still in Exercise 3-4.xls, make sure that you’ve cleared all the previous filters and that all 
of the data is displayed; then use the dropdown in column C to choose Sales.

Note that there are 10 employees in the Sales department and that they have been 
employed for 4 to 15 years. Let’s use a custom AutoFilter to show only the ones who have 
been employed for fewer than 10 years.

 

2.

 

Choose (Custom…) from the dropdown in column D and use the dropdowns in the top 
two boxes to choose Is Less Than and 10, as shown here:

 

3.

 

Click OK; this narrows the list down to six employees. Choose Data �

 

 Filter � Show All 
to remove all of the filters again.

E X E R C I S E  3 . 3 ( c o n t i n u e d )
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Working with Views
Along with the ways you can manipulate the display of your data, based on sorts and filters, 
there are methods of displaying your data onscreen to make it easier to deal with. You can hide 
data (as you learned in Chapter 1), and you can also lock data into a certain area of your 
screen, and view comparative data side by side. Once you’ve changed what you see onscreen, 
you can save this view so you can easily return to it at a later time. When you’re dealing with 
large workbooks, being able to access all of these features makes it much easier to see exactly 
what you want to see. 

4. Choose (Custom…) from the dropdown in column A and choose Is Less Than in the first 
box; then type f in the second box. Next, click the Or button and choose Is Greater Than 
in the first box below that; then type m in the second box, as shown here:

5. Click OK. The employees who fall alphabetically between Darcy and Marrietta have been 
removed.

If you are wondering why the M names are still showing, even though we told Excel to 
show us the names greater than M, it’s because those names are indeed greater than M 
to Excel. Anything added after the letter M is actually greater than M. If you don’t want to 
see the M names, then you would choose greater than N, or you could try step 6 instead:

6. Return to the Custom AutoFilter dialog box in that column and remove the m; then use 
the dropdown and choose Myers instead, since Myers is the last name beginning with M. 
Click OK to see the results.

7. Try using the basic AutoFilters in combination with custom AutoFilters to see the results 
you can come up with. When you are done, select Data � Filter � AutoFilter to remove 
the check and turn off the AutoFilters.

8. Close the file, but do not save the changes.

E X E R C I S E  3 . 4 ( c o n t i n u e d )
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With large worksheets, it’s often difficult to see all that you want to see on the screen at the 
same time. You can use the Zoom control on the Standard toolbar to zoom in (increase the 
percentage) when you want to focus on one area of the worksheet, or zoom out (decrease 
the percentage) when you want more of the worksheet to show without scrolling. But often 
this is not enough. If you need specific parts of a worksheet to remain in view while you exam-
ine other parts, you can freeze rows or columns or split your workbook to show two areas at 
once. Let’s learn how to do that now.

Freezing Panes and Splitting Worksheets

The Freeze Panes and Split utilities are very handy when you have a large worksheet that has 
you scrolling all over the place to compare or update data. Think how much scrolling would 
be required if you had to view data in the range A3:D8 and compare it to other data in cells 
A165:D171. You’d be hopping back and forth like crazy and increasing your confusion, as 
well as your chances to develop carpal tunnel syndrome. Or think of this situation: You have 
column headings in row 2 that show customer names and business phone, home phone, and 
fax numbers; however, when you scroll down to view the customer in row 698, you can’t 
remember which column holds which phone number, so again, you are jumping back and 
forth between row 3 and row 698 constantly.

Exercise 3.5 shows you how to lock certain parts of your worksheet so they stay onscreen 
no matter how much scrolling you do.

E X E R C I S E  3 . 5  

Freezing Panes

1. Open the file named Exercise 3-5.xls that you extracted from the zipped file for this chap-
ter and move to the Stats sheet.

When you scroll to the bottom of this sheet, you can no longer see the headings at the 
top, so it’s difficult to know what the values refer to. Let’s freeze those headings so they 
stay on top as you scroll. To freeze the panes correctly, you must first select the cell below 
and to the right of what you want frozen.

2. Select cell A4; then choose Freeze Panes from the Window menu.

3. Scroll to the bottom of the worksheet and note that the headings (rows 1 through 3) are 
now locked in place so you can always see them.

4. Go back to the Window menu and choose Unfreeze Panes. The rows are no longer frozen.

5. Click cell C4 and choose Freeze Panes again. This will freeze the rows above row 4 and 
the columns to the left of column C.

6. Because this worksheet isn’t that wide, freezing the columns is unnecessary, but to see 
it work, use the → key to move to column K and note that the first two columns remain 
onscreen.
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Another option you have for viewing is to split the worksheet. This allows you to have mul-
tiple areas of the sheet onscreen at the same time, so you don’t have to move back and forth 
constantly when working on different parts of the sheet. Exercise 3.6 demonstrates this.

Using Multiple Windows to View and Edit Data

Okay, so now you can view different parts of a worksheet at the same time, but what if you 
want to see more than one workbook at the same time? Say you have some data in Workbook1 
that you want to compare to data in Workbook2. Unlike some other programs, Excel does 
allow you to have more than one workbook open at the same time, which means you can keep 
flipping back and forth between the two. But, again, this is hard on your eyes and wrists and, 
if you are like me, very hard on your memory. I look at a range in Workbook1, then switch 
to Workbook2 and find the data I want to compare, but oops, now I’ve forgotten what was 
in Workbook1, so I better go back there and check again. Totally frustrating! 

All open workbooks are listed at the bottom of your Window menu in Excel so that you can 
move between them easily. However, when you want to compare data between them or copy 
or move data from one to another, this becomes tedious. With two workbooks open side by 
side, you can easily copy or move something from one to the other by using the copy, cut, and 

7. Return to the Window menu and choose Unfreeze Panes again.

8. Leave the file open for the next exercise.

E X E R C I S E  3 . 6

Splitting Sheets

1. Still inside Exercise 3-5.xls, select cell A11 and return to the Window menu, but this time 
choose Split. Your screen is now divided into two panes. Also, you have two vertical 
scrollbars. The split was inserted above the active cell, A11.

2. Use the bottom vertical scrollbar to scroll down to row 30. Note that you can view, com-
pare, and edit data in both panes without any scrolling.

3. Return to the Window menu and choose Remove Split.

4. Select cell C15 and apply a split there. Now your view is split into four panes, with two 
vertical scrollbars and two horizontal scrollbars. Note that you can use these scrollbars 
to display four different parts of your sheet onscreen at the same time.

5. Return to the Window menu and remove the split.

6. Close the workbook without saving changes.

E X E R C I S E  3 . 5 ( c o n t i n u e d )
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paste commands. Alternatively, you can use the mouse to drag cells from one workbook to the 
other. Just as you learned in Chapter 1, if you drag a cell it will be moved; if you want to copy 
it instead, you must hold down the Ctrl key while you drag it.

Exercise 3.7 teaches you how to view and edit multiple workbooks onscreen simultaneously.

E X E R C I S E  3 . 7  

Working with Multiple Workbook Windows

1. Open Exercise 3-5.xls again. Notice there are two worksheets in this workbook. Click the 
Jobs tab. Note that there are eight available job positions, five that have been assigned 
to specific departments and three that are still unassigned. The information we need to 
fill these positions is in another workbook, so let’s open that.

2. Leave this workbook open and open Exercise 3-7.xls from the files you extracted from the 
zipped file for this chapter. Now both are open at the same time.

3. Inside the 3-7 workbook, open the Window menu. Notice that, at the bottom, both open 
workbooks are shown; 3-7 is checked because it is the active workbook, as shown here:

4. From the Window menu, select the 3-5 workbook. It is now the active workbook on your 
screen.

5. Return to the Window menu and you’ll see that 3-5 is now checked.

6. Inside the 3-5 workbook, return to the Window menu and choose Compare Side By Side 
With Exercise 3-7.xls.

7. Both workbooks are now onscreen, with 3-5 above 3-7. Choose Window � Arrange.

8. In the resulting dialog box, choose the Vertical option and click OK. Now the workbooks 
actually are side by side. When you are in this view, you should have a Compare Side By 
Side toolbar on your screen that includes three buttons and looks like this:

If you don’t see this toolbar, or you accidentally close it, you can get it back onscreen by 
choosing View � Toolbars � Customize and selecting the option Compare Side By Side, 
then clicking the Close button.
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9. Click the 3-5 workbook and display the Jobs sheet. Freeze columns A and B and rows 1 
and 2 by selecting cell C3 and choosing Window � Freeze Panes.

10. Now use the scrollbar at the bottom of 3-5 to scroll to the right so you see only columns 
A, B, and E.

11. Notice that when you did that, the data in the 3-7 workbook scrolled out of view as well. 
This is because the first button on the Compare Side By Side toolbar is pushed in. Mouse 
over it to see the tooltip “Synchronous Scrolling.” This means both workbooks will scroll 
at the same time. We do not want that, so click that button to turn off that behavior.

12. Now, click the 3-7 workbook to make it active; then use the horizontal scrollbar to bring 
the data back onscreen.

Now let’s look at the job applicants we have in the 3-7 workbook. As you can see, we can 
fill all of the jobs on the Jobs tab of the 3-5 workbook. Based on the data in 3-7, we can 
make decisions about the three open positions for phone operators. We will assign two 
of those positions to the Sales department and one to the Customer Service department.

13. Move to the Stats tab in workbook 3-5 and copy cell C8; then move back to the Jobs tab 
and paste that into cell A8.

14. On the Jobs tab, copy cell A5 into cells A9 and A10. Press Esc to remove the marquee if 
it’s there.

15. In cell E3, type 5/5/05; then press Enter. Notice that Excel recognizes it as a date and con-
verts it to the default Date format.

16. Use the black plus-sign pointer on the fill handle to drag E3 to E10, to copy this date to 
all of these cells. 

17. Note that the date increases from day to day as you drag it. Click the AutoFill Options 
button to see your choices (shown here). Choose Copy Cells so that all of the cells have 
the same date in them.

18. Move to the Stats tab in workbook 3-5.

E X E R C I S E  3 . 7 ( c o n t i n u e d )
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Creating Workspaces

Now that you see how much easier it is to compare and update multiple workbooks when they 
are opened side by side, you may want to do this over and over with the same workbooks. For-
tunately, once you’ve set it up the first time, there’s no need to set it up again every time you 
want to use this workbook combination. Excel lets you save this setup as a workspace so you 
can quickly return to the same multiple-workbook view whenever you want to use it again. 

A workspace file is not actually a second copy of your workbooks. A workspace is just a 
view. The files you see in a workspace are the same files you see when you open them indi-
vidually; they are simply being viewed differently. Therefore, you can make changes to the files 
independently and those changes will show when you open the workspace; you can also make 

19. Click workbook 3-7 to make it active; then select the range A3:B10 and copy it.

20. Click workbook 3-5 to make it active and select cell A32 on the Stats sheet and paste that 
range there.

Based on the info in the 3-7 workbook, we can make decisions on who is best for what job. 

21. Go to the Edit menu and choose Office Clipboard. 

22. Copy the four department names to the Clipboard from any cells in column C of the 3-5 
Stats sheet. Once they all appear on the Clipboard, paste them into cells C32 through C39, 
in this order:

Morrison, Jeremy: Sales

Smith, Veronica: Sales

Jefferson, Maynard: Manufacturing

Jones, Wilma: Administration

Wilson, Warren: Sales

Keller, Feona: Sales

Johnson, Mary: Customer Service

Warren, James: Manufacturing

23. Click the Clear All button on the Office Clipboard and close the Clipboard task pane.

24. Click the Close Side By Side button on the Compare Side By Side toolbar.

25. Save both workbooks in your Chapter Three folder. Name the 3-5 workbook Exercise 3-7A.xls 
and name the 3-7 workbook Exercise 3-7B.xls. Close both workbooks.

E X E R C I S E  3 . 7 ( c o n t i n u e d )
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changes to the files within the workspace and those changes will show when you open the files 
individually.

Exercise 3.8 shows you how to quickly open multiple workbooks, set up your comparison 
view, then save the view as a workspace so you don’t have to set it up again every time you 
want to use it.

Workspaces can save you time when you view the same multiple workbooks onscreen a lot, 
as I explain in the sidebar “How I Use Workspaces.” 

E X E R C I S E  3 . 8

Save a Workspace

1. Choose File � Open. When the Open dialog box comes up, navigate to your Chapter 
Three folder and click once on Exercise 3-7A.xls; then hold down your Ctrl key and click 
Exercise 3-7B.xls. (If you did not save these files in the previous exercise, they can be 
extracted from the zipped file for this chapter.) Ctrl+clicking the two files selects both of 
them. Click the Open button to open them both.

2. Go to the Window menu and choose Compare Side By Side.

If your workbooks are now smaller because the space taken up by the Office Clipboard 
task pane is now blank, click the second button on the Compare Side By Side toolbar (its 
tooltip reads Reset Window Position). This tiles the workbooks horizontally again, so 
return to the Window menu and choose Arrange, then click Vertical and click OK.

3. Choose File � Save Workspace.

4. Notice Excel names this resume.xlw by default. Change the name to Exercise 3-8.xlw. 
Click the Save button.

5. Close both files by clicking on the Xs in their upper-right corners. Or here’s a tip: If you 
hold down your Shift key while you click the File menu, this adds a new command, Close 
All. Click Close All to close all open workbooks at one time.

6. Open Exercise 3-7A.xls again.

7. Add a zero (0) to cell D32, and then use the fill handle to repeat this zero in all cells from 
D33 through D39.

8. Save and close the workbook.

9. Open the workspace file Exercise 3-8.xlw. Note that the changes you made in the 3-7A 
workbook are showing in this workspace as well. 

10. Close all open files.

4002book.fm  Page 111  Friday, March 24, 2006  11:36 PM



112 Chapter 3 � Organizing Data, Changing Views, and Printing

Understanding Custom Views

Now that we’ve explored all the ways you can change your data display within a worksheet, 
it’s time to learn how to save different displays as views so you can easily switch from one view 
to another. Suppose you print employee reports every week for several departments. All of 
your employee data is on one worksheet, so you use filters to display one department and print 
that; then you change the filters to display another department, and then you print that; and 
so on and so on. Let’s look at a way to speed this up, so you can do this more quickly.

Exercise 3.9 teaches you how to use custom views to save your data with several display 
parameters.

How I Use Workspaces

I own my own small business and I am a fanatic about sticking to my budgets so I don’t over-
spend. I often need to compare my actual expenses with my budget to be sure I’m working 
within my means. So, I made a template in Excel that shows my expense categories. From this 
template, each year I create an expense budget workbook and another workbook where I 
enter actual expenses. I then tile the workbooks side by side vertically and save it as a work-
space. Then, at the beginning of each month when I pay my bills, I open the workspace, and 
everything I need to know is right there so I can quickly compare my actual bills to my budget 
and know I’m within my budget limitations (well, hopefully).

E X E R C I S E  3 . 9  

Create, Use, and Delete Custom Views

1. Open the file Exercise 3-4.xls (either the one you saved earlier or you can extract it from 
the zipped file for this chapter).

2. This is the file where we added the AutoFilters, but currently no filters are applied. Click 
the View menu and choose Custom Views.

3. When the Custom Views dialog box comes up, click the Add button.

4. In the Add View box, click in the Name box and type All Departments. Make sure the bot-
tom two boxes are selected, as shown here, and click OK.
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Controlling Page Layout
Up to this point, we’ve been exploring the different ways to view your data onscreen; now, the 
rest of this chapter is about changing the way your data looks when printed. Getting your 
worksheets to print properly can cause serious hair loss. Because workbooks often contain not 
only many rows but also many columns, Excel files are different from other types of files in 
that they can have both horizontal and vertical page breaks. Not only will your file print on 
more than one page after it reaches a certain length, but it will do the same when it exceeds a 
certain width. So, many times you print your beautifully laid-out spreadsheet, only to find 
you have one extraneous, unidentified column printing on every even-numbered page. How 
to fix this?

The layout of your printed page can be controlled through the Page Setup dialog box, the 
Print Preview screen, and the Page Break Preview view. In this section, we will look at how to 
adjust various settings, using these three features: Page Setup, Print Preview, and Page Break 
Preview.

Page Setup This dialog box allows you to make various adjustments regarding the layout 
and display of your printed worksheets.

5. Use the AutoFilter dropdown in column C to display only the employees in the Adminis-
tration department. Then, choose View � Custom Views; click Add, and name this view 
Administration Department.

6. Repeat step 5 to create views for the Customer Service Department, the Manufacturing 

Department, and the Sales Department.

7. Select Data � Filter� AutoFilter to remove the filters from this file. 

8. Save the file in your Chapter Three folder and name it Exercise 3-9.xls. Close the file.

9. Open the file you just saved and note that all of the departments are displayed and the 
AutoFilters are still turned off. 

10. Choose View � Custom Views. Click the view named Administration Department, and 
then click the Show button. Note that this shows only the Administration department 
employees.

11. Choose Data � Filter� AutoFilter to turn off the filters. Try showing the other custom views.

12. Return to the Custom Views box and click once on the view named All Departments. Then 
click the Delete button; click Yes when asked if you are sure you want to delete it. Click 
the Close button to return to the worksheet.

13. Save the file to update it and then close the file.

E X E R C I S E  3 . 9 ( c o n t i n u e d )
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Print Preview This feature is governed by your printer driver and shows you exactly what 
you will see when the page is printed with that particular printer. Using Print Preview can save 
you lots of time and paper. (See Table 3.1 for explanations of the Print Preview buttons.)

Page Break Preview This preview lets you drag page breaks to new locations and insert man-
ual page breaks in locations of your choice.

Orienting a Page and Repeating Rows and Columns

Two of the easiest ways to help control your printer output are by changing page orientation 
(see Figure 3.2) or repeating data at the top or left side of all printed pages. Let’s look at these 
first. 

F I G U R E 3 . 2 Choosing Landscape orientation allows more text to print across a page.

T A B L E 3 . 1 The Print Preview Buttons and What They Do

Button Description

Next and Previous Move from one page to the next and back again

Zoom Increase/decrease magnification

Print Open the Print dialog box

Setup Open the Page Setup dialog box

Margins Add/remove margin lines around the previewed page

Page Break Preview Switch to Page Break Preview view

Close Close Print Preview and return to the view you were in when 
you came to Print Preview

Help Get help with the Print Preview commands
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Let’s say you have 12 columns and 70 rows of data. When you print your worksheet, the 
first page shows columns 1 through 11; then page two shows column 12 all by itself and, 
because it’s on a page by itself, it’s difficult to see and match the data on page two with the cor-
rect rows on page one. Then page three shows the next area of data in columns 1 through 11 
with no column headings, so it’s hard to tell what the data is all about; and page four shows 
lonely column 12 again. This is not only unattractive, but it’s a total waste of paper and is con-
fusing to the reader. Sometimes you can fix this quickly by changing the page orientation to 
adjust where the pages break. You have two choices for orientation: portrait, which is taller 
than it is wide, and landscape, which is wider than it is tall (as shown in Figure 3.2). You can 
also repeat labels above or to the left of the values to better identify the data. Exercise 3.10 will 
show you how to do this.

E X E R C I S E  3 . 1 0  

Reducing the Number of Pages and Repeating Labels 

1. Open the file Exercise 3-10.xls that you extracted from the zipped file for this chapter, and 
move to the Stats sheet. Note that the data on this sheet covers 8 columns and 31 rows. You 
can also see fine dashed lines between columns F and G and between rows 25 and 26. 
This shows you that Excel has automatically placed vertical and horizontal page breaks 
in these locations, based on the size of the data. 

2. Click the Print Preview button on the Standard toolbar, or choose Print Preview from the File 
menu. (See Table 3.1 for descriptions of the buttons at the top of the Print Preview screen.)

You can see how the first page of your worksheet will look when printed. Also, note that 
the Status bar at the bottom of the screen shows this is Page 1 of 4 pages. Notice that you 
are not seeing all eight columns.

3. Click the Next button at the top of the screen to see page 2. This shows you the lower 
rows of your data, but you are still missing columns.

4. Click Next again to see page 3. You can now see the columns you were able to see before. 
Then, click Next one more time to see the lower portion of those columns.

5. Click the Previous button three times to get back to page 1.

6. Click the Zoom button, or simply click the previewed page, to zoom in for a closer look at 
the data.

7. Click the Zoom button again, or click the previewed page again, to zoom back out to full-
page view.

8. Click the Page Break Preview button to move to that view. You may see the box shown 
here; if so, just click OK.
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9. Page Break Preview shows you dashed blue lines where Excel has added automatic page 
breaks. It also displays the page number on each page. Click the Print Preview button on 
the Standard toolbar to return to Print Preview.

10. Notice the Page Break Preview button now says Normal View. Click that to return to your 
worksheet; then click the Print Preview button again to return to Print Preview and note 
that the button now says Page Break Preview again.

Looking at your pages in Print Preview lets you clearly see that your page needs to be 
wider so it will fit on two pages instead of four, and those columns on the right won’t be 
on separate pages.

11. Click the Setup button to bring up the Page Setup dialog box. (This box is also accessible 
from any view by selecting File � Page Setup.)

12. In the Page Setup dialog box, click the Page tab. Note that at the top you have a choice 
between Portrait and Landscape orientation. Click the button beside Landscape; then 
click OK.

13. Back in Print Preview, you see that now all columns are printing on one page wide. The 
Status bar now shows that you’ve reduced the number of pages to two. Click the Next 
button to see page 2.

14. Notice that the data on page 2 is not clearly identified because there are no column head-
ings. Click the Close button to close Print Preview and return to the worksheet’s Normal 
View. We need to return to Page Setup to tell Excel to repeat the headings on all pages, 
but we can’t do that by accessing Page Setup from within Print Preview. We have to do 
it from Normal View where we can select the range.

15. Use your vertical scrollbar to be sure row 3 is visible on your screen; then select File � 
Page Setup. Click the Sheet tab.

16. Select the option Rows To Repeat At Top. With your insertion point flashing in that box, 
click anywhere in row 3 and you will see that $3:$3 is added to that box. Click the Print 
Preview button to the right of that box.

17. Back in Print Preview, click the Next button to move to page 2 and note that now the data 
is clearly identified with headings.

18. Close Print Preview. Save the file in your Chapter Three folder and name it Exercise 3-

10A.xls. Close the file.

E X E R C I S E  3 . 1 0 ( c o n t i n u e d )
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Adding Headers and Footers

The Page Setup option lets you repeat rows at the top or columns on the left, making data 
much clearer when the values print over many pages. However, sometimes we want data 
repeated on every page, but this data does not appear in any row or column within the work-
sheet. For example, let’s say we want the filename and the name of our company at the top of 
every page. Or we want page numbers and the date at the bottom of every page. This infor-
mation can easily be added to the headers and footers. Headers and footers do not show in 
Normal View or Page Break Preview, but instead show only in Print Preview or when printed. 
You can manually type static data into headers and footers, or you can use Excel’s field codes 
to insert dynamic data. Static data remains the same unless you manually change it; dynamic 
data updates to reflect changes made to the file. The following two exercises show you how 
to add both types. Let’s start with static data in Exercise 3.11.

E X E R C I S E  3 . 1 1

Adding and Removing Static Data in Headers and Footers

1. Open the file Exercise 3-10A.xls that you saved in the previous exercise. If you did not 
save it, extract it from the zipped file for this chapter.

2. Make sure you are on the Stats sheet and select File � Page Setup. Click the Header/
Footer tab in the resulting dialog box.

3. Click the Custom Header button.

4. In the Left section box, type Orion Industries.

5. In the Right section box, type 5/5/2005. Then click OK, and your information will appear in 
the Header preview at the top. Also note that it has been added to the dropdown list 
below that:
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When you manually enter static data into a header or footer, the data will print the same 
way every time you print the worksheet. However, if you want the data to be dynamic and 
update when changes are made to the file, you must use Excel’s field codes. Notice the buttons 
above the Left, Center, and Right sections in the Custom Header and Custom Footer dialog 
boxes. These buttons allow you to add various field codes to the headers and footers. You can 
use these buttons individually or in combinations. Table 3.2 explains what each code does. 
The codes are listed in the table as they relate to the buttons in the Custom Header and Custom 
Footer dialog boxes, from left to right (unfortunately, these buttons do not display tooltips 
when you rest your mouse pointer on them).

6. Click the Print Preview button to the right of the Header preview. Notice the information 
at the top of page 1. Click the Next button and note that it is also on page 2.

7. Close Print Preview to return to Normal View and note that the header information does 
not appear there.

8. Return to the Page Setup dialog box and select the Header/Footer tab. Click the Custom 
Footer button.

9. In the Center box, type Confidential Information. Click OK twice to return to the work-
sheet. Click the Print Preview button on the Standard toolbar and note that the footer 
information has been added.

10. Return to the Header/Footer tab in the Page Setup dialog box and click the Custom 
Header button. Highlight the date in the Right section and press the Delete key to delete 
it. Click OK twice to return to your worksheet; then go to Print Preview, where you’ll see 
that the date has been removed from the header.

11. Close Print Preview. Save the file in your Chapter Three folder and name it Exercise 3-

12.xls, but do not close the file.

T A B L E 3 . 2 The Custom Header and Footer Field Code Buttons  

Field Code Description

Refers to the first button on 
the left, which does not insert 
a field code

Drag to select any text or field code, then click this button to 
change the font type, style, and attributes.

&[Page] Inserts the correct page number on each page.

&[Pages] Inserts the total number of pages in the active sheet.

E X E R C I S E  3 . 1 1
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Note that when you use field codes, the data is dynamic, so it reflects the current filename, 
the current date, the current time, and so forth. If you save the file with a new name, or print the 
document on a different date or at a different time, the data in the footer will adjust to reflect 
those changes.

Now in Exercise 3.12 let’s learn how to create dynamic headers and footers using these 
buttons to add field codes. 

&[Date] Inserts the current date.

&[Time] Inserts the current time.

&[Path]&[File] Inserts the filename, along with the complete path to where 
the file is located on the computer or network.

&[File] Inserts the filename.

&[Tab] Inserts the sheet tab name.

&[Picture] Inserts whatever picture you choose from the Insert Picture 
dialog box.

Refers to the last button on 
the right, which does not 
insert a field code

Click inside the &[Picture] code and click this button to change 
the size, set crop settings, and control brightness and contrast.

E X E R C I S E  3 . 1 2  

Creating Dynamic Headers and Footers

1. Still inside the file you saved in the previous exercise, move to the Jobs sheet. Return to 
Page Setup and click the Header/Footer tab. Click the dropdown below the Header pre-
view box and choose Jobs to insert the sheet tab name in the center of the Header; then 
click the Custom Header button.

Note that you do not see Jobs in the Center section. Instead, you see &[Tab]. This is 
because Excel inserted the Tab field code instead of the sheet tab name.

2. Click OK twice to return to the worksheet.

3. Double-click the Jobs sheet tab, rename it Jobs Available, and press Enter.

T A B L E 3 . 2 The Custom Header and Footer Field Code Buttons (continued)

Field Code Description
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4. View the sheet in Print Preview. Note that the header is updated to reflect the new 
tab name.

5. Click the Setup button in Print Preview and return to the Header/Footer tab. Click the Cus-
tom Footer button.

6. Click in the Right section box and click the Page Number button to add &[Page]. (If you 
accidentally choose the wrong button, just highlight the code and press your Delete key.)

7. Press your spacebar one time; then type of; press the spacebar again; then click the Num-
ber Of Pages button to add &[Pages].

8. Click into the Left section box and follow this sequence:

Type Printed on.

Press the spacebar.

Click the Date button to add &[Date].

Press the spacebar.

Type at.

Press the spacebar.

Click the Time button to add &[Time].

Highlight all of the text in the Left section, including the field codes, and click the Font 
button.

Choose Times New Roman, 14 pt., underlined. Click OK.

9. Click in the Center section box and click the File Name button to add &[File]. Your Footer 
preview box should now look like this:

E X E R C I S E  3 . 1 2 ( c o n t i n u e d )
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Setting Margins 

Another way to control how much you print on one page is to decrease or increase the amount 
of the page taken up by margins.

Margins are the blank areas of the printed page, on the top, bottom, left, and right edges. 
Excel also lets you adjust the size of the header and footer margins.

Certain printers that use rollers to pull the paper through must have a bottom 
margin of at least 3⁄4˝. If the margin is smaller than this, the printer will cut off 
one or even two lines of data. Laser printers can generally handle smaller bot-
tom margins, but Deskjet printers cannot.

When you are viewing margins within Print Preview, you’ll see black dotted lines around 
the page, and you’ll be able to see the header and footer margins, which contain the text you 
added to the header and footer. In addition, you’ll see black boxes at the top of the page, which 
show your column boundaries. You can drag the dotted lines and the black boxes to make 
adjustments as you see fit. However, note that there is no Undo button in Print Preview, so it’s 
best to save your file before you do anything; that way, you can always close the file without 
saving if you make mistakes.

Adjusting margin and header/footer sizes in Print Preview is handy because you can see the 
effect it has immediately. However, these adjustments are approximate because you are doing 
it by eye. If you know you have requirements for specific margin sizes, you should make the 
adjustments in Page Setup.

10. Click OK to close the Custom Footer box and return to Page Setup. Click the Print Preview 
button.

11. Zoom in on the footer on page 1. It should look like this:

12. Return to Page Setup � Header/Footer and click the Custom Header button.

13. Click in the Right section box, and click the Insert Picture button. Browse to find the pic-
ture named orionlogo.gif that you extracted from the zipped file for this chapter, and click 
the Insert button to add &[Picture].

14. Click the Format Picture button and click the Size tab. Set the height and width to 1˝ each. 
Click OK three times and preview the header in Print Preview.

15. Close Print Preview. Save the file to update it and then close the file.

E X E R C I S E  3 . 1 2 ( c o n t i n u e d )
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Exercise 3.13 shows you how to adjust margins and header/footer size using the Page Setup 
dialog box and Print Preview.

Managing Page Breaks

Excel will automatically insert page breaks when the data reaches the boundaries that can fit 
on that page. However, you can insert manual page breaks within a page if you want to have 
more control over the printing output.

Just as when we added splits or froze panes (earlier in this chapter), page break(s) are added 
to the left of the column and above the row of the active cell. Therefore, if you want only to 
insert a vertical page break, make sure the active cell is the top cell in the column to the right 

E X E R C I S E  3 . 1 3

Adjusting Margins

1. Open the file Exercise 3-12.xls that you saved in the previous exercise. (If you did not save 
it, extract it from the zipped file for this chapter.) Move to the Stats sheet and open Print 
Preview.

2. Click the Margins button at the top of the Print Preview screen.

3. Rest your mouse pointer on the black box at the top, between the Department and Years 
Employed columns. When you see the double-headed resizing pointer, click and drag to 
the right to widen the Department column slightly.

4. Move your mouse pointer over the dotted line at the top of the header. When you see the 
double-headed arrow, click and drag downward to increase the size of the header margin 
slightly. Then click the dotted line below the header and drag that downward to increase 
the top margin slightly.

5. Click the Setup button at the top of Print Preview to get into the Page Setup dialog box; 
then click the Margins tab.

6. Change the values in the top, bottom, left, and right boxes to 1˝ each. You can use the 
controls on these boxes to move up or down to increase or decrease the number, or you 
can just click in the box and type the number you want. Do not type an ˝ mark; just type 1 
and Excel will recognize that it’s an inch.

7. Click OK and preview the page. If increasing the margins caused text to be cut off on the 
right side of the page, drag the dotted line to the right until the text is fully displayed 
again.

8. Close Print Preview. Save the file in your Chapter Three folder and name it Exercise 3-

14.xls. Leave the file open for the next exercise.
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of where you want the page break added. Or, if you want only to insert a horizontal page 
break, be sure the active cell is in column A of the row below where you want the page break 
inserted.

When using Page Break Preview, you’ll see blue solid lines and blue dashed lines. The dashed 
lines are the automatic page breaks inserted by Excel. The solid lines are the manual page 
breaks you added yourself. You can drag manual page breaks to new locations in this view. 
When you move manual page breaks, Excel will adjust the automatic page breaks accordingly, 
based on the length of your data.

Exercise 3.14 shows you a few ways to control your page breaks.

Page breaks in Excel can sometimes be frustrating and problematic. It is 
always smart to save your file before you start playing around with page 
breaks. That way, if you make a mistake, you can close the file without saving 
changes to revert to what you had before you started.

E X E R C I S E  3 . 1 4  

Adding, Moving, and Removing Page Breaks

Still inside the file Exercise 3-14.xls that you saved in the previous exercise, be sure you are 
on the Stats sheet in Normal view (not Print Preview). Note the dashed line below row 18.This 
shows you that Excel has inserted a page break here.

1. Select cell F1; then choose Insert � Page Break. Note the dashed line to the left of column 
F, indicating that a vertical page break has been inserted there.

2. Select cell D23 and choose Insert � Page Break again. Note that this time Excel added a 
dashed line to the left of column D and also above row 23.

3. From the View menu, choose Page Break Preview. If you see the Welcome To Page Break 
Preview message box, click OK.

4. Move your mouse pointer over the solid blue line between columns E and F, and when 
you see the double-headed arrow, click and drag the line to the right of column G; then 
release your mouse button. Note that the page break is now moved there.

5. Click it again and drag it completely off the right side of the page. This removes the page 
break entirely.

6. Drag the solid blue line between columns C and D off the right side of the page to remove 
that line as well. Then drag the horizontal solid blue line between rows 22 and 23 off the 
bottom of the page to remove it too. Your sheet is now printing on just two pages again.

7. Select View � Normal View; then choose File � Page Setup. Click the Page tab.
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Printing
Excel is very screen-friendly, providing you with many ways to view your work on the com-
puter. Inevitably, however, there comes a time when you need to print a report or list. Excel 
has its quirks when it comes to printing, and it’s important for you to understand how to work 
with print settings.

By default, if you click the Print icon on the Standard toolbar or choose File � Print and 
make no adjustments in the Print dialog box, Excel prints one copy of the active worksheet to 
your default printer (meaning the printer set up as your default in Windows). However, if you 
want to print more than one copy, print to a different printer, or print something other than 
the full active sheet, you need to take additional steps. Excel’s Print dialog box gives you options 
for printing more than one copy, for choosing a different printer, and for changing other 
printer settings, depending on the printer or printers you have installed and available to your 
computer. Excel also allows you to print selected parts of a worksheet, selected pages within 
a sheet, multiple worksheets, and even the entire workbook.

Before you begin the exercises in this section, you need a worksheet that is more than one 
page long. Open the file Exercise 3-15.xls. Then follow the steps in Exercise 3.15 to increase 
the number of pages in a worksheet.

8. In the Scaling section, click the Fit To option button and set it to fit to 1 page wide by 1 page 
tall. Click OK.

9. Go to Print Preview. You’ll see that Excel has adjusted the font size and spacing so that 
the sheet now prints on just one page. Note that the Status bar now reads Page 1 of 1.

10. Close Print Preview. Save the file to update it and then close the file.

E X E R C I S E  3 . 1 5  

Scaling Files by Percentages

1. View the Stats sheet in Exercise 3-15.xls in Print Preview and you’ll see that it is one 
page long.

2. Return to Normal View, type a4:h31 in the Name box, and press Enter. This selects the 
range.

3. Copy the range; then select cell A32 and paste it. This doubles the length of your data.

4. Return to Print Preview and you’ll see that all of the data is still on just one page. This is 
because we set the page to Scale so it fits to 1 page wide by 1 page tall.

E X E R C I S E  3 . 1 4 ( c o n t i n u e d )
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In Excel, you can also print specific portions of any sheet instead of the full sheet. Let’s look 
at that next.

Printing Selections

By default, when you print a sheet, Excel prints the entire sheet. Sometimes, however, you 
don’t want to print the entire worksheet but only part of it. And sometimes this area is all you 
ever want printed when you print this sheet. Think of a large spreadsheet that has a few rows 
of formulas at the bottom that show only totals or other statistics pertaining to this sheet (we 
learn how to produce these types of statistics in Chapter 5, “Formulas and Functions in Excel”). 
Let’s say that this is the only part of this sheet that you want to print—perhaps the only part 
you ever print. Exercise 3.16 teaches you how to print a selected area one time and also shows 
you how to set a print area as the default print job so you can automatically print just a specific 
part of the spreadsheet in the future.

5. Click the Setup button. On the Page tab, in the Scaling section, click the Adjust To option 
button and change the percentage to 100%. Click OK.

6. Now the sheet is printing on three pages instead of one. Close Print Preview and save the 
file in your Chapter Three folder. Name it Exercise 3-15A.xls and leave it open for the next 
exercise.

E X E R C I S E  3 . 1 6  

Printing a Selected Area and Setting a Print Area

1. With Exercise 3-15A.xls still open, select the range A1:B18 on the Stats sheet and choose 
File � Print.

2. In the Print dialog box, at the bottom, in the Print What section, click the Selection option 
button. Click the Preview button below that and note that only the data in columns A and 
B (along with the header and footer) will be printed.

3. If you have a printer attached to your computer and want to actually print the selection, click 
the Print button at the top of the Print Preview screen. Otherwise, just close Print Preview.

4. Select the range A1:H7 and choose File � Print Area � Set Print Area.

5. Click in a cell outside the selection to deselect it. Notice the dashed line around the area 
you set as the Print Area. Go to Print Preview.

6. Notice that now, by default, this is the only area of the worksheet that will print, even 
when it’s not selected.

E X E R C I S E  3 . 1 5 ( c o n t i n u e d )
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For even more control over printing, you can choose to print more than one copy of the 
pages, and also specify exactly which pages you want printed.

Printing Multiple Copies and Specific Pages

The default settings for your printer are controlled by the Windows settings. Any changes you 
make in Windows will be applied to your printer settings in all programs. However, in Excel, 
you can specify printer settings for any one workbook and the settings will be remembered 
when you save the file. In the Print dialog box, clicking the Properties button will take you to 
your printer settings, where you can adjust different options, depending on your printer. The 
Printer Properties dialog box is controlled by the printer driver for your specific printer and 
not by Excel.

Excel’s Print dialog box, on the other hand, is where you can specify, for this particular 
job, how many copies you want printed, and what part of the workbook you want printed. 
Exercise 3.17 shows you how to specify these settings.

7. Close Print Preview and select the range A8:D11. Choose File � Print. Click Selection and 
then click the Preview button. Note that the selection overrides the Print Area and will be 
printed instead.

8. Close Print Preview and cancel out of the Print dialog box. Choose File � Print Area � 
Clear Print Area. Make sure no range is selected; open Print Preview and you’ll see that 
the whole worksheet again prints.

9. Close Print Preview and move to the Job Applications sheet. Click the chart to select it.

10. With the chart selected, choose File � Print. Notice that the Print What section shows only 
one choice: the Selected Chart. Click the Preview button and you’ll see that, when a chart 
is selected, you can print just the chart, without the data.

11. Close Print Preview and save the file to update it, but don’t close the file.

E X E R C I S E  3 . 1 7  

Choosing the Pages to Print and How Many Copies of Each Page to Print

1. Still inside Exercise 3-15A.xls, choose File � Print and, in the Print What section, choose 
Entire Workbook. Then click the Preview button.

2. Use the Next button to preview all the pages that will print. Notice that now the Jobs 
Available sheet is also being included in the print job.

E X E R C I S E  3 . 1 6 ( c o n t i n u e d )

4002book.fm  Page 126  Friday, March 24, 2006  11:36 PM



Printing 127

Now that you’ve learned how to print the entire workbook, as well as selected pages within 
a worksheet, it’s time to learn how to print multiple selected sheets instead of just one or the 
whole workbook. To do this, you must first select the multiple sheets.

To select multiple sheets, you can group them. It is important to note that you must remem-
ber to deselect multiple sheets after you have printed. Grouping sheets is a convenient feature, 
because when sheets are grouped, what you do to one is done to all. For example, if sheets are 
grouped and you type a value into cell F22 on one sheet, that same value will appear in F22 
on all of the grouped sheets. So, always remember to ungroup sheets before you move onto 
something else. (Grouped sheets are discussed in more detail in Chapter 9, “Advanced Tem-
plate Design and Workbook Security.”)

Our last exercise, Exercise 3.18, shows you how to print multiple selected worksheets with-
out printing the whole workbook.

3. Click the Print button and, in the Print Range section, choose Pages and type 2 in the From 
box and 3 in the To box. Click the Preview button.

4. Note that only pages 2 and 3 are now included.

5. Close Print Preview and choose File � Print.

In the dialog box, note the Number Of Copies option. You can print as many copies as 
you need, in one printing, and you can choose whether or not you want the pages col-
lated. Select and deselect the Collate box to see the preview pictures to the left of it change.

6. Save the file to update it, and leave it open for the next exercise.

E X E R C I S E  3 . 1 8  

Printing Multiple Worksheets

1. Still inside the file you saved in the previous exercise, add a new worksheet and name it 
Vacations.

2. Make it the last worksheet and enter in cell A1 the title Employees Who Have Not Yet 

Taken Their Vacation. Make the title bold.

3. Go to the Stats sheet, select the range A4:B11, and copy it.

4. Return to the Vacations sheet, select cell A3, and paste. Now we have three sheets in this 
workbook.

5. With the Vacation sheet active, hold down the Ctrl key and click the Stats sheet tab. Note 
that both tabs are white. This means both pages are active (or grouped).

E X E R C I S E  3 . 1 7 ( c o n t i n u e d )
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Summary
What a difference it makes to the look of your worksheets, both onscreen and when printed, 
when you understand how to manipulate the numerous views Excel has to offer! Different 
views and layouts help make the data more usable, as well as more attractive, and can save you 
time when comparing and printing.

To better organize data, you can sort it, by one or more columns, in ascending or descend-
ing order. You can create various sort sequences and print them. You can also save different 
sorted lists as custom views.

AutoFilters allow you to specify what you want to see and temporarily remove unnecessary 
information. You can filter for specific values and top or bottom items or percentages using 
the basic AutoFilters. Or you can create custom AutoFilters to select data meeting specific cri-
teria. You can then print the filtered list and save the filtered view.

To make onscreen use of data more convenient, you can freeze portions of your data so they 
appear onscreen at all times while you scroll to other areas. You can also split your window 
into separate panes that allow you to see different parts of a spreadsheet at the same time. 
Excel also lets you view multiple workbooks onscreen at the same time, using the Compare 
and Arrange features, and you can save these views as workspaces.

Before printing, you can use Print Preview to see how the printed worksheet will look. Page 
Setup and Page Break Preview let you make many different changes to the layout and control 
the page breaks. The Print dialog box enables you to choose whether you want to print a 
selected area or chart, the whole active worksheet, individual pages within a worksheet, or the 
entire workbook. You can also group sheets before printing to be able to print specific sheets, 
and set up predefined default print areas.

6. Go to Print Preview and click the Next button. You’ll see that all pages on both sheets are 
now in the print job.

7. Close Print Preview and click the Jobs Available tab. This deselects the other two tabs so 
they are no longer grouped.

8. Click the Stats sheet tab, then hold down the Shift key and click the Vacations tab. This 
action selects all three tabs.

9. Open Print Preview. All sheets will now print.

10. Close Print Preview. Right-click any grouped sheet tab and choose Ungroup Sheets.

11. Save the file to update it, and then close the file.

E X E R C I S E  3 . 1 8 ( c o n t i n u e d )
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Exam Essentials
Know how to sort data. Be able to sort by up to three columns, in both ascending and 
descending order. Understand what primary and secondary sorts are and when a secondary 
sort would come into play.

Be familiar with all of the different AutoFilter choices. Know how to apply basic AutoFil-
ters by choosing a single item from the AutoFilter dropdown or by using the Top 10 filter. 
Know how to create custom AutoFilters by using criteria such as Less Than, Greater Than, 
and Equal To. Be able to turn AutoFilters on and off, and know how to clear filters from any 
one column or all columns.

Be able to use the right view for the right reason. Recognize the various views and when to 
use them. Know all the features of Page Break Preview, Print Preview, and Normal View, so 
you can use the correct one when necessary.

Know all of the different Window layout features. Be proficient in the use of all of the com-
mands in the Window menu, including Freeze Panes, Split, Arrange, and Compare Side By 
Side. And know how to save and show custom views and workspaces.

Be familiar with all the features needed to specify printing choices. Understand how to use 
the four tabs in the Page Setup dialog box, the buttons in Print Preview, and the choices in the 
Print dialog box. Be able to print selections; set up, print, and clear Print Areas; print specific 
page ranges; print entire workbooks; group and print specific worksheets; and print multiple 
copies.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the completed Solu-
tions files in the zipped file for this chapter to see how you did. To complete these exercises, 
extract the appropriate files identified before each scenario from the zipped file for this chapter.

For scenarios 7 and 8, use the file MOS Scenarios Ch 3.xls.

 

MOS Scenario 7: Sort and Filter Data and Save Custom Views

Using the Stats worksheet, create and save a custom view named Manufacturing Ten Plus, 
showing only the employees in the Manufacturing department who have been employed for 
longer than ten years, sorted alphabetically by last name and first name. Show the view in 
Print Preview.
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For Scenario 9, you must have both MOS Scenario 8 Completed.xls and MOS Scenario 
3A.xls open.

To be able to view the workspace file,401K-Insurance.xlw, you must also have 
all of the other scenario files on your machine in the same folder, since they 
are included in the workspace. Also, when you open this workspace file, you 
will need to display the custom view named scenarioview in the file shown on 
the left, so that you can see the workspace displayed correctly.

 

MOS Scenario 8: Remove Filters, Adjust Settings, and Print Specific 
Sheets and Selections

Remove the filters from the Stats worksheet and change the orientation to Portrait; then print 
two copies of the Stats and Vacations sheets in one print job. Print again, this time printing 
only one copy of the chart on the Jobs Available worksheet. Force the Stats page to print on 
one page only and print that.

 

MOS Scenario 9: View Multiple Workbooks at the Same Time, Compare 
and Change Data, and Save a Workspace

Compare the two open workbooks side by side and type an X in the columns in the 3A work-
book to signify “yes” when appropriate, using the information from the other workbook. Use 
appropriate features so that you can see all data on the screen at one time. When you have 
finished, save the workspace as 401k-Insurance.xlw in the My Documents folder.
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4

 

Editing Tools, 
Comments, 
and Hyperlinks

 

MOS SPECIALIST OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Locate, select, and insert supporting information

�

 

Insert, view, and edit comments

�

 

Create and modify hyperlinks
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Excel assists you in keeping your data accurate, consistent, clear, 
and documented. Tools included in the program help you cor-
rect text and formula errors and inconsistencies. We discuss the 

formula-correction tools in Chapter 8, “Data Analysis and Sharing Workbooks.” However, 
in this chapter, you’ll learn how to check for and correct spelling errors, as well as how to use 
different tools and utilities to ensure that information is added the same way in all places in 
a workbook. You’ll also learn how to research references, add comments for clarification and 
instruction, and include shortcuts to other sources.

This chapter is important not only because of the three MOS objectives it covers, but also 
because it provides you with quick ways of checking the accuracy of your data while taking 
your MOS Exam so you don’t lose points because of something that would have been simple 
to double-check.

I’ve provided files on the book’s website that you will need for each exercise in this chapter. 
Download the file exl2003ch04.zip and extract the files before you begin.

 

Using Excel’s Editing Tools

 

One of my students once told me he lost a lot of points when taking the MOS Exam because 
of “stupid stuff.” When I asked him what he meant, he replied, “Stuff like spelling errors.” I 
explained to him that the MOS Exams are scored by a computer and not a human, and, there-
fore, if the instructions tell you to type 

 

John Smith

 

 and you type 

 

John Smeth

 

, the machine can-
not find the text “John Smith” and, consequently, assumes you did not complete that part of 
the exercise correctly.

Some people think spelling and grammar are only important when using word processing 
programs; also, some people think consistent data is only important when using database pro-
grams. This is not true. No matter how well your spreadsheet works, how accurate your data is, 
or how impressive your formulas are, people will not take you seriously if you can’t spell. In the 
same vein, no one will be able to accurately search or filter your data if it isn’t consistent. So, the 
reality is that both accuracy and consistency are important parts of a well-designed workbook.

The exercises in this section will guide you through Excel’s utilities, which make accuracy 
and consistency easier to achieve. Let’s start with the Spelling tool.

 

Using the Spelling Tool

 

Microsoft Office 2003 includes an extensive dictionary, based on the language chosen in your 
Windows installation. It is this dictionary that Microsoft Office uses to check your spelling in 
all of the Office programs, including Excel. When a word is flagged as misspelled, it does not 
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mean it is necessarily spelled wrong; it simply means the word is not in the 

 

Office dictionary

 

. 
If you select Tools �

 

 Options and click the Spelling tab, you will see what language Excel is 
using to check spelling. If the language being used by Excel is incorrect, you can change it there 
(you’ll learn more about changing these type of settings in Chapter 12, “Customizing Excel 
and Setting Defaults”).

When you check your spreadsheet for misspellings, you can choose to change them, ignore 
them, add them to the dictionary, or automatically correct them if you ever spell them this way 
again. When you select Change or Ignore Once, the spelling is ignored or corrected just this 
one time, but will be flagged again if it is found later in the worksheet. On the other hand, if 
you choose Change All or Ignore All, this tells Excel to ignore that word everywhere on the 
sheet this time—though running the Spelling tool again at another time would still flag the 
misspelled word. If you choose to add the word to the dictionary or add it to your autocor-
rects, you’ll make the change in all of your Office programs (because these proofing tools are 
shared by all of them) in all files you work on in the future.

Exercise 4.1 shows you how to use the Spelling tool in Excel to make various choices 
regarding spell-checking.

 

E X E R C I S E  4 . 1  

 

Finding and Correcting Spelling Errors

 

1.

 

Open the file Exercise 4-1.xls and note that there are two sheets: One is named Current 
and the other Possibles. This workbook is set up for a nonprofit medical-research com-
pany and shows both the current outside resources they use and the companies they are 
considering using in the future. Notice that the Possibles worksheet contains several 
spelling errors.

 

2.

 

Select cell A1 on the Possibles sheet and open the Spelling dialog box by either clicking on 
the Spelling button on the Standard toolbar, choosing Spelling from the Tools menu, or 
pressing F7 on your keyboard. You are presented with the Spelling dialog box shown here:

 

3.

 

As you can see, the first word it found is 

 

Clinets

 

, and it shows four possible corrections 
at the bottom. Choose the first one, Clients, and click the Change button.
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Excel does not mark spelling errors in any noticeable way (as a word process-
ing program, like Microsoft Word, does). This is because Excel does not check 
spelling as you type; instead, usually when you have finished working on a 

 

worksheet, you must run the Spelling tool manually.

 

In Exercise 4.1, there were two buttons we did not use. One was the Add To Dictionary 
button and the other was AutoCorrect. Both of these buttons have a similar effect; selecting 

 

4.

 

Next it finds 

 

Expertize

 

, and this time it has only one suggested correction. But it’s the 
right one, so just click Change.

 

5.

 

Mandiglio

 

 is the next word it finds, and this is one of the company names, so you don’t 
want to choose any of the suggested corrections. Also, because this company is not one 
that will be likely to show up again, you really don’t want to add it to the dictionary, so 
just click Ignore Once.

 

6.

 

The word 

 

pharmacueticals

 

 comes up next. Choose the top one in the list again and click 
Change.

 

7.

 

Goosedown

 

 is another company name, so ignore it. But keep in mind that, if this were in 
fact a company name that you use in many different Office documents, you might want 
to add it to your dictionary so the spell checkers in the various programs don’t continue to 
flag it.

 

8.

 

Graphix

 

, 

 

Plusse

 

, and 

 

Zeero

 

 are all more company names. Ignore each of them.

 

9.

 

The word 

 

evals

 

 does not give the suggested correction you want, so just click into the top 
box and manually change evals to 

 

evaluations

 

. Then click Change.

 

10.

 

The next one is 

 

espensive

 

. This time choose the second suggestion in the list, expansive; 
then click Change. However, you chose the wrong one, so click the button at the bottom 
that says Undo Last. Then, choose the first one in the list, expensive, and click Change.

 

11.

 

Again, for 

 

intelligents

 

, the choices do not reflect the one you want, so manually change 
it to 

 

intelligence

 

; then click Change.

 

12.

 

Franchises

 

, 

 

clinics

 

, and 

 

Savannah

 

 are all the correct choices, and they all appear at the 
top of the list, so just click Change for each of them.

 

13.

 

Ignore 

 

Collecti

 

 and 

 

Phila

 

, and click OK when the box tells you the spelling check is 
complete.

 

14.

 

Select File �

 

 Save As and create a folder named Chapter Four. Save this file in that folder 
and name it 

 

Exercise 4-2.xls

 

, but do not close it.

 

E X E R C I S E  4 . 1

 

( c o n t i n u e d )
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them will keep a particular word from being flagged again in any of your Office programs. But 
they are different in two distinct ways:
�

 

Add To Dictionary tells Excel to put a word in your 

 

custom dictionary

 

, exactly the way 
it is now, because you always want this word spelled this way. You might choose to add 
your last name and company name to the dictionary, for example, if Excel is constantly 
flagging them as spelling errors.

�

 

AutoCorrect 

 

means that this is something you often misspell, so when you misspell it this 
way from now on, you want Excel to change it to the correct spelling automatically, with-
out flagging it for you to choose.

Adding something to the dictionary is fairly straightforward and doesn’t require any more 
explanation from me. If you want Excel to stop bugging you about the way something is 
spelled, just add it to the dictionary.

However, AutoCorrect has many options that are available to you from outside of the 
Spelling tool, so read on to learn more about that.

 

Using AutoCorrect

 

Most AutoCorrect actions reflect what you want most of the time, so simply using the Undo 
button occasionally when they don’t is no big deal. But what if your last name is Abbout and 
every time you type it, Excel changes it to About? In that case, you might want to remove this 
autocorrection completely.

The AutoCorrect feature not only corrects common misspellings, but it changes things like 
(c) to ©, the copyright symbol. Also, the feature identifies multiple words that require a space; 
for example, it will change “aboutthe” to “about the.”

Another beneficial use of the AutoCorrect feature is to create your own corrections and use 
them as shortcuts to convert initials to long names. Assume your company name is Magilicutty, 
Hammerschlemmer, and McCaulkin, Ltd. Imagine having to type this 40 times a day. You can 
create your own AutoCorrect shortcut so whenever you type 

 

mhm

 

, Excel automatically cor-
rects it to Magilicutty, Hammerschlemmer, and McCaulkin, Ltd. Not only does this shortcut 
decrease the amount of typing you have to do, but it assures you that this company name will 
be entered in exactly the same way in every Office program and will never be misspelled. The 
possibilities are endless; you can set up AutoCorrect shortcuts for anything you type frequently.

 

Read This Exercsie … Ooops, I Mean Exercise

 

I am writing this book using Microsoft Word 2003, which uses the same dictionary and Auto-
Correct feature as Excel. One word that I have been typing a lot and consistently type incorrectly 
is 

 

exercise

 

, which my fingers want to type as 

 

exercsie

 

; the spell checker in Microsoft Word will 
flag it as a spelling error, which indeed it is. So, I’ve just added an AutoCorrect entry to replace 

 

exercsie

 

 with 

 

exercise

 

, and it is saving me lots of time. However, while typing this paragraph, 
I had to undo the autocorrection three times, just to accommodate my deliberate misspellings.
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Remember, when you create AutoCorrect shortcuts, be careful. The “correction” should 
never be a real word that you would not want changed. For example, you wouldn’t want to 
replace “to” with “Tom O’Neill” because “to” is a word you often type; it’s better to use 
something like “tfo” if Tom’s middle name is, for instance, Francis. Creating AutoCorrect 
shortcuts like this is a good way to ensure that names are entered the same way in every Office 
program. Some people keep a list of autocorrections they have created taped to the side of their 
computer monitors.

This next exercise, Exercise 4.2, shows you how AutoCorrect works, how to adjust the 
AutoCorrect options, how to remove AutoCorrect entries you don’t want, and how to create 
new entries without using the Spelling tool.

 

E X E R C I S E  4 . 2  

 

Working with AutoCorrect Options

 

1.

 

With the file you saved in the previous exercise still open, select cell A11 on the Possibles 
sheet. Type 

 

Teh Banyo

 

 and watch your screen closely.

 

2.

 

Notice as soon as you pressed the spacebar after the h, Excel autocorrected Teh to The. 
Press the Esc key to clear the cell.

 

3.

 

Type 

 

Teh

 

; then press the spacebar. As soon as you see Excel change your entry to The, 
click the Undo button or press Ctrl+Z. When you do this, Excel undoes the last thing 
done—in this case, the autocorrection. Now type 

 

Banyo

 

 and note that Excel leaves Teh 
alone.

 

4.

 

Select Tools �

 

 AutoCorrect Options; then select the AutoCorrect tab.

 

5.

 

In the Replace box, type 

 

teh

 

 and note that “the” appears in the With box beside it (see the 
graphic below). Also, note below that, in the list, you see the “teh-to-the” AutoCorrect 
entry highlighted. Click the Delete button below that.
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Using Find And Replace

 

Another way to assure that data is consistent within your workbook is to use 

 

Find and 
Replace

 

. In Chapter 1 you learned how to use Excel’s Find utility; now let’s take it a step fur-
ther and add the Replace component. When you want to find all instances of a particular 
word or phrase in your workbook and then replace them with something else, doing it man-
ually is tedious and time-consuming, and does not ensure consistency, since you are depend-
ing on your ability to type it exactly the same way every time. The exercises in this section 
show you how to find something, then replace it one time or replace it everywhere on the 
worksheet or in the entire workbook. First, in Exercise 4.3, let’s look at finding it and replac-
ing it one time.

 

Now, in reality, that’s an autocorrection you probably want to keep, so let’s bring it back.

 

6.

 

It should still appear in the Replace and With boxes, but if it does not, simply type 

 

teh

 

 in 
the Replace box and 

 

the

 

 in the With box, then click the Add button. That’s how you add 
an autocorrection to the list.

 

7.

 

Click in the Replace box and type 

 

mhm

 

. Then, in the With box, type 

 

Magilicutty, Ham-

merschlemmer, and McCaulkin, Ltd.

 

 Click the Add button; then click OK to close the Auto-
Correct Options box.

 

8.

 

In cell A12, type 

 

mhm

 

 and press Enter. AutoCorrect enters the full name, and you know 
it’s all spelled correctly and the same way, every time you see it.

 

9.

 

Return to the AutoCorrect Options box and type 

 

mhm

 

 in the Replace box; then delete the 
autocorrection you just created.

Look at the other AutoCorrect options above this list. You can deselect any you don’t 
want to use. Notice the last one, Replace Text As You Type; deselecting this option turns 
AutoCorrect off completely.

Look at the AutoFormat As You Type and Smart Tags tabs also, and note the additional 
options you can turn on or off.

 

10.

 

When you are done, click OK to make sure mhm is removed from the AutoCorrect list.

 

11.

 

Double-click cell A12, then click your pointer behind the comma after Hammerschlem-
mer. Hold down your Alt key and press Enter. This drops the text after this to a new line 
within the cell. Press your Delete key to remove the space before the word “and,” and 
then press Enter to leave the cell.

 

12.

 

Save the file to update it, and then close the file.

 

E X E R C I S E  4 . 2

 

( c o n t i n u e d )
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Find and Replace, One at a Time

 

1.

 

Open the file Exercise 4-2.xls that you saved in the previous exercise. If you did not save 
it, extract it from the zipped file for this chapter.

 

2.

 

Select cell A1 on the Current sheet and open the Find And Replace dialog box, either by 
selecting Edit � Replace or pressing Ctrl+H.

3. This brings up the same dialog box you saw when you used the Find feature in Chapter 1; 
however, you are on the Replace tab. In the Find What box, type pharmaceutical (be sure 
you spell it correctly); then in the Replace With box, type drug, as demonstrated here:

4. Notice the buttons at the bottom of the box. Click the Find Next button and the cursor 
finds cell C3, which contains the text you typed in the Find What box.

5. Click the Replace button. Notice that Excel changes pharmaceuticals to drugs, keeping 
the “s” at the end, even though you did not type the s. Because the word you typed was 
pharmaceutical, that’s all that was replaced with drug and the s was left intact.

6. Click the Find All button and note that it displays all of the occurrences of the word on this 
worksheet.
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When using the Replace feature, in many cases it’s best to replace just one occurrence at a 
time so that you can review what’s being replaced to be sure it is, in fact, something you want 
changed. However, if you are 100 percent sure you want to replace every occurrence, you can 
use the Replace All feature. Another alternative, if you are fairly sure you want to replace all 
occurrences but not 100 percent sure, is to first click Find All; review what it found and then 
click Replace All.

By default, the Find And Replace feature finds only the designated occurrences on the active 
worksheet. If you want to instead find the specified occurrences on multiple sheets, you must 
group the sheets first. I talked about grouping in Chapter 3, when explaining how to print more 
than one sheet at the same time. But, remember, I said that grouping can be used whenever you 
want to include more than one sheet in any action, so here’s another place where it’s applicable.

Let’s take a look at the different ways to use Find All and Replace All in Exercise 4.4.

7. With the first one in the list highlighted, click the Replace button to replace just that one. 
Then, with the second one highlighted, click Replace again.

Notice that the Find And Replace box may move when you click Replace to show you the 
location of the next occurrence. If it does not move automatically, or if you want to move 
it somewhere else, drag it by its title bar to any location on your screen.

8. Once you’ve replaced all instances of the word, click the Close button; then save the file 
into your Chapter Four folder and name it Exercise 4-5.xls. Do not close the file.

E X E R C I S E  4 . 4  

Find and Replace, All at Once

1. In the file you saved in the last exercise, select cell A1 on the Current sheet and return to 
the Find And Replace dialog box.

2. Change the entry in the Find What box to drug and change the Replace With entry to 
pharmaceutical.

3. Click Replace All. The box pops up, telling you that Excel completed the process and 
made three replacements. Click OK.

4. With the Find And Replace dialog box still open, hold down your Ctrl key and click the 
Possibles tab so that both sheets are now selected.

5. Change the boxes again to find pharmaceutical and replace it with drug; then click the 
Find All button. In the list at the bottom of the dialog box, you’ll see that Excel found the 
three occurrences on this sheet, but also a fourth occurrence on the Possibles sheet.

E X E R C I S E  4 . 3 ( c o n t i n u e d )
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There are two elements of Find And Replace that are pretty helpful. Let’s take a minute to 
discuss wildcards and finding and replacing formatting.

Using Wildcards

Notice in Exercise 4.4 that the categories in the Area of Expertise column are consistent on the 
Current sheet. However, on the Possibles sheet they are not. The drug company categories not 
only appear as drugs; they also show drug sales and drug evaluations. Think of how we used 
the AutoFilters in Chapter 3 to filter this data and how much easier it would be to find the drug 
companies if they all had the same category in this column. You can clean this up, using Find 
And Replace with wildcards.

Wildcards are characters that represent any string or any character. In Excel, there are 
two wildcards you can use. A question mark (?) designates any one character, but one char-
acter only. So, searching for drug?sales would find drug sales (because a space is considered 
a character), but would not find drugs sales or drug resales because there is more than one 
character between the text drug and the text sales. An asterisk (*) is the wildcard you use to 
find any string of characters; so, drug* finds drugs, drug sales, and drug evaluations. Yes, 
simply entering drug in the Find What box would find them all also; however, when replaced, 
only the word drug would be replaced. If you want to find all phrases that begin with the 
word drug and replace each phrase with the word drugs, you would find drug* and replace 
it with drugs.

Exercise 4.5 shows you how to use wildcards along with Find And Replace.

6. Click the occurrence found on the Possibles sheet and note that you are moved to that 
location. Yes, it’s one you want to replace, so click Replace All. The confirmation box now 
tells you it made four replacements. Click OK.

7. Move back to the Current sheet. Clicking on that sheet tab should ungroup the sheets but, 
if it doesn’t, right-click one of the tabs and choose Ungroup Sheets.

8. Close the Find And Replace dialog box and save the file to update it, but do not close 
the file.

E X E R C I S E  4 . 5  

Using Wildcards to Find and Replace

1. In the workbook you still have open from the last exercise, select cell A1 on the Possibles 
sheet and open the Find And Replace dialog box.

2. In the Find What box, type drug* and in the Replace With box, type drugs. Click Find All.

E X E R C I S E  4 . 4 ( c o n t i n u e d )
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On occasion, you may want to find an actual wildcard character; for example, you have 
company names starred in a column, using asterisks before their names. If you wanted to find 
all the names with an asterisk, and you type an asterisk in the Find What box, Excel will think 
the asterisk is a wildcard, so it will not find the right occurrences for you. To find the actual 
asterisk as text in the Find What box, type a tilde (~) before the asterisk; then Excel will rec-
ognize it. Searching for * will find every cell in your sheet, but searching for ~* will find only 
the cells that include an asterisk. If you want to remove all the asterisks in your worksheet, 
put ~* in the Find What box and leave the Replace With box empty. Excel will then find and 
remove all of the asterisks by replacing them with nothing.

Finding and Replacing Formatting

Not only can you find and replace data, but you can also find and replace formatting. This is 
a great shortcut when you want to change all instances of a font in a workbook, for example. 
Exercise 4.6 shows you how to find all instances of one font and replace it with another.

3. Click the Replace button one time. The first one is replaced, but because it already read 
“drugs,” nothing changes. Click Replace again and drug sales becomes drugs; then click 
Replace a third time and drug evaluations is also changed to drugs.

4. Close the Find And Replace dialog box; then save the file to update it and close the file.

E X E R C I S E  4 . 6  

Finding and Replacing Formats

1. Open Exercise 4.5.xls and select cell A1 on the Current sheet. Open the Find And Replace 
dialog box.

2. Click the Options button to reveal the Format buttons shown here:

3. Click the Format button to the right of the Find What box; then click the Font tab. Choose 
Arial.

E X E R C I S E  4 . 5 ( c o n t i n u e d )
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Using Automated Features to Maintain Accuracy and 

Consistency

There are a few more Excel features we haven’t looked at yet that help you maintain accuracy 
and consistency within your spreadsheet. These include AutoComplete, which fills in data 
based on data previously entered above or below it in a column; Pick From Drop-Down List, 
which lets you click and choose from a list of data that was entered above or below it in the 
column; and AutoFill, which lets you fill a series of data based on a recognized sequence. 
Not only do these utilities make for less typing, but, more importantly, they allow you to see 
how data was entered previously and let you enter it in exactly the same fashion. Let’s look 
at AutoComplete and Pick From Drop-Down List first, since they are fairly similar. Check 
out Exercise 4.7.

4. Click the Format button to the right of the Replace with box and choose Times New 
Roman.

5. Notice the Preview buttons display the fonts as Arial and Times New Roman. Click the 
Replace All button, and everything on the worksheet that was Arial is now Times New 
Roman.

6. Close the file but do not save the changes.

Custom Lists Can Be Real Time-Savers

I once helped a small company set up Excel templates for one of their departments, and I 
asked them to prepare the data that they would need to include in each template. They were 
all busily typing away, and I happened to notice one woman typing the same four department 
names over and over down a column. She obviously knew how to use AutoComplete, so she 
actually only had to type the first letter of each department, then press Enter. I asked her why 
it had to be set up this way, and she explained that she had to have the four departments 
repeated for every day of the year for charting purposes. And it turned out that she really did 
need it set up this way so it would be compatible with some outside database. But, when she 
told me she would need this same setup in about seven different report templates we would 
be making, I taught her how to make a custom list. She was truly impressed when she saw she 
could create a custom list that included the four department names, then type the first depart-
ment name in one cell and use the fill handle to repeat the series of four department names 
over and over 365 times to fill 1,460 rows, all in less than 2 minutes.

E X E R C I S E  4 . 6 ( c o n t i n u e d )
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E X E R C I S E  4 . 7

Using AutoComplete and Pick From Drop-Down List

1. Open a blank workbook and enter the following data in cells B1:B5:

Supervisor on Call

Jones

Peterson

Harrison

Myers

2. Select cell B1 and make the text (Supervisor on Call) bold.

3. In cell B6, type an uppercase P and see that Excel is ready to autocomplete that for you 
and fill in Peterson. Continue to type the letters hillips and see that what you type over-
writes Excel’s AutoComplete suggestion. Press Enter.

4. In cell B7, type a lowercase j. This time Excel suggests jones, from the list above, and, in 
this case, Jones is what you want; so, just press Enter. Note that Excel uppercases the J 
and fills in the full name, Jones.

5. In cell B8, type another lowercase p. This time, nothing happens. This is because there 
are two names above this that begin with P, so Excel doesn’t know yet which one you 
want. AutoComplete does not kick in until it matches what you type with something 
unique above it. “P” is not unique; there are two entries above that begin with P.

6. Type an e and Excel suggests peterson. Press your Backspace key to remove the e and 
type h and Excel suggests phillips. Press Enter; Excel uppercases the P and enters Phillips 
into the cell.

7. Right-click in cell B9 and choose Pick From Drop-Down List. Click Myers, and press Enter.

8. Right-click in cell B10; choose Pick From Drop-Down List; select Harrison. Then, double-
click after the “i” in Harrison and change the name to Harrington. Press Enter.

9. Move over to column C and select cell C10, type H, and you’ll notice nothing happens. 
Press the Esc key to clear the cell, and right-click and choose Pick From Drop-Down List. 
Note that the list is empty. AutoComplete and Pick From Drop-Down List work only ver-
tically down a column, and not horizontally across a row.

10. Save the file in your Chapter Four folder and name it Exercise 4-7.xls. Leave the file open 
for the next exercise.
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AutoComplete and Pick From Drop-Down List simply suggest items for you, from those 
entered above or below the active cell. AutoFill, however, lets you fill a range of cells with a 
progressive series. These series can be numerical (5, 10, 15, 20, etc.) or textual (Monday, 
Tuesday, Wednesday, etc.). Excel comes installed with a few sequential lists that it recognizes 
automatically, but you can also add your own custom lists.

Exercise 4.8 teaches you how to use AutoFill in a few different ways.

E X E R C I S E  4 . 8  

AutoFill and Custom Lists

1. Still inside the workbook you saved in the previous exercise, type Day in cell A1 and make 
it bold.

2. In cell A2, type Monday, then press Enter.

3. Select cell A2 again and, using the thin black plus-sign pointer on the fill handle, drag the 
cell content down to cell A10.

Note the tooltip that pops up as you are dragging and shows the progression from Mon-
day to Tuesday to Wednesday, etc.:

4. Release your mouse button when you get to cell A10. Note that Excel displays the days 
of the week from Monday through Sunday, then starts at Monday again.

This is an example of a premade AutoFill custom list that is included in Excel. Another 
one consists of months of the year. Excel will also recognize a series of numbers if you 
either show it a pattern or define the parameters of a series fill.
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5. Select any cell in column B and insert a new column to the left of it. In the new column B, 
type Rotation in cell B1.

6. In cell B2, type the number 1; then type 2 in cell B3.

7. Select the range B2:B3 and use the fill handle to drag both cells down to cell B10.

For Excel to detect a pattern, you must select all of the cells needed to show Excel the pat-
tern and drag the whole selection, using the fill handle, as seen here:

Notice that Excel recognized the series specified in the first two cells and continued it, 
increasing by one in each cell.

8. Click the Undo button until cells B2:B10 are empty. Type 3 in cell B2 and 7 in cell B3; then 
select the range B2:B3 and use the fill handle to drag that selection to cell B10. Excel rec-
ognizes a different pattern, increasing the cell values by four instead of one.

9. Click Undo again, until cells B2:B10 are empty. Type 10 in cell B2. Press Enter; then select 
cell B2 again. Select Edit � Fill � Series.

10. The Series In setting should be Columns; Type should be Linear. In the Step Value box, 
type 10 and in the Stop Value box, type 90 (see the graphic below). Click OK.

As you can see, you can choose to fill across rows instead of down columns, and specify 
different parameters for filling series. You chose a step value of 10, so the number increases 
by 10 in each cell, and because you chose 90 as the stop value, the fill ended when it hit 90.

You can also create custom lists for AutoFill to remember.

11. Select Tools � Options. Click the Custom Lists tab.

E X E R C I S E  4 . 8 ( c o n t i n u e d )
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Using the Research Pane

Like the dictionary that is used by all of the Office programs to check spelling, some other ref-
erences are included in Office’s Research Library: a thesaurus, a translation utility, and an Inter-
net encyclopedia. Depending on your installation of Office, you may be a different number of 

12. The custom lists appear on the left, showing the days of the week and months of the year. 
Click in the List Entries box on the right and type First; then press Enter and type Second; 
then press Enter and type Third. The List Entries box should look like this:

13. Click the Add button and note that the new list was added to the Custom Lists box on the 
left. Click OK.

14. In cell D1 type Shift and press Enter. In cell D2 type First and press Enter. Select cell D2 
again and use the fill handle to drag down to cell D10. Note that the new custom list is 
applied. When you create a custom list, you need to select only one cell before using 
AutoFill.

15. Click Undo until cells D2:D10 are empty. Type Second in cell D2 and drag that down to cell 
D10, using the fill handle. Note that the series begins with any value that is part of that 
series and repeats itself over and over.

16. To remove a custom list, return to Tools � Options � Custom Lists. Select the First/Sec-
ond/Third list in the Custom Lists box on the left and click the Delete button on the right. 
Click OK when the confirmation box appears. Click OK again to return to the worksheet.

17. Save the file in your Chapter Four folder and name it Exercise 4-8.xls. Close the file.

E X E R C I S E  4 . 8 ( c o n t i n u e d )
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references than I show in this section. The thesaurus allows you to find synonyms (words that 
mean the same thing), the translation utility lets you translate a word into another language, 
and the encyclopedia gives you access to various Internet reference sites. These exercises show 
you how to use these three default research tools.

You can access the Research task pane by clicking the Research button on the Standard 
toolbar, next to the Spelling button. Or, you can hold down your Alt key while clicking on any 
cell in the worksheet to bring up the Research task pane, including information pertaining to 
the text in that cell. Also, right-clicking on any cell and choosing Look Up will bring up the 
Research task pane.

We begin in Exercise 4.9 with a look at the thesaurus.

E X E R C I S E  4 . 9  

Finding Synonyms

1. Open Exercise 4-8.xls that you saved in the previous exercise. If you did not save it, 
extract it from the zipped file for this chapter.

2. Select cell E1 on Sheet1 and type Project. Press Enter.

3. Hold down the Alt key and click cell E1. The Research task pane opens and Project 
appears in the Search box. Make sure the box below that says All Reference Books. 
Below that is a list of the reference sources available to you:

Note that the list of reference works is expandable and collapsible. If you see minus signs 
to the left of any source, it means that section is expanded. Click all minus signs to col-
lapse everything, as shown in the graphic.
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4. Click the Research Options link at the bottom of the pane to see the choices shown in the 
following graphic. You can select or deselect the choices available to you within the 
Office suite and from the Internet. Make any changes you want, then click OK, or you can 
simply click Cancel if you want to accept the settings as they are.

5. Click the All Reference Books dropdown and choose the thesaurus for your language. In 
this case, I am using English (U.S.) for these examples.

6. The list of synonyms appears in the task pane. Rest your mouse pointer over the choice 
you want and a dropdown arrow appears to the right. Click the dropdown arrow and 
choose Insert. I chose Assignment and now that appears in cell E1.

7. In cell E2, type warehouse check. Press Enter, then Alt+click cell E2. Note that “ware-
house check” appears in the Search box, but below that, under the thesaurus name, it 
reads No Results Were Found. Below that there’s a Can’t Find It? section with an Other 
Places To Search subcategory.

8. Click the link All Reference Books again. You’ll notice that it shows other resources in 
addition to the thesaurus. However, what we are trying to find is a synonym for the word 
check, so we need a thesaurus. Click the Back button.

9. Click in the Search box and delete the word warehouse, leaving only the word check, and 
click the green arrow to the right of it.

10. In the English thesaurus, this finds the word inspection. Click the dropdown to the right 
of the word and choose Insert. The Insert command automatically replaces all of the text 
in the cell with the new word. This is not what we want, so click the Undo button.

E X E R C I S E  4 . 9 ( c o n t i n u e d )
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Synonyms come in handy when you find you are using the same word over and over and 
would like an alternative. Sometimes, you aren’t sure you are using the word correctly, so 
instead of a synonym, you want a definition. Exercise 4.10 shows you how to use the Research 
task pane’s dictionary.

Another way to use the Research task pane to help you better understand your data is to 
take advantage of the Internet encyclopedias, as demonstrated in Exercise 4.11.

11. Click the dropdown beside inspection again but, this time, choose Copy. Click in the For-
mula bar and double-click the word check to select it. Then, use the Paste command to 
paste the copied text, inspection.

12. Save the file in your Chapter Four folder and name it Exercise 4-9.xls. Leave the file open 
for the next exercise.

E X E R C I S E  4 . 1 0

Finding Definitions

1. Still inside the file you saved in the previous exercise, in cell E2 type security surveillance 
and press Enter.

2. Hold down your Alt key and click cell E2 to bring up the Research task pane with “security 
surveillance” in the Search box.

3. Click the plus sign beside the dictionary of your language choice to expand it. Note that 
it is giving you definitions of the word security, but what you want is surveillance. Double-
click the word security in the Search box and press the Delete key to remove it; then click 
the green arrow to the right.

4. If necessary, expand the dictionary again. Review the definition(s) of the word.

5. Save the file to update it, but do not close it.

E X E R C I S E  4 . 1 1  

Learning More

1. Still inside the file you saved in the previous exercise, in cell E3 type contact Microsoft 
and press Enter.

2. Alt+click cell E.

E X E R C I S E  4 . 9 ( c o n t i n u e d )
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One last use of the Research feature is the translation utility, explained in this next exercise, 
Exercise 4.12.

Converting Text to Columns

One final editing tool in Excel that helps to make data more searchable and filterable is the 
Text To Columns wizard, explained in Exercise 4.13. If you open the file Exercise 4-5.xls and 
compare the data in the two sheets, you’ll see that the locations are not formatted consistently. 

3. In the box below the Search box, choose Encarta Encyclopedia from the choices under All 
Research Sites.

4. Make sure you are connected to the Internet; then scroll through the list of articles dis-
played in the Research task pane until you see “Bill Gates, cofounder of Microsoft” and 
click the Article – Encarta Encyclopedia link.

Internet Explorer will open and take you to the web page that displays this article so you 
can learn all about Bill Gates. Notice the Research task pane is now displayed on the left, 
inside Internet Explorer, so you can continue to choose other articles. Also notice that not 
all Encarta articles are available for free; some require that you subscribe.

5. Close Internet Explorer. Save the workbook to update it. Leave the file open for the next 
exercise.

E X E R C I S E  4 . 1 2

Translating Text

1. Still inside the file you saved in the previous exercise, in cell E5, type review article "Mi 

casa es su casa" and press Enter.

2. Alt+click Cell E5. When the Research task pane shows the text has been entered into the 
Search box, choose All Reference Books from the dropdown below that.

3. Collapse the list of references, if necessary, then click the plus sign beside Translation.

4. Remove the words review article from the Search box and click the green arrow to the right.

5. Choose Spanish in the From box and your language in the To box. In this example, 
choosing English as the To language shows “my house is its house” under the Word 
Lingo heading. Sometimes translations are not perfect.

6. Save the file to update it and close the file.

E X E R C I S E  4 . 1 1 ( c o n t i n u e d )
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On the Current sheet, the location shows only the state; however, on the Possibles sheet, the 
location shows both the city and state, and the states are abbreviated in different ways, with 
no consistency. This will make it difficult to use AutoFilters on this data or to find just the 
entries for a particular state. You can use the Text To Columns wizard to easily clean this 
up. As you go through this wizard, the data is previewed at the bottom so you can change 
your choices until you get the desired result (see Figure 4.1). In Exercise 4.13, let’s give this 
a try.

F I G U R E 4 . 1 The Text To Columns wizard lets you preview how your choices affect 
the data.

E X E R C I S E  4 . 1 3  

Dividing Text Across Columns

1. Open the file Exercise 4-5.xls (either the one you saved previously, or the one extracted 
from the zipped file for this chapter).

2. On the Possibles sheet, select any cell in column D and insert a new column to the left of it.

3. Select the range C3:C10 and select Data � Text To Columns.

4. When the Convert Text To Columns wizard appears, make sure the top choice, Delimited, 
is selected and click the Next button.

In Step 2 of the wizard, you see that Tab is selected as the delimiter (the character that will 
be used to designate when the data will be split into a new column) and the preview below 
shows the data is still in one column because Excel cannot find any tabs within the data.
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Comments and Hyperlinks
Up to this point in this chapter, I’ve discussed all of the ways to help keep data accurate and 
consistent. Now, in this section, I’ll discuss how to use comments and hyperlinks to clarify 
data and give access to additional supporting information. Comments allow you to add your 
own instructional or explanatory information, while hyperlinks provide shortcuts to informa-
tion from other sources. Both are excellent ways to help people better understand the data 
included in your workbook, as well as to supply yourself with important reminders or sup-
plementary information. First, we’ll explore comments.

5. Click the checkmark beside Tab to remove it; then click in the box beside Comma to add 
a checkmark there. Note, as in Figure 4.1, the preview shows that Excel sees commas in 
the data and is putting the data into a new column every time it sees a comma.

6. The third step of the wizard lets you click the column headers at the top of both columns, 
then change the data format. In this case, they are both formatted as General, which is 
fine, so just click Finish.

Now that the states are in a separate column, let’s remove the cities.

7. Select the range D3:D10 and cut it.

8. Right-click cell C3 and choose Insert Cut Cells.

9. Click any cell in column D and select Edit � Delete � Entire Column. Click OK.

10. Next, either use Find And Replace to correct all of the states that are not the correct two-
letter abbreviation, or sort the Location column so the states are in order and then man-
ually correct them.

Notice that the states that were converted from text to columns have spaces in front of 
them. That’s because there was a space after the comma that you used as your delimiter. 
You need to remove those spaces.

11. Select the range C3:C10 and open the Find And Replace dialog box. Note that the Arial 
and Times New Roman font formats are still selected. Click the dropdown arrows on the 
right of both Format buttons and choose Clear Find Format.

12. Click in the Find What box and press your spacebar one time. Leave the Replace With box 
empty. This tells Excel that you want to find all spaces and replace them with nothing. 
Click Replace All. Click OK when Excel tells you it has made all the replacements.

13. Save the file in your Chapter Four folder and name it Exercise 4-13.xls. Close the file.

E X E R C I S E  4 . 1 3 ( c o n t i n u e d )
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Working with Comments

Comments are like sticky notes that you can attach to any cell to add instructional or clarifying 
information when sharing workbooks with others; they can also be used to insert reminders 
for yourself in cells that might need future updating. Basically, a comment can be added any-
where for any reason; it’s totally up to you. They can even replace some of those sticky notes 
you might have all over your monitor.

Excel identifies a comment author by using the user name specified in the 
Options dialog box. Before completing the exercises in this section, select 
Tools � Options. Click the General tab and enter your name in the User Name 
box, if it is not there already. While you’re in there, click the View tab and be 
sure comments are set to show Comment Indicator Only.

Exercise 4.14 shows you how to insert comments.

Once you’ve added comments to a cell, you can edit them when you want to change them 
or add formatting to them. Or you can remove the comments when you no longer need them. 
Exercise 4.15 shows you how to do both.

E X E R C I S E  4 . 1 4

Inserting Comments

1. Open the file Exercise 4-14.xls. This is a simple supply-request form.

2. Right-click cell B4 and choose Insert Comment. When the comment appears, it shows 
your user name:

3. Type Pencils must be ordered in packs. A pack includes 20 pencils. Click outside of the 
comment to close it. See the red triangle in the upper-right corner of cell B4? This indi-
cates the cell has a comment attached to it.

4. Run your mouse pointer over cell B4 and the comment appears. Whenever someone 
tries to type in this cell, they will see this comment.

5. Select cell A14, then select Insert � Comment. Type Enter items here that do not appear 

in the list.

6. Save the file in your Chapter Four folder and name it Exercise 4-15.xls. Do not close the file.
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Since you saw in Exercise 4.15 that comments do not print by default, Exercise 4.16 teaches 
you different ways to print your comments.

E X E R C I S E  4 . 1 5

Editing and Deleting Comments

1. Still inside the file you saved in the previous exercise, right-click cell B4 and choose Edit 
Comment.

2. Drag your mouse pointer to select all of the text except your user name. With the text 
selected, use the Formatting toolbar to change the font to Red, Bold, 10 pt. Use the resiz-
ing handles on the comment box to make the box larger, if necessary.

3. Click outside of the comment; then rest your mouse pointer over the cell to see it again.

4. Select cell A14. Choose Insert � Edit Comment. Change the text to read Only enter items 

here that do not appear in the list.

5. Click outside the comment to close it; then right-click cell A14 and choose Show/Hide 
Comment. Click another cell and note that the comment remains onscreen.

6. Click the Print Preview button. Note that, by default, comments don’t print, even when 
they are set to show onscreen. Close Print Preview.

7. Right-click cell B4 and choose Delete Comment. The comment is removed. Click the 
Undo button to bring it back.

8. Save the file to update it, but do not close the file.

E X E R C I S E  4 . 1 6  

Printing Comments

1. Still inside the file you saved in the previous exercise, select File � Page Setup. Click the 
Sheet tab.

2. In the Print section, where it says Comments, choose As Displayed On Sheet from the 
dropdown choices. Click the Print Preview button.

Remember that Print Preview shows you exactly how the page will print. In this case, because 
we are displaying one comment and hiding the other, only the one displayed will print.

3. Close Print Preview. Return to File � Page Setup and change the comment choice to At 
End Of Sheet. Click the Print Preview button.

Note that now you have two pages. The first page shows your data, and the second page 
lists all comments on the sheet, whether they are displayed or hidden, and identifies 
which cells contain the comments.
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Hyperlinks in Excel

Since this chapter is all about clarity and accuracy, what better way to add supporting documen-
tation and additional information to your file than to show other files and even websites that ver-
ify or add to your data? Hyperlinks are simply shortcuts to other locations. They can open other 
files or websites when clicked. They can also jump to other worksheets within this workbook or 
open an email addressed to someone specific. You can see these choices in Figure 4.2.

F I G U R E 4 . 2 The Insert Hyperlink dialog box lets you link to a file, a web page, another 
location in this workbook, or an email address.

Exercise 4.17 teaches you how to create hyperlinks that perform all of these actions.

Select Tools � AutoCorrect Options. Click the AutoFormat As You Type tab and 
be sure the option Internet And Network Paths With Hyperlinks is selected. 
Click OK.

4. Click the Print button and, in the Print Range section, choose to print Pages, From 2 
to 2. Click OK. This prints just the comments.

5. Close the file and save the changes.

E X E R C I S E  4 . 1 7  

Creating Hyperlinks

1. Open Exercise 4-16.xls and select cell B2 on the Vendors sheet.

2. Click the Insert Hyperlink button on the Standard toolbar (use the tooltip to find it). Alter-
natively, you can choose Hyperlink from the Insert menu or right-click the cell and choose 
Hyperlink.

E X E R C I S E  4 . 1 6 ( c o n t i n u e d )
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3. As shown in Figure 4.2, choose Existing File Or Web Page on the left, then in the top Text 
To Display box, type Wiley Publishing. In the bottom Address box, type http://wiley.com 
and click OK.

4. Note that the text “Wiley Publishing” is blue and underlined and if you rest your mouse 
pointer on it, the pointer changes to a hand. If you are connected to the Internet, clicking 
this link will take you to the Wiley website.

5. Select cell C2, type johndoe@wiley.com, and press Enter. Excel automatically creates the 
link because it recognizes this as a properly formatted email address. If you have an email 
client installed, click the email link and a new email will open, addressed to john-
doe@wiley.com. Close the email message.

6. Move to cell B3, type http://microsoft.com, and press Enter. Again, Excel recognizes the 
format and converts it to a link.

7. Move to cell C3 and click the Insert Hyperlink button on the Standard toolbar. On the lower 
left, click the E-mail Address button; then type Mary Smith in the Text To Display box at 
the top and type msmith@prescottswriters.com in the email box below that. Notice 
that the text mailto: is inserted in front of the email address you typed. This is the HTML 
tag needed to tell Excel to open an email message addressed to this person. Click OK.

8. Select cell B9 and type view recent requests. Click the Insert Hyperlink button. Because 
you typed the text in the cell before you opened this box, that text already appears in the 
Text To Display box. Choose Place In This Document on the left. This displays a list of the 
sheet names in this workbook. Click Requests and click OK.

9. Click the new link and note that you are moved to the Requests sheet in this workbook.

10. Move back to the Vendors sheet and, in cell B10, type view supervisors on duty. Press 
Enter. Select B10 again and select Insert � Hyperlink. This time, choose Existing File Or 
Web Page on the left and find the file named Exercise 4-9.xls in the box in the center. 
Select it and click OK.

11. Click the new link and that file opens.

12. Close Exercise 4-9.xls and return to the current file. Cell B10 should still be selected. If not, 
use the arrow keys on your keyboard to select it again. (You can’t click it to select it, 
because that will launch the hyperlink. If you want to select the cell with your mouse 
pointer, click and hold until the hand changes to a white plus sign.) Open the Insert 
Hyperlink dialog box again and click the Remove Link button. This removes the hyperlink. 
(Alternatively, you can right-click any hyperlink and choose Edit Hyperlink or Remove 
Hyperlink.)

13. Save the file into your Chapter Four folder and name it Exercise 4-16A.xls. Close the file.

E X E R C I S E  4 . 1 7 ( c o n t i n u e d )
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Summary
Understanding how to use editing tools will ensure that your data is both accurate and con-
sistent. Comments and hyperlinks will enable you to clarify instructions and include support-
ing information.

The Spelling tool lets you check any words that are not included in the Office dictionary. 
You can decide whether you want to ignore them, correct their spelling, add them to your cus-
tom dictionary, or create autocorrections.

AutoCorrect automatically replaces typed data with matched data. There are many autocor-
rections included in the program, and you can remove any entries you don’t want or add new ones.

To make single or global replacements of text, use the Find And Replace utility. You can 
replace found items one at a time or all at once. Using the Replace utility assures that you are 
replacing the items consistently.

When you have a progressive list of data, such as numbers in a sequence or frequently used 
text progressions (like days of the week or even your own department names), you can use 
AutoFill. Excel lets you fill based on a pattern you demonstrate, or you can manually specify 
a series and its step and stop values. You can also make your own custom lists for text series 
that you use often.

AutoComplete and Pick From Drop-Down List are two features in Excel that let you dupli-
cate data either above or below the active cell. You can also split data in one column into two 
or more columns, using the Text To Columns wizard.

When you need translations, definitions, synonyms, or supporting information, the Research 
task pane gives you access to a thesaurus, dictionary, and Internet encyclopedia.

You can clarify data by adding additional instructional advice in comments or by providing 
hyperlinks to other files, other locations in the active workbook, and Internet websites. You 
can also provide links that launch emails addressed to specific people.

Exam Essentials
Understand how to use all of the editing tools. Know when, how, and why to use the Spell-
ing tool, AutoCorrect, Find And Replace, AutoFill, custom lists, Pick From Drop-Down List, 
the Research task pane, and the Text To Columns wizard.

Be able to add and remove autocorrections. Understand all of the checkboxes in the Auto-
Correct Options dialog box. Also, be able to create new AutoCorrect entries and remove or 
modify existing ones.

Know the difference between definitions, synonyms, translations, and supporting information.
Understand which reference work to use for which task.

Know every aspect of working with comments. Be able to add, edit, and remove comments. 
Also know how to print comments in different ways and show/hide comments onscreen.

Recognize the different types of hyperlinks and be able to use them all. Know how to cre-
ate hyperlinks using the Insert Hyperlink dialog box, as well as by simply typing hyperlinks 
into a cell. Be able to remove a hyperlink from a selected cell.
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Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the file MOS Scenarios Ch4.xls from the 
zipped file for this chapter and open it before you begin.

 

MOS Scenario 10: Correct and Organize Data, Make Data Consistent, and 
Assure Data Accuracy

Add the following customers to this list, exactly as shown here; then use Excel’s editing tools 
to correct errors in the entire worksheet and make the new data consistent with the previous 
data. Assign consecutive customer numbers; then separate the customer names into three 
columns labeled Last Name, First Name, and Middle Initial. Sort the data by these three col-
umns. When you finish, all data must be consistent.

Name Date of First Purchase State

Williams, Martha 3/9/04 Delaware

Jones, Henry F. 11/24/04 New York

Andrews, Helen 01/08/2005 New Jersey

 

MOS Scenario 11: Add Supportive Documentation to a File

Add the information below to the worksheet. Create and add email addresses for the top three 
customers and add a comment in the correct cell in the Interests column, which provides 
information about cooking. Add another column labeled Websites and provide a cooking 
website name with an embedded hyperlink.

G H

2 E-Mail Interests

3 cooking

4 sewing

5 reading
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MOS SPECIALIST OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Insert and modify formulas

�

 

Use statistical, date and time, financial, and logical functions
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Excel helps you perform any calculations you need, from simple 
mathematics to intricate logical formulas. Though all of the 
other features are helpful, it is Excel’s formula-building abilities 

that make it unique. When you take the MOS Exam, the scenarios are randomly assigned, but 
generally you will have a fair number of formula exercises to complete. To truly know Excel 
and use it to its fullest, you must understand how to use functions to construct formulas. This 
chapter and Chapter 6, “Advanced Functions, Table Arrays, and Database Features,” are 
probably the two most important chapters in this book. The bottom line is if you don’t know 
how to use formulas, you don’t know how to use Excel.

To complete the exercises in this chapter, you need to download the file exl2003ch05.zip 
from the website for this book and extract the files to a temporary folder before you begin.

Since formulas range from simple addition to complex nested functions, it’s best to start 
with the horse before we add the cart. This first section eases you into formulas by starting with 
basic arithmetic and how you handle it in Excel.

 

Creating Basic Arithmetic Formulas

 

Though Excel can handle advanced, complicated formulas that include multiple functions, it’s 
best to learn how to do simple arithmetic first. Once you grasp the fundamental syntax and 
structure used in formula construction, the rest will fall into place more easily for you.

 

Formulas vs. Functions

 

I know you wouldn’t be taking the MOS Exam if you didn’t already understand the difference 
between formulas and functions. Here’s a quick reminder anyway.

Any cell that includes a calculation uses a 

 

formula

 

. Formulas can range from simple addition, 
=A1+A2, which adds the content of two or more cells or values, to intricate combinations of 
functions. A 

 

function

 

 is a named calculation that performs specific actions. A formula that 
includes multiple functions might look like this:

=(SUM(A1:A5))+(AVERAGE(B1:B20))

This formula tells Excel to add the sum of A1 through A5 to the average of what’s in B1 
through B20. The entire calculation is a formula; SUM and AVERAGE are the function names.
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Excel formulas include operators and arguments. 

 

Operators

 

 are simply characters you type 
in a formula to tell Excel what calculation you want it to perform. 

 

Arguments 

 

are the com-
ponents within parentheses that are required for each Excel function. I explain arguments and 
functions more fully in later sections of this chapter, but let’s begin with operators, since they 
are all you need when creating simple formulas that do not use functions. After that, you’ll 
learn about SUM functions.

 

Simple Arithmetic Using Operators

 

The four arithmetic calculations (add, subtract, multiply, and divide) are applied in a formula, 
using operators (see Table 5.1). You simply type the numbers or 

 

cell references

 

 (the term used 
to identify cell addresses inside a formula) that you want calculated, following an equal sign (=) 
and separated by operators. Examples are 

 

=4+2

 

 (which adds these two numbers), or 

 

=A1-B1

 

 
(which subtracts the value in B1 from the value in A1), or 

 

=A1*10

 

 (which multiples the value 
in A1 by 10). Formulas in Excel can refer to actual numbers and to cell addresses. When you 
use an actual number in a cell, the number remains static; however, when you use a cell ref-
erence, it is dynamic, meaning the result of the formula will update if the data in the referred 
cell changes.

It’s easy to remember the universal 

 

order of precedence

 

 used in calculating formulas, which, 
of course, Excel uses too. All you have to remember is the mnemonic “

 

P

 

lease 

 

E

 

xcuse 

 

M

 

y 

 

D

 

ear 

 

A

 

unt 

 

S

 

ally”:
�

 

P = Parentheses
�

 

E = Exponentiation
�

 

M= Multiplication
�

 

D = Division
�

 

A = Addition
�

 

S = Subtraction

 

T A B L E 5 . 1

 

Arithmetic Operators for Excel

 

Operator Calculation Performed

 

* Multiplication

/ Division

+ Addition

- Subtraction
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This is the order in which a formula is calculated. First, calculations within parentheses are 
done, then exponentiations, then multiplications, then divisions, then additions, and then sub-
tractions. And, if there is more than one of any type, they are calculated from left to right. 
Parentheses allow you to group calculations together so they will be applied before other cal-
culations that might have a higher order of precedence. All formulas 

 

must

 

 begin with an equal 
sign. When using functions, the function name follows the equal sign, and then the function’s 
arguments are entered within parentheses immediately after the function name.

For example, =A1+B1/C1 would divide B1 by C1 and then add A1 to that amount, because 
division is done before addition. However, enclosing A1+B1 in parentheses would tell Excel 
to add these together first, then divide that total by the value in C1, and this formula would 
be =(A1+B1)/C1. If all three cells contained the number 10, the first formula would return a 
result of 11 because 10 divided by 10 equals 1, and 1 plus 10 equals 11. The second formula 
would return a result of 2 because 10 plus 10 equals 20, divided by 10 equals 2.

 

Though you may be familiar with the four basic arithmetic terms, the word 

 

exponentiation

 

 may be new to you. This is the term used to describe a calcu-
lation that raises a number to a specific power. For example, 4^2 is the same 

 

as 4

 

2

 

, or 4 to the second power (which would be 4

 

×

 

4, or 16).

 

You can manually type cell references into a formula, or you can simply click on any cell 
when you want that cell reference included in your formula. Exercise 5.1 shows you how to 
do some simple arithmetic in Excel by using either method.

 

E X E R C I S E  5 . 1  

 

Add, Subtract, Multiply, and Divide

 

1.

 

Open the file Exercise 5.1.xls that you extracted from the zipped file for this chapter.

 

2.

 

Select cell B9 and type 

 

=A2+A3+A4+A5+A6

 

. The cells included in your formula are color-
coded to match the color of the cell reference in the formula (as shown in this graphic). 
Press Enter, and Excel enters the result of the formula (75) in the cell.
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3.

 

Select cell C9 and follow these steps:

Type 

 

=

 

.

Click cell A2.

Type 

 

+

 

.

Click cell A3.

Type 

 

+

 

.

Click cell A4.

Type 

 

+

 

.

Click cell A5.

Type 

 

+

 

.

Click cell A6.

Press Enter.

You get the same result as you did when you manually typed in the cell references.

 

4.

 

In cell B10, type 

 

=a4-a3

 

 and press Enter.

Note that you don’t have to capitalize the column identifiers in a cell reference within a 
formula; Excel will recognize them as cell addresses and uppercase them for you.

 

5.

 

The result of this subtraction formula shows as 5. Select cell B10 again and look at the 
Formula bar. Even though what you see in the cell is 5, what Excel sees is the actual for-
mula, as shown in the Formula bar.

 

6.

 

Select cell C10, type 

 

=15-10

 

, and press Enter. Note that the result is the same as in cell B10. 
Change the value in cell A4 to 

 

20

 

 and press Enter. Notice the result of the formulas in 
cells B9, C9, and B10 all changed because they all reference the cell you changed. Click 
the Undo button to revert cell A4 back to 15.

 

7.

 

In cell B11, type 

 

=

 

, then click cell A2. Type 

 

*20

 

 and press Enter. The result is 100.

 

8.

 

In cell B12, type 

 

=a6/a1 

 

and press Enter. You get an error in the cell that says #VALUE!. 
This is because cell A1 does not have a number in it, so Excel cannot perform the calcu-
lation. Select cell B12 again; then, in the Formula bar, change A1 to A

 

2

 

 and press Enter. 
The error disappears and the result is 5.

 

9.

 

From the Save As dialog box, create your Chapter Five folder and save this file in it. Name 
the file 

 

Exercise 5-2.xls

 

. Leave the file open for the next exercise.

 

E X E R C I S E  5 . 1

 

( c o n t i n u e d )
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Simple Addition Using the SUM Function

 

Functions are used for formulas that require multiple operations, but they are also handy 
when you are calculating a range of numbers. Of the four basic arithmetic calculations, only 
one (addition) has a function name, which is SUM. Subtraction, multiplication, and division 
are performed only on pairs of numbers, so they do not require anything more than a simple 
operator. However, because addition is often performed on long lists of numbers, it would be 
silly to use the plus sign and add each cell individually. Imagine if you wanted to get a total 
of a column of numbers that included 500 cells!

You can use the SUM function to add all the numbers in a single range and, when you want 
to add single cells, noncontiguous cells, and even multiple ranges all together in one formula, 
you separate the arguments with commas. When you enter a formula by clicking the cells to 
add them, you don’t have to type the final parenthesis; Excel will add it for you. But you 

 

must

 

 
type the opening parenthesis before you click cells or ranges to add them.

You can manually type the SUM formula in a cell or, when you want to sum a contiguous 
range of numbers, either immediately above or immediately to the left of your formula cell, use 
the 

 

AutoSum

 

 (

 

∑

 

) button on the Standard toolbar (see Figure 5.1). Also, notice the small drop-
down arrow to the right of the AutoSum button. Clicking this gives you other options, such 
as producing autocounts, averages, minimums, and maximums. These statistical functions are 
covered in a later section.

 

F I G U R E 5 . 1

 

Clicking the AutoSum button calculates the range immediately above or to 

 

the left of the cell.

 

Exercise 5.2 shows you how to use the SUM function and AutoSum button to total ranges 
and multiple arguments.

 

Function names are automatically capitalized by Excel. When you type 

 

sum

 

, 

 

Excel will convert it to SUM.
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Remember “Please Excuse My Dear Aunt Sally”? Use Exercise 5.3 to see how this order of 
precedence affects your formulas.

 

E X E R C I S E  5 . 2

 

Using SUM and AutoSum

 

1.

 

Still inside the file you saved in Exercise 5.1, in cell D9, type 

 

=sum(a2:a9)

 

 and press Enter. 
The result is 75.

 

2.

 

In cell E9, type 

 

=sum(a2,a4,

 

 (be sure to include the final comma), then click cell A6 and 
press Enter. The complete formula should look like =SUM(A2,A4,A6) and the result is 45. 
Select the cell again and view the formula in the Formula bar. Notice the final parenthesis 
was added.

 

3.

 

Try adding this formula to cell F9, following these steps:

Type 

 

=sum( 

 

(be sure to include the opening parenthesis).

Drag to select the range A2:A6.

Type 

 

,

 

.

Type 

 

b9,

 

.

Click cell C9.

Press Enter.

 

4.

 

Select cell F9 again and view the Formula bar. The formula should be =SUM(A2:A6,B9,C9) 
and the result is 225.

 

5.

 

Select cell A7 and click the AutoSum button. Note that the marquee selects the range 
immediately above cell A7. Press Enter. Select A7 again and view the SUM formula in the 
Formula bar.

 

6.

 

Type the number 

 

5

 

 in cells B14, C14, and D14. Then, select cell E14 and click the AutoSum but-
ton. As you can see, the marquee selects the cells to the left. Press Enter and the result is 15.

 

7.

 

Save the file in your Chapter Five folder and name it 

 

Exercise 5-3.xls

 

. Do not close the file.

 

E X E R C I S E  5 . 3  

 

How Parentheses Affect Formula Results

 

1.

 

Still inside the workbook you saved in the previous exercise, in cell A16, type 

 

=a2+a3*a4

 

 
and press Enter.

The result is 155 because Excel did the multiplication first. It multiplied 10 times 15 and got 
150; then it added 5 and got 155. But if what you wanted was 5 plus 10 and then that sum 
multiplied by 15, you need to use parentheses to let Excel know to add before multiplying.
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Working with Statistical Functions

 

As the name implies, 

 

statistical functions

 

 produce statistics: counts, highs, lows, means (aver-
ages), and so forth. When you want to produce reports that compare data, you’ll use statistical 
functions.

We know, from high school math, that calculating an average requires adding all of the 
items together, then dividing the sum by the number of items. So, you could simply enter a 
formula like

=(A1+B1+C1)/3

But what if you wanted to get the average of a list of 500 numbers? You can’t do it cell by 
cell as in the previous example if your number of cell references exceeds 30, because Excel lim-
its you to 30 arguments within a formula (not to mention that listing all the cell references 
would give you a formula two feet long). Fortunately, Excel has a statistical function named 
AVERAGE that does it for you easily. Similarly, Excel has other statistical functions, such as 
MAX (which returns the highest number in a range), MIN (which returns the lowest number 
in a range), COUNT (which counts all cells that contain numbers in a range), COUNTA 
(which counts cells that have anything in them), and COUNTIF (which counts cells that meet 
certain conditions).

You can enter functions directly into cells, or use the Insert Function dialog box when you 
aren’t sure of the arguments required. Simple functions that have only one argument are easy 
to enter manually, so let’s try that first.

 

Entering Statistical Functions Directly into Cells

 

Many of the commonly used statistical functions are entered exactly the same way as the 
SUM function and can be done using the same methods you learned in the previous section. 
These functions are constructed exactly like the SUM function: with an equal sign, then the 
function name, then the range in parentheses. Exercise 5.4 shows you how to do this using the 
range of statistical functions available in Excel.

 

2.

 

Select cell A16 again, click into the Formula bar, and add an opening parenthesis before 
A2 and a closing parenthesis after A3. The formula looks like this: =(A2+A3)*A4. Press 
Enter.

The new result is 225 because 5 plus 10 equals 15, and 15 times 15 equals 225.

 

3.

 

Save the file to update it, and then close the file.

E X E R C I S E  5 . 3 ( c o n t i n u e d )
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E X E R C I S E  5 . 4  

The AVERAGE, MAX, MIN, COUNT, and COUNTA Functions

1. Open the file Exercise 5-4.xls and notice the sales totals for various stores, with labels set 
up at the bottom for obtaining some statistics. We will enter formulas in the cells to the 
right of these labels.

2. The first one, B11, simply requires a total of the amounts in cells B2:B9. Select cell B11 
and click the AutoSum button. Below the selected range, you’ll see a preview of the for-
mula in your cell, and as you can see, it includes cell B10, which is empty. Click into that for-
mula and change the 10 to a 9 (see Figure 5.1). Now press Enter. The result is $354,239.14.

In cell B12, you need a formula that will give the average sales from all stores. To do this, 
follow these next steps.

3. Select cell B12, and enter the formula =average(b2:b9), and press Enter. The result is 
$44,279.89.

4. Cell B13 requires the MAX function, which shows the largest number in the range. Type 
=max( (be sure to include the opening parenthesis), then drag to highlight the range B2:B9 
and press Enter. The result is $71,686.50.

5. In B14, use the same procedure, but this time the function name is MIN, which gives the 
smallest number in the range. The result of this formula is $18,005.50.

6. The last formula you need is a bit different. Cell B15 requires a formula that will count 
how many stores there are. In cell B15, type =count(a2:a9) to count the store names and 
press Enter.

Notice that the result you get is zero, and it’s formatted as currency (obviously the same for-
mat as the cells above it). The reason you got zero is that the COUNT function counts all cells 
that contain numbers. Since there are no numbers in the range A2:A9, the result is zero.

7. Select Cell B15 and highlight A2:A9 in the Formula bar. Highlight only the range and not 
the parentheses. Then, drag your mouse to select the range B2:B9 on the worksheet and 
press Enter. Now you get the correct result, which is 8. Select the cell again, and choose 
Format � Cells, and click the Number tab. Change the format from Currency to Number, 
with zero decimal places. Click OK.

What if you need to count cells that have anything in them, not just numbers? The COUNTA 
function does this; it counts all cells in a range that have any value or label in them.

8. In cell C15, enter this formula: =counta(a2:a9). Once you press Enter, you’ll see that 
COUNTA counts the store names just fine.

9. Change the value in cell B6 to 0 (zero) and press Enter. Notice the result of the formula 
in B15 does not change, because Excel recognizes 0 as a number.
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The five functions mentioned in the previous exercise can also be performed 
on noncontiguous cells and ranges, just like the SUM function, by simply 
using commas to separate the arguments.

Using the Insert Function Utility

Once you know the required components of any function, you can always type the formula 
directly into the cell. But, often when you use a function for the first time, you aren’t sure how 
to construct the formula, or you’re not even sure what functions you have available to you. 
This is where the Insert Function utility comes in handy.

As you see in Figure 5.2, using the Insert Function dialog box, you can search for a function 
or select a category. In the selection dropdown list, the functions are grouped by categories, 
but there’s also a Most Recently Used choice, which displays that last few functions you have 
used, and All, which shows every function included in Excel.

F I G U R E 5 . 2 The Insert Function dialog box lets you choose from many different 
functions.

10. Select cell B6 and press your Delete key. You’ll see that a blank cell is not counted by the 
COUNT function, like a zero is. Click the Undo button twice to restore the original value 
to cell B6.

11. Save the file into your Chapter Five folder and name it Exercise 5-5.xls. Close the file.

E X E R C I S E  5 . 4 ( c o n t i n u e d )
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You can add even more statistical functions to Excel. Go to the Tools menu 
and choose Add-Ins. In the list of add-ins that appears, select Analysis Tool-
pak and click OK. This adds more-advanced statistical analysis functions—
which are out of the scope of this chapter and are not required for MOS 
certification, but they are worth mentioning for any statistical whizzes who 
want more.

Exercise 5.5 shows you how to use the Insert Function utility when learning a new function, 
COUNTIF, which counts cells with values that meet certain criteria.

E X E R C I S E  5 . 5  

The COUNTIF Function

1. Open Exercise 5-5.xls, which you saved in the previous exercise. If you did not save it, 
extract it from the zipped file for this chapter.

2. In cell A16, type Stores Over 50K and then press the → key to move to cell B16.

In this cell, you need a formula that gives you a count of the stores that have sales greater 
than $50,000.

3. With cell B16 selected, click on the Insert Function (fx) button on the Formula bar, to the 
right of the Name box (or you can choose Insert � Function).

4. Choose Statistical from the category dropdown. Then scroll through the list of statistical 
functions at the bottom and select COUNTIF. Note that below it shows you the arguments 
required within the parentheses (range, criteria). Click OK.

5. When the Function Arguments box appears, click and drag its title bar to move it so it is 
not obstructing your view of the data. Here you have boxes to enter both of the argu-
ments mentioned in the previous step (range and criteria).

6. Click into the first box, Range, and read the description that appears below it when your 
mouse pointer is positioned inside the box. With your cursor flashing in that box, drag 
your mouse to select the range B2:B9 on the worksheet. The Function Arguments box will 
minimize while you drag, but when you release your mouse button, it will reappear and 
Excel will enter B2:B9 in that box.

7. Press your Tab key to move to the Criteria box. Read the description below the box.

8. In this box, type >50000. (> is the “greater than” symbol.)
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Spend some time looking at all of the statistical functions in the Insert Function dialog 
box. Once you understand how to use this dialog box, you should be able to construct more-
advanced statistical functions. When you are comfortable with most of them, move on to the 
next section and learn about the Date and Time functions.

Working with Date and Time Functions
The Date and Time functions allow you to calculate numbers of hours, days, weeks, months, 
and years between one date/time and another. Excel does this very well, but only when you 
understand how the program handles dates and times.

The Format Cells dialog box controls whether Excel recognizes dates and times as dates 
and times, so this next section shows you how to use this dialog box to ensure you have them 
properly configured. But there is one pitfall you need to be aware of regarding date and time 
formatting.

The date and time formatting in Excel is based on the choices you make in the Format Cells 
dialog box, but also on your Regional and Language Options Settings in your Windows 
Control Panel. If you live in a country where the date format generally used is day/month/year 

It should look like this:

Notice the formula is being built and you can see it in both the cell and the Formula bar.

9. Click OK. The result is 3, because there are three numbers greater than 50,000 in the 
range B2:B9.

10. Format the cell as a number with no decimal places.

11. Save the file in your Chapter Five folder and name it Exercise 5-5A.xls. Close the file.

E X E R C I S E  5 . 5 ( c o n t i n u e d )
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and your dates in Excel are displaying as month/day/year, you’ll need to adjust the settings in 
your Windows Control Panel. The calendar/clock feature is not determined by Excel, but 
instead by Microsoft Windows. You must be sure Windows is correctly recognizing your 
country in the Regional and Language Settings in your Control Panel.

Now, let’s move on to learning about the Format Cells dialog box.

Date and Time Formats in Formulas

Excel has a little quirk when it comes to expressions of time. Excel can see time as time periods 
or times of the day. A time period refers to the numbers of years, months, weeks, days, hours, 
minutes, and seconds, whereas a time of day refers to 6:00PM or 8:30AM. The expression 4:30, 
when it’s not used in a formula, only specifies a time of the day. However, as soon as you 
express a time of day in a formula, Excel assigns it a unique serial number, which means the 
expression 4:30AM is seen as 4 hours and 30 minutes. 4:30PM would be calculated as 16 hours 
and 30 minutes.

Many people have trouble getting Excel to calculate date and time formulas correctly. 
That’s usually not because the formula is incorrect, but because the cells are not properly for-
matted. To increase the confusion, most of the time when you subtract one time from another, 
Excel defaults to displaying the result in a time-of-day format, so 9:00 minus 3:00 might result 
in 6:00. 6:00 would be the correct result if you wanted the time of day when you subtract 3 
hours from 9:00AM, but it would not be what you want if you were looking for the number 
of hours between 3:00AM and 9:00AM. For this calculation, you’d merely want the number 6, 
not 6:00. To display the number of hours between 3:00 and 9:00, you have to format the result 
as a number instead of as an expression of time.

Also, sometimes Excel displays formula results in percentages of a year or day, instead of 
actual numbers of days or hours. In this case, you would need to use multiplication or division 
operators to refine the result of the formula. For example, subtracting 6:00 from 12:00 might 
give you a result of 0.25, because 6 hours is 25 percent of a day. However, what you want is 
the number of hours and not the portion of the day. To get the result you want, you need to 
multiply the result of that formula by 24 hours in a day. It all comes down to understanding 
how Excel sees dates and times, and knowing which format to apply to which cell.

When you work with dates and times and use formulas that refer to those dates and times, 
Excel often assumes the wrong date/time format if you haven’t assigned a format prior to 
entering the data. If you ever see this, just remember to correct the cell formatting. However, 
you can avoid lots of headaches if you assign the formatting before you enter the data.

Here are some tips for ensuring that your dates and times display and calculate correctly:
� Format all cells that include dates or times of day with the date/time format of your choice.
� Format all cells that include formulas to calculate time periods (the difference between 

two times) as numbers.
� When you perform calculations that add or subtract time periods, use multiplication or 

division operators to get a number that reflects what you want.

Exercise 5.6 will familiarize you with the choices you have when it comes to dates and 
times.
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Once the cells are properly formatted, the values and formulas can be added. Let’s move on 
now and use some formulas to calculate date and time periods.

Calculating Dates and Times

Even if you have chosen the correct format, you still need to enter the values correctly so Excel 
knows how to convert them to the format you chose. For example, if you type 10:00pm (with-
out a space), Excel will not recognize it as a time; but if you type 10:00 pm (with a space), 
Excel will recognize it as a time and calculate it correctly when it’s referenced in formulas. If 
the time is AM, you don’t need to enter the “am”; Excel will assume this and add it for you. 
You can tell when Excel has recognized something as a time when you leave the cell and Excel 
adds the AMs and capitalizes the PMs. This shows you that Excel has recognized the time and 
formatted it correctly. If you don’t see this happen, you have entered the time in a way that 
Excel does not recognize. If you aren’t sure whether Excel is seeing it as a time, select the cell 
and go back to the Format Cells dialog box and see what it says.

Exercise 5.7 shows you how to do enter time information correctly, as well as how to use 
formulas to calculate numbers of hours and days.

E X E R C I S E  5 . 6

Date and Time Cell Formats

1. Open the file Exercise 5-6.xls. Note that it is a simple time sheet for a subcontractor’s 
hours worked.

2. Select the range A3:A7, then press the Ctrl key while selecting G2:G3. All of these cells do 
(or will) contain dates.

3. Choose Format � Cells. Click the Number tab, and select Number in the category list. You 
will see the serial number Excel has assigned. Select Date in the category list and select 
the second type on the right that says Wednesday, March 14, 2001. Click OK. You can see 
the change in the dates already on the sheet.

4. Select the range B3:B7 and return to the Format Cells dialog box. This time, choose the 
Time category and the third type, 1:30 PM. Click OK.

5. Finally, select the range D3:D7 and Ctrl+click on G3. Format these cells as numbers, with 
two decimal places. These cells will include total numbers of hours or numbers of days, 
so they should not be formatted as dates or times.

6. Save the file in your Chapter Five folder and name it Exercise 5-7.xls, but do not close 
the file.
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E X E R C I S E  5 . 7  

Adding Date and Time Data and Simple Formulas

1. Still inside the workbook you saved in the previous exercise, enter the following data, 
exactly as shown, in cells B3:C7 (note the space between the time and “pm”).

Enter 8:00 in B3 and 2:00 pm in C3.

Enter 9:30 in B4 and 11:00 in C4.

Enter 12:00 pm in B5 and 6:00 pm in C5.

Enter 1:45 pm in B6 and 8:00 pm in C6.

Enter 6:00 in B7 and 7:00 pm in C7.

2. Now, let’s add a formula that gives us the total hours worked on any given day. Select 
cell D3 and enter a formula that subtracts what is in B3 from what is in C3. The formula 
is =C3-B3. Press Enter. This gives you 0.25.

3. Recalling that you want the number of hours and not a portion of the day, select D3 and 
click in the Formula bar. Adjust the formula to be:

 =(C3-B3)*24.

And press Enter. Now the result shows as 6.00.

4. Select Cell D3 again, and use the thin black plus-sign pointer on the fill handle to drag the 
formula down to cell D7. (Because the cell references in this formula are relative, they will 
update by one row for each row they are dragged over. Don’t worry about this now. 
You’ll learn about relative references in Chapter 6.)

At this point, your data should look like this:

The numbers of hours are showing as decimals (.50 for a half hour and .25 for a quarter 
hour). This might be clearer if shown as fractions. The next step shows you how to do this.

5. Select the range D3:D7 and choose Format� Cells. On the Number tab, choose Fraction 
as the category, using the first type (up to one digit), and click OK.
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Most of the Date and Time functions are fairly straightforward. The TODAY function you 
used in Exercise 5.7 is a good example. Try using the Insert Function dialog box to set up some 
other Date and Time functions. Select them in the list and view the descriptions, and then try 
constructing some more until you are comfortable with them. Most of them (like YEAR, 
MONTH, HOUR, etc.) require only one argument and are used to pull a portion of a date out 
of a full date. For example, the MONTH function is simply =MONTH(A1); if you had the 
date November 15, 2005, in A1, this formula would return an 11 for November, which is the 
eleventh month of the year. The rest of the functions simply convert a date or time to a serial 
number. Once you’ve looked them over and feel comfortable using the Insert Function dialog 
box to construct them, move on to the next section, which covers financial functions.

Working with Financial Functions
The first thing I want to say here is don’t let the term financial scare you. The formulas I cover 
in this section do not require you to be a stockbroker or even an accountant. What these for-
mulas do is let you easily figure out calculations that may have baffled you in the past. Think 
of when you go to buy a new car. The car dealer is rattling off interest rates and all kinds of 

While the range is still selected, look at the Status bar at the bottom of your screen, on 
the right side. It shows “Sum=32 3/4”. You can autopreview the sum of any range by 
highlighting it, then looking at the Status bar. Also, note that you can right-click on the 
Status bar to change Sum to something else, like Average, Min, Max, or Count.

6. Select cell D8, click the AutoSum button on the Standard toolbar, and press Enter. Excel 
presents the sum of hours worked: 32 3⁄4.

7. Select cell G1. As you can see, the label in F1 tells you that G1 should include today’s 
date. You could enter the date manually and that would be a static date; but, instead, 
enter =today() in the cell, to use a function that will update the date to the current date 
dynamically every time the workbook is opened. Press Enter and Excel displays the result 
of the formula in the date format you chose earlier.

8. In cell G2, type 3/15/02 and press Enter. The date displays as Friday, March 15, 2002.

9. In cell G3, enter =G1-G2 and press Enter. This gives you the number of days between 
3/15/02 and today. Because of our formatting choice, it displays as a number, with two 
decimal places.

10. In cell F4, type =(g1-g2)/365.25 and press Enter. You use 365.25 when calculating years, 
to adjust for leap years. Format F4 as a fraction.

11. Save the file to update it and then close the file.

E X E R C I S E  5 . 7 ( c o n t i n u e d )

4002book.fm  Page 174  Friday, March 24, 2006  11:36 PM



Working with Financial Functions 175

financing option deals, and all you really want to know is, “How much of a down payment 
do I need to make so I can afford the monthly payments?” Or, maybe you have a savings plan 
at work and you are trying to figure out how much you have to contribute each month in order 
to have a certain amount saved in five years. Excel’s financial functions make it possible for 
you to figure this all out, so you are armed and ready before you talk to a banker.

Excel has various financial functions, but I can’t teach them all to you. Once you get the 
hang of using the Insert Function dialog box to do the two I will show you, then you need to 
try the others. There’s no way of knowing which one(s) could show up on your MOS Exam, 
but once you get comfortable with the Insert Function setup, you shouldn’t have any problem 
with any of Excel’s financial functions.

In this section, I’ll show you how to use the PMT function to determine loan payments and 
the FV function to calculate how much you can earn through a savings plan, since these are 
two of the most commonly used financial functions. Remember that car loan payment I men-
tioned previously? The PMT function addresses it, so let’s discuss PMT first.

Using the PMT Function

The PMT (short for “payment”) function determines the amount a loan payment will be, based 
on a constant number of payments and a constant interest rate. Assume you want to buy a new 
car and the car dealers all offer different interest rates and payment plans. Let’s say you know 
that the car you want costs $25,000 and the bottom line is you can only afford $450 a month 
for car payments. You have $6,000 in your savings account, but you want to use as little of 
that as possible for a downpayment. So, how much do you really have to put down on this car 
in order to get the payments you can afford?

Assume you have talked to some lending agencies and found out how many years you have 
to pay and what the interest rate is that they are offering. You are now ready to use the PMT 
function in Excel to figure out if you can keep that monthly payment below $450 with as low 
a downpayment as possible. Open a new blank workbook and enter the data as shown in 
Table 5.2 in cells A1:B7 before you begin Exercise 5.8. Format all cells appropriately (numbers, 
currency, percentages, etc.).

T A B L E 5 . 2 Information You Need Before You Get a Car Loan 

  Column A Column B

Row 1 Car Loan  

Row 2 Number of Payback Years 4

Row 3 Total Number of Payments =B2*12

Row 4 Loan Amount =25000-B6

Row 5 Interest Rate for Loan 4.9%
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Table 5.2 shows, in cell B4, you are borrowing $19,000 ($25,000 minus the downpayment 
of $6,000 which you put in B6), over four years (B2), totaling 48 payments (B3, which mul-
tiplies the number of years by 12 months), at a yearly interest rate of 4.9 percent (B5). Notice 
that I put formulas in both B3 and B4, so I can change the number of payback years and the 
downpayment amount and everything else will be adjusted automatically.

First, let’s figure out what the monthly payment would be with these figures. Then, in Exer-
cise 5.8 we’ll make some adjustments to reach that goal of a $450 payment.

Row 6 Downpayment $6000

Row 7 MONTHLY PAYMENT   

E X E R C I S E  5 . 8  

Calculating a Car Loan Downpayment

1. Inside the workbook you created using the data in Table 5.2, select Cell B7 and click the 
Insert Function button on your toolbar (or choose Insert � Function).

2. Choose Financial from the Or Select A Category box and choose PMT from the list 
below.

3. Click OK and you will be presented with this box:

Now, all you have to do is fill in the boxes and Excel will give you your answer.

T A B L E 5 . 2 Information You Need Before You Get a Car Loan (continued)

  Column A Column B
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4. In the Rate box, type b5, which is the cell that contains your interest rate. However, the 
lending agency will give you the yearly rate, and what you need is the monthly rate, so 
put b5/12 in this box (that’s B5 divided by 12 months in a year).

5. Press the Tab key to move to the Nper box.

6. The Nper box is for the number of payment periods and we have that entered in B3, so 
type b3 in this box. Or easier yet, with your insertion point flashing in that box, just click 
on cell B3 in the worksheet and Excel will put it in the box for you.

7. Press the Tab key to move to the Pv box.

8. The Pv box is for the present value, or the amount you are going to pay. That value is in B4, 
so type b4 in that box or just click B4 in the worksheet to enter it in the box.

9. Press the Tab key to move to Fv.

10. Notice that Fv and Type are not in bold like the others. This is because these arguments 
are optional, whereas the bold ones are mandatory. At the bottom of the box, Excel tells 
you that Fv is the future value; if you leave it empty, Excel will assume 0 (zero). Since you 
want to pay this loan off entirely, you want a zero balance, so just press the Tab key to 
leave this empty and move to the Type box.

11. Lending agencies often offer different payment amounts if the loan is paid at the begin-
ning of the month than if it is paid at the end of the month. Your lending agency will tell 
you if they offer this. For now, put a zero (0) in that box, assuming you will pay this loan 
at the end of the month. The dialog box should look like this:

12. Click the OK button and you see that your monthly payment is $436.70, which is lower 
than your goal of $450.

E X E R C I S E  5 . 8 ( c o n t i n u e d )
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It’s important to note that any value produced by a financial function that indi-
cates a payment will show up as a negative amount, because it’s a payout and 
will be deducted from money on hand.

The second financial function we will investigate is the FV function. Let’s do that now.

Using the FV Function

The FV, or future value, function determines the future value of an investment, based on con-
stant payments and interest rate. Assume you need to save $5,000 in two years and you cur-
rently have $800 saved. The best interest rate you have found is 4.5 percent. You want to 
know how much you have to invest each month to reach your goal, and Exercise 5.9 shows 
you how the FV function can answer this question for you.

13. Click in cell B6 and change the downpayment to 3000. This brings the monthly payment 
up to $505.65, which is a little too much.

14. Select cell B7 again and look in your Formula bar. Note that the formula is =PMT(B5/
12,B3,B4,,0). Change that last zero to a 1 (assuming your lending agency allows for pay-
ing at the beginning of the month). That brings the payment down to $503.59.

15. Change the 4 in cell B2 to a 5 to increase the number of years for the loan, and notice that 
your number of payments in cell B3 adjusts to 60 and your monthly payment drops to 
$412.48; again, a little too low.

16. Click in cell B6 again and change that downpayment amount to 1000. Your monthly pay-
ment is now $449.97 and right in line with your budget.

17. Save the file in your Chapter Five folder and name it Exercise 5-9.xls. Leave the file open 
for the next exercise.

E X E R C I S E  5 . 9  

Calculating Payments Needed to Reach a Goal

1. Still inside the workbook you saved in the previous exercise, rename the Sheet1 tab PMT; 
then name the Sheet2 tab FV.

2. On the FV sheet, enter the label $5000 Goal in cell A1 and make it bold.

E X E R C I S E  5 . 8 ( c o n t i n u e d )
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Now that you’ve finished exploring the PMT and FV functions, take some time to practice 
some others. You never know when other financial functions will come in handy. Then, 
when you’re done exploring financial functions, move on to logical functions in the next 
section.

3. In cell A2, type Current Savings; in A3 type Annual Interest Rate; in A4 type Number of 

Payments; and in A5 type Monthly Payment.

4. Now fill in what we know:

In B2 type 800 (which is what you have saved so far)

In B3, 4.5% (the best rate you’ve found)

In B4, 24 (payments once a month for two years)

In B5, 200 (the monthly payment you will try first)

5. Format the cells appropriately, then select cell B1 and click the Insert Function button. 
Choose the Financial category, then choose FV and click OK.

6. Let’s fill in the boxes:

Click in the Rate box, then click on cell B3 on your worksheet. When B3 appears in the 
box, divide it by 12 to get the monthly rate, B3/12.

Press Tab to move into the Nper box, then click on cell B4 so it appears there.

Press Tab to move into the Pmt box, then click cell B5 so that appears there.

Press Tab to move to the Pv box. Pv is what you currently have, so click on cell B2 to 
enter that.

Press Tab to move to the Type box. Assume you will pay this at the beginning of the 
month, so type 1.

7. Click OK to return to the worksheet. Note that paying $200 a month will give you 
$5,906.80 at the end of two years. This is more than you need.

8. Change the monthly payment value in cell B5 to 165 and press Enter. Very close now.

9. Change B5 to 164 and you have what you want (with $1.11 extra).

10. Save the file to update it, and then close the file.

E X E R C I S E  5 . 9 ( c o n t i n u e d )
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Working with Logical Functions
Understanding a logical function means thinking like Star Trek’s Mr. Spock. Definitions of the 
term “logic” include terms like “reason,” “the study of arguments,” and “theory that is 
proven consistently.” Logic is what takes the guesswork out of something. Logical questions 
ask, “What would happen IF I did this?” or “IF I did this AND this OR this but NOT that, 
what would be the result?” Logic is based on cause and effect.

Computers themselves deal strictly in logic. I’m sure you’ve heard computer techies say, 
“Everything is ones and zeroes.” What this means, in layman’s terms, is that all a computer 
understands is 1(meaning yes or true) and 0 (meaning no or false).

In Excel, logical functions basically deal with these two states. We ask Excel, “Is this con-
dition true or false?” Then we tell the program what we want done, based on the answer to 
that question. Examples of simple logical statements you might pose in a worksheet are:
� If Joe’s sales are higher than Marty’s, promote Joe to a management position.
� If this month’s perfume sales are lower than last month’s, reduce the price of the perfume 

by 10 percent.
� If a customer lives in the United States, their shipping fee will be $6.00, but if they reside 

elsewhere, it will be $10.00.

It’s obvious the key word here is if, so it makes sense that we start with the IF function.

Am I an “Advanced Excel User”?

Even though the IF statement is a logical function and included in the Specialist MOS Exam 
instead of the Expert Exam, I can tell you that every company I have ever dealt with considers 
potential employees as advanced Excel users if they understand two functions: IF and VLOOKUP. 
(I’ll discuss VLOOKUP in more detail in Chapter 6.)

A student of mine was considering applying for a job listed in the newspaper want ads that 
had this requirement: “Must have advanced Excel knowledge.” My student was brushing up 
on her Excel skills and focusing on trendlines, database functions, pivot tables, and so forth. 
Granted, these are all important parts of advanced Excel use and may need to be learned, but 
I told her not to forget IFs and VLOOKUPs because that’s what they were going to want to see.

Most business spreadsheets will require formulas that pull information from other places 
based on criteria or parameters, and the IF and VLOOKUP formulas are the most commonly 
used for this purpose.

A week later she came bursting into my classroom, all smiles, and said, “I got the job!” After 
we finished jumping up and down and hugging each other, she added, “And you were right. 
The only thing they asked me was ‘How good are you with formulas?’ and I said, ‘Well, I can 
do an IF statement and a VLOOKUP.’ They never even asked if I knew what a trendline was!”
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The IF Statement

In an earlier section of this chapter, when we were looking at statistical functions, we used the 
COUNTIF function to count only those stores that had sales over $50,000. Because that func-
tion’s basic purpose is to count items, it is included in the statistical category; however, the “if” 
part of that function is actually using logic.

IF statements understand only two conditions: yes (true) and no (false). No matter how 
intricate the IF statement is, if it can’t answer the true/false question, it won’t work. The 
IF function has three arguments: the logical test (the true/false condition); the value you 
want returned if the answer is true; and the value you want returned if the answer is false. 
Use Exercise 5.10 to learn the basics of how Excel’s IF function is constructed.

If you look at the formula in cell F4 (see Figure 5.3), you will see that it changed from what 
was in F3 to refer to E4 instead of E3; then in the next row it changed again to refer to that 
row, and so on. This is because the reference to the cell in column E is relative (you will learn 
more about relative cell references in Chapter 6). For now, it’s important only that you under-
stand that, by default, Excel formulas are generally relative. They update the row as you drag 
them down a column, and update the column as you drag them across a row.

E X E R C I S E  5 . 1 0

Using the IF Function to Answer True or False

1. Open Exercise 5-10.xls and select cell F3 on the IF worksheet. The question in F2 asks 
whether the stores will be included next month.

2. Assume any store that had sales in Week 4 is eligible for inclusion next month and click 
the Insert Function button.

3. Choose Logical as the category, then choose IF from the list and click OK.

4. In the Logical_test box, type e3>0 and note that to the right of that box it says TRUE 
because the value in E3 is, in fact, greater than zero. Press Tab to move to the next box.

5. In the Value_if_true box, type Yes and press Tab. Excel added quotation marks to “Yes.”

6. In the Value_if_false box, type No and either click OK or press Enter to return to the 
worksheet.

7. Note that the IF statement returns the word Yes because the answer to the logical test 
is True.

8. Use the thin black plus sign on the fill handle to drag this formula down to cell F7. Note 
that the only cell that says No is F6 because the value is E6 is not greater than zero.

9. Save the file in your Chapter Five folder and name it Exercise 5-11.xls. Leave it open for 
the next exercise.
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F I G U R E 5 . 3 Relative cell references update as formulas are dragged.

Also notice in Figure 5.3 that the words Yes and No have quotation marks around them in 
the Formula bar. This is because Yes and No are text and not numbers. If you put text in the 
Insert Function boxes, Excel will add the quotation marks, but if you manually enter the for-
mula in the cell or Formula bar, you must put the quotation marks in yourself. Numbers, however, 
do not require quotation marks. Let’s try some manual editing of the IF statement we created 
in Exercise 5.10 here in Exercise 5.11.

E X E R C I S E  5 . 1 1  

Editing an IF Function within a Cell

1. Still inside the workbook you saved in the previous exercise, select cell F3, then click in 
the Formula bar.

2. Use your → and ← keys to move your insertion point between the opening quote and the 
Y in Yes. Then press Delete three times to remove that word, but leave the quotation 
marks. Press Enter.

3. As you can see, cell F3 is now empty. Typing "" (two quotation marks with nothing 
between them) tells Excel you want nothing in that cell. Grab the fill handle on F3 and 
drag it down to F7 to update all the formulas. Note that the only cell that has anything in 
it is cell F6, because it’s the only one that does not meet the condition E3>0, so it still says No.
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Let’s look at a few more simple logical functions, and then I will teach you how to com-
bine them into one formula. This next section shows you how to use AND, OR, and NOT 
functions.

More Logical Functions

Just like the IF function, the other logical functions also answer the true/false question. If you 
know anyone who is left-brained and a logical thinker, you may recall that when you ask 
them a question like “Do you think this is correct?” they probably simply answer “yes” or 
“no.” A more right-brained thinker, on the other hand, might answer with a reply like “Well, 
in my experience it could be correct because I once saw it happen just that way.” Logical 
thinking includes little, if any, embellishment—and this is the case with the following logical 
functions also.

To understand the difference between AND, OR, and NOT, you need to turn on that left 
brain. The AND function asks if a condition is met in one situation and also in another; the 
OR function asks if the condition is met in one situation or the other, but not necessarily in 
both; and the NOT function asks if it’s met in one but not in the other.

First, let’s discuss the AND function in more detail.

4. Change the value in cell B4 to 8453.13 by simply changing the 3 to an 8.

5. Select cell F3 again and click into the Formula bar. Double-click on the zero in E3>0 and 
type b3 so it reads E3>b3 and press Enter. Drag this formula down to F7 and note that 
now two cells show No, because two values in column E are smaller than their corre-
sponding values in column B.

6. Double-click on cell F3 and double-click "" to select the two quotation marks. Type 1. Then, 
double-click “No” to select it, and type 2. The formula should now read =IF(E3>B3,1,2). 
Press Enter, and note that 1 appears in cell F3; grab Cell F3’s fill handle and drag it down 
to F7. The numbers work fine without quotation marks.

7. Change the 2 in the formula in F3 to No (without any quotation marks) and press Enter. 
Drag this formula down to F7 and note the #NAME? error in the cells where No should 
appear. The #NAME? error means that Excel does not recognize the name No. When you 
put text in a formula without the quotation marks, Excel assumes the text is either a func-
tion name or a range name; since it does not recognize No as either type of name, it gives 
this error. (You will learn how to fix these types of errors in Chapter 8, “Data Analysis and 
Sharing Workbooks.”)

8. Click the Undo button once to undo the fill, then once more to put 2 back into this revised 
IF statement. Save the file to update it, and then close the file.

E X E R C I S E  5 . 1 1 ( c o n t i n u e d )
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The AND Function

The AND function does one thing and one thing only. It can only return one of two values: 
TRUE or FALSE. If the condition is true in all references within the formula, the result of the 
formula will be TRUE. If it’s true in one or more, but not in all, the result will be FALSE.

Figure 5.4 shows the syntax for an AND formula, which is:
 =AND(condition1,condition2,condition3, etc.)

F I G U R E 5 . 4 An AND formula must meet all conditions to return a value of TRUE.

Let’s look at it in action in Exercise 5.12.

E X E R C I S E  5 . 1 2  

Filling Series across Worksheets and Using an AND Function

1. Open the file Exercise 5-11.xls that you saved in the previous exercise. If you did not save 
it, extract it from the zipped file for this chapter.

The first thing we need to do is get some data on the AND and ORNOT sheets in this 
workbook.

2. Select the range A1:E7, then group all three worksheets and choose Edit � Fill � Across 
Worksheets. (If the sheets are not grouped first, Across Worksheets will be grayed out.) 
Make sure All is selected and click OK.
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Did you notice that cell F5 has a small green triangle in the upper-left corner 
that displays an option button when you select the cell? Ignore that for now; 
we will explore what can be done with that triangle in Chapter 8.

The OR and NOT Functions

Because the AND function returns TRUE only when all conditions are met, we need to use the 
OR or NOT functions when we want TRUE returned for more specific conditions. The OR 
function will generally return more TRUEs than the AND function because it doesn’t require 
that all conditions are met.

The OR function is constructed exactly the same way as an AND function, except the function 
name is, obviously, OR instead of AND. The NOT function is different. It allows only one argu-
ment (condition) instead of multiple ones like the other two allow. All the NOT function does is 
change a TRUE to a FALSE, or a FALSE to a TRUE. Use Exercise 5.13 to understand this better.

3. Click the AND and ORNOT sheets and adjust all column widths to show the full data. (You 
cannot use Paste Special � Column Widths when you use the Fill feature to copy data to 
grouped sheets.)

4. Make sure your sheets are ungrouped and move to the AND sheet. In F2 type Bonus? and 
press Enter.

5. In F3 type =and(b3>5000,c3>5000,d3>5000,e3>5000) and press Enter. It returns TRUE 
because the condition is true in B3, C3, D3, and E3.

6. Use the fill handle to copy that formula down to F7. As you can see in Figure 5.4, the for-
mula returns TRUE in only two cases, because the other three rows do not meet ALL of 
the conditions and, therefore, return FALSE.

7. Save the file in your Chapter Five folder and name it Exercise 5.13.xls and leave it open 
for the next exercise.

E X E R C I S E  5 . 1 3  

Using OR and NOT Functions to Return More Specific TRUE Conditions

1. Still inside the workbook you saved in the previous exercise, move to the ORNOT sheet 
and enter Out of the Norm in cell F2. Press Enter.

2. In cell F3 type the exact same formula you typed in F3 in the AND sheet, but use OR 
instead, as the function name:

=or(b3>5000,c3>5000,d3>5000,e3>5000)

E X E R C I S E  5 . 1 2 ( c o n t i n u e d )
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The NOT function is something you probably won’t use much and will rarely use alone. It’s 
used more in nested functions, which we discuss in the next section.

Adding Multiple Nested Conditions and Multiple 

Return Values in IF Statements

Is your head spinning yet? Well, hold on because we’re about to move into really advanced 
logical function capabilities. (This might be a good time to take a break and walk the dog, 
because I need you clearheaded and alert for this!)

The IF function has minimal capabilities when used alone or used with only one condition, 
but when you add multiple conditions or combine the AND or OR functions together with an 
IF function in one formula, the possibilities are endless.

Sometimes you have more than one condition that has to be met within your IF statement, 
so you can use nested functions. Nesting functions simply means using one function inside 
another. When functions are nested, Excel will read the one nested deepest first, then work its 
way out. If you nest an AND (or OR) function inside an IF function to apply two or more con-
ditions that must be met, Excel will calculate the AND function first and use the results of the 
AND function for the IF function’s “logical_test.” Remember, the IF function’s second and 
third arguments return a “value_if_true” or a “value_if_false,” so if the AND function returns 
a TRUE, the IF function will return its value_if_true and if the AND function returns a FALSE, 
the IF function will return its value_if_false.

3. Just like the AND function, this one returns TRUE as well, but use the fill handle to drag 
it down to cell F3 and note that it returns TRUE every time, except in cell F5. This is 
because an OR function will return TRUE as long as any one of the conditions within the 
formula returns TRUE. Row 5 is the only row where none of the values are greater than 
5000, so F5 returns FALSE.

4. Add the value 5001 to cell B5 and press Enter. Notice the value in cell F5 changes to TRUE 
(and the little green triangle is removed).

5. Widen column F to display the full label in F2, then, in cell G2, type Week 4. Then hold 
your Alt key down and press Enter to move to the next line within the cell, type More than 

5000, and press Enter. Drag the right side of column G’s header to widen the column to 
show the text on two rows, if necessary.

6. In cell G3, type =not(e3<5000) and press Enter. You get a value of TRUE because the 
value in E3 is NOT less than (<) 5000. Use the fill handle to drag this down to cell G7 and 
see you get FALSE only when the value is less than 5000, because the NOT function basi-
cally just reverses the TRUEs and FALSEs.

7. Save the file to update it and then close the file.

E X E R C I S E  5 . 1 3 ( c o n t i n u e d )
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Sweating yet? Read on.…
In addition, once you have multiple conditions, you may need more than one value_if_true 

or more than one value_if_false. That requires nesting one IF statement inside another. You 
can nest up to seven IFs in one formula, so that means you can return up to eight different 
results (seven different values_if_true and one value_if_false).

To nest a function, you simply put it inside parentheses, wherever you want that nested 
function to be used as an argument in the parent function.

Though many formulas use nested functions, the IF statement probably uses nesting more 
than any other, because it’s not unusual to have more than one condition you need to meet for 
a particular formula result. This is all much clearer when you actually see it in action, I promise 
you, so let’s get moving and do Exercise 5.14.

Because the following exercise includes some pretty intense formulas, I cre-
ated a formula printout for you, which you can extract from the zipped file for 
this chapter and print so you have it beside you as a reference while going 
through this. The file is named NestedFormulaPrintout.xls. You’ll learn how 
to create your own formula printouts at the end of this chapter.

E X E R C I S E  5 . 1 4  

Nesting Functions

The workbook we’ll use in this exercise (Exercise 5-14.xls) shows salespeople’s district, annual 
sales, and number of years employed by a company. Now, let’s suppose you want a formula 
in column E that will assign a job level based on two different conditions: Salespeople who 
have been employed for more than 5 years AND have annual sales of more than $10,000 should 
be assigned a job level code of 2, and all others should have a job level code of 1. To include 
two conditions, when both conditions must be met, you must nest an AND function within 
your IF statement. Here’s how you’ll do that.

1. Open the file Exercise 5-14.xls.

2. Type this formula in cell E2:

=IF((AND(D2>5,C2>10000)),2,1)

3. Grab cell E2 by its fill handle and drag it down to cell E8. As you can see, the IF function uses 
the nested AND function for its logical_test, so where the AND function returns a TRUE, a 2 
is placed in the cell and where the AND function returns a FALSE, a 1 is placed in the cell.

This formula, if entered correctly, should show job level code 2 for Joe and Mary only, 
because they are the only two who have worked for the company more than five years 
and had annual sales greater than $10,000. (Similarly, you can use a nested OR function 
if you want a job level code of 2 to be applied if an employee meets EITHER condition, 
instead of both conditions.)
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Now I know you need to go take that break and walk the dog. And, if you don’t have a dog, 
go buy yourself a cocker spaniel puppy as a reward for completing that last exercise!

When you return, we can give your brain a rest and do something easier. Formulas and 
functions can be exhausting and hard to remember. So, I want to show you how to print for-
mula printouts, since we now have some formulas to work with; that may help you in learning 
them. For many people, hard copies of the formulas are invaluable resources, because you can 
have them beside you while you work on a file and you’re able to see the actual formulas 
instead of just the results of the formulas.

4. Type this formula in E2 now and copy it down to E8:

=IF((OR(D2>5,C2>10000)),2,1)

In this case, everyone is assigned a job level 2 except John, because he is the only one 
who did not meet either condition, since he has not worked for the company for more 
than five years OR had annual sales greater than $10,000.

Now, let’s say we want to assign a job level 3 if the employee meets both conditions 
above, a job level 2 if the employee meets either condition above, and a job level 1 if the 
employee doesn’t meet any of the conditions above.

5. Enter this formula in E2 and copy it down to E8:

=IF((AND(D2>5,C2>10000)),3,(IF((OR(D2>5,C2>10000)),2,1)))

Phew! Notice what we are doing here is basically nesting one IF statement within 
another. However, though we have two different logical tests and two different values_
if_true, we have only one value_if_false.

You can also nest multiple IFs if you want different results based on different values in the 
same cell. For this example, let’s say all of the employees in the East district will be assigned 
a job level 4, the West ones will be job level 3, the North ones will be job level 2, and the 
ones in the South will be job level 1.

6. Enter this formula in E2 and drag it down to E8:

=IF((B2=“East”),4,IF((B2=“West”),3,IF((B2=“North”),2,IF((B2=“South”),1,”“))))

Note that the value_if_false is "", which tells Excel to leave the cell empty if no match is 
found in column B for that row. If you delete the contents of any cell in column B or 
change it to anything other than East, West, North, or South, you will see the correspond-
ing cell in column E would now be empty. You must have something in your third argu-
ment (value_if_false) or Excel will simply enter the text FALSE into that cell if it does not 
find a match.

7. Close the file. It’s not necessary to save the changes.

E X E R C I S E  5 . 1 4 ( c o n t i n u e d )
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Printing Formulas
Sometimes it can be difficult to use formulas, because a cell doesn’t display a formula unless 
you have selected that cell. So, if you move to another cell, you have to keep selecting the pre-
vious cell to see the formula’s construction. However, Excel does give you the opportunity to 
display your formulas, and even print them (see an example in Figure 5.5).

F I G U R E 5 . 5 Excel lets you print formula printouts with gridlines and row and column 
headings.

Because Excel does not print gridlines by default, and because the rows and columns are not 
identified in printing, it’s difficult to see the location of the cells. A formula may refer to cell D2, 
but how can you tell where D2 is? Creating a formula printout that clearly shows the row and 
column headers and gridlines makes this much clearer.

I know many people who have a whole notebook of printed formulas they keep beside their 
computers. Exercise 5.15 teaches you how to create formula printouts that clearly show not 
only the formulas, but the cells to which they refer.

E X E R C I S E  5 . 1 5  

Displaying Formulas and Printing Formula Printouts

1. Open the file you saved in Exercise 5.5 and named Exercise 5-5A.xls. (If you didn’t save 
it, extract it from the zipped file for this chapter.) Locate the grave accent (`) key on your 
keyboard. On most keyboards, the grave accent occupies the same key as the tilde (~) 
symbol, above the left Tab key. Hold down your Ctrl key and press that key one time. 
Release both keys and Excel displays your formulas on your worksheet. Also, the For-
mula Auditing toolbar may appear.

2. You don’t need the Formula Auditing toolbar at this time, so just click on the X at the right 
end of the toolbar to close it.
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Summary
Formulas in Excel include everything from simple arithmetic, which adds, subtracts, multi-
plies, and divides numbers, to intense statistical and logical formulas with nested functions. 
Formulas can be entered into cells manually, or you can use the Insert Function utility, which 
lets you see exactly which arguments are required in any function and what the function does.

In this chapter, I covered four different function categories. Statistical functions help you to 
produce statistical reports from your data, showing summaries, such as averages (means), 
maximum values, minimum values, and counts. Date and Time functions allow you to calcu-
late time spans between seconds, minutes, hours, days, weeks, months, and years, which Excel 
stores as serial numbers when they are formatted correctly. Financial functions let you analyze 
and predict payment amounts, future values, interest rates, and so forth for both loans and 
investments. Logical functions answer the question, “Is this true or false?” and allow you to 
return different values based on different answers to your true/false questions.

You can nest multiple functions inside one formula to perform different calculations at one 
time. The mnemonic “Please Excuse My Dear Aunt Sally” reminds you that calculations are 
performed in this order: parentheses, exponentials, multiplication, division, addition, and 
then subtraction.

By default, formulas display their results in the cells where they are entered, but you can see 
the actual formula in any cell when you select it and view the Formula bar. You can also dis-
play the formulas themselves onscreen and even print formula printouts.

3. Click the Print Preview button.

Remember, you learned in Chapter 3, “Organizing Data, Changing Views, and Printing,” 
that Print Preview shows you exactly how your worksheet will print. You can see your 
formulas will print, but this isn’t quite good enough, so let’s add the row and column 
headers and gridlines so we can clearly see which values the formulas refer to.

4. Close Print Preview and choose Page Setup from the File menu. Click on the Sheet tab.

5. In the center section, labeled Print, select Gridlines and Row And Column headings. Click 
the Print Preview button.

6. See how much easier it is now to identify the location of the cells referenced in the for-
mulas (see Figure 5.5)? Click the Print button.

7. Once you have printed the file, press Ctrl+` again to remove the formulas from view.

8. Close the file without saving it.

E X E R C I S E  5 . 1 5 ( c o n t i n u e d )
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Exam Essentials
Understand the syntax of formulas and functions. Be able to correctly input a formula, 
either manually or by using the Insert Function dialog box. Know when to use commas, paren-
theses, and so forth.

Remember the order of precedence used by Excel in calculating formulas. Memorize 
“Please Excuse My Dear Aunt Sally” and understand how to use parentheses when you want 
to control the order of precedence in a formula.

Know how to format dates and times so they calculate correctly. Spend some time in the 
Format Cells dialog box so you understand all the different date and time formats. And if 
Excel returns a formula result that shows something like percentages of a day, know how to 
convert that to hours.

Be proficient in using the Insert Function dialog box. Make sure you can build various 
functions using this utility. That way, you can handle any function presented to you in the 
exam. You will be able to use it during the exam, so be sure you understand it!

Familiarize yourself with every function in the Statistical, Date and Time, Financial, and Log-
ical categories. Know what they all do. Just because a function wasn’t included in one of the 
exercises in this book does not mean it won’t show up on the exam. If you know what the function 
does and how to use the Insert Function dialog box, you will be able to handle the formula.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter, as well as some skills covered in previous chapters; then check the solutions to see how 
you did. To complete these exercises, you will need to extract the file MOS Scenarios Ch 5.xls from 
the zipped file for this chapter. Open the file in Excel before you begin the scenario exercises.

Use the CarLoans sheet for Scenario 12:

 

MOS Scenario 12: Use a Multiplication Formula and the PMT Function and 
Create a Formula Printout

Use formulas in cells B9 and C9 to calculate the monthly payments on a car loan, based on the 
information in the columns above. Then use another formula in B11 and C11 to determine the 
total amount that will be paid on the loans (not including downpayments). Format all dollar 
amounts as currency with two decimal places. Display the formulas and view the worksheet 
in landscape orientation in Print Preview. Make sure it will print on one page.
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Use the BonusReport Sheet for Scenario 13:

Use the VacationDays Sheet for Scenario 14:

 

MOS Scenario 13: Use the MIN, MAX, and IF Functions

Enter formulas in cells C9 and C10 to show the highest and lowest sales from all the sales 
shown on the sheet. Add formulas in the Bonus column to give each store a bonus if their 
Week 4 sales were larger than their Week 1 sales. The cells in the Bonus column should show 
the actual bonus amount, which is 10 percent of their Week 4 sales, if they qualify for a 
bonus; the cells should be empty if they do not qualify.

 

MOS Scenario 14: Use Arithmetic Formulas to Calculate Numbers of Days

This company works seven days a week and also on holidays, so vacation time is based on 
a seven-day week. Format the dates in this worksheet to show the day of the week, as well as 
the month, date, and year. Use a formula in the Days Used column to determine how many 
vacation days each employee has already used. Then deduct what they’ve used from what 
they are allowed to put the number of vacation days they can transfer to next year in the cor-
rect column.
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6

 

Advanced Functions, 
Table Arrays, and 
Database Features

 

MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Define, modify, and use named ranges

�

 

Define and apply advanced filters

�

 

Create and modify list ranges

�

 

Insert and modify formulas

�

 

Use Lookup and Reference functions

�

 

Use Database functions
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Congratulations! If you’ve made it this far, you now know how 
to do everything included in the MOS Specialist Objectives list. 
Now, let’s move on to the Expert Objectives.

In the previous chapter, I introduced you to many functions that perform calculations that 
refer to data in single cells, calculating one cell at a time. However, the Lookup and Reference 
and the Database functions covered in this chapter perform calculations that refer to data in 
a table array. A 

 

table array

 

 is nothing more than an identified range of data that includes mul-
tiple columns and rows. For example, you might want to produce an invoice that automati-
cally fills in all the information about a product when the product’s order number is typed into 
the invoice. To do this, you first create a table array that includes the information on all prod-
ucts; then use a Lookup and Reference function to search this table for the order number you 
enter, and return all of the information in the cells you specify. Or, maybe you want to use a 
formula to perform statistical calculations on fields in a table array that meet certain criteria, 
and you could do this using a Database function. Another way to perform calculations that 
search an array is by using an array-entered formula. I prefer this method because it eliminates 
the need to set up a separate table array and simply uses the existing information as its table.

To perform calculations that search a table for information, you must understand the dif-
ference between absolute and relative cell references (those dollar signs you’ve seen in cell ref-
erences in previous chapters and that I’ve been telling you to ignore). Also, it’s easier to use 
table arrays when you understand how to name ranges and lists. I’ll explain named ranges and 
lists, as well as absolute and relative cell references, in this chapter, before I actually show you 
the Lookup and Reference and Database functions that rely on these features.

To complete the exercises in this chapter, download the file exl2003ch06.zip from the web-
site for this book and extract the files to a temporary folder before you begin.

Now, let’s look at absolute and relative cell references and demystify those dollar signs 
you’ve been seeing in certain cell references.

 

Understanding Cell References

 

In previous chapters, when you used such features as the Chart Wizard and the Rows To 
Repeat At Top feature in Page Setup, you noticed dollar signs ($) included in some cell refer-
ences. These dollar signs tell Excel that the cell or range referred to is an 

 

absolute reference

 

, 
meaning that the formula will 

 

absolute

 

ly always refer to the same cell no matter where you 
copy the formula. It is important that you understand this and recognize the difference between 
absolute and relative cell references in a formula. 

 

Relative reference

 

 means that the cell refer-
ence will change 

 

relative

 

 to where you put the formula. By default, most cell references are 
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relative, so you can easily drag a formula with the fill handle, and the references within the for-
mula will update relative to the formula’s location. To make them absolute, you add dollar 
signs ($). The cell reference C5 will change relative to where you copy it, but the cell reference 
$C$5 will always refer to C5 no matter where you copy it. You can also make the row refer-
ence absolute but the column reference relative (C$5). When you do, the row will stay the 
same but the column will change relative to where you copy it. The same applies if you make 
the column reference absolute and the row reference relative ($C5).

Figure 6.1 illustrates how absolute and relative cell references do (or do not) update when 
dragged with the fill handle.

 

F I G U R E 6 . 1

 

Dollar signs designate that a cell reference is absolute and will not change 

 

when copied to another location.

 

Figure 6.2 shows the results of the formulas in Figure 6.1. Notice that the results of formulas 
that contain absolute references do not change when copied because they always refer to the 
same row or column, or both. Also, notice those green triangles in the corners of the some of 
the cells that contain relative references. Cells with green triangles in them contain possible errors. 
If you click one of these cells, you will get an option button that shows you that the formula 
is referring to an empty cell, which is what often happens when you drag a relative-reference 
formula. (I’ll discuss formula errors in Chapter 8, “Data Analysis and Sharing Workbooks.”)

Relative Row and Column Relative Row, Absolute Column

Absolute Row, Relative ColumnAbsolute Row and Column
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F I G U R E 6 . 2

 

Formulas with absolute references will always return the same result.

 

Most cell references in formulas are relative because we generally list data down a column. 
So when we put a formula in row 1, we do want it to update and refer to row 2, row 3, and 
so forth, as we drag it down the column to copy it. But, maybe you are wondering when you 
would use absolute references. Well, let’s say you have a number in cell A5 that includes the 
monthly bonus amount, and in other cells in the worksheet you use formulas to add this bonus 
amount, based on an IF statement. The reference to A5 in the IF statement must be absolute 
($A$5) so that when you drag the IF statement with the fill handle, A5 doesn’t change to A6 
when dragging down or B5 when dragging across. As I said earlier, sometimes you don’t want 
both the column and row to be relative or absolute, but instead you want a mixed cell refer-
ence. There are four different cell reference types:

 

A relative reference

 

This will increase or decrease by one column letter as you copy it to the 
right or to the left, and will increase or decrease by one row number as you copy it down or 
up (see cell D1 in Figures 6.1 and 6.2).

 

An absolute row and relative column

 

The row number will stay the same, but the column 
letter will increase or decrease by one letter as you copy it to the right or the left (see cell F1 
in Figures 6.1 and 6.2).

 

A relative row and absolute column

 

The column letter will stay the same, but the row number 
will increase or decrease by one number as you copy it down or up (see cell D6 in Figures 6.1 
and 6.2).

 

An absolute reference

 

This will refer to the same cell, no matter where you drag it (see cell 
A6 in Figures 6.1 and 6.2).
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To quickly switch between the four absolute/relative choices, select the cell 
with the formula in it and double-click on any cell reference in the Formula bar 
so just that cell name is highlighted in the formula. Then, press your F4 key 
once and Excel will change the reference. Continue pressing the F4 key and 

 

the reference will toggle through the four choices.

 

You can mix cell references within a formula in any way you choose, based on your needs. 
For example, you could use =A$1+$B1, where the first cell reference is relative column, abso-
lute row, and the second cell reference is absolute column, relative row.

If all of this is mind-boggling to you, here’s the good news: You can name ranges, cells, and 
constant values when you want them to remain absolute, and then use these names in your for-
mulas instead of the cell references themselves. This will ensure that your formula always 
refers to the correct cell or range. And that’s what I will teach you next.

 

Using Named Ranges, Cells, 
and Constants

 

Not only can you name ranges to keep them absolute, but naming ranges makes other oper-
ations easier also. Naming a range is simply a shortcut so you can include that range name in 
formulas, charts, and so forth and don’t have to manually type or select all the cells in the 
range. Though Microsoft calls the feature 

 

named ranges

 

, you can also name one cell or a con-
stant value. You can use named ranges, cells, and constants as references within formulas, but 
they are also handy to use as bookmarks that let you quickly jump to any location within a 
workbook. You can name a range or cell by selecting it and typing the name in the Name box 
next to the Formula bar, or you can use the Name command in the Insert menu.

There are some rules about names:
�

 

 Names cannot have spaces in them.
�

 

Names cannot be the same as a cell reference. For example, you could not use the name 
Q1 for a range showing the sales for your first quarter, because Q1 is a valid cell reference. 
You could however, name the range Q1Sales or Q1_sales.

�

 

Names cannot begin with a number.
�

 

Names cannot contain certain special characters, like -, $, %, &, or #.
�

 

Names should be more than one and fewer than 255 characters long.

If you forget any of these rules and try to name a cell something that Excel will not accept, 
you will get an error message and will have to change it (see Figure 6.3).

Excel has a lot of activities related to names and naming, but let’s first look at named 
ranges, which you’ll need when you use the Lookup and Reference and Database functions 
covered later in this chapter. First, I’ll show you how to name ranges, and then we’ll look at 
how to use range names in some simple formulas.
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F I G U R E 6 . 3

 

You must follow Excel’s rules when naming a range.

 

Named Ranges

 

Using 

 

named ranges

 

 in Excel can save you lots of time and repetitive work. Let’s say you have 
a range of cells that you are including in many different formulas or you have a block of cells 
that you are using a lot to produce various charts and/or pivot tables. (I’ll explain pivot tables 
in Chapter 7, “Advanced Data Organization and Display.”) If you name the range, you can 
easily select that range any time you need it. As stated in the previous section, using a named 
range in a formula also negates the need to make the range an absolute reference because it will 
always point to the correct range, no matter where you copy the formula. Let’s look at naming 
ranges, then I’ll show you how to use formulas with these names and edit the named ranges.

 

Naming Ranges

 

To name a range, select the cells you want to include in the range, click in the Name box, type 
a name, and then press Enter. Another option is to use the Name command in Excel’s Insert 
menu. The most commonly used method is the first one, but the Name command offers you 
some alternatives when you want to do more than something simple. Exercise 6.1 teaches you 
how to name ranges in different ways.

 

E X E R C I S E  6 . 1  

 

Naming Ranges in Different Ways

 

1.

 

Open the file Exercise 6-1.xls that you extracted from the zipped file for this chapter. It 
contains a list that shows the highest sales of any one product bought by any one com-
pany in each month of the year.

 

2.

 

Select the range A3:E14; then click in the Name box, type 

 

2003Tops

 

, and press Enter. 
Excel displays an error message because you broke one of its rules and tried to name a 
range beginning with a number. Click OK.

 

3.

 

With the range still selected, click in the Name box again, type 

 

TopSales03

 

, and press Enter. 
Excel accepts this name and centers it in the Name box. You must always press Enter 
after typing a name in the box so the name is committed.

 

4.

 

Click outside of the range to deselect it, and click the dropdown arrow to the right of the 
Name box. Your new name appears in the list. Click on TopSales03 to select the range again.
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5.

 

Select the range A2:E14. Note that this time we are including row 2 in the selection. 
Choose Insert �

 

 Name �

 

 Create.

 

6.

 

The box that appears asks you where the range names are. Make sure Top Row and Left 
Column are both selected and click OK.

 

7.

 

Deselect the range and click on the dropdown arrow to the right of the Name box. Note 
all the range names you have now.

 

8.

 

Select Amount from the list to select all of the values in the Amount column.

 

9.

 

Return to the dropdown and select May from the list. Excel selects all of the values in the 
May row.

 

10.

 

Return to the dropdown and select Month from the list. All values for all months are 
selected because Month is the column header for the left column, which includes all the 
row headers that have been used as range names as well.

 

11.

 

Select cells A3:A14, then hold down your Ctrl key and select E3:E14 to select the 
noncontiguous data. Choose Insert �

 

 Name �

 

 Define. Name the range 

 

MonthlyTotals

 

 
(as shown in the graphic). The Refers To box at the bottom now reads =‘2003 Top 
Sales’!$A$3:$A$14,’2003 Top Sales’!$E$3:$E$14. The dollar signs indicate that the 
ranges are absolute, and Excel includes the sheet name followed by an exclamation 
point. Click OK.

 

E X E R C I S E  6 . 1

 

( c o n t i n u e d )
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Now that you have some named ranges, let’s try using them in some simple formulas.

 

Using Named Ranges in Formulas

 

Once ranges are named, you no longer need to enter cell references in formulas; you can use 
the range name instead. In fact, Excel will often use the names by default. Try Exercise 6.2 to 
see what I mean.

 

12.

 

Click the dropdown arrow to the right of the Name box and select the MonthlyTotals 
range. Excel selects the noncontiguous data.

 

13.

 

Use the Save As dialog box to create a new folder named 

 

Chapter Six

 

 and save this file 
inside the new folder. Name it 

 

Exercise 6-2.xls

 

. Leave the file open for the next exercise.

 

E X E R C I S E  6 . 2

 

Creating Simple Formulas Using Named Ranges

 

1.

 

Still inside the workbook you saved in the previous exercise, select cell E15 and click the 
AutoSum button. Then press Enter.

 

2.

 

Select cell E15 again and look at the Formula bar. Notice that the formula reads 
=SUM(Amount); this is because Excel detected the range name applied to the values in 
the cells directly above the selected cell.

 

3.

 

Use the Format Painter to copy the format from cell E14 to E15. Widen the column if you 
see # signs.

 

4.

 

In cell A16, type 

 

Total Quantity

 

 and adjust column A’s width to fit this data.

 

5.

 

In B16 type 

 

=sum(

 

, click cell D3, and slowly drag down the column. Notice that B16 is 
updating the range to include each cell as you drag, and as soon as you reach D14, the 
formula updates to show the range name Quantity. Press Enter.

 

6.

 

In A17, type 

 

Total Months

 

, then tab over to cell B17 and type 

 

=counta(month)

 

. (Like func-
tion names, range names are not case-sensitive.) Press Enter and you’ll see that this gives 
an incorrect result of 48. This is because COUNTA counts all cells with data in them and 
the Month range name refers to 48 different cells. (Select Month from the Name box 
dropdown list to see which cells it includes.)

 

7.

 

Select cell B17 again, click in the Formula bar, double-click Month, type 

 

product

 

, and press 
Enter. This gives the correct result of 12 because the Product range includes only 12 cells.

 

8.

 

Save the file to update it, and leave it open for the next exercise.

 

E X E R C I S E  6 . 1

 

( c o n t i n u e d )
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Changing the range from Month to Product did indeed give us the correct result, but why 
would we want to count the product entries when we really want to count the number of 
months? Not a good idea. We need to change the range that the Month name refers to so that 
it is pointing to the list of 12 months. So let’s work on editing.

 

Editing Range Names

 

Editing range names is a little quirky. If you just want to change the name of a range, Excel 
will actually create a duplicate of the range name with a new name, so you end up with two. 
For some unknown reason, Excel will let you change the range the name refers to but not the 
name itself. Exercise 6.3 demonstrates this.

 

E X E R C I S E  6 . 3

 

Renaming Ranges and Changing the Range Referred to by a Name

 

1.

 

Still inside the workbook you saved in the previous exercise, choose Insert �

 

 Name � 
Define.

2. Scroll through the list of names and click Month to select it. Once the name is selected, 
Excel shows in the Refers To box that the name refers to the range ‘2003 Top 
Sales’!$B$3:$E$14.

3. Click in the top box where it says Month and change it to MonthList. Notice you have no 
choice for Change or Edit. Click the Add button. Now we have two range names that refer 
to the same range.

4. With MonthList selected in the list, click in the Refers To box at the bottom to select that 
entry (if everything in that box is not highlighted, drag your mouse pointer across it), then 
drag to highlight cells A3:A14 on the worksheet.

5. When you release your mouse button, note that the name now refers to the absolute 
range $A$3:$A$14. Click OK to return to the worksheet.

6. Select cell B17 and double-click the name Product in the Formula bar to select it. Press F3 
to display the Paste Name box. Double-click MonthList in the list of names to add that to 
your formula. Press Enter. Your formula now refers to the correct cells and gives the cor-
rect result, 12.

7. Return to the Define Names dialog box by pressing Ctrl+F3. Select the Month name and 
click the Delete button to remove it from the range names. Click OK.

8. In the Name box dropdown list, you’ll see MonthList, but Month is no longer there.

9. Save the file to update it, and then close the file.
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There are a few methods for adding or changing a name in a formula, and you should try 
them all to find which one you prefer. Obviously, you can manually type the name into the for-
mula, but you can also choose Insert � Name � Paste or press F3 to select the name from the 
list. No way is the “right” way; just do what works best for you.

Now that you’ve mastered range names, it’s time to look at naming single cells and naming 
constant values. Cell names first.

Naming Cells as Bookmarks

Sometimes you don’t need a whole range named, but just one cell so that you can quickly jump 
to a specific location in your workbook. Or, if a cell contains a formula and you want that for-
mula inside a new formula, naming the cell can make your formula writing easier, without so 
much nesting. Named cells can be used like bookmarks in your workbook, and you can also 
reference named cells in formulas.

Since the process for naming a single cell and referencing this name in a formula is identical 
to naming ranges and referencing them in formulas, there’s no need to do that again. But let’s 
look at a specific advantage to naming cells as bookmarks. Exercise 6.4 shows you how to cre-
ate bookmarks in a workbook and how to list them in an index.

E X E R C I S E  6 . 4  

Using Named Cells as Bookmarks and a Name List as an Index

1. Open the file Exercise 6-4.xls and move to the January Sales sheet. Select cell A1, if it isn’t 
already selected, and note that Jan now appears in the Name box.

2. Click the Name box dropdown list. It contains names for the first six months of the year 
and the first two quarters. Names appear in the list in alphabetical order.

3. Select Mar from the list and Excel moves you to that sheet.

4. Click the July Sales sheet tab to move to that sheet. Select cell A1 and click the Name box. 
Type Jul and press Enter.

5. Repeat this process to name cell A1 on every sheet with names that are consistent with 
the names already in the Name box dropdown list. Also, name cell A1 on the Yearly 
Totals sheet Year1.

6. When you are done, you’ll have a bookmark for every sheet in the workbook. Insert a new 
sheet at the end and name it Wkbk Index, and then name cell A1 Index.

7. Use the Name box dropdown list to move to the January Sales sheet by clicking Jan.

8. On the January Sales sheet, name the range A3:E8 OriginalStores.

9. Move to the Wkbk Index sheet by choosing Index from the Name box dropdown list.

10. In cell A1, type Index of Range Names.
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The Paste List feature is especially handy when you have a large number of named ranges 
in a workbook and can’t always remember what range each name refers to. Notice how much 
easier it is to find specific data in the workbook using the bookmarks and index you created 
(see Figure 6.4). Let your imagination go wild here and think of ways you can use bookmarks 
and a pasted list to make parts of your workbook more accessible.

When you are done playing around, move on to the next section so you can learn one more 
way to use names.

F I G U R E 6 . 4 Using the Paste List feature creates an index of all names in a workbook.

11. In cell A2, type Name.

12. In cell B2, type Range.

13. Format cells A1, A2, and B2 as bold, Verdana, 12 point. Adjust column widths if necessary.

14. Select cell A3 and press the F3 key to bring up the Paste Name box.

15. Click the Paste List button. Excel pastes a list of all of the named ranges in column A, with 
the ranges they refer to in column B (as shown in Figure 6.4).

16. Save the file in your Chapter Six folder; name it Exercise 6.4A.xls and then close the file.

E X E R C I S E  6 . 4 ( c o n t i n u e d )
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Naming Constant Values

Think of this scenario: Your boss just returned from a sales conference and told you that he’s 
increasing the cost of all products in a certain department by 14.9822 percent. Now, you could 
choose each of these cells and manually multiply them by 114.9822 percent (which would give 
you the original cost at 100 percent plus the increase of 14.9822 percent), but what if you 
made a typo and accidentally typed 112.9822% one time? If you name 114.9822% as a con-
stant and then use that name in your formulas, you will greatly reduce your risk of error. In 
this case, you have a value that you need to use over and over in many formulas, but the value 
itself does not appear in any cell within your workbook. If you create a named constant, you 
can add it to many formulas easily.

Let’s take a look at how naming constant values reduces work for you by doing Exercise 6.5.

E X E R C I S E  6 . 5  

Using Constant Values to Easily and Accurately Update Formulas

1. Open a new blank workbook and type 100 in A1 and 200 in A2.

2. Select both cells and use the fill handle to drag the series down to cell A50. You now have 
a list of numbers from 100 to 5000.

3. Press Ctrl+F3 or choose Insert � Name � Define to bring up the Define Name dialog box.

4. In the box at the top, type increase. In the Refers To box at the bottom, remove the current 
entry, type 114.9822%, and click the Add button:

5. Once you click the Add button, Excel updates the Refers To box to show =1.149822, which 
is the decimal equivalent of 114.9822%. Click OK.

6. In cell B1, type this formula: =a1*increase. Once you press Enter, Excel returns the value 
114.9822, which is correct.

7. Drag the formula in B1, using the fill handle, down to B50 and see all values in A1 now 
show an increase of 14.9822%.

Now for the cool part … The boss returns from yet another sales conference and now 
says, “We need to change that percentage to 18.776%.”
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Constant values are the only names that won’t appear in the Name box drop-
down, because they are not tied to any cell and therefore are not used for nav-
igation. However, they will be included if you use the Paste List feature to 
create your list of names.

Once you feel you have an understanding of both relative and absolute cell references, as 
well as named ranges, it’s time to move on to the next section, which teaches you how to work 
with Lookup and Reference functions.

Using Lookup and Reference Functions
Lookup and Reference functions do exactly what their category name implies. Lookup func-
tions let you look up information in an array and return other information based on the criteria 
or parameters you supply. Reference functions let you cite information in another location and 
return that information to your spreadsheet. In basic English, that means you tell Excel, “Go 
here and find the information related to such-and-such.”

When you use Lookup functions that scan through a table array looking for something to 
return, by default Excel will assume your table array is sorted in ascending order by the col-
umn (or row) where your lookup value lives. The lookup value is simply the label or value you 
are looking up in the array. If your table array is not sorted, you must include one of the 
optional arguments in the function to tell Excel to ignore sorting and just find what you want 
returned.

Before we go any further, let me try to put this into real-life terms. Assume you have a sheet 
called Employee Info that lists all of your company’s employees, and on another sheet, you 
want to enter any employee’s ID number and have Excel fill in that employee’s name, address, 
and phone number. In essence, what you want to tell Excel is, “Choose the Employee Info 
sheet and find Employee #17 and return to me the information on that same row that applies 
to that employee number.” This is what a VLOOKUP function can quickly do for you.

As I mentioned in Chapter 5, the two most important advanced functions that you need to 
understand are the IF statement (covered in Chapter 5) and the VLOOKUP function. VLOOKUP 
is the most commonly used Lookup and Reference function, and HLOOKUP is simply a vari-
ation of the same type of function, so let’s start with them.

8. Press Ctrl+F3 and click the Increase name in the list. Click in the Refers To box, delete the 
current entry, type 118.776%, and click OK.

Bingo! Every price is updated!

9. Save the file in your Chapter Six folder and name it Exercise 6-5.xls. Close the file.

E X E R C I S E  6 . 5 ( c o n t i n u e d )
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The Lookup Functions

The VLOOKUP and HLOOKUP functions are handy ones to know when you want Excel to 
look up a value in one place and insert it in another. For example, let’s say you have a list 
of all of your customers on a sheet named Accounts and an invoice on another sheet named 
Invoice. When you type the customer’s account number on the Invoice sheet, you want Excel 
to fill in the name of the customer and their address (and this information is included for all 
customers on the Accounts sheet). A VLOOKUP or HLOOKUP will do this for you.

VLOOKUP simply means vertical lookup and HLOOKUP stands for horizontal lookup. So, 
if the information in your table array is organized in the most common way (column headers 
with the data listed below in vertical columns), you would use a VLOOKUP. If your data is 
organized with the headers on the left end of each row and the data listed horizontally across 
the rows, you would use an HLOOKUP.

Because most spreadsheets are set up with the data listed down the columns, let’s look at 
VLOOKUP first.

Using the VLOOKUP Function

When I first started working at a help desk and someone would call in with a VLOOKUP ques-
tion, I would shudder. The function totally intimidated me. Half the time, I would simply pass 
the call to another person in the help desk department who was an Excel guru, because I 
thought these questions were simply out of my realm. Then, on one occasion, I found I wanted 
to do something in a workbook of my own that actually required a VLOOKUP, so I decided to 
overcome my phobia and give it a shot. Bottom line is, once I actually used the function, it all 
made perfect sense to me and definitely eased my workload because the function automates so 
much. Now, I can do VLOOKUPs in my sleep and you should be able to handle them easily 
also, once you get through the exercise in this chapter.

A VLOOKUP function (see Figure 6.5) contains four arguments—three that are required 
and one that is optional—and is constructed like this: =VLOOKUP(lookup value, table array, 
column index number, optional reference to approximate or exact match).

F I G U R E 6 . 5 The VLOOKUP function includes three required arguments and one 
optional argument.
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Here’s a brief explanation of each of the arguments included in the VLOOKUP:
� The lookup value is what you are looking up in your table. This value must always be in 

the leftmost column of your table array.
� The table array is the name of your table.
� The column index number is the column holding the information you want returned from 

the table.
� The optional reference tells Excel whether you want the closest match found or an exact 

match to what you entered as the lookup value. (See Figure 6.5; notice that optional argu-
ment is not bold like the others.)

Try Exercise 6.6 to put all of this into action.

E X E R C I S E  6 . 6  

Using a VLOOKUP to Fill In an Invoice

1. Open the file Exercise 6-6.xls and look at the three sheets. The first sheet is an invoice, the 
second sheet lists all of this company’s customers with their information, and the third 
sheet lists all the products sold by this company.

2. Move to the Invoice sheet and select cell E7. It contains a formula to multiply the quantity 
of items purchased by the cost of the item. This formula is a relative formula that is 
repeated in cells E8:E14. Note that cell E15 also contains a formula, which simply adds all 
of the totals in cells E7:E14 to give a grand total.

Let’s add formulas to the cells where the customer and product information will appear 
when we type in the customer ID number and product numbers. But, first let’s name 
some ranges.

3. Move to the Accounts sheet, select the range A3:C7, and type customer in the Name box. 
Press Enter.

4. Move to the Inventory sheet, select A3:C7, and name it product. Remember to press 
Enter after typing an entry in the Name box or it won’t be committed.

Now, let’s make those formulas.

5. Move to the Invoice sheet and select Cell B4 and click the Insert Function button.

6. Choose Lookup and Reference as the function category, then scroll through the list and 
select VLOOKUP. Click OK.

7. In the Lookup_Value box, you’ll enter a reference to the cell that contains what you want 
looked up. On the Invoice, you will enter a Customer ID number in cell A4, so either type a4 
in the box or click cell A4 on the worksheet so that Excel puts the cell reference in the box 
for you.
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8. Press your Tab key to move to the Table_Array box. This is where you identify the table 
that contains the information you want inserted in cell B4. Remember we named that 
table, so type customer in that box, or press F3 and double-click “customer” in that list.

9. Press Tab to move to the Col_Index_Num box. This is where you identify the column that 
contains the information you want returned in cell B4. Columns are identified by num-
bers from left to right in the table array. In the customer table array, the customer’s name 
is in the second column, so type 2 in that box.

10. Press Tab to move to the Range_Lookup box. Note that the description below that box 
tells you that if you leave it empty, the default will be applied. However, the default is an 
approximate match and we want an exact match, so type false in that box. Make sure 
your box looks just like this one, then click OK:

11. Ignore the #N/A error for now (see Figure 6.6); we will deal with that later. Look at the for-
mula in the Formula bar and you’ll see =VLOOKUP(A4,customer,2,FALSE), which tells 
Excel to look in the customer table for an exact match of whatever you type in A4, and 
then return what’s in the second column of the customer table.

12. Try it out. Type c009 in cell A4 and press Enter. Martin Lewis is returned in cell B4, 
because his name is in the second column of the customer table on the row that contains 
C009 in column A. Select cell A4 again, type c004, and press Enter. Martin Lewis’s name 
is now replaced with Anita Smith.

13. Select cell C4. This is the cell where we want the customer’s address returned. This for-
mula will be exactly like the one in cell B4, but the column reference will point to the third 
column instead of the second because that’s where the address is in the customer table. 
Enter =vlookup(a4,customer,3,false) in cell C4 and press Enter.

E X E R C I S E  6 . 6 ( c o n t i n u e d )
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Nesting Functions to Control What Is Returned

Lookup functions are often entered in cells before the actual data appears in the cell identified 
as the lookup value, and therefore will produce the #N/A error you saw in step 11 of Exercise 6.6. 
#N/A means “not available,” since the formula is looking for a value but there’s nothing there. 
You will learn more about how to deal with formula errors in Chapter 8, but this particular 
error can be removed by nesting (inserting) your Lookup function inside an Information func-
tion, inside an IF statement (phew!).

When you have a formula error in a cell, Excel adds that little green triangle and an option 
button (as shown in Figure 6.6). However, in some cases, it’s not technically an error. The for-
mula is working correctly, but it can’t return a value until it has more information.

Many lookup formulas will return the #N/A error because of this, so Excel includes an 
Information function, ISNA, that will let you set up conditions to remove this error, using this 
function nested inside an IF statement. Figure 6.7 shows how bad this error can make your 
worksheet look. Imagine if you had this VLOOKUP function in 300 cells but only 5 of them 
are currently returning values. That would look pretty unprofessional. Hang onto your seat, 
and let’s take this function for a ride in Exercise 6.7.

14. Because we have c004 in cell A4, the address returned belongs to Anita Smith. Change c004 
in A4 to c003 and note that B4 and C4 update to show Mary Andrews’s name and address.

Now, let’s use the VLOOKUP function to enter the description and price of any item 
entered into A7.

15. Select cell C7 and use the Insert Function button to create a VLOOKUP to return the cor-
rect product description. The lookup value is A7, the table array is product, the column 
index number is 2, and the range lookup is false.

16. Select D7 and insert a VLOOKUP to find the price, which is in the third column (3) of the 
product table.

17. When you have both formulas in row 7, use their fill handles to drag them down to row 
14. (This is where those range names are so helpful. The ranges remain absolute and 
always point to the correct table array. However, the lookup value is relative and updates 
row by row as you drag it down.)

18. Look at the product numbers on the Inventory sheet and add some product numbers to 
cells A8:A14 and some quantities in column B on the Invoice sheet to be sure they work. 
You should see the correct product descriptions and prices, and the formulas in column D 
should total the orders for you.

19. Save the file in your Chapter Six folder and name it Exercise 6-6A.xls. Close the file and 
take a rest.

E X E R C I S E  6 . 6 ( c o n t i n u e d )
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F I G U R E 6 . 6 When lookup formulas refer to cells that are empty, you will get the #N/A error.

F I G U R E 6 . 7 Too many errors in a worksheet detract from the professional quality you 
want displayed.
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Let’s see if I can get your head wrapped around this formula. It’s a whopper, but once you 
understand it, it should make more sense to you.

When you nest functions, Excel performs the deepest nested function first, then works its 
way outward; so, looking at the formula in Exercise 6.7, you will see the following:
� The first thing Excel does is perform the first VLOOKUP (since that’s the one that is 

nested deepest).
� Then it performs the ISNA function on the result of the VLOOKUP to see whether the 

VLOOKUP gave a #N/A error. The ISNA function returns a value of TRUE if it sees the 
#N/A error and a value of FALSE if it doesn’t.

� Then Excel performs the IF function on the result of the ISNA function. If it sees a TRUE, 
it returns nothing (which is what the "" tells it). If it is FALSE, it returns the result of the 
VLOOKUP function, which is what the last VLOOKUP function is telling it to do if the 
value is FALSE.

Getting the hang of it? What this formula says is, “If this VLOOKUP function returns #N/A, 
return nothing; if it does not return #N/A, then return the value produced by the VLOOKUP 
function in the first place.” Remember the IF statement requires three arguments: a logical test, 
then a value if true, then a value if false. So, in this case, the logical test is, “Does the first 
VLOOKUP return a value of #N/A?”; the value if that condition is true is “leave the cell 
empty” (""); the value if that condition is false is “give me the result of the VLOOKUP.”

Try constructing the same formula in cell D7 in the Exercise 6-7.xls workbook and see if 
you can get it to work. The only way to learn this stuff is to keep playing around with it until 
the light bulb in your head is illuminated. When you have finished experimenting, close the 
file, but don’t save it.

E X E R C I S E  6 . 7

Nesting Three Functions to Remove the #N/A Error

1. Open Exercise 6-6.xls that you saved in the previous exercise. If you did not save it, 
extract it from the zipped file for this chapter. Move to the Invoice sheet and select cell C7, 
which includes one of the VLOOKUP formulas that will produce the #N/A error if the cor-
responding cell in column A is empty.

2. Enter this formula into C7:
 =IF(ISNA(VLOOKUP(A7,product,2,FALSE)),”“,(VLOOKUP(A7,product,2,FALSE)))

3. Grab C7 by the fill handle and drag it down to C14. Note that all of the #N/A errors are 
gone. If they are not gone, or you get a different error, you probably didn’t type the for-
mula correctly, so do it again, being sure to include all commas, parentheses, quotation 
marks, and so forth.

4. Save the file in your Chapter Six folder and name it Exercise 6-7.xls, then leave the file 
open for the following discussion.
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Using the HLOOKUP Function

Because most workbooks are set up with the labels at the tops of the columns and the values 
listed below them, HLOOKUP functions are not used nearly as much as VLOOKUPs in the 
real world. Nevertheless, it’s still an important feature you need to know about. Let’s learn 
more by doing Exercise 6.8.

E X E R C I S E  6 . 8

Transposing Data and Using an HLOOKUP

1. Open the file Exercise 6-6.xls again. This is the file that includes the data you used to create 
the VLOOKUP function previously, but it doesn’t include the formulas or the range names 
you created.

2. To use the HLOOKUP, we first need to change our table arrays so they are in a horizontal 
layout instead of a vertical layout. Move to the Accounts sheet, select the range A2:C7, 
and copy it.

3. Select cell A9 and choose Edit � Paste Special. Select the Transpose checkbox and click 
OK. This puts the data in a vertical layout.

4. Press Esc to remove the marquee and, with this range still selected, click into the Name 
box, name it customer, and press Enter. Note that the customers’ names are in the sec-
ond row of this table array.

5. Move to the Invoice sheet and select cell B4. Click the Insert Function button and choose 
HLOOKUP from the Lookup And Reference category, then click OK.

6. The information you need to enter follows:

� The Lookup value is A4 (same as before, because this is where you would type the 
Customer ID Number in the Invoice).

� The Table array is customer (either type it in or press F3 and choose it from the result-
ing list).

� The Row index number is 2 (since the customer names are in the second row of the 
table array).

� The Range lookup is still false (we still want an exact match).

7. Click OK to return to the worksheet and type c002 in cell A4. Excel returns John Madison 
in cell B4.

8. Save the file in your Chapter Six folder and name it Exercise 6-8.xls. Close the file.
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As you can see, the HLOOKUP function is almost identical to the VLOOKUP function, 
except turned on its side! Once you understand how to use these two lookup functions, try 
some others, using the Insert Function dialog box. I assure you these are the most difficult; if 
you can handle these functions, the others should not present any problems for you. However, 
it’s very helpful for you to be able to use all the functions in the Lookup and Reference cate-
gory, so let’s look at the Reference functions next.

The Reference Functions

Reference functions are used to reference data in another location (HYPERLINK function), 
pinpoint the location of data (COLUMN function), or return information in a different layout 
(TRANSPOSE function).

Personally, I rarely use Reference functions because most of what they do can be accom-
plished more easily using one of Excel’s built-in utilities. A good example is the TRANSPOSE 

When to Use a TRUE Argument as a Range Lookup

In most cases, you will always use FALSE as the last argument in an HLOOKUP or a VLOOKUP 
formula. However, sometimes you really don’t want an exact match, but would prefer a close 
match. Using TRUE as your final argument requires that your data be sorted in ascending 
order, and Excel will go through your table looking for a match. If it gets past the point where 
the match should have shown up if sorted in ascending order, Excel will back up and grab the 
previous one. Confusing? Well, here’s a story that makes sense of this:

I’m a teacher and I have a lot of worksheets that calculate grades for my students and return 
numerical values. However, I need the letter grade that corresponds to that number. So, I 
have a lookup table that lists the grade numbers in column A, sorted in ascending order, and 
the corresponding letters in column B. However, I don’t need a separate row for each number. 
I only need a row for the lowest number that corresponds to the letter. So, in my lookup table, 
I have 0 in A1 and F in B1; 60 in A2 and D in B2; 70 in A3 and C in B3; 80 in A4 and B in B4; and 
90 in A5, and A in B5. My school bases its grades on A being equal to 90 or above; B equal to 
80 to 89; C equal to 70 to 79; D equal to 60 to 69; and F equal to 59 or less.

I named the lookup table range “grades” and my formula is =VLOOKUP(A1,grades,2). 
Remember that TRUE is what Excel assumes if you leave the fourth argument blank. Now, for 
example, I type in the number grade 76 and the VLOOKUP searches the table, starting with 
zero, and when it gets to 80 and sees there’s no exact match, it backs down to 70 and returns 
a C as the letter grade.

This is one case where a FALSE argument would not be appropriate. If you want to see this 
formula in action, extract the file RealWorldGradeBook.xls from the zipped file for this chapter.
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function. All this function does is the same thing we accomplished in the previous exercise 
using the Paste Special � Transpose command. The only time I’ve ever had a need to use one 
of these Reference functions was when I had a formula with about six nested levels (and that 
is way outside the realm of anything you would probably need to worry about!). But, I rec-
ommend you look through all of the Lookup and Reference functions anyway and be familiar 
with what they do; then you can just use the Insert Function dialog box to create a formula if 
one of them comes up in your work. Also, remember that you can use the Insert Function dia-
log box during the MOS Exam, so the most important thing to know is how to use it if one 
of the reference functions pops up during the exam.

However, just so we don’t skip these entirely, here’s Exercise 6.9, which teaches you how 
to use the HYPERLINK function. If you want to show a link to another workbook in a cell, 
you can use the Insert Hyperlink button on the Standard toolbar (as you learned in Chapter 4, 
“Editing Tools, Comments, and Hyperlinks”), or, as an alternative, you can use the HYPER-
LINK function, which does the same thing.

As you can see, the HYPERLINK function does nothing more than create a hyperlink the 
same as when you use the Insert Hyperlink button. But, at least, with the Insert Hyperlink dia-
log box, you can browse to find the file you want to link to. With the HYPERLINK function, 
you must manually type in the full path to that file if it isn’t located in the same folder as the 
file you are working in, so I find this function pretty useless. I feel the same way about most 
of the Reference functions, but you should at least know what each one does, in case one of 
them shows up on your MOS Exam.

Only one more category of functions to go and we will have covered all of the function cat-
egories required in the MOS Objectives. Take a deep breath, and let’s move on to the database 
functions and features.

E X E R C I S E  6 . 9

The HYPERLINK Function

1. Open a new blank workbook and type Open this file if needed: in cell A1.

2. Save the file into your Lesson Six folder and name it Exercise 6-9.xls. (It is important that 
you save it in the same folder that contains your Exercise 6-8.xls file. For simplicity’s sake, this 
will avoid your having to type a full path to the location of the file you want hyperlinked.)

3. Press Enter and in cell A2, click the Insert Function button. Choose HYPERLINK from the 
Lookup and Reference category. Click OK.

4. In the Link location box, type Exercise 6-8.xls.

5. In the Friendly name box, type My HLOOKUP Workbook.

6. Click OK to return to the worksheet. Now you have a hyperlink that will open Exercise 6-8.xls 
when clicked. Click the link to check it out.

7. Save the Exercise 6-9.xls file to update it, and close both files.
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Using Database Functions and Features
Those of you who are familiar with Microsoft Access might be surprised to learn that Excel 
includes some database utilities as well. The main difference between the two programs is that 
Access lets you build relational databases, in which you have relationships between multiple 
tables, whereas Excel can build only flat databases, in which the information is contained all 
in one table. So, if all you want is a simple database of your client information or your inven-
tory, for example, Excel can do an adequate job. However, if you need a database that allows you 
to draw related data from more than one table, you should use a relational database program.

Before I can teach you how to use the Database functions, I will show you how to set up 
and use a flat database in Excel.

Excel’s Database Features

Databases in Excel are based on list ranges. List ranges are similar to named ranges, but include 
some additional database functionality. The significant difference between named ranges and 
list ranges is when you create a list Excel treats your column headings as fields and your rows 
as records. Fields are the components that are the same in every record but display unique data 
for each record. For example, if State is one of the column headers in your list, State would be 
the field name and that field would appear in every record; however, the content of that field 
would be specific to the record in the row in which it appears. You can just think of columns 
as fields and rows as records.

All of Excel’s database features rely on named ranges or list ranges. Since I covered named 
ranges earlier, let’s look at list ranges next. You can create a list, then add data to it the same 
way you add data to any worksheet; or you can use a form to enter and edit data. Let’s look 
at creating a simple list and an accompanying form.

Using List Ranges and Forms

A list range is another form of table array and, though list ranges may look and act like named 
ranges, they have these unique differences:
� List ranges are not automatically named when you create them.
� Creating a list range adds AutoFilter buttons at the top of every column.
� Lists can be manipulated using the List toolbar.
� When you format a table of data as a list range, Excel treats it like a database and uses the 

column headers as field names and each row of data as a unique record.

It is never really necessary to use the List command to create a database table array. All of 
the database functions work just as well with a named range and, certainly, AutoFilters can 
be added manually to any table array. However, let’s create a simple list so you can see how 
they work. Check out Exercise 6.10.
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Anyone who uses database software knows that databases are based on tables, which hold 
the data, and forms, which provide a single-record view of each record for ease of editing and 
searching for specific records. The list in Excel is comparable to a table in Access or another 
database program, and Excel also includes a form, which is accessible from the List toolbar. Let’s 
use Exercise 6.11 to learn how to use forms to enter and edit data and find data in your list.

E X E R C I S E  6 . 1 0

Creating a List Range

1. Open the file Exercise 6-10.xls. This is a simple customer list.

2. Select any cell within the data and choose Data � List � Create List. Excel opens this 
dialog box:

3. Behind this box, you should see a marquee surrounding your data, and it includes your 
header row. Be sure the My List Has Headers option is selected and click OK.

4. Notice that AutoFilter dropdown buttons have been added, the list is shaded, and you 
have the List toolbar on your screen. (If you don’t see the List toolbar, choose View � 
Toolbars � List.) Also, notice the blue asterisk in cell A7; this is a placeholder where a new 
record can be added to the list.

5. Click in any cell outside of the list, and you’ll see that the toolbar and AutoFilter buttons 
are removed from view and the list is no longer highlighted.

6. Select a cell inside the list again and all the list features return.

7. Save the file in your Chapter Six folder and name it Exercise 6-11.xls. Leave the file open 
for the next exercise.

E X E R C I S E  6 . 1 1  

Adding, Changing, and Finding Data in a List Using a Form

1. Still inside the file you saved in the previous exercise, make sure your list is selected, then 
click the List button on the List toolbar and choose Form.

2. The form that appears says “Accounts” in the title bar because Accounts is the name of 
the sheet. You can have only one list on a sheet. The form shows the information in all 
of the fields for the first record. Click Find Next to move to the second record in the list.
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Another feature that is common to all database programs is a query, which pulls informa-
tion from a table based on criteria. In Excel, advanced filters are used for this purpose, so let’s 
look at them next.

Selecting Data from a List Using Advanced Filters

In Chapter 3, you learned how to sort data and use AutoFilters. Both of these features are com-
monly used in databases. I find, in most cases, that I can filter my data the way I want by using 
AutoFilters. However, you can set up a filter page using advanced filters. First, you need to set 
up a criteria range, where you specify the conditions for your filter; then you can produce an 
“And” filter by typing the criteria on one row, or an “Or” criteria by typing on multiple rows. 
When you use terms like criteria and database as range names, Excel automatically detects 
them as database features. Advanced filters also allow you to run a filter and produce the 
results in a new output range on the sheet. Let’s use Exercise 6.12 to explore the database fil-
tering features.

3. Click Find Prev to move back to the first record. Drag the form by its title bar so you can 
see the first record in the worksheet behind the form. Inside the form, change the address 
to 12 Century Street and press Enter. Notice that the information on the worksheet is 
updated, and you move to the next form in the Form box.

4. Click the New button, and Excel opens a blank form. In the Account ID box, type C007; 
press Tab and type Williams; press Tab and type Harry; press Tab and type 12 Bedford 

Ave.; press Tab, type Smallville; press Tab, type PA; and press Tab and type 11911. 
Press Enter, and Excel adds that record to the list behind the form and opens a new 
blank form.

5. Use the scrollbar in the middle of the form to scroll back to the first record. This is the 
record for John Madison, who also lives in PA. Click the Criteria button. A blank form 
appears. Type PA in the State field box, and then click Find Next. You are taken to Harry 
Williams’s record. Click Find Prev and you go back to John Madison’s record.

6. Click the Criteria button again, then click the Clear button. In the Last Name box, type 
>d and click Find Next. It takes you to the record for Martin Lewis because that is the 
first record where the last name is greater than D. Click Next until you’ve seen all the 
records.

7. Return to the record for Martin Lewis and click the Delete button. Click OK when the 
delete warning appears. Note that the record no longer appears in the Form box or in the 
list on the worksheet.

8. Click the Close button to close the form and save the file to update it. Close the file.

E X E R C I S E  6 . 1 1 ( c o n t i n u e d )
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E X E R C I S E  6 . 1 2  

Creating And and Or Filters

1. Open the file Exercise 6-12.xls. The Database sheet shows employee information pertain-
ing to department assignments, years employed, salary, etc. Copy the range A1:H1 on 
the Database sheet and paste it at the top of the Criteria sheet. Adjust column widths and 
row heights, if necessary.

2. Select the range A1:H2 on the Criteria sheet. (Note that you are selecting the data in row 1 
and one blank row below that.) Click in the Name box and name this range Criteria. Press 
Enter.

3. In cell D2 on the Criteria sheet, type sales and press Enter.

4. Move to the Database sheet. Select the range A1:F29 and name it Database, remember-
ing to press Enter afterward.

5. Click anywhere within the database range and choose Data � Filter � Advanced Filter. 
Because you used the terms database and criteria to name your ranges, Excel recognizes 
them as the List range and Criteria range.

6. Make sure Filter The List, In Place is selected and click OK. Excel applies the filter based 
on the criteria you entered on the Criteria sheet and shows only the employees in the 
Sales department.

Now let’s do an “And” filter:

7. Move back to the Criteria sheet and type >6 in cell E2 to find the employees in the Sales 
department who have been employed more than six years. Press Enter.

8. Return to the Database sheet and run the advanced filter again, exactly like you did in 
steps 5 and 6 earlier. This now applies the “And” criteria.

Let’s try one more: an “Or” filter that produces the results in a new location on the sheet:

9. Copy the field names (A1:F1) on the Database sheet, then select cell A31 and issue the 
Paste command. (Remember to press Esc to remove the marquee if necessary.)
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Excel’s database features aren’t my favorite. I find them inadequate. For example, when 
you filter a list to a new location, Excel will not allow you to use a different sheet as your loca-
tion. You must place the output on the same sheet as the list range. However, in most cases, 
you will be adding data to the list range constantly, so I recommend that, after you’ve run the 
filter, you cut that data and paste it onto a new sheet. That way, you will be able to add data 
to the bottom of your list range without constantly inserting new rows.

10. Select A31:F31 and name it results. You need to name only the header row in the output 
range; Excel will know to enter all of the data that meets the criteria below this row.

11. Move to the Criteria sheet and delete the >6 that is in E2 (however, leave sales in the 
Department field).

12. As I said previously, “Or” criteria must be entered on separate rows, so we need to add 
a row to the criteria range. Press Ctrl+F3 to bring up the Define Name dialog box. Select 
Criteria in the list and change the Refers To value to include the third row (simply change 
the 2 in $H$2 to a 3). Click OK. (You can include as many rows as you want in your criteria 
range, based on the number of “Or” criteria you need.)

13. Select Criteria from the Name Box to be sure it is selecting the correct range. Then, select 
cell F3, type >60000, and press Enter.

14. Move to the Database sheet and choose Data � Filter � Advanced Filter.

15. This time, select Copy To Another Location. Then, click in the Copy To box and either type 
results or press F3 and choose results from the list by double-clicking on it. Your filtered 
list appears below the results output range.

16. Save the file in your Chapter Six folder and name it Exercise 6-12A.xls and close the file.

A Realistic Use of Advanced Filters

Even though I feel the database features in Excel aren’t helpful for my day-to-day needs, I did 
have a situation where the advanced filters were actually quite useful.

I was called into a company because they had a huge Excel file that was filled with duplicates 
and they wanted me to help them clean it up. I think they assumed this would be a big deal 
because they did hire me for the whole day and this was the only thing they wanted done.

I asked them one question: “Are these duplicates exact duplicates?”

E X E R C I S E  6 . 1 2 ( c o n t i n u e d )
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So, now that you’ve got enough experience with the database features, let’s look at a couple 
database functions.

The Database Functions

Database functions are simply mathematic and statistical functions that pull data from spec-
ified fields, based on conditions you supply. All of the database function names begin with D, 
and they use the same three arguments: database, field, and criteria (see Figure 6.8). For 
example, DSUM searches your database and finds the field you specify, then totals that field 
from every record that meets the criteria you set. DAVERAGE does the same thing, but finds 
you the mean instead of the sum; DMIN finds the lowest value based on your criteria; DGET 
pulls one record that meets the criteria you specify; and so forth. Check out the Insert Function 
dialog box to see the other functions in the Database category.

F I G U R E 6 . 8 All database functions use the same three arguments.

They replied, “Yes, they are exactly the same.”

That was all I needed to know. I quickly applied an advanced filter (using the procedure described 
in Exercise 6.12, but with no criteria) and chose to filter the list in place. I also selected the 
Unique Records Only option. Excel proceeded to reproduce all the data (because no criteria 
was applied as a filter) and remove all of the duplicates (because I chose Unique Records 
Only). And, bang! All exact duplicates were removed in about 10 seconds.

The company was so happy, they paid me for the whole day and I left. But from that point on, 
when they had another problem, they always asked first, “How long do you think this will take?”

Granted, this will work only if the rows are exactly the same—meaning if every field is the 
same in any two records, only one will be included in the filter. But, when you truly do have 
exact duplicates, this is the fastest way I know of to remove them.
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Let’s try a couple database functions so you get the picture: DCOUNTA, which searches for 
nonblank cells in a field; and DMAX, which searches for the highest value in a field. Once you 
can do a couple of these, I’m sure you will be able to figure out how to do them all. Give Exer-
cise 6.13 a try.

E X E R C I S E  6 . 1 3

Using DCOUNTA and DMAX

1. Open the file Exercise 6-12.xls. This is the file you used for the last exercise, but it doesn’t 
have the filters you applied in that exercise. Change the Criteria sheet’s name to Statistics.

2. On the Statistics sheet, in cell A1, type Number of Employees, then press Alt+Enter and 
type in the Sales Dept and press Enter. Adjust the column width to fit the content.

3. Move to the Database sheet, select all of the data, and name it database.

4. Copy A1:F1 on the Database sheet, then move to the Statistics sheet and paste it in cell A10.

5. Type sales in cell D11 on the Statistics sheet. This is the criterion you are setting up for 
the formula.

6. Select cell B1 and click the Insert Function button. Choose Database as the category and 
DCOUNTA as the function and then click OK. (Like the COUNT and COUNTA functions, 
DCOUNT counts cells with numbers and DCOUNTA counts cells that hold any value.)

7. When the box appears, make sure your insertion point is flashing in the Database box 
and press F3; then double-click database.

8. Press Tab to move to the Field box and type department.

9. Press Tab to move to the Criteria box, type a10:f11, and click OK. (A10:F11 are the cells 
that hold the field name and criteria.)

10. The result you get is 10, which is the number of employees in the Sales department.

11. In A2, type Highest Paid Employee and press the → key to move to B2.

12. Click the Insert Function button and select DMAX from the list of Database functions. Click OK.

13. In the Database box, type database. Press Tab and, in the Field box, type salary. Press 
Tab and, with the insertion point in the Criteria box, click and drag to select F10:F11 on 
the worksheet so it is entered in this box. Click OK. Because there is nothing in F11, the 
DMAX function searches all records and returns 96000, which is the largest number in the 
Salary field.

14. Save the file in your Chapter Six folder and name it Exercise 6-13.xls. Close the file.
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Make sure you are clear as to what each Database function does. Use the Insert Function 
dialog box to examine the list of Database functions. Since they all use the same syntax, as long 
as you know what they do, you will have no problem constructing the formulas exactly the 
same way we did in Exercise 6.13. When you are comfortable with these functions, proceed 
to the next section, which covers the rest of the function categories.

More Functions
Though the MOS Objectives specifically mention some function categories, the Text, Math & 
Trig, and Information functions are not identified in the objectives by name. However, there 
is an objective that says you must know how to “Insert and modify formulas,” which, in my 
opinion, could include any function. Also, these three categories include some helpful func-
tions that make file cleanup and consistency much more easily accomplished, so I feel they are 
important to mention. Let’s start with the Text functions.

Text Functions

Text functions allow you to change text characteristics in cells. For example, the LOWER, 
UPPER, and PROPER functions will lowercase, uppercase, or apply title case to any cell. The 
syntax is simple: =LOWER(A1) or =UPPER(A1). Note that these functions cannot be applied 
to a range, but only to one cell at a time. So you typically do this by adding a new empty col-
umn to the right of the column you want to change case in, then putting the formula in the top 
cell and dragging it down the new column with the fill handle, and finally deleting the original 
column. It sure takes less time to do this than to retype the whole worksheet. Try these func-
tions out to be sure you understand them.

Another handy Text function is the CONCATENATE function, which can be applied using 
the function name (use the Insert Function box to see how this is done) or, more easily, by simply 
separating cell references or text with ampersands (&). If you use cell references, you can sim-
ply type them in the formula or click on the cells to add them to the formula; if you use actual 
text, you must enclose it in quotation marks. Let’s say you have two columns, which show first 
and last names, and you want them combined into one column. Assume column A contains 
first names and column B holds the last names, beginning in row 2. In C2 you can enter this 
simple formula: =A2&" "&B2 (note the space between the quotation marks). Then just use 
the fill handle to drag that down column C. This formula says, “Return what’s in cell A2, then 
insert a space, then return what’s in B2.” If you used the CONCATENATE function, the for-
mula would look like this: =CONCATENATE(A2," ",B2). Or, maybe you want last name, 
first name; if so, the formula would be =B2&", "&A2 or =CONCATENATE(B2,", ",A2). 
Again, note the space after the comma, inside the quotation marks.

Text functions are helpful when you need to clean up a messy or poorly constructed file.
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Math & Trig Functions

The Math & Trig functions range from the very simple mathematic functions like SUM, which 
we covered completely in Chapter 5, up to intense trigonometry functions that calculate things 
like hyperbolic sines. Don’t worry! Unless you are a physicist, you shouldn’t have to know any-
thing as complicated as using a hyperbolic sine. However, you may have a need to round off 
numbers, so let me tell you about the ROUND, ROUNDUP, and ROUNDDOWN functions.

The ROUND function will round a number up if it’s 5 or higher and down if it’s less 
than 5. The ROUNDUP function will always round the number up, no matter if it’s less than 
or greater than 5. The ROUNDDOWN function does the opposite and always rounds down. 
In these functions, you need to specify the number of digits you want it rounded to. A positive 
number of digits will round to the right of the decimal point in any number; a negative number 
rounds what’s to the left of the decimal point; and a zero rounds to the nearest integer. The 
syntax is =ROUND(A1,2) or =ROUNDUP(A1,-1). The best way to see how these various 
rounding functions work is to try them, so use the Insert Function button and do that.

Another commonly used Math & Trig function that is similar to the rounding ones is the INT 
function, which simply removes anything after a decimal point—which means 4506.76992 
would become 4506. The syntax is simply =INT(A1).

Depending on your needs, you can study the Math & Trig functions that apply for you. 
However, I seriously doubt you will ever see an advanced trig function on your MOS Exam, 
so you should concentrate more on the Math functions than the Trig ones.

Information Functions

In an earlier section in this chapter, when I showed you how to remove the errors from a 
VLOOKUP function, we used an Information function (ISNA). Information functions simply 
give you information about the value in a cell. Like the ISNA function, most of them return 
TRUE or FALSE only if a condition is met or not met; this is why they are so valuable nested 
inside IF statements—all an IF statement is looking for is whether the condition is true or false.

As we saw previously, the ISNA function returns TRUE if the cell contains a #N/A error 
and FALSE if it does not. There’s a similar Information function called ISERROR, which 
returns TRUE if there is any error in the cell; ISERR will return TRUE if there’s any error other 
than the #N/A error.

Some other Information functions that return TRUE or FALSE are ISBLANK, which 
returns TRUE if the cell is empty, and ISLOGICAL, which actually looks for TRUE or FALSE 
and returns TRUE if either of them appear in the cell. The syntax for these functions is simple: 
=ISERR(A1) or =ISBLANK(D5).

Other Information functions give you cell content, file, or computer information. An example 
is the INFO function. If you use the Insert Function button to use these functions, when you 
get to the Arguments dialog box, you can click the Help On This Function link to see the argu-
ments. The INFO function has many choices. One option is osversion; using this as your 
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argument returns the version of the operating system installed on your computer. The syntax 
is =INFO(“osversion”).

Play around in the Insert Function box and experiment with the different Information func-
tions to get a feel for how they work.

Most formulas can also point to cells on different worksheets or even in dif-
ferent workbooks. Once you understand how they work, Chapter 7 will show 
you how to use them with 3D references to other locations.

Now, let’s explore one last function type before we call it quits on this chapter. Read on to 
learn about array-entered formulas, which are a hidden treasure in Excel.

Array-Entered Formulas
AFs (array-entered formulas) are a feature of Excel that is not covered well in Excel’s help 
menus. Actually, until Excel 2002, they were hardly mentioned there at all. And the books I 
have seen that address AFs would intimidate the average user into believing that using them 
isn’t something they should even attempt. So, my intention here is to tell you what AFs can do 
and how to use them in the simplest way possible. Once you understand the basics of how they 
work, you can then try them on more-complicated data.

Though they are not specifically mentioned in the MOS Objectives, AFs are a wonderful 
alternative to the Database functions and can often make achieving your goal much quicker 
than creating all those list and criteria ranges. Remember that the MOS Exam does not score 
you on the steps you take to complete something, but it does score you on the result, and timing 
is of the essence. So if you can grasp this array concept, you will be better equipped for the test.

Constructing Array-Entered Formulas

First of all, why would we want to use AFs? Think of this situation: Let’s say you have a list 
of numbers in column A and you want a sum or a count of them based on two different cri-
teria. You can use a SUMIF or a COUNTIF formula if you just have one criterion, but if you 
have more than one, you will need to use an AF.

There is a significant difference between AFs and other formulas. All AFs are displayed with 
curly brackets—{ }—around them. This is how Excel identifies them as AFs.

Using arrays, you do not type in the curly brackets! These are added when 
you press Ctrl+Shift+Enter, and you must press Ctrl+Shift+Enter every time 
you enter or change an AF. If you manually type in the curly brackets, Excel 
does not recognize them as being part of a formula.
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AFs are all about ones and zeroes. When you use AFs, Excel looks into each area nested in 
parentheses and calculates that first to see if it returns a TRUE or FALSE; then it converts 
TRUEs to 1s and FALSEs to 0s and adds them up to supply a value to that argument before 
completing the rest of the calculations in the formula. This is the basis of AFs, so it’s important 
that you understand this.

If you want to consider yourself a true advanced Excel user, give Exercise 6.14 a try. Array-
entered formulas are something you might find useful. So, if you’re willing, let’s try it together 
with these samples.

E X E R C I S E  6 . 1 4

Building Array-Entered Formulas

1. Open the file Exercise 6.14.xls. This is a simple list of salaries and corresponding Depart-
ment codes.

2. Select cell A13 and type this formula: =SUMIF(A2:A11,”>500”). Press Enter and the result 
is 9500. This formula sums all the numbers in the range that are greater than 500.

3. In cell A14, type this formula: =COUNTIF(A2:A11,”>500”). Press Enter and the result is 5. 
This formula counts all of the numbers in the range that are greater than 500.

But, let’s say you need two criteria applied. The SUMIF and COUNTIF formulas are lim-
ited here. If you want a sum of all of the numbers greater than 500 and less than 300, an 
AF comes in really handy.

4. In cell A15, type this formula, and when you have finished typing, press Ctrl+Shift+Enter: 
=SUM((A2:A11>500)*(A2:A11))+SUM((A2:A11<300)*(A2:A11))

You will get 9800 as a result, and this is correct. And, if you look at the formula in 
the Formula bar at the top of your spreadsheet, you will see that Excel added the curly 
brackets to the formula, which now looks like this: 
{=SUM((A2:A11>500)*(A2:A11))+SUM((A2:A11<300)*(A2:A11))}

So, that’s how to enter a simple sum AF. Now, what if we wanted a count instead of a 
sum? That’s easy to fix. All you need to do is replace with a one (1) the part of the formula 
that multiplies the cells by themselves.

5. In cell A16, enter this formula and press Ctrl+Shift+Enter: 
=SUM((A2:A11>500)*1)+SUM((A2:A11<300)*1)

The result is 7. If it’s not, recheck your formula.

6. Save the file in your Chapter Six folder and name it Exercise 6-14A.xls. Leave it open if 
you want to continue with a few more AFs.
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Using Array-Entered Formulas

Another scenario where an AF comes in handy: Let’s say you want to sum or count the contents 
of column A based on something in column B. Here are some formulas you can use to see how 
this works. You can try the following formulas yourself or extract the copy of Exercise 6-14A.xls 
from the zipped file for this chapter, which includes all of them. But, remember, if you click 
in the Formula bar or enter edit mode in any way in a cell that includes an AF, you must press 
Ctrl+Shift+Enter to leave the cell, or the formula will no longer work.

Total salaries for the people in Dept. A: Type in =SUM((A2:A11)*(B2:B11="A")) and 
press Ctrl+Shift+Enter. The result should be 7600.

Count of all people in Dept. C who earn less than $1,000: Type in 
=SUM((A2:A11<1000)*(B2:B11="C"))*1 and press Ctrl+Shift+Enter. The result should be 2.

Average salary for people who make more than $1,000: Type in 
=AVERAGE(IF(A2:A11>1000,A2:A11,"")) and press Ctrl+Shift+Enter. The result should 
be 2663.3.

Getting the hang of it? I know it’s a lot to grasp, but I recommend you think of various sit-
uations where you will in fact need an AF and will wish you knew how to do this. The best 
way to learn this stuff is to play with it.

Summary
Most functions include cell references, so it is imperative that you understand how these ref-
erences work, as well as how to enter them in formulas.

Cell references in formulas can be absolute, meaning that they always refer to the same cell, 
or relative, meaning that they will update when copied to refer to a new cell relative to where 
they are pasted. The column and row references can both be absolute or relative, or you can 
mix references, making the column absolute and the row relative, or vice versa. Absolute ref-
erences are denoted by dollar signs within the cell address. The F4 key is an easy shortcut to 
use when changing reference types.

Naming ranges or cells ensures that the reference will always be absolute. Naming can also 
be used to create bookmarks within a workbook so areas are quickly accessed. You can name 
a range by selecting it and giving it a name, and you can do the same with a single cell. In addi-
tion, you can name a constant value that you want to use many times in formulas, and then 
use the name instead of the value as a reference. The Insert � Name command gives you many 
options for naming.

You can access range names from the Name box when you simply want to select that range 
and move there. You can also access them from the Paste Name box when you want to add 
them to a formula. Keyboard shortcuts like F3 and Ctrl+F3 make these processes even easier. 
You can also use the Paste Name box to paste a list of all of your named ranges into any loca-
tion in your workbook.
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The Lookup and Reference functions are necessary functions to understand when you want 
to include data from a table array or point to data in another location. The VLOOKUP func-
tion is probably one of the least understood and most needed functions you will ever come 
across, so it is an important one to understand.

Database features and functions allow you to use Excel to create flat databases. Though 
most people prefer to use a relational database program for their database needs, you very well 
may encounter some of these utilities and functions during your MOS Exam, so it is important 
that you understand how to use them. Excel’s database features let you filter data, sort data, 
create database list ranges, and use forms to enter and edit data and search your database. 
Excel also includes some database functions that allow you to perform statistical and mathe-
matical calculations based on criteria you supply.

Additional functions that are helpful in Excel are the Text, Math & Trig, and Information 
functions. Text functions perform text operations on specified cells, like changing the text case 
or combining text from multiple cells into one cell. Math & Trig functions range from simple 
mathematical calculations, like summing numbers and rounding them off, to advance trigo-
nometry calculations. Information functions give you information about the state of a cell, file, 
or your computer.

Exam Essentials
Understand all types of cell references. Be sure you can differentiate between absolute and 
relative references and know when it is appropriate to use each type.

Be able to create and use named ranges, cells, and constants. Know how to use all the com-
mands in the Insert � Name submenu. Be sure you understand how to use names as book-
marks, as well as how to insert them into formulas as references. Also, know how to delete 
names and edit the range they refer to.

Know what all the Lookup and Reference functions do. Spend some time in the Insert Func-
tion box and be sure you understand the basic idea behind all of the Lookup and Reference 
functions. Know how to use the Arguments box to add the correct arguments to the functions.

Understand the order of nested functions. Know which function is applied first when func-
tions are nested. Be sure you understand the order in which Excel calculates them.

Be familiar with all of the Database features and functions. Know the difference between a 
list range and a named range and how they are used. Understand how to work with forms and 
filters. Recognize when a database function is needed instead of a regular mathematical or sta-
tistical function.

Be aware of every function within the function categories. Don’t skip any functions. At 
least know what each one does and how to use the Insert Function dialog box to create them. 
You should be proficient in formula and function construction.
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Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the file MOS Scenarios Ch6.xls from the 
zipped file for this chapter and open it before you begin.

 

MOS Scenario 15: Sort a Range, Then Create a Named Range and Use It in 
a VLOOKUP Formula

Sort the data on the Employees sheet in ascending order by last name, then first name. Using 
the information on the Employees sheet, create formulas in cells B2:C25 on the Vacation 
Schedule sheet that will pull the correct first and last names when the employee’s ID number 
is typed in column A. Add employee numbers S987, M190, and A67 to the Vacation Schedule 
sheet and show them all as having used 14 days of their vacation time.

 

MOS Scenario 16: Change Cell References and Nest Functions to Remove 
Formula Errors

On the Employees sheet, the New Salary column is supposed to show a $2,000 increase in sal-
ary for every employee who has been with the company more than 10 years, but it does not. 
Correct this error. Also, on the Vacation Schedule, correct the formulas to remove the #N/A 
errors. Format all columns showing money values as currency with no decimal places.

 

MOS Scenario 17: Use Names as Bookmarks and Create an Index Sheet

Create range names for the Last_Name, First_Name, and Department data. Add a new sheet 
at the end of the workbook named Index and list all the ranges in this book on that sheet, 
under the headings Name and Range. Create a bookmark for cell A1 of the Index sheet.
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MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Use subtotals

�

 

Group and outline data

�

 

Consolidate data

�

 

Create PivotTable and PivotChart reports

�

 

Create and modify custom data formats

�

 

Use conditional formatting
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Building on Excel’s organizational features covered in earlier 
chapters, as well as all of the functions and formulas you’ve 
learned so far, this chapter is all about the advanced features in 

Excel that give you even more control over the organization, summarization, and display of 
your data. There’s quite a bit of information in this chapter, and it covers many different tools 
and features in Excel that give you maximum control over customizing your data.

Subtotals and Group and Outline are two commands used to summarize data and allow 
you to display individual selected sections of data.

Data consolidation is a great feature in Excel that lets you create worksheets that pull sta-
tistical information (totals, averages, etc.) from other worksheets using 3D references. 3D ref-
erences are simply cell references that refer to data outside of the worksheet where the 
reference is applied. You can also create 3D references to other sheets and workbooks man-
ually by linking data within formulas.

And, every advanced Excel user must know how to use pivot tables and pivot charts to dis-
play data in a way that can be manipulated to show the same information in various relational 
layouts.

Another way to enhance the display of your data is through the use of the advanced for-
matting techniques. Custom data formats provide you with endless possibilities for displaying 
cell content in various ways when none of the formats provided by Excel meet your needs. 
Conditional formatting, on the other hand, lets you display cells in different ways, based on 
criteria you specify, so the format of the cell changes if the content changes and matches dif-
ferent criteria.

To complete the exercises in this chapter, you will need to download the file exl2003ch07.zip 
from the website for this book and extract the files into a temporary folder before you begin.

 

Summarizing Data

 

When your worksheets include large amounts of data (a customer list with thousands of cus-
tomers, an inventory sheet with pages and pages of products, etc.), often you will want to 
show a subtotal summary, grouped by category. For example, you may want to display a 
count of all customers in each state in the United States, or maybe the values of the products 
sold by each department. This is what the 

 

Subtotals

 

 and 

 

Group and Outline

 

 commands in 
Excel do for you.
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Excel includes a Subtotals command in the Data menu, and it also has a SUBTOTAL func-
tion. The way in which your data is laid out will determine how you will use these features and 
which one you will use. The Group and Outline command in the Data menu lets you summa-
rize your data based on subtotal formulas you have added, whereas the Subtotals command 
lets you summarize your data based on sorted categories. Let’s look at both ways to summa-
rize, depending on different data layouts.

 

Using Outlining When Data Is Already Subtotaled

 

If your data is already arranged in groups on your spreadsheet, you can use Excel’s SUB-
TOTAL function to create subtotals for each group; then use the Auto Outline command to 
create an expandable/collapsible outline based on these subtotals. Though Excel will auto-
matically create an outline when you use the Subtotals command, you can also create the 
outline manually when your data already has subtotals you created using the SUBTOTAL 
function.

The SUBTOTAL function requires two arguments: Function_Num and Ref. Function_
Num is a number that Excel recognizes, which tells it what type of subtotal you want: a sum, 
an average, a count, etc. (See Figure 7.1 for a table of these numbers available to you in Excel’s 
Help files.) The Ref argument refers to the range you want subtotaled. You can have up to 29 
Ref arguments. Once you choose Ref1, another argument box appears that allows you to 
choose a second range for Ref2, and so forth.

 

F I G U R E 7 . 1

 

Inside the Function_Num box, click the Help On This Function button to find 

 

the number you want.

 

Exercise 7.1 will show you first how to use the SUBTOTAL function and then how to create 
an outline based on that.
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E X E R C I S E  7 . 1  

 

Using the SUBTOTAL Function and Auto Outline

 

1.

 

Open the file Exercise 7-1.xls that you extracted from the zipped file for this chapter. Make 
the Layout 1 sheet the active sheet, if it is not already.

 

2.

 

First we will create subtotals for the quarters of the year. Select cell E3 and click the Insert 
Function button.

 

3.

 

The function we want is called SUBTOTAL, and you can find that in the Math & Trig cat-
egory, or simply type 

 

subtotal

 

 in the Search box at the top and click the Go button to let 
Excel find it for you. Once you’ve found it, select it in the list and click OK.

 

4.

 

We want a sum subtotal, so enter 

 

9

 

 as the Function_Num argument (see Figure 7.1).

 

5.

 

Press your Tab key to move to the Ref1 argument box, and drag your mouse over cells 
B3:D3 to select that range on the worksheet. Release your mouse button, then click OK 
to return to the worksheet. As you can see, 123 is your subtotal.

 

6.

 

Use the fill handle to drag this formula down to E6 to get subtotals for all of the products 
in the Adult department for the first quarter.

 

7.

 

With the range E3:E6 still selected, copy it. Then, right-click in cell I3 and choose Paste. 
Then paste again in cell M3, and again in cell Q3. You should now have subtotals in all 
four quarters for all of the products in the Adult department.

 

8.

 

Right-click cell E3 and copy that formula. Then, select the range E8:E17 and paste. This 
pastes the formula relatively into every cell in that range. Select I8:I17 and paste again; 
then paste again in M3:M17 and Q3:Q17. Now you should have subtotals for all of the 
products in the Children department. Press Esc to remove the marquee from cell E3 (and 
remember to press Esc throughout the rest of this exercise, whenever you want to 
remove the marquee).

 

9.

 

Insert a blank row above row 7, then type 

 

Total

 

 in the now empty A7. Copy it and paste 
it into A19.

 

10.

 

Select cell B7 and use the SUBTOTAL function to create a sum (9) subtotal in that cell that 
references the range B3:B6. Use the fill handle to drag this formula to cell D7. Then copy 
B7 and paste it into the ranges F7:H7, J7:L7, and N7:P7.

 

11.

 

Repeat the above process to put a sum subtotal in B19 that references B9:B18 and copy 
that to all cells in row 19 that are below month headers (do not put subtotals in the col-
umns for the quarters, because the SUBTOTAL function cannot apply a subtotal to a 
range of subtotals).

 

12.

 

Select cell R3 and enter a formula to total the subtotals, 

 

=e3+i3+m3+q3

 

,

 

 

 

and copy this for-
mula to the ranges R4:R6 and R9:R18.

 

13.

 

In cell A20, type 

 

Grand Totals

 

.
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14.

 

In B20 add a formula to total your subtotals, 

 

=b7+b19

 

, and copy that to C20:D20, F20:H20, 
J20:L20, and N20:P20 (again, omitting the columns for the quarters).

 

15.

 

Select cell E7 and click the AutoSum button to add up the values in E3:E6 and press Enter. 
Repeat this in cells I7, M7, Q7, E19, I19, M19, and Q19. (Don’t worry about the green trian-
gles appearing in the cells. Excel only shows them because it sees your formulas as incon-
sistent. All of this will be covered in Chapter 8, “Data Analysis and Sharing Workbooks.”)

 

16.

 

And, finally, select cell B20 and copy it and paste that into E20, I20, M20, Q20, and R20.

 

17.

 

Now, select any cell within the data and choose Data �

 

 Group And Outline �

 

 Auto Outline.

You should now see expandable/collapsible outline groups at the top and left of your 
worksheet, as shown here:

 

18.

 

At this point all of your groups are expanded so you see all data. Click the 2 at the top of 
your worksheet, and you will see only quarterly and yearly totals and subtotals.

 

19.

 

Click the 2 on the left side of the worksheet, and you will see only the Adult and Children 
department totals and the grand totals.

 

E X E R C I S E  7 . 1

 

( c o n t i n u e d )

Column Outline GroupsRow Outline Groups
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Did that seem like an awful lot of work to you? If so, remember that most of the work was 
getting all of the formulas in there. Once you accomplished that, the actual Auto Outline com-
mand was pretty quick and easy and can now be turned on and off in that worksheet with one 
click. However, in most cases, when you want subtotals that you can expand and collapse, 
there’s a much easier method, so let’s learn that now.

 

Creating Subtotals and Outlines at the Same Time

 

Obviously, if you’ve already used the SUBTOTAL function to add subtotals to your data, or 
if you need subtotals of both columns and rows, the method described previously will give you 
what you want. But, in most cases, when your data is organized in the standard fashion (listed 
below column headings), using the Subtotal command in the Data menu gives you a quick sub-
total of one column based on changes in another column. For example, if you have one column 
that lists sales values and another column that lists product names, you can create subtotals 
that show the total sales for each product name.

When using the Subtotal command, the most important thing to remember is that you must 
first sort your data by the column that holds the category you want totaled. Using our earlier 
example, you would first sort the data by the product-name column, then use the Subtotal 
command to tell Excel to give you a subtotal of the sales-value column every time the product-
name column changes. You must sort by that column first so that all product names that are 
the same are listed together in that column. Then, when Excel produces your subtotals, it looks 
down the product-name column and sees five items that are the same, then it sees three more 
that are the same, then six more, and so forth. Every time the value in that column changes, 
it totals the corresponding cells in the sales-value column.

Let’s try it using Exercise 7.2:

 

20.

 

Click the 1 on the left side of the worksheet, and you will see only the grand totals for each 
quarter and the year.

 

21.

 

Click the 3 at the top of the sheet, and you will see only the grand totals, but this time you 
see them for each month, as well as the quarters and year.

 

22.

 

Click the various plus and minus signs at the top and left of the sheet, as well as the 1, 2, 
and 3 grouping levels, to see all of the ways you can change what is displayed.

 

23.

 

When you have finished experimenting, return to Data �

 

 Group And Outline and choose 
Clear Outline.

 

24.

 

Use the Save As dialog box to create a new folder named 

 

Chapter Seven

 

 and save this 
file into the new folder, naming it 

 

Exercise 7-2.xls

 

. If you plan to continue at this time, 
leave this file open for the next exercise.

 

E X E R C I S E  7 . 1

 

( c o n t i n u e d )
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E X E R C I S E  7 . 2  

 

Using the Subtotal Command

 

1.

 

Still inside the workbook you saved in the previous exercise, move to the Layout 2 sheet. 
(If you did not save the file, use Exercise 7-1.xls instead. Do not use the Exercise 7-2.xls 
file you extracted from the zipped file, because that already includes this completed lesson.)

This data shows total numbers of products sold and the department is identified in column B.

 

2.

 

First we need to sort the data by the department name, so select any cell in column B and 
click the Sort Ascending button.

 

3.

 

Type 

 

Total Sales

 

 in cell O1 and press Enter.

 

4.

 

Select the range O2:O15 and click the AutoSum button to give you totals for each product.

 

5.

 

Select any cell within the data and choose Data �

 

 Subtotals.

 

6.

 

When the Subtotal box appears (as shown in the following graphic), choose 

 

Dept.

 

 from 
the At Each Change In dropdown; then choose 

 

Sum

 

 from the Use Function dropdown. 
Then, in the Add Subtotal To box, put checks in the boxes for each month and also in the 
Total Sales box. (Do not select Product Number and Dept.) Be sure Replace Current Sub-
totals and Summary Below Data are selected. Click OK.

 

7.

 

Widen column B, if necessary, to see your new department subtotal and grand total labels.

 

8.

 

On the left side of your worksheet, click the three minus signs to collapse them, and now 
all you see are the grand totals.

 

9.

 

Click the number 2 on the top left, above where you collapsed the minus signs. Note that 
this summary shows you subtotals for each department and also the grand totals.

 

10.

 

Click the number 3 and everything is displayed again.

Notice, in the graphic above, that you can always return to the Subtotal box and click the 
Remove All button if you want the subtotals and outline removed.

 

11.

 

Save the file to update it, and then close the file.
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Once you understand both methods of creating subtotals, go back and try creating averages 
or counts, instead of sums. Remember, when using the SUBTOTAL function, you simply choose 
the correct number as the Function_Num (see Figure 7.1) and, when using the Subtotals com-
mand, you just choose the one you want from the Use Function dropdown. Changing the func-
tion does not affect how the features work; everything else is done exactly the same way.

When you are comfortable with using both of these features to summarize your data, move 
on to the next section and I’ll teach you how to consolidate data.

 

Consolidating Data

 

The difference between summarizing data and consolidating data is that 

 

data consolidation

 

 
allows you to create a new worksheet showing your summary. This is really handy when you 
have your data set up with categories or time periods on individual sheets and you want a final 
sheet that shows totals, counts, or averages. You can set up your consolidation sheet as a static 
report that shows only the data currently included on the individual sheets; or you can create 
a dynamic consolidation sheet that updates automatically to reflect any changes you make in 
the individual sheets. Dynamic consolidation not only gives you summaries, but also allows 
you to expand and collapse outline levels so you can view selected details with the summaries 
(see Figure 7.2).

 

F I G U R E 7 . 2

 

Dynamic consolidation includes expandable outline levels.

Expandable Outline Levels
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Exercise 7.3 teaches you how to create a static consolidation. Let’s try it.

 

E X E R C I S E  7 . 3

 

Creating a Static Consolidation Sheet

 

1.

 

Open the file Exercise 7-3.xls and look through the sheets. There are individual sheets for 
each quarter that show the total sales for each salesperson during that time period. The 
fourth quarter has not yet occurred, so that sheet shows no numbers.

Assume you want to create a report that shows these numbers as they stand today and 
you don’t want these numbers to change.

 

2.

 

Click the Static Report sheet tab and select the range B2:B10. Make sure you can see the sheet 
tabs for all four quarters at the bottom of your screen, then choose Data �

 

 Consolidate.

 

3.

 

Drag the Consolidate dialog box to the right so it isn’t covering any of your data. Make 
sure the Function dropdown shows Sum and that your insertion point is flashing in the 
Reference box.

 

4.

 

Click the 1st Qtr sheet tab and select the range B2:B10 on that sheet. Release your mouse 
button, and Excel enters that range in the Reference box. It displays the sheet name, fol-
lowed by an exclamation point, then the absolute range. Click the Add button.

 

5.

 

Click the 2nd Qtr tab. Excel chooses the same range on this sheet by default. Simply click 
the Add button.

 

6.

 

Click the 3rd Qtr tab and click Add. Click the 4th Qtr tab and click Add. You should now 
have all four sheets included in your consolidation; the box should look like this:

7. Be sure none of the boxes at the bottom of the Consolidate dialog box are selected. Click OK.

8. Your static report now shows totals for all salespeople. Select cell B2 and look at the For-
mula bar. This is a static reference, so all you see is a value.

9. Save the file in your Chapter Seven folder and name it Exercise 7-4.xls. Leave the file 
open for the next exercise.
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If you name ranges before you consolidate data, you can simply press F3 
when inside the Reference box and add the named range from the Paste 
Name dialog box without having to move from sheet to sheet.

There are some occasions when you want to produce a static consolidation because you 
want the values to remain the same so you can refer back to them even after the values on the 
individual sheets have changed. However, in most cases, you will probably want a dynamic 
consolidation that will update continuously, based on changes you make to the individual 
sheets. Creating dynamic consolidations produces formulas with 3D references to the included 
data. Exercise 7.4 shows you how to do this.

E X E R C I S E  7 . 4  

Creating a Dynamic Consolidation with 3D References

1. Still inside the workbook you saved in the previous exercise, move to the Ongoing 
Report tab.

2. Select the range B2:B10 and, again, be sure all four quarter sheet tabs are showing 
onscreen; then choose Data � Consolidate.

3. Follow steps 3–6 in Exercise 7.3 to add the references to B2:B10 on all sheets to the 
consolidation.

4. Once you have all four sheets showing in the All References box, select the Create Links 
To Source Data option. Click OK.

5. You now see the same totals you saw when you did the static consolidation, but you also 
see plus signs to the left of the sheet. Click the very top plus sign. This displays Ahmad 
Abdul’s sales for the first four quarters above his total for all four quarters. Click other 
plus signs to see the same for the other sales people. The quarterly totals are not very 
obvious and need labels.

6. Click the 2 at the top of the plus signs to expand all of them. In cell A2, type 1st Qtr and 
press Enter. Then type 2nd Qtr in A3, 3rd Qtr in A4, and 4th Qtr in A5. Copy the range 
A2:A5 and paste it in cells A7, A12, A17, A22, A27, A32, A37, and A42, so the correct quar-
ters show beside all of their totals. Press the Esc key to remove the marquee, then click 
the 1 at the top to collapse all levels.

7. Expand Ahmad Abdul’s sales again, then select cell B2. Look at the Formula bar. This cell 
contains a formula that points to cell B2 on the 1st Qtr sheet. Select cell B5, and note the 
formula that totals B2 through B4 on this sheet.
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One of the disappointing parts of data consolidation that I wish worked better is the Use 
Labels In feature you see at the bottom of the Consolidate dialog box. As you can see, Excel 
lets you select Top Row or Left Column. Logic would tell you that Excel would then select the 
labels that appear in your top row or left column, no? Well, unfortunately that is not the case. 
What does happen when you use this feature is the workbook name is inserted in the top row 
or left column for each row or column you include in the consolidation—so unless your data 
is being consolidated from multiple workbooks, this feature is pretty useless. However, in 
cases where you are actually pulling data from several workbooks, this will allow you to identify 
the workbooks within the consolidation sheet; try Exercise 7.5 if you want to see what I mean.

8. Note the value in cell A3 is $75,000 and Abdul’s total sales in cell A6 is $324,757. Move 
to the 2nd Qtr sheet and change Abdul’s sales to 100000 and press Enter.

9. Return to the Ongoing Report sheet. As you can see, Excel has updated Abdul’s 2nd Qtr 
sales and total sales.

10. Move to the 4th Qtr sheet and enter 100000 in all cells from B2 to B10.

11. Return to the Ongoing Report sheet and expand all by clicking the 2 at the top. Excel 
updates all 4th Qtr and total sales for all of the salespeople.

12. Click the 1 at the top to collapse all, then save the file to update it and close it.

E X E R C I S E  7 . 5

Using Left Column Labels When Consolidating

1. Open Exercise 7-4.xls; then, while it’s open, open a new blank workbook.

2. In the new empty workbook, select the range A1:B9 and select Data � Consolidate.

3. With your insertion point in the Reference box, click the Window menu in your blank 
workbook and choose Exercise 7-4.xls to move into that workbook; then follow the steps 
from Exercise 7.3 to select the range A2:B10 on all four sheets in the Exercise 7-4.xls 
workbook.

4. Once you’ve added all four worksheets as references, select the Left Column and Create 
Links To Source Data checkboxes. Click OK.

5. Expand your groups to see that Exercise 7-4 has been added to the left of each subtotal.

6. Close both of the files and click No when asked if you want to save anything.

E X E R C I S E  7 . 4 ( c o n t i n u e d )
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Exercise 7.5 teaches you a couple of things. First, it is possible to create 3D references that 
will link the data in one workbook to another; and second, the Top Row and Left Column 
checkboxes in the Consolidate dialog box are useful only when you are creating consolidation 
reports that point to multiple workbooks. Whenever you use formulas to access data in other 
workbooks, you are creating external links to that data, and that’s what you will learn about 
in this next section.

Linking Data
Many times, when you use specific Excel features, data in one place is automatically linked to 
data in another. Examples of this include dynamic data consolidation (described previously 
in this chapter), charts that are placed on a sheet other than the sheet where the data lives 
(explained in Chapter 2, “Formats, Graphics, and Excel’s Templates”), VLOOKUP formulas 
that refer to a table array on a different sheet (covered in Chapter 6, “Advanced Functions, 
Table Arrays, and Database Features”), and pivot tables, discussed later in this chapter. How-
ever, you can also manually create links to data in other locations simply by referencing the 
external cell or range within a formula.

Linking data assures you that data is updated in the linked location whenever the source 
data in the original location changes. In a work situation, think of that global workbook that 
lives on a network drive and includes product prices that you refer to in your local inventory 
workbook. Or, in a home situation, think of addresses that reside in your Contacts workbook 
and are referred to in your Birthday Cards Reminder workbook.

Formulas that include 3D references to cells or ranges in locations outside of the sheet are 
formatted in this way:
�  Cell reference to another sheet within the workbook:

SheetName!CellOrRangeReference
� Cell reference to another workbook:

'[WorkbookName]SheetName'!CellOrRangeReference

Creating Simple Links to External Data

Before we get into including 3D references as part of an argument within a function, let’s look 
at simple linking to external cells. If you only want to display a value from a different work-
book or worksheet but don’t need that value calculated in a formula, all you have to do is type 
an equal sign, followed by the workbook/worksheet/cell reference.

As long as you know the full name of the workbook and sheet, you can type the 3D refer-
ence directly after an equal sign. However, the easiest and most accurate way to do it (to avoid 
misspellings that will result in errors) is to enter your formula and, when you get to the part 
of the formula that references another sheet or workbook, simply move to that location, select 
the cell or range, and press Enter. But it is important to know that the default cell reference 
type for 3D references entered by selecting the cells is relative when referencing a sheet within 
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the same workbook and absolute when referencing a sheet in a different workbook. This is 
based on the behavior Microsoft assumes is the “norm,” and this may be true in your case; 
however, the important thing is that you know this and remember to change the cell reference 
type when the behavior does not suit your purpose.

Use Exercise 7.6 to learn how to manually type in simple 3D references or create them by 
selecting cells.

E X E R C I S E  7 . 6  

Creating Simple 3D References

1. Open a new blank workbook and save it in your Chapter Seven folder and name it Exer-

cise 7-6A.xls.

2. In cell A1 type 5, then in cell A2 type 10. Select both cells and drag the series down to cell 
A10, using the fill handle (so the series continues from 15 to 50).

3. Rename Sheet1 to Original, name Sheet 2 LinkedCopy, and name Sheet3 Totals.

4. Move to the LinkedCopy sheet. In cell A1 type Manual and in cell A2 type Selection.

5. On the LinkedCopy sheet, in cell B1 type =original!a1 and press Enter. Excel returns 5, 
which is what is in cell A1 on the Original sheet.

6. In cell B2 on the LinkedCopy sheet, type = and then click the Original sheet tab, select cell 
A2, and press Enter. When you press Enter, you are returned to the LinkedCopy sheet and 
10 appears in cell B2, because that is what is in cell A2 on the Original sheet.

7. View the formulas in cells B1 and B2 and note that they are basically the same, except 
they obviously refer to different cells on the Original sheet.

8. Save the workbook to update it and leave it open.

9. Create another new workbook and save it and name it Exercise 7-6B.xls.

10. In the new B workbook, in cell F5, type ='[exercise 7-6a.xls]original'!a1 (don’t miss the 
single quote before the left bracket and before the exclamation point). Press Enter and 
Excel returns 5.

11. In cell F6, type = and then from the Window menu select the Exercise 7-6A workbook. 
Inside the A workbook, click the Original tab, then click cell A1. Press Enter and you are 
returned to the B workbook. As you can see, cell F6 shows 5.

12. Examine the formulas in F5 and F6 and note that they are similar, but the A1 cell reference 
in F5 is relative and in F6 it is absolute.

13. Go back to the A workbook and change the value on the Original sheet, in A1, to 100 and 
press Enter.
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I guess it’s pretty obvious what the advantages to linking are. Data in one place can be kept 
up to date in many places this way. And, this becomes even more valuable when you include 
these links in formulas, so let’s learn about that next.

Using Linked Data in Formulas

When including linked data in formulas, the process is the same as described in Exercise 7.6. 
And, again, you can type the references directly into the formula, or simply click on them to 
select them. I find the easiest way to link data from one workbook to another is to arrange the 
workbooks side by side and use the click-to-select method. Exercise 7.7 shows how to use this 
technique when adding links within formulas.

14. Move to the LinkedCopy sheet and note that Excel has updated the value in B1 to 
100 also.

15. Move to the B workbook and note that both F5 and F6 now show 100 too.

16. Save both workbooks to update them and then close them both.

17. Reopen the B workbook and you should see this warning box:

If you don’t see the prompt shown in the graphic above, it means you have the prompt 
to update links turned off. You can turn it on by selecting Tools � Options. In the Options 
dialog box, select the Edit tab and select the option Ask To Update Automatic Links. 
You’ll learn about all of the settings in the Options dialog box in Chapter 12, “Customiz-
ing Excel and Setting Defaults.” For now, just be sure this option is checked. If it was not 
selected, select it now; then save and close the workbook and reopen it.

18. You can choose whether or not you want the B workbook updated with any changes 
made to the A workbook. Click the Update button.

19. Select cell F5 and view the formula in the Formula bar. Once the workbooks are saved, 
the full path to the linked workbook shows within the formula. Leave the B workbook 
open for the next exercise.

E X E R C I S E  7 . 6 ( c o n t i n u e d )
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E X E R C I S E  7 . 7  

Linking Data in Side-by-Side Workbook Formulas

1. You should still have Exercise 7-6B.xls open from the previous exercise, but if not, open 
it now. Then, open Exercise 7-6A.xls as well. (Use the workbooks you created, because 
the ones I included in the zipped file for this chapter are already completed.)

2. Choose Window � Arrange and then select Vertical and click OK.

3. In the A workbook, click the Totals sheet tab and type Original Totals in cell A1. Then 
press the → key to move to B1. (Widen column A if necessary.)

4. In B1, type = to start the formula, then click the Original sheet tab and select cell A1. Type +. 
Select A2; type +. Select A3; type +. Finally, select A4 and press Enter. This will move you 
back to the Totals sheet and the value in cell B1 should be 145.

5. View the formula in the Formula bar and verify that it shows the following:

=Original!A1+Original!A2+Original!A3+Original!A4

6. Move to the B workbook. Select cell A1 and type = to start the formula. Click the Original 
sheet tab in workbook A;, then select cell A1 and type *. Select A2 and press Enter. This 
action will return you to the B workbook; cell A1 should show 1000 and the Formula bar 
should display:

='[Exercise 7-6A.xls]Original'!$A$1*'[Exercise 7-6A.xls]Original'!$A$2

7. Select cell A2 in the B workbook, and click the Insert Function button. Choose the Logical 
category, then choose the IF function and click OK.

8. Move the box so you can see the A workbook. With your insertion point flashing in the 
Logical_Test box, click the Original tab in workbook A and select cell A1. You should see the 
workbook and cell reference appear in the Logical_Test box. Type >50 after that reference.

9. Press the Tab key to move to the Value_If_True box and type yes. Then tab to the Value_
If_False box and type no. Your box should look like this:
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Though links between workbooks are very helpful, sometimes they can also be problem-
atic. A common situation that occurs in some companies is that workbooks parked on net-
work drives are often moved or deleted and then the links no longer work. Let’s learn how to 
deal with that.

Dealing with Broken Links

Remember in Exercise 7.6, step 19, when you viewed the link in the Formula bar and it 
showed the full path to the linked workbook? Well, that’s what Excel reads when you open 
a workbook that contains links. If the linked workbook is renamed, moved to a different loca-
tion, or deleted, Excel will be unable to find it and will present you with a box asking you what 
you want to do about it. If a workbook has been moved or renamed, you can try to find it and 
update the path to the new location. Alternatively, if a workbook has been deleted, or you 
can’t find the new location, you can break the link permanently and just keep the values 
instead of the formula with the link.

Exercise 7.8 shows you how to make the correct choice when you are presented with these 
broken links.

10. Click OK to return to the worksheet. Cell A2 should say “yes” (because the value in cell A1 
in workbook A is greater than 50). View the formula in the Formula bar. It should look 
like this:

=IF('[Exercise 7-6A.xls]Original'!$A$1>50,"yes","no")

11. Grab cell A2 of the B workbook and drag it down to cell A6, using the fill handle. Notice 
that all the cells now say “yes.” View the individual formulas in all of those cells; as you 
can see, they are all identical.

12. Select cell A2 again, and remove the dollar signs from that formula. (Remember you can 
double-click on $A$1in the Formula bar to select it and press the F4 key three times to tog-
gle to the choice that has no dollar signs.)

13. Once you’ve made the A1 reference relative, press Enter. Then return to cell A2 and drag 
that new formula down to A6. You should now have four “no” entries. View the formulas 
in the Formula bar and you will notice that they show A1 updating to A2, A3, and so forth.

14. Close both files and save them to update them.

E X E R C I S E  7 . 7 ( c o n t i n u e d )
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E X E R C I S E  7 . 8  

Updating and Breaking Links

First make sure you don’t have any workbooks open in Excel. Now let’s go into your My Doc-
uments folder and break some links.

1. Open My Documents from your Windows desktop or your Windows Start menu. Navi-
gate to your Chapter Seven folder that you created in Exercise 7.1 and find the file named 
Exercise7-6A.xls. (If you did not create this folder, navigate to whatever folder holds your 
Chapter Seven files.)

2. Right-click on Exercise 7-6A.xls and choose Rename. Then, rename this file to Exer-

cise 7-8A.xls.

Remember that Exercise 7-6B.xls includes links to Exercise 7-6A.xls, which no longer 
exists, so we’ve broken a link.

3. Open Exercise 7-6B.xls and click the Update button when the prompt appears.

4. Now you’ll receive a second prompt. This one tells you that the workbook contains one 
or more links that can’t be updated:

5. Click the Edit Links button and in the resulting dialog box, you will see that you have one 
link listed. Under the Status column, it says “Error: Source not found.” Click the Change 
Source button.

6. Navigate to the Chapter Seven folder (or whatever folder contains your Chapter Seven 
files), select Exercise 7-8A.xls, and click OK. Notice that the Status column now says “OK.”

7. Click the Close button to return to the worksheet. Close the file but do not save it.

8. Open Exercise 7-6B.xls again. Once again, click the Update button, and again click the Edit 
Links button. But, this time, click the Break Links button, and you are presented with this box:
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If you ever want to change the link source file or break links while inside a 
workbook, you can choose Edit � Links, which takes you to the Edit Links 
dialog box you used in Exercise 7.8. If there are no links in the workbook, the 
Links command in the Edit menu will be grayed out.

9. Read the warning, which tells you that the formulas will be converted to static values and 
suggests that you save your file first. In our case, this doesn’t matter, so just click the 
Break Links button.

10. Excel returns you to the Edit Links box, and now there are no links. Click the Close button 
to return to the worksheet.

11. Select the various cells that had formulas in them before and note that now they only 
contain values. Close the file and click No if Excel asks if you want to save it.

12. Open the file again. As you can see, the formulas are still not there, even though you 
chose not to save the file. Breaking links is irreversible.

13. Close the file again.

Phantom Links in Excel

One of the more common troubleshooting requests I get concerns Excel workbooks that 
present the prompt saying links can’t be updated because the source workbook cannot be 
found. However, when you go to the Edit menu, the Links command is grayed out, so you 
can’t change the source or break the link. In fact, it would appear that there are no links at all. 
But this is not usually the case. On rare occasions, the workbook could have become cor-
rupted, thus the invalid prompt. However, this is indeed rare—generally, when Excel tells you 
there are links in the workbook, there are, in fact, links in the workbook. But sometimes they are 
in not-so-obvious places, or for some reason, they don’t appear in the Edit Links dialog box.

If this ever happens to you, here are some alternative ways to find links in a workbook:

� First, choose Edit � Find and search for [ (the square bracket is usually a good indicator 
of an external link). If there are any formulas that contain these brackets, this search will 
find them, so you can either adjust the link to refer to a valid workbook or remove it from 
the formula entirely.

E X E R C I S E  7 . 8 ( c o n t i n u e d )
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Summarizing, consolidating, and linking data are all excellent methods for organizing your 
worksheets, but now I will show you how to use pivotal reports to get maximum control over 
the layout and display of your data.

Using Pivotal Reports
One of the shortcomings of the features discussed in the previous sections of this chapter is the 
flatness, or one-sidedness, of the displays produced. Although the data produced using sub-
totals or consolidation is dynamic, the actual display is relatively static, meaning that the 
information will always be displayed using the same column and row headings, even when the 
data summaries are adjusted below or beside these headings. If you wanted the data in the 
rows to appear in columns, you would have to manually reconstruct the worksheet. In many 
situations, this is adequate, but when you want more flexibility, pivot tables and pivot charts 
add a new dimension to the layout. The word “pivot” is used in the name of these features 
because you can display the information one way, then pivot (turn or revolve) the data so it 
displays in an alternate fashion.

Also, pivotal reports allow you to show the relationship between multiple series. For exam-
ple, a pivotal sales report would show how many items of a specific type were sold for a spe-
cific dollar range, or which items were the biggest sellers during a particular date range. You 
can even combine both of these range criteria into one pivotal report.

Pivot tables are more commonly used than pivot charts. A lot of users produce a pivot 
table first, then create the pivot chart based on the pivot table. So, let’s learn how to make 
the tables first.

� Another place links can hide is in a chart or series. Select any chart in the workbook, and 
choose Chart � Source Data. If any series are referring to external workbooks, adjust or 
remove them.

� External links can also hide in pivot tables; you also need to check the source data used 
to produce these tables in your workbooks. (This will be clearer to you when you’ve com-
pleted the next section of this chapter.)

� And finally, check your named ranges. Select Insert � Name � Define and check the 
Refers To boxes for all names to see if any of them are referring to external files. If so, 
either change the reference or delete the name.

No one really seems to know why these phantom links don’t show in the Edit Links dialog box, 
but I can assure you this is a fairly common problem. Fortunately, in most cases, using one 
or more of the alternatives presented above will fix the issue so you are no longer bothered 
by that prompt.
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Manipulating Data Layout with a PivotTable Report

Pivot tables are a mystery to many, and I’ve often heard people say that they are more intim-
idated by pivot tables than they are by formulas! There’s no need to feel this way. Once you 
get the hang of pivot tables, you’ll wonder how you ever got along without them.

Pivot tables allow you to manipulate data in various ways. Figure 7.3 shows how random, 
unorganized data in a worksheet can be quickly categorized and summarized in an attractive 
table layout. Also, notice in Figure 7.3 that there are dropdown arrows beside the headings; 
you can adjust this pivot table by using these dropdown arrows. Because of the table’s flexi-
bility, you can easily pivot any column-arranged data so that it is arranged in rows instead, 
and vice versa.

F I G U R E 7 . 3 Pivot tables produce attractive, organized reports.

Let’s learn how to use the PivotTable and PivotChart Wizard to set up a simple pivot table 
first; then we’ll move on to the nitty-gritty of manipulating that data layout.

Using the PivotTable Wizard

Excel’s PivotTable and PivotChart Wizard walks you through the steps of creating the report 
you want. When you set up a pivot table, Excel lets you specify what you want presented in 
rows and columns, what you want presented in a page layout, and, of course, which data you 
want summarized. Figure 7.4 shows the Layout box from the wizard where you make these 
choices. When your data is laid out in columns on your worksheet, Excel recognizes the column 
headings as fields and displays them on the right side of the layout box. All you have to do is drag 
the fields to the page, column, row, or data section. Let me briefly explain these sections.

Page selection You drag a field to the Page section when you want the ability to manipulate 
the entire report to show only specific values from that field. For example, if a column on the 
original worksheet displays various product names, dragging this field to the Page section of 
the pivot table gives you the option of producing an entire report for just one product, or for 
selected products.

Worksheet data can be easily 
manipulated in a pivot table
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F I G U R E 7 . 4 Column headings are converted to fields when you produce a pivot table, 
and you can drag these fields to whatever section you prefer.

Column selection Drag a field to the Column section when you want the values in that field 
displayed as headings across the top of your pivot table. This will allow you to add and remove 
those values, and you can also increase or decrease the number of columns displayed.

Row selection When you move a field to the Row section, the data in that field will be dis-
played as row headings to the left of the data in the columns.

Data selection The most important section is the Data section. You cannot produce a pivot 
table without placing something in this area (whereas the other sections are optional). This is 
where you move the field that you want summarized. If you put a field in this section that has 
a text format (such as product names), the data from that field will be summarized, by default, 
as a count of those names. However, if you choose a field that is formatted as numbers or cur-
rency (such as prices), the default summary will be a total.

Exercise 7.9 shows how to produce a simple pivot table using the wizard.

E X E R C I S E  7 . 9  

Creating a Pivot Table

1. Open the workbook Exercise 7-9.xls. This workbook contains a simple listing of two prod-
ucts purchased by two different companies during a three-month period. It lists the num-
ber of each product purchased by each company in each month, and uses a formula to 
multiply that number by the cost of that product to give the value. However, the data is 
poorly laid out. As you can see, the months, product names, and company names are 
repeated and there’s no way to quickly determine how many products were purchased 
by each company in any given month. In this case, a pivot table is the ideal solution.

2. Select any cell within the data on the worksheet and choose Data � PivotTable and 
PivotChart Report to launch the wizard.
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3. The first step of the wizard wants to know two things: where is the data and what type of 
report do you want produced? Make sure the options Microsoft Office Excel List Or Data-
base and PivotTable are both selected and click Next.

4. The second step of the wizard asks where the range of data is located. Because the data 
on the worksheet is contiguous with no blank rows or columns, Excel should have auto-
matically selected the full range for you ($A$1:$E$13). If not, just drag your mouse across 
the range A1:E13 on the worksheet to select it. Click Next.

5. Step 3 of the wizard asks if you want the pivot table on a new sheet or on the existing 
sheet. Be sure New Worksheet is selected, but don’t click Finish yet.

If you click Finish, you can drag the field names to the correct sections on the actual pivot 
table, but it’s much clearer and easier if you do it before you click Finish, so let’s do that now.

6. Click the Layout button to open the Layout box shown in Figure 7.4.

7. Click the Month field button on the right side of the Layout box and, holding your mouse 
button down, drag the Month field to the white Page box and drop it there.

8. Drag the Company field and drop it in the Column box.

9. Drag the Product field and drop it in the Row box.

10. Drag the Quantity field and drop it in the Data box. Your layout should now look like this:

11. Click OK to return to Step 3 of the wizard, and now click Finish.

12. Your pivot table is on a new sheet named Sheet1. Rename the sheet tab to PivotTable.

13. Save the file in your Chapter Seven folder and name it Exercise 7-10.xls, but leave it open 
for the following discussion and exercise.

E X E R C I S E  7 . 9 ( c o n t i n u e d )
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Now, that wasn’t so hard, was it? And look at the pivot table you produced—isn’t this a 
much better representation of the data than you had in that worksheet? Before we start manip-
ulating and formatting the data in the table, let’s discuss the tools we’ll use.

Using the Pivot Table Tools

On the sheet that contains your pivot table (if you did not complete Exercise 7.9, extract the 
file Exercise 7-10.xls from the zipped file for this chapter and move to the PivotTable sheet), 
you should see a PivotTable toolbar and a PivotTable Field list (see Figure 7.5). If you don’t 
see the Field list, it means your pivot table isn’t selected. Click in any cell within the pivot table 
to select it, and you should now see the Field list. If you don’t see the PivotTable toolbar, 
choose View � Toolbars � PivotTable. The button on the far right end of the PivotTable tool-
bar (see Table 7.1) allows you to show or hide the Field list, so if you still don’t see the Field 
list, with the table selected click that button to display it.

F I G U R E 7 . 5 When a new pivot table is selected, you’ll see the PivotTable toolbar and 
Field list by default.

The Field list shows you the names of all the fields. Fields that are already included in the 
pivot table are shown in bold, whereas the Value field, which is not included in this table, is 
not in bold.
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As Table 7.1 shows, the PivotTable toolbar includes tools that allow you to change a lot of 
options and settings for the entire table, or for individual fields. As with other toolbars, run-
ning your mouse pointer across the buttons reveals tooltips that tell you the button names. The 
PivotTable button on the toolbar is especially helpful and includes many choices for format-
ting and organizing the fields. Remember that the pivot table must be selected in order to use 
this toolbar, so if the buttons are grayed out, click any cell within the pivot table to select it. 
Most of the options on this toolbar are also available when you right-click on any cell within 
the pivot table.

Spend some time exploring these buttons and right-click options. Next, we’ll look at the 
pivot table itself.

Drag the toolbar and the Field list so they are not blocking the pivot table. If you compare 
what you see in the pivot table with the picture in step 10 of Exercise 7.9, this should begin 
to make sense to you.

Notice, at the top, the field name Month appears, and to the right of that, there’s a drop-
down that displays All. This means that all three months are included in this report and that 
the report is based on the Month field because we moved that field to the Page section.

T A B L E 7 . 1 Buttons on the PivotTable Toolbar and What They Do

Button Name Description

PivotTable A dropdown that includes display and setting choices

Format Report Lets you choose an AutoFormat

Chart Wizard Produces a pivot chart based on the pivot table

Hide Detail/Show Detail Switches between summaries or detailed listings for any field

Refresh Data Updates the pivot table with any changes made to the orig-
inal data used to produce the report

Include Hidden Items in Totals A toggle that turns on or off any hidden data that was in the 
original worksheet

Always Display Items A toggle that overrides any settings in the worksheet and 
displays everything

Field Settings Displays the setting options for any selected field

Show/Hide Field List A toggle that turns the Field list on or off
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Below the Month field name is Sum of Quantity. This tells you that the Quantity field is the 
field shown in the Data section and that it is calculating totals of each quantity, using the SUM 
function.

To the right of Sum of Quantity, you can see the field name Company; below that, the com-
pany names appear as column headers because we moved the Company field to the Column 
section.

And, below Sum of Quantity, you can see the Product field name with the individual prod-
uct names listed row by row below that. This is because we moved the Product field to the 
Row section.

Finally, look at the bottom and rightmost column of the pivot table. As you can see, Grand 
Totals are automatically calculated based on what is displayed.

Now, here is where the real beauty of pivot tables comes in. We can use these drop-
downs, as well as the toolbar, Field list, and right-click menus to totally change this report 
to display exactly what we want—or don’t want. In Exercise 7.10, we’ll totally revamp this 
pivot table.

E X E R C I S E  7 . 1 0  

Editing and Manipulating the Pivot Table Display

Still inside Exercise 7-10.xls, make sure you are on the PivotTable sheet and that the pivot 
table is selected.

1. Click the dropdown in cell B1; as you can see, All is selected, so the totals shown are for 
all three months. Choose February and click OK. This changes the report to display only 
the total quantities ordered in February. Also, notice that the Grand Totals have changed 
to reflect only February’s data.

2. Right-click cell A3, which says Sum of Quantity, and choose Field Settings from the short-
cut menu. In the Name box, highlight Sum of Quantity (if it’s not already highlighted) and 
type Average Items Purchased to replace it. Then, choose Average from the list below 
and click OK.

Note that the amounts in cells B5:C6 do not change, because each of these companies 
has only one value per item, per month in the original worksheet. However, the grand 
totals at the bottom have changed to show the average for each company, and the 
grand totals on the right now display an average for each product.

3. Click the Undo button on the Standard toolbar to remove the averages and return the 
sums. Select cell A3. Then click the Field Settings button on the toolbar, change the name 
to Items Purchased, and click OK. (Note the toolbar button displays the same Field Set-
tings box you saw when you used the right-click method.)
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4. Display the Field list if it’s not already showing and click the Value field. Hold your mouse 
button down and drag that field onto the pivot table. Drop it on cell C6. Now you have two 
fields in the Data section; your display should look like this:

Notice that you also have a Data dropdown in cell B4, where you can choose to display 
only the Items Purchased or the Sum of Value.

5. Right-click cell B6 and choose Field Settings. Change the name to Dollar Amount and 
click OK.

6. Select any cell in row 1 and insert a blank row above it. In cell A1, type Monthly Report 
and press Enter. Format A1 to be a 20 pt. bold font.

7. Click in any cell within the pivot table and click the Format Report button on the PivotTable 
toolbar. Select the Report 6 format, which is the third one down in the right column. Click OK.

Notice that an AutoFormat overrides a lot of the choices you made. Not only do the font 
and background colors change, but also the field layout is rearranged by this format.

8. Select the range D5:D13 and click the $ on the Formatting toolbar.

E X E R C I S E  7 . 1 0 ( c o n t i n u e d )
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9. Click cell C4, which now holds the Items Purchased field name. Hold your mouse button 
down and drag the field outside of the pivot table. When you do, the mouse pointer 
changes to show a red X. When you see the red X, release your mouse button and Excel 
removes the field from the pivot table.

10. From the Field list, drag the Quantity field and drop it anywhere in column B within the 
pivot table. Click outside your pivot table to deselect it. Your new pivot table should look 
like this:

11. Select the pivot table again, then click the PivotTable button on the PivotTable toolbar 
and choose Table Options. Deselect the Grand Totals For Columns checkbox and click OK. 
Notice that the bottom row of the pivot table is now gone.

12. Choose Tools � Options. In the Options dialog box, click the View tab. In the bottom sec-
tion, Window Options, deselect the Gridlines checkbox, and then click OK.

13. Use the Save As dialog box to save the file in your Chapter Seven folder and name it Exer-

cise 7-10A.xls. Close the file.

E X E R C I S E  7 . 1 0 ( c o n t i n u e d )
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Well, I don’t know about you, but I prefer the look of that pivot table we made over the 
original worksheet. If you want to compare yours with mine, just extract the Exercise 7-10A.xls 
workbook from the zipped file for this chapter.

I’m sure you will be impressed with the flexibility of pivot tables. For example, in the one 
we just created, it’s a snap to use the Month dropdown box to display a different month, so 
you can print multiple reports from this pivot table with ease.

I highly recommend you spend some time trying all of the different pivot table options and 
settings until you are comfortable with changing them. Also, get comfortable with adding and 
removing fields, or dragging fields from one location to another. And, if you want to return 
to the Layout box you used in the wizard, you can always select your pivot table and then 
choose Data � PivotTable and PivotChart Report to return to Step 3 of the wizard, where you 
can click the Layout button and make your changes.

Once you have finished playing with pivot tables, it’s time to make a pivot chart.

Producing a Pivot Chart

As I said earlier, pivot charts are not used nearly as often as pivot tables, mainly because a 
pivot table produces such a nice presentation of the data and a chart is rarely needed. Another 
reason is that a pivot chart is more tied to its layout than a regular chart, and therefore, some 
of the normal chart options are unavailable.

The main difference between pivot charts and regular charts is that you can add the value 
and category series by dragging the field names onto the axes, instead of choosing them in the 
Chart Wizard (as you did in Chapter 2, “Formats, Graphics, and Excel’s Templates” when 
you learned how to create charts). Therefore, if you are producing a chart from a worksheet, 
it’s usually best to use the Chart Wizard instead of the PivotTable and PivotChart Report com-
mand from the Data menu; that way, the chart will be more flexible and customizable (as you 
learned in Chapter 2). But, if you want to reproduce the pivot table field layout in a chart for-
mat, the easiest way is to create a pivot chart based on an existing pivot table. Let’s give that 
a try in Exercise 7.11.

E X E R C I S E  7 . 1 1  

Using a Pivot Table Layout to Create a Pivot Chart

1. Open the workbook Exercise 7-10A.xls that you saved in the previous exercise. (If you 
didn’t save it, extract it from the zipped file for this chapter.)

2. Move to the PivotTable sheet and click on the pivot table to select it.

3. On the PivotTable toolbar, click the Chart Wizard button.

Because the layout was already determined when you created the pivot table, the wizard 
doesn’t run you through any steps. Instead, it automatically creates the chart for you, 
using the same field layout you chose when making the pivot table.
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Once the chart is produced, most of the normal chart options for formatting are the same 
as in any other chart. Let’s try a few customizations.

4. Click on any one of the blue columns and choose Format � Selected Data Series. Click the 
Options tab and select the option Vary Colors By Point. Click OK.

In the top-left corner of the chart, it shows February as the month (because this was the 
month displayed in the pivot table).

5. From the Month dropdown box, choose January and click OK. The chart changes to show 
January’s information.

6. Click anywhere in the white background behind the chart to select the Chart area (your 
Name box will say Chart Area if you have the correct area selected). Then, choose Format � 
Selected Chart Area.

7. On the Patterns tab, click the Fill Effects button and choose a light-colored texture as a 
background for your chart. Click OK twice to return to the chart.

8. Change the sheet tab name for the chart to PivotChart.

9. Choose Chart � Chart Options. Click the Titles tab and change the Chart title to January 

Sales. Click OK.

10. As you can see, the column that represents Hair Replacers for Fun Gadgets, Inc. 
shows 75 items purchased. Move to the QtrOneSales sheet and change the value 
in cell D11 to 175.

11. Return to the PivotChart sheet, and you’ll see that the 75 has not changed. Click the 
Refresh Data button on the PivotTable toolbar to update the value on the chart.

Also, because this chart was produced via the pivot table layout, the changed column 
moves to a different location. This is one of those layout glitches that happens when you 
refresh pivot table data in a pivot chart. It’s also one of the reasons I prefer normal charts.

12. Move to the PivotTable sheet and you’ll see that January is now displayed (instead of 
February) and the value has been refreshed to show 175.

When you changed the page display on the chart from February to January, that change 
affected the pivot table as well because the table and chart are linked. (This is yet another 
reason I prefer normal charts. Most of the time I don’t necessarily want my pivot table 
changing every time I change my chart.)

13. Save the file into your Chapter Seven folder and name it Exercise 7-11.xls. Then close 
the file.

E X E R C I S E  7 . 1 1 ( c o n t i n u e d )
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I guess you can see I’m a huge fan of pivot tables but less fond of pivot charts. However, 
the important thing is that you understand how to create and edit both, so experiment with the 
various options until you do. When you are satisfied with your progress, move on to the next 
section, which teaches you how to use the advanced formatting features in Excel to further 
customize the display of your data.

Using Advanced Formatting Techniques
So far we’ve shown you how to organize the layout of your data. This section expands on this 
concept by teaching you how to use formatting to control the display of your data even more. 
In Chapter 2, you learned most of the formatting techniques, but the MOS Expert Objectives 
include two more: custom data formats and conditional formatting. Custom formats give you 
almost total control over how data is shown in a cell, and conditional formatting changes 
the format of a cell, based on criteria you supply. Remember, in Excel, formatting not only 
includes font attributes and color, but also the way the text in a cell is interpreted and 
displayed.

Sometimes the formats provided on the Number tab in the Format Cells dialog box don’t 
give you the display you want, so you use custom formats to tweak the settings. A good example 
might be part numbers on an inventory sheet, which often begin with one or more zeroes. By 
default, Excel does not display leading zeroes, so a custom format fixes this shortcoming. Or, 
maybe you want certain text automatically added to whatever is typed in a cell, and a custom 
format can do this for you.

Overdue bills or inventory amounts that have gone below a certain level can often be over-
looked in a large array of data. If you have a large worksheet that includes various types of 
data, conditional formatting can make certain data more obvious.

Both of these features are often used in the world of Excel, so let’s examine them fully, 
beginning with custom data formats.

Controlling Data Display with Custom Formats

As you learned in Chapter 2, the Number tab in the Format Cells dialog box gives you many 
options for different data formats (percentages, currency, fractions, zip codes, etc.). However, 
every once in a while, none of the standard formats fits your specific need.

Figure 7.6 shows some of the format type choices you have when you select Custom in the 
Format Cells dialog box. The list on the right of the dialog box displays various symbols that 
produce custom formats: # represents a numerical character; @ represents text; and * and ? are 
wildcards. You can use these symbols in combinations with actual text or numbers you want 
displayed to produce all kinds of cool stuff. Selecting any format type in the list displays the 
value you have in the active cell, with the chosen format applied in the Sample box above the list.

Open the Format Cells dialog box and scroll through the list of custom formats. As with 
any formats, you can apply a custom format to cells that already contain data. Or you can 
apply the format to empty cells, and the data will reflect the format when you type it in later.
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F I G U R E 7 . 6 Custom data formats use symbols and characters to alter the display of the 
data in a cell.

The Type list also contains custom date and time formats, which are shown using place-
holders like h, m, s, and so forth. We’ll learn how to create some of these as well.

Try applying some of the formats listed in the dialog box. Next I’ll show you how to create 
your own, starting with custom text and number formats.

Controlling Text and Number Display

As I explained earlier, a # sign signifies a number in a custom format and an @ symbol means 
text. If you apply a custom format that is simply one @ symbol, it’s the same as choosing Text 
from the Category list in the Format Cells dialog box. You create a custom format by simply 
entering it in the Type box above the list in the dialog box (see Figure 7.6). You can also include 
specific text characters in a format by enclosing them in quotation marks. For example, a cus-
tom format of "Sales Amount  "# would add the words Sales Amount before any number you 
type in that cell. Certain text characters are automatically recognized by Excel and don’t require 
the quotation marks, but if you type any string of text characters in a custom format, you must 
use the quotation marks. Table 7.2 shows a list of the characters that Excel will recognize as 
text without the quotation marks.

T A B L E 7 . 2 Characters That Are Recognized as Text Without Quotation Marks 

Character Description Character Description

$ Dollar sign - Minus sign

+ Plus sign / Slash mark

( Left parenthesis ) Right parenthesis
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You can create formats to add color by enclosing the name of the color in brackets. Also, 
you can create special formats for negative numbers by preceding the format with a semicolon. 
Let’s try creating some of our own text and number formats in Exercise 7.12.

In the following exercises, I use the Format Painter quite a bit, so if you don’t 
remember how to use that feature, refresh your memory by rereading the 
Format Painter instructions in Chapter 2.

: Colon ! Exclamation point

^ Caret & Ampersand

' Apostrophe ~ Tilde

{ Left curly bracket } Right curly bracket

< Less Than sign > Greater Than sign

= Equal sign  Space character

E X E R C I S E  7 . 1 2  

Applying Text and Number Custom Formats

1. Open a new blank workbook and type 100 in cell A1. Then fill that down the column to cell 
A3 so that you have 100 in all three cells.

2. Select cell A1 and choose Format � Cells. On the Number tab, select Custom from the 
Category list on the left.

3. In the Type box on the right, highlight the word General and delete it.

4. Now, in that box, type 0000 (four zeroes). Notice that the Sample box shows a leading 
zero has been added before the 100.

5. Click OK and 0100 appears in cell A1. Use the Format Painter to copy the format from A1 
to B1. Then, type 25 in cell B1 and press Enter. The 25 adjusts to show 0025 because the 
0000 custom format tells Excel to fill in zeroes when any number less than four digits is 
typed in the cell.

T A B L E 7 . 2 Characters That Are Recognized as Text Without Quotation Marks (continued)

Character Description Character Description
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6. Select cell A2 and return to the Format Cells dialog box by pressing Ctrl+1. Give this cell 
a custom format of "I have "#" friends" (be sure to include spaces between have and " and 
" and friends). Look at the Sample box; as you can see, the text surrounds the number, 
as shown here:

7. Click OK and “I have 100 friends” is displayed in cell A2.

8. Use the Format Painter to copy the format from A2 to B2. Type 6000000 in cell B2 and 
press Enter. Note that the # includes all numbers typed into the cell, as opposed to the 0, 
which specifies a single numerical character.

9. Select cell A3. Return to the Format Cells dialog box and type [red]#;[blue]# " too low" 
(don’t miss the space between the first quotation mark and the word too). The Sample 
box doesn’t show any change because color formats are not displayed. Click OK.

10. Excel now displays 100 in red in cell A3. Use the Format Painter to copy the formatting 
from A3 to B3. Type -900 in B3 and press Enter. Excel changes that entry to “900 too low,” 
in blue.

11. Select cell B3 and return to the Format Cells dialog box. See the custom format in the 
Type box. Delete the # sign after the word [blue] and click OK.

Now B3 shows just the text “too low,” with no number.

12. Save the file in your Chapter Seven folder and name it Exercise 7-13.xls. Leave it open for 
the next exercise.

E X E R C I S E  7 . 1 2 ( c o n t i n u e d )
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The possibilities for custom text and number formats are limitless. Get creative and try dif-
ferent combinations of symbols, text, and colors to see what you can come up with. Don’t forget 
to use negative number formats too. Next, let’s see how to create custom date and time formats.

Controlling Date and Time Display

In Chapter 5, “Formulas and Functions in Excel,” you learned that Excel differentiates between 
times of day and time periods. Well, you can use custom date and time formats to control not 
only the way a date or time is presented, but also whether Excel sees the value as an actual time 
of day or a time period or span of time. The key is to use brackets, [ ], in your custom formats.

The custom formatting characters used for dates and times are shown in Table 7.3.

T A B L E 7 . 3 The Formatting Characters to Use for Date and Time Custom
Formats 

To Display As Use This

Months 1–12 m

Months 01–12 mm

Months Jan–Dec mmm

Months January–December mmmm

Months J–D mmmmm

Days 1–31 d

Days 01–31 dd

Days Sun–Sat ddd

Days Sunday–Saturday dddd

Years 00–99 yy

Years 1900–9999 yyyy

Hours 0–23 h

Hours 00–23 hh

Minutes 0–59 m

Minutes 00–59 mm
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Scroll through the list of custom format types to see your numerous choices. However, as 
with the custom text and number formats, you may need more, so Exercise 7.13 shows you 
how to create your own, and even combine them with text formats.

Seconds 0–59 s

Seconds 00–59 ss

Time 4 AM h AM/PM

Time 4:36 PM h:mm AM/PM

Time 4:36:03 P h:mm:ss A/P

Time 4:36:03.75 h:mm:ss.00

Time span (hours & minutes) 1:02 [h]:mm

Time span (minutes & seconds) 62:16 [mm]:ss

Time span (seconds & hundredths 
of seconds)

3735.80 [ss].00

E X E R C I S E  7 . 1 3  

Applying Date and Time Custom Formats

1. Still inside the workbook you saved in the previous exercise , select cell A5 and return to 
the Format Cells dialog box.

2. Type in this custom format: mm/dd/yyyy", " h:mm:ss (don’t forget the space between 
the comma and the second quotation mark). Note that the Sample box is empty because 
we have no data in the selected cell. Click OK.

3. In cell A5, type 1/1/05 6:45 (note the space between the date and time). Press Enter.

Excel expands the day and month to two digits and the year to four digits, then adds the 
comma and finally the seconds.

4. Select A6 and return to the Format Cells dialog box. This time, type [h] and click OK.

T A B L E 7 . 3 The Formatting Characters to Use for Date and Time Custom
Formats (continued)

To Display As Use This
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If you had any difficulties with the date and time exercises here, or if you did 
not get the results I did, open my copy of Exercise 7-13.xls and compare my 
formats and data with yours.

Again, the best way to understand all the custom format choices is to apply some and see 
how they affect your data display. Practice makes perfect, so don’t give up.

When you are ready to move on, this last section teaches you how to apply conditional for-
matting based on criteria you choose.

5. In cell A6, type 1 and press Enter.

Excel converts the number 1 to 24, which is the number of hours ([h]) in one (1) day. How-
ever, to see what Excel is really seeing, select A6 again and look at the Formula bar. As 
you can see, Excel displays 1/1/1900 12:00:00 AM. This is because the first year Excel rec-
ognizes, by default, is 1900 and 1 would be the first hour (12 AM) of the first day (January 1) 
of that year.

6. Use the Format Painter to copy the format from A6 to B6 and C6.

7. In B6, type 10 and press Enter. You get 240, which is the number of hours in 10 days, and 
the Formula bar shows the tenth (10) day of the first year.

8. In C6, type =b6-a6 and press Enter. The result is 216, which is the difference between 24 
and 240.

It’s obvious that you would not want to use the [h] format to display individual dates, but it’s 
the perfect format to use when you want to see the time span between the two days, dis-
played in a number of hours. Let’s combine some formats to show how to use these 
together.

9. Select the range A7:B7 and choose Format � Cells. Apply a custom format of mm/dd/

yyyy h:mm (note the space between the last y and the h). Click OK.

10. Select cell C7 and use the Format Cells dialog box to apply a custom format of [h]:mm. 
Then click OK.

11. In cell A7, type 1/1/99 5:15 and press Enter. The date is reformatted accordingly.

12. In cell B7, type 2/1/2000 9:45 and press Enter. Again, Excel applies the custom format.

13. Now, in cell C7, type =b7-a7 and press Enter. And there you have it. The time span 
between the dates and times in A7 and B7 is 9,508 hours and 30 minutes.

14. Save the file to update it and then close the file.

E X E R C I S E  7 . 1 3 ( c o n t i n u e d )
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Controlling Data Display Using Conditional Formatting

The custom formats discussed in the previous section are mostly used to determine how the 
data will be laid out in the cell, though you also learned how to control font colors somewhat. 
However, these displays are relatively static, meaning that no matter what you type in the cell, 
the same format will be used. Also, you cannot use custom formats to control the background 
color of a cell. This is where conditional formatting comes in.

Conditional formatting allows you to change the text or background color in any cell based 
on conditions you set up. You can apply up to three conditional formats, so, in essence, you 
could actually have four: three formats based on three different conditions, and one format 
that is applied if none of the three conditions are met.

You can set up conditions that pertain to the active cell, or you can use formulas within the con-
ditional formatting that change the colors in the active cell if the condition in a different cell is met.

First, I’ll show you how to apply conditional formatting based on the contents of the active cell.

Applying Conditional Formats Based on Conditions 

Met in the Active Cell

Think of a worksheet that shows your customers and their amounts due to you. If you have 
hundreds of customers, it’s often difficult to find the ones whose balances are getting danger-
ously high. Sure, you could sort the data in descending order by the Amounts Due column so 
that the largest amounts float to the top. But sometimes sorting your data displays it in a way 
that’s inconvenient for your purposes, so you have to keep sorting and re-sorting. And, if you 
forget to sort it this way, those high balances are lost in a myriad of data.

Conditional formatting lets you apply background color and font formatting to any cell 
based on the criteria you set. That way, Excel displays that data in a more obvious way as soon 
as you open the worksheet. Exercise 7.14 shows you how.

E X E R C I S E  7 . 1 4  

Using Conditional Formatting to Flag Cells Containing Important Data

1. Open the file Exercise 7-14.xls. This worksheet shows a list of customers, with the 
amount they owe and the date it is due.

2. Select the range B2:B8 and choose Format � Conditional Formatting. Excel opens this 
dialog box:

3. The first dropdown should say Cell Value Is. If it does not, use the dropdown to select Cell 
Value Is.
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Though you see the Borders tab in the Format dialog box, applying borders 
in conditional formatting does nothing, so don’t bother.

As you can see, setting up conditional formatting for the active cell or range is fairly straight-
forward. Explore some of the other options in the second dropdown box, such as Between, Not 
Between, or Equal To, so you are aware of the choices you have. Once you grasp the concept 

4. The box to the right of this should say Between. Click the dropdown for this box and 
choose Greater Than.

Note when you change the option displayed in this box, the box(es) to the right will 
change also.

5. In the box to the right, type 1000.

6. Below that box, click the Format button to the right of the No Format Set box.

7. On the Font tab, set up the font to be bold, red, and double-underlined. Click OK. The pre-
view shows your choices.

8. Click OK to return to the worksheet.

Note that all amounts in column B, except the first one, are bold, red, and double-under-
lined because they all contain values greater than 1000.

9. With the range still selected, return to the Conditional Formatting dialog box.

10. Change the value from 1000 to 5000.

11. Click the Add button to add a second condition.

12. In the second condition, be sure the first box says Cell Value Is and use the dropdown on 
the second box to choose Less Than Or Equal To; then type 5000 in the box to the right.

13. Click the Format button for the second condition and choose bold on the Font tab; then 
click the Patterns tab and choose yellow. Click OK.

14. Check out the previews of the formatting for both conditions, and then click OK to return 
to the worksheet.

As you can see, numbers larger than 5,000 are bold, red, and underlined, whereas all 
other numbers are bold with a yellow background.

15. Save the workbook in your Chapter Seven folder, name it Exercise 7-15.xls, and leave it 
open for the next discussion and exercise.

E X E R C I S E  7 . 1 4 ( c o n t i n u e d )
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of conditional formatting, these choices are pretty obvious and easy to use. You can use these 
options on text and dates, as well as numbers—just remember that something like Greater 
Than means a later date or a letter that comes later in the alphabet.

When you are comfortable with the basics of conditionally formatting based on the value 
in the active cell, move on to the next section, where you’ll learn how to apply formatting to 
the active cell based on a condition met in a different cell.

Applying Conditional Formats Based on Conditions 

Met in a Different Cell

Sometimes you want your formatting applied to one cell when the value in a different cell 
meets certain criteria. Look at the data in the workbook you still have open from the previous 
exercise. Assume you want to change the color of what’s in column A when the date in column C 
is overdue. Notice the formula in cell F1 is =TODAY(), which (as you learned in Chapter 5) 
returns the current date. You need a conditional format that changes the color of the customer 
name when the value in column C is less than the date displayed in F1. Or, suppose you want 
the entire row to change color when the value in column B is greater than 5000. You can 
accomplish both of these by using formulas in the conditional format, and Exercise 7.15 
shows you how.

E X E R C I S E  7 . 1 5  

Changing the Color of a Cell or Row When Conditions Are Met Elsewhere

First, let’s copy the data to another location and clear the conditional formats so we can set 
up new ones.

1. Still inside the workbook you saved in the previous exercise, select the range A2:C8 and 
copy it. Then click in cell A10 and paste. Press the Esc key to clear the marquee.

2. Select B10:B16. In the Conditional Formatting dialog box, click the Delete button. When 
the Delete Conditional Format box comes up, select the Condition 1 and Condition 2 
checkboxes and click OK.

3. Select cell A10 and open the Conditional Formatting box again.

4. Use the dropdown in the first box to choose Formula Is.

5. Drag the Conditional Formatting box so it is not blocking the data in A10:C16. Click your 
mouse pointer in the box to the right of the dropdown you just changed.

6. With the insertion point blinking in that box, click cell C10 on the worksheet. Then type 
a < sign, and click cell F1.

Excel inserts absolute references to the cells C10 and F1, and the formula shows as 
$C$10<$F$1.
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Again, if you had any problems with the conditional formatting exercises, open my copy of 
Exercise 7-15.xls and select any cells and use the Conditional Formatting dialog box to view 
the formats and formulas I have chosen.

Congratulations on completing another chapter. This one was loaded with lots of useful 
information that will be valuable to you when you need better control of how your data is 
organized and displayed.

7. We do want F1 absolute but not C10, so remove the dollar signs from C10 so that the for-
mula now reads C10<$F$1.

8. Click the Format button and choose bold, red as the font formatting. Click OK twice to 
return to the worksheet. The store name now shows as red in cell A10, because the date 
in C10 is earlier than the date in F1.

9. Use the Format Painter to copy the conditional format from A10 into A11. The store name 
also now appears in red.

10. Change the date in C11 to a date after today; the name in A11 is no longer red.

11. Click the Undo button to return the red formatting to cell A11.

12. Select the range A12:C12 and return to the Conditional Formatting dialog box.

13. Choose Formula Is in the first dropdown, then put your insertion point in the second box.

14. Click cell C12 to add it to the box, then type < and click cell F1. This time we do want the 
C in the first cell reference to be absolute because we always want to refer to column C. 
But we want the 12 to be relative, so just remove the second dollar sign. The formula 
should now say $C12<$F$1.

15. Click the Format button and, on the Patterns tab, choose yellow. Click OK twice to return 
to the worksheet.

16. Cells A12:C12 should now be yellow. Use the Format Painter to copy the format from A12 
to A13:A16; then use the Format Painter again to copy the format from B12 to B13:B16; 
then do it once more to copy the format from C12 to C13:C16.

You must copy the formats in three steps because the cells contain formatting other than 
the conditional formatting. If you use the Format Painter to copy the formatting from A12 
to A13:C16 all in one step, your dollar amounts and dates would be formatted as text.

17. Change the date in C14 to a date later than today. Excel removes the yellow background 
color from cells A14:C14.

18. Save the file to update it, and then close the file.

E X E R C I S E  7 . 1 5 ( c o n t i n u e d )
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Summary
To have maximum control over the organization, layout, and display in your workbooks, you 
can use Subtotals, Outlines, and Data Consolidation to summarize data; link formulas both 
to worksheets and external workbooks to create dynamic updates; create pivotal reports that 
allow you to manipulate data layout; and use Excel’s advanced formatting techniques to spec-
ify the display of differing types of data and values that meet certain conditions.

Subtotals can be produced first, using the SUBTOTAL function, and then outlined manu-
ally. Or, you can use the Subtotals command to do it all in one step once the data is sorted by 
the category you want summarized. Either way, using subtotals and outlines will summarize 
data so you can pick which parts of it you want displayed.

You can also use the Consolidate command to pull information from different worksheets 
and workbooks to produce a separate worksheet that merges data into a concise summary, 
which is dynamically updated when changes are made to the original data.

Three-dimensional referenced links to data in other worksheets and workbooks can be cre-
ated manually through formulas so that information in many locations updates when a change 
is made in one place. Links can be updated to reflect a new location if the linked workbook is 
moved, and links can be broken so that the formulas are replaced with static values.

You can construct pivot tables and pivot charts to present reports that you can easily 
manipulate to change the order and layout of the data based on what parts of the worksheet 
you want compared.

And, finally, custom data formats and conditional formatting enable you to present your 
data in a more precise manner, which improves the display and makes important information 
more obvious.

Exam Essentials
Know how to group and outline data based on subtotals. Be able to identify formulas that 
use the SUBTOTAL function and know how to group and outline this data based on these for-
mulas. Know when you can use the Subtotals command instead of the function to subtotal and 
outline all in one step; also know how to change the function the subtotal is based on, both 
in the function argument and through the command.

Understand how the Consolidate command works. Be able to set up a consolidation sheet 
in a workbook and know how to add all of the ranges to the Consolidate dialog box. Also, 
know how to choose which function you want the consolidation based on (sum, average, etc.). 
Be clear on the difference between static and dynamic consolidations and know when each 
would be used.

Be able to create 3D references through formulas. Know how to create cell references 
within formulas that pull information from other worksheets and workbooks.
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Be able to change link sources and break links. Make sure you understand all the choices in 
the Edit� Links dialog box.

Know all the ins and outs of PivotTable and PivotChart reports. Get comfortable with the 
wizard and the PivotTable toolbar so that you can quickly create and edit these reports. Know 
how to move data from rows to columns and change pivot table options and settings.

Be familiar with the custom format symbols and syntax. Know how to construct custom 
formats for text, numbers, dates, and times.

Understand conditional formatting. Be able to create conditional formats based on changes 
in the active cell(s) and on other cells. Know how to apply the formatting to a range of cells 
and how to apply it to one cell and then copy it to other cells.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the file MOS Scenarios Ch7.xls from the 
zipped file for this chapter and open it before you begin.

 

MOS Scenario 18: Summarize Data Using the Subtotals and 
Consolidate Commands

The Number of Products Sold worksheet shows total numbers of products sold by different 
departments in each month. Produce a summary directly on this sheet that shows subtotals for 
each department per month with grand totals at the bottom, then display the details for the 
Housewares department only. Also, produce a dynamic consolidation report on the Consolida-
tion sheet that gives monthly averages for the departments, from the years 2000 through 2002.

 

MOS Scenario 19: Create 3D References and Apply Custom Formats 
and Conditional Formatting

On the Consolidation sheet, create formulas below the consolidated area that show the 2000 
total products sold, 2001 total products sold, and 2002 total products sold. To do this, create 
a custom data format that will add total products sold after the year when the year is typed 
in cells A21, A22, and A23. Use formulas to get monthly totals on each individual sheet. Then, 
use a formula in cells B21:B23 on the Consolidation sheet that uses these monthly totals to 
produce yearly totals. Use conditional formatting to show all yearly totals over 40,000 in red 
bold font.
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MOS Scenario 20: Remove Subtotals and Create and Format a Pivot Table

Remove the subtotals from the Number of Products Sold sheet and produce a pivot table for 
the first three months from this data on a new sheet. The table should be laid out so that indi-
vidual reports can be produced to show just one department, with totals for each of the three 
months. Display only the Housewares department. Add an AutoFormat to the table and name 
this sheet PivotTable; then put it at the end of the workbook.
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Chapter

 

8

 

Data Analysis and 
Sharing Workbooks

 

MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Locate invalid data and formulas

�

 

Trace formula precedents, dependents, and errors

�

 

Watch and evaluate formulas

�

 

Perform data analysis using automated tools

�

 

Add, show, close, edit, merge, and summarize scenarios

�

 

Share workbooks

�

 

Merge workbooks

�

 

Track, accept, and reject changes to workbooks
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This chapter is about ensuring accuracy and integrity in your 
workbooks, then being able to predict future trends based on 
current data and share your workbooks for multiuser input. And 

that’s the order in which we will tackle these topics. First, I’ll show you how to find and correct 
formula errors, and then you’ll learn how to use what-if analysis for predictions and how to 
display different predictions as scenarios. Finally, we’ll look at how to share workbooks with 
multiple users and merge different versions of workbooks into one.

In Chapter 4, “Editing Tools, Comments, and Hyperlinks,” you learned how to correct text 
errors, using the Spelling tool, AutoCorrect options, and the Find and Replace feature. Now 
it’s time to learn how to identify and correct formula errors. As you’ve seen, when you create 
formulas, Excel often attaches an option button to a cell when there’s an inconsistency in a for-
mula. You’ve also seen the errors Excel places in the cell when the formula cannot be calcu-
lated. In this chapter, I’ll show you how to locate formula errors and inconsistencies and use 
various methods to clean them up.

Once you have all of your formulas working properly, the next thing you need to under-
stand is how to use Excel’s what-if analysis tools to show how values must change to produce 
the formula results you require. For example, suppose I need to make a profit of $5,000; how 
must I adjust item prices or amounts sold to reach this goal?

Many times, when forecasting possible changes that need to be made to reach goals, you will 
come up with various solutions that produce similar or different results and you want to be able 
to view or print the different solutions within one workbook. I’ll show you how to create scenarios 
in Excel that can be saved and easily reproduced with a few mouse clicks. I’ll also demonstrate 
how to produce summary reports that show comparisons between the different scenarios.

And finally, you’ll learn how to share your workbooks with other users so that more than 
one person can contribute to the changes made in the workbook.

We’ll begin with finding and fixing formula errors so that the workbook is ready for fore-
casting and sharing.

To complete the exercises in this chapter, download the file exl2003ch08.zip from the 
book’s website and extract the files into a temporary folder before you begin.

 

Troubleshooting Formula Errors

 

In Chapter 6, “Advanced Functions, Table Arrays, and Database Features,” you learned how 
to fix a #N/A formula error by using a nested ISNA function to replace the error with some-
thing else. I also explained other functions (ISERROR and ISERR) that you can nest to replace 
errors other than #N/A. However, in most cases, you won’t want to replace the error, but 
instead will want to correct it.
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When Excel enters an error value in a cell, the error name tells you something. One of the 
first steps in evaluating a formula error is understanding what it means. Many times, armed 
with this information, it’s relatively easy to manually adjust the formula to correct the error. 
Let’s look at the different error values and what they mean. Error values include #DIV/0!, 
#N/A, #NAME?, #NULL!, #NUM!, #REF!, and #VALUE!.

 

#DIV/0!

 

The #DIV/0! error value is displayed when the formula is trying to divide some-
thing by zero, which is impossible. While you can add a zero, subtract a zero, and multiply by 
zero, you cannot divide by zero.

 

#N/A

 

N/A stands for “not available.” Excel displays this error when a formula refers to a 
value that cannot be found (usually an empty cell).

 

#NAME?

 

When text is included in a formula, without enclosing it within quotation marks, 
Excel assumes it is a named range or a function name. If the name can’t be found, #NAME? 
is the error value you get.

 

#NULL!

 

The #NULL! error value is rarely seen because it occurs when a formula refers to 
an intersection of cell ranges that don’t intersect. In most cases, Excel simply adjusts the range 
reference to correct it, so you may never actually see this error. Personally, I’ve never seen it 
(nor has the technical editor for this book).

 

#NUM!

 

If a formula refers to an invalid numeric value, the #NUM! error value is returned. 
The best example of this is a function that requires positive numbers but the referenced cell 
includes a negative number.

 

#REF!

 

When a formula refers to a cell that cannot be found, you get the #REF! error. Most 
commonly, this happens if a formula refers to a cell on a different sheet and that sheet is 
deleted.

 

#VALUE!

 

The #VALUE! error value tells you that the formula is referencing something 
that cannot be calculated. Trying to multiply a number by a cell that contains text is a good 
example.

Excel also adds a green triangle to the upper-left corner of a cell that contains an error 
value. The green triangle also appears as a warning when Excel sees something inconsistent in 
your formula or something that might need your attention, but is not necessarily an error. For 
example, dividing something by a cell that is empty will produce the #DIV/0! error, but adding 
something to an empty cell will only produce the green triangle as a warning. When you select 
any cell that contains a green triangle, you are presented with an option button that tells you 
why the green triangle is there and gives you options for removing it.

However, as helpful as Excel is, it cannot possibly know the goal of your formula, so some-
times a formula can display incorrect results without displaying an error value. Simply because 
a formula does not display an error or green triangle, never assume that you have the right 
result.

So, let’s get started on this error-checking process and first learn how to locate all of the 
errors in a worksheet.
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Locating Formula Errors

 

In smaller worksheets, the cells that contain errors are fairly obvious to see, but if the work-
sheet contains thousands of rows, there are a few ways to find all of them:

 

1.

 

Manually scroll through the worksheet and look for error values and green triangles.

 

2.

 

Use the Go To Special dialog box to select all error values (see Figure 8.1).

 

F I G U R E 8 . 1

 

The Go To Special dialog box lets you select all cells with errors.

 

3.

 

Use the Find utility to search values for # signs (see Figure 8.2).

 

F I G U R E 8 . 2

 

You can use the Find utility to find all cells with values that contain the # sign.

 

4002book.fm  Page 276  Friday, March 24, 2006  11:36 PM



 

Troubleshooting Formula Errors

 

277

 

4.

 

Use the Error Checking button on the Formula Auditing toolbar to find all error values 
and green triangles with help options to fix them (see Figure 8.3)

 

F I G U R E 8 . 3

 

The Error Checking dialog box finds all cells that contain error values and 

 

gives you options for correcting them.

 

Method 1 certainly works, but you might still miss one or two (especially the little green 
triangles, which aren’t that easy to see in a crowded worksheet). Method 2 simply selects all 
the cells with error values, but it doesn’t really let you do anything to them and it doesn’t 
find the green triangles. Method 3 finds them all and gives you the ability to manually cor-
rect them, but it doesn’t find the green triangles either. In addition, it will find other cells that 
contain # signs that have been typed in and are not errors at all. Finally, Method 4, the most 
thorough, still does not find the cells that contain # signs because the number is too large to 
be displayed.

As you can see, no one method will find everything and you may have to use a combination 
of all four methods to do a thorough job. Exercise 8.1 shows you how each method works. We 
will not make any changes during this exercise, but it’s important to learn how to use each 
method.

 

E X E R C I S E  8 . 1  

 

Finding Formula Errors, Formula Warnings, and Insufficient Column Widths

 

The file you will use for this exercise is small, so the errors are obvious. Use your imagination 
to envision the same number of errors spread out over a worksheet that has 50 columns and 
5,000 rows, and the benefits of the methods for finding formula errors I discussed in this sec-
tion will seem more relevant.

 

1.

 

Open the file Exercise 8-1.xls that you extracted from the zipped file for this chapter.

Notice that the Customers sheet contains customer numbers and names; the Products 
sheet contains product numbers, prices, and discount rates; and the Orders sheet shows 
the orders made by the customers and is full of errors.

 

2.

 

Using Method 1, described earlier, view the Orders sheet to see the errors and green tri-
angles.
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3.

 

Select cell D14, which contains a green triangle but no error value. The option button will 
appear. Rest your mouse pointer on that button; you’ll see a dropdown arrow and a tool-
tip tells you “This formula refers to cells that are currently empty.” Click the dropdown 
arrow beside the button and view the choices, as shown here:

The first line in the option button dropdown tells why the green triangle is there. The 
other lines give choices for correcting the problem; there’s also an option to ignore the 
error.

 

4.

 

In the option list, click Error Checking Options.

In the Error Checking Rules list, the option to check formulas referring to empty cells is 
selected. This explains why Excel is flagging this cell with the green triangle. Notice the 
other choices in the list. We will learn more about changing these and other options in 
Chapter 12, “Customizing Excel and Setting Defaults,” so, for now, make no changes and 
click the Cancel button to return to the worksheet.

 

5.

 

Press Ctrl+Home to move to cell A1.

 

6.

 

Press Ctrl+G or F5, or choose Edit �

 

 Go To to open the Go To dialog box.

 

7.

 

Click the Special button.

 

E X E R C I S E  8 . 1

 

( c o n t i n u e d )
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8.

 

Click the Formulas radio button and deselect Numbers, Text, and Logicals. Leave the 
Errors option selected, and then click OK.

This selects all cells that contain error values, but it does not select cells with green 
arrows, nor does it select the cells that display multiple # signs (which, as you learned, 
in Chapter 1, “Navigating in Excel and Understanding the Interface,” are displayed when 
numbers are too wide for the column).

 

9.

 

Click in any nonselected cell to deselect the cells with errors.

 

10.

 

Press Ctrl+Home to return to cell A1.

 

11.

 

Press Ctrl+F or choose Edit �

 

 Find to open the Find and Replace dialog box.

 

12.

 

In the Find What box, type 

 

#

 

. In the Look In box, choose Values.

 

13.

 

Click the Find All button.

Excel lists all cells it finds in the box below the Find All button and gives you a lot of infor-
mation, such as the cell reference, the value that contains the # sign, and the formula in 
the cell. Notice, in Figure 8.2, cell F5 shows a value of $100.00, but it was found using this 
search for #. Selecting this row in the found list reveals that the cell is displaying multiple 
#s because it is not wide enough for the number to be displayed. Also notice that Excel 
found cells A3 and C3 because they contain values with #s that were manually typed into 
the cells.

 

14.

 

Close the Find and Replace dialog box without making any changes.

 

15.

 

Press Ctrl+Home to return to cell A1 again.

 

16.

 

Choose View �

 

 Toolbars �

 

 Formula Auditing.

 

17.

 

When the Formula Auditing toolbar appears, click the first button on the left end (its tool-
tip says “Error Checking”).

As you can see in Figure 8.3, this dialog box shows the first formula that contains an 
error, along with buttons to help you fix it.

 

18.

 

Click the Next button to move to the next error. Click Next three or four more times, then 
click Previous a few times, until you’ve seen enough to understand how to navigate from 
error to error using these buttons.

 

19.

 

Click the X at the top of the Error Checking box to close it.

 

20.

 

Leave the Formula Auditing toolbar onscreen and leave the file open for the next exer-
cise. (If you made any changes to the file while exploring these methods, close the file 
without saving changes, then open it again so it’s back to its original condition.)

 

E X E R C I S E  8 . 1

 

( c o n t i n u e d )

 

4002book.fm  Page 279  Friday, March 24, 2006  11:36 PM



 

280

 

Chapter 8 �

 

Data Analysis and Sharing Workbooks

 

The method or methods you use to find the errors will depend on the size of your workbook 
and what type of errors you have. The choices you make concerning how to deal with each 
error also depend on the error type, but, just as importantly, on how the cell containing 
the error relates to other cells. Let’s move on now, and analyze and fix all the errors we found 
in Exercise 8.1.

 

Evaluating and Correcting Formula Errors

 

Many times, when you have errors in formulas, it’s because of something simple: a misspelled 
range name or a mistyped cell reference within the formula itself. Another common cause of 
formula errors is not within the cell containing the error, but within another cell to which 
the formula refers.

Many formula errors can be evaluated using common sense. For example, let’s say you have 
a formula that says =AVERAGE(J10:J25) and it’s returning a #DIV/0! error. The formula 
itself is fine: No parts are missing or misspelled. Now that we know a #DIV/0! error tells us the 
formula is trying to divide by zero and that an average is calculated by adding values together, 
then dividing by the number of values, we know we are getting this error because there are no 
numerical values in J10:J25 that can be added together. Another example is a formula return-
ing a #NAME? error. Remember that this error value is returned when a range or function 
name is not recognized. So, looking at the formula =SIM(A1:A15) that returns this type of 
error, the problem would be easy to figure out: “SIM” is not a function name Excel recognizes, 
so it must be changed to SUM.

To evaluate formula errors, you need to look at the actual formula itself, as well as using 
the Trace Precedents button on the Formula Auditing toolbar to see the 

 

precedents

 

, which 
are the other cells referred to in the formula. You can also use the Trace Dependents button 
to see the 

 

dependents

 

, which are the other formulas that contain references to this cell. To 
show you the precedents, Excel uses a thick arrow that points from the precedent cells to the 
formula cell. To show you dependents, it uses a thinner arrow that points from the selected cell 
to the cells whose formulas refer to the cell. In the example shown in Figure 8.4, the thicker 
arrow points from the range E8:E10 to the cell E11, which contains the formula using the pre-
cedent cells, E8:E10. Also, the thinner arrow points from E11:G11 to cell H11, which contains 
the formula that depends on the values in E11:G11.

 

F I G U R E 8 . 4

 

You can trace precedent and dependent cells for any formula, using the 

 

Formula Auditing toolbar buttons.
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Tracing precedents and dependents is helpful because it gives you a visual take on what’s 
going on. Seeing the actual data in the cells referred to in the formula makes it easier to spot 
the problem. As you can see in Figure 8.4, cell E11 has precedents of its own (E8:E10), but it’s 
also a precedent itself, for the formula in H11. Seeing this relationship shows you that if E11 
and H11 both showed error values, fixing the problem in E8:E10 could very well fix the errors 
in both cells. Often, fixing one error fixes many, creating a domino effect.

Look at the Formula Auditing toolbar you displayed and left onscreen in the last exercise. 
Running your mouse pointer over the buttons displays tooltips that tell you what the buttons 
do. You know the first button (Error Checking) opens the Error Checking box, which we 
explored earlier, and now you know what the Trace Precedents and Trace Dependents buttons 
do. There are also buttons that remove the precedent and dependent arrows, as well as a but-
ton that removes all arrows. There’s also a button that traces errors. This uses similar arrows 
to point to the cell referenced in the formula that is the root of the problem. The buttons for 
comments and invalid data will be discussed in Chapter 9, “Advanced Template Design and 
Workbook Security,” because they really don’t have anything to do with formula errors. The 
Watch Window button opens a window where you can keep an eye on cells that contain 
errors produced by precedent cells, so you can determine if the error is fixed in, say, cell H986 
when you make a change in, say, cell A5, without having to scroll to and from the error cell. 
And, finally, the last button on the right, Evaluate Formula, opens a box where you can walk 
through a formula step by step to see the actual point in the calculation where the error 
occurs.

Along with using the Formula Auditing toolbar, you can access most of the same com-
mands by clicking on the dropdown arrow beside the option button displayed when you select 
any cell containing a green triangle. And, of course, you can also evaluate any formula using 
common sense, by viewing the formula in the Formula bar.

Exercise 8.2 teaches you how to correct all types of errors using these different tools and 
techniques, so let’s move on and clean up the errors in the file where we identified them all in 
Exercise 8.1. Again, as in the previous exercise, the processes illustrated in this exercise would 
be more helpful in a larger workbook, so keep that in mind as you do this exercise.

 

E X E R C I S E  8 . 2  

 

Using the Formula Auditing Tools and Common Sense to Analyze 
and Remove Errors

 

1.

 

Still inside the file Exercise 8-1.xls, be sure you are on the Orders tab and that the Formula 
Auditing toolbar is displayed. (If you can’t see the toolbar, choose View �

 

 Toolbars �

 

 For-
mula Auditing.) Grab the toolbar by its title bar and drag it down to row 16 so that you can 
see all of the data.

 

2.

 

Select cell D14 and click the option button dropdown arrow. This formula refers to an 
empty cell, and you can see the formula in the Formula bar. D13 is the empty cell causing 
the warning.
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3.

 

Select D13 and click the Trace Dependents button. The arrows show that both D14 and 
F13 are dependent on the value in this cell.

 

4.

 

Click the Remove Dependent Arrows button, then type 

 

2

 

 in cell D13 and press Enter. D14 
and F13 both update and their green triangles are removed.

 

5.

 

Use the double-click method to widen Column F to display the contents. Excel replaces 
multiple # signs with the actual data.

 

6.

 

Select cell E4 and look at the Formula bar. As you can see, this is a VLOOKUP formula, 
which is looking for the value in C4 in a table array named prod. Note that the value in C4 
is 211.

 

7.

 

Use the Name box dropdown to the left of the Formula bar to select prod from this list of 
names in the workbook. This moves you to the range A2:C12 on the Products sheet. Note 
that there is no Product number 211.

 

8.

 

Move back to the Orders sheet and select C4, then click Trace Dependents. Cells E4, F4, 
and G4 all refer to this cell. Select H4 and click Trace Precedents; as you can see, H4 
depends on what is in F4 and G4. Change the value in C4 to 

 

210

 

, which is a valid product 
number, and press Enter. Excel removes the #N/A errors from cells E4, F4, G4, and H4.

 

9.

 

Select cell A10 and view its formula in the Formula bar. Note that #REF is followed by an 
exclamation point (!), which tells you this formula was referring to a sheet name but that 
sheet name no longer exists.

 

10. Select B10 and click Trace Precedents. The red arrow shows that this cell depends on 
A10, and the dotted arrow pointing to a spreadsheet icon shows it also depends on cells 
on another sheet. With B10 selected, click the options button dropdown and choose 
Trace Error. The arrow pointing to the other sheet is removed and only the arrow point-
ing to A10 remains. This means the error in this cell will be removed when we correct the 
error in cell A10.

11. Select cell A9 and note that it does not contain a formula. Select A11 and you’ll see that 
it also contains no formula. Obviously, A10 does not require a formula. It simply requires 
a customer number. In cell A10, type 6, and press Enter. Excel removes the errors in A10 
and B10. Click the Remove All Arrows button on the Formula Auditing toolbar.

12. Select cell B12 and view the Formula bar. This is another VLOOKUP, but this one is look-
ing for something in the table array named custs. Click Trace Precedents and note that 
both A12 and another sheet are being referenced in this formula. Click the Remove All 
Arrows button.

E X E R C I S E  8 . 2 ( c o n t i n u e d )
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13. Choose custs from the Name box dropdown. Note that there is no customer number 9, 
which is what is in A12. Return to the Orders sheet, select A12, and type 6. The errors in 
A12 and B12 are fixed.

14. Select cell F6 and click the Trace Error button. Note that the error is coming from D6. Look 
in the Formula bar, then check what’s in D6. D6 contains text, which obviously cannot be 
multiplied. Change the “one” in D6 to 1 and press Enter. This removes the error from F6 
and G6, but H6 still shows the #VALUE! error.

15. Select cell H6 and view the Formula bar. As you can see, it’s has a similar problem. Excel 
cannot subtract the word “none” in G6.

16. Select cell G6 and view the Formula bar.

This nested IF statement tells Excel that if the value in F6 is greater than 50, it should 
divide what’s in F6 by the discount amount returned for the product number in cell C6; 
however, if the value is F6 is not greater than 50, Excel should enter the text “none.” We 
need to adjust this formula so this cell will always have a number in it instead of text. 
(Note that cells H10 and H12 are having the same problem.)

17. Select cell G4 and double-click “none” in the Formula bar. This selects the word and the 
quotation marks around it. Type 0 and press Enter to replace “none” with 0.

18. Grab the fill handle on G4 and drag this new formula down to G13. Excel removes the 
#VALUE! errors.

19. Right-click cell H11 and choose Add Watch. This opens the Watch window and reveals 
that H11 has the #NAME? error and that the formula refers to F11 and G11.

20. Click the Add Watch button within this window. When the Add Watch box comes up, 
select cell G11 on the worksheet to add it, then click the Add button. Now the Watch win-
dow is watching both cells, as shown here:

21. Select cell E11 and click the Evaluate Formula button on the Formula Auditing toolbar.

22. The Evaluate Formula box shows the VLOOKUP formula in this cell, and the first argu-
ment (C11) is underlined. Click the Evaluate button; it evaluates C11 to return the value 
of 410, which is what is in C11. It has now underlined the second argument (prods).

E X E R C I S E  8 . 2 ( c o n t i n u e d )
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Most worksheets won’t contain this many errors at once. Generally, you will evaluate and 
correct errors as soon as you see them, instead of waiting until your worksheet is riddled with 
them. But, I promise you, if you could handle Exercise 8.2, you should be able to analyze and 
fix most formula errors you will come across.

Sometimes, you might have an error or two in a worksheet and you don’t 
have time to fix them, but you need to print the worksheet to present it to 
someone. You can suppress errors in a worksheet when printing by choosing 
File � Page Setup, clicking on the Sheet tab, and using the Cell Errors As drop-
down to choose Blank. This will suppress cells with errors in them so they 
don’t print at all (but still show when the sheet is viewed on the computer.)

Now that you know how to clean up a worksheet so that all of the formulas work correctly, 
let’s investigate how to make predictions for future goals based on data we already have.

23. Click the Evaluate button again to evaluate the second argument. It returns the #NAME? 
error, as shown in the following graphic. Now you know it’s the range name prods that 
is incorrect. Click the Close button to close the Evaluate Formula box.

24. With cell E11 still selected, double-click prods in the Formula bar to select it. Then press F3, 
select prod from the list, and click OK. Press Enter. The errors in the cells disappear and 
the Watch window shows that G11 and H11 have been updated.

25. Select H11 in the list in the Watch window and click the Delete Watch button. Then do the 
same with G11.

26. Close the Watch window by clicking the X in the upper-right corner; also close the For-
mula Auditing toolbar.

All formulas in this worksheet are now corrected!

27. Use the Save As dialog box to create a Chapter Eight folder and save this file into the new 
folder. Name the file Exercise 8-2.xls. Close the file.

E X E R C I S E  8 . 2 ( c o n t i n u e d )
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Understanding What-If Analysis
What-if analysis is used when you want to make predictions for the future. You can answer 
questions like, “If I need to make a profit of $100,000 by year’s end, how much must I sell each 
month?” or, “Based on what I’ve sold in the first six months of this year, what can I assume 
I might sell in the second six months?” To answer the first question, you would use Excel’s 
Goal Seek tool, which lets you choose a target goal, then see how your data needs to be 
adjusted to meet that goal. To answer the second question, you would add a trendline to a 
chart, which forecasts future data based on the trends seen in the current data.

Both Goal Seek and trendlines are included in Excel by default. In addition, Excel also has 
some add-ins that are included when you install the program but not loaded by default. These 
add-ins give you even more tools that you can use for forecasting and analyzing data. Both the 
Analysis Toolpak and Solver are add-ins that can give you many more options when predict-
ing and analyzing data.

Once you’ve set up your predictions and viewed them, you can save them as scenarios. Sce-
narios let you quickly view different forecasts based on different information, without having 
to reconstruct the data over and over. And, you can even create a scenario summary report, 
which will show you various outcomes based on different changes.

Let’s look at what’s installed and loaded by default first, because these are the tools you will 
use most often. Then we’ll move on to explore some add-ins.

Using Goal Seek and Trendlines

A common concern for many people is the bottom line. In sales workbooks, the bottom line 
usually is, “Here’s what I need to make. How can I adjust my pricing and sales volume to make 
this much?” Goal Seek does this easily for you. It lets you set a goal and then see how certain 
cell values must change to meet this goal. Before you set goals, though, it’s best to first see if 
you are already going to meet that goal before you make any changes. Obviously, if you are 
already selling enough to meet your goal, there’s no need to change anything (unless you are 
really greedy). So, before you use Goal Seek, you might first want to create a chart and add a 
trendline to it, which will show you what you’re likely to make if your sales volume and prices 
stay the same as they are now.

Exercise 8.3 shows how you can easily add a trendline to a chart.

E X E R C I S E  8 . 3  

Adding a Trendline to a Chart

1. Open the file Exercise 8-3.xls and move to the Sales Trends sheet.

This is a simple chart that shows sales for each month, based on the data in A1:B8.

2. Click on the chart to select it.

3. Choose Chart � Add Trendline.
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So, you can see that using a trendline gives you an idea of where your sales would be at a 
future date. If the trend shows an amount that is less than what you need, you can use Goal 
Seek to figure out what you have to do to reach that goal.

When you use Goal Seek, the cell you set as the goal must include a formula that refers to 
the cells that would have to change to meet this goal. Let’s use Exercise 8.4 to give this a try.

4. In the Add Trendline box, on the Type tab, select Linear.

5. Click the Options tab and, in the Forward box type 5 to show a forward trend of five peri-
ods (months). Click OK.

Based on the sales for the first seven months, there’s a trend that shows the sales for the 
last five months of the year will slowly drop to less than $200,000.

6. On the worksheet, change the amount in B8 to 500000 and press Enter.

See, if we had a killer month in July, our last five months would look much better.

7. Click the Undo button to change the July value back to $175,000.

8. Change the value in B6 to 500000 and press Enter.

This also shows an upward trend, but not as dramatic as the previous one because Excel 
recognizes that sales went down after May.

9. Save the file in your Chapter Eight folder and name it Exercise 8-4.xls. Leave it open for 
the next exercise.

E X E R C I S E  8 . 4  

Meeting Goals Using Goal Seek

1. Still inside the file you saved in the last exercise, move to the Orders sheet.

This sheet shows product sales amounts. Note the formulas in D2:D10 are multiplying 
the amount ordered in column B by the price in column C; cells B11 and D11 are summing 
what’s in those columns. Let’s say we need to sell $200 worth of Product #312, so we 
need to know how many of them we have to sell at the current price.

2. Select cell D5 and choose Tools � Goal Seek.

3. In the Set Cell box, D5 appears because you selected it before you opened this box. How-
ever, if this box does not show D5, click cell D5 on the worksheet to enter it in that box.

4. Press the Tab key to move to the To Value box and type 200, which is the amount we need 
to make.

E X E R C I S E  8 . 3 ( c o n t i n u e d )
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No matter what method you use to make your predictions, you can create scenarios to 
show different outcomes based on different data changes and then produce attractive reports 
using these scenarios.

5. Press Tab to move to the By Changing Cell box, then click cell B5 on the worksheet to 
enter it there.

As you can see here, Excel displays “Set cell D5 to value 200 by changing cell B5”:

6. Click OK. The box tells you that Goal Seek was able to find a solution. Click OK again.

Now you see that in order to make $200 in sales, you need to sell 13.33333333 of the prod-
uct. That’s pretty ridiculous, so change the format of B2:B11 to show no decimal places.

Is it reasonable to assume we can sell 13 of this product? Maybe not. Assume we know 
we can sell this product as long as we keep the price under $30 and we’re pretty sure we 
can sell 7 of them. Let’s try another solution.

7. Change cell B5 to 7.

8. Select cell D5 again and return to the Goal Seek box.

9. Make sure D5 appears in the first box, and type 200 in the second box again. But, this 
time, type c5 in the By Changing Cell box.

10. Click OK and note that Excel found a solution again. Click OK.

This solution is more realistic, based on what we know.

Let’s try one more. This time, assume we need to have a total sales of $1500. We know 
our best-selling item has always been product #510, so we assume we can promote this 
item more to increase its sales, but how many do we need to sell?

11. Select cell D11 and return to the Goal Seek box.

12. Use the instructions in the previous steps of this exercise to set cell B11 to the value 1500 
by changing cell B9. Click OK twice to return to the worksheet.

13. Save the file to update it, and then close the file.

E X E R C I S E  8 . 4 ( c o n t i n u e d )
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Using Scenarios to Compare Predictions

Scenarios are similar to the custom views you saw in Chapter 3, “Organizing Data, Changing 
Views, and Printing.” However, scenarios do not rely on filters or any other manual setups to 
change the view. Scenarios rely totally on values you specify in ranges. You can set up scenar-
ios to show multiple results when values in specified cells change.

Here’s an example of when a scenario would come in handy: You will be presenting a 
report at a meeting that will show the yearly sales income based on 10 percent, 25 percent, and 
50 percent increases in prices. Now, you could edit the worksheet three times and use formulas 
to produce these amounts, copy the data to another location showing the three different 
amounts on one sheet, and then format the worksheet and add outlines so different results 
could be displayed. But doesn’t that seem like a lot of work to you? Using a scenario would 
make it easier and the report is generated with just a few clicks of the mouse.

Exercise 8.5 shows you how to add some scenarios to a workbook. You’ll also learn how 
to show different scenarios.

E X E R C I S E  8 . 5  

Adding and Showing Scenarios

1. Open the file Exercise 8-4.xls that you saved in the previous exercise. (If you didn’t save 
it, extract it from the zipped file for this lesson.)

2. On the Orders sheet, choose Tools � Scenarios.

3. The Scenario Manager shows No Scenarios Defined. Click the Add button.

4. In the Add Scenario dialog box, type Current Prices in the Scenario Name box.

5. Press Tab to move to the Changing Cells box, then drag to select cells C2:C10 on the 
worksheet.

6. In the Comment box, type Sales report based on current prices.

7. The following graphic shows how your information should look. Click OK.
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8. The Scenario Values dialog box shows all the cell values in C2:C10. Since this scenario 
is for these current values, simply click OK.

9. Click Add to add a second Scenario.

10. This time, the Scenario Name is Ten Percent Increase.

11. Press Tab to move to the Changing Cells box. This information will be the same as before, 
so C2:C10 should still be in this box. Press Tab to move to the Comment box.

12. Type Proposed sales report based on 10% increase. Click OK.

13. When the list of scenario values comes up, adjust each one to show a formula that multiplies 
it by 110 percent. For example, C2 would be =75*110%, C3 would be =25*110%, and so on.

14. Once all of the values are updated, click OK. The message box tells you that the formulas 
will be converted to values. Click OK to return to the Scenario Manager.

15. Make sure Ten Percent Increase is selected in the list of scenarios and click the Show but-
ton. Move the Scenario Manager dialog box out of the way if you can’t see the data in col-
umn C. Note that the values show an increase of 10 percent.

16. Select Current Prices in the Scenario Manager list and click the Show button. The original 
values are back in the cells.

17. Click the Add button and create a scenario for Twenty-Five Percent Increase with an 
appropriate comment. Use a formula to increase the original prices by 25 percent; for 
example, =75*125%. When done, show the scenario to be sure it worked, then show the 
Current Price scenario again.

18. Repeat Step 17, this time creating a scenario for Fifty Percent Increase and using a for-
mula like =75*150%. Remember to show the Current Prices scenario before you add the 
new one, so that your formulas are multiplying the original amounts by the percentages.

Think of shortcuts you could use to do this even faster. Here’s an example:

Type = in front of 75; then press → twice; then type *150%; then highlight *150% and 
press Ctrl+C to copy it; click into the next box, type the = sign; use the → key to move 
to the end of the number; and press Ctrl+V to paste what you copied. Repeat this pro-
cess in all boxes.

19. When you’ve created all four scenarios (see Figure 8.5), try showing them one at a time. 
Then, be sure the Current Prices scenario is the one displayed and click the Close button 
to close the Scenario Manager.

20. Save the file in your Chapter Eight folder and name it Exercise 8-5.xls. Leave it open for 
the following discussion.

E X E R C I S E  8 . 5 ( c o n t i n u e d )
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Granted, it takes a little bit of time to set up the scenarios, but when you are done, you can 
easily display any one that you want simply by going back to the Scenario Manager and select-
ing it and clicking Show.

As you can see in Figure 8.5, the Scenario Manager dialog box contains other buttons: 
Delete, Edit, Merge, and Summary. Delete is pretty obvious: select any scenario you no longer 
want and click the Delete button to remove it.

F I G U R E 8 . 5 Scenarios can be easily accessed and updated using the Scenario Manager.

Selecting a scenario and clicking the Edit button lets you change the scenario on two levels. 
The first box that comes up is named Edit Scenario; it lets you change the scenario name, the 
cells referenced in the scenario, and the comment. Once you click OK, the Scenario Values dia-
log box appears and you can edit the values for each cell.

If you have scenarios in different sheets within the workbook or in different workbooks, 
you can add them to this worksheet if you want to. Simply open the Scenario Manager and 
click the Merge button. Then, select the other sheet from the list or use the dropdown list to 
select a different workbook, and then click OK. Now those scenarios are included in this 
worksheet. If you select the new scenario in the list and click the Show button, the values from 
the cells from the other sheet or workbook will appear in this sheet. Before you can do this, 
obviously, you must have scenarios set up in a different worksheet or workbook.

Finally, one of the biggest advantages to using scenarios is the quick and easy summary you 
can produce when you have multiple scenarios. Simply choose Scenario Manager and click the 
Summary button (it doesn’t matter which scenario is selected in the list because the summary 
includes all of them). If you use Exercise 8-5.xls as an example, you will see that when the Sce-
nario Summary dialog box comes up, it shows cell D11 in the Result Cells box. This is because 
D11 is where the grand totals reside. With Scenario Summary as the chosen report, simply 
click OK and look at the beautiful report you get (see Figure 8.6): It’s fully formatted and 
shows all scenarios. (I produced this report and named the file Scenario Summary. Extract it 
from the zipped file for this chapter if you want to see it.)
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F I G U R E 8 . 6 Print Preview shows the professional-looking report you can produce in 
seconds using the Scenario Summary feature.

Print your Scenario Summary report and take it to your meeting to impress everyone. 
And if some heckler in the crowd says, “What about if we decrease prices by 20 percent?” 
just excuse yourself for a moment, run back to your office, and whip off another scenario 
to multiply the numbers by 80 percent and add that information to the report in less than 
five minutes.

As you can see, by default Excel includes really handy tools for predicting, forecasting, and 
summarizing your data. But, as I mentioned earlier in this chapter, if you turn on the add-ins, 
you can access even more tools. Let me tell you about them in the next section.

Excel’s Add-Ins

When you install Excel, a few add-ins are included but not loaded for use. Excel’s Tools menu 
contains an Add-Ins item, and if you click it, you will see the dialog box shown in Figure 8.7. 
The list shows all of the add-ins Microsoft includes for your specialized needs. Note there is 
also a Browse button, which you would use to add any add-ins you have that were created by 
Microsoft or other third-party creators.

F I G U R E 8 . 7 Add-ins give you more specialized tools and utilities.
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Some add-ins are more frequently used than others. Probably the two most popular add-
ins are the Analysis ToolPak and the Solver. Using these add-ins is beyond the scope of this 
book, but I will tell you what they do, and you can feel free to try them yourself. To activate 
an add-in, you simply click to add a check to the box beside its name (see Figure 8.7) and click 
OK. Note that when you activate any add-in, it will load every time you start Excel, so acti-
vating too many of them may greatly slow down Excel’s startup.

As you will see from the upcoming sections, some of these add-ins will give you exactly 
what you need when analyzing your data. If you find you are not using an add-in that you have 
installed and you want to remove it, simply return to Tools � Add-Ins and click the checkmark 
beside its name to remove it, and then click OK. It will no longer show in your Tools menu.

Let’s look at them one at a time in the sections below.

Analysis ToolPak

The Analysis ToolPak add-in provides you with additional analysis tools, most of which won’t 
mean much to you unless you are familiar with advanced data analysis techniques. Loading 
this add-in adds a new command to your Tools menu: Data Analysis. When you choose this 
item from the menu, you are presented with a dialog box that lists the many tools included in 
the add-in.

One of the more commonly used tools is the Histogram, which calculates individual and 
cumulative frequencies for a cell range of data and data bins. This tool generates data for the 
number of occurrences of a value in a data set. For example, in a class of 20 students, you 
could determine the distribution of scores in letter-grade categories. A histogram table pre-
sents the letter-grade boundaries and the number of scores between the lowest bound and the 
current bound. The single most frequent score is the mode of the data.

The Analysis ToolPak includes other tools, such as Random Number Generation, Regres-
sion, and Fourier Analysis. If you use these types of analysis in your work, they will make your 
life easier.

Along with these tools, the Analysis ToolPak adds many new statistical and financial functions 
to your Insert Function dialog box, which allow you to create detailed, analytical formulas.

Analysis ToolPak – VBA

The Analysis ToolPak – VBA is designed for developers who create modules and functions 
using Visual Basic for Applications (VBA). For most users, it’s way beyond the scope of their 
Excel usage, but programmers will find it very valuable.

Conditional Sum Wizard

If you can’t get your head around the array-entered formulas introduced in Chapter 6, the 
Conditional Sum Wizard add-in might help you. Installing it adds a Conditional Sum com-
mand to your Tools menu, and you can use the wizard to create a formula that sums data in 
a range when the data matches criteria you specify. I prefer using nested IF statements and 
array-entered formulas, but you may want to check out this wizard.
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Euro Currency Tools

If you do a lot of converting between US dollars and German deutsche marks or between Ital-
ian liras and Euro dollars, for example, then the Euro Currency Tool will help you. Loading 
it adds a Euro Conversion command to your Tools menu, which lets you easily convert one 
type of currency to another.

Internet Assistant VBA

Another feature for developers using VBA, the Internet Assistant VBA tool allows program-
mers to publish Excel data to the Web by using Internet Assistant syntax. The Internet Assis-
tant itself is another add-in that can be downloaded from Microsoft’s website if you want 
additional help when saving Excel worksheets for the web (see Chapter 10, “Data In and 
Data Out”).

Lookup Wizard

An alternative to using the Insert Function dialog box, the Lookup Wizard is a separate tool 
that creates lookup formulas. When it’s installed, a Lookup command appears in your Tools 
menu. I’ve never found a need to use it because I don’t see any real difference between this and 
just choosing a lookup function from the Lookup and Reference category in the Insert Func-
tion dialog box. But you can load this add-in and give it a try, if you want.

Solver Add-In

The Solver Add-In is the most relevant to this chapter. It’s basically Goal Seek on steroids. As 
you can see in Figure 8.8, Solver, like Goal Seek, shows the changes that need to be made to 
reach a goal. However, Solver adds some features that Goal Seek does not include. With Solver, 
you can set minimum and maximum target criteria instead of just a number, and you can add 
constraints (controllers) that refine the actions taken on the changing cells. If you want specific 
values within the range to override the changes made, you set them up as constraints. Then 
you click the Solve button and Solver shows you the proposed solution.

F I G U R E 8 . 8 The Solver tool allows you to add constraints to your prediction solutions.
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In most cases, and certainly within the MOS Exam objectives, Goal Seek will give you what 
you want. However, if you want more control over the solution results, try using Solver. 
When you install it, the Solver tool appears in your Tools menu.

 Well, now that you are armed with a clean workbook and have included all of your pre-
dictions and scenarios, let’s learn how to share workbooks with others for multiple-user input.

Sharing Data
Though we all have workbooks that we use for our own personal needs, many times you will 
create or use workbooks that are also used by others. Whether you access the workbook from 
a shared network drive or email a copy of the workbook to others for their input, you can set 
up the workbook so that different users can make suggested changes, which you can then 
reject or approve. You can also set up the workbook as “shared” on a common drive, which 
would allow more than one user to edit the workbook at the same time.

Remember, if you email a workbook for others to edit, any formulas that contain links to 
other workbooks will not work if the recipient does not have those workbooks as well. If the 
recipient does not need these links to be dynamic, you can simply create a second copy of the 
workbook, then choose Edit � Links and break the links before emailing the copy to them. Or, 
another option is to select the cells including the linked formulas and copy them; then, with 
the cells still selected, choose Edit � Paste Special and select Values, and then paste them right 
on top of themselves. This leaves the values but removes the formulas. Again, you would want 
to create a copy of the workbook first so that your original still includes the links.

Another advantage to creating copies of workbooks is you can then merge the copies to cre-
ate one final workbook and compare the changes made in each to reach a final decision as to 
what data you want to accept. To do this, when the copy is returned to you, you open both 
the copy and the original and choose Tools � Compare and Merge Workbooks. Then you 
select both workbooks and let Excel merge them for you.

Obviously, to ensure that everyone has access to the most recent data, you would want the 
links to remain dynamic. To do this, you would need to include all linked workbooks every 
time you email this workbook to someone. This can be a real pain in the neck, so most people 
choose to park all necessary workbooks in a location where they can be accessed by all. Gen-
erally, in a company, there is a shared network drive that all employees and contractors have 
access to. Or, in some situations a company has established an Internet or intranet location 
expressly for this purpose. Whenever workbooks are stored in shared locations, the workbook 
itself must be set up as shared; otherwise, only one user can open it at a time.

Shared workbooks do have some heavy limitations, however:
� You cannot delete worksheets or cell ranges. You can, however, insert worksheets and 

insert and delete rows and columns.
� You cannot merge cells.
� You cannot use conditional formatting or data validation. (Data validation is covered in 

Chapter 9.)
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� You cannot edit or add charts, graphics, hyperlinks, scenarios, outlines, automatic sub-
totals, pivot tables, or macros. (Macros are covered in Chapter 11, “Working with 
Macros.”)

� You cannot add or change passwords (also covered later, in Chapter 9).

However, even with these drawbacks, shared workbooks are still handy because of the abil-
ity for multiple users to edit them at the same time. In addition, you can maintain histories, 
which show all changes made by everyone.

When multiple users have access to a shared workbook, these users are referred to as a 
workgroup. When changes are made to shared workbooks, Excel uses the user’s name to iden-
tify who made the changes. The user name is specified in the Options dialog box (Tools � 
Options) on the General tab (see Figure 8.9). To do the exercises in this section, you have two 
choices: either you can find someone to be your partner when doing them, or you will have to 
change the user name in Excel every time you open the workbook as a different user to sim-
ulate a workgroup.

F I G U R E 8 . 9 User names are specified in Excel’s Options dialog box.

Note in Figure 8.9 that my user name is Linda F. Johnson. This is what will appear in the 
shared workbook, indicating changes that I’ve made. It’s also the name that will show in any 
comments I insert in a workbook (we covered comments in Chapter 4).

Before you continue with this section, be sure your name appears in this box. Then, in any 
exercise, when I ask you to “switch users,” you will return to this box and enter my user name 
(Linda F. Johnson). In my case, my primary user name will be Harry Smith. So, when you see 
“Harry Smith” in any of these exercises or graphics, Harry simulates you, and Linda F. Johnson 
is the second user. Our workgroup includes only two people, but in reality, a workgroup could 
include hundreds or even thousands of users.

Choose Tools � Options, and on the General tab, type your name in this box now. Then 
let’s look at how to set up a shared workbook.
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Creating a Shared Workbook

The first thing you will do is create a folder where shared files will be stored. In our case, we will 
use our Chapter Eight folder, which we’ve already created, but if you were doing this procedure 
on a shared network drive, you would obviously name your folder something more relevant.

When multiple users make changes to shared workbooks, the owner of the workbook can 
review the changes made using Track Changes. This feature assigns different colors to changes 
made by different users so they are easily identified.

Let’s set up a shared workbook now using Exercise 8.6. Remember, when I refer to Harry 
Smith, I am referring to your user name.

E X E R C I S E  8 . 6  

Setting Up a Shared Workbook with Track Changes and Adjusting 
History Options

1. Make sure you are using your user name and open the file Exercise 8-6.xls.

2. Choose Tools � Share Workbook.

3. On the Editing tab, select the option Allow Changes By More Than One User At The Same 
Time. Notice your name in the box below, which shows “Who has this workbook open now”:

4. Click OK. Then click OK when the confirmation box appears. Note the title bar now shows 
[Shared] after the filename.

5. Save the file in your Chapter Eight folder and name it Exercise 8-6 Shared.xls. Close the file.

6. Open a new blank workbook in Excel and switch users (change your user name to Linda 
F. Johnson); then open the file Exercise 8-6 Shared.xls.

Note that you cannot access Tools � Options without a file open, so you need to have a 
blank workbook open before you can switch users.
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7. Choose Tools � Share Workbook. My name now shows as the user currently using the 
workbook. Close the workbook.

On a network drive, if multiple users have the workbook open, all of their names will 
appear here.

8. Switch users and open the shared workbook again.

9. Choose Tools � Share Workbook and click the Advanced tab.

10. In the first section, Track Changes, choose to keep the change history for 15 days.

11. Make sure When File Is Saved is selected in the Update Changes section.

12. Also, make sure Ask Me Which Changes Win is selected in the Conflicting Changes 
Between Users section.

13. Both Print Settings and Filter Settings should be checked in the Include In Personal View 
section.

14. Click OK; your history options have now been set.

15. Save the file to update it, click OK if a confirmation box appears, and close the file.

16. Switch users and open the file again.

17. Repeat steps 9 through 14. (These settings are unique for each user.)

18. Choose Tools � Track Changes and click Highlight Changes.

Note that Track Changes While Editing is selected. This is because the workbook was set 
up as shared by the original user (in my case, Harry Smith).

19. Make sure When is selected and choose Not Yet Reviewed from the dropdown beside it.

“Who” should already show “Everyone” and therefore should not be selected. You need 
to check this option only if you want to choose a specific user from the dropdown beside 
it. The dropdown shows the name of every user who has saved this workbook. “Where” 
should not be selected either. You would use it only if you wanted to restrict these set-
tings to a specific range. Your settings should look like this:

E X E R C I S E  8 . 6 ( c o n t i n u e d )
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As you can see, even though you opened the exact same file, the changes made in the Tools 
menu did not appear. This is because you switched users and Excel recognizes the settings 
made there as unique per user. Any changes made using the Share Workbook or Track 
Changes command will appear only when opened by the user who made the changes.

However, when changes are made to the data, these changes will appear to all users sharing 
the workbook. Let’s move on now and make some changes, using different user names, to see 
how this works.

Using a Shared Workbook

Shared workbooks work differently, based on the choices you made in the Track Changes and 
Share Workbooks dialog boxes. For example, in the previous exercise, we chose to highlight 
the changes “when” they are “not yet reviewed.” This means only changes that have not yet 
been reviewed will be highlighted.

So, how do we review changes? This is done using the Reviewing toolbar to view and change 
comments added to the worksheet. To display this toolbar, choose View � Toolbars � 
Reviewing. You can leave this toolbar floating on your screen or drag it to a location and dock 
it there. (I explained this in Chapter 1.)

Table 8.1 shows all of the button names on the Reviewing toolbar and their descriptions. 
Running your mouse over the buttons displays tooltips showing the names. When you make 
a change in a shared workbook, a comment will automatically be added (see Figure 8.10). 
However, you can also add comments manually. Some of the buttons on the Reviewing tool-
bar require that you have Microsoft Outlook installed or that you are using a tablet (which 
uses a pen to draw or handwrite on the worksheet).

20. Make sure Highlight Changes On Screen is selected and List Changes On A New Sheet 
is not. Click OK. Click OK again when Excel displays a box telling you that it found no 
changes made with these specific properties.

21. Save the workbook, close it, switch users, and open the workbook again.

22. Repeat steps 18 through 20 with this user name. Then save the workbook and close it.

T A B L E 8 . 1 The Buttons on the Reviewing Toolbar and What They Do 

Button Name Description

New Comment Add a comment.

Previous/Next Comment Move between comments.

Show/Hide Comments or Show All Comments Change display to show or hide comments.

E X E R C I S E  8 . 6 ( c o n t i n u e d )
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F I G U R E 8 . 1 0 Comments showing the user name are automatically added when any 
user makes a change in a shared workbook.

Delete Comment Delete a comment.

Hide Ink Annotations/ Delete All Ink Annotations Hide or delete annotations added using a 
tablet.

Create Microsoft Office Outlook Task Create a task in Outlook.

Update File Update the file to show any changes made 
by others since you opened the file.

Send to Mail Recipient (as Attachment) Send the file as an attachment in an email.

Reply with Changes If you opened the file while it was attached 
to an email, this lets you reply to the email 
showing the changes you made to this file.

End Review End the reviewing session.

T A B L E 8 . 1 The Buttons on the Reviewing Toolbar and What They Do (continued)

Button Name Description
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Also, when reviewing, you can accept or reject any change made by any user. This is con-
trolled by the settings you chose on the Advanced tab in the Share Workbook dialog box. In 
Exercise 8.6, we chose to be asked which changes would “win” when more than one user 
changed the same data, so we have to ability to accept one and reject the other, or, of course, 
make our own change instead.

Let’s use Exercise 8.7 to make some changes and then review them.

E X E R C I S E  8 . 7  

Making Changes to a Shared Workbook and Reviewing Changes to Accept 
or Reject Them

1. Make sure your user name appears on the General tab the Options dialog box. Then open 
the file you used in Exercise 8.6 (Exercise 8-6 Shared.xls).

2. On the Orders sheet, select cell B7. Note that it is a negative number. Type 4 and press Enter.

3. Change B8 to 1 and press Enter.

4. Right-click cell B11 and choose Insert Comment from the shortcut menu.

5. Notice the comment shows your user name. Below your user name, type I fixed the neg-

ative numbers so this total is now correct.

6. Click outside of the comment to hide it.

7. Save the file to update it and close the file.

8. Switch users and open the file again.

9. Choose Tools � Track Changes � Highlight Changes and make sure the When box is 
selected; then choose Not Yet Reviewed from the dropdown. Click OK to return to the 
worksheet and note that the changed cells are outlined in color.

10. Click cell B7 and read the comment.

11. Click the Next Comment button on the Reviewing toolbar (if the toolbar isn’t showing, 
choose View � Toolbars � Reviewing).

Excel takes you to the comment in B11 that was inserted manually and skips over the 
comment in cell B8. This is because the Reviewing toolbar recognizes only comments 
inserted manually.

12. Select cell B8 to read the comment.

13. Select cell B4 and type 10. Press Enter; the cell is now outlined in a different color.

14. Select B4 again and click the Add Comment button on the Reviewing toolbar.

15. The comment shows the current user name. Type I guess you missed these orders so I 

added them. Click outside of the comment to hide it. Save and close the file.
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If you open the file you just saved, you will see that the History sheet is no longer there. His-
tories are just a temporary view. You can print them if you want to have them available at 
another time. Or, you can always choose Tools � Track Changes � Highlight Changes, 
choose All in the When box, and select List Changes On A New Sheet to see them again.

Well, we’ve made it through one more chapter. Give yourself a pat on the back. You’re 
doing great!

16. Switch users and open the file.

17. Choose Tools � Track Changes � Highlight Changes and make sure the When box is 
selected; then choose Not Yet Reviewed from the dropdown. Click OK to return to the 
worksheet; the cells changed by both users are now outlined in different colors.

18. Hover your mouse pointer over cell B4, and both the comment Excel added automatically 
and the comment you added manually appear.

19. Choose Tools � Track Changes � Accept or Reject Changes.

20. Not Yet Reviewed should now appear in the When box, and the other two boxes should 
be empty. Click OK.

21. You will see the first changed cell (depending on what cell you had selected when you 
opened this box). It shows the change made and who made it. Click Accept.

Note these buttons: Accept All will accept every change made in the workbook, Reject 
will reject this change and put the cell back to the way it was before the change was 
made, and Reject All returns all cells to their original values.

22. You see the second change. Click Accept again. Click Accept again for the third change.

23. Save the file and close it.

24. Switch users and open the file again.

None of the changes are outlined in color anymore, because they have all been reviewed 
and therefore no longer show.

25. Choose Tools � Track Changes � Highlight Changes.

26. In the When box, choose All from the dropdown. At the bottom, select List Changes On 
A New Sheet and click OK.

You now have a new temporary sheet in the workbook named History, and it shows all 
changes made, who made them, and the old and new values in the cells.

27. Save the file and close it.

E X E R C I S E  8 . 7 ( c o n t i n u e d )
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Summary
In this chapter, you learned how to clean up formula discrepancies and errors, how to use 
what-if analysis to predict trends and forecast changes, how to work with scenarios, how to 
install and use add-ins, and how to share your data. All of these techniques are important to 
know in order to fully analyze data created both by you and by others.

Formula discrepancies in your workbook display green triangles, and errors display the green 
triangles as well as error values. The error values give you information to help you trouble-
shoot the errors, but you can also use the option buttons displayed and the Formula Auditing 
toolbar to evaluate the errors and come up with methods of correcting them. You can find all 
of the errors in your workbook by manually scrolling through it, or by using the Find and 
Replace dialog box, the Go To command, or the Error Checking utility. You can also use the 
Watch window to keep an eye on any formula while you move to other places in the workbook 
and make adjustments.

Once all of your data is accurate, you can use existing data to make predictions. This is 
called what-if analysis, and you can do it by using the Goal Seek or Solver tool or by producing 
charts with trendlines. Goal Seek and Solver let you see how you need to change your data to 
reach specific goals. Trendlines, on the other hand, show you what the future will probably 
look like, based on current performance.

When you want to create reports that show different possibilities, based on your what-if 
analysis, you can create scenarios based on different situations, and then combine those sce-
narios into an attractive summary report.

To have even more tools at your disposal, load some of Excel’s preinstalled add-ins. These 
add commands to your Tools menu, including commands for wizards and advanced analysis 
and programming options.

Another part of data analysis involves sharing workbooks for other users’ input. Excel files 
can be emailed to others, as copies, then merged together with the original when they are 
returned to you. Or, you can share workbooks on network drives so that multiple users can 
edit them at the same time. Shared workbooks can show all the changes made by different 
users and allow you to accept or reject any changes made using Track Changes.

With this chapter under your belt, you’ve learned a lot about keeping data up-to-date, accu-
rate, and clean.

Exam Essentials
Know how to find formula errors and discrepancies. Understand how to scroll through a 
workbook and see the errors, how to use the Find utility to find them, how to use Go To to 
select them all, and how to use the Error Checking utility.

Be familair with all of the buttons on the Formula Auditing toolbar. Be able to trace prece-
dents and dependents in formulas and use the toolbar buttons to evaluate and correct formula 
errors.
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Be able to use the Watch window. Know how to add watches for cells containing formula 
errors so that you can see if the error is corrected in one place while you make adjustments in 
others.

Understand what-if analysis and what the various tools are used for. Know the difference 
between trends and goals, and be sure you can use both chart trendlines and Goal Seek.

Be able to use scenarios and scenario summaries. Know how to create, edit, delete, show, 
merge, and summarize scenarios.

Be familiar with all of the different options for sharing workbooks. Be able to identify 
users in a workgroup, merge different copies of workbooks, share workbooks, use Track 
Changes to accept and reject changes, add comments, and produce temporary history 
reports.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the files MOS Scenarios Ch8.xls and MOS 
Scenario Ch 8 Shared.xls from the zipped file for this chapter and open the appropriate one 
before you begin each exercise.

Use the file MOS Scenarios Ch 8.xls for the first scenario.

Use the corrected file for the next scenario. If you don’t do Scenario 21, you can extract 
MOS Scenario 21 Completed.xls from the zipped file for this chapter.

 

MOS Scenario 21: Find Formula Errors and Correct Them

Find all errors in this worksheet and correct them.

 

MOS Scenario 22: Use Goal Seek and Create a Scenario Summary

Add a total to the Salary column, then figure out what the newest employee’s salary must be 
changed to in order to bring the total salaries down to $1,260,000. Do not keep the solution 
after it’s been applied. Instead, create a Scenario Summary report to show the current salaries 
compared to a 1 percent decrease for all employees.
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Use the file MOS Scenario Ch 8 Shared.xls for this scenario.

 

MOS Scenario 23: Use Track Changes in a Shared Workbook to Accept/
Reject Changes and Produce a History Sheet

Two people have edited this file. However, the boss has asked you to review it because he 
feels they have been too generous. He wants you to review the changes and accept all price 
increases but reject all price decreases. Then, you need to remove all comments and print a 
history for your boss to see which prices have increased.
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MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Create and edit templates

�

 

Use data validation

�

 

Locate invalid data and formulas

�

 

Define and modify workbook properties

�

 

Protect cells, worksheets, and workbooks

�

 

Apply workbook security settings
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You have learned how to use so many features in Excel in the 
previous chapters, and I think it’s time you learn how to create, 
modify, and protect templates. That way, you will have all of 

these features already set up for you when you or other users create workbooks based on these 
templates. In Chapter 12, “Customizing Excel and Setting Defaults,” I’ll show you how to add 
features and settings in your default blank workbook, but this chapter shows you how to make 
alternative workbook templates to use when you don’t want to use the standard blank one. 
Sometimes you want default settings in particular templates that are different from the settings 
you have set up in your default blank workbook.

A template

 

 

 

is a preset collection of formats and data that supplies a starting point when 
used to create a new workbook. Excel template filenames have an .xlt extension, so Windows 
recognizes them as being different from workbooks with .xls extensions. Creating templates 
gives you control over how cells and the data in cells are formatted. Not only can you set cell 
formats, but you can also use data validation to add informational messages that guide users 
through correct data entry. In addition, you can create validation rules to restrict what users 
can enter in cells. You can also preset labels and values in specific cells so they are already in 
place when the template is used to produce a new workbook. Basically, almost anything you 
can do in a workbook can be saved as part of a template so you don’t have to do it again.

The two areas we’ll focus on are template design and workbook security. I’ll show you how 
to create various types of templates, using different features to control data input, and then 
how to set up security within workbooks and templates so that other users cannot change set-
tings or values you don’t want changed.

To complete the exercises in this chapter, you’ll need to download the file exl2003ch09.zip 
from the book’s website and extract the files into a temporary folder before you begin.

In Chapter 2, “Formats, Graphics, and Excel’s Templates,” you learned how to use Excel’s 
preinstalled templates. Now, in this first section, I’ll show you how to create your own tem-
plates, either by editing the ones that are already installed or by making your own from scratch.

 

Designing Templates

 

Whether you start with one of Excel’s preinstalled templates and tweak it to meet your needs 
or you create a template from scratch, you’ll find that using templates greatly reduces the 
amount of work you have to do to set up your workbooks. Once all the formatting and data 
is added to the template, it never has to be added again.

First, let me explain how templates differ from workbooks.
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Understanding Templates and How They Work

 

I have seen many people reuse the same workbook over and over. They edit the data and then 
use the Save As command to save it with a different name. In some cases, when the data being 
edited is not a significant amount, this works fine: If you are simply changing the date at the 
top of a worksheet or changing the data in only one or two cells, it’s easy to just do this and 
save it with a new name. But when you’re changing more than you’re keeping, this can be a 
lot of work. For example, think of a yearly expense report. At the end of the year, you could 
delete all of the data for that year and leave only the column and row headings intact, and then 
use Save As and give it a new name to produce a new empty expense report for the next year. 
However, inevitably, you might find you have deleted something from the original workbook 
that you need in the new one, so you have to enter it all over again. Or, maybe you had for-
mulas in the previous workbook that you’ve deleted and need to use again, so now you have 
to open the old workbook to view these formulas so that you can create them again in the new 
workbook. And what if you remove data from the original workbook, then accidentally click 
the Save button instead of using Save As? Whoops, the previous year’s expense report is now 
lost forever!

When you use a template, you access it using the File �

 

 New command, and it works sim-
ilarly to a blank workbook. You can simply enter or edit data in the workbook, then click the 
Save button and name it just as you would if you had created the new workbook starting with 
a blank workbook. The blank workbook itself is a template—albeit a template without much 
preset formatting.

It’s important for you to understand the difference between using a template and editing 
a template. Using a template allows you to produce a new workbook based on the template. 
Editing a template lets you change the actual template itself. To use a template (as we did 
in Chapter 2), you choose File �

 

 New and select a template. When you’ve finished adding 
data, you simply click Save to create a new workbook based on this template. However, to 
edit a template, you can use File �

 

 Open instead, and then locate the template file and make 
your changes. Then, when you save it, you’re updating the actual template itself instead of 
creating a new workbook based on the template. Since templates are stored in an obscure 
location designated by Microsoft, it’s usually easiest to find one by just loading it as a tem-
plate using File �

 

 New, then clicking on the On My Computer link in your task pane, which 
opens the Templates dialog box and displays them all for you. If you load a template by 
using File �

 

 New, you can use File �

 

 Save As and choose to save it as a Template (*.xlt) file. 
This would also update the actual template instead of creating a new workbook based on 
that template. In Excel’s Save As dialog box, if you choose Template (*.xlt) from the Save 
As Type dropdown, Excel will automatically open your default Templates folder. Once you 
save the template in this location, Excel includes the template name on the General tab of 
the Templates dialog box.

Let’s get our feet wet by editing one of Microsoft’s templates first. Then you’ll move on to 
learn how to make your own from scratch.
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Editing Existing Templates

 

In some cases, when you want a new template, there’s already one on your computer that 
is close to what you want. In this case, there’s no need to reinvent the wheel by starting 
from scratch; instead, it’s easiest to edit the one you already have. You can edit existing 
templates, then save them with the same name to overwrite the existing one with your new 
one. Or you can save it with a new name so that you have both available in your Templates 
dialog box.

By default, Excel has two tabs in the Templates dialog box. The General tab shows your 
blank workbook template and any new templates you create and save in Excel’s default loca-
tion. The other tab is Spreadsheet Solutions; this tab contains Microsoft’s templates that are 
included when you install Excel (see Figure 9.1). Remember, in Chapter 2, we used the Time-
card template to create a new workbook based on a template? Excel also includes templates 
to produce balance sheets, expense statements, loan amortization tables, and sales invoices. 
There’s also a Templates On Office Online button at the bottom of the Templates dialog box. 
If you’re connected to the Internet, clicking this button takes you to Microsoft’s website, where 
you can download more templates not only for Excel but also for all of the Microsoft Office 
programs. I recommend you go there and check them out.

 

F I G U R E 9 . 1

 

Excel's Spreadsheet Solutions templates

 

Usually, when you use a template created by someone else, the template is protected with 
a password so that you cannot change it. However, because Microsoft assumes you’ll want to 
modify these templates to suit your own needs, they are not password-protected.

Let’s use Exercise 9.1 to edit Microsoft’s Sales Invoice template.
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E X E R C I S E  9 . 1  

 

Making Changes to a Template

 

1.

 

Open Excel, and choose File �

 

 New. The New Workbook task pane opens.

 

2.

 

In the Templates section, click the On My Computer link. The Templates dialog box opens.

 

3.

 

Select the Spreadsheet Solutions tab, then double-click the Sales Invoice template. The 
template loads; Excel’s title bar reads, “Microsoft Excel Sales Invoice1” instead of the 
usual “Microsoft Excel Book1.”

 

4.

 

Click on the Insert Company Information Here text at the top of the worksheet. A message 
appears explaining how to use Excel’s Help files to learn how to edit the template.

 

5.

 

Try to click on any other text in the invoice and you’ll see that you can’t select those cells. 
However, you can select the cells to the right of the text (remember we learned this in 
Chapter 2). This is because the template is protected.

 

6.

 

Choose Tools �

 

 Protection �

 

 Unprotect Sheet. Because Microsoft did not password-protect 
this template, the protection is removed, and now you can select all areas and edit them.

 

7.

 

Choose File �

 

 Save. When the Save As dialog box comes up, use the Save As Type drop-
down box at the bottom to choose Template (*.xlt). When you do, the Save In box at the 
top displays Microsoft’s Templates folder. Do not change this location or your template 
will not show up in the Templates dialog box.

 

8.

 

Name the template 

 

My Invoice.xlt

 

 and click Save. (Remember, you don’t have to type the 
.xlt extension. Because you chose that as your file type, Excel will add the extension for you.)

 

9.

 

Click Insert Company Information Here. You can see by the shading of the row and col-
umn headers that this is a merged cell that includes C3:J6. Use the buttons on the For-
matting toolbar to change the font to Comic Sans MS, 12pt., Dark Blue, bold, and remove 
the italics. Then use the Fill Color button to set the fill color to Light Turquoise.

 

10.

 

With the merged cell still selected, type 

 

Choice Chocolates

 

 and press Alt+Enter. Then 
type 

 

10 Sweet Street, Candyville, PA

 

 and press Enter.

 

11.

 

Click the Invoice No text. As you can see, the Name box shows that you’re in cell L3. Click 
in the Formula bar and change the word 

 

Invoice

 

 to 

 

Order

 

 so that the cell now contains 

 

Order No.

 

 Press Enter.

 

12.

 

Click in the Name box, type 

 

m19

 

, and press Enter. This moves you to the first cell below 
the text TOTAL. As you can see in the Formula bar, this cell contains a formula.

According to this formula, if the value in L19 (unit price) is not (<>) empty (""), Excel 
should multiply L19 by C19 (quantity), then round this off to two decimal places. How-
ever, if L19 is empty, Excel should leave this cell empty too.
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Check out the other formulas in M36, M38, M39, and M40 and try to figure out what they 
are doing.

 

13.

 

Cells M38 and M39 contain formulas to calculate the sales tax on the order based on dif-
ferent tax rates you can enter in L38 and L39. Let’s assume we only have one tax rate, so 
select cells L39:M39 and press your Delete key to clear them. Then type 

 

6

 

 in L38 and press 
Enter. Note that it is formatted as a percentage with two decimal places and is converted 
to 6.00%. Return to cell L38 and click the Decrease Decimal button two times to change 
it to 6%.

 

14.

 

Click the Insert Fine Print Here text and type 

 

All Sales Are Final. 

 

Press Enter.

 

15.

 

Move to cell A1, then choose Insert �

 

 Picture �

 

 Clip Art. The Clip Art task pane appears.

 

16.

 

In the Search For box, type 

 

candy

 

. Be sure the Search In box says All Collections and 
use the Results Should Be dropdown to deselect everything except Clip Art. Click the 
Go button.

 

17.

 

Click on any one of the candy pictures that appears in the task pane to insert it on the 
invoice. Close the Clip Art task pane.

 

18.

 

Select the merged cell at the top of the invoice that holds the company name and 
address, and click the Align Right button on the Formatting toolbar. Then resize and repo-
sition the Clip Art picture that you inserted so that it sits to the left of the company name 
at the top of the invoice.

 

19.

 

Choose Tools �

 

 Protection �

 

 Protect Sheet. When the Protect Sheet dialog box opens, 
leave all the default settings, but type 

 

123

 

 in the Password To Unprotect Sheet box. 
Click OK. Then type 

 

123

 

 again when Excel asks you to confirm the password and click 
OK again.

 

20.

 

Click Save to update the invoice, then close it.

 

21.

 

Choose File �

 

 New and select On My Computer in the task pane. Note the template, My 
Invoice, appears on the General tab. Double-click to load it.

 

22.

 

Notice the areas you couldn’t select before cannot be selected again. This is because you 
protected the template. Choose Tools �

 

 Protection �

 

 Unprotect Sheet and see you’re 
prompted for a password. Click Cancel.

Try entering some items and amounts and see how the template works. When you’re done, 
close it again. Remember, when you close it, if you’re prompted to save, it’s a new workbook 
you’re saving and not the template itself. You can save it if you want, but it’s not necessary.

 

E X E R C I S E  9 . 1

 

( c o n t i n u e d )
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So, there you go. See how easy it is to take an existing template and tweak it to meet your 
needs? Did you notice some other stuff in that template, such as the dropdown list available 
where you can select the payment method? Or the instructional boxes that tell you how to use 
the template? Or how about the fact that you couldn’t select any cells with labels or formulas 
in them when it was protected but you could select other areas? Well, these are the types of 
controls you can include in a template so that users don’t enter incorrect data.

 

If you’re concerned about removing the new template you created in the pre-
vious exercise, you can move on to the section called “Organizing Your Tem-
plates” and learn how to get rid of it. However, if you leave that template on 

 

your computer for now, I assure you we will remove it later.

 

Now that you know how to edit templates, if you have any templates you have received 
from other people or have installed in your work computer, you can change them to better suit 
your needs—well, if you have the password, that is. If you don’t, you’ll have to contact the 
template’s creator to see if that individual will give you the password. Most template creators 
include contact information in the template’s properties sheet. We’ll learn how to do that, 
along with lots more tricks, when we create our own templates from scratch in this next 
section.

 

Creating Your Own Templates

 

As you saw in the previous section, as long as a template is pretty close to what you want, you 
can simply edit that template. But many times no template is available that is close to what you 
want. Or perhaps the one you want is password-protected and the creator doesn’t want to 
share. So, in these cases, it’s time to make your own. I prefer to create my own templates from 
scratch because only I know exactly what I want and I have my own layout preferences.

 

When creating templates, you’ll use most of the techniques you’ve learned 
throughout this book, so if you’re unsure of how to do anything in these exer-
cises, you may have to refer to previous chapters. Think of it as a great oppor-
tunity to learn something new while reviewing some things we’ve already 

 

covered.

 

Let’s start by setting up the formatting for a new supply-request form.

Formatting a New Template

In the first two chapters of this book, you learned how to enter basic data in cells and how to 
format cells. Now, you’ll use that knowledge to add default data and apply formats to the cells 
and ranges in your template.
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When you create a template, you can add preset labels and data and set up all kinds of for-
mats: font styles, cell formats, column widths and row heights, headers and footers, and so 
forth. You name it—if anything can be formatted, it can be included in the template.

Let’s use Exercise 9.2 to add some labels and format a new supply-request form and then save 
it as a template. Remember to refer back to Chapters 1 and 2 if you need help with any steps.

E X E R C I S E  9 . 2  

Setting Up the Basic Data and Formatting in a Template

1. Open a new blank workbook.

2. Change the Sheet1 tab name to Request Form and delete Sheet2 and Sheet3.

3. In cell A1, type XYZ Construction and, in cell A2, type Supply Request Form.

4. In cell A4, type Name: and, in A5, type Department.

5. In A7, type Item #; in B7, type Description; and, in C7, type Amount Needed.

Your data should now look like this:

6. Choose File � Save As. In the Save As dialog box, choose Template (*.xlt) as the file 
type (you’re moved to the Templates folder) and name the template Supply Request.xlt. 
Click Save.

7. Format the cells as follows:

A1—Times New Roman, 14 pt., bold, Dark Blue font. Center this text across the selec-
tion of A1:C1 and set the fill color for this selection to Light Yellow.

A2—Arial, 12 pt., Dark Blue

A4:A5—Arial, 10 pt., italic, Dark Blue

A7:C7—Arial, 10 pt., bold, Dark Blue

8. Set the width of column B to 22.

9. Widen column A so the word Department is not spilling into cell B4.

10. Widen column C to fit its content.

11. Format A4:A20 and C7 as text.
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Since this lesson is not about formatting, I chose to keep the formatting pretty simple in this 
template. However, feel free to add a company logo, background image, or anything else that 
floats your boat. Just remember that the more graphics you add to a file, the larger it becomes 
and the slower it loads.

Now that we have the basic form, let’s add some automation so that users of this template 
won’t have to type that much, and, even more important, they’ll enter the correct information 
in the form. The next section shows you how.

Automating and Controlling the Template

Look at the template we created in Exercise 9.2; as you can see, people using the template have 
to type in their name, their department name, the item number of whatever they are request-
ing, the description of that item, and how many they want. Obviously, one reason to create 
templates is to make them pretty to look at, but more important reasons are to ensure that the 
data entered is accurate and consistent and that the template makes the entry process simpler.

12. Format C8:C20 as numbers, with no decimal places.

13. Add a heavy Dark Blue bottom border to cells B4 and B5 so that the cells appear to be 
underlined.

14. Select A8:C20 and apply the same heavy Dark Blue border, but apply it both as an Outline 
and Inside, so the individual cells are completely outlined.

15. Choose Tools � Options. Click the View tab and deselect the options Gridlines and Zero 
Values. Click OK.

Your template should now look like this:

16. Click Save to update the template. Leave it open for the next discussion and exercise.

E X E R C I S E  9 . 2 ( c o n t i n u e d )
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You can automate and control data input in templates by using formulas and data valida-
tion, which lets you control the values entered in any cell or range by setting up parameters. 
You can also add field codes to the header or footer so that the information in them is dynamic 
and will update whenever the template is used. Let’s start with formulas and footer field codes.

Using Formulas and Field Codes to Speed Data Entry

The less someone has to type, the faster they get the job done. Using formulas to calculate 
results instead of making users get out their calculators is obviously a good idea. However, 
lookup formulas can also be used to pull data from other locations. Field codes can also be 
used in headers and footers to update data every time the template is opened. Both of these 
processes ensure that data is correct and up-to-date.

Exercise 9.3 shows you how to add formulas and dynamic footers to a template. (You 
learned how to create these in Chapters 3, 5, and 6, so refer back to those chapters if you get 
stuck.) We’ll do this first, then move on to data validation.

E X E R C I S E  9 . 3  

Adding Formulas and Field Codes to a Template

1. With Supply Request.xlt still open from the previous exercise, open the file Exercise 9-
3.xls that you extracted from the zipped file for this chapter.

2. Right-click the Items sheet tab in Exercise 9-3.xls and choose Move Or Copy.

3. Select Supply Request.xlt in the top box and “(move to end)” in the bottom box. Select 
the Create A Copy option and click OK. This adds the Items sheet to your template.

4. Close Exercise 9-3.xls.

5. On the Items sheet in Supply Request.xlt, name the range A2:B9 items.

6. Move to the Request Form sheet and select cell B8. Add a VLOOKUP formula, which will 
pull the description from the Items sheet when the Item # is typed in cell A8. Then edit the 
formula to remove the #N/A errors. Use the fill handle to drag the formula down to B20.

I really want you to create this formula yourself, so you know how. Refer back to Chapter 6, 
“Advanced Functions, Table Arrays, and Database Features,” for help. However, if 
you get hopelessly stuck, you can open my copy of Supply Request.xlt to see the for-
mula. Or you can use the formula you saw in Microsoft’s Invoice template as a sample 
and build a formula based on whether or not A8 is empty. Whatever formula you choose, 
cells B8:B20 should not show error values when cells A8:A20 are empty.

7. Type 101A in cell A8 to test whether your formula is working. If it is, cell B8 will show Pine 
2x4. Delete the contents of A8, since you don’t want this data in your template.

8. In cell C2, type Date: and right-align it.
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The ol’ form is looking pretty good so far, isn’t it? But there’s still a lot more we can do to 
ensure that people don’t mistype information. Imagine that you would use the results of this 
form to compile a list of items that need to be ordered. If people can’t remember an item num-
ber or if they type in their department name incorrectly, this could give you major headaches. 
This is where data validation comes in.

Using Data Validation to Ensure Accuracy and Consistency

Using data validation, you can insert messages people will see when they click in a cell. You 
can provide information, give warnings, or actually stop them from making an incorrect entry. 
You can specify whether a value has to be within a specific range (for example, between 10 and 
20 or greater than 15). You can specify what type of value it must be (number, date, etc.). You 
can even indicate the length of text allowed in a cell.

Another helpful feature of data validation is that it lets you add dropdown lists to cells so 
users don’t have to type anything at all but instead just choose from the list. When you create 
dropdown lists, you can either enter the choices manually or select them from data already 
included in another location on the sheet. Using this second option, the data in the dropdown 
list will automatically update to include any changes, deletions, or additions you made to the 
original data.

Data validation can be used in regular workbooks as well (not only in templates). But it’s 
most useful in templates because those are what you usually create when you’re distributing 
forms, invoices, and so forth for users to fill in, so it’s critical in this case.

You access the Data Validation dialog box by choosing Validation from the Data menu. This 
box includes three tabs. The first tab (shown in Figure 9.2) is the Settings tab. This is where 
you choose the type of value and any parameters that you’ll allow or disallow. Figure 9.3 
shows the second tab, which is where you enter the input message that will appear when the 
cell is selected. (Remember the message you saw in Microsoft’s Invoice template when you 
clicked the cell at the top of the sheet?) And, finally, the third tab, shown in Figure 9.4, is the 

9. In cell C3 enter the TODAY function you learned in Chapter 5, “Formulas and Functions 
in Excel,” which returns the current date.

10. Select the range B8:B20 and use the option-button menu to tell Excel to ignore this error 
(and, consequently, remove the green triangles).

11. Set up a custom footer that includes the text Printed at followed by a space, followed by 
the field code, which inserts the current time. Preview the form in Print Preview to check how 
it looks. Your footer should say something like, “Printed at 4:15 PM.” Close Print Preview.

12. Move to the Items sheet and choose Format � Sheet � Hide.

13. Save the file to update it, but leave it open for the following discussion and exercise.

E X E R C I S E  9 . 3 ( c o n t i n u e d )
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Error Alert tab; this is where you choose the level of control you want and add the message 
users will see if they enter something outside the parameters you specified on the Settings tab. 
There are three levels of control:

Stop This one displays a red circle containing an X and will not allow users to override it. 
The only option they will have is to correct the data to meet your control criteria.

Warning This one displays a yellow triangle containing an exclamation point. In this case, 
users are being warned that what they are doing is not what you recommend, but they can 
choose to override your choice with their own if they feel it is necessary.

Information In this case, they see a callout bubble with an “i” in it. This is usually just infor-
mation you’re supplying to guide them, but they will make their choices on their own.

F I G U R E 9 . 2 The Settings tab of the Data Validation box lets you choose what data can 
be entered.

F I G U R E 9 . 3 The input message is what users see when they select the cell.
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F I G U R E 9 . 4 The Error Alert type determines the level of control you have over the input. 

In Exercise 9.4, we look at some different ways to use data validation.

E X E R C I S E  9 . 4  

Applying Data Validation to Cells in a Template

1. With your Supply Request template still open, select the range C8:C20 on the Request 
Form sheet. Then choose Data � Validation.

2. On the Settings tab, choose Whole Number from the Allow dropdown; choose Less Than 
Or Equal To from the Data dropdown; and type 100 in the Maximum box. Be sure that 
Ignore Blank is selected and that Apply These Changes To All Other Cells With The Same 
Settings is not (see Figure 9.2).

3. Select the Input Message tab and make sure that Show Input Message When Cell Is Selected 
is selected. In the Title box, type Remember our budget and in the Input message box, 
type Try not to order more than 100 of any item. (See Figure 9.3.)

4. On the Error Alert tab, make sure that Show Error Alert After Invalid Data Is Entered is 
selected. From the Style dropdown, choose Warning. In the Title box, type Be Warned! 
and in the Error message box, type Ordering more than 100 of this item will reduce what 

you can order in the future. (See Figure 9.4.) Click OK.

5. Select cell C8 and note the input message. Type 100 and press Enter.

6. In cell C9, type 200 and press Enter. When you see the warning message, click Yes to 
override the warning.

7. Delete the values you typed in cells C8 and C9.
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8. Select cell B4 and return to the Data Validation box. On the Settings tab, choose Text 
Length, then choose Greater Than and type 2. On the Input Message tab, leave the Title 
box empty and type Enter your full name as the Input message. On the Error Alert tab, 
choose Stop from the Style dropdown. Type Incorrect Name in the Title box and You 

must enter your FULL name! in the Error message box. Click OK.

9. Cell B4 should still be selected. Note the input message. Type Al and press Enter. When 
you see the error box, note that you can choose only Retry or Cancel because you chose 
the Stop style Error Alert. Click Retry and type Albert Smith. Press Enter.

10. Return to cell B4 and press the Delete key to delete the content.

11. Click Save to update the file.

12. Select cell B5 and return to the Data Validation dialog box.

13. On the Settings tab, choose List from the Allow dropdown. In the Source box, type Con-

struction,Accounting,Sales,Management (note the words are separated by commas, 
with no spaces). Be sure Ignore Blank and In-Cell Dropdown are selected. Click OK.

14. In cell B5, use the dropdown to choose Accounting. Press Enter.

15. Return to cell B5; highlight Accounting and press the Delete key to remove it. Type Main-

tenance and press Enter. An error message tells you that you can’t do this. This is the 
default error shown when you don’t add a message on the Error Alert tab. Click Cancel.

16. Choose Format � Sheet � Unhide to see the Items sheet again.

17. On the Items sheet, copy the range A2:A9. Go back to the Request Form sheet and paste 
this list in cell F1. Hide the Items sheet again.

18. Select the range A8:A20 and return to the Data Validation box.

19. On the Settings tab, choose List from the Allow dropdown. Click in the Source box, then drag 
to select cells F1:F8 on the worksheet so that Excel enters the range into this box. Click OK.

20. On the Request Form sheet, select any cell in column F and choose Format � Column � 
Hide to hide the data you put in column F.

21. Select cell A8 and choose 404A from the dropdown. Note that Excel also enters the 
description “Standard Nails (100)” in B8, because of the VLOOKUP formula.

22. Return to A8 and delete the data. (Doing so also removes the data from B8 because of the 
VLOOKUP formula.)

23. Make sure there is no data in the form (in other words, no information relating to a spe-
cific order), but leave the formulas and data validation in the template. Then click Save 
to update the template.

E X E R C I S E  9 . 4 ( c o n t i n u e d )
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After you created the button to link to the other file (in step 24 of Exercise 9.4), 
you may find a need to edit it; however, you can’t click on it because doing 
that launches the hyperlink. If you want to select a linked object to edit it, 
right-click on it first to select it; then you can edit it normally.

Well, we’re almost there. Now we have a really easy-to-use template that’s set up to restrict 
the input of data to meet our requirements. Next, in Exercise 9.5, we will use the template and 
then locate invalid data to correct it and remove data validation from some cells.

24. From the Drawing toolbar, select the Textbox tool and draw a text box below the date in 
cell C3. Change the text box font to Dark Blue, bold, and fill the box with Light Yellow. In 
the box, type Find an Item Number (press Enter after the word an to put the text on two 
lines). Move and resize the text box to your liking; then make sure the boundary around 
the text box shows the dots (not the slashes) and click the Hyperlink button on your Stan-
dard toolbar. Browse to the file Exercise 9-3.xls, which you extracted from the zipped file 
for this chapter. Once you select this file, click OK.

25. Click the new button you just made to view the list of items. If you see a security warning 
about the “danger” of hyperlinks, just click Yes. This opens the file to display all the item 
numbers. Close Exercise 9-3.xls. Click Save to update your template and close the template.

E X E R C I S E  9 . 5  

Using Our New Template, Then Finding Invalid Data and Removing Validation

1. Choose File � New, then click on On My Computer in the task pane.

2. Double-click the Supply Request template on the General tab.

3. Enter your name in cell B4 and press Enter.

4. Choose Construction from the dropdown in B5.

5. Select A8 and choose 101A from the dropdown. Press Tab twice to move to C8 and then 
type 75.

6. Move to cell A9 and choose 303B; then Tab over to C9 and type 200. Press Enter and click 
Yes to override the warning.

7. In A10, choose 202A and enter 150 in C10. Press Enter and, this time, heed the warning 
and click No. Type 100 in C10.

8. In A11, choose 303A, enter 150 in C11, and press Enter; this time click Yes to override the 
warning again.

E X E R C I S E  9 . 4 ( c o n t i n u e d )
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Are we having fun yet? I get pretty enthusiastic about automating my templates with for-
mulas and validation rules, because I like being able to do things in the fastest way possible. 
However, you must be thinking that anyone using the template we created previously could 
easily change the formulas, remove the validation, unhide the sheets and columns, and, of 
course, edit all of the cell formats and content. Don’t worry. We’ll solve all that in the second 
part of this chapter, where you’ll learn about protection and security. But, before we begin, I 
want to show you how to organize your templates and delete the ones you don’t want.

9. Click Save. Create a folder named Chapter Nine and save this file in this new folder. 
Name it Exercise 9-5.xls. Close the file.

10. Open Exercise 9-5.xls again. You can see the completed form.

11. Press Ctrl+Home to move to cell A1.

12. Press Ctrl+G to open the Go To dialog box. Click the Special button. Choose Data Valida-
tion � All and click OK. Excel selects all cells that contain data validation.

13. Select cell A8 and open the Data Validation dialog box. Select the option Apply These 
Changes To All Other Cells With The Same Settings; then click the Clear All button and 
click OK. The validation is removed from cells A8:A20.

14. Click the Undo button to return the validation to those cells.

15. Select A8 again and open the Data Validation box.

16. This time, make sure Apply These Changes To Other Cells With The Same Settings is not 
checked and just click Clear All and then OK. This removes the validation from the one 
cell, A8, but it remains in cells A9:A20.

17. Select cell A9 and copy it; then click A8 and choose Edit � Paste Special. In the resulting 
dialog box, select Validation and click OK. The validation is back in A8. Press Esc to 
remove the marquee from A9.

18. Choose View � Toolbars � Formula Auditing.

19. Run your mouse across the buttons on the Formula Auditing toolbar until you find the 
Circle Invalid Data button and click it. Note that cells C9 and C11, where you overrode the 
warning, are now circled in red.

20. Select cell C9 and change it to 100. Press Enter and Excel removes the red circle.

21. Click the Clear Validation Circles button and Excel removes the circle from C11. Close the 
Formula Auditing toolbar.

22. Close the file and don’t save the changes.

E X E R C I S E  9 . 5 ( c o n t i n u e d )
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Organizing Your Templates

If you’re beginning to appreciate the value of templates as much as I do, you may already be think-
ing of all of the templates you want to create. I’m almost embarrassed to tell you how many I 
have. I like my workbooks to be uniform from year to year, and using templates makes this a 
snap. I’m also a big fan of anything that makes my job easier, and obviously templates do this too.

But when you have a lot of templates, they can get lost in the crowd. I can’t even imagine 
how much time I would waste searching for a template on the General tab in the Templates 
dialog box if all of my templates were on that tab.

Aha, you say, so you can have more tabs! Yes, you can. To create tabs in your Templates 
dialog box, you simply make subfolders in your Templates folder.

If you already have a lot of templates and want to organize them into directories so that 
each directory will have its own tab in the Templates dialog box, you can simply open your 
Templates folder in My Computer or Windows Explorer and move the templates around in 
there. But I’ll also show you how to create the folders (and therefore the tabs) by using the Save 
As dialog box.

When you want to delete a template (such as the templates you create in these exercises), 
just right-click on them in the Templates dialog box and choose Delete from the shortcut 
menu. We’ll do this in Exercise 9.6.

E X E R C I S E  9 . 6  

Creating Template Directories and Deleting Templates

1. Open a new blank workbook in Excel and type your name in cell A1; then choose File � 
Save As and select Template (*.xlt) as the file type to move to the Templates folder.

2. Click the Look In dropdown arrow, which shows you the location of your Templates-
folder. As you can see in the following graphic, this folder is buried in C:\Documents and 
Settings\<your Windows user name>\Application Data\Microsoft\Templates.
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Notice that in this exercise I had you close Excel before you deleted the tem-
plate folders. This isn’t necessary in some cases, but Windows has a nasty 
habit of hanging onto previously used folders and not allowing you to delete 
them if it thinks you’re still using them. So, if you ever try to delete a folder or 
file from within Excel’s Save As dialog box and Windows tells you it can’t be 
deleted because it is in use, just close Excel and reopen it, and you should be 
able to delete it without any problems.

3. Press Esc to close the dropdown box. You should still be inside your Templates folder.

4. Click the New Folder button (the same one you’ve been using to create new chapter folders 
to save your files). Name this new folder Accounting and click OK.

5. Name this template TestOne.xlt and click Save to save it in your new Accounting folder.

6. Back in your workbook, click File � Save As again. This returns you to the Accounting 
folder; the selected file type should still be Template (*.xlt).

7. To the right of the Save In box, you’ll see a yellow folder button with a green arrow on 
it. Run your mouse pointer over it, and the tooltip reads Up One Level. Click that button 
to return to your Templates folder.

8. Click the New Folder button again, then name this folder Inventory and click OK.

9. Name your file TestTwo.xlt and save it in your new Inventory folder.

10. Back in your workbook, click the X to close the file but do not close Excel.

11. Choose File � New. In the task pane, click On My Computer.

12. The Templates dialog box should display your two new tabs, Accounting and Inventory. 
Click the Accounting tab and you’ll see TestOne.xlt. Click the Inventory tab and you’ll see 
TestTwo.xlt.

13. Right-click on TestTwo and choose Delete from the shortcut menu. Then move to the 
Accounting tab and delete TestOne. Both templates are now gone. Click Cancel to close 
the Templates dialog box. Then close Excel.

14. Open Excel again. You should now see a new blank workbook.

15. Choose File � Save As. Select Template (*.xlt) as the file type to return to the Templates 
folder.

16. Right-click the Accounting folder and choose Delete. Click Yes when you see the confir-
mation message. Then repeat these steps to delete the Inventory folder.

E X E R C I S E  9 . 6 ( c o n t i n u e d )
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If you want to delete the template we created called My Invoice, go ahead and delete it. 
However, keep the template called Supply Request because we will use that in the next section, 
where I’ll show you how you can have total control over who can do what in your workbooks 
and templates.

Workbook Security and Protection
I don’t know about you, but I’m a bit of a control freak when it comes to my templates. There’s 
nothing worse than creating a great template, only to find that people are changing it so that 
it no longer works as I intended—and maybe then sharing it with others. Now there’s a tem-
plate out there that is working incorrectly or causing people problems and it’s got my name 
on it!

The bottom line is, what good is a template if users keep changing all of the settings and 
formats? If you want the template to work as designed, you need to restrict what users can 
do to it.

In the previous section, you learned how to set up some restrictions using data validation. 
However, users can simply change the validation rules or remove the validation entirely if they 
want to. You also added formulas to the template you created in the previous exercises. Now, 
how do you stop people from changing your formulas? Or, better yet, how do you stop them 
from even seeing the formulas?

You can control all of this by locking and hiding cells, then protecting the worksheet with 
a password. That way, if you want a particular user to have more options, you can simply give 
that user the password. Another alternative would be to create multiple copies of a workbook, 
each allowing different types of changes and using different passwords. Then you can choose 
which copy you share with whom.

But, workbook security is about more than simple password protection of templates. Secu-
rity settings also allow you to protect regular workbooks as well as templates. You can protect 
the worksheet, which protects the data in the sheet, and you can protect the workbook, which 
protects the structure (hidden sheets and columns, sheet names, etc.).

Both worksheet protection and workbook protection are applied from within the work-
book and do not restrict users from opening the workbook. However, you can also apply file 
protection, which lets you control who can open and/or edit the file.

All of these types of protection give you control over what happens to your workbooks and 
templates when others use them. But there’s one more type of security that protects you when 
opening workbooks made by others. This is called macro security. Macros are covered in 
Chapter 11, “Working with Macros,” so I won’t go into a lengthy discussion here. Just keep 
in mind that macros are shortcuts you can create to complete multiple tasks with one or two 
clicks. They are handy tools indeed; however, malicious people exist in the big bad world who 
take pleasure in creating macros that contain viruses or scripts that can damage the data in 
your computer. So, you need to know how to set up your macro security so that you’re in 
charge of the macros you accept or decline.

4002book.fm  Page 323  Friday, March 24, 2006  11:36 PM



324 Chapter 9 � Advanced Template Design and Workbook Security

Another area of security is ownership and copyright, pertaining to workbooks and templates 
you create. Though some people ignore this type of protection, it is important that you include 
it in any workbooks or templates you share. That way, if down the line someone uses pass-
word-cracking software to unprotect your workbook and then makes changes or hacks into 
your file, you can take legal action against them. If you set up the workbook correctly, you’ll 
be able to supply a copy of the original workbook showing the date you created it, the original 
author (you), and any other copyright information you included in the workbook properties.

Let’s look at setting up these properties first; then we’ll explore all the other protection and 
security options available to you.

The Importance of Workbook Properties

Workbook properties tell you a lot about a workbook, and modifying them is especially 
important if you’re making the workbook (or template) available to others. To see the prop-
erties of any workbook from within Excel, open the file and choose File � Properties (see the 
sample Properties dialog box in Figure 9.5). You can view the properties of any template by 
right-clicking the template name in the Templates dialog box and choosing Properties from the 
shortcut menu. You can also see the properties of a workbook or template outside of Excel by 
right-clicking the filename in Windows Explorer or My Computer and choosing Properties 
from the shortcut menu. In Windows XP, simply resting your mouse pointer on any filename 
displays a tooltip that shows the properties and also displays the properties in the Status bar. 
So, you can see that including important information in a workbook’s properties makes this 
information available and fairly obvious to anyone looking for it.

F I G U R E 9 . 5 A sample Properties dialog box
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I mentioned earlier that if you want to make changes to a template that is password-protected, 
you have to contact the creator of the template to ask them for the password. Therefore, it’s 
important for the creator to include contact information in the template’s properties. It’s also 
a good way to get feedback on the template from users. If the template works fine on your 
machine but not on other machines, you would want to know this, so adding your contact 
information to the properties makes you more easily accessible.

In Exercise 9.7, I’ll show you how to view and edit the properties of the Supply Request 
template you created in the previous exercises.

E X E R C I S E  9 . 7  

Viewing and Adjusting Workbook Properties

1. Choose File � New. Then click On My Computer in the task pane and double-click the 
Supply Request template in the Templates dialog box.

(If you did not save this template in the previous exercises, you can extract Supply 
Request Exercise 9.7.xlt from the zipped file for this chapter. First open it and use File � 
Save As to save it as a template named Supply Request in your Templates folder; then 
close it and follow the instructions in step 1.)

2. Return to the File menu and choose Properties. You’ll see the Properties dialog box, 
which contains five tabs, as shown in Figure 9.5.

3. Select the General tab. This tab is basically void of information because the general infor-
mation pertains to the workbook you’ll create using this template and not the template 
itself, and obviously you haven’t created a workbook yet.

4. Click the Statistics tab. This tab shows when the template was created, last modified, last 
printed, and so forth.

5. Click the Contents tab. This displays the names of the sheets and named ranges in this 
template. Note that the Items sheet appears, even though it is hidden.

6. Click the Custom tab. This is where you set up and view any custom properties in this 
workbook. (Setting custom properties is beyond the scope of this book, but feel free to 
explore the different options if you like.)

7. Select the Summary tab. This tab contains the author of the template and perhaps a 
company name. This information is pulled from the information supplied when Excel 
was installed. If you open the template you created, you’ll see your information. If you 
open the template Supply Request Exercise 9-7.xlt, you’ll see my information, since I 
created that template.
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Now that we’ve got all of the formatting and data in the template and we’ve set up the prop-
erties, let’s learn how to protect all of this so it can’t be changed.

Worksheet and Workbook Protection

As I mentioned earlier, there is a difference between protecting a worksheet and protecting a 
workbook. When you want to protect the content of the sheets, you use worksheet protection. 
When you want to protect the workbook components (sheet tabs, properties, etc.), you use 
workbook protection. You apply both of these types of protection from within the workbook, 
using the Protection command in the Tools menu. Let’s look at worksheet protection first.

Protecting Worksheets

Before you protect the content of the cells using worksheet protection, you must choose which 
cells can be edited and which cannot. As you’ll recall from Exercise 9.1, when we viewed 
Microsoft’s template we were unable to select or edit certain areas until we unprotected the 
worksheet. That was because the cells in these areas were locked cells.

By default, all cells in a worksheet are locked when you protect it. So, you need to unlock 
the cells you will allow users to edit before you apply the protection. Once you’ve set up the 
values and formats in a sheet, you must decide what areas people will have access to and what 
areas you don’t want anyone else touching.

8. On the Summary tab, enter this information:

Title: Supply Request Form

Author: Your name (if it isn’t already there)

Company: XYZ Construction

Keywords: supplies, forms, requests

Comments: This template is copyrighted by XYZ Construction and cannot be edited in 

any way without permission.

9. Select the option Save Preview Picture. This option adds a preview of the template that 
is visible in the Preview box in the Templates dialog box.

10. Click OK.

11. Choose File � Save As and save this as Template (*.xlt). When you open the Templates 
folder, select Supply Request.xlt from the list of templates shown and click Save. When 
a message appears telling you the file already exists, click Yes to overwrite the file.

12. Close the template.

E X E R C I S E  9 . 7 ( c o n t i n u e d )
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Along with the locked format, Excel offers a hidden format, which allows you to hide the 
information usually displayed in the Formula bar. This is really handy when you don’t want 
people seeing the precious formulas you’ve worked so hard to design but instead want the 
formula to perform the action without users seeing any of the mechanism behind the action. 
When the formula is hidden, people think it’s a miracle when data pops up in a cell without 
them touching the cell! When you protect a workbook, you have options as to what you’ll 
allow. In most cases, you’ll choose to let users select only unlocked cells, but if you chose 
to let them select locked cells that contain formulas, they would be able to view your for-
mulas. If you allow users to select locked cells but hide the formulas, they won’t be able to 
see them.

In Chapter 2, we explored all of the tabs in the Format Cells dialog box except one: the Pro-
tection tab. That’s where you control the locked and hidden formats (see Figure 9.6).

F I G U R E 9 . 6 The Protection tab in the Format Cells dialog box

Using the combination of locked cells, hidden formulas, and the various protection options, 
you can decide what people can see and change in your workbook. Use Exercise 9.8 to explore 
these possibilities.

E X E R C I S E  9 . 8  

Setting Up Locked and Hidden Cells When Protecting Worksheets

1. Choose File � New. In the New Workbook task pane, click On My Computer. Double-click 
the Supply Request template to load it. (If you don’t have the Supply Request template, 
follow the instructions in step 1 of Exercise 9.7.)

2. Choose Tools � Protection � Protect Sheet.
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3. In the Protect Sheet dialog box, make sure Protect Sheet And Contents Of Locked Cells 
is selected. Leave the Password box empty and, in the list of choices below that, the only 
one that should be selected is Select Unlocked Cells. If Select Locked Cells is also 
selected, remove that check. Click OK.

4. Try to select anything on the sheet and you’ll see you cannot. This is because every cell 
on the sheet is locked.

5. Choose Tools � Protection � Unprotect Sheet so that you can edit it.

Remember how we set up this template. The only information people need to add is their 
name, the company name, the item numbers, and the amounts. The Description column 
and the date are filled in by the formulas we entered, so users have no need to access 
those cells. Also, we do not want them changing the labels. We need to unlock only those 
cells users will change.

6. Use the Ctrl+click method to select the three ranges users will edit: B4:B5, A8:A20, and 
C8:C20.

7. Open the Format Cells dialog box and select the Protection tab.

8. Deselect the Locked option (as shown in Figure 9.6) and click OK.

9. Return to the Tools menu and protect the sheet again, applying the same choices as in step 3.

10. Click in any unlocked cell and note that you can now select it and add information. Press the 
Tab key; this moves you from one unlocked cell to another and skips over the locked cells.

11. Choose an item number in cell A8. Excel has entered the description in B8, but you cannot 
select B8 and, therefore, cannot view the formula.

12. Delete the item number in A8.

13. Choose the Tools menu and unprotect the sheet again.

14. Now, protect the sheet again, but this time select both the Select Locked Cells and Select 
Unlocked Cells options. Click OK.

15. Select cell B8 and check the formula in the Formula bar. Try to type in B8 and you’ll 
immediately see the message shown here, which tells you that you can’t make an entry 
in that cell:

E X E R C I S E  9 . 8 ( c o n t i n u e d )

4002book.fm  Page 328  Friday, March 24, 2006  11:36 PM



Workbook Security and Protection 329

With the template still open from the previous exercise, choose the different menus and 
note any grayed-out commands. Because you allowed users to select only locked and unlocked 
cells, they won’t be able to do anything more than type in data. If you unprotect the sheet, then 
protect it again, you can examine the list of choices you have to allow or disallow. As you can 
see, you can let users format cells, add columns, or sort the data, for example. Play around 
with various choices and see what becomes available in the menus. When you’re done, protect 
the worksheet again, applying the same settings you applied in step 14 in Exercise 9.8, because 
I want it in the same shape it was in when you completed that exercise. In the next section, I’ll 
show you what you can do with workbook protection.

Protecting Workbooks

Though worksheet protection affords you a lot of control, Excel has some workbook features 
that cannot be controlled with worksheet protection. For example, take a look at the Format 
menu in the template you protected in the previous exercise. The formatting options for rows 
and columns are all grayed out; however, other than Background, all of the sheet options for 
hiding, unhiding, renaming, and recoloring tabs are still available. Also, if you right-click any 
sheet tab, you can see that all the choices remain available.

Similarly, if you choose the File menu in a workbook that has worksheet protection, you 
can still view and edit the properties from there. If you want the Properties dialog box to be 
unavailable, you have to protect the workbook.

You can use workbook protection in conjunction with worksheet protection or choose to 
do one or the other. Also, like worksheet protection, workbook protection gives you some 
options when you set it up, though there are only two: protect the structure or protect the win-
dows. Protecting the structure removes choices like renaming sheets, moving sheets, inserting 
sheets, hiding and unhiding sheets, and viewing properties. Protecting the windows prevents 
users from resizing windows, freezing panes, creating splits, and so forth.

16. Click OK to close the warning box.

17. Unprotect the sheet and select cell C3 and the range B8:B20.

18. Open the Format Cells dialog box and return to the Protection tab. Note that the cells are 
locked but not hidden. Select the Hidden option and click OK.

19. Protect the sheet again, using the settings described in step 14.

20. Select cell B8. Excel lets you select it, but the Formula bar is empty.

21. Be sure you have removed any data you added to the cells; then choose File � Save As 
and save the template, Supply Request, as a template. Click Yes to overwrite the original. 
Leave the template open for the following discussion.

E X E R C I S E  9 . 8 ( c o n t i n u e d )
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Though worksheet protection is more commonly used than workbook protection, there are 
times when you need both. Two common needs for workbook protection arise when you have 
situations similar to the ones we created in our Supply Request template: We don’t want peo-
ple seeing that hidden worksheet and we don’t want them editing the properties of our tem-
plate. So, let’s use Exercise 9.9 to see how to gain this control, and more.

E X E R C I S E  9 . 9  

Using Workbook Protection to Keep Information Hidden

1. Still inside the template you saved in the last exercise, choose the File menu and note 
that the Properties command is still available.

2. Next, choose Format � Sheet � Unhide. The Items sheet is available for view. Click Can-
cel to close the Unhide box without making any change.

3. Also, choose the Window menu and note that both Split and Freeze Panes are available.

4. Finally, right-click the Request Form sheet tab and note that every choice there is available.

Let’s see what we can do to make these options unavailable:

5. Choose Tools � Protection � Protect Workbook. In the Protect Workbook dialog box, 
make sure Structure is selected but that Windows is not (again, don’t bother entering a 
password). Click OK.

6. Now, double-click the Request Form sheet tab. You’ll see the following message, telling 
you that you can’t change the name:

7. Click OK to close the message box.

8. Choose the File menu; Properties is unavailable.

9. Right-click the sheet tab. Most options are now unavailable. You can’t rename, add, 
delete, move, or recolor sheet tabs.

10. Choose Format � Sheet. All options are grayed out, including Unhide, which means you 
can no longer get to the Items sheet or even know it’s there.

11. Unprotect the workbook by choosing Tools � Protection � Unprotect workbook.

12. Now protect the workbook again, but this time deselect Structure and select Windows.

13. Choose the Window menu and note that both Freeze Panes and Split are unavailable.

14. Look at the top-right corner of your screen. You have the minimize, maximize, and close 
buttons for Excel, but the ones for the open workbook are not there.
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As you can see, the combination of worksheet and workbook protection gives you maxi-
mum control over what users can do once they have the workbook open. The next section 
addresses how to use file protection to control who can open the workbook in the first place.

If you want to delete the Supply Request template now, you can, unless you 
want to go back and play with it some more.

File Protection

File protection is pretty simple to set up. All you need to know is that there are three ways to 
configure it. You can require a password to open the file, you can require a password to edit 
the file, or you can set up a file with a read-only recommendation and let people choose how 
they want to open it.

All three choices are available to you in the Save As dialog box. Choose General Options 
from the Tools dropdown list in the upper-right corner (see Figure 9.7) . The dialog box shown 
in Figure 9.8 appears.

F I G U R E 9 . 7 Choose General Options to set up file protection choices.

15. Unprotect the workbook. The buttons that allow you to minimize, maximize, and close 
the workbook have now returned.

16. Return to the Tools menu and remove the worksheet protection. Be sure neither the 
workbook nor the worksheet are protected and save the file as a template with the same 
name, updating the original. Close the file.

E X E R C I S E  9 . 9 ( c o n t i n u e d )
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F I G U R E 9 . 8 Save Options allows you to restrict how files are opened.

Exercise 9.10 shows how these three choices affect the file.

E X E R C I S E  9 . 1 0  

Using File Protection Options

1. Open a new blank workbook and type File Protection in cell A1.

2. Click Save. When the Save As box comes up, click the Tools button (see Figure 9.7) and 
choose General Options.

3. In the Save Options dialog box, type 123 in the Password To Open box and click OK. 
Retype 123 in the password confirmation box and click OK again.

4. Save the file in your Chapter Nine folder and name it Exercise 9-10 password to open.xls.

5. Edit cell A1 so it displays Less File Protection. Choose File � Save As.

6. Click the Tools dropdown again and choose General Options.

7. Delete the current password and type 123 in the Password To Modify box. Click OK. Type 123 
again to confirm, and click OK.

8. Save this file in your Chapter Nine folder also, but name it Exercise 9-10 password to 

modify.xls.

9. Change A1 to Even less file protection and choose File � Save As.

10. In the Save Options dialog box, remove the last password and select Read-Only Recom-
mended. Click OK.

11. Save this file in the Chapter Nine folder and name it Exercise 9-10 read only.xls.

12. Close the file.

13. Choose File � Open. Locate the file Exercise 9-10 password to open.xls and open that file. 
You’ll see this message box requiring a password:
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14. Type 123 in the password box and click OK. The file opens.

15. Close the file.

16. Open the file Exercise 9-10 password to modify.xls. You’ll see this message box:

You can choose to open the file as read-only if you don’t know the password, or enter the 
password if you want to be able to edit the file.

17. Type 123 and click OK. The file opens and you can edit it.

18. Close the file.

19. Open Exercise 9-10 read only.xls. You’ll see this message box:

This is similar to the one you saw in step 16, but in this case, Excel emphasizes that you 
should choose to open it as read-only.

20. Click No. The file opens and you can edit it.

21. Close the file and open it again. This time click Yes. The files opens, and the title bar dis-
plays [Read-Only] after the filename.

22. Add your name to cell A2 and press Enter. So far, so good.

23. Click Save and you’ll see this message box:

This message tells you that the file cannot be saved, so you need to make a copy.

24. Click OK. The Save As dialog box comes up. Click Cancel.

25. Close the file.

E X E R C I S E  9 . 1 0 ( c o n t i n u e d )
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Well, I’m sure if you had any paranoia about people messing with your workbooks or tem-
plates, you’re feeling more comfortable now. Excel relieves my control issues immensely.

Just two more things before we move on:
� If you ever decide you want to change the file-protection options or remove the protection 

completely, simply open the file, then choose File � Save As and open the Save Options 
dialog box and modify those settings.

� Remember, to remove a password, you must know the password to get into the file first, 
so take whatever precautions you must to remember your passwords, or make a backup 
copy of the file that does not include the password.

Now that you’re fully armed with all the ways you can protect files you create and share 
with others, let’s look at one more security measure: how to protect yourself from dangerous 
files you might receive from others.

Macro Security

As I mentioned earlier, macros are completely covered in Chapter 11, so there’s no need for 
me to get into a big discussion about them here. But, since this section is about protection and 
security, macros should be mentioned.

Help! I Need a Password to Edit This Workbook and I Don’t Have It

This is something that, as a consultant, I’m frequently called about. Generally, the caller is 
some bigwig who fired an employee and, before the employee left, they changed the pass-
words in their Excel workbooks and templates so that no one can open or edit them. So, what 
would you do in this case?

Well, the only choices you have are to either purchase some password-removal software 
(which is generally pretty expensive) or send the file to an outside computer support techni-
cian who owns this type of software and can access these protected files (also expensive).

Another option is to press charges against the ex-employee. The law states that any files used 
or developed by an employee are the property of the employer, so the employee has techni-
cally broken the law (again, this could be another expensive proposition).

So, the real solution to this problem is to be proactive instead of reactive. As an employer, 
don’t let yourself get into this position in the first place. If any Excel workbooks or templates 
are being shared in your company, make backup copies, store them somewhere safe, and 
remove the password from the backup. Make this a regular routine in your company. Be 
aware of the files your employees are depending on. Keep the backups up-to-date. And, 
never, never, never let an employee have more control over your files than you do. Someday, 
I assure you, you’ll regret that you haven’t been on top of that.
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Briefly, you can set up your level of macro security by selecting Tools � Macro � Security. 
As you can see in Figure 9.9, the Security Level tab lets you specify how much security you 
want. By default, when Excel is installed, your security will be set to High and, if you change 
it, installing any updates for Microsoft Office (especially those related to security) will bring it 
back up to High, so you’ll need to reselect this option whenever you update Office.

F I G U R E 9 . 9 Macro Security dialog box

Why would you want to change this option? Well, in my case, I find the High setting to be 
overkill. Let me explain each level in plain English in case you have difficulty understanding 
what Microsoft tells you in this dialog box.

Very High This means you won’t be able to run macros in any file unless the file was created 
by Microsoft. You won’t be given a choice when you open a file containing a macro. You 
won’t even know the macro is there. The macro will simply be turned off.

High This means you won’t be able to run a macro in any file unless the macro was “signed” 
by someone who obtained a digital certificate from Microsoft and you have used this certifi-
cate information to add this person or company to the Trusted Publishers on the second tab 
in this box. Again, you won’t be given a choice when you open a file containing a macro that 
is not signed. You won’t even know the macro is there; the macro will simply be turned off.

Medium This means you’ll be prompted upon opening a file containing a macro. You can 
choose to enable or disable the macro. The macro does not have to be signed for you to run 
it. If you disable the macro, it will not run (and therefore cannot hurt your computer). In my 
opinion, this is the smart choice and it is the level I use on my computers. When I receive a file 
containing a macro, I choose to disable it. Then I use the file. If there is something I need to 
do in this file that absolutely requires this macro to run, then I’ll check out the person who sent 
it to me and decide if it’s smart for me to run it. To run it, I simply close the file and open it 
again and, this time, click the Enable button at the prompt. However, in most cases, I can usually 
use the file without having the macro running.
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Low I don’t recommend anyone use this level. With the Low setting, Excel enables all mac-
ros when you open a file without prompting you or letting you know there’s a macro in the 
file. This is very dangerous, and I’m surprised Microsoft even includes this setting anymore. 
When a malicious macro is enabled in a file, it can do serious damage to your computer data 
by running virus or Trojan scripts.

Do yourself a favor and take the two seconds needed to click the Enable or Disable button 
when a file containing a macro is opened. Changing the setting to Low to avoid two mouse 
clicks is not a good idea. Choose Tools � Macro � Security now and make sure your level is 
set to Medium or higher. Someday, you could be happy you did.

Another chapter chock-full of information. This section on security contains some of the 
most important stuff in this book.

Summary
This chapter is all about control: control over how your workbooks perform when used, con-
trol over what others can do when using your workbooks, and control over your own safety 
when opening workbooks created by others.

Templates are used to set up default data and formats so you or others can produce similar 
files in a snap. With templates, you can specify all of the default settings and information 
needed to produce files that have similar uses and properties. A template is like a shell or a 
frame: Users fill it with specific data, based on the guidelines present in the template. When 
you create a new workbook based on a template, you can then save it in the same way you 
would any other workbook.

Along with setting up the format and standard data, you can automate the process of enter-
ing data in a workbook based on a template by using formulas and data validation. Formulas 
allow template users to enter their data and have it calculated automatically. Data validation 
provides users with helpful messages that tell them how to properly enter data, and also lets 
them choose options from dropdown lists instead of having to type an entry from memory.

Another use of data validation is to limit the entries users can make. You can set up validation 
as user-entry guidelines, or as a warning to alert users when they have entered data outside 
acceptable parameters, or even to stop them from entering anything other than your choices.

Another way to control how people use a workbook or a template is through protection. 
You can lock areas of a worksheet or hide formulas, then protect the sheet so no one can access 
those areas. You can also protect the workbook’s structure or window layout to restrict such 
actions as viewing hidden data or changing sheet names (and, therefore, possibly making for-
mulas that refer to these sheets unusable).

You can also protect an entire file by specifying options in the Save Options dialog box to 
require a password to open or edit the file or make the file read-only.

Along with protecting your files from other hands, you can also protect yourself from mali-
cious code entered in macros in files you receive by adjusting your macro security settings.

All in all, the combination of templates and security gives you peace of mind when sharing 
workbooks.
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Exam Essentials
Understand the difference between using a template and opening a template. Know all the 
ins and outs of the File commands, Open, New, Save, and Save As, and how they affect what 
you’re doing with templates, whether you’re editing existing templates or creating new ones 
from scratch.

Know how to organize templates. Know how to use the Templates dialog box to create 
directories (tabs) and add and remove templates from different areas.

Be able to apply data validation to automate data entry in templates. Be familiar with set-
ting up data validation of all types, using different parameters, different messages, and differ-
ent style levels. Also, know how to remove validation.

Make sure you can locate cells containing data validation and invalid data. Know how to 
use the Go To dialog box to find all data validation in a sheet and how to use the Formula 
Auditing toolbar to circle invalid data as well as remove circles from invalid data.

Understand what file properties mean. Know the various ways to view file properties from 
both Excel and Windows.

Understand the difference between worksheet protection and workbook protection. Be 
familiar with what abilities are restricted when a worksheet is protected versus what hap-
pens when a workbook is protected. Know which type of protection is necessary in certain 
scenarios.

Be able to lock and unlock cells and hide and unhide formulas. Know how to use the 
options on the Protection tab in the Format Cells dialog box, and understand the difference 
between locking and hiding.

Be sure you can protect worksheets, workbooks, and files. Be proficient in using the Tools � 
Protection submenu and the Save Options dialog box. Make sure you know how to turn on 
and off all types of protection, as well as how to add and remove passwords.

Know how to set up macro security and what the settings mean. Understand what the dif-
ferent security levels do and how to change them.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you’ll encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the file MOS Scenarios Ch9.xls from the 
zipped file for this chapter and open it before you do these exercises.
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Use the template you created in Scenario 24 for this scenario, or extract Newsletter 
Signup.xlt from the zipped file for this chapter and add it to your Templates folder.

 

MOS Scenario 24: Create a Template and Password-Protect It

Using the Newsletter Signup form, create a template, and then save it in the Templates folder 
as Newsletter Signup. Add an attractive text box instructing people to do the following:

1. Complete the form.

2. Save it as <lastname>_newsletter.xls.

3. Email it to subscriptions@email.com.

Add a formula in F9 to insert the current date. Create a dropdown list in G1 for users to choose 
their customer number, and lock and protect all cells except that one. Hide the customer list 
sheet so that no one can see it. The protection password should be abc.

 

MOS Scenario 25: Remove Worksheet/Workbook Protection, Add File 
Protection, Delete a Template, and Set Up Macro Security

Use the Newsletter Signup template to subscribe to the newsletter as customer 150. (Follow 
the instructions on the form for saving the file and save it in your My Documents folder, but 
don’t email it.) Then edit the template by deleting the first sheet. Save the second sheet in 
your My Documents folder as customerlist.xls, with password-to-open protection; use the 
password abc. Delete the Newsletter Signup template.
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MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Import data to Excel

�

 

Export data from Excel

�

 

Save data in appropriate formats for different uses

�

 

Publish and edit Web worksheets and workbooks

�

 

Structure workbooks using XML
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This chapter explains how to bring data and graphics into a 
workbook from other sources and how to move data and graph-
ics out of a workbook into those same sources. The ways to get 

data 

 

in

 

 include importing, inserting, pasting, and dragging and dropping; the ways to move data 

 

out

 

 include exporting, using Save As, copying/cutting, and dragging and dropping. So, right off 
the bat, I’ll take a moment to explain converters and how data is moved to and from Excel to 
other Microsoft Office programs.

Along with moving data into and out of different programs, I will also teach you how to 
move Excel data to a web page and how to bring web page information into your workbook. 
Included in this section is a discussion of both HTML and XML. HTML (Hypertext Markup 
Language) is the most common programming language used to produce web pages, so it’s 
important to know the basics of how Excel converts data to HTML. XML (Extensible Markup 
Language) is a newer programming technology; it is content based, which means it tells the 
web browser how to display the data. Improved XML compatibility is one of the most signif-
icant additions to the 2003 version of Microsoft Office. You’ll learn how to bring HTML and 
XML coding into an Excel spreadsheet, and you’ll see how Excel takes an existing spreadsheet 
and converts it to these coded languages when converted to HTML or XML.

The techniques I will teach you include import/export, insert, Save As/Open, cut/copy/paste, 
and drag and drop.

To complete the exercises in this chapter, you will need to download the file exl2003ch10.zip 
from the book’s website and extract the files into a temporary folder before you begin.

The first section of this chapter shows you how to bring data into Excel; then, you’ll see 
how to move data out.

 

Introduction to Converters

 

So, what types of data can you bring in and move out of Excel, or other programs within the 
Microsoft Office suite (Access, Outlook, PowerPoint, and Word)? Almost anything. Cer-
tainly, data can be exchanged between all these programs because the converters are built into 
the programs. In cases where you don’t need to make any choices, the conversion is done 
silently, in the background, without you even seeing it happen. When you move Excel data 
into a file created in a non-Microsoft program, converters are needed when the formatting of 
the data must be changed to suit the formatting of the program where the data now resides. 
The same thing happens when you bring data into Excel from another program. So, if you 
want to exchange data between Excel and a non-Microsoft program, you need the proper con-
verters installed. Many of the more common converters are automatically included within 
Excel, so you can just use the Save As command and choose that format as the file type. Types 
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automatically available include different versions of Excel itself, as well as varieties of text for-
mats, Lotus formats, web formats, and dBASE formats. However, if the type you need is not 
available in the Save As type dropdown list, this tells you that you need a different converter. 
If a converter is available, you can probably find it at the website for that program. If no con-
verter is available, you have to use a different technique covered in this chapter. However, one 
of the advantages of using Excel is that most smaller companies recognize that the majority of 
the world uses Microsoft programs, so they usually have a converter available for you.

With all this information in mind about converters and the way Microsoft Office programs 
work together, you’re ready to learn how to put data into Excel.

 

Data In

 

Depending on what you want to do with data, the methods for bringing it into Excel are dif-
ferent. Also, depending on what format the data is currently in, your options for getting it into 
Excel will vary.

If you want to create a whole new workbook using existing data that is in a different file 
format, select File �

 

 Open and see if Excel can convert the data for you. In some cases, where 
the data format is compatible with Excel, Excel does the conversion silently for you and the 
file simply opens. In other cases, Excel will use a conversion wizard and prompt you for choices 
on how you want the data laid out. In some instances, Excel may tell you it cannot read the 
format, so you will have to find another way of bringing the data in, either by searching the 
Internet for a converter or by using one of the methods discussed later in this section.

If you don’t want to add an entire file to a new workbook but instead want to add just a 
portion of the file to an existing workbook, or if Excel cannot open the chosen file, you can 
use alternate methods to bring the information into your workbook. These methods include 
importing, inserting, cutting/copying and pasting, and dragging and dropping.

Let’s start by examining the file types that Excel can open for you when you use the File �

 

 
Open command.

 

Opening Different File Types in Excel

 

As I said previously, by default there are some file types other than Excel workbooks and tem-
plates (*.xls and *.xlt) that Excel can open for you. If you are trying to open a file in Excel that 
cannot be opened with the default converters, Excel will tell you. If opening the file requires 
you to make some choices, Excel will also tell you that. Let’s try opening some different file 
types with Excel and see what happens.

 

To be able to see the file extensions on the file types covered in this section, 
you must have the extensions showing. Windows XP hides file extensions for 
known file types by default, so you may have to change this. To do this, open 
your Windows Control Panel and double-click Folder Options. On the View 
tab, deselect Hide Extensions For Known File Types. Click OK and close the 

 

Control Panel.
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In Excel, select File �

 

 Open and browse to open the folder named Samples that you 
extracted from the zipped file for this chapter. In the Samples folder, you will see only two 
files, as shown in Figure 10.1: Exercise 10 Sample.xml and Exercise 10 Sample.htm. This is 
because, by default, the Files Of Type box in the Open dialog box displays only All Microsoft 
Office Excel Files. Though the XML and HTM files you see are technically not Excel files, they 
are the only two included in these samples that were created in Excel.

 

F I G U R E 1 0 . 1

 

By default, Excel’s Open dialog box displays only Excel files.

 

To see all of the different file format samples, choose All Files (*.*) from the Files Of Type 
dropdown list. You will see the complete list of files in that folder, as shown here:

 

Note that there is a subfolder named Exercise 10 Sample_files within the 
Samples folder. Excel created this folder automatically when I saved an Excel 
file as a web page (.htm). We’ll discuss this later when we discuss saving 

 

Excel files for the Web.
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Table 10.1 shows descriptions of these file types. When you view the complete list of files, 
they may have different icons than the ones shown in the previous graphic. The icon displayed 
is determined by Windows and the program associated with the file extension; so, if you have 
different programs associated with any file type, or if you have no program associated with a 
file type, you will see different icons than the ones shown here.

 

Opening a CSV File

 

Still inside Excel’s Open dialog box, click on Exercise 10 Sample.csv to select it, and then click 
the Open button. Excel opens the file without any problems and doesn’t display a prompt. 
Because CSV files are comma-separated (see Table 10.1), Excel knows to separate the data 

 

T A B L E 1 0 . 1

 

Descriptions of Some Standard File Types You May Want to Bring into Excel 

 

File Type (Extension) Description

 

.csv Comma-Separated Values (CSV) text file. A commonly used type of 
unformatted text file created in a text editor like Notepad. This type 
of text file separates values, using commas as delimiters. Other text 
file extensions include .txt and .prn.

.doc Microsoft Word document. A commonly used formatted text file 
type, created in a word processor like Microsoft Word or WordPad. 
Another type of formatted text file you might see is RTF (Rich Text 
Format).

.htm Web page file, created in various programs and saved as a web page 
to be viewed in a browser such as Internet Explorer. Another version 
of this file extension is .html.

.jpg JPEG graphic file. This is just one type of graphic file created in a 
graphic-editing program like Microsoft Paint or Adobe Photoshop. 
There are many graphic file formats (BMP, GIF, TIF, etc.), and all are 
handled similarly in Excel.

.mdb Microsoft Access database file, created in Access.

.ppt Microsoft PowerPoint presentation file, created in PowerPoint. 
Another PowerPoint file extension you might see is .pps, which is a 
PowerPoint Slide Show.

.wk4 Lotus 1-2-3 file type, created in Lotus 1-2-3. This is another popular 
spreadsheet program. You may also see .wk3, .wk2, .wk1, and .wks, 
which are created by various versions of Lotus 1-2-3.

.xml Extensible Markup Language, which is another format that can be 
viewed in a browser such as Internet Explorer. XML files include for-
mat settings that can be applied to other files.
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into columns based on the comma delimiter, so it doesn’t need to ask you anything. Some 
forms of text files do not specify delimiters, so in that case Excel would open the Text Import 
Wizard shown in Figure 10.2. The wizard lets you specify the delimiter (comma, space, tab, 
etc.) and guides you through the conversion.

 

F I G U R E 1 0 . 2

 

The Text Import Wizard lets you specify how to format the text into columns.

 

Many times, your data is in a file that Excel cannot open. In that case, you can open the file 
in the program where it was created, and save it as a text file. Then, use Excel’s Text Import 
Wizard to set up the data in a way that closely matches your needs. Once the data is in Excel, 
you can fine-tune it to improve its appearance and formatting. So, remember, if someone is 
trying to send you data that is in an incompatible format, ask them to save it as a text file and 
you should be able to get most of what you need out of the file that way.

As you can see, in the CSV file, the only thing Excel cannot determine is the column widths 
necessary to display the data, so you will have to adjust the widths yourself. 

Close this file and click No if Excel asks you if you want to save changes; then return to the 
Open dialog box.

 

Opening a DOC File

 

This time, try to open Exercise 10 Sample.doc. Surprisingly, even though this file was created 
with another Office program (Microsoft Word), Excel cannot open it and displays this box:

There are a lot of options inside a formatted text document that require interpretation in 
order to display the document correctly and Excel cannot determine which parts would need 
this interpretation. But never fear; there are alternative ways to open this file, and you will 
learn them later. For now, just click OK to close the message box.
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Opening an HTM File

 

Now, return to the Open dialog box and open the file with the.htm extension in the Samples 
folder. This file opens automatically and doesn’t require any help from you. Because HTML 
code is a universal programming language used to create web pages, Excel can understand it 
and format the workbook accordingly. In this case, the data inside this web page is constructed 
within a table; therefore, Excel easily transfers the data into the correct cells based on the table 
tags used in the HTML code. In other cases, the file may not come into Excel quite as cleanly 
because, without table tags in the HTML, Excel won’t know how to organize the data into 
cells and might put the whole web page inside one cell.

 

Opening a JPEG File

 

Next, close the HTML file and try to open the JPEG file. Whoops! Excel is confused. If you 
look at the wizard that Excel is running, you will see it’s the Text Import Wizard shown in 
Figure 10.2. Sometimes, when Excel doesn’t recognize a file type, it makes the wrong assump-
tion. Graphic files include underlying binary code, and Excel tries to interpret that code as 
text. Note the weird binary symbols shown in the preview box at the bottom of the wizard. 
The binary code is not what we want, so, like the DOC file, this file needs to be brought into 
Excel in a different way. Click the Cancel button in the wizard.

 

Opening an MDB File

 

Return to the Open dialog box and this time open the MDB file. The first box you see is a secu-
rity warning, because database queries can be designed to grab information about your com-
puter files: 

Click Open, and Excel displays the following dialog box. Because the MDB file is a 
Microsoft Access database file, it includes multiple tables, so you must choose which table you 
want to bring into Excel.
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Select tblStoreSales and click OK. Again, the file opens without any help from you. Excel 
is able to easily open Access tables because the settings stored in the properties of an Access 
table are fairly compatible with Excel. However, notice the words TRUE and FALSE in col-
umn F. In Access, these fields are known as yes/no fields and show checkboxes in the table. 
Excel interprets a selected checkbox as TRUE and a deselected checkbox as FALSE, and dis-
plays them accordingly. But, remembering what you learned in Chapter 5 (“Formulas and 
Functions in Excel”) about logical functions, you can see how this true/false information could 
be very usable in Excel, so this isn’t really a bad thing.

Close the Access table; click No if Excel asks if you want to save changes.

 

Opening a PPT File

 

Now try to open the PPT file. You’ll see the same error you got when you tried to open the 
DOC file; this is another file type created in an Office program that Excel does not open auto-
matically. Click OK to close the message box.

 

Opening a WK4 File

 

Return to the Open dialog box and open the file Exercise 10 Sample.wk4. It opens flawlessly. 
Well, in some cases it won’t be flawless because a WK4 file is a spreadsheet file created by 
Lotus 1-2-3, which is not a Microsoft program. Though this program is very similar to Excel, 
certain differences will cause problems in the conversion when the Lotus features are not com-
patible with Excel. However, in most cases the files created in either program are usable in 
both. If you look at the formulas in column F, you will see that Excel converts them to be 
compatible.

 

Opening an XML File

 

Finally, close the Lotus file and open the XML file. Again, the file opens with no problems. 
XML is relatively new compared with other programming languages. Microsoft Office 2003’s 
compatibility with XML is a major improvement. You’ll learn more about XML in a later sec-
tion in this chapter, “Saving Workbook Structure Using XML.” For now, just close the file.

As you can see, Excel is capable of opening a variety of file types without any help from you. 
If you want to create a workbook from the open file, you simply select File �

 

 Save As, choose 
Microsoft Office Excel Workbook (*.xls) from the Files Of Type dropdown list, and save the 
file. However, you’ll recall that some file types cannot be opened by Excel; we’ll explore your 
options next.

 

Bringing Data into Excel Using Alternative Methods

 

When you don’t want an entire file brought into Excel as a complete workbook, or the data 
you need is in a format that Excel cannot open, you need to use other techniques. In some 
cases, with data created in more obscure programs, this is a trial-and-error process. The most 
important thing for you to know is what the alternatives are; armed with this knowledge, you 
should be able to bring most data into Excel in one way or another. As mentioned earlier, these 
methods include cut/copy/paste or drag and drop, inserting, and importing.
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The simplest method is often just copying from a file and pasting into an Excel worksheet. 
This can be accomplished by using the cut, copy, and paste commands or by using the drag-
and-drop techniques. Let’s explore these first.

 

Moving and Copying Data into a Worksheet

 

Depending on how usable you need the data to be in Excel, you can use methods to move or 
copy it into your worksheet. Anything you see on your screen can always be captured using 
the Print Screen key on your keyboard. Capturing a screen image using the Print Screen key 
places this image in the Windows Clipboard, so all you need to do is open your Excel work-
book and paste it there. Of course, this will paste a picture of the data and not the data itself, 
so that limits what you can do with the data in Excel. However, if you have a program with 
Optical Character Recognition (OCR) capability, you can try to convert the image to text. 
This is rarely perfect, but it does get you closer to what you want. Then you can just copy the 
converted text and paste it into your worksheet. Generally, most new image scanners include 
OCR technology, so if you have a scanner, you probably have some type of OCR software on 
your computer.

But rarely do you have to resort to screen captures. In most cases, no matter what the for-
mat of the document, if you can open it in any program on your computer, you should be able 
to select the text or image and copy it, and then paste it into your worksheet.

 

It’s important that I mention plagiarism here. Always remember, if you are 
copying data from any file that you did not create yourself, you must get per-
mission from the author to do this. Whether it’s a file you received via email, 
or a scanned image of a hard copy of any document, or a web page you’ve 
browsed to on the Internet, copying data from these sources will always 
require written permission—especially if you are going to share this informa-
tion. In most cases, authors will include copyright permissions and instructions 
in the file or on the website. Be sure what you are doing is legal; don’t assume 

 

that, just because it’s on your computer, it belongs to you!

 

Let’s use Exercise 10.1 to explore the different ways to cut or copy data, and then paste it 
into a worksheet.

 

E X E R C I S E  1 0 . 1  

 

Using the Copy/Paste Commands to Bring Data In

 

1.

 

Open the file Exercise 10-1.xls that you extracted from the zipped file for this chapter.

Assume we are an ad agency and this is a listing of prospective clients. Also, assume you 
have browsed the Internet for new clients and found one named Perfect Perfumes.

 

2.

 

In My Computer, browse to the folder Exercise 10-1 webpage that you extracted from the 
zipped file for this chapter. Double-click the folder to open it. Then double-click the file 
perfectperfumes.htm. The file opens in your browser. 
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3.

 

On the web page, drag your mouse to select all of the text in the purple box and copy it.

 

4.

 

Click the Excel file button on your Windows Taskbar (at the bottom of your screen) to 
bring up your opened Excel worksheet.

 

5.

 

Select cells A8:A14 and choose Insert �

 

 Row. Excel inserts seven rows above Wild 
Fragrances.

 

6.

 

In the new empty cell A8, type 

 

Perfect Perfumes

 

.

 

7.

 

Select cell A9 and paste. Excel inserts the data from the web page into cells A9:A13.

 

8.

 

Use the Format Painter to copy the format from A3 into A8; then copy the format from A4 
into A9:B9; and finally copy the format from A5 into A10:B14.

 

9.

 

Format B10:B14 as currency with two decimal places.

 

10.

 

Widen column B to fit the text in B9.

 

11.

 

In C9, type 

 

Logo

 

 (or type an 

 

L

 

 and let AutoComplete finish it for you). Press Enter.

 

12.

 

Select cell D9 and click on the web page on your Windows Taskbar to bring it up.

 

13.

 

Click outside the highlighted text on the web page to deselect it. Then, right-click on the 
picture of the perfume bottle on the web page and choose Copy.

 

14.

 

Bring up the workbook again by clicking it on the taskbar, and then paste the picture. 
Resize and move the picture so that it fits between rows 10 and 14.

 

15.

 

Close the browser window. In My Computer, find the file Wild Fragrances.doc that you 
extracted from the zipped file for this chapter. Double-click it to open it. Doing so opens 
the file in the word processor on your computer (such as Microsoft Word).

 

16.

 

Right-click on the picture in the document and choose Copy.

 

17.

 

Return to the Excel workbook and delete the text 

 

unavailable

 

 in cell D16. Then paste the 
picture there. Move and resize it so that it fits between rows 17 and 22.

 

18.

 

Return to the DOC file and select View �

 

 Task Pane. Choose Clipboard from the dropdown 
list at the top of the task pane. Select the text 

 

Bold and Beautiful

 

 and copy it. It appears 
in the task pane. Then, select the text 

 

$12

 

 and copy that. It too appears in the task pane.

 

19.

 

Return to the Excel workbook and select View �

 

 Task Pane. Choose Clipboard from the 
dropdown at the top of the task pane. You should see both of the copied items in the 
task pane.

 

20.

 

Select cell B22 and click on the text 

 

Bold and Beautiful

 

 in the task pane to add it to B22. 
Then select C22 and click on $12 in the task pane. Close the task pane.

 

E X E R C I S E  1 0 . 1

 

( c o n t i n u e d )
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As you can see, it’s fairly simple to copy data from any file into Excel using the copy/paste 
commands. You can also remove the data from the original file and put it into the Excel file 
using Cut instead of Copy. In addition, you can tile windows side by side (see Figure 10.3) and 
use drag and drop to move or copy data. Exercise 10.2 shows you how.

 

F I G U R E 1 0 . 3

 

Tiling windows lets you easily drag and drop data from one program to 

 

another.

 

If you do not have Microsoft Word on your computer, you will have to select the two text 
areas in the DOC file, one at a time, then return to Excel and paste them individually into 
the cells. However, it’s important that you know how to use the Clipboard task pane. This 
is because all of the Microsoft Office programs will be installed on any computer where 
you take a MOS Exam, and you may have to do exercises using steps 18 through 20.

 

21.

 

Format cell C22 as currency with two decimal places.

 

22.

 

Use the Save As dialog box to create a 

 

Chapter Ten

 

 folder and save this file in that folder. 
Name it Exercise 10-2.xls and close the workbook. Also, close the DOC file. If you’re 
prompted to save the DOC file or keep the data stored on the Clipboard, click No.

E X E R C I S E  1 0 . 1 ( c o n t i n u e d )
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E X E R C I S E  1 0 . 2  

Using Drag and Drop to Bring Data In

1. Open the file Exercise 10-2.xls that you saved in the previous exercise. If you did not save 
it, extract Exercise 10-2.xls from the zipped file for this chapter.

2. For simplicity’s sake, make sure no other programs are open on your computer. Then 
select My Computer and locate the Exercise 10 Sample.ppt file in the Samples folder. 
Double-click to open that file. PowerPoint launches, displaying the slide show presenta-
tion file. Be sure to close the My Computer window. Nothing should show on your Task-
bar except the opened Excel file and the opened PowerPoint file.

If you do not have PowerPoint installed on your computer, you can follow along in this 
exercise using another file. But, remember, when taking the MOS Exam, you may have 
to move between different Office programs, so you should understand how to do this 
exercise.

3. Right-click on a blank area of your Windows Taskbar. (Do not right-click on any button. 
Make sure you right-click on a blank part of the Taskbar.)

You’ll see the shortcut menu shown here:

4. From the shortcut menu, choose Tile Windows Vertically. The Excel file and PowerPoint 
file appear onscreen, side by side, as shown in Figure 10.3.

5. Click in the Excel workbook to make it active. Then add a new worksheet to the workbook 
and name it Chart.

6. Make sure the new empty sheet is displayed. Then click on the PowerPoint presentation 
to make that the active file.

7. On the left side of the PowerPoint file, you’ll see four small numbered icons. Click the one 
that shows number 2. PowerPoint displays the slide with the chart on it.

8. Click on the large chart picture to select it (white circles appear around it when it is 
selected); then hold down your left mouse button and drag it onto the Chart sheet in the 
Excel workbook.
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When you copy information from one program to another, the information is embedded 
if you are copying an entire object (for example, the chart object copied in Exercise 10.2). 
Microsoft does this so that you can edit the copied object using the original software that 
created the object (see Figure 10.4). This is called Object Linking and Embedding (OLE). 
When objects are embedded, double-clicking the object in the client application launches the 
server application (right inside the client!). In the example demonstrated in Exercise 10.2 
and shown in Figure 10.4, the client is Excel and the server is Microsoft Graph, which is 
what PowerPoint 2003 uses to create charts. Once you’ve launched the server, you can then 
edit the object using the original software that created it, then simply deselect the object, with-
out having to open that software, find the file, make the changes, save the file, and reinsert the 
new file into the Excel workbook. It’s quite a timesaver.

9. As you can see, dragging moves the file. At this point, it is missing from the PowerPoint 
file and appears in the Excel file. Click the Undo button in Excel; then click on the Power-
Point file to make it active and click the Undo button there as well. The chart returns to 
the PowerPoint file.

10. Right-click on the large chart in the PowerPoint file and note the copy option on the short-
cut menu. However, this time hold down your right mouse button and drag the chart onto 
the Chart sheet in Excel. Release your mouse button and choose Copy Here. This action 
puts a copy of the chart in the Excel workbook but leaves the original in the PowerPoint 
presentation.

11. Click on the PowerPoint file to make it active. Then close PowerPoint by clicking on the X 
in its top-right corner. If prompted to save changes, click No.

12. Maximize the Excel window. Then click one time on the chart to select it. When it is 
selected, white circles appear around it. (It may be pretty large, so you may have to scroll 
to find the white circles on the edges or corners.) Use your resizing pointer on the white 
circles to resize the chart so that you can see all of it onscreen. Make sure you can see 
some blank cells at the bottom and to the right of the chart.

13. Double-click the chart and note the boundary box surrounding it. A data sheet also 
appears. Click the Help menu; you’ll see that you are in Microsoft Graph (see Figure 10.4).

14. With the chart open in Microsoft Graph, click the X on the small data sheet to close it; then 
right-click on the white background area of the chart and choose Format Chart Area. 
Choose a green color from the color choices in the Area section. Then, click OK.

15. Click outside of the chart to deselect it and return to the Help menu. You are now back in 
Excel.

16. Save the file as Exercise 10-2A.xls and close the file.

E X E R C I S E  1 0 . 2 ( c o n t i n u e d )
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F I G U R E 1 0 . 4 Embedded objects in Excel will launch the program that created them 
when double-clicked.

You can use OLE to add many different types of objects to your Excel workbooks. This is 
done through the Insert menu, as you’ll learn next.

Inserting Objects into a Worksheet

Many times, when you can’t open a file type in Excel and you don’t have the program needed 
to open the file outside of Excel, you can instead insert the object from within Excel without 
actually opening it. Inserting objects always embeds them, and it gives you the option to link 
to the original object so the copy in the Excel file will update when the original is updated. 
Another option is to insert an icon that can be clicked to open the file. Obviously, using the 
icon or including a link will require that the linked objects are available when the workbook 
is opened (see more on this in Chapter 7, “Advanced Data Organization and Display”), so 
take that into account when making your choices.

Some different types of objects you can insert into Excel worksheets include Adobe Acrobat 
PDF files, all types of graphic files, Microsoft Word documents, and PowerPoint slides.

Premade objects can be easily inserted into a worksheet, but the Insert � Object command 
also lets you actually create the object using any software on your computer. As you can see 
in Figure 10.5, the Object dialog box has two tabs: Create New and Create From File. The 
Create New tab displays all of the programs that Excel can launch for you. In some cases, if 
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you try this, it won’t work because you don’t have the program installed. But if you do have 
the program installed, Excel will insert an empty object in the worksheet and launch the pro-
gram for you when you select it in the list and click OK.

F I G U R E 1 0 . 5 The Insert � Object command lets you create a new object or choose one 
from a file already on your computer.

I find the Create New option more problematic and confusing than it is worth. If you have 
the program installed, it’s much easier to create the object with that program before you insert 
it into Excel by using the Create From File tab. Exercise 10.3 shows you how.

E X E R C I S E  1 0 . 3  

Using the Object Dialog Box to Bring Data In

1. Open a new blank workbook and select Insert � Object. Then select the Create From File tab.

2. Click the Browse button and find the Samples folder you extracted from the zipped file for 
this chapter.

3. Select Exercise 10 Sample.doc and click the Insert button. The path appears in the File 
Name box.

4. Click OK; Excel inserts the document as an embedded object. With the document 
selected, note that the Formula bar says =EMBED("Document","").

5. Click outside of the object, then double-click the inserted object box.

6. Note the boundary box surrounding the object. Select the Help menu and you’ll see that 
you are in Microsoft Word. Now you can edit this file using all of Word’s features.

7. Click outside of the object to deselect it.
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Experiment with the files in the Samples folder and insert them all to see what happens. You 
can also put the Word document into a worksheet simply by selecting the text in Word, copy-
ing it, and pasting it into the worksheet (dragging and dropping also works well between 
Word and Excel files). However, this is a good example of the difference between copying and 
pasting just the text and embedding the entire document. As you saw in Exercise 10.3, when 
you embed the entire Word document, you must use Word if you want to edit it. But if you 
just copy/paste the text from the Word document (as we did in Exercise 10.1), it will not be 
embedded, so you can edit it with Excel. The choice is yours. As long as you understand the 
difference between the two, you can make the decision based on your own needs.

Now, we’ll discuss one more way to bring data into Excel: importing.

Importing Data into a Worksheet

While inserting is used to bring objects into Excel, importing is used specifically for data. If 
you choose Import External Data from the Data menu, you can select between importing your 
data or running a query. Importing is basically a database feature in Excel, so generally it is 
used to bring in either Access data or data from some other database, or to bring in XML data. 

Select Data � Import External Data � Import Data to open the Select Data Source dialog 
box. By default, it is set to look in the folder My Data Sources, a premade subfolder in your 
My Documents folder. Note that the Files Of Type dropdown box is set to look for database 
files only, such as MDB and ODC files.

8. Select a cell in column A below the object and return to the Object dialog box. Move to 
the Create From File tab and browse to find the file Exercise 10 Sample.ppt in your Sam-
ples folder. Insert that file.

9. On your worksheet, you’ll see the first slide in the PowerPoint presentation and your For-
mula bar displays =EMBED("Presentation","").

10. Double-click the slide to run the slide show. (If you are unfamiliar with PowerPoint slide 
shows, just click your mouse button to advance from slide to slide; then, when the show 
is done and you see a black screen, click your mouse button one more time to end the 
show and return to the workbook.)

11. Click on the slide one time to select it; then press the Delete key to delete it from the work-
sheet. Select a cell in column A below the Word document object.

12. In the selected cell, type Click to see our slide presentation and press Enter.

13. Return to the Create From File tab in the Object dialog box and select your PPT file again. 
This time, select Link To File and Display As Icon before you click Insert. 

14. The icon appears on the worksheet. Double-click it to run the slide show.

15. Close the Excel file and save it in your Chapter Ten folder as Exercise 10-3.xls.

E X E R C I S E  1 0 . 3 ( c o n t i n u e d )
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Click the New Source dropdown and you’ll see the Data Connection Wizard shown in Fig-
ure 10.6. This wizard helps you to connect to any remote data source and lets you choose the 
type. Many companies use SQL Server, for example, and you can import data from this type 
of setup by using this wizard to connect to the server when your company tells you its location, 
the password needed, and other connection information.

F I G U R E 1 0 . 6 Use the Data Connection Wizard to import data from remote servers.

Click Cancel to close the Data Connection Wizard, and then close the Select Data Source 
dialog box.

Return to the Data menu and look at the submenu displayed when you select XML. Notice 
that there’s an Import option in this submenu also. Clicking it brings up a dialog box where 
you can browse to find any XML files.

As we saw in the beginning of this chapter, both MDB and XML files can be opened in 
Excel when you want to bring the whole file in as a new workbook. However, when you want 
to bring these files into an existing workbook, you must import them. Let’s use Exercise 10.4 to 
do that.

E X E R C I S E  1 0 . 4  

Using the Import Options to Bring Data In

1. Open the file Exercise 10-1.xls.

2. Select cell A16 and choose Data � Import External Data � Import Data.

3. Navigate to your Samples folder and open Exercise 10 Sample.mdb.

4. When the Select Table dialog box opens, choose tblProductSales.

5. When the next dialog box opens, be sure it is showing cell A16 in the Existing Worksheet box, 
then click OK. Excel brings all of the records from that table into your existing worksheet.
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As you can see, there are many ways to bring data into Excel. Now, let’s explore all the 
methods for getting data out of Excel and into a format that can be used by other programs.

Data Out
Though more and more people are using Excel, there are still times when you need to share 
your data with someone who does not have Excel installed on their computer. There are also 
times when you simply want the data included in another file of a different type or even in a 
web page at a website. Most of what I cover in this section is basically the opposite of what 
was covered in the “Data In” section. In some cases there are fewer options when moving data 
out of Excel than there are when bringing it in. Sometimes, the format you are moving the data 
into will not support all of the Excel features used to create the file and, therefore, the data will 
lose some functionality. However, in most cases, you can get your data into a format that can 
be viewed by others—even when they don’t have Excel installed.

In this section, we will look at cut/copy/paste and drag and drop as ways to move or copy 
data out of Excel into other file types; Save As and the different ways Excel files can be saved, 
viewed, and edited; ways to import and insert Excel data and objects in the other Office pro-
grams; and methods for exporting XML data maps. Let’s start with simple moving and copy-
ing of data.

6. Return to the Data menu and choose XML � Import. Navigate to the file Exercise 10 Sam-
ple.xml in your Samples folder. Select the file and click the Import button. You see the fol-
lowing message telling you that Excel must create a schema (which you will learn more 
about when we export XML later in this chapter). Just click OK.

7. When the next dialog box opens, choose XML List In A New Worksheet and click OK.

8. You will see an error message telling you that some data was imported as text. This is 
fine. Click OK. 

When the XML data comes in, take a look at it. Note the headings in row 1 showing the 
formatting and properties of the data. Remember that XML does not really pertain to the 
data itself, but instead reflects the formatting and properties applied to the data.

9. Save the file in your Chapter Ten folder and name it Exercise 10-4.xls. Close the file.

E X E R C I S E  1 0 . 4 ( c o n t i n u e d )
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Moving and Copying Data Out of a Worksheet

This is done basically the same way as moving and copying data into Excel. However, it’s 
important to keep in mind that when you copy data from Excel into another file format, in 
most cases the data is formatted as a table.

When the file you are moving or copying the data to supports table formatting (Microsoft 
Word documents, HTML email, etc.), Excel data will appear in a table, based on the way it 
is divided into cells in the worksheet. If the file you are moving or copying to does not support 
formatting (such as a Notepad text file or plain-text email), the data will simply appear in 
rows, separated by spaces, based on the layout of the worksheet.

You can see this in action pretty easily by simply opening a blank email in whatever email 
program you use and setting the format to HTML or Rich Text then selecting a range of cells in 
an Excel workbook, copying them, and pasting them in the email. Excel aligns the data nicely 
in a table, as shown in Figure 10.7. Then, open a second email, set the format to plain text, 
and paste the range of cells again. The rows are maintained but the columns are not aligned. 
You can try the same thing using Microsoft Word to paste the formatted version, and Notepad 
to paste the unformatted version.

How Excel Saved My Website

I have a website and I use Microsoft FrontPage as my web-editing software. However, it has 
one major flaw: It will not sort data for me. So, generally, when I add data to a list on my web-
site, I have to manually insert the data in the proper location if I want it in alphabetical order.

On one occasion, I had a list of various websites on one of my web pages and the list was ran-
domly input and in no order at all. I realized the list would be much easier for people to use 
if the entries were alphabetical, but the list included over 500 websites and I was darned if I 
was going to manually rearrange them. So, I put on my thinking cap and thought, “This would 
be so easy if it was in Excel” and then it hit me. The list on my webpage was in a table, so I 
copied the table in FrontPage, opened a blank workbook in Excel, clicked in cell A1, and pasted 
the list. Because it was in a table in the web page, Excel recognized it and automatically dis-
played all the table cell contents in the cells on the worksheet. I then sorted the data in ascend-
ing order, based on the column that included the website names; then selected that range and 
copied it; went back into FrontPage and pasted right over top of the unsorted table that was 
there. Bingo! My web page now listed the sites in alphabetical order and the whole cleanup 
process took me about two minutes.

This is a really good example of how moving data in and out of Excel can save you lots of time 
and headaches.
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F I G U R E 1 0 . 7 Pasting Excel data into HTML or Rich Text emails preserves table 
formatting while plain text does not.

The bottom line is the data can be shared via email, by simple copy/pasting, even if some 
of the formatting is lost. Obviously, if you want to move the data as opposed to copying it, you 
do it the same way, except you use the Cut command instead of Copy. You can also move and 
copy data from Excel by tiling windows and using the various drag-and-drop techniques.

When moving or copying data from Excel into another program, the options you have when 
pasting are governed by the other program and not Excel. See Figure 10.8 for an example; 
when pasting a chart from Excel into Word, the option button gives you choices of pasting the 
chart as a picture, pasting the entire workbook as an embedded object, or linking the picture 
to the Excel chart.

Plain Text Email

HTML Email
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F I G U R E 1 0 . 8 Different programs give you different options when pasting from Excel.

Use Exercise 10.5 to learn some other ways you can use copy/paste and drag and drop to 
move or copy data and objects from Excel into other file formats.

E X E R C I S E  1 0 . 5  

Using Copy/Paste and Drag and Drop to Get Data Out of Excel

1. Open the file Exercise 10-5.xls. 

2. Right-click on the pie chart and choose Copy.

3. Go into My Computer and navigate to the Samples folder. Double-click Exercise 10 
Sample.doc to open it. The file opens in Microsoft Word.

4. Click below the table in the Word document and press the Enter key twice. Then right-
click and choose Paste (or press Ctrl+V). Click the Paste option button and note that the 
default is to paste the chart as a picture. Choose Link To Excel Chart. Click on the picture; 
it takes you to the Excel workbook.

5. Close the Word document and do not save it.
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Try copying different data and objects in Excel and pasting them into various programs and 
see what you get. If you have a graphics-editing program on your computer (such as Adobe 
Photoshop or Microsoft Paint), paste some Excel data in a picture, then save the picture and 
try inserting it in another file type. Or press Alt+Print Screen and copy the Excel window, then 
paste that into a picture or into a Word document. Get creative. Try as many different cut/
copy/paste options as you can. When you are done, move on to the next section, where you’ll 
learn about some more Save As options (in addition to the ones we explored in Chapter 1, 
“Navigating in Excel and Understanding the Interface”), as another way to get data out of 
Excel.

Saving and Editing Excel Files in Different Formats

As I showed you in Chapter 1, the Save As dialog box provides you with many file type 
choices. Some choices will display warning messages on your screen telling you that data may 
be lost if you select this type, so you’ll want to find the best option for your needs. There are 
some file formats that can be opened on any computer, so when you have to get your data into 
a format that everyone can see, you must choose one of these. Text (.txt) and HTML files are 
examples of files everyone can view; however, editing the data in these types is limited to the 
experience level of the person attempting to edit the file.

Let’s look at text files first.

Working with Text Files in Excel and Notepad

When you need to share some data with someone who does not have Excel installed or has an 
old computer with limited capabilities, one way to do it is to save the file as plain text, then 
send that file to them. They can make their changes and return it to you; then you can convert 
it back to an Excel file to view the changes. Remember, though, that plain text is just that: 
plain text. When using this format, no formatting or formulas will be included with the file, 
so it’s a limited alternative.

Use Exercise 10.6 to see what can and cannot be done with text files.

6. Go to My Computer and navigate to the Samples folder. Double-click Exercise 10 Sam-
ple.ppt to open the PowerPoint presentation. Use the instructions in Exercise 10.2 to tile 
the presentation vertically beside the Excel workbook.

7. Select the range A3:A7 in the worksheet and move your mouse pointer to the top of the 
selection. When you see the four-headed arrow, right-click and drag the selection onto 
the bottom part of the PowerPoint slide (Slide 1, which shows a title and subtitle). Release 
your mouse button and note the choices in the shortcut menu. Select Move. The range 
is pasted onto the slide, in a table, and removed from the Excel worksheet.

8. Close the PowerPoint presentation and the Excel workbook. Do not save either of them.

E X E R C I S E  1 0 . 5 ( c o n t i n u e d )
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E X E R C I S E  1 0 . 6

Saving and Editing Plain Text Files in Excel

1. Open the file Exercise 10-6.xls. Notice the simple data on the Prices sheet and a pie chart 
on the Chart sheet. Also, note that there is a formula in cell B9 on the Prices sheet.

2. Make sure you are on the Prices sheet and select File � Save As. Save this file in your 
Chapter Ten folder. In the Save As Type dropdown, choose Text MS-DOS (*.txt). The file-
name is now Exercise 10-6.txt. Click Save.

3. You are presented with a message telling you that text files do not support multiple 
pages and that only the active sheet will be saved. Click OK.

4. Excel displays another message, this time telling you that saving in this format may not 
include all of the features in the file. Click Yes.

5. Note that the title bar in Excel now displays Exercise 10-6.txt. Close the file. If prompted 
to save changes, click No.

6. In My Computer, navigate to your Chapter Ten folder. Find the file Exercise 10-6.txt and 
double-click it to open it. It opens in Notepad (or whatever text editor you use).

7. In your text editor, change the Hand Lotion price to $6.95 and the Vita Bath price to 
$10.95. Notice the Average does not change.

8. Go to the File menu in your text editor and choose Save As. Name the file Exercise 10-

6A.txt and save it in your Chapter Ten folder. Close the text file.

9. Return to Excel and select File � Open. Choose All Files (*.*) in the Files Of Type drop-
down list. Find Exercise 10-6A.txt and open it.

10. When the Text Import Wizard appears, note the default settings. Leave them as is and click 
Next, then Next again, noting the settings and preview on the first two steps of the wizard.

11. When you get to Step 3 of the wizard, note the choices for formatting. As you can see, cur-
rency is not an option. Leave both columns formatted as General and click Finish.

Note that the updated prices are reflected, but the formula in B9 is missing and the Chart 
sheet is missing as well. Also note that the sheet name has changed to show the file-
name. And, of course, all of the font formatting has been stripped away too.

12. Select one of the cells containing a dollar amount and open the Format Cells dialog box. 
As you can see, Excel has recognized it as currency (because of the dollar sign in the cell). 
Click Cancel to close the dialog box.

13. Choose File � Save As and save it as a Microsoft Office Excel Workbook (*.xls). Save it 
in your Chapter Ten folder, with the name already assigned, Exercise 10-6A.xls, and close 
the file.
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You can see that using text files to share data is pretty limited. But if it’s the only choice you 
have, at least it does allow others to make changes to the data. Generally, when a text file is 
returned to me, I open it in Excel, then copy the changed data from the text file into my original 
Excel file. This way, I don’t have to reconstruct all of the formulas. Fortunately, most people 
have computers that include some type of software a little more advanced than a text editor, 
so the need to use plain text files doesn’t come up nearly as much as it used to.

Another way to share Excel files in a global format that all people can see is to save them 
as HTML. Let’s look at that next.

Working with HTML Files in Excel and Internet Explorer

Because every computer comes with an Internet browser installed and every computer with 
Windows installed includes Internet Explorer, the option of saving the file as a web page is 
very useful. The advantages to a web page (versus a text file) are you can include more than 
one sheet and you can display charts and graphics. 

If you want people to be able to view only the file, simply saving it with the .htm or.html 
extension will work. However, when you want people to be able to manipulate the data, Excel 
also allows you to publish web pages with interactivity so others, either on a network or via 
the Internet or intranet, can edit them. When a file includes interactivity, even the formulas can 
be adjusted by double-clicking a cell (see Figure 10.9); however, this works with few browsers 
other than Internet Explorer 5.01. It also requires that Excel be installed on the computer on 
which you’re viewing the page.

F I G U R E 1 0 . 9 Publishing Excel files as web pages with interactivity allows Internet 
Explorer users to adjust cell content.
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When you save an Excel workbook for the Web, you use the Save As Web Page command 
in the File menu. You can choose to save the entire workbook or just the active sheet (see Fig-
ure 10.10). Other options are available if you click the Publish button in the Save As box. You 
can specify a specific range to be published, you can choose to AutoRepublish the web page 
every time a change is made to the workbook, and you can specify whether you want spread-
sheet or PivotTable interactivity.

F I G U R E 1 0 . 1 0 The Save As dialog box gives different options when you’ve used the 
Save As Web Page command to access it.

Let’s look at publishing web pages in Exercise 10.7.

E X E R C I S E  1 0 . 7  

Publishing Workbooks as Web Pages

1. Open the file Exercise 10-7.xls and select File � Save As Web Page.

2. Note the choices at the bottom of the Save As dialog box (shown in Figure 10.10). Make 
sure Entire Workbook is selected, then select Add Interactivity.

3. Change the filename to prices.

4. Click the Publish button; the following dialog box appears:
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5. Use the picture shown as a guideline and make these choices:

� The Item To Publish box should display Entire Workbook. If it doesn’t, use the drop-
down to change it.

� The Viewing options should display Add Interactivity With Spreadsheet Functionality, 
and it is grayed out. If it does not show this, choose Items On Prices from the Item To 
Publish dropdown at the top. Then adjust the interactivity choices, and choose Entire 
Workbook again from the top dropdown.

� Click the Change button to change the title to Products and Jobs. Click OK.

� Click the Browse button to navigate to your Chapter Ten folder. Click OK.

� Select Open Published Web Page In Browser.

6. Click the Publish button and the page launches in Internet Explorer.

Internet Explorer may show a bar at the top that says it has restricted active content. This 
is a security thing. Click that bar and choose Allow Blocked Content. Then click Yes when 
the next security warning pops up.

7. Double-click cell B9 in the interactive page. Note that you can view and edit the formula.

8. Select cell B3, type 7.95, and press Enter. Note that you can change the cell content and 
that the value in B9 also adjusts.

9. Select cell A3 and click the Sort Ascending button.

10. Run your mouse across the other buttons at the top of the worksheet and review the tool-
tips. Click the Commands And Options button. Look through the tabs to see what you 
can do.

11. Close the Commands And Options dialog box by clicking the X at the top right. 

12. Look at the bottom of the worksheet and click the Prices sheet tab. Choose Goals from the 
pop-up.

13. Double-click cell A5. Use the → key to move to the end of the sentence and press your 
spacebar, then type -- I will do this one. LJ (you can use your own initials instead of LJ).

14. Click the Export To Microsoft Office Excel button on the toolbar. The file is moved into 
Excel.

15. In Excel, select File � Save As. Note the default file type is XML Spreadsheet (*.xml). Do 
not change this file type. Save the file as Exercise 10-7A.xml in your Chapter Ten folder. 
Close the XML file.

E X E R C I S E  1 0 . 7 ( c o n t i n u e d )
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If you just want to save a file in an HTML format so others can see it, even without Excel 
installed, simply choose File � Save As Web Page; do not select the Add Interactivity box and 
do not click the Publish button. Simply give it a name and click Save. This will save the file and 
create a folder to hold the settings for the file. If you look in the Samples folder for this chapter, 
you will see a file named Exercise Sample 10.htm. You will also see the folder that was created 
when this file was saved; it is named Exercise Sample 10-files. If you are experienced with web 
page design, open this folder and check out the XML, CSS, and various HTM files. If you 
aren’t a web designer, you can ignore that folder because it’s outside the scope of this book. 
However, if you ever want to send someone an HTML page that was created and saved in 
Excel, you must include that folder so that people can view it properly.

If you are familiar with HTML coding, you might want to save one of your 
Excel workbooks as a web page, then right-click on it in your browser and 
choose View Source. Take a gander at that code! Personally, I prefer to create 
my web pages using software other than Excel because of all of the excess 
code Excel adds when doing this. However, to fully utilize the interactivity fea-
ture, you must use Excel.

Now, let’s briefly look at how Excel files can be inserted and imported into other file formats.

Importing and Inserting Excel Worksheets into 

Other File Types

Unlike some programs, Excel doesn’t give you the opportunity to export the data into another 
file. However, you can use the Import and Insert commands in many programs to bring the 
Excel data in. 

Since the importing or inserting would be done in the other program, and not in Excel, I 
won’t go into a lot of detail on how to do this, but I will give you some tips so it goes smoothly 
when and if you need to do it:

Preparing a worksheet for Microsoft Access importing Access allows users to import Excel 
worksheets to create tables in a database. Access assumes row 1 of the data includes headings 

16. Return to the interactive web page by clicking on it on your Windows Taskbar.

17. Click the Export To Microsoft Office Excel button again.

18. Use Save As to save the file again, but this time, change the file type to Microsoft Office 
Excel Workbook (*.xls). Save it in your Chapter Ten folder and name it Exercise 10-7B.xls. 
Close the file; also close Exercise 10-7.xls (click No if prompted to save changes) and 
close Internet Explorer.

E X E R C I S E  1 0 . 7 ( c o n t i n u e d )
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and allows importers to use those headings as field names. Access does not allow spaces in 
field names, so when preparing your data for Access import, make sure your column labels are 
in row 1 and the labels have no spaces (for example, change Week 1 to Week1 or Week_1). 
Also, remove any blank rows from the data, or the Access table may be cluttered with empty 
records. It’s also a good idea to name any ranges that might be imported into Access tables 
individually (as opposed to the whole worksheet). Access allows importers to choose the range 
name when importing the Excel data, so this is a timesaver.

Preparing a worksheet for Microsoft Word mail merges Mail merges in Word are used for 
mass mailings to a database of contact names. The data source for the names can be created 
in Word, or pulled from an Access table, an address book in Microsoft Outlook, or a work-
sheet in Excel. I almost always use Excel for this because it allows me to set up a simple listing 
of names and addresses. When setting up an Excel sheet as a mail-merge data source, you need 
to keep a few quirks in mind. Like Access, Word will assume the field names are in row 1 and, 
for some unknown reason, Word sometimes can’t identify these names if the formatting in 
row 1 is the same as the formatting in the rest of the rows. So, it’s always best to change row 
1’s formatting slightly (simply making it bold seems to do the trick). Also, Word sometimes 
complains that it can’t find the data because there are no named ranges in the workbook. So, 
with this in mind, it’s best to name the range of contacts in the worksheet. And, finally, Word’s 
mail merge will stop when it sees a blank row and assume there is no more data, so always 
remove all blank rows from your worksheet when preparing it for a mail merge.

Preparing workbooks for inserting them as objects in other Microsoft Office programs
Like Excel, other Office programs, like Word and PowerPoint, have the Insert � Object com-
mand and allow users to insert Excel worksheets and charts into documents and slides as 
embedded objects. However, they only insert the first sheet. So, to prepare a workbook for 
insertion as an object, you can do one of two things: create separate workbooks for each sheet 
or move the sheet you will be inserting to the first sheet-tab position.

Obviously, preparing Excel workbooks for importing into other non-Office programs is 
something you may have to do. So, it’s important that you understand how the import features 
work in a program so you can set up your worksheets to come into the program in the cleanest 
way possible. Hopefully, this chapter has helped you with that.

Before we are done, there’s one more way to get information out of Excel. Let’s move on 
and learn a bit about XML, which allows you to export data and settings from Excel files in 
yet another way.

Saving Workbook Structure Using XML

XML technology is one of the focal points of Microsoft Office 2003. It allows you to share 
data with people who aren’t using Excel and it includes all of the settings regarding the work-
book’s structure. Most of this technology is way beyond the scope of this book or the MOS 
Exam, but it’s important for you to have an overall idea of how XML data looks and how to 
export the XML data out of a workbook, so that’s what we focus on next.
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XML technology is based on a schema, which is the document that defines the structure of 
a set of XML files. The schema is stored in a file with a .xsd extension. The pattern of data rep-
resented in any worksheet is called a data map. To save Excel files as XML data files (which 
display as XML code), you must know how to create maps and schemata, which is not covered 
in this book. But you can save any Excel file as an XML spreadsheet without this knowledge. 
Let’s look at an XML data file to see the code, then create an XML spreadsheet to see how 
it’s done.

In My Computer, navigate to the Samples folder. Open the subfolder named Exercise 10 
Sample_files. This folder was created automatically when Exercise 10 Samples.htm was saved 
as a web page in Excel. Inside this folder is a file named filelist.xml, which is an XML data file. 
Double-click the XML file and it opens in Internet Explorer (click the bar at the top if Internet 
Explorer blocks the content and choose Allow Blocked Content). This is a very simple XML 
data file that shows the simple structure of the Exercise 10 Sample folder. The top line iden-
tifies the schemata as coming from Microsoft Office, and you can also see lines that refer to 
the HTML pages created in the folder. This filelist.xml file simply shows the structure of the 
folder contents for this web page. That’s what an XML files does; it stores the structural set-
tings for any folder or file.

Close Internet Explorer and open Excel. Open Exercise 10-X.xls, then select File � Save As 
and choose XML Spreadsheet (*.xml) as the file type. Save it in your Chapter Ten folder as 
Exercise 10-X.xml. Just click Yes when Excel warns you that it can’t save the VB Project this 
way. Saving the file as an XML spreadsheet configures it differently than saving it as an XML 
data file. To see this, close the XML file in Excel and open Internet Explorer. Choose Open 
from Internet Explorer’s File menu. Click the Browse button. Change the File Type dropdown 
at the bottom to show All Files and locate Exercise 10-X.xml in your Chapter Ten folder. 
Select the file and click Open, then click OK. The file opens in Excel.

Most people on the user level will never use the full XML technology, but you could pos-
sibly be given XML files or be asked to save a workbook in XML format, so now you know 
how to view them and export the structure.

Summary
Knowing how to move data in and out of Excel will greatly reduce the amount of work you 
have to do when creating files. If you have the data in one location already, knowing how to 
get it into another is probably one of the biggest advantages to having data stored in a com-
puter. There’s no need to retype stuff over and over—just bring it in or send it out.

Using the Save As command in most programs lets you save files in various formats. Many 
of these formats can then be opened by Excel, either through automatic conversion or by using 
conversion wizards. 

Another way to get data into and out of Excel is by using the Cut, Copy, and Paste com-
mands (or their keyboard shortcuts) or even by tiling the Excel window beside the other 
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program’s window and dragging and dropping data between them. You can also create screen 
captures of anything on your screen and paste them into Excel or any of the other Office 
programs.

File objects can also be inserted into Excel worksheets, and Excel worksheets or charts can 
be inserted, as objects, into other files. Inserting objects embeds them so they can be edited 
using the original software used to create them. When you double-click an inserted object, the 
server program that created the object launches inside the client program that now holds the 
object.

Excel data can also be copied into web pages as a table, and data in web-page tables can 
be easily copied from Internet websites into Excel. You can also save selected ranges, whole 
worksheets, and entire workbooks as web pages, and you can make them interactive so people 
who have the later versions of Excel and Internet Explorer can manipulate the data and import 
it into Excel.

The advantage to saving a workbook as a web page is that other users who don’t have Excel 
installed can still view the data. You can also save worksheets as plain text files that anyone 
can view and edit. You can save the structural settings for a workbook so they can be viewed 
by anyone, using XML.

Some of the other Office programs have Import commands that allow users to import Excel 
data and, as long as your Excel data is cleanly formatted, this goes relatively smoothly. For 
example, Excel data can be imported into Access tables and Word mail merges.

There is rarely a case where Excel data cannot be moved in or out. The possibilities are limited 
only by your own imagination.

Exam Essentials
Know which types of files Excel can open. Familiarize yourself with the more common file 
types that Excel can convert by simply using the File � Open command.

Be familiar with all methods of copying and moving data to and from Excel. Know how to 
copy data between programs using the copy and paste commands and how to move data using 
the cut and paste commands. Understand when tiling windows and using drag-and-drop tech-
niques will save you time.

Know how to insert various objects into worksheets. Be familiar with the choices available 
to you in the Objects dialog box. Know how to insert the full object or just an icon, as well 
as how to link to the original.

Make sure you can work with embedded objects. Be prepared to edit objects using the 
server software that created them.

Be proficient in saving files as HTML and XML. Understand the additional functionality 
available when saving web pages with interactivity. Know the difference between HTML and 
XML and what they do.
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Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. To complete these exercises, extract the complete folder MOS Scenarios Ch10 
from the zipped file for this chapter and open the file MOS Scenarios Ch10.xls from within 
that folder.

 

MOS Scenario 26: Add External Data and Graphics into an Excel File

This file needs a logo on the Stats sheet to the left of the title. It also needs an editable chart 
on a new sheet at the end named Chart. Find the logo in the Word document ZebraTech.doc 
and the chart in the PowerPoint presentation file EasternSales.ppt, and add them in the cor-
rect places in this file.

 

MOS Scenario 27: Import XML

Add a new sheet named Structure Settings at the end of this file and import the XML file 
named Chapter 10 Scenario.xml into the new sheet.

 

MOS Scenario 28: Prepare Excel Data for Importing into Microsoft Access

The information on the Jobs sheet needs to be put into a range named Job_Openings and 
prepared for import into an Access table.
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Working with Macros

 

MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Create, edit, and run macros

�

 

Customize toolbars and menus 
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I’ve dedicated a lot of this book to showing you the steps for per-
forming tasks in the fastest and most efficient way. I’ve also 
focused on making sure data is entered consistently to facilitate 

searching, sorting, and filtering. Now you’ll learn how to create shortcuts that allow you to 
repeat these step-by-step procedures over and over without having to go through all the steps 
manually.

That’s really all a 

 

macro

 

 is: a shortcut. When you devise a way to do something that requires 
a series of steps, you can record those steps and create a macro. The recorded macro is assigned 
to the keystroke combination of your choice, using the macro recorder. You can also assign 
your macro to a toolbar button, a command button, and/or a menu command. Macros can be 
assigned to one specific workbook or they can be assigned to your personal workbook and, 
therefore, be available in all workbooks. Along with teaching you how to record various types 
of macros, I will show you how to view the underlying VBA (Visual Basic for Applications) 
code and how to do some very basic VBA editing, just to get your feet wet. 

First we will learn everything about macros by assigning them to specific workbooks: We 
will create them, edit them, delete them, and assign them to buttons and menus. Once you 
understand all of this, I will show you how to manage your personal workbook, where you 
can store global macros that you want to use in all your workbooks.

To complete the exercises in this chapter, you will need to download the file 
exl2003ch11.zip from the book’s website and extract the files into a temporary folder before 
you begin.

Let’s begin by learning how to use macros in a single workbook.

 

Working with Macros in One Workbook

 

Depending on the function of the macro, you may want it to be available for use in all work-
books, or only in one specific workbook, or even available on only one sheet. When you create 
a macro and assign it to a workbook, that macro will be available to anyone who opens that 
workbook.

Open the file welcome.xls that you extracted from the zipped file for this chapter so that 
you can see a macro in action while I discuss the various features.

When you see the Security Warning message box, click Enable Macros and the file opens. 
As I explained in Chapter 9, “Advanced Template Design and Workbook Security,” if you 
clicked Disable Macros, the file would still open but the macro in the file would not work.
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If your macro security is set to High or Very High, the files used in this chapter 
will not work! In Chapter 9, I taught you how to set up your macro security 
settings. All of the exercises and discussions in this chapter assume you have 
your macro security set to Medium. If you don’t, I recommend you follow the 

 

instructions in Chapter 9 and set it to Medium before you start this chapter.

 

 This looks like a simple blank workbook, but let’s try some things. First, make sure you 
are in cell A1 on sheet 1; then press Ctrl+Shift+Y.

A welcome message appears in cell A1, and the active cell is now A2. This macro simply 
tells Excel to enter that text in the active cell; format it in red, bold, Arial, 14 pt. font; and then 
move to cell A2.

Macros can have both absolute and relative settings. Just as you learned in Chapter 6, 
“Advanced Functions, Table Arrays, and Database Features,” when applying this thinking to 
formulas, 

 

absolute

 

 means it will always refer to the same cell, whereas 

 

relative

 

 means it 
will refer to a cell relative to the location of the active cell selected before running the macro. 
Whether the macro is applied to the active cell or a different cell depends on two things: whether 
the active cell was selected before recording the macro or after the recorder started, and 
whether the recorder was set to absolute recording or relative recording. The macro you just 
ran was recorded after A1 was selected, but it was set to record absolutely, meaning when the 
Enter key was pressed while recording (to move to cell A2), A2 was set as an absolute refer-
ence. To see this in action, select cell D5 and press Ctrl+Shift+Y again. As you can see, this time 
Excel enters the text in D5 (the active cell), but A2 is still selected as the active cell afterward.

As I mentioned earlier, macros can also be assigned to toolbar buttons, command buttons, 
and menu commands. When you assign macros to toolbar buttons or menu commands, 
these toolbar and menu customizations will not be available on other computers, because the 
changes are made to your installation of Excel itself and not contained within the workbook. 
However, a 

 

command button

 

 is a button you can place directly within the workbook and 
easily assign a macro to; that way, anyone opening the workbook on any machine will be able 
to use it.

Move to sheet 2 to see this in action. See the Welcome! button on the sheet? Select cell F2, 
and then click that button. The macro runs in F2 and you are moved to A2. This is the same 
macro that runs when you use the keystroke combination, so it can be run from any sheet in 
this workbook. But, if you only assign the macro to a command button, people will have to 
go to that sheet to run it.

Another way you can run a macro is by using the Run button in the Macro dialog box. To 
see this in action, select any empty cell, then choose Tools �

 

 Macro �

 

 Macros. You will see 
the dialog box shown in Figure 11.1. This dialog box lets you perform different actions per-
taining to any macros you have in the workbook. You can see all the macros listed here. In 
this case, the only macro in this workbook is the Welcome macro, so make sure that you’ve 
selected it in the list and click Run. The macro runs in your selected cell and you are back in 
A2 again.
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The Macro dialog box

 

Close the file now; don’t save your changes, because we will be opening it again in a later 
section and I want it to look just like it did when you first opened it.

Let’s move on now and begin recording some macros together.

 

Recording New Macros

 

Many people are intimidated by macros. Because the underlying programming language used 
in macros is VBA, people often assume they have to be a VBA programmer to be able to create 
macros. This is not so. Macros can be easily created by anyone who understands how to use 
the 

 

macro recorder

 

, and that’s what I will teach you here.
It’s important to understand the difference between recording a macro and running a 

macro. 

 

Recording

 

 is what you do when you create the macro. 

 

Running

 

 is what you do when 
you use an existing macro. Think of it as recording a cassette, CD, or DVD; you turn on the 
recorder to grab the action or sound, then you play (run) the tape or DVD when you want to 
see or hear what you recorded.

Macros can be recorded to perform various actions. Pretty much anything you can do from 
the keyboard or with the mouse can be recorded in a macro. You can record simple macros 
to add text and format it (as you saw in the welcome.xls file in the previous section). However, 
you can also record macros to do more advanced tasks, such as running formulas, opening 
other files, and even printing your workbook with specific settings.

Macros are handy to have when there is any procedure you perform repeatedly. To record 
the procedure, you simply go through all the steps while the macro recorder is running.

However, the recorder will include every step you take while it is running, so I always rec-
ommend you rehearse the steps before you run the macro so it includes as few steps as possible. 
The size of the macro will affect how quickly it runs as well as how much it increases the file 
size of your workbook. A macro that includes three steps—such as selecting a cell and for-
matting it as bold and then typing your name—will be very small and should run quickly. But 
it’s a different story when you record a macro in which you select one cell, then change your 
mind and select a different cell; then format the cell as italic, then change your mind and make 
it bold; then change the font size and decide you don’t like that so you change it again; then 
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type your name including your middle initial, but then decide you don’t want the middle initial 
so you delete it—well, you get the picture. You create a macro that will actually go through 
each and every one of these steps when it runs, and it will run slowly and its file size will be 
huge. And, if any programming geeks decide to take a peek at your macro, they will laugh! So, 
a little rehearsal before recording will increase the performance of the macro and assure you 
that your code is clean and terse (and can fool any programmer into thinking you wrote the 
code using VBA).

Where a macro runs is influenced by the steps taken before and after you start the recorder. 
If you always want a macro run within a particular cell, you must select that cell after you start 
the recorder so the cell selection is part of the macro. If you select the cell before you turn 
on the recorder, the cell selection will not be included in the macro and, therefore, the macro 
will run in whatever cell the user selects before running the macro.

The other option that affects where the steps of the macro are run is the Relative Reference 
button on the macro recording toolbar. No matter where the macro starts, if this button is not 
selected, the following steps of the macro will run in an absolute location; however, if the but-
ton is selected, the macro will be relative and the steps will run in relative locations. When the 
button is selected, it’s shaded and surrounded by a box, as shown here:

To clarify this, let’s say you select cell B1 before you start the recorder; then, while record-
ing the macro, you select cell C2, which is one row below and one column to the right of B1. 
If you record an absolute macro, when the macro is run it will always move to C2, no matter 
what cell it started in. However, if you record a relative macro, when it runs it will move one 
row down, then one column to the right. So, if a user ran this relative macro from D4, it would 
move to E5 and not C2.

Do not confuse absolute and relative macro references with absolute and relative cell ref-
erences in formulas (covered in Chapter 6). If a cell reference in a formula is absolute and that 
cell or formula is included in a step of a relative macro, the cell reference will remain absolute. 
The Relative Reference button only controls which cells will be selected when the macro runs, 
and nothing more.

 

Before you begin recording macros, choose View �

 

 Toolbars. If the list con-
tains a Stop Recording toolbar with a checkmark beside it, click on it to 

 

remove it from the list.

 

The macro recording toolbar is not an “official” toolbar. In other words, you can’t dis-
play it from the list of toolbars in your View menu. The only way to display it is to start 
a new recording job by selecting Tools �

 

 Macro �

 

 Record New Macro. However, while you 
are recording a macro, a temporary Stop Recording entry appears in your toolbar list.

 

4002book.fm  Page 375  Friday, March 24, 2006  11:36 PM



 

376

 

Chapter 11 �

 

Working with Macros

 

This toolbar is tiny and contains only two buttons: the Relative Reference button we dis-
cussed earlier and the Stop Recording button that you click when your macro is complete. It’s 
important that you don’t confuse the Stop Recording button with the X that closes the toolbar. 
Closing the toolbar does not stop the recorder. If you close the toolbar and continue to work 
in the workbook, everything you do is being added to that macro until you click the View 
menu and choose Stop Recording from the list of toolbars. So, it’s a good idea not to use that 
X at all, or you could end up with a macro that’s recorded a lot more than you intended.

One more thing to remember: the recorder does not record live time, which means that if 
you start recording and go have dinner and come back, the recorder will not include the half-
hour gap in time. The recorder only records keystrokes and mouse clicks, so you can take all 
the time you need and it will not affect the size or speed of your macro.

 

If, while doing any of the exercises in this section, you see a Visual Basic 
Runtime Error box, this means that Excel cannot read your macro code and 
is unable to run the macro. This probably just means you have made a small 
error. For now, if this does happen, just close the error message box and 
choose Tools �

 

 Macro �

 

 Macros, then select the macro in the list and click the 
Delete button. Click Yes to confirm the deletion. Then follow the instructions 

 

here to record it again.

 

Let’s try to make this all more real by doing Exercise 11.1. We’ll start with relative refer-
enced macros because this is the type used most often.

 

E X E R C I S E  1 1 . 1  

 

Recording and Running a Simple Relative Macro

 

1.

 

Open a new blank workbook.

 

2.

 

In cell A1, type 

 

This workbook was created by

 

.

 

3.

 

Widen column A to fit the contents.

 

4.

 

In B3, type 

 

This workbook was revised by

 

.

 

5.

 

Select cell C1 and choose Tools �

 

 Macro �

 

 Record New Macro.

The dialog box that appears lets you name the macro, assign a keyboard shortcut if you 
want one, and give the macro a description that clarifies what it does. Follow my instruc-
tions so that your dialog box looks something like this:
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As you saw in this exercise, when you ran the macro everything was done relative to the 
location you were in when you ran it. Excel even adjusted the width of the column you were in, 
even though that was 

 

not

 

 the column you were in when you recorded that step. In Exercise 11.2, 
we’ll try an absolute macro, with a few more steps.

 

6.

 

Enter 

 

Signature

 

 as the macro name.

 

7.

 

Click in the Shortcut Key box; hold down your Shift key and type 

 

S

 

.

Note that the Ctrl key is already shown because all shortcut combinations entered here 
will automatically include the Ctrl key; you don’t have to hold that key down when enter-
ing a shortcut combination. We are including the Shift key because we don’t want to 
override an existing keyboard shortcut (Ctrl+S is Excel’s shortcut to save a file.)

 

8.

 

Be sure the Store Macro In dropdown box is set to This Workbook. Then type 

 

This macro 

adds my name and the current date.

 

 in the Description box. If you want, you can leave 
the default information specifying who recorded the macro and when. Click OK.

 

9.

 

The macro recording toolbar appears. (If it does not appear, go to the View menu and 
click on Stop Recording in the list of toolbars.) Be sure the Relative Reference button is 
selected. If it’s not, click on it. Then type your full name in C1 or whatever cell was active 
when you started the recorder. (In my case, I typed 

 

Linda F. Johnson

 

.)

It’s important that you do not select a different cell before you type your name, or that cell 
selection will become a part of the macro. If you do this by accident, stop the recorder by 
clicking the Stop Recording button; choose Tools �

 

 Macro �

 

 Macros; select the Signature 
macro; click the Delete button; then click Yes to confirm. Then repeat steps 5 through 9 
to create the macro again.

 

10.

 

Press the Tab key to move to the cell to the right and type 

 

=today()

 

. Press Enter.

 

11.

 

Double-click the right edge of the column header between C and D to adjust column C to 
fit your name.

 

12.

 

Click the Stop Recording button. (Be sure to click the Stop Recording button and not 
the X!)

 

13.

 

Select cells C1 and D1 and choose Edit �

 

 Clear �

 

 All.

 

14.

 

Select cell A2 and press Ctrl+Shift+S. The macro runs and adds your name to A2 and 
today’s date to B2, then moves you down one row.

 

15.

 

Select cell B4 and press Ctrl+Shift+S. The macro runs, adds your name to B4, puts the 
current date in C4, drops you to the next row, and adjusts column B to fit your name.

 

16.

 

Use the Save As dialog box to create a new folder named 

 

Chapter Eleven

 

 and save this 
file in that folder, naming it 

 

Exercise 11-1.xls

 

. Close the file.

 

E X E R C I S E  1 1 . 1

 

( c o n t i n u e d )
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Recording and Running an Absolute Macro

 

1.

 

Open Exercise 11-2.xls. Make sure cell A1 is selected, then choose Tools �

 

 Macro �

 

 
Record New Macro.

 

2.

 

Name the macro 

 

information

 

; assign it a shortcut of Ctrl+Shift+I; make sure the macro is 
being stored in This Workbook; and type the description 

 

This adds my name, dept., and 

employee #

 

. Click OK.

 

3.

 

Make sure the Relative Reference button is not selected. If it is, click it to deselect it.

 

4.

 

Select cell B1 and type your full name. Press Enter.

 

5.

 

In B2, type 

 

Marketing

 

 and press Enter, and in B3 type 

 

16B

 

. Press Enter.

 

6.

 

Select the range A1:A3 and click the Bold button on your Formatting toolbar. Then, with 
the range still selected, use the Font Color dropdown list to make it dark blue. Double-
click the right edge of the column A header to adjust it to fit the contents.

 

7.

 

Group the three sheets by selecting the Information sheet tab, then holding down your 
Shift key and clicking the Personal Copy tab.

 

8.

 

Select A1:B3 on the Information sheet and choose Edit � Fill � Across Worksheets. Move 
to the Office Copy sheet and double-click the column A header to adjust the width of col-
umn A. Since the sheets are still grouped, this will adjust the column width on the Per-
sonal Copy sheet also.

9. Right-click on any tab and choose Ungroup Sheets.

10. Select cell A1 on the Information sheet and click the Stop Recording button.

11. Select the range A1:A3 on the Information sheet and choose Edit � Clear � Formats (but 
leave the text there).

12. Select B1:B3 and choose Edit � Clear � All. Go to the two other sheets and clear all on 
the ranges A1:B3. At this point, the only text you should have is on the first sheet and 
there should be no formatting at all in any cells.

13. Save the workbook and name it Exercise 11-2A.xls.

14. Move to the Information sheet and select cell D10. Press Ctrl+Shift+I. The macro runs and 
inserts the name, department, and employee number in B1:B3 in the first sheet, then 
adds the formatting and copies the range A1:B3 onto the second and third sheets, and 
finally moves you to A1 on the first sheet.

15. Close the workbook but do not save changes. Open the workbook (Exercise 11-2A.xls) 
again. Since you saved it in step 13, it still includes your macro but none of the information 
added by the macro. Click the Enable Macros button when prompted.
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The best way to understand the whole absolute/relative thing is to just keep making test 
macros and seeing the different behaviors you get when you make different choices. Just make 
sure you always store the test macros in This Workbook and not your Personal Macro Work-
book. Then, when you have finished playing with them, simply choose Tools � Macro � Mac-
ros and select them in the list, one at a time, and click the Delete button to remove them.

Now let’s take a crack at some VBA and edit a macro.

Editing Macros

If you create a very simple macro with two or three steps, then want to change one of the steps, 
probably the easiest and fastest way to do that is to delete the macro and then just record a new 
one. However, when you have spent hours creating some detailed macro that includes many 
steps and now all you want to do is change the font color in one step, it’s a lot easier to edit 
the existing macro than it is to start all over again.

Though VBA programming is beyond the scope of this book, most people try-
ing to learn VBA find that the easiest way to do it is to record macros using the 
macro recorder and then study the VBA code generated by the recorder. So, 
I will give you all the information you need to get comfortable with moving 
around in the Visual Basic Editor.

To edit macros, you must use the Visual Basic Editor (VBE). Don’t let this scare you, though, 
because I’m right here with you, holding your hand. And, the macros in these exercises are very 
benign, so even if you really mess them up, you won’t do any permanent damage to anything.

You can access the VBE in three ways:
� Choose Tools � Macro � Visual Basic Editor.
� Press Alt+F11 on your keyboard.
� Choose Tools � Macro � Macros, select the macro in the list, and click the Edit button.

16. On the Information sheet, select the range A1:A3 and choose Edit � Clear � All to remove 
everything from those cells.

17. Select cell C5 on the Information sheet and press Ctrl+Shift+I. Note that only your name, 
department, and employee number were filled in because the labels in column A are not 
part of the macro (because they were there before you started recording).

18. However, move to cell A1 on the Personal Copy sheet and type aaa and you’ll see that 
Excel formats that entry in blue and bold. This is because the formatting of those cells 
was done after the recorder was started and is therefore part of the macro.

19. Press Enter or Esc to get out of Enter mode. Close the file but do not save it.

E X E R C I S E  1 1 . 2 ( c o n t i n u e d )
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The first two ways do exactly the same thing. The third option is preferable to most begin-
ner VBA coders because it takes you directly into the VBA module for a specific macro; that 
way, you don’t have to wander around in there looking for your macro if you have more than 
one in the workbook.

Open the file welcome.xls (click Enable Macros when prompted) and let’s take a look at 
this code stuff.

Remember, the macro in this workbook (Welcome) is an absolute macro that inserts and 
formats some text. Choose Tools � Macro � Macros and select the Welcome macro in the list; 
then click the Edit button. A window like the one in Figure 11.2 appears. The title bar tells you 
that you are in Microsoft Visual Basic. The Projects pane in the top-left corner lists all of the 
projects in this workbook; projects include sheets and modules (and possibly other elements 
that are beyond the scope of this book). The lower-left pane shows the properties of whatever 
is selected in the Projects pane. Because a module is selected in the Projects pane at this time, 
the Properties pane is empty; the content of a module is, instead, displayed in the large Content 
pane to the right.

F I G U R E 1 1 . 2 The Visual Basic Editor

Module Name Dropdown List

Properties Pane

Projects Pane

Module Content Pane
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Click on the Sheet1 project in the Projects pane to select it and note its properties in the 
Properties pane. Double-click the Sheet1 project in the Projects pane; the Content pane is now 
empty. This is because there is no code in the actual sheet project; in this case, the code is 
strictly inside the module. Double-click Module1 in the Projects pane to display the code again 
in the Content pane.

Now, let’s take a closer look at this code:
� The lines beginning with an apostrophe (') are comments. They will show in green in the 

VBE to let you know that they are not actual steps taken in the macro but simply infor-
mation about the macro. Comments include the shortcut key, the description, and any 
other notes or instructions you want to add for coders to see. The comments shown in this 
macro represent what I typed in the Record Macro dialog box when I recorded this macro.

� The first line says ActiveCell.FormulaR1C1 = "Welcome to the world of macros!". 
This tells Excel to add the text in quotes to whatever cell is active. R1C1 (short for 
Row1Column1) is the style used to refer to relative references, as opposed to absolute ref-
erences. Because no cell was selected before typing this text after the recorder started, the 
text will be typed in whatever cell is active.

� Below that are the font characteristics of the active cell: Arial, bold, and 14 pt. size. Fur-
ther down it shows a color index of 3, which represents red.

� Notice the line near the end that says Range("A2").Select. This is the absolute refer-
ence to cell A2. This tells Excel to always select A2 at this point.

Let’s use Exercise 11.3 to make a few simple changes to this macro, using the VBE.

E X E R C I S E  1 1 . 3  

Making Changes to a Macro using VBA Code

If you don’t already have welcome.xls open, open it now.

1. Click after the green apostrophe in the line above the line showing the keyboard shortcut. 
Press your spacebar one time to insert a space and type Macro edited by <your name> 
to change the font color (obviously replacing <your name> with your actual name).

2. Click into the keyboard shortcut line, and the text you typed above it should turn green. 
This lets you know that Excel recognizes it as a comment. If it did not turn green, check 
to be sure you didn’t remove the apostrophe.

3. Find the line that says .ColorIndex = 3 and change the 3 to 5. (5 is the index number that 
represents blue. Feel free to try other numbers to see what color you get. For example, 
4 is green and 2 is white.)

4. In the VBE, choose File � Close And Return To Microsoft Excel.

5. Back inside the workbook, press Ctrl+Shift+Y. Excel inserts the text in blue (or whatever 
color you chose).

4002book.fm  Page 381  Friday, March 24, 2006  11:36 PM



382 Chapter 11 � Working with Macros

Hey! You just did some VBA coding! And it wasn’t so hard, was it? I promise you that this 
is how most VBA programmers got started. In most cases, a knowledge of VBA is not man-
datory to create macros because the recorder does it all for you in a WYSIWYG (what you see 
is what you get) fashion. But, when you want to edit the macros, you will end up in the VBE, 
so it’s important to feel somewhat comfortable in there. Let’s move on to see another handy 
use for the VBE.

Copying Macros

Another time when you need to be familiar with VBE is when someone offers to share one of 
their macros with you. Sometimes people will send you a macro in a workbook and tell you 
that you may copy it and add it to your own workbook. And, in other cases, they don’t send 
you a workbook but instead just send you the VBA code. In either case, all you have to do is 
copy the code and paste it into a new module in your workbook. Let’s try that in Exercise 11.4.

6. Choose Tools � Macro � Macros. Select the Welcome macro in the list and click the 
Options button.

7. In the keyboard shortcut, change the Y to an X. Click OK; then click Cancel to close the 
Macros window.

8. Select a blank cell in the workbook and press Ctrl+Shift+Y. Nothing happens. Press 
Ctrl+Shift+X and the macro runs.

9. Return to the Macro box and click the Edit button. The comment still shows the shortcut 
as a Y. This is simply a comment and must be edited manually if you want it changed.

10. Go to the VBE File menu and return to Excel. Close the workbook and do not save the 
changes.

E X E R C I S E  1 1 . 4  

Using the VBE to Copy Macros

1. Open welcome.xls.

2. Press Alt+F11 to open the VBE.

3. In the Projects pane on the upper left, click the plus sign (+) beside Modules, then double-
click Module1 to display the code in the Content pane.

4. Choose Edit � Select All (or press Ctrl+A). This highlights all of the code in the module.

5. Copy the code (by either using the Edit menu or pressing Ctrl+C).

E X E R C I S E  1 1 . 3 ( c o n t i n u e d )
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6. Close the VBE and close welcome.xls.

7. Open Exercise 11-2A.xls. Press Alt+F11.

8. This is the file you saved in Exercise 2 and it includes one module. Click on the Modules 
folder in the Projects pane to select it. (Do not double-click it.)

9. Choose Insert � Module. You now have two modules.

10. Double-click Module1, and you’ll see this is the information macro you recorded in 
Exercise 11.2.

11. Double-click Module2,and you’ll see this is the empty module you just inserted. Right-
click in the empty Content pane and select Paste. Now this module includes the code to 
run the Welcome macro.

12. In My Computer, find the file macro.txt that you extracted from the zipped file for this 
chapter. Double-click it to open it in your default text editor (such as Notepad.) As you can 
see, this is VBA code that runs a macro. Select all of the text and copy it.

13. Return to the VBE by clicking it on your Windows Taskbar. Repeat steps 8 and 9 to insert 
a third module. Paste the copied code inside Module3.

14. Choose File � Close And Return To Microsoft Excel.

15. Choose Tools � Macro � Macros.

16. Select the addition macro and click the Options button. Assign the shortcut Ctrl+Shift+S. 
Click OK.

17. Select the Welcome macro and click the Options button. Assign the shortcut Ctrl+Shift+Y. 
Click OK.

18. Click the Cancel button to close the Macros box.

19. Use Save As to save the file and name it Exercise 11-4.xls.

20. Select cell C5 on the Information sheet and press Ctrl+Shift+Y. The Welcome macro runs 
and inserts the welcome message.

21. Press Ctrl+Shift+I (it doesn’t matter what cell is selected), and the information macro runs 
and fills in the information on all three sheets.

22. On the Office Copy sheet, type any five numbers in cells D1:D5, then select cell D6 and 
press Ctrl+Shift+S. The macro runs and totals the five numbers.

23. Close the file, but don’t save it. (You should have saved it in step 19 after the macros were 
set up but before they were run.)

E X E R C I S E  1 1 . 4 ( c o n t i n u e d )
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Well, I think you’ve created and edited enough macros to get the general idea. I recommend 
you try some more and make them do different types of things. If you mess one up really badly 
and you get a runtime error when you try to run it, just go into your Macro dialog box and 
delete it, or, be really brave and try editing it in the VBE to see if you can fix it there. Once you 
are comfortable with this process, move on to the next section, where I will show you how to 
add command buttons so that the macros in a workbook can be run by clicking instead of 
using shortcut keys.

Using a Macro to Control How a Workbook Opens

In most cases, recording a macro can give you what you want—but not always when you 
want it. Using the macro recorder only allows you to set up the macro to work when the key-
board shortcut is pressed or a button is clicked.

Though I use the recorder to create most of my macros, on occasion I want a macro that runs 
as soon as I open the workbook, without me clicking or typing anything.

A client once asked me to create a table of contents for his workbook and then set it up so that 
whenever he opened his workbook, the table of contents would be the active sheet. Well, the 
table of contents was easy to make, using links, but controlling which sheet was active when 
the workbook opened was a bit trickier.

As you have probably noticed, when you save a workbook, Excel maintains which worksheet 
and cell has focus on at the time so that the next time you open the file you’re returned to the 
same place. For the life of me, I couldn’t get the recorder to do this for me, so I had to use some 
VBA. The solution turned out to be quite simple—not to mention my first real success with VBA.

The VBA code that tells Excel to select a certain sheet is one simple line:

Worksheets("Sheet1").Select

Obviously, Sheet1 represents the sheet you want active when the workbook is opened.

All I had to do was go into the VBE in my client’s workbook and, in the Projects pane, double-
click on This Workbook. In the Content pane I set the Object dropdown on the left to Workbook 
and the Procedure dropdown on the right to Open. Then I just typed the previous code line 
into the Content pane where my insertion point was flashing.

I saved the file, then clicked onto a different sheet, then saved the file again and closed it. 
When I reopened it, I was happy to see that it opened with the table of contents sheet active.

If you want to try this, extract the file VBA_Sample_to_open.xls from the zipped file for this 
chapter. No matter which sheet is active when you save and close this workbook, when you 
reopen it you will always be on the March Sales sheet. Take a peek in the VBE and you’ll see why.
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Assigning Macros to Command Buttons

When you want to make a clickable button that launches a macro in a particular workbook, 
you use a command button. Though you can also assign a macro to a toolbar button or menu 
command, you wouldn’t do this if you only wanted the macro to run inside one particular 
workbook. Adding toolbar buttons and menu commands is a global process, meaning it is an 
addition to your Excel interface and not an addition to a workbook. So, if you assign a macro 
to a toolbar button and the macro is part of one particular workbook, that workbook will 
have to open in order for the macro to run. And, if you assign a macro to a toolbar button or 
menu command, that button or command will appear only on your computer and will not be 
available to anyone else opening the workbook.

Generally, you assign macros to toolbars or menus only when you want the macro available 
in all workbooks (which I’ll show you later). However, when you have a macro inside a par-
ticular workbook, creating a command button puts a button inside that workbook and not on 
your toolbar. This button is then available to anyone who opens this workbook on any com-
puter. You saw this in action when you clicked the Welcome button in welcome.xls.

Command buttons are available from the Forms toolbar, and when you add one to your 
worksheet, the Assign Macro dialog box (shown in Figure 11.3) pops up for you to easily 
choose the macro you want assigned to the button.

Now, let’s use Exercise 11.5 to give this a try.

E X E R C I S E  1 1 . 5  

Creating a Command Button and Assigning a Macro to It

1. Open Exercise 11-4.xls (either the one you saved in the previous exercise or the one in the 
zipped file for this chapter). This file includes three macros.

2. Make sure you are on the Information sheet. Then, choose View � Toolbars � Forms. The 
Forms toolbar appears.

3. Run your mouse over the buttons on the toolbar until you see the one whose tooltip 
reads Button; click it.

4. Release your mouse button and move your pointer to cell D5. You will see your mouse 
pointer is a crosshair. Click and drag to draw a box that covers cells D5:F7 and release 
your mouse button.

5. The Assign Macro dialog box appears (as shown in Figure 11.3). Select the information 
macro and click OK. Excel adds a button labeled Button 1 to the worksheet.

6. Move your mouse pointer over the button and note that it changes to an I-beam. Click and 
drag to select the text Button 1 and type Fill In Information. Highlight that text and use the 
buttons on the Formatting toolbar to make the font 14 pt., bold, Indigo.
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F I G U R E 1 1 . 3 Use this dialog box to assign a macro to a command button.

Feel free to try creating command buttons for the other two macros in Exercise 11-5.xls. 
Once you’ve done this once, it’s pretty easy to do again. Also, if you want to edit the button 
to change the font style or the text, you cannot click it to select it without running the macro. 
You have to right-click it instead to select it, and then you can edit the text the same way you 
did when you first created it.

It is possible to also assign macros to toolbar buttons and menu commands when the macro 
lives inside a specific workbook—but clicking the button or command will then open that 
workbook so the macro can run, which is not usually what you want. Most of the time, you 
want the button to function in any workbook without the original workbook opening. To 
achieve this effect, you need to store the macro(s) in your Personal Macro Workbook, which 
I’ll show you how to do in the next section.

Working with Macros in All Workbooks
Though there are some occasions when you want a particular macro for one particular work-
book, in many cases you will want the same macro available to you in all workbooks, new and 
old. When you set up a macro this way, Excel creates a Personal Macro Workbook (commonly 
referred to as your personal workbook) in Excel’s startup folder. I will teach you all about this 

7. Click outside the box to deselect it; then rest your pointer over the button. Note that your 
pointer changes to the hand you see when something can be clicked. Click the button and 
the information macro runs.

8. Close the Forms toolbar by clicking the X on the right end of its title bar. Save the file as 
Exercise 11-5.xls and close it.

E X E R C I S E  1 1 . 5 ( c o n t i n u e d )
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startup folder in Chapter 12, “Customizing Excel and Setting Defaults;” for now, just know 
that it exists. Excel sets up your personal workbook as a hidden workbook named personal.xls, 
and it is opened every time you open Excel.

Creating a Personal Macro Workbook to 

Store Global Macros

The easiest way to create your personal workbook is to record a macro and, in the Record 
Macro dialog box where you would normally choose to store the macro in This Workbook, 
you would instead choose to store it in personal.xls by selecting Personal Macro Workbook 
from the dropdown list. Once you’ve created your personal workbook, you can go into any 
individual workbook, open the VBE, and copy any modules from there into personal.xls to 
make those macros available in all workbooks. If you do this, make sure that you delete the 
macro from the individual workbook after you’ve copied the module into the personal work-
book, or the macro will try to run twice when you run it and probably lock up your computer, 
or even crash Excel.

Whenever you want to record new macros in your personal workbook, you simply record 
them in any workbook and choose to store them in your Personal Macro Workbook. Or, if 
you want to copy modules into your personal workbook, just open a blank workbook, choose 
Window � Unhide, and unhide personal.xls. Then press Alt+F11 and insert as many modules 
as you want.

As with anything else, the larger a file is, the slower it loads in your computer. 
So, remember the more modules you store in personal.xls, the slower Excel 
will open, because it will have to load this file every time it opens.

Use Exercise 11.6 to learn how to record a macro to add five sheets to the beginning of a 
workbook and store it in the Personal Macro Workbook. Don’t worry that you are adding this 
to Excel’s startup folder because I will include an exercise later in this section where we will 
delete it.

E X E R C I S E  1 1 . 6  

Recording and Running a Macro in Your Personal Macro Workbook

1. Open a new blank workbook.

2. Turn on the macro recorder. Name the macro AddSheets; give it a shortcut of Ctrl+Shift+Q; 
choose Personal Macro Workbook from the Store Macro In dropdown; and give it any 
description you like or none at all. Click OK.

Because this macro doesn’t select any cells, it doesn’t matter if it’s absolute or relative.

3. Choose Insert � Worksheet. Repeat this four more times.
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And that’s how easy it is to make a global macro that is available in new workbooks and 
all of your existing workbooks. Also, now you have a personal workbook and it’s set up to 
open every time you open Excel. Even if you delete the macro that’s in there, you will still have 
the personal workbook loaded and ready every time you start Excel. Of course, later in this 
chapter we will delete this macro and in Chapter 12 I’ll show you how to have full control over 
Excel’s startup; you can remove personal.xls at that time, if you want. But, if it’s empty, it 
won’t hurt anything to load with Excel.

Now, close Excel and you’ll see the message shown in Figure 11.4, asking if you want to 
save the personal workbook. Click Yes.

F I G U R E 1 1 . 4 When you’ve made changes to personal.xls, you are prompted to save it 
when you close Excel.

4. Stop the recorder.

5. Close the blank workbook. When Excel asks if you want to save it, click No.

6. Open Exercise 11-2.xls. Note the three existing worksheets.

7. Press Ctrl+Shift+Q, and Excel adds five worksheets to the beginning of the workbook.

8. Press Alt+F11 and you’ll see that the Projects pane shows both Exercise 11-2.xls and 
PERSONAL.XLS:

9. Close the VBE and, back in Excel, choose Window � Unhide. Select PERSONAL.XLS from 
the list and click OK.

10. Look at Excel’s title Bar and you’ll see that you are inside personal.xls. The Window menu 
lists both Exercise 11-2.xls and PERSONAL.XLS as being open. Click Hide.

11. Close Exercise 11-2.xls and click No when asked to save.

E X E R C I S E  1 1 . 6 ( c o n t i n u e d )
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You edit and copy macros in your personal workbook the same way you did in the previous 
section: using the VBE. The only thing you need to remember is that you must first access the 
Window menu and unhide personal.xls. When you want to delete macros from this workbook, 
you simply unhide it, choose Tools � Macro � Macros, select the macro in the list, click the Delete 
button, and click Yes to confirm. Then, always remember to hide it again when you are done.

Now, finally, it’s time to learn how to assign macros to toolbar buttons and menu commands.

Assigning Macros to Toolbars and Menus

Obviously, if you have a great memory and prefer using shortcut keys for launching your mac-
ros, this section won’t be that important to you. But for those of you who prefer clicking 
instead of typing, toolbar buttons and menu commands are more convenient.

As I said earlier, you can assign macros stored within a workbook to a toolbar button or 
menu command, but when you click them, the workbook storing the macro has to open before 
the macro can run. And, of course, if that workbook has been moved or renamed, Excel won’t 
be able to find it and it will not run. That’s what’s nice about personal.xls. It’s always open, 
so when you assign toolbar buttons or menu commands to any macro stored in your personal 
workbook, nothing has to load before the macro runs.

In Chapter 12, I will teach you all about customizing your toolbars and menus so they work 
best for you, so I won’t go into great detail about that here. All I want to show you now is how 
to link a button or command to a macro and then run that macro from any workbook using either 
the button or the command. Exercise 11.7 shows you the basic steps for doing this. Rest assured, 
in Chapter 12 I’ll show you how to customize the text and buttons to suit your personality.

E X E R C I S E  1 1 . 7  

Creating Macro Toolbar Buttons and Menu Commands

To do this exercise, you don’t need any workbook open because this is a global operation that 
will apply to the Excel interface itself. The only workbook this process needs is personal.xls, 
and that will open automatically when you open Excel. So, just launch Excel. However, if you 
did not complete the previous exercise and did not save personal.xls, you will have to finish 
that exercise before you can do this one.

1. Choose Tools � Customize.

2. When the Customize dialog box opens, select the Commands tab and scroll down to find 
Macros in the category list on the left. Click on Macros.

3. Note the two options in the Commands box on the right: one for a Custom Menu Item and 
one for a Custom Button.

4. Click the yellow smiley face Custom Button, hold your mouse button down, and drag it 
up and drop it on the menu bar just to the right of the word Help. You will see a little 
button and a plus sign attached to your mouse pointer. Don’t release your mouse button 
until you see the black vertical line to the right of the word Help.
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5. When you release your mouse button, you will see the smiley button with a black box 
around it like this:

The black box around the button means it is selected.

6. With the button selected, choose Assign Macro from the Modify Selection dropdown in 
the Customize dialog box.

7. Select PERSONAL.XLS! AddSheets from the list and click OK.

Adding a menu item is a tad trickier, so follow me closely.

8. Click on Custom Menu Item in the Commands list on the right side of the Customize dia-
log box. Drag it up and hover it over the word Tools on the menu bar until the Tools menu 
appears (again, you’ll see the button and plus sign attached to your mouse pointer). 
Don’t let go of your mouse button. Drag the mouse pointer straight down the Tools menu 
until you see a black line below the words Error Checking, as shown here:

E X E R C I S E  1 1 . 7 ( c o n t i n u e d )
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And there you go. You have completed the macros chapter! Oh, don’t forget to go to the 
Window menu and click Unhide to unhide your personal workbook. Then select Tools � 
Macro � Macros and delete the AddSheets macro if you don’t want it. Then hide the personal 
workbook again.

Also, if you accidentally removed the wrong button or menu item from your menu bar or 
Tools menu, don’t panic. Just read the next chapter and I’ll show you all the ways you can add, 
remove, and move buttons and commands all over the place, so you can easily get them back.

Summary
Macros in Excel save you much time and effort and automate repetitive processes. Whenever 
there’s a step-by-step procedure you find yourself doing repeatedly, you can create a macro 
that does it for you and store it either in a particular workbook or in your Personal Macro 
Workbook so that you can use it in all workbooks.

9. Release your mouse button and you’ll see the text Custom Menu Item with the black box 
around it. Right-click on the new text on the menu and choose Assign Macro from the 
shortcut menu.

10. Again, choose PERSONAL.XLS! AddSheets from the list and click OK.

11. Click the Close button to close the Customize dialog box.

12. The smiley button appears on the menu bar. Click the Tools menu and you’ll also see the 
new command Custom Menu Item.

13. Open Exercise 11-2.xls.

14. Click the smiley button and Excel adds five sheets to the beginning of the workbook.

15. Choose Tools � Custom Menu Item. Excel adds five more sheets.

16. Close Exercise 11-2.xls and do not save changes.

17. Right-click on any of your toolbars and choose Customize from the shortcut menu.

18. While the Customize box is open, click the smiley button on the menu bar and drag it 
straight downward, off the toolbar, and release your mouse button. The button disappears.

19. Click on the Tools menu and release your mouse button. Now click on Custom Menu Item 
in the Tools menu and drag it off the menu. It no longer appears on the menu.

20. Close the Customize box and close Excel.

E X E R C I S E  1 1 . 7 ( c o n t i n u e d )
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The easiest way to create macros is to record them using the macro recorder. Like any cam-
corder or tape recorder, it stores all that happened while it was recording, so you can play it 
back at any time by running the macro.

Two things determine where on the worksheet the macro will run: whether cells were 
selected before the recorder was started or after, and whether the recorder was set to record 
absolutely or relatively.

Once you have recorded a macro, you can edit it, if necessary, using the Visual Basic Editor. 
The VBE gives you access to the code behind the macro, and a lot of it is relatively obvious and 
can be changed without much knowledge of Visual Basic for Applications. Stuff like font 
names and font sizes are easy to identify in the code and can be manually changed. It’s also 
pretty easy to find a cell reference in the code and adjust that as well.

If you store the macro in the active workbook, it will be available only from within that 
workbook. Whenever that workbook is open, you can run the macro by pressing the keyboard 
shortcut you assigned to it or by clicking a command button you created.

However, if you store the macro in the Personal Macro Workbook, you can run that macro 
from within any workbook. You can also add a macro button to a toolbar or a macro com-
mand to a menu so that you can run the macro with a single click. You can also use a keyboard 
shortcut to run the macro.

Exam Essentials
Understand the difference between absolute and relative macros. Understand when each 
type should be used and how to use the Relative Reference button on the macro recording 
toolbar to choose the type you want.

Be able to record various types of macros. Familiarize yourself with the various things mac-
ros can do. Know how to record macros to add text, change cell properties, add formulas, 
copy worksheets, and similar tasks.

Know your way around the Visual Basic Editor. Be sure you can make simple changes to 
comments in the code, as well as obvious changes to the code itself.

Know how to set up macros to run in various ways. Know how to assign the macros to 
keyboard shortcuts, command buttons, toolbar buttons, and menu commands.

Understand how to delete macros and change their options. Remember that both the Delete 
button and the Options button (which allows you to change the description and the shortcut 
key) are located in the Macros dialog box. Know how to get there.
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Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. Extract the file MOS Scenarios Ch11.xls from the zipped file for this chapter and 
open it before you do these exercises.

If you did not do Scenario 29, use MOS Scenario 29 Completed.xls to do Scenario 30.

 

MOS Scenario 29: Create a Macro Assigned to a Button

Record a macro that adds your name to cell A3; your employee number, which is EZ1210, to 
cell B3; and the current date to cell D2. Name the macro Info, assign it a shortcut key of your 
choice, store it in this workbook, and give it an appropriate description. Create a button below 
the data on this sheet that runs the macro. Label the button Enter Employee Info and format 
it in 14 pt., Red, Times New Roman font. Clear the information entered on the sheet while 
recording the macro, and then run the macro by using the button.

 

MOS Scenario 30: Edit a Macro Comment, Change a Shortcut, and 
Delete a Macro

Using the macro you created in the previous scenario, edit the macro to add a comment that 
says This macro copyrighted by the Memo Co., Inc. Change the shortcut key to Ctrl+Shift+F. 
Clear the data entered when you ran the macro using the button. Run the macro using the 
new shortcut key. Delete the macro.
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MOS OBJECTIVES COVERED 
IN THIS CHAPTER:

�

 

Customize toolbars and menus

�

 

Modify Excel default settings
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Now that you have learned how to do just about everything in 
Excel and understand all of its features, it’s time to show you 
how to tweak the program to make it all your own.

In the first part of this chapter, I will take up where I left off in Chapter 11, “Working 
with Macros,” and show you how to totally revamp your toolbars and menus beyond your 
default settings. Not only can you add new toolbars, toolbar buttons, and menu com-
mands, but you can also remove existing ones, rearrange the ones you have, change the 
images used for the buttons, edit the text labels associated with the buttons, and more. 
When you finish this chapter, there won’t be much you can’t do with your toolbars 
and menus.

But the toolbar and menu defaults are not the only features you can control. Most of the 
settings that you can adjust are included in Excel’s Options dialog box. Here, you can manip-
ulate and control features that regulate how Excel looks and behaves. I will walk you through 
every tab in that dialog box so you understand all the settings.

Once you have everything set up the way you like it, I will then show you how to use tem-
plates you design to change both your default workbook and default worksheet. For example, 
if you want your company logo automatically included in the header in every new worksheet 
you create, this is doable. Or, if you prefer a different row height, page margins, or page ori-
entation as your default, you can set that up as well. You accomplish these things by creating 
a template and then assigning that template as the default for all new workbooks and/or any 
new sheets you add to existing workbooks.

I purposely saved this information until the end of the book because it makes more 
sense to tweak Excel after you understand what everything does. Adjusting default set-
tings for features you don’t completely understand could cause problems, but once you 
have a good grasp of what a feature does, it’s time for you to control how the feature 
works.

To complete the exercises in this chapter, you will need to download the file exl2003ch12.zip 
from this book’s website and extract the files into a temporary folder before you begin. 
However, because of the nature of this chapter, most of what you do cannot be shared 
via a file, so this chapter is light on exercises and heavy on discussion, and therefore the 
zipped file isn’t very big (but the chapter provides lots of graphics so you can see what I’m 
seeing).

 

4002book.fm  Page 396  Friday, March 24, 2006  11:36 PM



 

Customizing Toolbars and Menus

 

397

 

Customizing Toolbars and Menus

 

Excel’s 

 

default settings

 

 and look are based on what Microsoft feels most people want. The 
toolbars include buttons for what Microsoft believes you will use most often; the default font 
is the one Microsoft thinks most people prefer. Even what happens when you press the Enter 
key is controlled by Microsoft’s choice for the default behavior of the program.

However, Microsoft isn’t really all that controlling. They have provided ways for you to 
change almost all of the default settings and behaviors so that Excel looks and acts the way you 
prefer. Though there are some settings that are critical for the program to function properly 
and therefore cannot be adjusted, you may be surprised to find out how much you can change.

When I first started writing this book, I decided I had to reset Excel back to its original look 
so my installation of Excel would appear and behave like the default installation. Yes, I did 
have to turn off a few add-ins, reset my default fonts and colors, and other stuff like that; but, 
hands down, the biggest adjustments I had to make were to my toolbars and menus because 
I had totally changed their look to suit my needs. Consequently, I found that using Excel while I 
wrote this book was more challenging since I had to go digging to find stuff that was much 
more obvious with my custom toolbar and menu settings.

 

Help! I’ve Lost My Print Button!

 

When I worked on a help desk, a “lost” toolbar or command was one of the most common 
complaints. A similar problem occurred when users installed software that added a button to 
their toolbar every time they opened Word or Excel; they now had gazillions of these buttons 
and their toolbar was taking up half their screen!

Many of the callers had tried uninstalling Excel and then reinstalling it to try to fix the problem 
but were unsuccessful. A lot of these calls came from IT people in major companies, who 
were really embarrassed when I told them how easy the fix was.

When you are missing a button or command, or have an extra button or command, uninstall-
ing the program will not correct this. The settings that control your buttons and commands 
are in your Windows Registry, and these settings are not removed and replaced when you 
uninstall and reinstall Excel. So you may wind up with a new installation of Excel, but you still 
have the same Registry settings and, therefore, the same buttons and commands. To com-
pletely clean up the Windows Registry, you would have to format your hard drive and reinstall 
Windows itself. Sometimes, the System Restore command in Windows XP will fix some Reg-
istry issues, but you would have to know exactly when the problem occurred in order to be 
able to restore to the correct data. However, that is way beyond ridiculous if all you want to 
do is get your Print button back on a toolbar in Excel. (But, believe it or not, I’ve heard IT people 
tell users that they will have to reinstall Windows to fix the toolbars.)
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All changes to toolbars and menus are done via the Customize dialog box. While this box 
is open, all buttons and commands are in edit mode and will not function when clicked. So, 
to be able to change the text in a command or the image on a button, you must have the Cus-
tomize dialog box open. Once you close the Customize dialog box, the commands and buttons 
become clickable again and function as intended.

You can access the Customize dialog box in a few different ways:
�

 

Choose Tools �

 

 Customize.
�

 

Choose View �

 

 Toolbars�

 

 Customize.
�

 

Right-click on any toolbar and choose Customize from the shortcut menu.
�

 

Press Alt+T+C.

No matter which method you choose, you will end up in the dialog box shown in Figure 12.1 
and that’s where you can perform all of the actions discussed in this section. When the Cus-
tomize dialog box opens, the tab selected will be the one you last used when opening this dia-
log box.

You can use the Options tab in the Customize dialog box to set toolbar and menu default 
behaviors. The Commands tab lets you add new buttons or commands to existing toolbars 
and menus (as you did in Chapter 11). And, you can also create new toolbars and menus them-
selves. You add new toolbars using the Toolbars tab and new menus via the Commands tab. 
Once you’ve added buttons and commands, you can use the Commands tab to change their 
look and behaviors (as we did in Chapter 11 when we assigned a macro to a button and a 
menu command). You can even change the look of Excel’s existing buttons if you want.

In the very first chapter of this book, I had you open the Customize box and change the set-
tings on the Options tab so that all of your buttons and menu items would appear onscreen. 
But, in case you didn’t do that, let’s revisit that tab first.

 

Setting Toolbar and Menu Options

 

The Options tab, shown in Figure 12.1, shows the two checkboxes at the top, Show Standard 
And Formatting Toolbars On Two Rows and Always Show Full Menus, as selected. This is 
what I told you to do in Chapter 1, “Navigating in Excel and Understanding the Interface.”

The newer versions of Excel have the added feature of displaying only the buttons and com-
mands that you have recently used. If you want to see the rest of the buttons on any toolbar, 
you must click the Options dropdown button at the right end of the toolbar. If you want to 

 

So, I would tell the caller to open Excel and choose Tools �

 

 Customize; then locate the 
Print button and drag it from the Customize box onto their Standard toolbar. Or, if they had 
unwanted buttons on a toolbar, I would tell them to hold down their Alt key and drag the but-
tons off.

Non-IT types would squeal with joy: “It worked! It worked!” However, the IT people who 
called me after they had uninstalled and reinstalled 12 times were not so enthusiastic, and 
usually embarrassed, but, nonetheless, educated and able to impress their buddies.
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see the rest of the commands, you must click the chevron button that appears at the end of the 
menu (or wait patiently until the menu eventually expands on its own, if you have that choice 
selected on the Options tab). Both of these buttons are shown in Figure 12.2.

 

F I G U R E 1 2 . 1

 

The Options tab in the Customize dialog box

 

F I G U R E 1 2 . 2

 

Buttons you click to see hidden buttons or commands

Chevron to ExpandEnd-of-Toolbar Options Dropdown
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I prefer to see my full menus and toolbars, so I keep both of these boxes selected. And, when 
I teach Excel, I always have my students check these boxes to avoid constantly hearing them 
say, “But that’s not in my menu.” You can now decide which you prefer and adjust the check-
marks accordingly.

Below these two checkboxes you’ll see the Reset Menu And Toolbar Usage Data button. 
This button label is somewhat misleading, I think. If you think clicking this button will restore 
all your defaults and remove custom buttons or commands you have added, you are mistaken. 
All it does is clear Excel’s memory of any commands or buttons you have used recently. 
Clicking this button only affects which buttons and commands are hidden on the menus and 
toolbars. It does not reset your toolbars and menus back to the defaults. Therefore, it is use-
ful only when you have the two checkboxes above it deselected, so obviously I don’t use this 
button at all.

Below this, in the Other section, you’ll see four options:
�

 

Large Icons makes your toolbars huge and is handy if you are visually impaired, but it 
takes up a lot of your screen real estate, so you may find it a bit of overkill. You’d prob-
ably have better results using your Windows Control Panel to tweak your display settings 
to give you more of what you want.

�

 

List Font Names In Their Font is a feature I can’t live without. I have so many different 
fonts in my computer that I can never remember what they look like. I hate programs that 
generically list all the fonts in the font dropdown box, because I have to keep trying dif-
ferent fonts, by trial and error, to finally find the one I want. So, I always keep this option 
selected (and I’m thankful to Microsoft for giving us this feature).

�

 

Show ScreenTips On Toolbars is another one I had you select in Chapter 1, and I 
always keep it checked. Sometimes a button just isn’t that obvious and it’s nice to get 
a hint.

�

 

Menu Animations is a dropdown box that gives you the choice of Random, Unfold, Slide, 
and Fade. You can try them all and see how it affects the way your menus are presented 
when you click them. The (System Default) choice will use the global menu animations 
you specified in your Windows settings, and this is what I select here in Excel. 

 

Menu ani-
mations

 

 are one of the things that use those precious system resources in your computer. 
If I’m playing a game on my computer or working in a 3D graphics program, I’m probably 
willing to use stuff that requires a lot of resources because that is necessary to get the full 
effects in those programs. But to waste system resources so my Excel menus can “unfold” 
isn’t something I’m willing to do. However, the choice is yours.

I recommend you select and deselect various options on this tab, then click the Close button 
to see how they affect your Excel interface. When you close Excel and open it again, Excel will 
remember these settings because they have now overwritten the defaults. It might be best to 
change only one at a time, and then see how that affects Excel; this way, if you don’t like the 
effect, you can change it back because you will remember what it was you changed in the first 
place.

When you are done experimenting with the Options tab, let’s move on to the Toolbars tab.
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Creating New Toolbars and Adding Buttons

 

Before I get into showing you how to customize new buttons and commands, I want to show 
you how to add new toolbars. Though you can add new buttons to existing toolbars (as we 
did in Chapter 11), for upcoming exercises I think it’s best that you make a new toolbar and 
add your customized buttons to that; then it will be easier to clean up after we are done because 
you will only have to delete one toolbar instead of many buttons on your regular toolbars.

In my experience, the Standard and Formatting toolbars contain several buttons that I 
rarely use. There are also other commands that I use pretty often that are not on the default 
toolbars. So, I have my own “Linda” toolbar, and I don’t even display the Standard and For-
matting toolbars at all, which is why it was fairly easy for me to clean up Excel before writing 
this book. I just turned off the Linda toolbar and turned the other two back on. All of this is 
easily done through the Toolbars tab in the Customize dialog box (see Figure 12.3).

 

F I G U R E 1 2 . 3

 

The Toolbars tab in the Customize dialog box

 

This tab lets you turn toolbars on and off, add new toolbars, reset toolbars back to defaults, 
and attach toolbars. Attaching toolbars allows you to attach a toolbar to a template so that 
toolbar can be shared with others or added to another computer of your own.

Let’s use Exercise 12.1 to explore the Toolbars tab.

 

E X E R C I S E  1 2 . 1  

 

Adding, Attaching, and Removing Toolbars

 

1.

 

Open a new blank document, then open the Customize dialog box and click the Toolbars tab.

 

2.

 

The list displays all available toolbars. The ones with checkmarks are the ones that Excel 
will display on the screen every time you open the program. Click the New button.
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3.

 

Name the toolbar 

 

MyToolbar

 

 and click OK. Excel adds your new toolbar to the end of the 
list and a new small, empty toolbar appears on your screen.

 

4.

 

Make sure MyToolbar has a checkmark beside it in the list, then move to the Commands 
tab in the Customize dialog box.

 

5.

 

In the Categories list on the left, be sure File is selected. Then click the Open command 
in the list on the right and drag that onto your new MyToolbar.

 

6.

 

Repeat step 5, and drag the Save command onto your MyToolbar.

Your new toolbar looks like this:

 

7.

 

Click the Close button in the Customize dialog box.

 

8.

 

Drag MyToolbar up and dock it somewhere at the top of your screen. In my case, it fits 
nicely on the right end of my Formatting toolbar.

If you forgot how to relocate toolbars on your screen, reference Chapter 1.

 

9.

 

Close Excel and reopen it. Excel now displays the toolbar by default.

 

10.

 

Return to the Customize dialog box and click the Toolbars tab. Click the Attach button.

 

11.

 

This dialog box opens, showing any custom toolbars you may have. Select MyToolbar in 
the list and click the Copy button to move it to the list on the right. Click OK.

 

12.

 

Click the Save button and save this workbook as a template. Name it 

 

Toolbars.xlt

 

 and 
make sure it is saved in your Templates folder.

If you aren’t sure how to save templates, refer to Chapter 9, “Advanced Template Design 
and Workbook Security.”

 

E X E R C I S E  1 2 . 1

 

( c o n t i n u e d )
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As you can see, loading a toolbar from any template or workbook will make that toolbar 
available in all templates and workbooks. So, you don’t have to keep turning it on every time 
you open a different workbook in Excel. Attaching a custom toolbar to a template is useful 
only when you want to share a toolbar with others, or copy a toolbar from one installation of 
Excel to another. Think of the template as a vehicle to move the toolbar from one computer 
to another. I have a toolbar template where I attach all of my custom toolbars, and I save a 
copy of this template in my Windows backup folder. If I ever have to reinstall Excel, I can 
quickly get all of my toolbars back if I just load the template one time. Simply opening or load-
ing the template will add all of my custom toolbars back into Excel. You can use the Toolbars 
template you created in the previous exercise for this same purpose, or you can delete that tem-
plate now (using the instructions in Chapter 9) if you don’t want it. Just be sure MyToolbar 
appears in your blank workbook before you delete the template, because you will need that 
for the next discussion and exercise.

 

13.

 

Close the template and click File �

 

 New to open a new blank workbook. You’ll see the 
MyToolbar toolbar.

 

14.

 

Go back to the Customize box. Click the Toolbars tab. Select MyToolbar from the list and 
click the Delete button.

 

15.

 

Close the Customize box and close Excel.

 

16.

 

Open Excel and you’ll see that MyToolbar is not displayed.

 

17.

 

Go to File �

 

 New. Choose On My Computer in the Templates section of the task pane, 
then choose the Toolbars.xlt template in the General window of the Templates dialog 
box. Click OK.

 

18.

 

The template displays MyToolbar. Close Excel.

 

19.

 

Open Excel again and note that the toolbar has been added again to your blank work-
book. Go to the Customize box and remove the checkmark from MyToolbar in the list.

 

20.

 

Close the Customize box. The toolbar no longer displays. Close Excel.

 

21.

 

Reopen Excel. Still no MyToolbar showing. Use File �

 

 New to load Toolbars.xlt. No 
MyToolbar there either.

 

22.

 

Return to the Customize box and click the box beside MyToolbar to reselect it. Close the 
Customize box and the toolbar is back onscreen. It will remain there whenever you open 
any workbook or template.

 

23.

 

Close Excel.

 

E X E R C I S E  1 2 . 1

 

( c o n t i n u e d )
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The only button we didn’t cover in the previous exercise is the Reset button. You can try 
this one on your own if you want. Use the Commands tab to drag any button onto your For-
matting toolbar. Then, move to the Toolbars tab, select Formatting in the list, and click the 
Reset button. A message will appear asking if you are sure you want to reset the Formatting 
toolbar. Click OK. The button you added to the Formatting toolbar should be gone and the 
toolbar reverts to the way it looked when you first installed Excel.

Now, let’s move on to the fun stuff and see how we can customize buttons and commands 
on the toolbars and in the menus.

 

Editing Toolbar Buttons and Menu Items

 

Once you’ve added a new toolbar button, you can do all kinds of customizations: change the 
button image, edit the button image, change the text, change the display, and so forth. You can 
also add new items to your menus and customize them, and even create new menus. You can 
do all this by using the Commands tab in the Customize dialog box (see Figure 12.4).

 

F I G U R E 1 2 . 4

 

The Commands tab in the Customize dialog box

 

The Commands tab also lets you add any of Excel’s preexisting buttons and commands to 
your toolbars and menus. So, for example, if you insert a lot of pictures directly from your 
scanner or digital camera and would like a toolbar button for that, you can simply select the 
Insert menu from the Categories list, scroll through the Commands list to find From Scanner 
Or Camera, and drag that button to your Formatting or Drawing toolbar, or even put it on 
your own personal toolbar.

You can also remove buttons from your toolbars if they are ones you rarely use. Or, if you 
never use a command at all, you can completely remove it from your menus. This is not dan-
gerous to do, now that you know how to add them back if you decide you want them again. 
When you remove a button or command, it is still always available to you in the Customize 
box, so you can easily put it back.
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To remove a button from a toolbar, you don’t even have to have the Customize dialog box 
open. You can just hold down your Alt key while you drag the button off the toolbar. How-
ever, if you do have your Customize box open, you can drag any button off any toolbar with-
out using the Alt key. Also, with the Customize box open, you can click any menu to display 
it, then drag any command off the menu.

Try adding and removing buttons and commands until you get comfortable with it. Then, 
move on to Exercise 12.2 and I’ll show you how to customize buttons and commands as well 
as add a new menu.

 

E X E R C I S E  1 2 . 2  

 

Customizing Toolbar Buttons and Menu Items

 

Before you start this exercise, make sure MyToolbar is showing. If you did not complete the 
previous exercise or if you deleted MyToolbar, you can extract Toolbars.xlt from the zipped 
file for this chapter and open that, and it will add the toolbar on the right end of your Format-
ting toolbar. You then close Excel and open it again. Or, you can simply use the knowledge 
you now have and create a new MyToolbar with an Open and a Save button on it.

 

1.

 

Open Excel to display a new blank workbook.

 

2.

 

Open the Customize dialog box and click the Commands tab.

 

3.

 

Click the Open button on MyToolbar to select it. It now has a black box around it.

 

4.

 

In the Customize box, click the Modify Selection button. In the Name box on the submenu 
displayed, replace the existing entry with 

 

Get a File

 

.

 

5.

 

Click Change Button Image to display the image choices Excel offers. Select any one you 
want (I chose the door key). The submenu collapses and you see the new image on 
MyToolbar.

 

6.

 

With the new button still selected, click Modify Selection again. The display options are 
as follows: Default Style, Text Only (Always), Text Only (In Menus), and Image And Text. 
Choose Image And Text. The button on the toolbar now looks like this:

 

7.

 

Right-click the Save button on MyToolbar to display the same choices you have when 
clicking the Modify Selection button. Change the name to 

 

Update

 

. Then, use the Change 
Image choices to choose the question mark image.

Adding text and buttons to MyToolbar will make it larger and, therefore, may cause the 
toolbar to move to another location so that the full toolbar can be displayed.

 

8.

 

Right-click the button again and choose Image And Text.
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9.

 

Right-click the button one more time and choose Edit Button Image.

This brings up the Button Editor. Clicking on any color in the Colors boxes then clicking 
on any box in the Picture grid allows you to change the color of that grid box (equal to 
one pixel). Clicking on the Erase box then clicking a grid box clears the color from that 
pixel. Clicking the Clear button clears the entire grid so that you can start fresh. The Move 
arrows let you move the image up, down, left, and right. The Preview box shows how 
your button will look.

 

10.

 

Use the Button Editor to change the yellow question mark into a red exclamation point, 
as shown here:

 

11.

 

Click OK to close the Button Editor.

12. In the Customize box, click the Rearrange Commands button to bring up this box:

E X E R C I S E  1 2 . 2 ( c o n t i n u e d )
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Once you’ve completed the previous exercise, click your new Get A File button to open any 
workbook in Excel and try out your new menu commands and buttons on that file. Try going 
back into the Customize box and changing more features in My Menu and MyToolbar.

When you are done with this section, if you want to get rid of My Menu and MyToolbar, 
just open the Customize box. To delete My Menu, simply click on it and drag it off the menu 
bar. To delete MyToolbar, go to the Toolbars tab, find it in the list and select it, and then click 
the Delete button.

This should get you well on your way to making your toolbars and menus work the way 
you want them to. Now, let’s move on and learn all about the default settings you can change 
using Tools � Options.

Working with Excel’s Options Dialog Box
In most programs, there are places where you can adjust the settings for how the program 
performs. Whenever I open a new program, I always look for “preferences,” “settings,” or 
a similar choice in one of the menus so I can see how to personalize the program to meet my 
needs. In Excel’s case, these customization settings are found via the Options command in 
the Tools menu.

This is where you can change the order of the commands on any toolbar or menu. (Or, 
with the Customize box open, you can always just drag and drop buttons and commands 
to put them in the order you want.)

13. Choose Toolbar at the top, then choose MyToolbar from the list beside that.

14. Select Get A File and click the Move Down button in order to position the Get A File button 
after the Update button. Click the Close button to return to the Customize box.

15. In the list of Categories, select New Menu. From the Commands box on the right, drag 
New Menu up and put it beside your Help menu on your menu bar.

16. Right-click New Menu on your menu bar and change its name to My Menu.

17. Click Format in the Categories list. Then, in the Commands list on the right, drag Increase 
Font Size into your new menu on the menu bar. (We did this in Chapter 11, so if you don’t 
remember how, you can refer to that. Basically, just drag the command up to the menu 
and wait for it to expand, then drag it down to place the item within the menu, and release 
your mouse button.)

18. Add the Decrease Font Size command to My Menu also.

19. Close the Customize box.

E X E R C I S E  1 2 . 2 ( c o n t i n u e d )
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Throughout this book I have taken you into Tools � Options to do various things (hide 
gridlines, turn on your tooltips, etc.). Now, I want to take you through this entire dialog box, 
tab by tab, so that you understand what each setting does and can make your own choices 
accordingly. Though you may choose never to use some of these settings, it’s important that 
you have a general knowledge of what they do so you can make an educated decision.

Because we covered the Custom Lists tab completely in Chapter 4, “Editing 
Tools, Comments, and Hyperlinks,” I won’t be going over that again here, so 
refer to that chapter if you need a refresher.

Let’s start with the View tab, which is the first tab on the bottom row on the left, and work 
our way through.

Excel’s View Options

Although most of the settings you change in the Options dialog box are global settings and will 
apply to all of your workbooks, some tabs have settings that apply only to the active work-
book, and the View tab is one of them.

Let’s begin by choosing Tools � Options and clicking on the View tab (see Figure 12.5).

F I G U R E 1 2 . 5 Settings that affect the onscreen view

The top three sections on this tab affect global settings, whereas the Window Options sec-
tion affects only the view of the active workbook.

The options on this tab affect the settings for how Excel or a specific workbook is viewed. 
The first section, Show, at the top, is where you can select or deselect the elements you want 
displayed every time you open Excel. Don’t like the task pane showing up every time Excel 
launches? Then deselect Startup Task Pane. The task pane will still launch when you need it, 
but it won’t automatically appear onscreen when you first open the program. You can also 
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deselect Formula Bar and Status Bar, but I don’t recommend that because they are both fea-
tures you will probably use a lot. Windows In Taskbar is something you can deselect if you 
don’t want Excel to open a new window for each workbook. If you do deselect this option, 
you will need to use the Window menu to move from one open workbook to another.

The Comments section lets you choose how to display comments added to cells. Obviously, 
None means comments will not be displayed at all. Comment Indicator Only is the default 
choice; comments will be indicated by the small red triangle in the corner of a cell and will dis-
play only when you rest your mouse pointer over the cell. Comment & Indicator means the 
full comment will be displayed all the time.

If you have a slower machine and find that inserted objects make your worksheets load like 
snails, you can use the Objects section to display only placeholders where these objects have 
been inserted. Obviously, if you need to view the object in any particular worksheet, you 
would have to return to this dialog box and choose Show All. The Hide All choice is probably 
not something you would want to use because that doesn’t even show a placeholder, so you 
wouldn’t even know the object was there.

As I said earlier, the Window Options settings do not apply to all workbooks. These set-
tings apply only to the workbook that is open when you make your choices. In Chapter 5, 
“Formulas and Functions in Excel,” I showed you how to press Ctrl+` to show formulas 
instead of results. You can see there is a checkbox here for Formulas, which does the same 
thing as pressing Ctrl+`. Also, in Chapter 9, I taught you how to deselect the Zero Values and 
Gridlines checkboxes to hide them when creating templates. Try selecting and deselecting the 
other options in this section to see how they affect your workbook. Also, use the Gridlines 
Color dropdown choices to change the color of your gridlines.

When you are done playing with the View options, move on to the next section to learn 
about the Calculation choices you have.

Excel’s Calculation Options

The tab shown in Figure 12.6 is one I don’t recommend you make many changes to, except 
on very rare occasions. Actually, the only time I’ve ever messed around on this tab was when 
I was helping someone who was having problems with Excel not calculating correctly. In these 
cases, it was because they had gone into this tab and made changes. Usually, their problem was 
solved when I simply returned all the settings to their defaults. So, my recommendation is, “If 
it ain’t broke, don’t fix it.” Stay away from this tab unless you are having problems. Never-
theless, I’ll briefly explain the settings you may want to change on occasion. All of the settings 
on this tab are workbook-specific and affect only the active workbook.

The Calculation section allows you to change the calculation of formulas from automatic 
to manual. The only time I have had to change to manual was when I helped users with a 
worksheet that summed, say, seven or eight columns of numbers (spanning about 30,000 
rows) and every time the user changed one number, Excel had to recalculate all of these sums. 
In this case, the person who owned the workbook had an older machine and this process took 
forever, especially if he was changing a lot of numbers. Changing this workbook to manual 
calculation allowed him to make all of his changes without any formula results being updated; 
then, when he was done, he could either press F9 to calculate, or save the workbook to update 
all of the formula results.
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F I G U R E 1 2 . 6 Settings that affect the way Excel calculates formulas

The Iteration settings, again, are something I don’t recommend you change. These settings 
affect how many times Excel will loop through data that requires constant recalculation. Gen-
erally, the defaults work best.

The Workbook Options section includes some settings you may want to change. For example, 
when Update Remote References is deselected, if another workbook is linked to this one and 
you make a change in this workbook, the other one (which is the Remote Reference) will not 
be updated. On the other hand, when Save External Link Values is deselected, if you have links 
in this workbook and when you open it you click Yes to update the links, these updates will 
not be saved when you save this workbook. Precision As Displayed can be useful but should 
be used with caution. If you select this option, all of the numbers in your workbook will be 
replaced with what is showing in the cell. So, if you have a cell that shows 100 but the Formula 
bar displays 99.76 (because the number is being rounded to display no decimal places in the 
cell), both the cell and the Formula bar will show 100.

Because the settings on this tab only affect the active workbook, I recommend you make a 
test copy of a workbook and try modifying some settings to see how they affect it.

When you are satisfied that you understand this tab, move on to the next section, where we 
discuss the Edit settings.

Excel’s Edit Options

All of the settings on this tab (shown in Figure 12.7) are global and will affect all of your work-
books. These are the settings used to control how you move around in a worksheet and edit 
the content of the cells. If when you went through Chapter 1 of this book you didn’t like the 
way Excel performed, then you might want to make some changes here.

You will notice that, by default, all of the boxes on this tab are checked except Fixed Decimal 
Places. Be cautious when enabling this option because it is misleading. You might think that, 
with this box selected and 2 decimal places chosen, Excel would display 2 as 2.00. Not true. With 
this box checked, typing 2 in a cell would display it as .02, which may not be what you want.
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F I G U R E 1 2 . 7 Settings that affect how you move around in worksheets and edit content

The rest of the settings on this tab are fairly obvious. Edit Directly In Cell allows you to 
change the cell content by typing in the cell. With this deselected, you would only be able to 
edit the content in the Formula bar. Allow Cell Drag And Drop lets you use your mouse to 
move cells from one location to another. Ask To Update Automatic Links causes Excel to 
prompt you when you open a workbook that contains links. If you deselect this, opening those 
workbooks will automatically update the links without letting you know.

One setting that many people do like to change is Move Selection After Enter Direction. As 
you know, when you press the Enter key you are moved to the cell below. This tab lets you 
change this behavior so that you would instead be moved to the cell to the right, left, or above. 
Lots of people prefer to be moved to the cell to the right, so they simply change this option.

Again, play around on this tab until you understand what the different settings do. But, in 
this case, I caution you to try one change at a time because these settings will affect all of your 
workbooks. If you change more than one, then find you don’t like the way Excel is perform-
ing, you might not remember which option caused the problem, so trying them individually 
will make it easier for you to troubleshoot.

When you are done, move on to the next section, which explains the General tab.

Excel’s General Options

As with most of the tabs in this dialog box, the option settings on the General tab are global 
and affect all workbooks. Throughout this book, I’ve taken you to this tab occasionally (e.g., 
to change your user name when tracking changes or to turn on tooltips). Now let’s examine 
some of the other options you see in Figure 12.8.

As you can see, the Recently Used File List defaults to show four entries. This is the number 
of recently saved workbooks that appears at the bottom of Excel’s File menu and the Getting 
Started task pane. Just change this number to however many files you want to display.
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F I G U R E 1 2 . 8 Settings that affect the general look and feel of Excel

The Web Options button gives you lots of choices for how you want workbooks handled 
when you use the Save As Web Page command. The Service Options button lets you control 
what is displayed in the Help sections and how shared workbooks are handled.

Notice that you can also change the default number of sheets included in a new workbook 
as well as the default font. Many users change both of these features.

The Default File Location is what controls your Save As and Open dialog boxes. You’ve 
probably noticed that, when you open a new workbook or save a workbook for the first time, 
the dialog boxes take you to the My Documents folder. If, in fact, this is not where you want 
your Excel files saved, change this location.

For now, let’s skip the At Startup, Open All Files In option, because we will look at that 
later in this chapter.

When you are satisfied that you understand the choices on this tab, move on to the Tran-
sition tab, described in the next section.

Excel’s Transition Options

These settings let you change Excel’s default behaviors. The three Transition checkboxes (shown 
in Figure 12.9) should be selected only if you want Excel to perform more like Lotus 1-2-3. 
The Transition options are handy if you are new to Excel and accustomed to using Lotus; 
however, enabling these options can have strange effects on how Excel does stuff, so I do not 
recommend you do this. If you are going to use Excel, then you should learn to use it like Excel, 
not like Lotus 1-2-3.

The dropdown at the top that says Save Excel Files As allows you to change the default file 
type. If most of the files you save will be opened by users running Excel 97 or Lotus 1-2-3, for 
example, you can make this your default Save As Type choice that will be selected in the Save 
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As dialog box. Again, I don’t recommend this because you will probably want most of your 
workbooks saved in the default XLS format.

F I G U R E 1 2 . 9 Settings that affect Excel’s behaviors

The Microsoft Office Excel Menu Key, as you can see, is set to use a slash (/). Most people 
don’t even know this feature exists. To see how it works, open any workbook, make sure 
you are in Ready mode, and type /. Excel highlights your File menu button with a box 
around it. Press Enter and the File menu opens. How useful is this? To me, it’s not useful at 
all (because I’m more of a mouse user than a keyboard-shortcut person), but if you find it 
handy and want to use something other than a slash, change this setting to whatever single 
character you want.

Generally, I don’t use the Transition tab much, but feel free to check it out.
The next tab in the lineup is the Custom Lists tab. I covered this one completely in Chapter 4, 

so there’s no need to discuss it here again. However, if you need to review that tab, do so. Let’s 
now move on to the Charts tab.

Excel’s Chart Options

This tab doesn’t really include much, but it’s worth mentioning. It allows you to change the 
settings for one specific chart while it is onscreen. Note, in Figure 12.10, the Active Chart set-
tings are available because I opened this dialog box with a chart on my screen. If you open this 
dialog box without a chart selected onscreen, only the Chart Tips section at the bottom will 
be available for changes.

I’m not sure why Microsoft put these settings in the Options box instead of including them 
with the options you have available while working on a chart, but it’s important to keep in 
mind that these settings are here. This tab lets you tell Excel how to handle empty cells, columns, 
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and rows in the data used to produce your chart. As you’ll recall, deleting the content of a col-
umn in your data could cause your chart to show a gap where that bar used to be. Well, if you 
use this tab to tell Excel not to plot empty cells, that gap will not appear.

F I G U R E 1 2 . 1 0 Settings that affect charts

Also, this tab contains two checkboxes that control the tips displayed when you rest your 
mouse on the different objects in your chart. By default, these tips display both the name of 
the object and its value. Select or deselect either of these boxes to change this. Remember, 
though, that these two checkboxes affect global settings and, therefore, all of your charts.

Next, let’s look at the Color tab.

Excel’s Color Options

I often hear people complaining that some of the places in Excel where you can use colors 
do not include the choices they want. So, here’s the place where you can change that (see 
Figure 12.11).

As you can see, your Standard Colors, Chart Fills colors, and Chart Lines colors are dis-
played. Click on any one of the color boxes, then click the Modify button and you can change 
that color. Now when you use any of the features in this workbook that let you choose colors, 
the new one you chose will be included instead of the default ones. Clicking the Reset button 
will return the choices to the defaults.

The settings on this tab are not global; they only affect the active workbook. So, if you 
change the colors in one workbook and then want those same colors in another workbook, 
open both workbooks and use the Copy Colors From dropdown list to copy the settings from 
one workbook to another.

I use this feature a lot, especially with charts. I’m not fond of the limited colors offered by 
Excel for charts, and I have to use the More Colors option when I want to recolor parts of my 
chart (refer to Chapter 2, “Formats, Graphics, and Excel’s Templates”).
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F I G U R E 1 2 . 1 1 Settings that affect color choices

Become familiar with how this works, then move on to the next section and we’ll learn 
about the International tab.

Excel’s International Options

These options won’t mean much to you if you are American and share your workbooks only 
with other Americans. However, if you live in a country where decimals and commas are not 
the characters used when you display numbers or currency, here is where you can change that 
(see Figure 12.12).

F I G U R E 1 2 . 1 2 Settings that affect country-specific data display
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If you deselect the Use System Separators option, you can change the period and comma to 
whatever you want.

Also, remember that not all countries use the standard 81⁄2 ×11 paper size Americans use. If 
you live in a country that uses the A4 letter paper size, you can change that here as well.

Finally, remember that not all nationalities read from left to right. If you read from right 
to left, here’s the place to change Excel’s default directional movement.

Next, let’s look at the Save options.

Excel’s Save Options

As you can see in Figure 12.13, this tab doesn’t refer to saving per se but to AutoRecover.

F I G U R E 1 2 . 1 3 Settings that affect the automatic recovery of crashed workbooks

AutoRecover is a feature in Microsoft Office that can save your bacon if Excel crashes. If 
Excel does crash, when you reopen it, you will be presented with a recovered file that you can 
then open and save. If you have this feature turned off and Excel crashes, you could lose all 
of the data you entered since your last manual save. The AutoRecover settings on this tab are 
global and will affect all workbooks.

However, it’s important to understand the difference between AutoRecover and Save. 
Some people think if they have this feature turned on Excel will automatically save their doc-
ument for them every so many minutes and therefore, they don’t need to save it themselves. 
Not true. This feature only saves AutoRecover information, so if Excel crashes, you will be 
able to retrieve the last AutoRecover information. However, if you close Excel normally and 
forget to save your changes, this AutoRecover information won’t help you at all. This feature 
helps you only if Excel crashes.
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This tab lets you tell Excel how often you want the AutoRecover information to be saved 
and where you want it stored. It also allows you to disable the AutoRecover feature, which I 
definitely do not recommend!

Next, let’s look at the Error Checking tab.

Excel’s Error Checking Options

In Chapter 8, “Data Analysis and Sharing Workbooks,” you learned how to use the Error 
Checking feature and the option buttons and green triangles that display when Excel recog-
nizes an error or inconsistent information. As shown in Figure 12.14, this tab lets you control 
what Excel will consider an error or inconsistent.

F I G U R E 1 2 . 1 4 Settings that affect error checking

If you deselect the Enable Background Error Checking checkbox, Excel won’t check any-
thing for errors and you will have to do it all manually. Also, notice that below that box, you 
can change the Error Indicator Color from green to any color you want.

The Rules list determines what Excel will flag with the green triangle and option buttons. 
If you don’t want any of these things flagged, just remove the checks. You can always come 
back to this tab and reselect them individually, or click the Reset Ignored Errors button to put 
them all back to the defaults.

The settings on this tab are global and will affect all workbooks.
Try selecting and deselecting the various options until you are comfortable with the level 

of error checking that Excel is performing on your formulas. When you are done experiment-
ing, move on to the next section, where we check out the Spelling options.
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Excel’s Spelling Options

This tab (shown in Figure 12.15) governs the global spellchecking settings and applies to all 
workbooks.

F I G U R E 1 2 . 1 5 Settings that affect the Spelling tool

The Dictionary Language dropdown lets you choose the language you want the Spelling 
tool to use by default. The Add Words To dropdown list shows the name of the file where any 
words you add manually to your dictionary are stored. This CUSTOM.DIC file is a simple text 
file; now that you know its name, you can search your hard drive and find it and remove words 
that you may have accidentally added previously. By default, this file is located in C:\Docu-
ments and Settings\<your user name>\Application Data\Microsoft\Proof. When you find it, 
you can simply double-click it to open it and it will open in Notepad. You will see a list of the 
words you’ve added, and you can simply delete any you don’t want the Spelling tool to ignore 
anymore. Remember that this file is shared by all of your Office programs, so removing any-
thing from it will affect the spellcheckers in all of the programs. When you edit this file, make 
sure you have no Office programs running, because this file is open and being read whenever 
you use any of the Office programs.

The checkboxes below this dropdown allow you to make choices as to what you want 
spellchecked and what you don’t.

If you have German, Korean, Arabic, or Hebrew chosen as your default language, the 
Language-Specific options on the right will be available to you as well.

Now, let’s move onto the last tab, Security.
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Excel’s Security Options

The settings you see at the top of Figure 12.16 are workbook specific and will only apply to the 
active workbook. They are no different from the settings you chose in Chapter 9; this is simply 
another way to get to them.

F I G U R E 1 2 . 1 6 Settings that affect security

The Privacy Options section allows you to remove personal information from the proper-
ties of a file when it is saved. So, if you create a template and don’t want people changing this 
information, you can select this checkbox, then protect the workbook without disabling users’ 
abilities to see the properties (see Chapter 9), but still control their ability to change the infor-
mation. Or, if you don’t want your own information included in the properties, selecting this 
checkbox will remove the information automatically inserted by Excel when you create or 
save a file. This is a global setting.

The Macro Security button at the bottom simply takes you to the same place you went in 
Chapter 9 when you chose Tools � Macro � Security. This setting is a global setting and will 
affect all workbooks.

The Digital Signatures button lets you add signatures created by programmers you trust so 
you won’t be prompted to accept the macros from these people every time you open one of 
their workbooks.

That covers just about everything you can adjust from within Excel. Once you understand 
Tools � Options, you should have Excel set up to run in a fashion that suits your own par-
ticular style and needs.

Now, let’s look at the ways you can apply all of the settings and formats you’ve learned in 
this book and use them as your defaults every time you open a blank workbook or add a new 
sheet to an existing workbook.
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Creating Default Workbooks 
and Worksheets
Up to this point, you’ve learned how to create defaults in templates and individual workbooks, 
and how to use Tools � Options to make global default settings. But the bottom line is that 
your new blank workbook still looks pretty much the same as when you first installed Excel. 
And, when you insert a new sheet, it looks like Excel’s default sheet.

Also, though the Options dialog box does allow you to make many global changes, in some 
cases you may work for a company that has disabled your ability to make certain changes in 
that box. This section will show you one way to get around most of that by creating your own 
default workbook.

This last section shows you how to control which template will be your default blank 
workbook template and which sheet style will be the default when you add sheets to exist-
ing workbooks.

Excel uses a folder on your hard drive named XLSTART to locate defaults when it loads. 
When you create a Personal Macro Workbook to store your global macros, Excel places the 
personal.xls file in this XLSTART folder. You can also create templates for your default work-
book and default worksheet and save them in this folder, and they will be the ones that load 
at startup.

In the previous section, when I discussed the General tab in the Options dialog box, I men-
tioned an option called At Startup, Open All Files In. If that box is empty, Excel will load only 
files located in XLSTART. However, if you enter another path to a different folder there, you 
can load the files in that folder instead. Usually, this isn’t necessary. But if you are working on 
a company computer and, because of the restrictions placed on you, you aren’t allowed to add 
files to XLSTART, you may be able to add a folder in this box and use that folder instead for 
the following exercises.

Let’s start with the default workbook.

Changing Your Default Workbook

When you first install Excel, two folders named XLSTART are added to your computer. One 
is located in C:\Documents and Settings\<your user name>\Application Data\Microsoft\Excel, 
and this is the one that will hold all defaults you want for you alone. The second one is in 
C:\Program Files\Microsoft Office\Office 11; this is where you would store defaults you want 
for all users of this computer.

Unless you have added anything to these folders, they will be empty. When you launch Excel, 
it looks in both of these folders and loads anything in them. If they are empty, then Excel just 
loads normally, using its own defaults.

So, let’s say you want your new blank workbooks to look different from what Microsoft 
has determined you should have. You can create your own new blank workbook template 
with anything you want in it, then simply save it as a template named book.xlt and place it in 
the XLSTART folder.
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Try Exercise 12.3 to learn how to do this. And, don’t worry; I will show you how to delete 
these defaults later, so you can feel free to do these next exercises.

E X E R C I S E  1 2 . 3  

Creating a New Default Workbook

1. Open a new blank workbook in Excel.

2. Add a new worksheet at the end so you have four.

3. Go to View � Header And Footer.

4. Click the Custom Header button. In the Center section, type your full name. Click OK.

5. Click the Custom Footer button. Use the buttons to add the filename in the left section 
and the date in the right section. Click OK.

6. Click OK again to return to the worksheet.

7. Group the four worksheets.

8. Click the Select All box (to the left of the A column header and above the 1 row header) 
to select the whole sheet.

9. Change the font to Comic Sans MS, 12 pt. (If you don’t have Comic Sans MS installed, 
choose any font you want.)

10. Select A1 (so all of the cells are no longer selected) and then ungroup the sheets. If you 
are not on Sheet1, move there and select A1.

11. Click the Save button.

12. Change the file type to Template (*.xlt).

13. Navigate to your XLSTART folder. It’s probably located in C:\Documents and Settings\
<your user name>\Application Data\Microsoft\Excel. Be sure the Save In box at the top 
says XLSTART.

14. In the File Name box, name it book.xlt. Click Save.

15. Close the file.

16. Click the New button on the Standard toolbar. As you can see, your new blank workbook 
shows four sheets.

17. Type hello in cell A1. It appears in Comic Sans MS, 12 pt. Press Enter.

18. Click the Print Preview button and see your header and footer.

19. Insert a new worksheet and note that it does not look like your new default.

20. Close the file and do not save it.
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So, you can see that creating a template and storing it in XLSTART with the name book.xlt 
does indeed give you a new default blank workbook, but when you add new sheets, they are 
still the old default controlled by Microsoft’s choices. Read on to find out how to fix that.

Changing Your Default Worksheet

Creating a new default worksheet is done pretty much the same way as creating the default 
workbook; the only difference is you simply give it a different name when you save it as a tem-
plate. The name used for the default worksheet is sheet.xlt.

As with the new workbook, when you insert a new sheet, Excel looks in the XLSTART 
folders and, if there’s nothing there, it simply uses its own default sheet.

Exercise 12.4 shows you how to change this.

So, there you have it: a new default workbook and worksheet that look just like you want.
Remember that you can apply all of what you’ve learned in this book to create a template 

and then save that as your default workbook and/or worksheet. You can add a company 
logo, and even add formulas if you want. You are limited only by your own imagination.

But, before I end this chapter and this book, let’s get your defaults back to the originals.

Restoring Excel’s Default Workbook and Worksheet

I’m sure you don’t really want your default workbook and worksheet to look like the ones you 
created in this lesson, so you have two choices: You can open a new blank workbook, make 
any changes you want, then save it as book.xlt and/or sheet.xlt in your XLSTART folder to 
overwrite the ones you made following my directions. Or, you can delete book.xlt and 
sheet.xlt to get back to Excel’s defaults.

E X E R C I S E  1 2 . 4

Creating a New Default Worksheet

1. Click the New button to open a new blank workbook. Obviously, you’ll see your new 
default workbook.

2. Delete sheets 2, 3, and 4, so that you only have one sheet.

3. Click the Save button.

4. Save it as a template in your XLSTART folder and name it sheet.xlt.

5. Close the file.

6. Open a new blank workbook, or any workbook on your computer, and insert a new sheet. 
Note that it is your new default sheet.

7. Close the file and do not save it.
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Remember that Excel looks in XLSTART and, if if it finds nothing there, it just displays the 
original defaults. So, all you have to do now is delete book.xlt and sheet.xlt and everything will 
be back to normal.

Make sure you have no workbooks open and choose File � Open. Navigate to your XLSTART 
folder. Click on book.xlt to select it, then hold down your Ctrl key and click on sheet.xlt. Both 
templates should be selected. If personal.xls is in there and you want to get rid of that as well, 
just Ctrl-click on it also. Press the Delete key on your keyboard; then click Yes to delete them.

Close the Open dialog box. Click the New button on your Standard toolbar. You’ll see that 
the new workbook is back to normal. Insert a new worksheet and it is also back to Excel’s 
default style.

Close Excel. You are done!
I hope you have learned much from this book. It has been my pleasure to teach you. Best 

of luck on that MOS Exam. I know you can do it!

Summary
Excel gives you many different ways to customize its look, feel, and performance and lets you 
save those customizations as your defaults.

You can customize your toolbars and menus so they include the buttons and commands 
you use most often. You can add, remove, and relocate buttons and commands. You can also 
create new toolbars and menus and customize them to your liking. And, you can change the 
look of any button or command you add, by modifying its image and text.

Using Excel’s Options dialog box lets you change many of the default settings within an 
individual workbook as well as globally. The Options dialog box includes tabs for various set-
tings, and each tab gives you many choices to suit your needs.

Finally, once you’ve made all the adjustments you want to any workbook or worksheet, 
you can save them as templates in your XLSTART folder, with the correct names, so they will 
be your default workbook and worksheet.

Exam Essentials
Know how to create new buttons, menu items, and toolbars. Understand how to use all of 
the tabs in the Customize dialog box, as well as all of the options in the Modify Selection menu.

Be familiar with the Options dialog box. Get comfortable with each tab in this dialog box 
so you can quickly locate any settings you want to change.

Understand how to save templates as your default workbook and worksheet. Remember 
where the XLSTART folder is located and that you must save the default workbook as book.xlt 
and the default worksheet as sheet.xlt.

Know how to restore Excel to the original defaults. Know how to revert settings to their 
defaults: either by clicking buttons in the Options dialog box or by deleting templates in 
Excel’s XLSTART folder.
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Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter but also include skills learned in the previous chapters; then check the solutions to see 
how you did. Extract the file MOS Scenarios Ch12.xls from the zipped file for this chapter and 
open it before you do these exercises.

 

MOS Scenario 31: Add, Modify, and Remove a Toolbar Button

Add a button to the Standard toolbar that allows you to protect the worksheet. Then modify 
the button so that it shows as a musical note with the text Protect Me. Use the button to pro-
tect the sheet with default settings and no password. Then, remove the button.

 

MOS Scenario 32: Create a New Default Worksheet

Delete all of the text in the workbook, but save the formatting. Rename the sheet tab to 
Sheet1. Make this the default new worksheet. Add two new worksheets to this file. Then 
delete the default new worksheet.
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Remember that the software used during the actual MOS test 
cannot tell which steps you took to complete an exercise, so you 
are not graded on that. You are graded only on the results you 

achieve. So, if you only want to check your results, you can extract the completed files from 
the zipped file for each chapter and compare them to yours. Though the steps to complete each 
scenario are listed here, these are just examples of how they could be accomplished. There are 
various ways to accomplish the same end in Excel.

 

Chapter 1 Scenario Solutions

 

Scenario 1, Suggested Steps

 

1.

 

Click cell A4 and press F2 to enter Edit mode. Adjust the name as instructed.

 

2.

 

Press Enter to move to cell A4 and repeat step 1 to edit the data. Then continue down 
column A until you have renamed all stores.

 

3.

 

Edit cell B8 to 

 

14975.03

 

.

 

4.

 

Edit cell C8 to 

 

13542

 

.

 

5.

 

Edit cell D8 to 

 

14007

 

.

 

6.

 

Edit cell E8 to 

 

1676

 

.

 

7.

 

Click any cell in row 9 and choose Insert �

 

 Rows.

 

8.

 

Type 

 

Smithfield Clothiers

 

 in cell A9.

 

9.

 

Select cells B5:E5 and copy their contents; then click in cell B9 and paste.

 

10.

 

Double-click the right edge of each column header to adjust the column to fit the contents.

 

Scenario 2, Suggested Steps

 

1.

 

Double-click the Sheet1 sheet tab, type 

 

March 2005

 

, and press Enter.

 

2.

 

Select Insert �

 

 Worksheet. Double-click that tab and type 

 

March 2004

 

.

 

3.

 

Repeat step 2, but type 

 

March 2003

 

.

 

4.

 

Click the sheet tabs and drag them until they appear as March 2003, March 2004, and 
March 2005, from left to right.
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5.

 

Right-click each tab; choose Tab Color, and select a different color for each.

 

6.

 

Select cells A1:E11 and copy them. Move to cell A1 of one of the other sheets and paste, 
then move to the last sheet and paste again.

 

7.

 

Move to cell A1 on the first sheet. Select Edit �

 

 Find.

 

8.

 

Type 

 

french

 

 in the Find What box and click the Find All button. Click in the Formula bar 
and change Corner to 

 

Riviera

 

.

 

9.

 

Click the next sheet tab and repeat steps 7 and 8. Then repeat these steps again on the 
third sheet.

 

10.

 

Double-click the right edge of each column header to adjust the column to fit the contents. 
Repeat this on all sheets.

 

Scenario 3, Suggested Steps

 

1.

 

Click the March 2005 sheet tab, then click any cell in row 2. From the Edit menu choose 
Delete, then choose Entire Row.

 

2.

 

Click any cell in row 2 and choose Format �

 

 Row�

 

 Height and type 

 

20

 

. Click OK.

 

3.

 

Click the March 2004 tab, then select cell C9 and choose Insert �

 

 Cells. Choose Shift 
Cells Down and click OK.

 

4.

 

Select cell C12 and cut it. Select cell C11 and paste.

 

5.

 

Choose File �

 

 Save As.

 

6.

 

In the Save As dialog box, click My Documents on the left.

 

7.

 

Click the New Folder icon and type 

 

MOS Scenarios

 

. Click OK.

 

8.

 

In the File Name box, type 

 

ChapterOneScenarios

 

. Click the Save button.

 

9.

 

Click the March 2005 tab, then choose File �

 

 Save As.

 

10.

 

From the Save As Type dropdown list, choose Text (Tab Delimited) (*.txt) and click the 
Save button. Click Yes or OK in all warning boxes.

 

Chapter 2 Scenario Solutions

 

Scenario 4, Suggested Steps

 

1.

 

Select cell A1 and double-click the Format Painter. Select the range A3:A8; then select 
B3:E3. Turn off the Format Painter, then reselect the ranges and click the Italics button 
to remove italics. Adjust column widths.

 

2.

 

Select the range B4:E4; then choose Format �

 

 Cells and click the Number tab. Choose 
Number as the category, with 2 decimal places. Click OK.
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3.

 

With the range B4:E4 still selected, use the Fill Color button on the Drawing toolbar to 
fill the cells with Light Turquoise. Click outside the range to deselect it.

 

4.

 

From the Format menu, choose Sheet �

 

 Background. Navigate to find Blue hills.jpg; click 
it and click the Insert button.

 

Scenario 5, Suggested Steps

 

1.

 

Click the Oval tool on the Drawing toolbar and draw an oval that covers the number in 
cell E7. Use the Fill Color button and choose No Fill; then use the Line Color button to 
change the oval to Red.

 

2.

 

Use the AutoShapes button on the Drawing toolbar and choose Callouts �

 

 Rectangular 
Callout. Click and drag to the right of the circled number to place the callout there. Type 

 

The Winner

 

; then click the diagonal-lined border to change it to the dotted border. Click 
the Bold button; change the font size to 14 pt.; use the Fill Color button and choose No 
Fill. Use the resizing handles to make the callout wider and shorter, so the text is on one 
line. Then click the yellow diamond on the callout and move it so it points to the number 
circled in red.

 

3.

 

Click the Insert Clip Art button on the Drawing toolbar. In the Search box on the task 
pane, type 

 

runner

 

. Click any of the pictures to insert it. Then, click the Format Picture but-
ton on the Picture toolbar; go to the Size tab; deselect the Lock Aspect Ratio option, and 
set the height and width to 2˝.

 

4.

 

Click the Insert Diagram Or Organization Chart button on the Drawing toolbar and choose 
Target Diagram. Click the AutoFormat button on the Diagram toolbar and choose 
Square Shadows. Click the upper-right line (Click To Add Text) and type 

 

Peak Perfor-
mance

 

; then click the next one and type 

 

Practice

 

; then type 

 

Desire

 

 on the last line. (I then 
highlighted all of the text and made it bold, so it showed up better.) Drag the left and 
right resizing handles on the outside of the whole diagram to make it wide enough to 
show the entire word 

 

Performance

 

. Use the four-headed arrow to move the diagram 
below the text.

 

Scenario 6, Suggested Steps

 

1.

 

Select the range A3:C8 and click the Chart Wizard.

 

2.

 

In Step 1, click the Custom Types tab and choose Line – Column On 2 Axes. Click Next.

 

3.

 

In Step 2, make sure Columns is selected. Click Next.
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4.

 

In Step 3, click the Titles tab and type 

 

How

 

 

 

Age Relates to Running Times

 

 in the Chart 
Title box; type 

 

Time

 

 in the Value (Y) Axis box and type 

 

Age

 

 in the Second Value (Y) Axis 
box. Click Next.

 

5.

 

In Step 4, choose As Object In to place the object in Sheet 2. Click Finish.

 

6.

 

Double-click the Sheet 2 tab and type 

 

Age Comparison

 

.

 

Chapter 3 Scenario Solutions

 

Scenario 7, Suggested Steps

 

1.

 

Select any cell in column A, within the data.

 

2.

 

Choose Data �

 

 Sort. Select Last Name in the Sort By box; then choose First Name in the 
Then By box. Make sure that both are set to sort in ascending order and that Header Row 
is selected. Click OK.

3. Click anywhere in row 3 and choose Data � Filter � AutoFilter.

4. Use the dropdown in column D and choose Manufacturing.

5. Use the dropdown in column E and choose Custom. Select Is Greater Than in the first 
box; then type 10 in the second box. Click OK.

6. Choose View � Custom Views. Click the Add button. Type Manufacturing Ten Plus. 
Click OK.

7. Click the Print Preview button on the Standard toolbar.

Scenario 8, Suggested Steps

1. Click Data � Filter � AutoFilter to remove the filter.

2. Choose File � Page Setup; click the Page tab and choose Portrait. Click OK.

3. Click the Stats tab; then Ctrl+click the Vacations tab. Choose File � Print and change the 
Number Of Copies setting to 2. Click OK.

4. Move to the Jobs Available sheet and click the chart to select it. Choose File � Print and 
click OK.

5. Move to the Stats page; choose File � Page Setup and then click the Page tab. Set the Scal-
ing To Fit option to 1 page wide by 1 page tall. Click the Print button; then click OK.
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Scenario 9, Suggested Steps

It is important to remember that, with Scenario 9 particularly, you may have 
chosen a completely different method than the one described here—and that 
is okay. The MOS Exam does not grade you on how you achieved the desired 
result; it only grades you on the accuracy of the final result. Notice in this sce-
nario, the important things are that 1) you end up with a workspace file that 
is named correctly and saved in the right location, 2) the file shows all infor-
mation needed onscreen at one time without scrolling, and 3) the 3A file has 
Xs in the right places. The method described here is only one way that takes 
minimal time.

1. Close the file from the previous scenario, if it is still open. Then open the files MOS Sce-
nario 8 Completed.xls and MOS Scenarios 3A.xls, using Ctrl+click to select them both in 
the Open dialog box.

2. Inside MOS Scenario 3A.xls, go to the Window menu and choose Compare Side By Side 
With MOS Scenario 8 Completed.xls.

3. If when the tiled workbooks appear they are not filling the screen equally, use the double-
headed arrow on their edges to resize them so that each has equal screen space.

4. Turn off the Synchronous Scrolling button on the Compare Side By Side toolbar.

5. Click the Stats tab on the Completed Scenario file to make that the active sheet, if neces-
sary. Then select the range A1:B1 and choose Format � Column � Hide.

6. Select Cell D1 and choose Window � Freeze Panes. Use the → key to move to the right 
until only columns G and H show.

7. Reduce the Zoom percentage by using the Zoom box on the Standard toolbar until you 
can see all 30 rows of data in both workbooks. In my case, I chose a Zoom percentage 
of 45. Don’t worry that the data is hard to read. As long as you can tell Ys from Ns, 
you’ll be okay.

8. Drag the edge of the 3A workbook window to the left until it butts up against the data in 
the other workbook. Use the scrollbars to be sure the rows are aligned.

9. Type X in cell D4 of the 3A workbook because that employee has both a 401k and insur-
ance. Copy the X.

10. Use the Ctrl+click method to select the right box for each row in the 3A workbook (401K 
if the employee only has that; Insurance if the employee only has that; and both if the 
employee has Ys in both cells). Then, once they are all selected, paste the X into all of the 
cells at once.

11. Choose File � Save Workspace and name it 401K-Insurance.xlw. Save the file in your My 
Documents folder. When the Save confirmation box appears, click the Yes To All button.
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Chapter 4 Scenario Solutions

Scenario 10, Suggested Steps

1. Type the new data into rows 9, 10, and 11.

2. Select cell A1 and click the Spelling tool button. Change Cutomer to Customer and Ferst 
to First.

3. Select the range C3:C11. Choose Format � Cells, select the Number tab, and assign a 
Date format.

4. Select Cell D2. Use Find And Replace to find New York and replace it with NY, find Del-
aware and replace it with DE, and find New Jersey and replace it with NJ.

5. Select cell B8 and use the fill handle to drag down to B11, adding progressive customer 
numbers from MLR2007 to MLR2009.

6. Select any cell in column B and insert two new columns to the left of it.

7. Select the range A3:A11 and use the Text To Column wizard to split the data, with a space 
as the delimiter.

8. Change the text in A2 to read Last Name. Add First Name to B2 and Middle Initial to C2.

9. Select the range A3:A11, and use Find And Replace to find the commas and replace them 
with nothing.

10. Select any cell within the data. Choose Data � Sort and sort by Last Name, then First 
Name, then Middle Initial.

11. Double-click the right edges of all column headers to autofit the columns to display all data.

Scenario 11, Suggested Steps

1. Type the new information into columns G and H.

2. Type email addresses into cells G3:G5. Widen the column to show all data.

3. Alt+click cell H3. In the Research task pane, choose MSN Search from the Reference 
Books dropdown list; then click the link to www.goodcooking.com. When the website 
comes up in Internet Explorer, click the URL in the Address bar at the top; then right-click 
the URL and copy it. Return to the workbook, right-click cell H3, and choose Insert Com-
ment. Type Check out; then paste the URL into the comment. Adjust the width of the 
comment box so the URL is all on one line.

4. Add the text Websites to cell I2.

5. In cell I3 type Good Cooking and press Enter; then return to I3 and click the Insert Hyper-
link button. Click the Existing File Or Web Page button on the left; then click the Address 
box and press Ctrl+V to paste the same URL there. Click OK.

6. Adjust all columns to fit the data.
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Chapter 5 Scenario Solutions

Scenario 12, Suggested Steps

1. Ctrl+click to select the ranges B4:C4, B6:C6, B9:C9, and B11:C11, then choose Format � 
Cells and on the Number tab, choose Currency with two decimal places.

2. In B3, enter =b2*12. Drag that by the fill handle to C3.

3. Select B9 and click the Insert Function button. Choose the PMT function from the Finan-
cial category. Click OK.

4. In that box, enter the following: Rate is B5/12; Nper is B3; Pv is B4-B6; Fv is blank; Type 
is 1. Click OK. Result is ($1161.92).

5. Drag that formula to C9, using the fill handle. Click into the Formula bar and change the 
last 1 to 0. Press Enter. Result is ($926.23).

6. In cell B11, type =b9*b3. Press Enter. Result is ($55,772.12). Then return to that cell and 
drag it by its fill handle to C11. Press Enter. Result is ($55,573.67).

7. Press Ctrl+` to display the formulas. Adjust column widths.

8. Choose File � Page Setup. On the Page tab, choose Landscape. On the Sheet tab, choose 
Gridlines and Row And Column Headers.

9. Click the Print Preview button.

Scenario 13, Suggested Steps

1. Add a formula to C9, =MAX(B3:E7). Result is $56,000.00.

2. Add a formula to C10, =MIN(B3:E7). Result is $2476.80.

3. Add a formula to F3, =IF(E3>B3,(E3*10%),""). Use the fill handle to drag that to F7.

4. Cells F3 and F4 are empty. The result in F5 is $987.90. The result in F6 is $5600.00. The 
result in F7 is $1498.99.

5. Adjust all column widths.

Scenario 14, Suggested Steps

1. Select B2:C7 and choose Format � Cells. On the Number tab, select Date and choose the 
type that says Wednesday, March 14, 2001. Click OK.

2. Widen columns B and C as necessary.

3. Select cells D2:D7 and choose Format � Cells. On the Number tab, choose Number with 
no decimal places.

4. In cell D2, type =c2-b2 and press Enter.

5. Return to Cell D2 and use the fill handle to drag that down to D7.
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6. In F2, type =e2-d2 and press Enter, then drag that down to E7.

7. Adjust all column widths.

Chapter 6 Scenario Solutions

Scenario 15, Suggested Steps

1. Select any cell within the data on the Employees sheet and choose Data � Sort. Choose 
Last Name, ascending as the primary sort, then First Name, ascending as the secondary 
sort. Click OK.

2. Select the range A2:F29, then click in the Name box, type employees, and press Enter.

3. Move to the Vacation Schedule sheet and select cell B2. Click the Insert Function button.

4. Click in the Lookup_Value box, then click cell A2 on the worksheet. Press Tab to move 
to the Table_Array box.

5. Press F3, then double-click employees. Press Tab to move to the Col_Index_Num box.

6. Type 2. Press Tab to move to the Range_Lookup box.

7. Type false and click OK.

8. Right-click cell B2 and choose Copy.

9. Right-click cell C2 and choose Paste, then click in the Formula bar and change B2 to A2 
and 2 to 3. Press Enter.

10. Drag both formulas down to row 25, using the fill handle.

11. In cell A2, type S987. Press Enter.

12. In cell A3, type M190. Press Enter.

13. In cell A4, type A67. Press Enter.

14. In cell D2, type 14 days, then grab that by the fill handle and drag it to D4. Click the 
Option button that displays, and choose Copy Cells.

Scenario 16, Suggested Steps

1. Select cell G2 on the Employees sheet and double-click I2 in the Formula bar. Press the F4 
key. Press Enter.

2. Drag the corrected formula in G2 down to G29.

3. Move to the Vacation Schedule sheet and select cell B2. Edit the formula in the Formula 
bar to read 
=IF(ISNA((VLOOKUP(A2,employees,2,FALSE))),"",(VLOOKUP(A2,employees,2,FALSE))) 
and press Enter.

4. Drag B2 down to B25, using the fill handle.
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5. Right-click B2 and choose Copy.

6. Right-click C2 and choose Paste. Then, adjust the formula in cell C2 so both VLOOKUPs 
nested in that formula show A2 as the lookup value and 3 as the column number index. 
Press Enter.

7. Drag C2 down to C25.

8. Select B5:C25, click the Option button, and choose Ignore Error.

Scenario 17, Suggested Steps

1. Select B2:D29 on the Employees sheet. Choose Insert � Name � Create. Deselect Left 
Column, but leave Top Row selected. Click OK.

2. Choose Insert � Worksheet. Drag the sheet tab to the right of the Vacation Schedule 
sheet, then double-click the sheet tab and type Index. Press Enter.

3. On the Index sheet, type Name in cell A1 and press Enter.

4. Type Range in cell B1 and press Enter.

5. Select cell A2 and press F3. Click the Paste List button.

6. Select cell A1 and click in the Name box. Type Index and press Enter.

7. Double-click on the right edge of both column headers to adjust the columns to fit the data.

Chapter 7 Scenario Solutions

Scenario 18, Suggested Steps

1. On the Number of Products Sold sheet, sort the data by the Dept. column, in ascending 
order.

2. Click any cell within the data and choose Data � Subtotals.

3. In the Subtotals box, choose Dept where it says At Each Change In; choose Sum where it 
says Use Function; and select every checkbox except Dept in the Add Subtotal To list. 
Click OK.

4. Collapse the Cosmetics, Hardware, and Sporting Goods categories by clicking the minus 
signs to the left. Leave the Housewares category expanded.

5. Move to the Consolidation sheet and select the range B2:M5. Choose Data � Consolidate.

6. From the Function dropdown list, choose Average.

7. Click in the Reference box and move to the 2000 sheet; then select the range B2:M5 and 
click Add.

8. Select the 2001 sheet and click Add.

9. Select the 2002 sheet and click Add.
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10. Select Create Links To Source Data and click OK.

11. Adjust column widths to display all data.

Scenario 19, Suggested Steps

1. Move to the Consolidation sheet, select A21:A23, and press Ctrl+1. Choose Custom from 
the list and type #" total products sold" in the Type box. Click OK.

2. Type 2000 in A21, 2001 in A22, and 2002 in A23.

3. Group the 2000, 2001, and 2002 sheets.

4. Select the range B6:M6 on any one of the grouped sheets and click the AutoSum button.

5. While the sheets are still grouped, double-click between the column headers to adjust the 
column widths as necessary.

6. Ungroup the sheets.

7. Move to the Consolidation sheet and, in cell B21, type =sum(. Then click on the 2000 
sheet, select the range B6:M6, and press Enter. Repeat this in cell B22, using the 2001 sheet, 
and in B23, using the 2002 sheet.

8. Select B21:B23 and choose Format � Conditional Formatting. Choose Cell Value Is and 
Greater Than from the dropdowns and type 40000 in the last box. Click the Format but-
ton and choose bold and red on the Font tab. Click OK twice.

Scenario 20, Suggested Steps

1. Move to the Number of Products Sold sheet and click any cell within the data.

2. Choose Data � Subtotals.

3. Click the Remove All button.

4. With a cell inside the data still selected, choose Data � PivotTable and PivotChart Report.

5. In Step 1, leave the defaults and click Next.

6. In Step 2, be sure A1:M15 is selected and click Next.

7. In Step 3, make sure New Sheet is selected and click the Layout button.

8. Drag the Dept field to the Page box and drag Jan, Feb, and March to the Data box. 
Click OK.

9. Click Finish.

10. From the Dept dropdown, choose Housewares.

11. Click the Format Report button on the PivotTable toolbar. Choose any format and 
click OK.

12. Double-click the Sheet 5 tab and name it PivotTable. Then press Enter.

13. Right-click the PivotTable sheet and choose Move or Copy. Choose (move to end) and 
click OK.
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Chapter 8 Scenario Solutions

Scenario 21, Suggested Steps

1. Choose View � Toolbars � Formula Auditing to display the toolbar.

2. Click the Error Checking button. The first error shown is in cell H4. It says Formula 
Refers To Empty Cells.

3. Click the Trace Empty Cell button. It shows an arrow pointing from cell J3.

4. Look at the Formula bar. This formula should be adding the salary in F4 to the Increase 
amount in J2 (not J3). Deduce that J2 should be an absolute amount instead of relative.

5. Select cell H3. Double-click on J2 in the Formula bar. Use the F4 key to make the reference 
absolute. Press Enter.

6. Grab H3 by the fill handle and drag it down to H29.

7. Click the Resume button in the Error Checking box. The next cell selected is G7. It says 
the value in the formula is the wrong data type.

8. Click the Trace Precedents button on the Formula Auditing toolbar. Look at the Formula 
bar. It shows that the formula is trying to multiply D7 by F7 and that D7 contains text.

9. Click the Edit In Formula Bar button in the Error Checking box.

10. Change the D to an E. Press Enter.

11. Click the Resume button in the Error Checking box. The next error is in cell C31. It shows 
that the AVERAGE function is trying to divide by zero.

12. Click the Trace Precedents button on the Formula Auditing toolbar. It shows that the col-
umn being averaged is column D instead of column E.

13. Close the Error Checking box. In the Formula bar, drag to highlight D2:D29. Then, drag 
to select the range E2:E29 on the worksheet. Press Enter.

14. Press Ctrl+G to open the Go To box. Click the Special button. Select Formulas and dese-
lect all boxes except Errors. Click OK. The message presented tells you that there are no 
more errors on the worksheet. Click OK.

15. Close the Formula Auditing toolbar.

Scenario 22, Suggested Steps

1. Select cell F30 and click the AutoSum button. Press Enter. The total is $1,264,900.

2. With F30 still selected, choose Tools � Goal Seek. Set cell F30 to value 1260000 by 
changing cell F22 (which contains the salary for the employee who has only been 
employed one year). Click OK.

3. Note that a solution has been found. Click OK. See that Martha Resnick’s salary has been 
reduced from $18,000 to $13,100.
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4. Click the Undo button to return her salary to $18,000.

5. Select the range F2:F29 and choose Tools � Scenarios.

6. Click the Add button.

7. Name the Scenario Current Salaries and type Salary report based on current salaries in the 
Comment box. Click OK. Then click OK again to accept the current values.

8. Click the Add button again. Name this Scenario Reduced Salaries. Type Salary report 
based on one percent decrease in salaries in the Comment box. Click OK.

9. In the Scenario Values box, click before 33000 in the F2 value and type an = sign. Then 
move to the end of the number using the → key and type *.99 (.99 is the same as 99 per-
cent, which would be a 1 percent decrease).

10. Highlight *.99 and press Ctrl+C to copy it. Move to the next box, type = in front of the 
number, and use the → key to move to the end of the number. Then press Ctrl+V to paste 
*.99 after the number. Repeat this in all of the value boxes.

11. Click OK, then click OK again to confirm.

12. Click the Summary button in the Scenario Manager. Accept the default choices made in 
the Results cells box by clicking OK.

Scenario 23, Suggested Steps

1. Choose Tools � Track Changes � Highlight Changes.

2. In the When box, choose Not Yet Reviewed and be sure Everyone appears in the Who box. 
Click OK.

3. Choose Tools � Track Changes � Accept or Reject Changes.

4. In the When box, choose Not Yet Reviewed and in the Who box, be sure it says Everyone. 
Click OK.

5. Reject the first change because it decreases the price from $50 to $35.

6. Accept the second one that raises $10 to $15.

7. Accept the next one that changes $25 to $35.

8. Accept the next one that changes $5 to $10.

9. Reject the next one that changes $95 to $75.

10. Select cell B2, then Ctrl-click on B4, B6, B8, and B9 to select all the cells containing com-
ments. Click the Delete Comment button on the Reviewing toolbar. (If the toolbar isn’t 
showing, you can also right-click on one of the selected cells and choose Delete Comment.)

11. Choose Tools � Track Changes � Highlight Changes.

12. In the When box, choose All from the dropdown.

13. Select List Changes On A New Sheet.

14. Click OK.

15. Print the History sheet.
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Chapter 9 Scenario Solutions

Scenario 24, Suggested Steps

1. Choose File � Save As and choose Template (*.xlt) as the file type. Type Newsletter 
Signup as the filename. Click Save.

2. Click the Textbox tool and draw a text box above the Signup date. Format the text box 
(I chose blue text with a pale blue gradient background and added a shadow effect).

3. In the text box type this list, pressing Enter after each numbered entry:

1. Complete the form.

2. Save it as <lastname>_newsletter.xls.

3. Email it to subscriptions@email.com.

4. Resize the text box to fit the text.

5. Select F9. Type =today() and press Enter.

6. View the customer numbers on the customer list sheet.

7. Select G1 on the Newsletter Signup Form sheet and choose Data � Validation. On 
the Settings tab, select List from the Allow dropdown choices. In the Source box, type 
110,120,130,140,150,160,170,180,190 and click OK.

8. Choose one of the numbers using the dropdown box in G1 to make sure it works. Delete 
the number from G1.

9. With G1 selected, choose Format � Cells, click the Protection tab, and deselect the 
Locked option.

10. Select the customer list sheet and choose Format � Sheet � Hide.

11. Choose Tools � Protection� Protect Sheet. Type abc in the password box. Select just the 
option Select Unlocked Cells and click OK. Type abc again and click OK.

12. Choose Tools � Protection � Protect Workbook. Choose Structure. Type abc in the pass-
word box. Click OK. Type abc again and then click OK.

13. Click Save to update the template.

Scenario 25, Suggested Steps

1. Close the template if it’s still open from the last scenario. Then use File � New, and select 
the option On My Computer to load the template.

2. Type 150 in cell G1 and press Enter. Note the customer’s last name.

3. Click Save and save the file in My Documents. Type phillips_newsletter in the filename 
box. Click Save.

4. Choose Tools � Protection � Unprotect Sheet. Type abc. Click OK.
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5. Choose Tools � Protection � Unprotect Workbook. Type abc. Click OK.

6. Choose Format � Sheet � Unhide. Choose the customer list sheet and click OK.

7. Right-click the Newsletter Signup Form sheet and choose Delete. Click the Delete button 
in the confirmation box.

8. Choose File � Save As. Click the Tools dropdown and choose General Options. Type abc 
in the Password To Open box. Click OK. Type abc to confirm and click OK again.

9. Type customerlist in the filename box and click Save.

10. Close the file.

11. Choose File � New, and select the option On My Computer. Right-click the Newsletter 
Signup template and choose Delete. Click Yes. Click Cancel to close the Templates dialog box.

Chapter 10 Scenario Solutions

Scenario 26, Suggested Steps

1. Select cell A1 on the Stats sheet and cut it, then paste it in C1.

2. In My Computer, navigate to the folder MOS Scenarios Ch10. Open ZebraTech.doc and 
select the picture. Copy it.

3. Move back into the Excel file and paste it. Drag it to the upper-left corner, resize it so it’s 
about 1  ̋× 1˝. Increase the height of row 1 so the picture doesn’t cover any text in row 2. 
(If necessary, right-click the picture; choose Format Picture; click the Properties tab; select 
Don’t Move Or Size With Cells; click OK.)

4. Close the Word document.

5. In My Computer, open EasternSales.ppt and move to the slide containing the chart (Slide 2). 
Select the chart and copy it.

6. Return to the Excel file. Insert a new sheet. Drag it to the right end. Rename it Chart. Press 
Enter.

7. Paste the slide there. Resize and move as necessary.

8. Close the PowerPoint presentation.

Scenario 27, Suggested Steps

1. Insert a new sheet. Drag the tab to the right end.

2. Rename the tab Structure Settings. Press Enter.

3. Choose Data � XML � Import.

4. Navigate to the MOS Scenarios Ch10 folder and select Chapter 10 Scenario.xml. Click 
the Import button.
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5. Click OK in the box to let Excel create the schema.

6. Make sure the XML is being placed in the Structure Settings sheet in cell A1. Click OK.

7. Click OK in the message box telling you that some data was imported as text.

Scenario 28, Suggested Steps

1. Move to the Jobs sheet.

2. Select A1:A2 and choose Edit � Delete; select Entire Row. Click OK.

3. Adjust the label in C1 to have no spaces. (I made it FullPartTime.)

4. Select A1:D9 and click in the Name box; type Job_Openings. Press Enter.

Chapter 11 Scenario Solutions

Scenario 29, Suggested Steps

1. Choose Tools � Macro � Record New Macro.

2. Name the macro Info; type Shift+Z in the shortcut box; choose This Workbook from the 
dropdown; and type This macro enters my information in the Memo sheet. Click OK.

3. Make sure the Relative Reference button is not selected.

4. Type your name in cell A3; type EZ1210 in B3; and type =today() in D2. Press Enter.

5. Click the Stop Recording button.

6. Choose View � Toolbars � Forms.

7. Choose the command button from the Forms toolbar and draw a box below row 3. 
Release the mouse button.

8. Choose the Info macro when the dialog box opens and click OK.

9. Change the text on the button to Enter Employee Info.

10. Highlight the text and choose Times New Roman, 14 pt., red from the Formatting toolbar.

11. Click outside the button to deselect it.

12. Close the Forms toolbar.

13. Ctrl-click on cells A3, B3, and D2 and select Edit � Clear � All.

14. Click the button to run the macro.

Scenario 30, Suggested Steps

1. Choose Tools � Macro � Macros.

2. Select Info in the list and click the Edit button.
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3. Click in any blank line that begins with an apostrophe. Type a space, then type This 
macro copyrighted by the Memo Co., Inc.

4. Close the VBE.

5. Choose Tools � Macro � Macros.

6. Select the Info macro in the list and click the Options button.

7. Click in the shortcut box and change the Z to an F. Click OK. Click Cancel to close the 
Macros dialog box.

8. Ctrl-click on cells A3, B3, and D2 and select Edit � Clear � All.

9. Press Ctrl+Shift+F to run the macro.

10. Choose Tools � Macro � Macros.

11. Select the Info macro in the list and click the Delete button. Click Yes to confirm.

Chapter 12 Scenario Solutions

Scenario 31, Suggested Steps

1. Right-click on any toolbar and choose Customize.

2. Click on the Commands tab.

3. Select Tools in the Category list, then scroll through the Commands list to find the Protect 
Sheet button.

4. Drag the button onto the Standard toolbar.

5. With the button still selected, click the Modify Selection button.

6. Click Change Button Image and choose the musical note.

7. In the Modify Selection menu, click Image And Text.

8. In the Name box on the Modify Selection menu, delete the contents and type Protect Me.

9. Close the Customize dialog box.

10. Click the button, accept all defaults, and leave the password box blank. Click OK.

11. Hold down the Alt key and drag the button off the Standard toolbar.

Scenario 32, Suggested Steps

1. Unprotect the sheet.

2. Select cells A1:C10 and press the Delete key. Click in cell A1 to deselect the range.

3. Double-click the sheet tab and type Sheet1. Press Enter.
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4. Choose File � Save As and save it as a template in the XLSTART folder. Name it sheet.xlt. 
Click Save.

5. Insert two new sheets.

6. Go to File � Open. Navigate to the XLSTART folder and delete sheet.xlt.

7. Click Cancel to close the Open dialog box.
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3D references

 

When you include a formula that pulls data across multiple worksheets, it’s 
called a 3D reference.

 

Absolute reference

 

An absolute reference to a cell is a static reference that will always refer 
to the same cell.

 

Active cell

 

When you select a cell, it is referred to as 

 

active

 

. This is the cell that will be 
affected by whatever you do.

 

Active sheet

 

Clicking on a sheet tab selects the sheet and presents it on the screen. The 
worksheet displayed is the active sheet.

 

Add-ins

 

These are extra tools included when Excel is installed but not loaded by default.

 

Advanced filters

 

Advanced filters allow you to use criteria from a criteria range to produce 
filtered data in a specified output range.

 

Analysis ToolPak

 

This Excel add-in adds the Data Analysis command to the Tools menu 
and also adds some statistical functions. Included in the data analysis tools are histograms and 
regression analysis.

 

Analysis ToolPak – VBA

 

This add-in is for developers who create modules and functions 
using Visual Basic for Applications.

 

Arguments

 

Within a formula function, the required components are placed within paren-
theses. These are known as arguments.

 

Array-entered formulas

 

These specially formatted formulas perform calculations on arrays 
of data; you must enter them by pressing Ctrl+Shift+Enter.

 

AutoComplete

 

When you’re typing in a cell, if Excel recognizes that you have already typed 
this entry in a previous cell in the same column, it will fill in the cell for you.

 

AutoCorrect

 

Common misspellings are automatically detected and corrected by Excel’s 
AutoCorrect utility. You can also add your own AutoCorrect entries.

 

AutoFill

 

Excel recognizes patterns in your data and will repeat them when you use the fill 
handle. For example, if you type 

 

Monday

 

 in a cell and use the fill handle to drag that cell, Excel 
will AutoFill Tuesday, Wednesday, etc.

 

AutoFilters

 

In Excel, the AutoFilters feature allows you to apply filters quickly based on 
preset filters and lets you create your own custom filters using parameters.

 

AutoFormats

 

These are premade formats included in Excel that can be applied to any 
selected range. AutoFormats include font types, cell background and border colors, and so 
forth. You can apply the complete AutoFormat or use the AutoFormat options to deselect any 
parts of the format you don’t want included.

 

Automatic page breaks

 

When the data in a worksheet exceeds the page margins, Excel will 
insert automatic page breaks, both horizontally and vertically.
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AutoRecover

 

If Excel crashes, the AutoRecover feature will present a recovered copy of the 
file when you launch Excel the next time. You can then choose to save it or delete it.

 

AutoShapes

 

From the Drawing toolbar, you can add different premade AutoShapes, 
including such things as lines, connectors, flow chart shapes, stars, and banners.

 

AutoSum

 

To quickly sum a column of numbers, you can use the AutoSum button, which 
totals the numbers above the active cell.

 

Backgrounds

 

You can apply backgrounds to any worksheet. Backgrounds are picture files 
and only appear onscreen; they do not print.

 

Bitmap

 

This is a graphic term. Bitmap fonts are graphic, nonresizable fonts.

 

Book.xlt

 

When you want to replace your default new workbook with a template of your 
choice, you must name the template book.xlt and save it into your XLSTART folder.

 

Border

 

All cells have four borders, or outside edges. Borders are shared by adjacent cells, so 
formatting a bottom border on a cell would also format the top border of the cell below it.

 

Category axis

 

In Excel charts, this is the axis that displays the labels from the data. Most 
typically, it is the X axis.

 

Cell address

 

Cells are identified by the intersection of the column and row where the cell 
resides, like the entries on a road map. For example, the cell in column D in row 10 has a cell 
address of D10.

 

Cell alignment

 

In cells, you can align the data to the left or right of the cell, or center the data 
in the cell. By default, text is left-aligned and numbers are right-aligned, but you can change 
the alignment manually to override the defaults.

 

Cell formatting

 

Formatting in Excel includes a lot more than color and style. Cell formatting 
allows you to configure cells as currency, telephone numbers, and percentages. Also included, 
as part of cell formatting, are security formats such as locked and hidden.

 

Cell management

 

The process of copying, moving, removing, and formatting complete cells 
is known as cell management.

 

Cell references

 

When a cell address is referred to in a formula, it’s called a cell reference.

 

Cells

 

In a worksheet, the individual boxes that can accept data are called cells.

 

Center Across Selection

 

This alignment option lets you select a range of columns and display 
the text from one cell, centered across this range. It is not to be confused with the Merge & 
Center command, which combines the data into one cell.

 

Chart Area

 

Charts include many different areas, which can be formatted individually. The 
Chart Area is the background area of the entire chart.
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Charts

 

Charts provide a graphic representation of data comparisons. Excel lets you set up 
different chart types: bar, column, pie, line, and many more.

 

Clip art

 

Generally clip art refers to line drawings, but Excel’s Clip Art Gallery also includes 
photographs, movies, and sounds that can be added to any worksheet.

 

Collate

 

Select the Collate checkbox when you want to print multiple copies of multiple pages 
and put them in the proper sequential order.

 

Column headers

 

At the top of every column in a worksheet is a header that contains the 
letter(s) identifying the column name.

 

Columns

 

Columns refer to the vertical arrangement of cells in a worksheet. A worksheet can 
contain up to 256 columns of data.

 

Combination chart

 

When you want to plot comparisons between two different data range 
types, a combination chart allows you to plot each range using a different chart type.

 

Command button

 

You insert this button using the Forms toolbar; it allows you to link it to 
a macro.

 

Commands

 

The items listed in any menu are called commands and will perform a specific 
action when selected.

 

Comments

 

Comments are informational or instructional notes that you can add to any cell.

 

Compare Side by Side

 

New to Excel in version 2003, this feature allows you to view mul-
tiple workbooks side by side within the Excel window and includes a toolbar with scrolling 
choices.

 

Compression

 

Most commonly used with graphic files, compression reduces the file size.

 

Conditional formatting

 

This utility in Excel allows you to apply formats to cells that meet 
certain conditions you supply.

 

Conditional Sum Wizard

 

This is an Excel add-in that helps you create formulas that sum 
ranges based on criteria you supply.

 

Contiguous

 

Cells that are adjacent to one another and share side, top, or bottom borders are 
contiguous.

 

Converters

 

In order to be able to open a file created in another program, you must use con-
verters to put the data in a compatible format.

 

Criteria range

 

This is a named range you create to include the criteria used in an advanced 
filter.

 

Cropping

 

Cropping removes parts of the image to only show one section, as opposed to 
resizing, which reduces the visual size of an image.

 

Custom AutoFilters

 

When the standard AutoFilters don’t give you what you need, you can 
use custom AutoFilters to set up your own criteria and parameters.
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Custom dictionary

 

When you choose to add words to your dictionary during a spellcheck, 
they are added to a file named custom.dic and will no longer be flagged as spelling errors.

 

Custom formats

 

When the premade cell format options don’t give you what you want, you 
can make your own custom formats to include text, numbers, font colors, and so forth.

 

Custom lists

 

When you create a new series of values to be used by the AutoFill feature, it is 
stored in your custom lists.

 

Custom views

 

This feature lets you set up your workbook view, then save it so you can use 
it again at a later time. You can include multiple custom views within a workbook so you can 
easily switch between them.

 

Data

 

Data is a broad term used to refer to anything typed into a cell.

 

Data Consolidation

 

This utility allows you to quickly pull data from multiple worksheets to 
produce totals, counts, and averages in a consolidation sheet.

 

Data management

 

The process of adding, editing, copying, moving, and deleting cell con-
tent is known as data management. Data management consists of three modes: Ready (before 
you’ve done anything in a cell), Enter (when you first add something to a cell), and Edit (when 
you change the content of a cell). The modes are identified on the Status bar at the bottom of 
your screen.

 

Data map

 

Using XML technology, the pattern of data represented in any worksheet is called 
a data map.

 

Data table

 

When you produce a chart in Excel, you can include the data table in your chart 
display. This table shows all the data used to produce the chart.

 

Data Validation

 

This utility allows you to control the data input by users. You can provide 
information to influence their input, warn them that their input is outside accepted parame-
ters, or totally restrict their input to what you want. You can also use the Data Validation fea-
ture to produce dropdown lists including the choices you will allow.

 

Database

 

Though this term is usually applied to relational database files created in pro-
grams like Microsoft Access, Excel also allows you to create flat databases. A database is 
merely an organized body of related data.

 

Database functions

 

These functions use mathematic and statistical equations to pull data 
from specified fields in a database, based on conditions you supply.

 

Date and Time functions

 

This set of functions performs calculations based on time spans.

 

Default printer

 

When you click the Print button on the Standard toolbar, you print to your 
default printer. If your computer has access to more than one printer and you want to use one 
other than the default, you must use the Print command in the File menu so you can choose. 
Your default printer is determined in your Windows settings.

 

Default settings

 

These are the settings in Excel when it is first installed, before you have 
applied any customizations.
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Dependents

 

Dependents are formulas that contain references to the active cell and therefore 
depend on its content.

 

Diagram Gallery

 

New to Excel in version 2003, this gallery allows you to choose different 
types of diagrams to include in your workbook: organization charts, radial diagrams, and pyr-
amid diagrams, to name a few.

 

Drawing toolbar

 

The Drawing toolbar is usually displayed at the bottom of the Excel 
window. It includes buttons for adding and formatting shapes, pictures, and diagrams.

 

Dynamic data

 

Dynamic data is data that automatically updates when something else changes.

 

Error alert

 

This is the part of data validation that determines the level of control you want 
over the input.

 

Error Checking

 

This command, accessed from the Tools menu, walks you through formulas 
to help determine the cause of any error.

 

Esc key

 

When you’re editing the content of a cell, pressing the Esc key on the keyboard will 
revert the cell to its original content.

 

Euro Currency tool

 

This add-in helps with converting foreign currency amounts.

 

Field codes

 

In Excel, field codes are used by the Custom Header and Footer buttons to insert 
dynamic data.

 

Fields

 

In a database, the column heading labels are referred to as fields.

 

File protection

 

This type of protection lets you control who can open or edit a workbook.

 

Fill effects

 

Things like AutoShapes and chart objects in Excel can be filled with colors or, for 
a more dramatic look, you can use fill effects. Fill effects include gradient fills, patterns, tex-
tures, and pictures.

 

Fill handle

 

When a cell is active, it includes a small black box in its bottom-right corner. 
Known as the fill handle, it can be used to copy cell content or fill a series (Sunday, Monday, 
Tuesday or 10, 20, 30, for example).

 

Filters

 

Filters are used when you want to limit the display of data to meet certain criteria.

 

Financial functions

 

This set of functions performs calculations to show things like interest 
amounts and returns on investments.

 

Find and Replace

 

This utility allows you to find one word, phrase, or type of formatting and 
replace it with another.

 

Fixed decimal places

 

If you choose this option, whatever number you type will be con-
verted to this number of decimal places. For example, choosing 2 fixed decimal places would 
convert 5, when typed in a cell, to .05.

 

Flat database

 

A flat database is a database that must pull all of its information from one 
table (or worksheet).
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Font attribute

 

Font attributes include bold, italic, and underlined.

 

Font color

 

When formatting the text in cells, you can use the font color choices to change the 
color of all of the text in a cell or any selected text within a cell.

 

Font effects

 

Font effects are special font formats that can be applied to any selected text. 
They include strikethrough (crossed out), subscript (lowered), and superscript (raised).

 

Font formatting

 

This term applies to any changes made to the font style, type, size, or color 
of any selected text.

 

Font size

 

Font sizes can be adjusted by changing their point size. 72 points equals one inch.

 

Font style

 

In Excel, the term 

 

font style

 

 refers to the attributes applied to a font type.

 

Font type

 

This term refers to the name of the font: Arial, Times New Roman, and so forth.

 

Footers

 

Footers include data at the bottom of every page in a worksheet and appear only in 
Print Preview or when printed.

 

Format Painter

 

This Excel tool allows you to copy the formatting from one cell and paste 
it into another. It does not copy the data but only the formatting.

 

Formatting toolbar

 

One of the toolbars that appears onscreen by default, the Formatting 
toolbar includes buttons for the most commonly used formatting commands (such as font 
attributes, text alignment, and cell fill color).

 

Formula

 

Formulas are mathematical equations and can range from simple addition, totaling 
the contents of one or more cells, to intricate calculations using functions.

 

Formula bar

 

Below the toolbars and above the column headers, the Formula bar is a white 
box that displays the true content of the active cell. Data editing can be done in this bar, as an 
alternative to editing directly in the cell.

 

Formula printout

 

Using procedures to display formulas, along with gridlines and row and 
column headers, you can print a Formula printout that shows the actual formulas instead of 
the results of the formulas.

 

Freeze Panes

 

This command in the Window menu prevents columns or rows from moving 
offscreen when you scroll.

 

Function

 

A function is a named calculation that includes the necessary arguments to per-
form specific actions.

 

Global settings

 

The settings that affect all workbooks, as opposed to just the active work-
book, are termed global.

 

Goal Seek

 

This tool lets you use what-if analysis to see how values must change to reach a 
specific goal.

 

Gradient

 

One of the fill effects choices in Excel, gradients are combinations of color ranges 
that blend from one to the other.
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Gridlines The pale lines that define the cell borders are known as gridlines. By default, grid-
lines do not print but only appear onscreen to make cell definition more obvious.

Group and Outline This command lets you organize data in a hierarchical fashion with out-
line levels that can be expanded and collapsed to change the display.

Grouped sheets Many features in Excel are applied only to the active sheet. To make more 
than one sheet active at a time, you must group them. Both adjacent and nonadjacent sheets 
can be grouped.

Header row This refers to the top row of labels above the value data in any range.

Headers Headers include the data at the top of every page in a worksheet, and appear only 
in Print Preview or when printed.

Hidden format When protecting your worksheets, you can choose the hidden format for 
cells containing formulas to prevent users from seeing your formulas in the Formula bar.

Horizontal alignment This form of alignment determines where the data is displayed 
between the left and right cell borders.

Horizontal page break A page break that spans across columns, a horizontal page break is 
inserted between rows.

HTML Short for Hypertext Markup Language, HTML is a programming language used to 
produce web pages.

Hyperlinks Hyperlinks are shortcuts that, when clicked, will take you to another file, 
another place in the current file, or an Internet website; they may even launch an email 
addressed to a specific person.

I-beam When in Edit mode in a cell, the mouse pointer appears as an I-beam, which indicates 
the insertion point where whatever you type will be added.

Inactive sheets Any sheet tabs you see at the bottom of your workbook that do not repre-
sent the sheet showing onscreen are inactive, unless the sheets are grouped, which makes them 
all active.

Information functions This set of functions supplies information about a file or computer 
configuration.

Input message This is the part of data validation that controls the message you want users 
to see defining their input.

Insertion point The place in a cell where your mouse pointer is located, when in Edit mode, 
is known as the insertion point, meaning whatever you do will be executed at this spot.

Interactivity When you save a worksheet or workbook as a web page, you can add interac-
tivity so people can manipulate the data on the page.

Internet Assistant VBA An add-in for Excel made for VBA programmers to publish Excel 
data to the Web by using Internet Assistant syntax.
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Iteration Iteration means loop, and in Excel, it refers to the loops made when a cell must be 
recalculated.

Labels Any data in your worksheet that does not represent actual values is referred to as a 
label. For example, in an expense sheet, the category names across the top of the sheet would 
be the labels, with values listed below them.

Landscape One choice for page orientation, landscape prints your data across the wider part 
of the paper.

Legend In a chart, a legend identifies the individual plotted series of data.

Linking Whenever a formula, chart, or data is referencing a source outside the workbook for 
dynamic updates, the workbook is linking to the external source.

List range A range of data used as a database table.

Locked cells By default, when you protect a worksheet, all cells are locked so no one can edit 
the content. You must unlock the cells to allow changes.

Logical functions This set of functions performs calculations based on cause and effect and 
answers what-if types of questions.

Lookup functions This set of functions searches a table array for specified values and 
returns a related value from a different location in the array.

Lookup value In a lookup function, the lookup value is the value you are searching for in the 
table array.

Lookup Wizard This Excel add-in gives you an alternative wizard made especially for cre-
ating lookup formulas.

Macro A macro is a shortcut that performs a series of steps with the press of a keystroke 
combination or the click of a button.

Macro recorder This Excel tool makes it easy for you to walk through the steps of any pro-
cedure while recording those steps to produce a macro.

Macro Security You can set your Macro Security level from Low to Very High, depending 
on what types of macros you want to be able to use.

Manual page breaks When you want to tell Excel exactly where to start a new page, insert 
a manual page break by clicking and dragging in Page Break Preview.

Margins The areas of a page outside of the printable area are called margins. Excel lets you 
set top, bottom, left, right, header, and footer margins.

Marquee When you copy cell content or formatting to the Clipboard, a moving border 
appears around the copied cell. This is known as a marquee (though many people refer to it 
as “marching ants”). To remove it, simply press the Esc key.
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Math & Trig functions Math & Trig functions range from simple mathematical calcula-
tions, like summing numbers and rounding them off, to advanced trigonometry calculations.

Menu animations Menu options can be adjusted to change the way menus appear, or 
“animate.”

Menu bar Located below the title bar, the menu bar includes the names of all of Excel’s 
menus (File, Edit, View, etc.). When clicked, the menus expand to reveal commands.

Merge This command allows you to compile the data from multiple versions of the same 
workbook into one merged copy.

Merge and Center This alignment option merges selected cells into one cell and centers the 
data in this cell. Merged cells have some limitations, so this feature should be used with caution.

Named cells You can select any cell and use the Name box to name it, then use that name 
to reference it in formulas or as a bookmark to move to the cell quickly.

Named constants You can name any value as a constant, and then use the name in a for-
mula reference in place of the value the name represents.

Named ranges Named ranges are used when you want the range reference in formulas to 
always remain absolute.

Nested functions When one function is included within another, it is referred to as a nested 
function.

Noncontiguous Cells that are not adjacent to one another are noncontiguous.

Normal view When adding or editing data, the worksheet view you see onscreen is termed 
Normal view.

Office Clipboard When you copy or cut more than one block of data, you can use the Office 
Clipboard to store it for pasting later. This works not only in Excel but also between the var-
ious Office programs. The Clipboard stores up to 24 blocks of data at one time.

Office Dictionary This is the shared dictionary that is used for spellchecking any file made 
using any Office program.

OLE Short for Object Linking and Embedding, this technology links inserted objects to the 
server application that created them.

Operators Operators are the characters you type in a formula to tell Excel what calculation 
you want it to perform. Examples include plus (+), minus (-), and multiply (*), among others.

Option button When performing certain operations in cells, an option button appears adja-
cent to the cell. When clicked, the button opens a shortcut menu. Option buttons can reveal 
formatting choices, error alerts, copy options, and more.

Order of precedence This is the rule that dictates the order in which formula operators are 
applied.
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Organization chart This diagram type displays data in a hierarchical tree-type view, with 
subordinate data shown in boxes below upper-level data.

Output range A named range you create to hold the results of an advanced filter.

Page Break Preview This view in Excel allows you to see both automatic and manual page 
breaks. Manual page breaks can be adjusted here by dragging them with the mouse pointer.

Page Setup This dialog box is used to control how your page is laid out for printing.

Parent function This is a function that uses another function as one of its arguments.

Paste Special When you want more pasting choices, the Paste Special command in the Edit 
menu offers them. Excel’s Paste Special dialog box includes many options such as pasting only 
values (without formulas), transposing (pasting data listed in columns as listed across rows 
instead), and skipping blanks (to paste only the cells in a range that contain data).

Patterns One of the fill effects choices in Excel, patterns are dots and lines to which you can 
apply color.

Personal Macro Workbook When you record a macro and choose to store it in your per-
sonal workbook, the macro will be available to you in all workbooks. The Personal Macro 
Workbook is a hidden file named personal.xls, which is stored in your XLSTART folder.

Picture toolbar When you insert or select a picture (JPEG, GIF, BMP, etc.) in Excel, you can 
use this toolbar to adjust some of the picture’s formatting and settings.

Pivot charts Similar to Pivot tables, this chart type allows for manipulations by pivoting 
the data.

Pivot tables Pivot tables allow you maximum control over the relational layout of your 
data, letting you control what parts you want displayed in rows or columns.

Plot Area Not to be confused with the Chart Area, the Plot Area is the background of the 
plotted data area within the Chart Area and not the entire chart.

Portrait One choice of page orientation, portrait prints your data across the narrow part of 
the paper.

Precedents Precedents are the cells referenced in a formula.

Precision As Displayed This setting overrides formulas and cell formats related to decimal 
places, and replaces what you see in the Formula bar with what is displayed in the cell. It is 
irreversible.

Primary sort When sorting data, Excel lets you sort by up to three columns at a time. The 
column you select from the top dropdown list in the Sort dialog box is the Primary sort, which 
will be executed first.

Print area In Excel, you can select a range and set it as a print area so it will be the default 
area printed every time you print the worksheet.
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Print dialog box This dialog box controls which pages are printed and how, as well as which 
printer is used.

Print Preview Before printing, you can preview how the worksheet will print. Print Preview 
is governed by the printer driver you have installed; therefore, if you have no printer, you 
won’t have Print Preview available to you.

Printer Properties In the Print dialog box, you can click the Properties button to get to the 
properties for your specific printer to make adjustments for printing a worksheet. If you have 
no printer installed, the Properties button will not be available.

Publish When you save an Excel file for the Web, you can then use the Publish command to 
post the page on a website or network.

Range Range is the term applied to any block of cells. In Excel, a range is designated or 
named by showing the first cell in the range, then a colon (:), then the last cell in the range. For 
example, the range of cells that starts at cell A1 and continues down and to the right to cell 
E5 would be called A1:E5.

Records In a database, the values shown across rows, under column labels, are referred to 
as records.

Reference functions This set of functions lets you cite information in another location and 
return that information to your spreadsheet.

Relational database This type of database includes multiple tables joined by related fields.

Relative reference When a cell reference is dynamic and updates based on its location, it is 
a relative reference.

Remote references Remote references are any external files that have links referring to the 
active workbook.

Research Library This library, available via the Research task pane, includes a set of tools 
used by all the Microsoft Office programs, including a dictionary, a thesaurus, a translation 
utility, and an Internet encyclopedia.

Row headers At the left end of every row in a worksheet is a row header, which contains the 
number that identifies the row name.

Rows Rows refer to the horizontal arrangement of cells in a worksheet. A worksheet can 
contain up to 65,536 rows of data.

Scaling You can use Page Setup to adjust the scaling of the worksheet size for printing. You 
can choose to scale it to a certain percentage of the original size or scale it to fit a certain 
number of pages.

Scenario Summary Report Once you have created scenarios, you can quickly create this 
report, which shows a clear comparison between them.

4002book.fm  Page 454  Friday, March 24, 2006  11:36 PM



Glossary 455

Scenarios Scenarios give you a way to view the same data under various conditions. Sce-
narios can be saved and compared.

Schema Using XML technology, a schema is the document that defines the structure of a set 
of XML files. The schema is stored in a file with an .xsd extension.

Scrollbars When the data in a sheet cannot be fully displayed in one screen view, the horizontal 
and vertical scrollbars allow you to move data onscreen. Scrollbars include three elements: scroll 
arrows, the scroll bar, and the scroll box.

Secondary axis When you are plotting data in a chart and the data includes significantly dif-
ferent parameter ranges, you can apply part of the data to a secondary axis so it is better 
displayed on the chart.

Secondary sort When sorting data, Excel lets you sort by up to three columns at a time. The 
sorts are performed in the order you choose in the dialog box. Any sort that is secondary to 
a previous one listed will be performed only if the previous sort includes exact duplicates.

Serial number In order for Excel to calculate dates and times properly, it assigns them 
unique serial numbers.

Series In Excel, the term series refers to the range of data used to produce one bar or column 
in a chart.

Sheet This is the more commonly used term to refer to a worksheet in Excel.

Sheet.xlt When you want to replace the default worksheet you get when you insert a new 
sheet into a workbook, you must create a template, name it sheet.xlt, and save it in your 
XLSTART folder.

Solver This add-in is similar to Goal Seek, but it allows you to add constraints to the what-
if analysis used.

Sort To organize data in alphabetical, numerical, or chronological order, you sort it, either 
in ascending or descending order.

Source data This is the underlying data used when producing a chart.

Split When you want to view two different areas of your worksheet onscreen at the same 
time, you can apply a split from the Window menu. The split is applied to the left and above 
the active cell.

Spreadsheet Solutions In the Templates dialog box, the Spreadsheet Solutions tab contains 
the premade templates supplied by Microsoft.

Standard toolbar One of the toolbars that appears onscreen by default, the Standard 
toolbar includes buttons for the most commonly used file management and editing commands, 
including Open, Save, Print, Copy, and Paste.

Static data As opposed to dynamic data, static data remains the same no matter what else 
happens.
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Statistical functions This set of functions produces comparative statistics, such as counts, 
averages, and maximum values.

Status bar The status bar appears, by default, at the bottom of the Excel screen and reveals 
the data management mode for the active cell. You can right-click the Status bar to see preview 
calculations for any selected range.

Styles When you make a series of changes in the Format Cells dialog box, you can name this 
formatting collection and save it as a style so you can use it again.

Subtotals The Subtotals command quickly gives sums or averages of one column based on 
changes in another.

Tab scrolling buttons These are the buttons to the left of the sheet tabs that you can click 
to move through the sheets when you have so many tabs that you can’t view them all at one time.

Table array This is the term used to refer to a data range in a lookup function.

Task pane A pane that appears on the right side of the Excel screen, the task pane (intro-
duced in Office XP) gives you another way to find some commonly used features.

Templates When you use the File � New command, you are using templates, which are 
simply a collection of premade data and formats that can be used to produce a new workbook.

Text functions This set of functions controls text formatting and allows you to quickly 
change large ranges of data from one case to another, such as upper case, lower case, and 
proper case.

Title bar This is the bar at the top of the Excel screen that shows the program name and file-
name and includes the minimize, maximize, and close buttons for the program window.

Tooltips When you rest your mouse pointer over buttons and some object elements, a tooltip 
appears to identify the button or object.

Track Changes When you share workbooks so multiple users can work on them at the same 
time, Track Changes lets you see each user’s changes in different colors and then allows you 
to accept or reject those changes.

Trendline On a chart, you can add a trendline to forecast what the future may look like, 
based on the current data.

True type This class of fonts is WYSIWYG (what you see is what you get), meaning these 
fonts appear exactly the same way onscreen as they will when printed.

Undo button On the Standard toolbar, this button, which looks like a curved arrow 
pointing to the left, lets you undo your last action. There is also a dropdown arrow to the right 
of this button, which allows you to go back more than one step. Once you’ve undone some-
thing, an arrow curving to the right appears to let you redo what you undid. There’s also an 
Undo command in the Edit menu.

Value axis In Excel charts, this is the axis that displays the values from the data. Most typ-
ically, it is the Y axis.
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Values This is the term used to refer to the meat of your workbook data. For example, in an 
expense sheet, the category names across the top of the sheet would be the labels and the actual 
amounts listed below the labels would be the values. Values can be text or numbers.

VBA Visual Basic for Applications (VBA) is the programming language underlying macros 
and other advanced procedures used in the Office programs.

Vertical alignment This form of alignment determines where the data is displayed between 
the top and bottom cell borders.

Vertical page break A page break that spans across rows, a vertical page break is inserted 
between columns.

Visual Basic Editor To edit the code behind a macro, you must use this editor, which is 
launched when you click the Edit button in the Macros dialog box or by pressing Alt+F11.

What-if analysis This type of analysis asks the question, “What if this changed? What else 
would have to change?”

Windows Clipboard When you copy or cut anything, it is placed on your Windows Clip-
board, an area of memory used to hold data until it is pasted. The Windows Clipboard (as 
opposed to the Office Clipboard) can hold only one block of data at a time. The data will 
remain in the Clipboard until 1) something else is cut or copied to overwrite it, 2) it is manually 
cleared, or 3) Windows is shut down.

Workbook When an Excel file is saved, by default, it will be saved as a Microsoft Excel 
Workbook (*.xls). The entire file is referred to as a workbook, and it can include multiple 
worksheets.

Workbook protection Workbook protection protects the workbook structure and window 
layouts from being changed. It does not protect the data.

Workgroup When multiple users share a workbook, they are referred to as a workgroup.

Worksheet Within an Excel workbook or template, you can have many worksheets (com-
monly referred to as sheets). Each sheet includes a sheet tab that appears at the bottom of the 
workbook. The number of sheets allowed in any workbook is restricted only by the amount 
of memory your computer has to handle them. The more sheets in a workbook, the more 
memory needed to open the workbook.

Worksheet protection Worksheet protection protects your data so no one can change it.

Workspace When viewing multiple workbooks onscreen simultaneously, you can save this 
view as a Workspace (*.xlw) file so you can use it again. Changes made to the files in the work-
space will also appear in the individual files, and vice versa.

Wrap text By default, when you type in a cell, all of the text is displayed on one line. The 
wrap text formatting option allows you to format the cell so the text drops to the next line 
when it reaches the set width of the cell. You can also wrap any individual line by pressing 
Alt+Enter at the end of the line.

4002book.fm  Page 457  Friday, March 24, 2006  11:36 PM



458 Glossary

XLSTART When you want something to load every time you start up Excel, you must put it 
in the XLSTART folder.

XML Extensible Markup Language (XML) is a newer programming technology that is con-
tent based, meaning that it tells a web browser how to display the data.

Zoom control This feature lets you increase or decrease the magnification of your screen 
view of a worksheet. This will not affect the size of the data when it is printed.
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cropping, vs. resizing, 73
CSV files, 343
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curly brackets ({ }), for array-entered formulas 
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Currency Style button (Formatting toolbar), 47
current date, function for, 174
cursor movement after Enter key press, 411
custom AutoFilters, 104–105
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custom dictionary, adding word, 135
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for AutoFill, 145
time savings from, 142
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Custom Views dialog box, 112
CUSTOM.DIC file, 418
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left column labels when, 239
static consolidation sheet, 237

linking, 240–247
broken links, 244–246
linked data in formulas, 242–244
phantom links, 246–247
simple links to external data, 240–242

selection for pivot table, 249
sharing, 294–301
summarizing, 230–236

outlining, 231–234
subtotals and outlining together, 234–236

Data Connection Wizard, 355, 355
data entry

of statistical functions, 166–168
for time, 172

data in, 341–356
alternative methods, 346–356

importing data into worksheet, 354–356
inserting objects, 352–354
moving and copying data, 347–352

opening different file types, 341–346
CSV files, 343–344
DOC files, 344
HTM files, 345
JPEG files, 345
MDB file, 345–346
PPT file, 346
WK4 file, 346
XML file, 346

data management, 12. See also organizing 
data

copy and paste, 29–31
cut and paste, 31–32

data map, 367
Data menu, 86
� Consolidate, 237
� Filter
� Advanced Filter, 218
� AutoFilter, 103
� Show All, 104

� Group And Outline, � Auto Outline, 233
� Import External Data, 354
� Import Data, 354, 355–356

� List, � Create List, 216
� Sort, 101
� Subtotals, 231
� Validation, 315, 317
� XML, � Import, 356

data out, 356–367
importing and inserting worksheets into other 

file types, 365–366
moving and copying data, 357–360
saving and editing in different formats, 

360–365
HTML files, 362–365
text files, 360–362

saving workbook structure with XML, 
366–367

Data Table button (Chart toolbar), 83
data validation, 306

in templates, 315–320
Data Validation dialog box

Error Alert tab, 315–316, 317
Input Message tab, 315, 316
Settings tab, 315, 316, 317

database, for named ranges, 218
database functions, 215–222
date

field code for, 119
headers and footers for printing, 117

date and time functions, 170–174
Date cell format, 53
dates and times

calculating, 172–174
custom formats for, 262–264
functions for current, 174

DAVERAGE function, 220
days of week

AutoFill for, 144
formatting to display, 262

DCOUNTA function, 221
Decrease Decimal button (Formatting 

toolbar), 47
Decrease Indent button (Formatting toolbar), 47
Default File Location, 412
default printer, 124
default settings in Excel, 397
default workbooks, 420–422

restoring original, 422–423
default worksheets, 420, 422

restoring original, 422–423
Define Name dialog box, 199, 199, 204, 204
definitions, finding, 149
Delete All Ink Annotations button (Reviewing 

toolbar), 299
Delete Comment button (Reviewing toolbar), 299
deleting, 90

book.xlt file, 423
buttons from toolbars, 404–405
cells in worksheet, 16, 16
comments, 154
custom lists, 146
items from Office Clipboard, 38
rows or columns, 20–21
scenarios, 290
sheet.xlt file, 423
space, 152
template folders, 322
templates, 321
worksheets, 26–27

dependents of cell, 280, 280
DGET function, 220
Diagram Gallery, 75, 75
diagrams, adding and editing in worksheet, 

75–78
dictionary. See Spelling tool
digital signatures, 419
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directional movement of text, 416
directories. See folders
#DIV/0! error value, 275, 280
division, 161
DMAX function, 221
DMIN function, 220
DOC files, 343

opening, 344
docking toolbars, 5
Document Updates task pane, 7
dollar sign ($)

for absolute ranges, 80
for absolute reference, 194–195, 195

domino effect for error fixes, 281
drag and drop

Allow Cell Drag and Drop setting, 411
for bringing data in, 350–351
to get data out of Excel, 359–360
with mouse, 38–41

dragging
formulas, 181, 182
to select range for function argument, 170

Draw button (Drawing toolbar), 65
Drawing toolbar, 65–69

Insert Picture from File button, 71
modifying shapes with, 68–69

drop-down lists
adding to template cells, 315
for Formatting toolbar buttons, 47

DSUM function, 220
duplicates, advanced filters to remove, 220
dynamic consolidation sheet, 236, 236

with 3D references, 238–239
dynamic data, in headers and footers, 117, 

119–120

E
Edit Directly In Cell setting, 411
Edit Links dialog box, phantom links and, 

246–247
Edit menu
� Clear, 21
� Copy, 30
� Cut, 31
� Delete
� Entire Column, 152
� Entire Row, 90

� Delete Sheet, 26
� Fill
� Across Worksheets, 184
� Series, 145

� Find, 12, 246, 279
� Go To, 12, 278
� Links, 294

grayed out, 246

� Office Clipboard, 36
� Paste, 30
� Paste Special, 294
� Column Widths, 33
� Transpose, 214

� Replace, 138
Edit mode, Esc key in, 14
Edit Scenario dialog box, 288, 288
editing

comments, 154
data for charts, 88–91
macros, 379–382
named ranges, 201–202
templates, 307

existing, 308–311
editing tools, 132–152

AutoCorrect, 135–137, 136
automated features for accuracy and consis-

tency, 142–146
AutoComplete and Pick from Drop-Down 

List, 143–144
AutoFill and custom lists, 144–146

converting text to columns, 150–152, 151
exam essentials, 157
Find and Replace, 137–142, 138

for formatting, 141–142
with wildcards, 140–141

Research task pane, 146–150
finding definitions, 149
finding synonyms, 147–149
Internet encyclopedia, 149–150
translating text, 150

Spelling tool, 132–135, 133
email address, as hyperlink, 156
embedded objects, 351
employees, and file control, 334
empty cell, "" for, 182
encyclopedia

Encarta Encyclopedia, 150
Internet, 146–147, 149–150

End key, 12
End Review button (Reviewing toolbar), 299
Enter key

cursor movement after, 411
for data entry, 14
to move between cells, 13

Enter mode, Esc key in, 14
equal sign (=), to start formula, 162
Error Checking dialog box, 277, 277
error checking, options for, 417, 417
Error Checking Rules list, 278
error messages, 198

“formula in this worksheet contains one or 
more invalid references,” 90

from named range, 197
“Error: Source not found” message, 245
errors. See troubleshooting formula errors
Euro Currency tools, 293
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464 Evaluate Formula dialog box – Format menu

Evaluate Formula dialog box, 284, 284
Excel

add-ins, 291–294
“advanced user,” 180
interface. See user interface
opening, 2
startup, add-ins and, 292

Excel file. See workbooks
expandable/collapsible outline, 231–234, 233
exponentiation, 162
Extensible Markup Language (XML), 340. See 

also XML file
external data, simple links to, 240–242

F
field codes

for dynamic data, 118–119
in templates, 314–315

Field Settings button (PivotTable toolbar), 252
fields, 215
file extensions, displaying, 341
File menu
� Add Clips to Organizer, 70
� Close, 29
� Exit, 29
� New, 93, 309

and templates, 307
� Open, 93

and data format conversion, 341
� Page Setup, 116, 154, 190
� Print, 124
� Print Area
� Clear Print Area, 126
� Set Print Area, 125

� Properties, 324
� Save As, 27, 28

for templates, 312
� Save As Web Page, 363, 363
� Save Workspace, 111

file protection, 323
file types, 343

opening different, 341–346
saving files in different, 360–365

filenames
field code for, 119
headers and footers for printing, 117

files, saving in different formats, 360–365
Fill Color button (Drawing toolbar), 66
Fill Color button (Formatting toolbar), 47
fill color for cells, 52
fill effects, 84
Fill Effects dialog box, 87
fill handle, 145, 145

on cell, 39, 39
filters, 102

advanced, 217–220
realistic use, 219–220

AutoFilters, 102–105

financial functions, 174–179
Find and Replace, 137–142, 138

for formatting, 141–142
to search for errors, 276, 276, 279
with wildcards, 140–141

finding
definitions, 149
formula errors, 276–280
links in workbook, 246–247
synonyms, 147–149

first cell with data, moving to, 10
Fixed Decimal Places setting, 410
flat databases, 215
floating toolbar, 5

from Formatting toolbar submenus, 47, 48
folders

creating
in Save As dialog box, 28
for templates, 321–322

creating for templates, 321–322
default for saving files, 412
XLSTART, for default files, 420

Font button (Formatting toolbar), 47
Font Color button (Drawing toolbar), 66
Font Color button (Formatting toolbar), 47
font size, 48
Font Size button (Formatting toolbar), 47
font style, 48
font type, 48
fonts, 48–51

for charts, 85
Find and Replace for, 141–142
Format Cells dialog box to change, 50–51
Formatting toolbar to change, 49–50

Footer dialog box, 120
footers, 117–121
Format Axis dialog box, 85
Format button (Chart toolbar), 83
Format Cells dialog box, 46

Alignment tab, 55–57
Border tab, 57–58
choices, 52–55
Custom tab, 258, 259
and date and time display, 170
Font tab, 50–51
Number tab, 53–54, 54, 258
Patterns tab, 57, 59
Protection tab, 327, 328

Format Chart Area dialog box, 85
Format Data Series dialog box, 86
Format dialog box, Borders tab, 266
Format menu
� Cells, 46, 50, 167, 172, 173
� Column
� Autofit, 20
� Hide, 22, 318
� Standard Width, 20
� Unhide, 22

� Conditional Formatting, 265
� Object, 68
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Format Picture button – grouping worksheets 465

� Picture, 74
� Row
� Autofit, 20
� Height, 20
� Hide, 22
� Unhide, 22

� Selected Data Series, 257
� Sheet
� Background, 64
� Unhide, 318, 330
grayed out options, 330

for modifying shapes, 68–69
Format Picture button (Picture toolbar), 72
Format Picture dialog box, 74
Format Report button (PivotTable toolbar), 252
formatting

conditional, 258, 265–268
custom, 258–264
exam essentials, 94–95
Find and Replace for, 141–142
for new rows or columns, 20
new template, 311–313
shortcuts, 59–62

Format Painter, 61–62
styles, 60–61

and templates, 92–94
worksheets, 62–65

with AutoFormats, 62–64
backgrounds, 64–65

Formatting toolbar, 3, 4, 46–47, 154
for cell formatting, 51–53
to change font formats, 49–50

forms, for adding, changing and finding data in 
list, 216–217

Formula Auditing toolbar, 5, 277
Error Checking button, 279
Evaluate Formula button, 281
Trace Dependents button, 280, 280, 282
Trace Error button, 283
Trace Precedents button, 280, 280, 282
Watch Window button, 281

Formula bar, 3, 4, 18
Insert Function (fx) button, 169

“formula in this worksheet contains one or more 
invalid references” error message, 90

formulas
= (equal sign) to start, 162
automatic vs. manual calculation, 409
basic arithmetic, 160–166
constants to update, 204–205
date and time formats in, 171–172
displaying, 189–190
vs. functions, 160
hiding, 327
linked data in, 242–244
named ranges in, 200–201
order of precedence in, 161–162
parentheses in, 165–166
printing, 189, 189–190

quotation marks (") for text in, 182
relative cell reference in, 181, 182
in templates, 314–315
troubleshooting errors, 274–284

evaluating and correcting, 280–284
exam essentials, 302
locating errors, 276–280

Fourier Analysis, 292
Fraction cell format, 53
freezing panes, 106–107
Function Arguments box, 169, 170

for database functions, 220
for PMT function, 176

functions
addition, with SUM function, 164, 164–165
database, 215–222
date and time, 170–174
exam essentials, 227
financial, 174–179
vs. formulas, 160
information, 223–224
logical, 180–188
lookup, 206–213
Math & Trig, 223
optional vs. mandatory arguments, 177
statistical, 166–170
text, 222

FV (future value) function, 178–179

G
General cell format, 52
Getting Help task pane, 6
global macros, Personal Macro Workbook to 

store, 387–389, 420
Go To dialog box, 12
Go To Special dialog box, 276, 276, 278
goal, calculating payments needed to reach, 

178–179
Goal Seek, 285–287. See also Solver Add-In

dialog box, 287
gradient fill, 84
grammar, 132
graphical user interface. See user interface
graphics, 65–78. See also charts

adding and editing in worksheet, 69–74
clip art, 70
pictures, 71–74

diagrams and organization charts, 75–78
Drawing toolbar, 65–69
exam essentials, 94–95
importing files, 345
inserting in worksheet, 352

grave accent (`), for formula display, 189
green triangle in cell, 275
gridlines, 9
grouping worksheets, 127

for Find and Replace, 139–140
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466 hash (#) – JPEG files

H
hash (#), for number in custom format, 259
headers and footers, 117–121

field codes, 118–119
headings, locking, 106–107
Help button (Print Preview), 114
Help menu, 13
Help task pane, 6
hidden format, 327
hidden information, workbook protection 

for, 330
Hide Comments button (Reviewing toolbar), 298
Hide Detail/Show Detail button (PivotTable 

toolbar), 252
Hide Field List button (PivotTable toolbar), 252
Hide Ink Annotations/Delete All Ink Annotations 

button (Reviewing toolbar), 299
hiding

rows or columns, 21–22
worksheets, 26–27

High setting for macro security, 335
Highlight Changes dialog box, 297, 297
histogram, from Analysis ToolPak, 292
History temporary worksheet, 301
HLOOKUP function, 212–213

close match from, 213
horizontal alignment of cells, 56
horizontal page break, 123
hours, formatting to display, 262
HTM files, 343

opening, 345
HTML (Hypertext Markup Language), 340

for copy and pasting into email, 357, 358
saving data as, 362–365

HYPERLINK function, 213, 214
hyperlinks, for supporting information, 152, 

155–156

I
I beam, 15
IF statement, 181–183

multiple nested conditions and multiple return 
values, 186–187

nesting AND function in, 187–188
importing data. See also data in

into worksheet, 354–356
Include Hidden Items in Totals button (Pivot-

Table toolbar), 252
Increase/Decrease Decimal button (Formatting 

toolbar), 47

Increase/Decrease Indent button (Formatting 
toolbar), 47

index, name list as, 202–203
INFO function, 223–224
information functions, 223–224
initials, converting to full name, 135
Insert Clip Art button (Drawing toolbar), 65
Insert Diagram or Organization Chart button 

(Drawing toolbar), 65
Insert dialog box, 25
Insert Function (fx) button (Formula bar), 169
Insert Function utility, 166, 168, 168–170
Insert menu
� Cut Cells, 32
� Diagram, 77
� Edit Comment, 154
� Module, 383
� Name, 197, 198
� Define, 204
� Paste, 202

� Object, 352
� Page Break, 123
� Picture � Clip Art, 310
� Row, 348
� Worksheet, 25

Insert menu (Office programs) � Object, 366
Insert Picture from File button (Drawing toolbar), 

66, 71
Insert WordArt button (Drawing toolbar), 65
inserting

comments, 153
objects in worksheets, 352–354
workbooks in other Office programs, 366
worksheets in workbook, 25

insertion point, 15
INT function, 223
interface. See user interface
Internet Assistant VBA, 293
Internet encyclopedia, 146–147, 149–150
Internet Explorer, saving file as web page for, 

362–365
invoice, VLOOKUP function to fill in, 207–209
ISBLANK function, 223
ISERR function, 223
ISERROR function, 223
ISLOGICAL function, 223
ISNA function, 209, 211, 223
Italic button (Formatting toolbar), 47
Iteration settings for Excel, 410

J
JPEG files, 343

opening, 345
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K
keyboard shortcuts, 13
keywords, for clip art, 71

L
labels, 12, 13

repeating when printing, 115–116
landscape orientation, 114, 115, 116
language, for Spelling tool, 418
Large Icons for toolbar, 400
last cell with data, moving to, 10–11
leading zeros, displaying, 258
leap years, adjusting for, 174
left column labels when consolidating 

data, 239
Legend button (Chart toolbar), 83, 85
Less Brightness button (Picture toolbar), 71
Less Contrast button (Picture toolbar), 71
Line button (Drawing toolbar), 65
Line Color button (Drawing toolbar), 66, 67
Line Style button (Drawing toolbar), 66
Line Style button (Picture toolbar), 72, 73
linking data, 240–247

broken links, 244–246
linked data in formulas, 242–244
phantom links, 246–247
settings for automatic update, 411
simple links to external data, 240–242

List Font Names in Their Font, 400
list ranges, 215–217
lists

custom, 144–146
forms for adding, changing and finding data 

in, 216–217
selecting data with Advanced Filters, 

217–220
locked areas, in templates, 93
locked cells, 326
locked-up computer, from macros, 387
logical functions, 180–188
Lookup functions, 205, 206–213

HLOOKUP function, 212–213
nesting, 209–211
in templates, 314
VLOOKUP function, 205, 206, 206–209

lookup value, 205
Lookup Wizard, 293
Lotus 1-2-3 files, 343, 346, 412
Low setting for macro security, 336
LOWER function, 222

M
Macro dialog box, 374

Run button, 373
macro recording toolbar, Relative Reference 

button, 375, 375–376
macro security, 323, 334–336, 373
macros, 372

availability in all workbooks, 386–391
assigning to toolbars and menus, 389–391
Personal Macro Workbook for storing, 

387–389
computer lockup from, 387
to control opening workbook, 384
exam essentials, 392
in one workbook, 372–386

assigning to command buttons, 385–386
copying, 382–384
editing, 379–382
recording, 374–379

shortcut key for, 377
mail merges in Word, worksheet for, 366
manual page breaks, 123
margins, 121–122
Margins button (Print Preview), 114
Math & Trig functions, 223
MAX function, 166, 167
MDB file, 343

opening, 345–346
Media Gallery, 69
Medium setting for macro security, 335
memory, clearing Excel of recent commands or 

buttons, 400
menu bar, 3, 4
menu key for Microsoft Office Excel, slash (/) 

for, 413
menus

animations, 400
assigning macros to commands, 373
customizing, 397–407

Merge and Center button (Formatting 
toolbar), 47

problems from, 52, 55
merging copies of workbooks, 294
Microsoft Access, 215
Microsoft Access files, 343, 345–346

importing worksheet to, 365–366
Microsoft Graph, 351, 352
Microsoft website, downloading templates from, 

308
Microsoft Word mail merges, worksheet for, 366
MIN function, 166, 167
minutes, formatting to display, 262
module content pane (Visual Basic Editor), 380
MONTH function, 174

4002bindex.fm  Page 467  Sunday, March 26, 2006  6:19 PM



468 months of year – organizing data

months of year
AutoFill for, 144
formatting to display, 262

More Brightness button (Picture toolbar), 71
More Contrast button (Picture toolbar), 71, 73
mouse

to drag and drop to fill data, 38–41
for resizing rows and columns, 18–19

mouse pointers, 38–41, 39
Move Or Copy dialog box, 25
Move Selection After Enter Direction setting, 411
moving

data into worksheet, 347–352
data out of worksheet, 357–360
toolbars, 5

between computers, 403
worksheets in workbook, 24–25

multiplication, 161

N
#N/A (Not available) error, 209, 210, 275

nesting functions to remove, 211
Name box

for cell address, 8, 9
constants and, 205
typing address to move to specific cell, 12

#NAME? error, 183, 275, 280
named cells, 197

as bookmarks, 202–203
named constants, 204–205
named ranges, 197–205

for consolidating data, 238
database or criteria for, 218
editing, 201–202
in formulas, 200–201

names
of fonts, 48
for worksheet tabs, 23–24

navigation, 9–12
exam essentials, 42

negative numbers, 54, 54
custom formats for, 260

nested functions
to control Lookup function results, 209–211
in IF statement, 186–187

New (Add) Comment button (Reviewing 
toolbar), 298, 300

New Workbook dialog box, 92
New Workbook task pane, 7, 309

templates section, 92
Next button (Print Preview), 114
noncontiguous ranges of cells, selecting, 32, 

34–36
NOT function, 183, 185–186
Notepad, for text files, 360

#NULL! error, 275
#NUM! error, 275
Number cell format, 52
numbers

AutoFill for, 144
custom formats for, 259–262
narrow column and, 18

O
Object dialog box

Create From File tab, 353–354
Create New tab, 352–353, 353

Object Linking and Embedding (OLE), 351
objects in worksheets

displaying placeholders, 409
inserting, 352–354

OCR (Optical Character Recognition), 347
Office Clipboard, 36–38

removing items from, 38
Office dictionary, 133
OLE (Object Linking and Embedding), 351
Open dialog box, default display of Excel files, 

342, 342
opening Excel, 2
operators in formulas, 161–163
Optical Character Recognition (OCR), 347
option button in active cell, 20
Options dialog box, 396, 407–419

Calculations tab, 409–410, 410
Chart tab, 413–414, 414
Color tab, 414, 415
Custom Lists tab, 145–146, 146
Edit tab, 242, 410–411, 411
Error Checking tab, 417, 417
General tab, 4, 411–412, 412

User Name, 153, 295
International tab, 415, 415–416
Save tab, 416, 416–417
Security tab, 419, 419
Spelling tab, 133, 418, 418
Transition tab, 412–413, 413
View tab, 408, 408–409

Or filters, 218–219
OR function, 183, 185–186
order for worksheet tabs, arranging logically, 

24–26
order of precedence in formulas, 161–162
organization charts, adding and editing in 

worksheet, 75–78
organizing data, 98–105

with AutoFilters, 102–105
exam essentials, 129
sorting, 99–102

based on multiple columns, 102
based on single column, 100–101
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orientation of page – Printer Properties dialog box 469

views for, 105–113
creating workspaces, 110–112
custom views, 112–113
freezing panes, 106–107
multiple windows for viewing, 107–110
splitting worksheets, 107

orientation of page, 114–115
outlining, 231–234

and Subtotal command, 234–236
Oval button (Drawing toolbar), 65, 66
ownership of files, 324

P
Page Break Preview, 114, 115–116
page breaks, 122–124
page layout, 113–124

exam essentials, 129
headers and footers, 117–121
margins, 121–122
orientation, 114–115
page breaks, 122–124
repeating rows and columns, 115–116

page numbers
field code for, 118
headers and footers for printing, 117

page selection for pivot table, 248
Page Setup dialog box, 113, 116

Header/Footer tab, 117
Margins tab, 122
Sheet tab, 190, 284

pages, printing specific, 126–128
paper size, A4 letter, 416
parent function, 187
parentheses

impact on formula results, 165–166
and order of precedence, 162

passwords
for file protection, 332–333
removing, 334
for templates, 308, 310
for worksheets, 323

Paste List feature, 203, 203
Paste Special dialog box, 33
pasting. See also copy and paste

multiple blocks of data, 36–38
other programs' options for, 359
range of cells, 32–33

with same data, 39
path for file, field code for, 119
patterns

for cells, 57–59
for fill effect, 84

PDF files, inserting in worksheet, 352
Percent Style button (Formatting toolbar), 47

Percentage cell format, 53
personal information, removing from file 

properties, 419
Personal Macro Workbook, 386

copying macros to, 389
recording and running macro in, 387–388
saving changes, 388
XLSTART folder for storing, 420

personal.xls file. See Personal Macro Workbook
phantom links, 246–247
Pick from Drop-Down List, 142, 143–144
Picture toolbar, 70

buttons and functions, 71–72
for editing pictures, 72–74

pictures. See also graphics
adding to worksheets, 71–74
field code for, 119
for fill effect, 84

pie charts, 78
from Chart Wizard, 82, 82–83

pivot charts, 247, 256–258
pivot tables

to create pivot chart, 256–257
creating, 249–250
editing and manipulating display, 253–255, 

254, 255
external links in, 247
tools, 251, 251–256

PivotTable button (PivotTable toolbar), 252
PivotTable Field list, 251, 251–252
PivotTable report, 248, 248–256

PivotTable Wizard for, 248–249, 249, 250
PivotTable toolbar, 251, 251–252
plagiarism, 347
plain text

copying data to, 357
saving file as, 360–362

PMT function, 175–178
Function Arguments box for, 176

points for font size, 48
portrait orientation, 114, 115, 116
PowerPoint (PPT) files, 343

drag and dropping data from, 350–351
inserting slides in worksheet, 352, 354
opening, 346

precedents for formula, 280, 280
Precision As Displayed setting, 410
predictions, scenarios to compare, 288–291
Previous button (Print Preview), 114
Previous/Next button (Reviewing toolbar), 298
primary sort, 101
Print dialog box, 124
Print Preview, 114

and comments, 154
for formulas, 190
margins and header/footer sizes in, 121

Print Screen key, to capture screen image, 347
Printer Properties dialog box, 126
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printing, 124–128
background image and, 64
comments, 154–155
formulas, 189, 189–190
multiple copies and specific pages, 126–128
multiple worksheets, 127–128
page layout, 113–124

headers and footers, 117–121
margins, 121–122
orientation, 114–115
page breaks, 122–124
repeating rows and columns, 115–116

scaling by percentages, 124–125
selections, 125–126
suppressing errors when, 284

Privacy Options, 419
.prn file, 343
programs, copying information between, 351
projects pane (Visual Basic Editor), 380
prompt, to update links, 242
PROPER function, 222
Properties dialog box for workbooks, 324, 325

Summary tab, 324
properties of workbooks, 324–326
properties pane (Visual Basic Editor), 380
Protect Sheet dialog box, 310, 328
Protect Workbook dialog box, 330
publishing web pages with interactivity, 362, 

362, 363–365

Q
queries. See advanced filters
question mark (?), as Find and Replace 

wildcard, 140
quotation marks ("), for text in formulas, 182

R
radial diagram, 75–76, 76
Random Number Generator, 292
range of cells, 32
Ready mode, changing to Edit mode, 15
Rearrange Commands dialog box, 406, 406–407
recalculations, Iteration settings and, 410
Recently Used File List setting, 411
Record Macro dialog box, 376
recording macros, 374–379
records, 215
recovery, automatic, of crashed workbooks, 416, 

416–417
Rectangle button (Drawing toolbar), 65
#REF! error, 90, 275
Reference functions, 205, 213–214
Refresh Data button (PivotTable toolbar), 252

Registry (Windows), settings for buttons and 
commands, 397

Regression, 292
relational databases, 215
relative cell reference, 194–195, 195

in formulas, 181, 182
in macros, 381

relative macro, 373
recording and running, 376–377

repeating rows and columns when printing, 
115–116

Reply with Changes button (Reviewing 
toolbar), 299

Research Options dialog box, 148
Research task pane, 6, 146–150, 147

finding definitions, 149
finding synonyms, 147–149
Internet encyclopedia, 149–150
translating text, 150

Reset Picture button (Picture toolbar), 72
resizing

vs. cropping, 73
toolbars, 5

return values, multiple, from IF statement, 
186–187

Reviewing toolbar, 298
comment recognition, 300

Rich Text, for copy and pasting into email, 
357, 358

Rotate Left 90˚ button (Picture toolbar), 72
rotating shapes and text, 68
ROUND function, 223
ROUNDDOWN function, 223
ROUNDUP function, 223
rows in worksheets, 8

absolute vs. relative references, 195, 195–196
adding and deleting, 20–21
blank rows and contiguous ranges, 99
changing size, 17–20

with menus, 19–20
with mouse, 18–19

freezing, 106–107
hiding, 21–22
outline groups, 233
repeating when printing, 115–116
selection for pivot table, 249

S
sans serif font, 48
Save As dialog box, 27, 28

and templates, 307, 312
Templates folder, 321, 321
Tools dropdown list, 331, 331, 332

Save Options dialog box, 332, 334
saving

default folder for, 412
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scaling by percentages when printing – static data in headers and footers 471

files in different formats, 360–365
workbooks, 27–29

structure with XML, 366–367
workspace, 111

scaling by percentages when printing, 124–125
scanner, OCR software with, 347
Scenario Manager, 288, 290, 290
Scenario Summary dialog box, 290–291, 291
scenario summary report, 285
scenarios, 285

adding to worksheets, 290
to compare predictions, 288–291
exam essentials, 303

schema for XML, 367
Scientific cell format, 53
screen image, capturing with Print Screen 

key, 347
ScreenTips On Toolbars, 400
scrollbars, 8, 8
Search Results task pane, 6
secondary axis in combination chart, 91
secondary sort, 101
seconds, formatting to display, 263
security

exam essentials, 337
file protection, 331–334
for macros, 323, 334–336, 373
options for, 419, 419
workbook protection, 329–331
worksheet protection, 326–331

Security dialog box for macros, Security Level 
tab, 335, 335

Select Data Source dialog box, 354
selecting

cells in worksheet
with hyperlink, 156
inclusion in macro, 375

contiguous and noncontiguous ranges of cells, 
32–36

data from list with Advanced Filters, 217–220
for printing, 125–126

Send to Mail Recipient button (Reviewing 
toolbar), 299

serial number, for time of day, 171
Series dialog box, 145
serif font, 48
Set Transparent Color button (Picture toolbar), 72
Setup button (Print Preview), 114
Shadow and 3D Styles button (Drawing 

toolbar), 66
shapes

creating, 66–68
modifying, 68–69

Share Workbook dialog box
Advanced tab, 297
Editing tab, 296

shared network drive, for storing workbooks, 294
shared workbooks

comments in, 299, 300

creating, 296–298
displaying changes, 298
exam essentials, 303
limitations, 294–295
reviewing changes, 298–299

Shared Workspace task pane, 7
sheets, 7. See also worksheets
sheet.xlt file, 422

deleting, 423
shortcut key, for macros, 377
Show Detail button (PivotTable toolbar), 252
Show/Hide Comments button (Reviewing 

toolbar), 298
Show/Hide Field List button (PivotTable 

toolbar), 252
size

of toolbars, 5
of worksheet rows and columns, changing, 

17–20
slash (/), for menu key for Microsoft Office Excel, 

413
smiley face (Custom) button, 389–390, 390
Solver Add-In, 285, 293, 293–294
Sort dialog box, 101, 101, 102
sorting

based on multiple columns, 102
based on single column, 100–101
for Subtotal command, 234
website information in Excel, 357

Source Data range, for charts, 89–91
space

AutoCorrect to add between words, 135
deleting, 152

Special cell format, 53
Spelling dialog box, 133, 133
Spelling tool, 132–135, 133

language for, 418
splitting worksheets, 107
square bracket ([), in search to find external links, 

246–247
Standard toolbar, 3, 4

AutoSum (∑) button, 164
Copy button, 30
Cut button, 31
Format Painter, 61
Insert Hyperlink button, 156
New button, 92
Print button, 124
Research button, 147
Sort Ascending button, 100
Sort Descending button, 100
Spelling button, 133
Undo button, 14–15

limitations, 23
Zoom button, 106

Start menu � All Programs � Microsoft Office � 
Microsoft Office Excel 2003, 2

static consolidation sheet, 236, 237
static data in headers and footers, 117–118
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472 statistical functions – Tools menu

statistical functions, 166–170
entering directly into cells, 166–168

Stop Recording toolbar, 375
stopping, macro recording, 375
strikethrough, 48, 50
Style dialog box, 60, 60
styles, 60–61
subfolders, for Templates folder, 321
subordinates in organization chart, creating, 77
subscript, 48
Subtotal command

dialog box, 235
and outlining, 234–236

SUBTOTAL function, 231
help for, 231

subtraction, 161
SUM function, 164, 164–165
SUMIF function, 225
summarizing data, 230–236

vs. consolidating, 236
outlining, 231–234
subtotals and outlining together, 234–236

superscript, 48, 50
synonyms, finding, 147–149
system resources, for menu animations, 400

T
Tab key, to move between cells, 13
tab scrolling buttons, 7, 8
table array, 194
task pane, 5–7, 6
Taskbar (Windows), shortcut menu, 350, 

350–351
Template Help task pane, 6
templates, 92–94, 306–323

adding data using, 93–94
attaching toolbars, 401
creating, 311–320

data validation, 315–320
formatting, 311–313
formulas and field codes, 314–315

deleting, 321
editing, 308–311
exam essentials, 337
finding invalid data and removing validation, 

319–320
how they work, 307
locating, 307
organizing, 321–323
saving, 312

Templates dialog box, 308
creating tabs in, 321
Spreadsheet Solutions tab, 308, 309

text
characters recognized as, 259–260
conditional formatting to change color, 265

converting to columns, 150–152
custom formats for, 259–262
in formulas, quotation marks (") for, 182
narrow column and, 17
rotating shape with, 68

Text cell format, 53
text files, 343

saving data as, 360–362
text functions, 222
Text Import Wizard, 344, 344, 361
Text To Columns Wizard, 150–152, 151
Textbox button (Drawing toolbar), 65, 67
texture

for chart background, 257
as fill effect, 84

thesaurus, 146–147
tilde (~), in Find and Replace, 141
tiling windows, 349
Time cell format, 53
time, field code for, 119
time functions. See date and time functions
time span

formatting to display, 263
vs. times of day, 171

Times New Roman font, 48
Title bar, 3, 4
TODAY function, 174

in templates, 315
toolbars, 3–5

assigning macros to buttons, 373
attaching to template, 401
closing, 5
creating, 401–404
customizing, 397–407
deleting, 407
deleting buttons from, 404–405
docking, 5
editing buttons, 404–407
lost, 397
moving and resizing, 5
turning off and on, 401

Tools menu
� Add-Ins, 169, 291
� AutoCorrect Options, 136
� Compare and Merge Workbooks, 294
� Customize, 3, 389, 398
� Data Analysis, 292
� Euro Conversion, 293
� Goal Seek, 286
� Macro
� Macros, 373, 380, 383
� Record New Macro, 376, 378
� Security, 335
� Visual Basic Editor, 379

� Options, 407. See also Options dialog box
� Protection
� Protect Sheet, 310, 327
� Protect Workbook, 330
� Unprotect Sheet, 309, 328
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Track Changes feature – workbooks 473

� Scenarios, 288
� Share Workbook, 296
� Spelling, 133
� Track Changes
� Accept or Reject Changes, 301
� Highlight Changes, 300, 301

tooltips, 4
displaying, 400
for PivotTable toolbar, 252

Track Changes feature, 296, 297, 297
translating text, 150
translation utility, 146–147
TRANSPOSE function, 213–214
trendlines, 285–287
troubleshooting formula errors, 274–284

evaluating and correcting, 280–284
locating errors, 276–280
suppressing when printing, 284

TRUE argument, as range lookup, 213
true type font, 48
txt file, 343

U
Underline button (Formatting toolbar), 47
Undo button (Standard toolbar), 14–15

for AutoCorrect, 136
limitations, 23

Update File button (Reviewing toolbar), 299
UPPER function, 222
user interface, 2–9, 4

default bars, 3–5
exam essentials, 42
task pane, 5–7

users, and template changes, 323

V
validating data with templates, 315–320
validation rules, 306
#VALUE! error, 163, 275
values in cells, 12, 13
VBA (Visual Basic for Applications), 292
vertical alignment of cells, 56
vertical page break, 122–123
Very High setting for macro security, 335
View menu
� Header And Footer, 421
� Page Break Preview, 123
� Task Pane, 5, 7
� Toolbars, 3, 375
� Chart, 83
� Customize, 398
� Drawing, 65

� Forms, 385
� Formula Auditing, 5, 279, 320
� Picture, 70
� PivotTable, 251
� Reviewing, 298

views for organizing data, 105–113
creating workspaces, 110–112
custom views, 112–113
exam essentials, 129
freezing panes, 106–107
multiple windows for viewing, 107–110
splitting worksheets, 107

Visual Basic Editor, 380
Visual Basic for Applications (VBA), 292

code to select specific worksheet, 384
comments in, 381

Visual Basic Runtime Error box, 376
VLOOKUP function, 205, 206, 206–209

close match from, 213
in nested function, 211
in templates, 314

W
Watch Window, 281, 283
websites

Microsoft, downloading templates from, 308
publishing Excel data to, 293

what-if analysis, 285–294
exam essentials, 303

wildcards, Find and Replace with, 140–141
Window menu, 108
� Arrange, 108, 243
� Compare Side by Side, 108

windows
opening new for each workbook, 409
tiling, 349

Windows (Microsoft)
folder management control, 322
hidden file extensions, 341
Registry settings for buttons and 

commands, 397
Taskbar, shortcut menu, 350, 350–351

WK4 file, 343
opening, 346

Word document, 343
inserting in worksheet, 352

Word Mail Merge, Excel data for, 99
Word (Microsoft) mail merges, worksheet 

for, 366
“workbook contains links to other data sources” 

warning box, 242
“workbook contains one or more links that 

cannot be updated” warning, 245
workbooks

components, 7
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474 workgroup – Zoom button

copying colors between, 414
data entry and editing, 12–29
default, 420–422

restoring original, 422–423
name for new, 3
navigating, 9–10
opening

macro to control, 384
in new window, 409

properties, 324–326
publishing as web pages, 362, 363–365
saving, 27–29

structure with XML, 366–367
security and protection, 323–336
viewing multiple, 107–110

workgroup, 295
worksheets, 7. See also columns in worksheets; 

rows in worksheets
adding graphics, 69–74

clip art, 70
diagrams and organization charts, 75–78
pictures, 71–74

components, 8–9
data editing, 15
data entry, 13–15
default, 422

restoring original, 422–423
deleting and hiding, 26–27
formatting, 62–65

with AutoFormats, 62–64
backgrounds, 64–65

grouping, 127
inserting objects, 352–354
navigating, 10–12
organizing, 22–27
printing multiple, 127–128
protection, 323, 326–331

splitting, 107
tabs, 8

arranging in logical order, 24–26
naming and color-coding, 23–24

workspaces
creating, 110–112
uses for, 112

WYSIWYG fonts, 48

X
.xls file extension, 306
XLSTART folder, for default files, 420
.xlt file extension, 306
XML (Extensible Markup Language), 340
XML file, 343

importing, 356
opening, 346
saving workbook as, 364
saving workbook structure as, 366–367

XML Source task pane, 7
.xsd file extension, 367

Y
years, formatting to display, 262

Z
zeros, displaying leading, 258
Zoom button (Print Preview), 114
Zoom button (Standard toolbar), 106
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Microsoft Office Specialist: Excel Study Guide

 

MOS: Specialist Exam Objectives

MOS: Expert Exam Objectives

 

OBJECTIVE CHAPTER

Creating Data and Content

 

Enter and edit cell content 1

Navigate to specific cell content 1

Locate, select and insert supporting information 4

Insert, position and size graphics 2

 

Analyzing Data 

 

Filter lists using AutoFilter 3

Sort lists 3

Insert and modify formulas 5, 6

Use statistical, date and time, financial, and logical functions 5

Create, modify, and position diagrams and charts based on worksheet data 2

 

Formatting Data and Content

 

Apply and modify cell formats 2

Apply and modify cell styles 2

Modify row and column formats 1

Format worksheets 2

 

Collaborating

 

Insert, view and edit comments 4

 

Managing Workbooks

 

Create new workbooks from templates 2

Insert, delete and move cells 1

Create and modify hyperlinks 4

Organize worksheets 1

Preview data in other views 3

Customize Window layout 3

Setup pages for printing 3

Print data 3

Organize workbooks using file folders 1

Save data in appropriate formats for different uses 1, 10

 

OBJECTIVE CHAPTER

Organizing and Analyzing Data

 

Use subtotals 7

Define and apply advanced filters 6

 

4002PerfCard.fm  Page 1  Saturday, March 25, 2006  12:21 AM



 

Exam objectives are subject to change at any time prior to notice and at Microsoft’s sole 
discretion. Please visit Microsoft Learning’s web site (

 

www.microsoft.com/learning

 

) for the 
most current listing of exam objectives.

 

Organizing and Analyzing Data

 

Group and outline data 7

Use data validation 9

Create and modify list ranges 6

Add, show, close, edit, merge and summarize scenarios 8

Perform data analysis using automated tools 8

Create PivotTable and PivotChart reports 7

Use Lookup and Reference functions 6

Use Database functions 6

Trace formula precedents, dependents, and errors 8

Locate invalid data and formulas 8, 9

Watch and evaluate formulas 8

Define, modify and use named ranges 6

Structure workbooks using XML 10

 

Formatting Data and Content 

 

Create and modify custom data formats 7

Use conditional formatting 7

Format and resize graphics 2

Format charts and diagrams 2

 

Collaborating

 

Protect cells, worksheets, and workbooks 9

Apply workbook security settings 9

Share workbooks 8

Merge workbooks 8

Track, accept, and reject changes to workbooks 8

 

Managing Data and Workbooks

 

Import data to Excel 10

Export data from Excel 10

Publish and edit Web worksheets and workbooks 10

Create and edit templates 9

Consolidate data 7

Define and modify workbook properties 9

 

Customizing Excel

 

Customize toolbars and menus 11, 12

Create, edit, and run macros 11

Modify Excel default settings 12

 

OBJECTIVE CHAPTER
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